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Introduction to Microsoft Dynamics AX functionality

Microsoft Dynamics AX is an integrated, adaptable business management solution that helps you and your employees make business decisions with greater confidence. Microsoft Dynamics AX works like and with other Microsoft software. Microsoft Dynamics AX automates and streamlines business processes, and enables you to connect with global customers, business partners, and subsidiaries. 

Product sections

Each section of the Navigation Pane is described below. 

General ledger

In the General ledger section, you define and manage the financial records for your company. These financial records include: 

· Company currencies.

· Ledger accounts within the chart of accounts.

· Fiscal periods and fiscal years.

· Sales taxes (for both sales and purchases).

· Journals for posting to ledger accounts and accounts in other sections.

· System accounts for automatic posting.

· Parameters, defaults, and number sequences that apply to ledger accounts and ledger transactions.

· Dimensions, dimension sets and hierarchies, and financial statements.

· Optional features related to journals and posting.

· Sales tax specific to countries/regions.

· Vendor withholding tax.

· Ledger budgets and period allocation keys.

· Fixed assets.

Cost accounting

In the Cost accounting section, you set up and manage cost accounting. You can redirect overhead and indirect costs to the entities that you set up as cost categories and to the dimensions that you define for use within cost accounting. 

When you set up cost categories, you can activate a link to the ledger accounts, so that a copy of posted ledger transactions automatically appears in the appropriate cost category. You can then redistribute the costs among other cost categories and dimensions, and analyze the cost structure of your business. 

Bank

In the Bank section, you create and manage company bank accounts and the financial instruments that are associated with bank accounts, such as deposit slips, checks, bills of exchange, and promissory notes.

You also create bank groups, bank transaction types, the bank accounts that the company has in each bank group, and check layouts for the bank accounts.

You can view bank data by using a number of standard inquiries, reconcile bank account statements, and print bank data in standard reports. These standard reports include balances, payment lists, summaries, deposit slips, payment advice, and bank transactions that are not reconciled.

CRM

In the CRM section, you enter and track all your business contacts, accounts, opportunities, and relationships. Some of the tasks you can perform include: 

· Track activities.

· Create and manage campaigns.

· Manage sales quotations.

Accounts receivable

In the Accounts receivable section, you track all sales and incoming payments from customers.

You also set up customer groups, customers, posting profiles, various payment options, interest notes, collection letters, commissions, parameters concerning customers and sales orders, prices and discounts, charges, supplementary items, deliveries and destinations, and bills of exchange.

Depending on your setup, you can then perform many tasks that are related to customers and sales. Some of the tasks you can perform include:

· Create and manage sales orders, sales quotations, and free text invoices.

· Settle customer invoices.

· Create reports.

Accounts payable

In the Accounts payable section, you track all purchases and outgoing expenditures to vendors.

You also set up vendor groups, vendors, posting profiles, various payment options, parameters concerning vendors and purchase orders, prices and discounts, charges, supplementary items, deliveries and destinations, and promissory notes

Depending on your setup, you can then perform many tasks that are related to vendors and purchases. For example, you can create and manage purchase orders and planned purchase orders, use various kinds of journals, and settle vendor invoices.

Inventory management

In the Inventory management section, you track items from receipt to issue, and track their storage and transport.

Master planning

In the Master planning section, you set up and run scheduling to calculate requirements and generate planned orders. You can use forecast scheduling to calculate gross requirements based on forecasts, and to plan long-term materials and capacity needs. Use master scheduling to calculate net requirements based on actual orders and to control inventory replenishment on a daily basis.

Production

In the Production section, you manage the production of items, from creating an order to the finished, manufactured item. 

The section is integrated with other sections, including the Inventory management, General ledger, and Basic sections. This integration supports the information flow that is needed to complete manufacturing.

Product Builder

In the Product Builder section, you set up dynamic configurations for items based on requirements and modeling variables determined by sales order, purchase order, production order, sales quotation, or project quotation.

Based on a configuration, and from these predefined modeling variables, this section automates the generation of standard bills of materials and standard routes—within Microsoft Dynamics AX—for the production of each item. This simplifies the job production process and improves the interaction of sales and production.

Shop Floor Control

In the Shop Floor Control section, you set up and manage data collection for a production environment.

You also set up employees, work profiles, indirect activities, various employee groups, parameters for posting on production orders and projects, pay agreements, and registration forms.

You can collect data about time and attendance, production orders, projects, and indirect activities. You can post collected data about production orders and projects, generate payroll data for employees, and schedule shift plans.

Human Resources

In the Human Resources section, you manage a wide variety of business information and perform a range of actions that are related to the business workforce and its organizational structure. 

Questionnaire

In the Questionnaire section, you design, create, distribute, and complete questionnaires, and then analyze the results.

Balanced scorecard

In the Balanced scorecard section, you create scorecards to help your company identify its visions and strategies and then translate them into measurable objectives. 

Project

In the Project section, you set up projects, estimate project costs, use projects to generate quotations, and track project process. Types of projects you can manage include: 

· Time and materials.

· Investment.

· Fixed price.

· Time.

· Cost.

· Internal.

Service

In the Service section, you set up and manage service agreements, service orders, and service subscriptions. 

Basic

The Basic section contains data and functionality that is used across other sections. In it, you manage the data for:

· Employee information. 

· Work center groups.

· Work calendars.

· Dimension values.

· Companies.

· Record templates.

· E-mail templates.

· Number sequences.

You can also manage the following functionality: 

· Alerts.

· Document management. 

· Batch processing. 

· Reporting. 

· Application integration framework. 

Administration

In the Administration section, you manage users and groups, company accounts, domains and virtual company accounts, system settings, Internet-related settings, and security.

Cross-section functionality

This section describes the Microsoft Dynamics AX functionality that is set up across multiple parts of the product.

Business analysis

Microsoft Dynamics AX provides multiple tools for viewing and analyzing business data.

· Ad hoc reports offer you the flexibility to create and modify reports using a drag-and-drop feature and a report template. 

· Online Analytical Processing (OLAP) reporting helps you analyze trends in business data. 

· Standard reports enable you to produce reports and filter data in them. 

Enterprise Portal

Enterprise Portal provides Web-enabled access to data stored in Microsoft Dynamics AX. From Enterprise Portal, you can manage documents that are attached to records in the Microsoft Dynamics AX database, search for data stored in Microsoft Windows SharePoint Services, and use SharePoint announcements, surveys, and discussion lists to collaborate with customers, business partners, and other employees. 

Application Integration Framework 

Application Integration Framework (AIF) enables companies to integrate and communicate with other business processes and partners electronically. As the replacement for the Microsoft Axapta 3.0 Commerce Gateway, it enables more secure business-to-business and application-to-application integration scenarios. 

Microsoft Dynamics AX roles

Microsoft Dynamics AX requires that you define which computer in your system is going to perform a specific function or role. A single computer can host one or more roles.

Core computer roles

A Microsoft Dynamics AX system is comprised of the following core computer roles:

Application Object Server (AOS)

An AOS:

· Is a Microsoft Windows service that controls communications among Microsoft Dynamics AX clients, databases, and applications. 

· Can be installed on a single computer, or on a cluster using Windows load-balancing. 

Microsoft Dynamics AX requires Windows-integrated authentication for all servers in the system, which means that you must have an Active Directory directory service system. For security reasons, the AOS must be installed on Windows Server 2003. 

A system used for demonstrations, development or test can be set up to use more than one AOS instance. 

Database

A Microsoft Dynamics AX database stores your Microsoft Dynamics AX data as part of an existing Microsoft SQL Server or Oracle database server installation. The database server must be set up with Windows authentication.

File server

The application file server contains the files in which the Microsoft Dynamics AX business logic is stored. Examples of the files in this directory include indexes, headers, and labels for each layer. The directory must be accessible to all AOS computers. Permissions on this directory should be highly restrictive because data stored can include sensitive customer data. Only the AOS Windows service and Microsoft Dynamics AX administrators should have write access to the directory. Client computers do NOT require access to the directory, and such access should not be granted. 

Client

The interface to Microsoft Dynamics AX data and functionality.

Extended computer roles

When you use extended Microsoft Dynamics AX functionality, additional computer roles can be added to your system. None of these roles are required.

Enterprise Portal server

An Enterprise Portal server hosts and provides site definitions for a Microsoft SharePoint site that can present live Microsoft Dynamics AX data and functionality to trusted users, and can present restricted functionality, such as catalog information and questionnaires, to anonymous users.

Reporting server

A reporting server adds to the reporting functionality within Microsoft Dynamics AX by linking Microsoft Dynamics AX to Microsoft SQL Server Reporting Services. A reporting server provides enhanced support for ad hoc reporting.

Application integration server

An application integration server provides support for sharing data from Microsoft Dynamics AX with external parties, such as vendors and customers. It supports many scenarios, including Orders-to-Cash, Procure-to-Pay, and other enterprise application integration. It runs the Application Integration Framework (AIF), a document-based integration interface.

Custom client

A custom client is an application written by a partner or customer to access Microsoft Dynamics AX data. Custom client applications use an integration component--either the Microsoft .NET Business Connector or the COM Business Connector to connect to Microsoft Dynamics AX.

OLAP server

An OLAP server adds to the reporting functionality within Microsoft Dynamics AX by linking Microsoft Dynamics AX to SQL Server Analysis Services. An analysis server provides enhanced support for online analytical processing (OLAP).

Other common computer roles

The following common roles are also found in infrastructures that are running Microsoft Dynamics AX. This documentation does not include content on how to set them up, but provides information on how to use Microsoft Dynamics AX with them.

Messaging server

A messaging server enables sending and receiving e-mail messages and instant messages. Microsoft Dynamics AX can use e-mail to send alerts to users. Microsoft Dynamics AX requires a messaging server that supports SMTP.

Firewall server

A firewall server is part of a security system that helps protect a network from external threats, originating outside the network.

Microsoft Dynamics architecture

Understanding the internal architecture of Microsoft Dynamics AX can help you make decisions when planning and developing a Microsoft Dynamics AX system.

System architecture
This diagram provides a high-level overview of a Microsoft Dynamics AX system with all components installed, and describes how communications flow among components. 

Note   The diagram does not depict the physical topology of a system. Many logical servers can be placed on a single physical server. For guidance about the physical topology of a system, see System topology recommendations.
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Application Object Server (AOS) architecture
This diagram describes the functionality within the AOS Windows service, and describes how communications flow within it.
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Application file server architecture
This diagram describes the application file server.
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Client kernel architecture
This diagram describes the functionality within the client kernel, and describes how communications flow within it.
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Business Connector architecture
The differences between the client kernel as it runs on a standard client and a Business Connector client are: 

· The Session Manager in the client kernel manages only a single instance--in the Business Connector kernel, it manages multiple instances.

· The client kernel includes forms security, while the Business Connector kernel does not. 

This diagram describes the architecture of the Business Connector version of the client kernel, and describes how communications flow within it.
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Application integration framework architecture
This diagram describes the functionality within the application integration framework, and describes how communications flow within it.
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Enterprise Portal architecture
This diagram provides a logical overview of a Microsoft Dynamics AX system with an Enterprise Portal server, and describes how communications flow within it.
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Reporting Server architecture
This diagram provides a logical overview of a Microsoft Dynamics AX system with a reporting server, and describes how communications flow within it.
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Security architecture

Microsoft Dynamics AX security architecture consists of infrastructure security and application security.

Infrastructure security

Microsoft Dynamics AX infrastructure security is built on:

· Active Directory directory services configured in native mode. For details about Active Directory user topology, see: Active Directory user topology. For information about configuring Active Directory, see the Microsoft Windows Server 2003 Active Directory Technology Center.

· Integrated Windows authentication.

· A perimeter network with a firewall for Internet-facing Enterprise Portal.

· Secured servers. Many of the servers running Microsoft Dynamics AX components have specific security requirements. For details, see Plan infrastructure security.

Follow recommended Microsoft practices for securing the servers you are running, and stay up-to-date on understanding and implementing recommendations that make sense for your environment. For the most recent guidance, see the Microsoft Technet Security Center.

Application security

The application security architecture of Microsoft Dynamics AX includes the features listed below. 

· Active Directory users that have been added to Microsoft Dynamics AX. Users that are not in Active Directory cannot be added. Users cannot be granted permissions directly.

· Microsoft Dynamics AX user groups that are granted permissions. 

By adding a user to a group, you grant that user all the permissions assigned to that group. Users that are not assigned to groups cannot access Microsoft Dynamics AX. A user can be a part of more than one group; that user inherits the highest permissions level of the two groups.

Caution   An Administrator User and an Administrators group are created the first time a Microsoft Dynamics AX client is run. Administrators have complete access to all forms, menus, tables, reports, and the Application Object Tree (AOT). Restrict the number of users in the Administrators group. 

· Domains that are groups of company accounts.

Domains make it easier to maintain user group security if several companies use the same Microsoft Dynamics AX system, and have similar security needs. Domains enable you to restrict permissions to user groups to a single company, or to set up user groups with permissions to data across companies. The domains feature requires a separate license.

· Security keys that control access to menu items, forms, reports, and fields within a form.

Security keys are disabled by default, and can be set for user group/domain combinations. Only administrator users and those accessing Microsoft Dynamics AX with a developer license have all security keys enabled by default.

· Table and field security that allow you to restrict access and changes to a table.

· Record-level security that allows you to set permissions on rows in tables, to restrict access to particular sections of a table.

No record-level security is set by default.

Getting started with associated technologies

Implementing and administering Microsoft Dynamics AX solutions requires an understanding of many technologies. Before you begin, you may want to become familiar with the technologies in the table below that pertain to the functionality you are using.

	Functional area
	Prerequisite knowledge
	Resources

	All
	Database administration
	· Microsoft SQL Server TechCenter on TechNet
· Microsoft SQL Server Developer Center
· Oracle. See your Oracle documentation.

	Enterprise Portal
	· Administering Internet Information Services (IIS)

· Administering Windows SharePoint Services

- or -

· Administering Microsoft Office SharePoint Server
	· Microsoft Windows Server 2003 Internet Information Services (IIS) information on TechNet
· Windows SharePoint Services Technology Center
· SharePoint Portal Server Technology Center

	Application Integration Framework (AIF)
	· Administering Internet Information Services

· Communication security

· Enterprise Application Integration

· Web services
	· Microsoft Windows Server 2003 Internet Information Services (IIS) information on TechNet
· SharePoint Portal Server Technology Center
· Microsoft Patterns and Practices
· Web Services Developer Center

	Business Intelligence and reporting
	Microsoft SQL Server Reporting Services functionality and administration
	· SQL Server 2005 Technology Center
· SQL Server 2005 Developer Center

	Business analysis
	Microsoft SQL Server Analysis Services functionality and administration
	· SQL Server 2005 Technology Center
· SQL Server 2005 Developer Center

	Highly-available systems
	· Microsoft Windows load-balancing

· SQL Server disaster recovery
	· Windows Server 2003 Clustering Services
· SQL Server 2005 Technology Center

	Tuning Microsoft Dynamics AX
	· Windows performance management

· Database performance management

· Remote Procedure Call service
	· Windows Server TechCenter
· SQL Server 2005 Technology Center

	Securing your system
	· Windows Active Directory

· Network administration

· Windows security

· Perimeter networks
	· TechNet Security Home Page
· Microsoft Security Developer Center


Quick start for installing or upgrading

For a quick introduction to working with Microsoft Dynamics AX, we recommend that you first review the following topics:

· Flowchart: Installation process
· Flowchart: Configuring a core installation
Then, as you require more in-depth information, we recommend that you become familiar with the content in these sections: 

· Planning an implementation or upgrade
· Installing and configuring Microsoft Dynamics AX
For a quick introduction to an upgrade project, start with these topics:

· Flowchart: Upgrade methodology
· Upgrade methodology 

As you require more in-depth information, we recommend that you become familiar with the section Upgrading to Microsoft Dynamics AX.

What's new in implementing Microsoft Dynamics AX

Many changes have been made to Microsoft Dynamics AX that affect the way you implement and upgrade. The links below highlight some of the more important changes.

Architecture
The following topic lists some of the architectural changes in Microsoft Dynamics AX. For detailed descriptions of the Microsoft Dynamics AX architecture, see Microsoft Dynamics architecture.

Three-tier implementations

This version of Microsoft Dynamics AX only supports 3-tier implementations.

Application Object Server (AOS) is now a Windows service

The AOS is now a Microsoft Windows service instead of a separate executable file. The configuration, control, and management of this service can be done with the standard Windows interface for managing services.

This service provides better manageability, is more secure, and leverages the existing Windows Service interface for a faster ramp-up time.

AOS communication mechanism updated

Communication between the Microsoft Axapta 3.0 client and server is implemented with socket programming. The Microsoft Dynamics AX network transportation layer uses the Microsoft Remote Procedure Call (RPC) service, a powerful technology for creating distributed client/server programs.

This change allows runtime support for channel security, data serialization, client-side connection pooling, server-side thread pooling, asynchronous calls, and an exception-handling mechanism across the client and server. 

The amount of abstraction the RPC service provides makes it easier to identify and implement potential performance improvements for client/server communications. Lastly, the RPC service requires a formal contract between client and server, which moves Microsoft Dynamics AX one step closer to a true Web service model.

64-bit RecID

To support larger customers, Microsoft Dynamics AX 4.0 has moved to using 64-bit per table record identification representation.

Table permissions framework

Write access to sensitive system tables and metadata is now restricted to developers and administrators. For more information, see Table Properties.

Unicode

In this version, the Microsoft Dynamics AX code base is Unicode-compliant. Unicode enables a single software product or a single Web site to be targeted across multiple platforms, languages, and countries/regions without re-engineering. Unicode supports double double-byte characters and our geographic expansion plans for Microsoft Dynamics AX wave of releases includes China and Japan. Closely related to ISO/IEC 10646, it allows data to be transported through many different systems without corruption.

Any database used with Microsoft Dynamics AX must handle Unicode data types. For new installations on a Microsoft SQL Server database, we recommend that you use Windows collations.

For upgrade, all databases must be upgraded to handle Unicode data types. Unicode upgrade is handled as part of the upgrade process.

Improved language support

All languages are automatically supported in the AOS. The only language decision to make during installation is for the default client language. This improved language support speeds setup, reduces deployment errors, and generally simplifies deployment.

Batch Server

Batch jobs can now be executed as the Microsoft Dynamics AX user that initially submitted the job, rather than the user that is running the batch process, by using the newly-available RunAs functionality. When this type of batch processing is used, the user that initiates batch processing cannot interact with the batch job or view its output. Batch processing that does not use RunAs is still available. Batch-enabled classes in Microsoft Dynamics AX that do not use RunAs can easily be changed to use it, if appropriate.

Setup, upgrade, and configuration
The following topic lists the changes to Setup, Upgrade, and Configuration.

Integrated Setup Wizard

The Microsoft Dynamics AX installation runs from a single setup wizard for either distributed or single-computer topologies. Deep technical knowledge of Microsoft Dynamics AX architecture is no longer needed to successfully install the product.

Upgrade tool set

The upgrade tool set has been improved for Microsoft Dynamics AX. For more information, see Upgrading to Microsoft Dynamics AX.

· The Upgrade checklist automatically opens when a new version of Microsoft Dynamics AX is installed on top of an existing installation. The checklist leads the implementer through upgrading code and data. In this version the checklist has been simplified with fewer steps, and performance is improved so that the tasks in the checklist can be completed more quickly.

· The Dynamics AX DB Upgrade Preparation Tool reads a Microsoft Axapta 3.0 database and repopulates the new database (installed through the Microsoft Dynamics AX database server installation) with Unicode data types (nchar, nvarchar.and ntext) in place of the MBCS data types. In addition, the record identification references and the transaction identification reference fields are converted from 32 bit to 64 bit (data type int64 instead of int). For relevant tables, optimistic concurrency control is enabled.

Configuration Utilities

The configuration utilities have been rewritten, and are now launched from All Programs > Administrative Tools.

The utilities have been updated to support architecture changes, allow configuration of Business Connector when running non-interactively, and enable robust tracing capabilities. For more information, see:

· Changes in configuring Microsoft Dynamics AX servers.

· Changes in configuring Microsoft Dynamics AX clients.

Perimeter Network Configuration Wizard integration

Microsoft Dynamics AX ships with the Microsoft Business Solutions Perimeter Network Configuration Wizard so that customers can quickly deploy Microsoft Internet Security and Acceleration Server (ISA 2004) to configure a secure perimeter network for external users of Microsoft Dynamics AX Enterprise Portal. Integration with the Perimeter Network Configuration tool reduces deployment costs and errors, and reduces the setup time. For more information, see: Setting up a perimeter network.

New and improved demonstration data

The new Global Trade and Manufacturing Company demonstration data supports demonstrating new Microsoft Dynamics AX functionality. The Global Trade and Manufacturing Company is based in the US and represents an American company with US-specific functionality in use. The structure of the data is based on the Light Company data.

Excel data export and import

Partners can modify the existing demonstration data using the new Microsoft Excel Export data to a Microsoft Excel spreadsheet and import functionality. This functionality enables data residing in tables to be exported to an Excel workbook for editing and then to be imported into Microsoft Dynamics AX. The new features also ease the transfer of data between systems, such as legacy applications and Microsoft Dynamics AX. When data is available in Excel, users can modify, translate, and add data in a familiar way using the Microsoft Office environment for presentation or business use.

Performance
The following topic lists some of the changes in Microsoft Dynamics AX made to improve performance.

Application Object Server (AOS) communication mechanism updated

Communication between the Microsoft Axapta 3.0 client and server is implemented with socket programming. The Microsoft Dynamics AX network transportation layer uses the Microsoft Remote Procedure Call (RPC) service, a powerful technology for creating distributed client/server programs.

This change allows runtime support for channel security, data serialization, client-side connection pooling, server-side thread pooling, asynchronous calls, and an exception-handling mechanism across the client and server.

The amount of abstraction the RPC service provides makes it easier to identify and implement potential performance improvements for client/server communications. Lastly, the RPC service requires a formal contract between client and server, which moves Microsoft Dynamics AX one step closer to a true Web service model.

Database concurrency configuration

Previous versions of Microsoft Dynamics AX did not allow control over the concurrency model to use when creating, updating, deleting, or reading data. To increase transaction throughput in this version of Microsoft Dynamics AX, control over the concurrency model has be added in the form of global concurrency settings, a table property, and keywords.

Database index improvements

In Microsoft Dynamics AX 4.0, the product database indexing and updating has been optimized, and the documentation provides guidelines for improved database performance in customizations and add-ons. 
Database hint improvements

The number of available Microsoft SQL Server hints was decreased. Global control over hint features was added to the user interface. For more information, see Tune database settings.

Improved tracing

New functionality has been added to Microsoft Dynamics AX that enables tracing either client or server activity. Traces are set in the Microsoft Dynamics AX Server Configuration Utility and the Microsoft Dynamics AX Configuration Utility. For more information, see Set tracing options.

Performance improvements with Microsoft SQL Server 2005

· Read Consistent Snapshot Isolation (RCSI). This new isolation level allows greater concurrency between read and update transactions. The effect of this isolation level is that a read operation does not block (and cannot be blocked by) concurrent update operations. RCSI specifically benefits customers who need to run reports or queries in real-time.

· Enhancements to the query optimizer and optimizer statistics. The accuracy of statistics is improved, and the manner in which they are collected can be made less intrusive to concurrent transactions.

· Easier index maintenance. Index management is made easier through the ability to create and modify indexes online. Also, insert operations have been optimized in the manner in which they update the index tree. 

· Dynamic Address Windowing Extensions (AWE) memory. AWE memory, which allows 32-bit operating systems to use large amounts of memory for data caching, is dynamic in SQL 2005. This enables easier memory management, especially in a cluster configuration. For more information, see the topic Enabling AWE Memory for SQL Server in SQL Server Books online: http://msdn2.microsoft.com/en-us/library/ms190673(SQL.90).aspx.

· Support for SQL Server on a 64-bit platform. This low-cost entry into 64-bit database technology allows higher levels of database scalability. 64-bit features are available on SQL Server 2005 Standard, Enterprise and Developer editions.

· Enhanced visibility into database operation and performance. Additional events in Profiler and the dynamic management views (DMVs) help improve capabilities for observing and improving performance.

Application Object Server
The Application Object Server (AOS) provides the infrastructure to execute the business logic on the middle tier of a 3-tier Microsoft Dynamics AX installation. The AOS handles the connectivity, security, and database connection management that an Microsoft Dynamics AX system requires. 

In Microsoft Axapta 3.0, the AOS was a standalone program, that is, an executable file that was started and stopped by the Microsoft Dynamics AX Server Manager, which functioned as a load-balancing application. In Microsoft Dynamics AX, the AOS is implemented as a Microsoft Windows Service to take advantage of the following:

· Windows Service applications run in the security context of a specific user account that is different from a user that is logged on or the default computer account. After installation of Microsoft Dynamics AX, the default user account has all the permissions required to access Microsoft Dynamics AX functionality.

· Eliminating the dependency on the Microsoft Dynamics AX Server Manager removes a security threat by which an attacker could send a command to the AOS to shut it down.

· A Windows Service application runs in its own Windows Session and takes advantage of the Service Control Manager (a feature of the Windows Server 2003 operating system) to maintain status information and to provide the user interface for managing the AOS.

· Windows Services can be configured to start at system startup or upon demand, and they continue to run even when no user is logged into the system.

· Server status can be reported to the Windows event log, allowing administrators to view errors and warnings that can aid in troubleshooting problems.

Access management
This topic describes important changes to access management features for Microsoft Dynamics AX. Access management features include domains, user groups, permissions, users, record-level security, and system authentication. 

User authentication

To add an additional layer of security to your computing environment, Microsoft Dynamics AX requires that all users be listed in Microsoft Active Directory directory services on your domain controller before they can be added to the list of Microsoft Dynamics AX users. Active Directory catalogs information about all the objects on a network, including people, computers, and printers, and distributes that information throughout your network. Security is integrated with Active Directory through logon authentication. Active Directory is a feature of Microsoft Windows Server 2003 and Microsoft Small Business Server 2003. For more information, see Active Directory user topology.

If a user is not found in Active Directory, that user cannot be enabled in the list of Microsoft Dynamics AX users and, therefore, cannot access Microsoft Dynamics AX. Once the user is found in Active Directory and added to the list of users, Microsoft Dynamics AX authenticates the user's network credentials against Active Directory each time the user opens a Microsoft Dynamics AX client. For more information about adding users, see Create new users.

User defaults

You can set a user's default language and default Help content language from the Options form. 

System authentication

The accounts used to communicate between servers have changed. Only Windows authentication is used within the system. No SQL Server authentication is used, so the BMSSA account is no longer required. The following computer accounts are used to communicate between servers: 

	Server computer and account 
	Function 

	Application Object Server (AOS), AOS account (the domain account or Network Service account associated with an AOS instance) 
	Communicates with database server, granted rights as user in database.

	Database server, Local System
	MSSQL service must be running under Local System


Business Connector
Business Connector for Microsoft Dynamics AX enables third-party applications to interface with the application as though they were native clients. Enterprise Portal, for example, allows users to access Microsoft Dynamics AX functionality and data using a Web browser. When a user connects to Microsoft Dynamics AX using a Web browser, Business Connector is the key component that bridges Enterprise Portal and Microsoft Dynamics AX.

Business Connector in Microsoft Axapta 3.0 supported Component Object Model (COM) and Active Server Pages (ASP) applications, that is, COM and ASP applications could interact with Axapta through Business Connector. Microsoft Dynamics AX still supports COM Business Connector for your existing applications and includes the following enhancements:

· .NET Business Connector – Applications built using Microsoft .NET Framework or ASP.NET can now interface with Microsoft Dynamics AX using .NET Business Connector. The .NET Framework is composed of the common language runtime (CLR) and a unified set of class libraries. The .NET Framework supports more than 20 programming languages and makes it easier than ever before to build, deploy, and administer secure, robust, and high-performing applications. Integrated with Enterprise Portal and Web services, .NET Business Connector leverages the benefits of these other applications and services.

· Integrated Windows authentication – To support integration with Microsoft SharePoint Services and to enhance product security, Microsoft Dynamics AX uses integrated Windows authentication in both COM Business Connector and .NET Business Connector. Changes to the authentication scheme mean that your existing COM applications must be modified to use integrated Windows authentication before they can work with COM Business Connector in Microsoft Dynamics AX.

· Installing and registering Business Connector – In previous versions, Business Connector was installed and registered using the Client Configuration Utility and/or Component Services. Now you can install and uninstall Business Connector using Setup.exe on the Microsoft Dynamics AX DVD. Business Connector is automatically registered when installed.

Enterprise Portal
This topic provides an overview of the changes to the Microsoft Dynamics AX Enterprise Portal that are of interest to system administrators. 
Integration with SharePoint

In Microsoft Dynamics AX, the Enterprise Portal platform is built on Microsoft Windows SharePoint Services (WSS). Integration with SharePoint greatly simplifies the process of creating and maintaining Web pages on the Enterprise portal site.

· SharePoint Web authoring experience.  Web pages are created outside of the Microsoft Dynamics AX Integrated Development Environment (IDE) by using SharePoint Web Parts Pages. Several new Microsoft Dynamics AX Web Parts display Microsoft Dynamics AX forms, reports, and menus on the Enterprise Portal site. Users can create and modify Web pages on the Enterprise Portal site by using standard Web editing tools, such as Microsoft Office FrontPage.

· Better personalization.  Users can easily personalize Enterprise Portal pages from within the browser by adding standard SharePoint page elements such as discussion lists, announcements, and document workspaces.

· Integrated collaboration and content management.  The proprietary collaboration and content management functionality in Microsoft Microsoft Dynamics AX 3.0 is no longer present in Microsoft Dynamics AX. Collaboration and content management functionality is incorporated into Microsoft Dynamics AX Enterprise Portal sites using the equivalent features in WSS.

· Integrated document management.  Microsoft Dynamics AX document management functionality is integrated with the SharePoint user interface. Therefore, users can accomplish many of the same document management tasks from the Enterprise Portal that they can accomplish from the Microsoft Dynamics AX client application. 

· Common search.  Users can search for Microsoft Dynamics AX records from the Enterprise Portal. They can also search for documents and list items that are stored in Windows SharePoint Services, such as announcements and discussions.

Features removed from Enterprise Portal

The following features of Axapta 3.0 Enterprise do not exist in Microsoft Dynamics AX.

· Web projects. Use Microsoft Dynamics AX projects. 

· Web applications. In Microsoft Dynamics AX, there is only one Web application. 

· Weblet editor. The Weblet editor has been removed from the product--you should now use SharePoint Page designer.

Content management changes in Enterprise Portal

If you are familiar with the content management features in previous versions of the Microsoft Dynamics AX Enterprise Portal, the following table briefly describes the changes introduced in the Enterprise Portal for version 4.0.

	Content management feature for Enterprise Portal in version 3.0 
	Corresponding functionality for Enterprise Portal in version 4.0 

	Categories
	There is not an exact equivalent to this feature for version 4.0. However, you can customize the SharePoint lists, and you can control access to these lists using SharePoint security (site groups). For example, you can create one announcements list per category. 

	Articles
	SharePoint announcements lists

	Article moderation and publishing
	SharePoint content approval

	Discussions (enabled by categories)
	SharePoint discussion boards

You can create a discussion board for a particular category.

	Polls
	SharePoint surveys


Other enhancements

· Microsoft .NET Business Connector.  In Microsoft Dynamics AX, Enterprise Portal uses the .NET Business Connector (instead of the COM Business Connector) to interoperate with Microsoft Dynamics AX. The performance and reliability of Enterprise Portal is greatly improved by leveraging the .NET features of Business Connector. There is less work involved in configuring Business Connector for Enterprise Portal, because the registration step has been removed (previously, the COM Business Connector was used by Enterprise Portal and could be registered in a number of different ways). In fact, most of the Business Connector-specific configuration options in the Microsoft Dynamics AX Configuration utility have been removed.

· Integrated Windows authentication.  No separate user identification or password is required to enter the site. 

· Authorization.  Authorization is through both SharePoint site groups and Microsoft Dynamics AX security keys. 

Reporting
This topic provides a brief description of the changes to reporting and business intelligence features for Microsoft Dynamics AX.

Ad hoc reporting

In previous versions of this product, when a business decision maker wanted to customize a standard report, that person needed a developer to alter the report in the X++ code. The process was neither quick nor easy. This version of Microsoft Dynamics AX introduces a new feature called ad hoc reporting. Ad hoc reporting enables business decision makers to create and customize reports on their own using a drag-and-drop report authoring tool. For more information, see Introduction to ad hoc reporting and Set up and configure ad hoc reporting.

OLAP reporting

Online analytical processing (OLAP) in Microsoft Dynamics AX uses Windows authentication in combination with Microsoft SQL Server Analysis Services roles for improved OLAP security. Additionally, OLAP requires a more secure version of Microsoft Office Web Components. For more information, see Set up OLAP reporting and OLAP security.

Standard reporting

Microsoft Dynamics AX includes an enhanced drill-down capability for standard reports. For more information, see Drill down in standard reports.

Document exchange (AIF)
The Application Integration Framework (AIF) enables companies to electronically integrate and communicate with other business processes and partners. As the replacement for the Commerce Gateway, AIF enables more secure Business-to-Business and Application-to-Application integration scenarios, with reduced cost to develop and customize documents based on industry-standard XML. 

With AIF, the document-based interface to Microsoft Dynamics AX has been renewed, XML schemas have been simplified, and performance in the supply chain process has been improved. Also, the XML Common Business Library (xCBL) document standard has been eliminated. You can still map to xCBL standard documents, but this is no longer required.  

Improved setup and customization features make it easy to translate data into XML for export to other internal and external software applications or to a different Microsoft Dynamics AX installation. Export is handled through Web services or in batches, for example, using the Microsoft BizTalk Server 2006 adapter. XML documents are imported by AIF through the same channels, and AIF helps ensure that the appropriate business logic is applied before writing the data to the Microsoft Dynamics AX database.

AIF includes out-of-the-box support for an enlarged set of commonly used documents, including:

· ASN (Advance shipping notice - outbound)

· Exchange rates (outbound and inbound)

· Free text invoice (inbound)

· Inventory balances (outbound)

· Inventory counting journal (inbound)

· Inventory profit and loss journal (inbound)

· Inventory transactions (outbound)

· Inventory transfer journal (inbound)

· Ledger chart of account (outbound and inbound)

· Ledger dimensions (outbound and inbound)

· Packing slip update (inbound)

· Picking list (outbound)

· Price discount agreement journal (inbound)

· Price list (outbound)

· Purchase invoice (inbound)

· Purchase order (outbound)

· Sales invoice (outbound)

· Sales order (inbound)

Partners and customers can easily customize and extend the application programming interfaces (APIs) using the Microsoft Dynamics AX software development kit (SDK). The SDK includes a new wizard that enables developers to easily create custom documents.

AIF provides a pluggable framework that supports multiple transports to reliably exchange documents with trading partners or other systems.

· Send Documents. Microsoft Dynamics AX sends documents to another system.

· Receive and Create Documents. Microsoft Dynamics AX receives documents from another authorized system and creates new records in the Microsoft Dynamics AX database.

· Respond to Read Requests. Microsoft Dynamics AX receives requests for documents from another authorized system, retrieves the requested information from the Microsoft Dynamics AX database, and returns it to the requesting system, with appropriate filtering and security.

Microsoft Dynamics AX supports the following asynchronous adapters:

· File System

· Message Queuing

· Outbound Web Service Adapter

· BizTalk Adapter

Additional custom asynchronous transport adapters can be developed using the SDK.

AIF supports the following character encoding formats:

· UTF-8

· UTF-16

· UTF-16be

· GB18030

AIF also provides a Web services interface for exchanging documents synchronously. This interface provides a seamless integration experience for .NET and other Web clients. The Web services are generated automatically from the Microsoft Dynamics AX business logic, so that developers with limited Web experience can easily create their own Web services.

To support document transformations, AIF provides a pluggable pipeline architecture with configurable components. A value substitution component is provided out-of-the-box that allows administrators to define simple value maps without programming. Partners can develop other custom pipeline components using the SDK and the hooks provided by the pluggable architecture to address specific transformation needs.
Version control
You can now use Microsoft Visual SourceSafe to manage your Microsoft Dynamics AX code, or use the version controls APIs to integrate Microsoft Dynamics AX with another version control system. For more information, see Managing version control. 

Preparing to install or upgrade

This section contains information about the methodologies and processes that have been developed for use with Microsoft Dynamics AX. It also describes the steps to take in planning a Microsoft Dynamics AX systems. Consistent use of standard methodologies and processes and careful system planning lead to more successful implementations.

The table below describes what you will find in this section.

	Section
	Description

	Recommended methodology and processes
	This section describes the recommended implementation methodology, and processes to use in implementation and upgrade. 

	Planning an implementation or upgrade
	This section describes key elements to consider in planning an implementation or upgrade.


Recommended methodology and processes

This section describes the implementation and upgrade processes that Microsoft recommends.

The table below describes what you will find in this section.

	Section
	Description

	Implementation methodology
	Microsoft strongly encourages our partners to use the recommended Microsoft Dynamics implementation methodology that is described fully in the Microsoft Dynamics Consulting Toolkit.

	Upgrade methodology
	This section describes the recommended preparation for and path through an upgrade project.

	Flowchart: Installation process
	This topic provides a visual overview of the installation process, and links to all steps in the process.

	Flowchart: Configuring a core installation
	This topic provides a visual overview of the configuration process, and links to all steps in the process.


Implementation methodology

The Microsoft Dynamics Implementation methodology describes consulting and process best practices for partners working with Microsoft Dynamics AX, Microsoft Dynamics Nav, and Microsoft Dynamics GP. Toolkits are available for download from PartnerSource.
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The methodology consists of the following phases:

	Phase
	Partner accomplishments during phase

	Diagnostic
	· Evaluates a customer's business processes and infrastructure

· Prepares a proposal

	Analysis
	· Analyzes the current business model

· Produces a gap/fit analysis

· Creates the requirements documentation

	Design
	Documents:

· Feature design

· Data migration design

· Test criteria

· Technical design

	Development
	· Develops the features

· Tests the features and functions

· Creates and tests the user documentation

	Deployment
	· Sets up the production environment

· Configures the system

· Migrates data

· Tests the system

· Trains the end-users

· Gets the system up "live"

	Operation
	· Clears pending issues

· Finalizes the user documentation and knowledge transfer

· Conducts a post-mortem of the project

· Provides on-going support

The activities involved in this phase are on-going activities performed after project close and throughout any future involvement with the client.

	Optimization 
	· Analyzes the system to determine how it can best be optimized for the customer's needs

· Performs the optimization

· Tests

The purpose of this phase is to help the customer refine the benefit they get from the business solution. Many times, after the implementation project is complete, customers desire minor changes to their system. This phase understands that need and supports the Customer for Life scenario.

	Upgrade
	· Reviews the customer's business processes

· Aligns the business processes to new functionality

· Sets the systems in place to support the upgrade

· Creates value to maintain a Customer for Life scenario


Upgrade methodology

Upgrading to Microsoft Dynamics AX from an earlier product version must be done using the following stages:

Note   For a description of the entire upgrade process, see Flowchart: Upgrade methodology.
Prepare for upgrade

Before you begin:

· Make a backup of your current application and database, install the pre-upgrade tools for Microsoft Dynamics AX, and make sure that people involved in the upgrade process have sufficient user rights to perform the upgrade process.

· Disconnect the Application Object Servers or database servers from any Internet connection during upgrade.

Upgrade code

After you set up your test environment and start the Microsoft Dynamics AX client for the first time, you must create an upgrade project. When you create an upgrade project, the process analyzes the application files, and creates the project with application objects that must also be upgraded. For information about how to create an upgrade project, refer to Create an upgrade project.

If you have modified application objects in any layer, you must:

· Identify where the changes are for these application objects

· Analyze your business processes and decide what code modifications you need to port to the new version

· Compare and port your modifications to the new version.

In order to identify the changes to application objects, and then evaluate and port these changes to the new version, these tools are available:

· The Compare tool compares an application object in different layers. Properties, as well as X++ source code, are compared.

· The Code upgrade tool is used to upgrade X++ source code. The tool presents source code comparisons and provides convenient access to the X++ editor to make the actual updates.

For details and procedures for upgrading your code, see Upgrade your code in the test environment.

For details and procedures for testing your system after you upgrade the code, see Test the system after code upgrade.

Upgrade data

After you have evaluated and ported code changes to the new version, then you must upgrade your data. The data must be upgraded because of changes made to the data dictionary since the last product version. Changes to the data dictionary mean that tables and/or fields have been added, renamed or deleted. In addition, upgrading to the new version could require validation and correction of existing data.

After you upgrade your data when you upgrade your system, you must upgrade data when you import data that was exported from a previous product version. See Import data from older versions for more information. 

Data upgrade is handled by the Data upgrade cockpit (%1 -> %2), which is a part of the Upgrade checklist.

For details and procedures for upgrading your data, see Upgrade your data in the test environment.

Upgrade in the production environment

After you have evaluated and tested the upgraded code and data upgrade, port the code changes into your production environment and run them through the upgrade checklist.

For details and procedures for upgrading in your production environment, see Upgrade in the production environment.
Flowchart: Upgrade methodology

The figure below shows the process flow to upgrade your system:
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Before you begin upgrading

Before you begin upgrading, be aware of the following restrictions and requirements.

Restrictions

There are a number of upgrade restrictions that you should be aware of before actually starting the upgrade:

Version support

Upgrade to Microsoft Dynamics AX 4.0 must be from Microsoft Axapta 3.0 with or without one of the service packs.

Because data dictionary changes, and as a consequence DEL_ prefixed tables and fields, are typical from one version to the next, you cannot skip a full version when you upgrade. For example, you cannot upgrade Axapta version 2.5 information directly to Microsoft Dynamics AX version 4.0. You must upgrade to version 3.0 first, and then to version 4.0. If you skip a version, the data upgrade facilities cannot handle data upgrade, and you are liable to lose data. For more information about upgrading from versions prior to Axapta 3.0, see Note on upgrading from releases prior to 3.0.

Upgrade restriction: Axapta 3.0 with multi-code page data cannot be upgraded

Axapta 3.0 had the documented limitation that a single Microsoft Dynamics AX installation could not use multiple code pages, and that such installations were not supported. Partners may nevertheless have succeeded in making such installations work in version 3.0. These installations cannot be upgraded to Microsoft Dynamics AX.

During the upgrade to Unicode, the database code page is used and multi-code page data cause data corruption:

· If the "enable database for Unicode" option is not selected, all character data (string and memo) that is not in the code page of the database is lost.

· If the "enable database for Unicode" option is selected, any data of the memo data type that is not in the code page of the database is lost.

For more information about the Unicode upgrade, see About the Dynamics AX DB Upgrade Preparation Tool.

Requirements

Before you begin upgrading, check the following:

Set appropriate user permissions

Before beginning the Microsoft Dynamics AX upgrade process, ensure that the account you log on with on each server has appropriate permissions. The permissions listed below are implemented using the principle of least privilege.

Note   If you upgrade Microsoft Dynamics AX using a domain account other than your own, that account must have appropriate permissions in the system.

	Action
	Permissions required for account

	Install Application Object Server (AOS)
	Member of Administrators group on the local computer

	Create a Microsoft SQL Server database 
	Member of Database Creators role on the SQL Server instance

	Connect AOS to a SQL Server database 
	Member of Database Security Administrators role on the SQL Server instance

	Create Oracle database 
	Member of SYSDBA on Oracle database server

	Connect AOS to an Oracle database 
	Member of SYSDBA on Oracle database server

	Install application file server
	Member of Administrators group on the local computer

	Install Microsoft Dynamics AX client
	Member of Administrators group on the local computer

	Run the DB Upgrade Preparation Tool
	SQL Server – Ensure all objects are created with dbo as the owner. The minimum level of permissions for the user that is running the tool to ensure this happens is that they are a member of the ddl_admin, db_datareader and db_datawriter roles.

Oracle – Create a user called “dbo” with a random maximum length password (20 characters). All objects created must be created with the dbo user as the owner/schema.

	Run the Upgrade checklist
	During the client startup, the current Windows user is designated as the Microsoft Dynamics AX Administrator.


In Axapta 3.0: Move any packed identification references

The record identification upgrade handled by the Microsoft Dynamics Database Preparation Upgrade tool is unable to locate existing record identification references that are packed inside containers and stored in the database. Such record identification references must be moved to a dedicated field prior to the upgrade.

In your Axapta 3.0 modifications, this is what you should look for:

· A class that extends the SysPackable class, and 

· A field containing a record identification is packed inside the pack() method of that class, and

· The packed data is subsequently saved to a database table.

If your Axapta 3.0 code has such modifications, this is what you must do before running the Dynamics AX Database Preparation Upgrade tool:

1. Create a dedicated field in the relevant table to store the record identification reference.
2. Unpack existing packed data and move it into the dedicated field.

This is needed to ensure that data import and export can correctly handle record identifications.

In Axapta 3.0: Disable Keep update objects configuration key

If not already done, disable the Keep update objects configuration key (SysDeletedObjects30). This ensures that redundant tables and fields with prefix DEL_ are deleted from your system when the system is synchronized.

If these application objects with prefix DEL_ are left in your system, you are prompted to delete them later when you synchronize during upgrade to Microsoft Dynamics AX 4.0.

Back up your data

Before you begin upgrading you should:

· Back up your existing Axapta application files (*.aod, *.add, *.ald, *.ahd, and *.khd files).

· Back up your data. See SQL Server information at Microsoft SQL Server documentation.

· Back up your local hard drive.

Disconnect Internet connections

Do not have any Internet connection to the Application Object Servers or database servers during upgrade to reduce the chance of outside attack.

Clean up data

Remove data in the Microsoft Axapta 3.0 database that is not needed for audit trails, and that is slowing down performance or making the database unnecessarily large. Before you upgrade your database, select the type of data that you want to clean up by using the standard filtering mechanism.

3. Start Axapta 3.0 in your test environment (Start > All programs > Navision Axapta), and log on.
4. Open the Application Object Tree (AOT).

5. Under \Menu Items\Action, open and run the following forms to clean up the respective types of data:

· SysUserLogCleanUp

· SysDatabaseLogCleanUp

· ProdJournalCleanUp

· InventJournalCleanUp

· ProdTableCleanUp

· SalesParmCleanUp

· PurchParmCleanUp

· LedgerJournalCleanUp
Application upgrade: how it works

When you upgrade an Microsoft Dynamics AX installation, you must create an upgrade project by activating Create upgrade project.

Using the files in the Standard and in the Standard\Old folders, Create upgrade project analyzes the installation, deletes duplicate objects, and creates a project with application objects that must be upgraded manually.

The files in the Standard\Old folder are not modified during the upgrade process.

The creation of the upgrade project takes about one-half hour, depending on the number of modifications and on the hardware, and the purpose is to make the resulting project as small as possible.

When the application object changes have thus been identified, they must be evaluated and may be ported to the new version. To make this easier, the following tools are available:

· Compare - For more information, see Code compare tool.

· Code upgrade - For more information, see Code upgrade tool.

As an alternative to the Create upgrade project tool, the Compare layers tool can be used. The Compare layers tool compares any two layers and creates a project with the objects that differ. As opposed to the Create upgrade project tool, it compares only two layers and not all existing layers. Additionally, duplicate objects are not per default deleted when creating an upgrade project. Consequently compare layers may also be useful as a general tool, such as to give an overview of modifications made in a certain layer.

The comparison reveals that a number of application objects have been deleted (see the Status column) since the previous version. If the list comprises objects that you have added X++ code to, you must manually port your modifications from the previous version to the current one.

Note   If you have modifications in more than one layer, upgrade one layer at a time. The lowest layer that you have access to should be upgraded first. For example, if you have a VAR layer and a USR layer, upgrade the VAR layer first and then the USR layer.

Creating upgrade project process flow

The modification of Microsoft Dynamics AX consists of creating new application objects and modifying existing application objects. When an existing application object is modified, a copy of the original object is moved to the layer in which the modifications are saved. Conflicts appear when the underlying standard application is updated to another version or with a new service pack. Some application objects that have been copied to a layer may be changed in the update, but they will not come into effect because they are shadowed by your modification.

The first task is to detect the application objects that have been modified and also have been changed by the upgrade of the standard application. This process flow is portrayed in the following graphic.
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To learn more about how the upgrade process works for different types of application objects, see Application upgrade: examples.

Application upgrade: examples

The following upgrade scenarios are described:

· Scenario 1: Upgrading the CustTable table.

The first scenario deals with table upgrade because a typical modification is the addition of one or more fields to an existing table.

· Scenario 2: Upgrading the VendTable form.

The second scenario deals with form upgrade because another typical modification is to add a button to an existing form.

Tables and forms are chosen as examples because tables and forms are treated differently during an upgrade.

Forms, as well as reports, are seen as one, whole entity. This means that any modification to a form, whether the addition of a button or the change of a method, entails that the whole form must be updated.

All other types of application objects (tables, classes, menus, and so on) are seen as consisting of a number of components, and are shown as nodes in the Application Object Tree (AOT). For example, if only one table method has been modified, only that method is considered during the upgrade process.

The field names and numbers used in the following scenarios are fictional examples that do not necessarily correspond to the real-life situation. The examples use a SYS layer and a USR layer. The modifications might also be in another layer, or even in several layers.

Scenario 1: Upgrading the CustTable table

This is the situation when Microsoft Dynamics AX has been installed as an upgrade to an existing Microsoft Axapta version 3.0 installation.

	Microsoft Axapta Version 3.0 in the Standard/Old folder
	Microsoft Dynamics AX in the Standard folder

	The CustTable table has 2 fields, A and B in the SYS layer.
	The CustTable table has 4 fields, A, B, C and D, in the SYS layer, that is, two fields have been added in the new version.

	The CustTable table has an additional field, 'CompanyLogo', added in the USR layer.
	The CustTable table has an additional field, 'CompanyLogo', added in the USR layer. The USR layers in the new and the old directories are identical.


The Create upgrade project algorithm is used on each field in the CustTable table. For field A this results in field A being ignored. No upgrade is necessary.
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Field B is parallel to field A since both existed in version 3.0.

And the same scenario also applies for the new fields, C and D, that Microsoft has added: there are no changes to the fields as compared to the previous version, since the fields did not exist then. Therefore, no upgrade is required.

For field 'CompanyLogo', the question: 'Has Microsoft changed field 'CompanyLogo' in CustTable also returns NO, and the field is not relevant for upgrade. There are no conflicts with the previous version.

The final result of the Create upgrade project for the CustTable table is that the table is not included in the upgrade project since there are no conflicts to resolve. In Microsoft Dynamics AX CustTable has five fields, four in the SYS layer and one in the USR layer.

Scenario 2: Upgrading the VendTable form

As in scenario 1, this is the situation when Microsoft Dynamics AX has been installed as an upgrade to an existing Microsoft Axapta version 3.0 installation.

	Microsoft Axapta Version 3.0 in the Standard/Old folder
	Microsoft Dynamics AX in the Standard folder

	The VendTable form exists in the SYS layer.
	The VendTable form has an additional button Y, added in the new version.

	The VendTable form has an additional button X, so VendTable now exists in the USR layer.
	The VendTable form has an additional button X, added in the USR layer since the USR layers in the new and the old directories are identical.


The create upgrade project algorithm is used on the entire VendTable form. This results in the form being added to the upgrade project.
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There is a potential conflict in the form because it has been changed in two layers. The form is added to the upgrade project and the conflict must be examined and resolved manually.

A variant on the form scenario

The situation when a "hot fix" (a fix sent quickly for an issue that is causing a major problem), is imported is a variant on the form scenario. For example, a customer experiences an error on form A and receives a hot fix that solves the problem.

The hot fix is an .xpo file and, when imported, the form is added into the USR layer. When Microsoft Dynamics AX is released, the hot fix has been implemented and is part of the standard application.

So this might be the situation when Microsoft Dynamics AX has been installed as an upgrade to an existing Microsoft Axapta version 3.0 installation.

	Microsoft Axapta Version 3.0 in the Standard/Old folder
	Microsoft Dynamics AX in the Standard folder

	Form A exists in the SYS layer.
	Form A exists in the SYS layer, in a new version as compared to the old SYS layer version.

	Form A exists in the USR layer in a modified version.
	Form A exists in the USR layer in a modified version.


The following graphic shows the decision tree when implementing a hot fix.
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Because form A is identical in the new SYS layer and the new USR layer, form A in the USR layer is obsolete and is deleted.

Data upgrade: how it works

As part of the upgrade process to a new version or to a service pack, data must be upgraded. This is necessary when changes have been made to the existing data dictionary, where tables, fields, or indexes have been renamed, deleted or added.

Data upgrade is handled by the Upgrade checklist, which starts when Microsoft Dynamics AX discovers that the application should be upgraded.

Data upgrade is necessary in the following situations:

· When a table is deleted and the data must be saved.

· When a field is deleted and the data must be saved.

· When unique indexes are added or changed.

· When a non-unique index is changed to a unique index.

· When the location where data is stored is moved. For example, when data is moved from one field to another.

· When inconsistencies of old data are fixed.

· When new tables need to be populated with existing data.

· When new fields need to be populated with existing data.

Renamed application objects

As tables and fields are identification-based rather than name-based, they have unique identification codes. This means that renamed fields and tables are not a problem as far as data upgrade is concerned. Renamed application objects become an issue only when the objects are referenced in your X++ code. In that case, you get compile errors, and you must modify your code accordingly.

Deleted application objects

Data upgrade uses DEL_ as a special prefix. It is an abbreviation for “Deleted” and is used for application objects, most frequently tables that will be deleted in the next version of the product.

The DEL_ tables and fields are necessary for data updating purposes. Such objects present the only access to old data that are now stored somewhere else.

When an object with a DEL_ prefix is introduced, the Microsoft Dynamics AX update mechanisms handle changes in the standard application, for example by moving fields and X++ code to the table that replaces the one with the DEL_ prefix. But if you have written X++ code that references an application object that has been given a DEL_ prefix, you should evaluate and modify your modifications.

During the upgrade process, the ReleaseUpdateDB_<old version>to<new version> class handles changes, for example, by moving data from a DEL_ field to the field that replaces it.

Note   If you have written X++ code that references an application object that has been given a DEL_ prefix, re-evaluate and create modifications.

To be able to handle these deletions, the application object is given a special configuration key along with the DEL_ prefix. This configuration key is called Keep update objects SysDeletedObjects<version>, for example, SysDeletedObjects30. 

Disable the Keep update objects configuration key

After data upgrade, you should disable the Keep update objects configuration key to optimize performance and gain database space. To import data from a previous version at a later time, turn the configuration key on again. For more information, see Enable and disable configuration keys. 

When the key is turned off, the fields and tables with the key set are deleted with all the data in them. Turning the key on later results only in recreating the fields and tables, but the data is not returned.

If the Keep update objects configuration keep is left enabled, the application objects with prefix DEL_ are left in your system, and you will be prompted to delete them later when you synchronize during the next upgrade.

Version support

Upgrade to Microsoft Dynamics AX 4.0 must be from Microsoft Axapta 3.0 with or without one of the service packs.

Because data dictionary changes, and as a consequence DEL_ prefixed tables and fields, are typical from one version to the next, you cannot skip a full version when you upgrade. For example, you cannot upgrade a Axapta version 2.5 directly to Microsoft Dynamics AX version 4.0. You must upgrade to version 3.0 first, and then to version 4.0. If you skip a version, the data upgrade facilities cannot handle data upgrade, and you will lose data. For more information about upgrading from versions prior to Axapta 3.0, see Note on upgrading from releases prior to 3.0.

Example

The field CostValue in the CustInvoiceJour table becomes obsolete in version 4.0 and is given the DEL_ prefix. When the customer updates from version 3.0 to version 4.0, the upgrade system manages the move of data from the DEL_-prefaced field to the field that replaces it.

Any references to the CostValue in X++ code in higher layers must be updated manually.

When the customer later upgrades from version 4.0 to the next major version, the DEL_ field is deleted.
Flowchart: Installation processes

The basic installation process for Microsoft Dynamics AX is illustrated below.
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For more information about the steps in the installation process, expand the sections below.

Install and configure a core system

To get started quickly with an Microsoft Dynamics AX installation, follow the process illustrated below.
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The table below provides links to detailed steps for each stage in the process:

	Step
	Related content

	Configure active directory topology
	Active Directory user topology

	Install prerequisite software
	Hardware and software requirements

	Create database
	Create a SQL Server database
Set up an Oracle database

	Install file server
	Install a file server

	Install AOS
	Install an Application Object Server (AOS) instance
Install multiple Application Object Server instances

	Install client
	Install a client

	Start system
	Start Microsoft Dynamics AX

	Complete installation checklist
	Initial setup of the system

	Configure core modules
	Set up core modules

	Configure additional modules
	Set up additional modules

	Configure users and security
	Set up application security

	Import customer and item data
	Migrating data

	Import test data
	Migrating data


Set up and configure extended functionality

Extended functionality refers to those features that should be installed after a core system is configured, including Enterprise Portal, application integration server, reporting server, OLAP server, and team server.

Set up and configure Enterprise Portal

The illustration below illustrates the process of setting up and configuring Enterprise Portal.
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The table below provides links to detailed steps for each stage in the process:

	Step
	Related content

	Install prerequisite software
	Hardware and software requirements
Install an Enterprise Portal server

	Set up account for Business Connector proxy user, connect to IIS
	Install an Enterprise Portal server

	Install Enterprise Portal server using Setup
	Install an Enterprise Portal server
Set up an Enterprise Portal server farm

	Configure Enterprise Portal
	Configuring Enterprise Portal
Configure Enterprise Portal

	Deploy Enterprise Portal
	Deploy Enterprise Portal

	Create Enterprise Portal site
	Create an Enterprise Portal site

	Grant user permissions to site
	Managing Enterprise Portal users

	Customize site
	Customizing an Enterprise Portal site

	Re-deploy site
	Deploy changes to Enterprise Portal Web sites


Set up and configure a reporting server

The illustration below illustrates the process of setting up and configuring a reporting server.
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The table below provides links to detailed steps for each stage in the process:

	Step
	Related content

	Install prerequisite software
	Hardware and software requirements

	Create account for reporting server to use
	Import users from Active Directory

	Install reporting server role
	Install and configure a reporting server for ad hoc reporting

	Configure reporting server in Microsoft Dynamics AX
	Install and configure a reporting server for ad hoc reporting

	Create an ad hoc report model
	Create an ad hoc report model


Set up and configure an application integration server

The illustration below illustrates the process of setting up and configuring an application integration server.
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The table below provides links to detailed steps for each stage in the process: 

	Step
	Related content

	Install prerequisite software
	Hardware and software requirements

	Install application integration
	Install an application integration server
Install BizTalk adapter for application integration

	Configure application integration
	Adapter-based exchanges
Web services for application integration
Configuring document exchanges
Configuring document exchanges that expose Web services


Set up and configure an OLAP server

The illustration below illustrates the process of setting up and configuring an OLAP server.
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The table below provides links to detailed steps for each stage in the process: 

	Step
	Related content

	Install prerequisite software
	Hardware and software requirements

	Create an OLAP database from within Microsoft Dynamics AX
	Set up OLAP reporting

	Set database permissions
	OLAP Security

	Set OLAP parameters
	Set up OLAP reporting

	Import standard cube definitions
	Set up OLAP reporting

	Create and process an OLAP cube
	Create and process an OLAP cube


Set up and configure a team server

The illustration below illustrates the process of setting up and configuring a team server.
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The table below provides links to detailed steps for each stage in the process: 

	Step
	Related content

	Install prerequisite software
	Hardware and software requirements

	Install team server
	Set up a version control object server

 HYPERLINK  \l "b_8d83dc4b" 
Set up an object ID team server

	Configure version control settings
	Enable version control
Set up connection to the ID server
Deploy application objects
Deploy label file
Add rules for objects
Delete object IDs manually
Cleaning up the ID server


Flowchart: Configuring a core installation

The figure below shows the process flow to set up your system.
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Microsoft Dynamics AX allows you to add, remove and modify functionality by adjusting the relationships of the licensing, configuration and security subsystems.

Planning an implementation or upgrade

Clearly understanding your customers' needs and plans for a Microsoft Dynamics AX system can help you make good decisions as you recommend hardware and software, install, customize, and deploy a successful implementation.

The table below describes what you will find in this section.

	Topic
	Description

	System topology recommendations
	Describes recommendations for system topology.

	Planning hardware and software
	Describes hardware and software minimums.

	Planning security
	Describes considerations in planning security, including security architecture, Active Directory directory service user topology, infrastructure security, and application security.

	Planning data migration
	Describes considerations in planning data migration.

	Planning reporting
	Describes considerations in planning reporting.

	Planning maintenance and disaster recovery
	Describes considerations in planning maintenance and disaster recovery.


System topology recommendations

Before implementing an Microsoft Dynamics AX system, you should carefully plan the system topology.

Note   This topic describes network and system topologies, not how a Microsoft Dynamics AX system communicates internally. For information on architecture, see Microsoft Dynamics architecture.

Steps in planning system topology

6. With your customer, define and document:
· Number of transactions

· Number of users

· Uses of system (modules and features to be implemented)

· External user access required

· Web access required

· Required availability

· Projected growth rate

· Number of sites

7. Evaluate and document the existing infrastructure:

· Bandwidth

· Operating system

· Databases present

· Applications to integrate

8. With this information in hand, you can start to determine how to structure the system. Key decisions are:

· Whether any Microsoft Dynamics AX computer roles can be combined on a single computer, and if they can, which to combine

· Whether to create network load-balanced clusters to host the Application Object Server (AOS)

· Whether to create network load-balanced clusters to host the database

· Whether to have a cold, warm or hot backup system for the database

Core topologies

If your customer does not have users outside their domain (external users) that need to access data, you can use one of the following basic topologies.

Note   Although you can install Microsoft Dynamics AX on a single computer for development and trial purposes, we recommend that you do not install a production system on a single computer.

The figure below shows one of the more common topologies that uses three computers:
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The figure below shows a core system topology running on clustered servers.

Note   If you choose to install the application file server on the AOS cluster, it should only be installed on a single computer in the cluster.
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Enterprise Portal topologies

Enterprise Portal can be set up to run for an intranet-only scenario, or it can be set up to run in an Internet-facing scenario.

Intranet-only Enterprise Portal

The figure below shows a topology for a simple intranet-only Enterprise Portal.:
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The figure below shows a larger-scale intranet-only Enterprise Portal.
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Internet-facing Enterprise Portal

There are two recommended topologies for Internet-facing Enterprise Portal--which you use depends on the configuration of the perimeter network.

The primary difference between the two topologies is how access to Enterprise Portal is managed for external users.

The following sections describe two options for configuring a perimeter network to support Microsoft Dynamics AX.

Standard perimeter network

In this configuration, called a standard perimeter network, the Active Directory domain contains:

· All internal users to be added to Microsoft Dynamics AX.

· Special users required for Microsoft Dynamics AX functionality.

· An organizational unit containing any users from outside the organization that require Enterprise Portal access. These users' rights must be restricted in the following ways:

· Cannot log on locally

· Cannot access network

Note   The organizational unit can contain other organizational units, as long as the top node is associated with Microsoft Dynamics AX.

The following illustration shows a standard perimeter network configuration.
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Traditional perimeter network

This configuration, called a traditional perimeter network, contains two Active Directory domains. The internal domain contains:

· All internal users to be added to Microsoft Dynamics AX.

· Special users required for Microsoft Dynamics AX functionality.

· Group required for application integration server functionality.

The perimeter network contains:

· A second domain controller with a one-way trust relationship to the first domain controller that contains any users from outside the organization that require Enterprise Portal access. These users cannot have any rights in the internal domain, and their rights must be restricted in the following ways in the perimeter network domain:

· Cannot log on locally

· Cannot access network

Note   On the Enterprise Portal computer, you must override the group policy set to cannot access network to allow access to that computer.

The following illustration shows a traditional perimeter network configuration.
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Reporting server topology

Reporting server is installed on an Internet Information Services (IIS) server that is not Internet-facing.

The following illustration shows a simple reporting server topology.
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Application integration server topology

An application integration server is installed on an Internet Information Services (IIS) server that is not Internet-facing.

The following illustration shows a simple application integration topology.
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Setting up a perimeter network

Microsoft Dynamics AX ships with the Microsoft Perimeter Network Configuration Wizard. The Wizard helps you install and configure Microsoft ISA Internet Security and Acceleration (ISA) Server 2004 Service Pack 1 (SP1) as your perimeter network's firewall server. If you already have a network in place that includes a hardware firewall, you can add the Microsoft Perimeter Network as an addition to your current network setup, or use your existing perimeter network (referred to as a traditional perimeter network). For details about the topology of a traditional perimeter network see Active Directory user topology.

The Microsoft Perimeter Network Configuration Wizard also helps you install and configure your Microsoft Business Solutions applications, allowing them to be accessed by authenticated users outside of your perimeter network. The wizard supports the following Microsoft Business Solutions applications:

· Microsoft Dynamics AX Enterprise Portal

· Microsoft CRM Mobile

· Microsoft Business Solutions Great Plains Business Portal

The Wizard guides you through the following tasks:

· Installing ISA Server 2004 SP1 on your perimeter network.

· Configuring three network cards in the computer running ISA Server, one for each network: 

· Internal network 

· Perimeter network 

· Internet 

· Configuring ISA Server for the Microsoft Business Solutions products you select, and testing your configuration. 

The result is a secure network, with external access from the Internet available only to the specified Microsoft Business Solutions products. In the following figure, you can see a typical network configuration used with the Microsoft Perimeter Network Configuration Wizard. For details about how to use the Microsoft Perimeter Network Wizard, refer to the documentation for the wizard included on the Microsoft Dynamics AX DVD.
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The Microsoft Perimeter Network Configuration Wizard also supports other network configurations that include additional application and Microsoft Internet Information Servers (IIS), as required for some Microsoft Business Solutions applications. For example, Microsoft Business Solutions Great Plains Business Portal and Axapta both support multiple IIS servers. Check the implementation guide for the Microsoft Business Solutions applications you want to deploy for specific network requirements. Then, make sure you have the correct number of servers for your planned network before you begin the deployment process. The wizard is designed to support additional Microsoft Business Solutions applications as they are released.

Planning hardware and software

Choosing appropriate hardware for an Microsoft Dynamics AX installation depends on many factors, including the following:

· Number of transactions per hour

The total average number of sales orders, purchase orders, accounts payable, accounts receivable, production orders, CRM orders, and general ledger journal transactions processed per work hour is a key indicator of the size of database system you need.

· Number of concurrent users
The total number of concurrent users is a key indicator of the size of the Application Object Server system you need. It also affects the appropriate bandwidth and latency for your network.

· Number of concurrent Enterprise Portal users
The total number of concurrent Enterprise Portal users is a key indicator of the size of the Windows SharePoint Server system you need.

· Number of remote connections
The total number of remote connections you plan to run affects the appropriate bandwidth and latency for your network.

· Number of locations
The number of locations and how you need them to interact also affects your infrastructure.

This section contains the following topics:

· Hardware and software requirements
· Hardware sizing
Hardware and software requirements

Before installing a Microsoft Dynamics AX system, be sure that the system you are working with meets or exceeds the minimum hardware and software requirements.

Network requirements

The following table lists the minimum network requirements for client/server connections in a Microsoft Dynamics AX system.

	Value
	Application Object Server (AOS)
	Database

	Bandwidth (b)
	100 MB per second
	100 MB per second

	Latency (l)
	Less than 5 milliseconds
	Less than 5 milliseconds


The total response time for running a task in Microsoft Dynamics AX can be expressed by the following formula:

(Number of calls to and from the server * l) + number of bytes sent/b

Domain requirements

The computer running Microsoft Dynamics AX must also have access to computers in the same Active Directory directory service domain running Active Directory configured in native mode.

Client requirements

The following tables list the minimum hardware and software requirements for running the Microsoft Dynamics AX client from a workstation. 

Hardware requirements

This table lists hardware requirements for installing and running the Microsoft Dynamics AX client from a workstation.

	Hardware
	Minimum requirements

	Computer
	Intel Pentium/Celeron family or compatible Pentium III Xeon or higher processor minimum; 1.1 GHz or higher recommended

	Memory (RAM)
	512 MB or more recommended

	Hard disk space 1
	1 GB or more recommended

	Monitor
	Super VGA (1,024x768) or higher resolution

	Pointing device
	Microsoft Mouse or compatible pointing device

	CD-ROM drive
	Required for CD installation


1Actual requirements depend on your system configuration and the applications and features you choose to install.

Operating System Requirements

	Operating System

	Microsoft Windows XP Professional, Service Pack 2 (SP2)

	Microsoft Windows XP Tablet PC Edition, Service Pack 2 (SP2)

	Microsoft Windows Server 2003 R2, Standard Edition 1

	Windows Server 2003 R2, Web Edition 

	Windows Server 2003 R2, Enterprise Edition 1

	Windows Server 2003 R2, Datacenter Edition 1

	Windows Server 2003 with Service Pack SP1 (SP1), Standard Edition 1

	Windows Server 2003 with Service Pack SP1 (SP1), Web Edition 

	Windows Server 2003 with Service Pack SP1 (SP1), Enterprise Edition 1

	Windows Server 2003 with Service Pack SP1 (SP1), Datacenter Edition 1

	Microsoft Windows Small Business Server 2003 (Windows SBS), Standard Edition 

	Windows Small Business Server 2003 (Windows SBS), Premium Edition 

	Microsoft Windows 2000 Advanced Server with Service Pack 4 or later

	Windows 2000 Server with Service Pack 4 or later

	Microsoft Windows 2000 Professional with Service Pack 4 or later


1 Microsoft Dynamics AX is supported on the 64-bit versions of the operating systems listed, and runs in 32-bit mode if installed. 

Software Requirements

	Component
	Version
	State during installation

	Microsoft .NET Framework 1
	2.0
	Can be installed during Microsoft Dynamics AX installation

	Microsoft Windows Installer
	3.0
	Required


1 The Microsoft Dynamics AX Setup Wizard installs the US English version of the Microsoft .NET Framework version 2.0. If you need an alternate language of the .NET Framework version 2.0, you can either download and install it before installing Microsoft Dynamics AX, or you can reinstall the .NET Framework in the language of your choice after installing Microsoft Dynamics AX.

Application Object Server requirements

The following tables list the minimum hardware and software requirements for running AOS. 

Hardware Requirements

This table lists hardware requirements for installing and running an AOS instance.

	Hardware
	Minimum requirements

	Computer
	Intel or compatible Pentium III Xeon or higher processor minimum; 1.1 GHz or higher recommended

	Memory (RAM)
	512 MB or more recommended

	Hard disk space 1
	1.5 GB or more recommended

	Monitor
	Super VGA (1,024x768) or higher resolution

	Pointing device
	Microsoft Mouse or compatible pointing device

	CD-ROM drive
	Required for CD installation


1Actual requirements depend on your system configuration and the applications and features you choose to install.

Operating System Requirements

	Operating system

	Microsoft Windows Server 2003 R2, Standard Edition 1

	Windows Server 2003 R2, Web Edition 

	Windows Server 2003 R2, Enterprise Edition 1

	Windows Server 2003 R2, Datacenter Edition 1

	Windows Server 2003 with Service Pack SP1 (SP1), Standard Edition 1

	Windows Server 2003 with Service Pack SP1 (SP1), Web Edition 

	Windows Server 2003 with Service Pack SP1 (SP1), Enterprise Edition 1

	Windows Server 2003 with Service Pack SP1 (SP1), Datacenter Edition 1

	Microsoft Windows Small Business Server 2003 (Windows SBS), Standard Edition 

	Windows Small Business Server 2003 (Windows SBS), Premium Edition 


1Microsoft Dynamics AX is supported on the 64-bit versions of the operating systems listed, and runs in 32-bit mode if installed. 

Software Requirements

	Component
	Version
	State during installation

	Microsoft Data Access Components (MDAC) 

– or –

Oracle data provider
	2.80.1022.3, if Microsoft SQL Server database

– or –

10.2.0.1, if Oracle database
	Must be present before installation.

	Microsoft Internet Explorer 
	6.0, Service pack 2
	Must be present before installation.

	Microsoft .NET Framework 1
	2.0
	Can be installed during Microsoft Dynamics AX installation.

	Microsoft Windows Installer
	3.0
	Required


1 The Microsoft Dynamics AX Setup Wizard installs the US English version of the Microsoft .NET Framework version 2.0. If you need an alternate language of the .NET Framework version 2.0, you can either download and install it before installing Microsoft Dynamics AX, or you can reinstall the .NET Framework in the language of your choice after installing Microsoft Dynamics AX.

The computer running the AOS must also have access to computers in the same domain running only one of the following: 

· SQL Server 2005, Standard or Enterprise editions, with Service Pack 1 or later

· SQL Server 2000, Enterprise edition

· Oracle Database 10g, running on a Windows operating system. 

To support alerts in Microsoft Dynamics AX, you must have access to an SMTP (Simple Mail Transfer Protocol) server.

Database server requirements

The following sections list the database server requirements.

Software Requirements

A Microsoft Dynamics AX Database server requires the following components before installation. 

	Component
	Version
	State during installation

	Microsoft Data Access Components (MDAC) 
	2.80.1022.3, if Microsoft SQL Server database
	Must be present before installation


Microsoft SQL Server versions supported

Microsoft Dynamics AX supports the following versions of SQL Server. Refer to the chart to determine which versions support reporting functionality by default.

You can find the minimum hardware and operating system requirements for the version you choose on the SQL Server website. Refer to the system requirements at: http://www.microsoft.com/sql/default.mspx
	Database version 

	Microsoft SQL Server 2005, Enterprise Edition, SP1 or later 1

	SQL Server 2005, Standard edition, SP1 or later 1

	Microsoft SQL Server 2000, Enterprise Edition, SP4 or later


1Microsoft Dynamics AX is also supported on the 64-bit versions of these editions of SQL Server. 

Supported collations

This version of Microsoft Dynamics AX supports Unicode collations. The following are the requirements for the Unicode collation you select:

· Must be case-insensitive

· Must match the Microsoft Windows locale of the computers running instances of Application Object Server (AOS).

If you are setting up a new Microsoft Dynamics AX installation, we recommend that you choose a Windows collation, rather than a SQL collation. For more information about choosing a collation for a SQL Server database, see the SQL Server documentation.

Oracle Database versions supported

Microsoft Dynamics AX supports Oracle Database 10g.

Authentication requirements

Microsoft Dynamics AX requires that the database use Windows Authentication to authenticate users.

For Oracle, be sure you that have installed and configured the Windows native authentication adapter. See your Oracle documentation for details. 

Other requirements

The computer running the Microsoft Dynamics AX database server must also have access to computers in the same domain running Active Directory configured in native mode.

To support reporting functionality, the database server must also have access to a computer in the same domain running SQL Server 2005 Reporting Services, SP1 or later.

To support analysis functionality, the database server must also have access to computers in the same domain running SQL Server 2000 Analysis Services, SP4 or later, or SQL Server 2005 Analysis Services, SP1 or later.

File server requirements

You may place the Microsoft Dynamics AX application files on any Windows-based computer. There are no minimum requirements identified for the computer. The computer must be part of a domain with access to computers in the same Active Directory domain running Active Directory configured in native mode.

Note   The share where the application files are installed cannot be configured as a Distributed File System (DFS).

Reporting server requirements

The following table lists the software requirements for running a reporting server. 

Software Requirements

Microsoft Dynamics AX requires Microsoft SQL Server 2005 Reporting Services, Service Pack 1 which is available in the versions of Microsoft SQL Server listed below.

You can find the minimum hardware, software, and operating system requirements for the version you choose on the SQL Server website. Refer to the system requirements at: http://www.microsoft.com/sql/default.mspx
	Database version

	SQL Server 2005, Enterprise Edition, SP1 or later 1

	SQL Server 2005, Standard edition, SP1 or later 1


If the primary database in your Microsoft Dynamics AX system is an Oracle database server, a SQL Server database server must also be installed. 

A reporting server also requires the following components before installation. 

	Component
	Version
	State during installation

	Microsoft Data Access Components (MDAC) 

- or -

Oracle data provider
	2.80.1022.3, if SQL Server database

- or -

10.2.0.1, if Oracle database, or higher
	Must be present before installation.

	Internet Explorer
	6.0, Service pack 2
	Must be present before installation.

	Internet Information Services
	6.0
	Must be present before installation.

	Office web components
	 
	 

	Microsoft Windows Installer
	3.0
	Required


Authentication requirements

Microsoft Dynamics AX requires that the reporting server use Windows Authentication to authenticate users.

Enterprise Portal server requirements

The following sections list the Enterprise Portal server requirements..

Software Requirements

	Component
	Version
	State during installation

	Microsoft Internet Explorer 
	6.0, Service pack 2 or later
	Must be present before installation

	Microsoft .NET Framework 1
	2.0
	Can be installed during Microsoft Dynamics AX installation

	Microsoft Internet Information Services (IIS)
	6.0
	Must be present to support SharePoint 

	Microsoft SQL Server
	2000, SP3 or later

– or –

2005, SP1 or later
	Must be present to support SharePoint.

	Microsoft Windows SharePoint Services

– or –
	(version 2), SP2 - or –(version 3), Beta 2 or later
	Must be present before installation

	Microsoft Office SharePoint Server 2007
	Beta 2 or later
	 

	Microsoft Windows Installer
	3.0
	Required


1 The Microsoft Dynamics AX Setup Wizard installs the US English version of the Microsoft .NET Framework version 2.0. If you need an alternate language of the .NET Framework version 2.0, you can either download and install it before installing Microsoft Dynamics AX, or you can reinstall the .NET Framework in the language of your choice after installing Microsoft Dynamics AX.

You can find the minimum hardware and operating system requirements for the version of SharePoint you choose on the SharePoint website. Refer to the SharePoint technologies system requirements.

Authentication requirements

Microsoft Dynamics AX requires that the web server use Windows Authentication to authenticate users.

For external user access to documents and to Enterprise Portal, a firewalled perimeter network domain must have been configured, and a Business Connector Proxy account must have been set up and configured. For more information, see Set up the Business Connector proxy user.
Application integration gateway requirements

The following tables list the minimum hardware and software requirements for running an application integration gateway

AIF Web Services Requreiements

To run an application integration gateway that uses the Application Integration Framework (AIF) Web services, review the following sections.

Hardware Requirements

This table lists hardware requirements for installing and running an application integration server.

	Hardware
	Minimum requirements

	Computer
	Intel or compatible Pentium III Xeon or higher processor minimum; 1.1 GHz or higher recommended

	Memory (RAM)
	512 MB or more recommended

	Hard disk space 1
	1.5 GB or more recommended

	Monitor
	Super VGA (1,024x768) or higher resolution

	Pointing device
	Microsoft Mouse or compatible pointing device

	CD-ROM drive
	Required for CD installation


1Actual requirements depend on your system configuration and the applications and features you choose to install.

Operating System Requirements

	Operating system

	Microsoft Windows Server 2003 R2, Standard Edition 1

	Windows Server 2003 R2, Web Edition 

	Windows Server 2003 R2, Enterprise Edition 1

	Windows Server 2003 R2, Datacenter Edition 1

	Windows Server 2003 with Service Pack SP1 (SP1), Standard Edition 1

	Windows Server 2003 with Service Pack SP1 (SP1), Web Edition 

	Windows Server 2003 with Service Pack SP1 (SP1), Enterprise Edition 1

	Windows Server 2003 with Service Pack SP1 (SP1), Datacenter Edition 1

	Microsoft Windows Small Business Server 2003 (Windows SBS), Standard Edition 

	Windows Small Business Server 2003 (Windows SBS), Premium Edition 


1Microsoft Dynamics AX is supported on the 64-bit versions of the operating systems listed, and runs in 32-bit mode if installed. 

Software Requirements

	Component
	Version
	State during installation

	Microsoft Internet Explorer 


	6.0, Service pack 2 or later
	Must be present before installation

	Microsoft .NET Framework 1
	2.0
	Can be installed during Microsoft Dynamics AX installation

	Microsoft Internet Information Services
	6.0
	Must be present for configuration.

	Microsoft Windows Installer
	3.0
	Required


1 The Microsoft Dynamics AX Setup Wizard installs the US English version of the Microsoft .NET Framework version 2.0. If you need an alternate language of the .NET Framework version 2.0, you can either download and install it before installing Microsoft Dynamics AX, or you can reinstall the .NET Framework in the language of your choice after installing Microsoft Dynamics AX.

Authentication requirements

Microsoft Dynamics AX requires that IIS 6.0 be installed and that it use Windows Authentication to authenticate users.

BizTalk Server Adapter Requreiements

To run an application integration gateway that uses the BizTalk Adapter for Microsoft Dynamics AX, review the following sections.

The BizTalk Adapter for Microsoft Dynamics AX runs on Microsoft BizTalk Server 2006. You can find the minimum hardware and operating system requirements for BizTalk Server on the BizTalk website. Refer to the system requirements at: http://www.microsoft.com/biztalk/default.mspx
OLAP (Online analytical processing) server requirements

The following table lists the software requirements for running an OLAP server. 

Software Requirements

Microsoft Dynamics AX supports the following versions of Microsoft SQL Server Analysis Services.

You can find the minimum hardware and operating system requirements for the version you choose on the SQL Server website. Refer to the system requirements at: http://www.microsoft.com/sql/default.mspx
	Version 

	SQL Server 2005 Analysis Services, SP1 or later

	SQL Server 2000 Analysis Services, SP4


If the primary database in your Microsoft Dynamics AX system is an Oracle database server, a SQL Server database server must also be installed to support OLAP. 

Authentication requirements

Microsoft Dynamics AX requires that the OLAP server use Windows Authentication to authenticate users.

OLAP (Online analytical processing) client requirements

To use a computer as an OLAP client for Microsoft Dynamics AX, it must have a Microsoft Dynamics AX client installed.

Requirements for clients connecting to systems running SQL Server 2000 Analysis Services

The following components are required for clients that are connecting to systems running SQL Server 2000 Analysis Services. 

Note   The components must be installed in the order specified.

	Component
	Version
	State during installation

	Microsoft SQL Server 2000 PivotTable Services
	 
	Can be installed after Microsoft Dynamics AX installation. All components are available in the downloadable Feature Pack for Microsoft SQL Server 2005.

Note   If a client must be able to connect to both SQL Server 2000 and SQL Server 2005 Analysis Services data sources, this component must be the first installed.

	Microsoft Office Web Components 11 (OWC11) 
	2003
	Can be installed after Microsoft Dynamics AX installation. 

Available from this location as a download: http://go.microsoft.com/fwlink/?LinkId=47538 

By installing the Office Web Components tool, users can view published components and data access pages on the Web without having to install Office 2003. 

Note   If you do not own an Office 2003 license, the Office Web Components are licensed to be used in static, non-interactive, client-side, view-only mode. If you do own an Office 2003 license, the Office Web Components are licensed to be used in interactive mode.


Requirements for clients connecting to systems running SQL Server 2005 Analysis Services

The following components are required for clients that are connecting to systems running SQL Server 2005 Analysis Services. 

Note   The components must be installed in the order specified.

	Component
	Version
	State during installation

	Microsoft Core XML Services (MSXML) 
	6.0
	Can be installed after Microsoft Dynamics AX installation. All components are available in the downloadable Feature Pack for Microsoft SQL Server 2005.

	Microsoft SQL Server 2005 Analysis Services OLE DB Provider
	9.0
	Can be installed after Microsoft Dynamics AX installation. All components are available in the downloadable Feature Pack for Microsoft SQL Server 2005.

	Microsoft SQL Server Native Client
	 
	Can be installed after Microsoft Dynamics AX installation. All components are available in the downloadable Feature Pack for Microsoft SQL Server 2005. 

Note   This component is not required if the client does not need to create or configure cubes.

	Microsoft SQL Server 2005 Analysis Management Objects (AMO) Collection
	 
	Can be installed after Microsoft Dynamics AX installation. All components are available in the downloadable Feature Pack for Microsoft SQL Server 2005.

Note   This component is not required if the client does not need to create or configure cubes.

	Microsoft Office Web Components 11 (OWC11) 
	2003
	Can be installed after Microsoft Dynamics AX installation. 

Available from this location as a download: http://go.microsoft.com/fwlink/?LinkId=47538 

By installing the Office Web Components tool, users can view published components and data access pages on the Web without having to install Office 2003. 

Note   If you do not own an Office 2003 license, the Office Web Components are licensed to be used in static, non-interactive, client-side, view-only mode. If you do own an Office 2003 license, the Office Web Components are licensed to be used in interactive mode.


Hardware and performance

Microsoft publishes benchmarking and performance information as technical articles, which are available at Microsoft Dynamics AX Online.
Planning security

Planning security for any Microsoft Dynamics AX system that you implement enables your customers to help protect their business assets and maintain their system security in the future. It also lets you and your customers evaluate the security risk the customer is willing to accept, and document any tradeoffs you make.

Any system you design for a customer should follow Microsoft standard guidelines for enterprise application security. It should be:

· Secure by design

· Secure by default

· Secure in deployment.

For the latest information on security, refer to the TechNet Security Center. It provides security tools, security response information, such as security bulletins and virus alerts, and the most prescriptive security guidance Microsoft has to offer to assist IT Professionals in securing their systems.

We recommend that you review the security architecture then plan the system's security in the phases listed described in the topics in this section. 

This section contains the following topics:

· Security architecture
· Plan Active Directory user topology
· Plan infrastructure security
· Plan Microsoft Dynamics AX security
· Maintaining privacy in Microsoft Dynamics AX
Security architecture

Microsoft Dynamics AX security architecture consists of infrastructure security and application security.

Infrastructure security

Microsoft Dynamics AX infrastructure security is built on:

· Active Directory directory services configured in native mode. For details about Active Directory user topology, see: Active Directory user topology. For information about configuring Active Directory, see the Microsoft Windows Server 2003 Active Directory Technology Center.

· Integrated Windows authentication.

· A perimeter network with a firewall for Internet-facing Enterprise Portal.

· Secured servers. Many of the servers running Microsoft Dynamics AX components have specific security requirements. For details, see Plan infrastructure security.

Follow recommended Microsoft practices for securing the servers you are running, and stay up-to-date on understanding and implementing recommendations that make sense for your environment. For the most recent guidance, see the Microsoft Technet Security Center.

Application security

The application security architecture of Microsoft Dynamics AX includes the features listed below. For more information about creating secure applications, see Microsoft Dynamics AX Security.

· Active Directory users that have been added to Microsoft Dynamics AX. Users that are not in Active Directory cannot be added. Users cannot be granted permissions directly.

· Microsoft Dynamics AX user groups that are granted permissions. 

By adding a user to a group, you grant that user all the permissions assigned to that group. Users that are not assigned to groups cannot access Microsoft Dynamics AX. A user can be a part of more than one group; that user inherits the highest permissions level of the two groups.

Caution   An Administrator User and an Administrators group are created the first time a Microsoft Dynamics AX client is run. Administrators have complete access to all forms, menus, tables, reports, and the Application Object Tree (AOT). Restrict the number of users in the Administrators group. 

· Domains that are groups of company accounts.

Domains make it easier to maintain user group security if several companies use the same Microsoft Dynamics AX system, and have similar security needs. Domains enable you to restrict permissions to user groups to a single company, or to set up user groups with permissions to data across companies. The domains feature requires a separate license.

· Security keys that control access to menu items, forms, reports, and fields within a form.

Security keys are disabled by default, and can be set for user group/domain combinations. Only administrator users and those accessing Microsoft Dynamics AX with a developer license have all security keys enabled by default.

· Table and field security that allow you to restrict access and changes to a table.

· Record-level security that allows you to set permissions on rows in tables, to restrict access to particular sections of a table.

No record-level security is set by default.

Active Directory user topology

Before you install or deploy Microsoft Dynamics AX, carefully plan the user topology of your Active Directory directory service.

All Microsoft Dynamics AX users must first be defined in Active Directory. The computers running Microsoft Dynamics AX must have access to computers in the same domain running Active Directory configured in native mode.

Document Active Directory structures

Work with the system administrator at the customer site to understand the existing Active Directory structures.

Existing Active Directory structures do not require modifications to be used to support Microsoft Dynamics AX users within the domain. If your customer has a site with Active Directory domains, and all the domains in the forest are set up with two-way trust, Microsoft Dynamics AX will recognize all the users in the domain after they have been imported. For details, see Import users from Active Directory.

If your customer does not have Active Directory installed and configured, refer them to the best practices in the Microsoft Windows Server 2003 Deployment Kit chapter on Designing and Deploying Directory and Security Services, located at the Microsoft Windows Server 2003 Active Directory Technology Center. 

Determine whether users external to the domain require access through Enterprise Portal

If external user access to Enterprise Portal is required, domain accounts must be set up for the external users. The location of the external user domain accounts depends on the structure of the customer's perimeter network. For details about setting up external user access see Set up Web users.

The following sections describe two options for configuring a perimeter network to support Microsoft Dynamics AX.

Standard perimeter network

In this configuration, called a standard perimeter network, the Active Directory domain contains:

· All internal users to be added to Microsoft Dynamics AX.

· Special users required for Microsoft Dynamics AX functionality. 

· An organizational unit (OU) that contains any users external to the organization who require Enterprise Portal access. These users' rights must be restricted in the following ways:

· Cannot log on locally

· Cannot access the network

Note   The organizational unit can contain other organizational units, but the top node must be associated with Microsoft Dynamics AX. 

You can use the Microsoft Business Solutions Perimeter Network Wizard configuration tool to quickly set up a standard perimeter network after you set up your organizational unit. For details, see Setting up a perimeter network. 

The following illustration shows a standard perimeter network configuration.
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To set up external users, follow this process:

· Create a new organization unit (OU) for external users. All external users must be created under this OU or a subsidiary OU.

· Create a security group. All external users must be added to this group.

· Create a Group Policy Object (GPO), and link the GPO to the security group. 

Follow the procedures below from the domain controller computer to set up external users in a Windows Server 2003 domain. If you are running a Windows 2000 domain, see the Windows 2000 Group Policy documentation for details. 

Create an organizational unit

9. On the domain controller computer, open the Active Directory Users and Computers management console (click Start > Administrative Tools > Active Directory Users and Computers).
10. In the left pane, right-click the domain, and then click New > Organizational Unit.

11. Enter a name for the OU, and then click OK.

Create a security group

12. In the Active Directory Users and Computers management console, right-click Users, click New, and then click Group.
13. Enter a name for the group, under Group Scope click Global, under Group type click Security, and then click OK.

14. Add all external users to the security group that you created.

Create Group Policy Object links

15. In the left pane of the Active Directory Users and Computers management console, right-click the domain, and then click Properties.
16. On the Group Policy tab, click New, and then enter a name for the Group Policy object link.

17. In the Group Policy Object Links list, select the link you created, and then click Edit.

The Group Policy Object Editor window opens.

18. In the left pane, expand Computer Configuration > Windows Settings > Security Settings > Local Policies > User Rights Assignment.

19. Double-click Deny access to this computer from the network.

20. Select Define these policy settings, click Add User or Group, and then click Browse. 

21. In the Enter the object names to select box, enter the name of the security group that you created for external users, click Check Names, and then click OK to close all open dialog boxes and return to the Group Policy Object Editor. 

22. Repeat steps 5 through 7 for the Deny log on locally user right.

23. In the left pane, right-click the root node (your new Group Policy Object) and click Properties.

24. On the Security tab, click Add, enter the computer name of the server running Internet Information Services (IIS), and click OK.

25. In the Permissions for Authenticated Users list, select Deny under Apply Group Policy, and then click OK.

26. Close the Group Policy Object Editor and the Properties dialog box.

27. Use the gpupdate command to force a Group Policy update on all other computers in your environment.

Traditional perimeter network

A traditional perimeter network contains two Active Directory domains. 

The internal domain contains: 

· All internal users to be added to Microsoft Dynamics AX.

· Special users required for Microsoft Dynamics AX functionality.

· Group required for application integration server functionality.

The perimeter network contains:

· A second domain controller with a one-way trust relationship to the first domain controller. The domain controller contains any users external to the organization who require Enterprise Portal access. These users cannot have any rights in the internal domain, and their rights must be restricted in the following ways in the perimeter network domain:

· Cannot log on locally

· Cannot access the network

Note   On the Enterprise Portal computer, you must override the group policy set to Cannot access network to allow access to that computer.

The following illustration shows a traditional perimeter network configuration.
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Create special accounts for required functionality

The following features require dedicated domain accounts.

Reporting Server account

During setup, you must provide an existing domain account for the Microsoft Dynamics AX reporting server to use to connect to a Microsoft SQL Server data source and to retrieve data. We recommend that the account have a password that does not expire, and be set up as follows:

On the Microsoft Dynamics AX Database computer (if a SQL Server):

· Not a member of any groups (not a member of the Users group)

· No positive privileges should be granted

· Deny logon locally

· Deny logon through Terminal Services.

On the Reporting Services computer:

· Not a member of any groups (such as the Users group)

· No positive privileges should be granted

· Should have Deny logon through Terminal Services

· Should have Deny access to this computer through the network

· Must not be denied the ability to log on locally.

This account is granted read-only access to the Microsoft Dynamics AX database (or, in the case of an Oracle database, the SQL Server data source linked to the database).

Business Connector

A domain account to act as the Business Connector Proxy is required when you configure the Business Connector if your application requires "act-on-behalf-of" functionality. We recommend that the account be set up as follows:

· Password does not expire

· No interactive logon rights

The Business Connector Proxy domain account should not be set up as an Microsoft Dynamics AX user.

Infrastructure security considerations

The first step in helping to secure Microsoft Dynamics AX is to make sure that it is deployed in a secure environment. An Microsoft Dynamics AX system requires:

· Active Directory directory service configured in native mode. For details about Active Directory user topology, see Active Directory user topology. For information about configuring Active Directory, see the Microsoft Windows Server 2003 Active Directory Technology Center.

· For an Internet-connected Enterprise Portal, a network with a firewall configured either with one domain controller or with two domain controllers - one inside the internal network, and one in the perimeter network. For details about configuring Active Directory to work with perimeter networks, see Active Directory user topology.

Follow recommended Microsoft practices for securing the underlying servers you are running, and stay up-to-date on understanding and implementing recommendations that make sense for your environment. For the latest information on security, refer to the TechNet Security Center.

Security requirements for Microsoft Dynamics AX Servers

All servers must be using Microsoft Windows authentication. Depending on the functionality that you implement, Microsoft Dynamics AX may also require that you use domain accounts with specific permissions. For details, see Plan Active Directory user topology.

The following table describes the security settings we recommend that you implement.

	Server
	Set

	Application file server
	The folder containing the application files should be restricted to the Application Object Server (AOS) account (the domain account or Network Service account that is associated with the AOS service) and administrators only. 

	Database server
	Be sure that you have followed recommended practices for securing your database. If you are running a Microsoft SQL Server, for the latest information on SQL Server security, see the SQL Server TechCenter.

	Application Object Server
	The log directory cannot be changed--the log is always installed to installationdirectory\log. Restrict access to the directory to administrators and the AOS account.

If you are using a domain account for the AOS account, use an account with the following rights: 

· Log on as a service

· No positive privileges should be granted

	Enterprise Portal
	The computer running Microsoft Internet Information Services (IIS) must be configured to have Basic authentication over secure socket layers (SSL) as the only supported mechanism for Internet login.

The Enterprise Portal server can be either in the perimeter network and Internet-facing, or inside the internal network.

Note   The Enterprise Portal is dependent on the Business Connector proxy user, described below.

Be sure that you have followed recommended Microsoft practices for securing IIS and Microsoft Windows SharePoint Services. 

· For the latest information about IIS security, see the IIS 6.0 documentation. 
· For the latest information about Windows SharePoint Services security, see the Windows SharePoint Services TechCenter.

	Business Connector proxy user
	A Windows domain account that acts as the Business Connector Proxy is used to support "act-on-behalf-of" functionality. This functionality is used by Enterprise Portal for external users or users that are at times unable to connect to your application. Other applications can leverage this functionality. We recommend that the account be set up as follows: 

· Password does not expire. 

· No interactive logon rights.

	Application Integration Framework (AIF) Web services
	The computer running the Application Integration Framework (AIF) Web services must be inside the internal domain and not Internet-facing.

The server requires the local Windows group Dynamics AX Web Service Administrators, which is created by Setup. 

Be sure that you have followed recommended Microsoft practices for securing IIS. For the latest information on IIS security, see the IIS 6.0 documentation. 

	Reporting server
	The computer running reporting server must be inside the internal domain and not Internet-facing.

The reporting server requires a dedicated domain account set up with a password that does not expire, and with the following rights.

· On the Microsoft Dynamics AX Database computer (if it is a Microsoft SQL Server):

· Not a member of any groups (not a member of the Users group)

· No positive privileges should be granted

· Deny log on locally 

· Deny logon through Terminal Services.

· On the SQL Server Reporting Services computer:

· Not a member of any groups (for example, should not be a member of the Users group)

· No positive privileges should be granted

· Should have Deny access through Terminal Services

· Should have Deny access to this computer through the network

· Must not be denied the ability to log on locally.

Be sure that you have followed recommended Microsoft practices for securing IIS and SQL Server Reporting Services. For the latest information on IIS security, see the IIS 6.0 documentation. For the latest information on SQL Server Reporting Services security, see the SQL Server TechCenter.


Security requirements for Microsoft Dynamics AX clients

The following table lists the security requirements for all Microsoft Dynamics AX Clients:

	Client
	Requirement

	Desktop client
	If no local configuration file is present, must have read permissions on the file share where a shared configuration file is stored.

	Business Connector proxy user
	A Windows domain account that acts as the Business Connector Proxy is used to support "act-on-behalf-of" functionality. This functionality is used by Enterprise Portal for external users or users that are at times unable to connect to your application. Other applications can leverage this functionality. We recommend that the account be set up as follows: 

· Password does not expire. 

· No interactive logon rights.


Computer accounts used for server connections

The following computer accounts are used to communicate between servers: 

	Server computer and account
	Function

	Object server, AOS account (the domain account or Network Service account that is associated with the AOS service) 
	Communicates with database server, granted rights as user in database.

	Database server, Local System
	MSSQL service must be running under Local System.


Application security considerations

Microsoft Dynamics AX allows you to add, remove and modify functionality by adjusting the relationships of the licensing, configuration and security subsystems.

· Licensing – The licensing system allows a customer to unlock purchased sets of functionality for use within an installation.

For information about the relationship and dependencies of the different licenses, see License codes.

· Configuration Keys – The configuration key system allows an administrator to set the availability of functionality for the entire system. These modifications are to subsets of a module's functionality that are not currently necessary to have enabled within the system. From a security perspective, the removal of unused functionality reduces the surface that is open to attack.

For information about the relationship among configuration keys, see Configuration keys.

· Security system – The security system allows an administrator to control access to system elements (such as forms, menu items, and tables). These settings are set by user group and domain combinations.

For instructions about setting up your security, see Set up application security.

Configuration hierarchy

The figure below shows the configuration hierarchy for security in an Microsoft Dynamics AX system.
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Components of application security

The application security architecture of Microsoft Dynamics AX consists of: 

· Active Directory directory service users that have been added to Microsoft Dynamics AX
Users that are not in Active Directory cannot be added. Users cannot be granted permissions directly.

For information about setting up users, see User configuration and security.

· User groups in Microsoft Dynamics AX that are granted permissions

By adding a user to a group, you grant that user all the permissions assigned to that group. Users that are not assigned to groups cannot access Microsoft Dynamics AX. A user can be a part of more than one group and that user inherits the highest permissions level of the groups in which they are members.

Caution   By default, an Administrator User and an Administrators group are created the first time a Microsoft Dynamics AX client is run. Administrators have complete access to all forms, menus, tables, reports, and the Application Object Tree (AOT). Permission settings in the Administrators group cannot be altered. Restrict the number of users in the Administrators group.

For information about setting up user groups, see User group configuration and security.

· Domains that are groups of company accounts

Domains make it easier to maintain user group security if several companies use the same Microsoft Dynamics AX system, and have similar security needs. Domains enable you to restrict permissions for user groups to a single company, or to set up user groups with permissions to data across companies. The domains feature requires a separate license. 

For information about how to add licenses, see Add license keys.

For information about setting up company accounts and domains, see Company accounts and security and Domains and security.

· Security keys that control access to menu items, forms, reports, and fields within a form

Security keys are disabled by default, and can be set for user group/domain combinations. Only administrator users and those accessing Microsoft Dynamics AX with a developer license have all security keys enabled by default.

For information about refining your security system, see Security keys and Table and field access.

· Record-level security that allows you to set permissions on rows in tables, to restrict access to particular sections of a table

No record-level security is set by default.

For information about setting up these further restrictions, see Manage record-level security.

Best practices

By following a few simple rules in administration, you can increase the security of your Microsoft Dynamics AX environment:

· There is no need for Microsoft Dynamics AX users to have administrative privileges over the domain, so all Microsoft Dynamics AX user accounts should reside in restricted, well-defined User Groups. Also, following the principle of least privilege, anyone using the Microsoft Dynamics AX system should have minimal rights. This starts at the domain level. A domain user account should be created and used to run Microsoft Dynamics AX.

· If you are uncertain about whether to allow permission to a certain item, leave the permissions level set to No access. It is better to deny permission to an item and force an individual to request permission for their group than to grant permission to an area that a group should not be able to access.

· Restrict the number of users who are members of the Administrators group, which has access to all fields, tables, reports, and modules in Microsoft Dynamics AX by default. If users are made members of the Administrators group, they can potentially view reports or data they should not be allowed to see, or change configurations and business logic in the system. Ideally, only those individuals who are configuring and administering Microsoft Dynamics AX should be members of the Administrators group. Access in the Administrators group cannot be altered.

· Work with managers who oversee the different groups in your business or organization to determine permission levels. For example, work with a manager in the Finance department to determine permissions levels for the Finance group or groups. The manager knows which groups should have permissions to items like General ledger and Bank, including permissions on child nodes.

· Passwords should never be used across systems and domains. For example, an administrator responsible for two domains may create Domain Administrator accounts in each that use the same password, and even set local administrator passwords on domain computers that are the same across the domain. If this happens, a compromise of a single account or computer could lead to a compromise of the entire domain. Passwords should never be reused in this way.

· Service accounts should never be domain administrator accounts, and they should be limited in privilege as much as possible. Domain Administrator accounts are commonly used as service accounts for common services such as backup systems. However, it is a security risk to use Domain Administrator accounts as service accounts, because the password must be stored, or cached, locally on every computer where the service resides. The password can easily be retrieved by anyone with administrative rights over the computer. If this happens, the compromise of a single computer could lead to a compromise of the entire domain. Service accounts should never be domain administrator accounts, and they should be limited in privilege as much as possible.

· If you change permissions for a user group, especially if you demote permissions, restart the server after making the change. If you do not restart the server, members of the group might retain their former permissions until the next time the server is restarted. 

As a best practice, ask members of a group to log off Microsoft Dynamics AX before changing permissions and inform all Microsoft Dynamics AX users of the impending server restart. If necessary, before changing user group permissions, select users in User group permissions (Administration > Online users) and click End sessions. 

For more information, see Remove users.

Maintaining privacy in Microsoft Dynamics AX

As you implement a Microsoft Dynamics AX system, work with your implementation team to help ensure that any personal information stored in your system is secured in accordance with the rules and regulations of the countries you operate in. 

Personal information is any information relating to an identified or identifiable individual. Such information may include name, country/region, street address, e-mail address, credit card number, Social Security number, government identification number, IP address, or any unique identifier that is associated with personal information in another system.

Personal information collection

If you choose to send error reports to Microsoft, personal information could be unintentionally collected by Microsoft Dynamics AX. If it is present, it will not be used to identify you or anyone in your corporation. You can review the data collection policy for the Microsoft Error Reporting engine on the Microsoft Online Crash Analysis site.

You may choose to collect personal information using axapta from customers, employees, and vendors as part of your business processes. It can be collected directly from customers registering through Enterprise Portal, or it can be collected by an employee on behalf of a customer or another employee.

Personal information storage

In a Microsoft Dynamics AX system, you may store personal information in the Microsoft Dynamics AX database. The following list includes some, but not necessarily all tables that may contain personal information:

· Any table that begins with BANK

· Any table that begins with COMMISSION

· COMPANYINFO

· CONTACT

· CUSTTABLE

· EMPLTABLE, and any other table that starts with EMPL

· ECPCUSTSIGNUP

· Any table that begins with HRM

· SYSCOMPANYUSERINFO

· USERINFO

· VENDTABLE

Recommendations for managing access to personal information include: 

· As part of your business processes, document and communicate appropriate policies and procedures.

· Within the Microsoft Dynamics AX client, restrict access to forms that may contain personal information to only those groups of employees that require access for business reasons. For details, see Set up application security.

· Restrict access to reports that may list personal information to only those groups of employees that require access for business reasons. For details, see Set up application security.

· Restrict direct access to the Microsoft Dynamics AX database to Microsoft Dynamics AX administrators only. See your database documentation on controlling access.

Personal information transmission

The primary means that you may use to transmit personal information when using Microsoft Dynamics AX are through Enterprise Portal or by using the Application Integration Framework (AIF). Transmission of personal information should be as secure as possible. See the following topics for details on helping to secure Enterprise Portal and AIF: 

· Manage Enterprise Portal security
· Securing the Application Integration Framework
Planning data migration

Planning how to migrate from the current ERP system to Microsoft Dynamics AX is critical for a successful data migration process. It is impossible to offer a step-by-step guide for planning data migration, but you should consider the following issues when planning the process:

· Determine whether and how you can extract data from the current system. 

If the current system's data can be extracted into a Microsoft Excel spreadsheet, then Microsoft Dynamics AX Excel templates can be used to import the data into Microsoft Dynamics AX. For more information about Importing using the Excel template wizard, see AdminCreateTemplateInExcel
If the current data cannot be extracted into a spreadsheet, then you can create a custom import file, or data can be entered manually. A custom import file allows the user to define criteria, set delimiters, and map each field to Microsoft Dynamics AX.

· Will you be importing master data (Customers, Vendors, Items, and Ledger accounts)? 

If you will, then the setup required for those files must be completed before performing the import. Field names and values in Microsoft Dynamics AX may be different than that of the current system. It may help you to create a record manually to understand all of the available Microsoft Dynamics AX fields and how they correspond to the current system. 

It is also a good time to consider cleaning the database. Are there old records that can be deleted or archived? Does your current database contain duplicate records? Do you want to change numbering schemes?

· Financial data is imported into an Microsoft Dynamics AX journal, but it is not imported directly into data files. 

Because of the complex file structures in Microsoft Dynamics AX, financial data should never be imported directly into the data file, since this causes inconsistencies in other files. 

If financial data is going to be manually entered, data is entered into a journal. After the financial data has been converted into a journal, the journal can then be reviewed and posted. When the journal is posted, all of the necessary Microsoft Dynamics AX files are updated. 

· Almost any table can be imported into Microsoft Dynamics AX, but it may be easier or more effective to enter some tables manually. 

For example, many of the setup screens, such as Terms of payment, do not have many records, so it is faster to enter them manually.

Note   Create a backup before importing any data into Microsoft Dynamics AX. A hard copy backup should be performed by your system administrator. An online backup in Microsoft Dynamics AX can be created by copying the company's information to a newly created company.

Planning reporting

Microsoft Dynamics AX includes the following options for creating and viewing reports of your business data:

· Standard reports: Microsoft Dynamics AX includes hundreds of reports to help you analyze your business data. Standard reports are located in the Reports folder in each section.

· Ad hoc reports: Ad hoc reporting enables technical users to dynamically create, customize, and run reports. Ad hoc reporting is a powerful tool for day-to-day business analysis. For more information about ad hoc reporting, see Introduction to ad hoc reporting.

· Online analytical processing (OLAP) reports: OLAP reporting is typically used for month-end, quarter-end, or year-end business analysis. OLAP can help business decision-makers identify key trends in their data, which can aid business forecasting. For more information about OLAP reporting, see Introduction to OLAP Reporting.

This topic describes important planning considerations for standard, ad hoc, and OLAP reporting. For specific set up and configuration information, including hardware and software requirements, see Set up and configure ad hoc reporting or Set up and configure OLAP reporting.

Overview of reporting features

The following table provides an overview of Microsoft Dynamics AX reporting features.

	 
	Standard
	Ad hoc
	OLAP

	Requires separate  Business Analysis license 
	No
	Yes
	Yes

	Uses a SQL Server reporting feature
	No
	Yes, Reporting Services
	Yes, Analysis Services

	Requires maintenance on the part of an administrator
	Very little. Must maintain user group permissions for report access
	No
	Yes. Cubes can be processed as a batch. If you modify a cube definition, cubes must be retransferred and permissions must be reset.

	By default, reports return data for multiple companies
	No
	Yes
	No, but you can create a separate cube for each company

	By default, reports allow multiple currencies
	No
	Yes
	No, but you can create a separate cube for each currency

	Reports are easily customizable
	No
	Yes
	Yes


Planning standard reporting

The most important planning consideration for standard reporting is report access, in which you determine who can view and print standard reports by granting permissions to the report when you create user groups. If members of a group must not be able to view or print a report, do not grant that group access to the Reports folder in a given section.

For information about creating user groups, see Manage user groups. For information about setting user group permissions, see Manage permissions.
Planning ad hoc reporting

Important considerations include:

· Acquire license for Business Analysis in Microsoft Dynamics AX.

Contact your Microsoft partner.

· Configure replicated read-only reporting database(s) (recommended).

The process of generating report models can consume memory and CPU resources on the database server. Therefore, we recommend that you replicate your primary Microsoft Dynamics AX database and configure Reporting Services to generate models from the replicated database. For information about how to replicate your database, see the SQL Server books online.

· Determine a batch schedule for updating models (if needed).

How often you update report models depends on the needs of the business-decision makers in your organization or business. If models are not updated periodically, ad hoc reports will contain outdated data. Model generation batch options are configured on the Model generation options form (Administration > Setup > Business analysis > Reporting Services > Model generation options) Click the Update models button and then the Batch tab.

· Decide on the number of Reporting Services instances (or separate servers) to have (for example, geographically separated instances).

· Establish a disaster recovery plan for Reporting Services reports and report models.

For information about backing up reports and report models, see the SQL Server Reporting Services online Help.

· Install and configure SQL Reporting Services.

See Install and configure a reporting server for ad hoc reporting.

· Review the guidelines and best practices in Ad hoc reporting security. 

· Identify ad hoc reporting users. Create groups and set permissions in Microsoft Dynamics AX.

For information about creating user groups, see Manage user groups. For information about setting user group permissions, see Manage permissions.

· Identify the data that will be used in report models. Use the standard perspectives or create new perspectives for report models. 

For more information about perspectives and models, see Create an ad hoc report model.

· Configure report model options on the Model generation options form (Tools > Reporting tools).

· Manually generate a report model: Tools > Reporting tools > Model generation options > Update models.

· Set batch mode options for generating a model: Tools > Reporting tools > Update models > Batch tab

· Create and run test report(s) that use the generated models. 

For more information about creating ad hoc reports, see Create ad hoc reports.

Planning OLAP reporting

Important considerations include:

· Acquire license for Business Analysis in Microsoft Dynamics AX.

Contact your Microsoft partner.

· Review Microsoft SQL Server Analysis Services security topics.

· Identify who will be using this feature. Create user groups (if necessary). Set permissions in Microsoft Dynamics AX and in Analysis Services.

For information about creating user groups, see Manage user groups. For information about setting user group permissions, see Manage permissions.

· Identify the data used in OLAP cubes (work with a developer if necessary). Based on reporting needs, develop reporting queries in Microsoft Dynamics AX AOT. Develop cube definitions based on these queries or start using the 15 sample cube definitions provided in the product.

For more information, see Create and process an OLAP cube.

· Determine batch processing schedule.

· Configure SQL Analysis Services (2000 or 2005).  Decide on the number of Analysis Services servers to have. 

For more information, see the SQL Server Books online.

· If using an Oracle database, manually create a data source in SQL Analysis Services.

For more information, see Set up an OLAP server to work with an Oracle database.

· Set up OLAP reporting in Microsoft Dynamics AX.

· Create and process an OLAP cube
· View OLAP reports
Planning maintenance and disaster recovery

Maintenance and disaster recovery are two key elements in planning your implementation.

Planning maintenance

A Microsoft Dynamics AX system, like any other software system, requires ongoing maintenance. Routine maintenance can include the following: 

· Database backup and restore

· Application file backup and restore

· Alerts on specific events that you want to monitor, either in Microsoft Dynamics AX or in the database. 

Determine a maintenance strategy that meets your company's needs before implementing your system. Remember to plan and implement a maintenance strategy for all the environments you are running: production, development, and test.  

Database backup and restore

Implementing a well-planned backup and restore strategy protects databases against data loss due to damage caused by a variety of failures. Testing your strategy by restoring a set of backups and recovering your database prepares you to respond effectively to a disaster. 

A backup is a copy of data that is used to restore and recover data after a system failure. Backups allow you to restore data after a failure. With proper backups, you can recover from many failures, including: 

· Media failure.

· User errors (such as dropping a table by mistake).

· Hardware failures (such as a damaged disk drive or permanent loss of a server).

· Natural disasters.

Additionally, backups of a database are useful for routine purposes, such as copying a database from one server to another, setting up database mirroring, archiving for governmental purposes, and disaster recovery. Refer to your database documentation for details about how to choose and implement a backup and restore strategy.

Remember to include all the databases in your Microsoft Dynamics AX system in your backup and restore strategy. These databases can include: 

· A Microsoft Dynamics AX database, either SQL Server or Oracle

· A SharePoint database to support Enterprise Portal

· A SQL Server 2005 Reporting Services database to support ad hoc reporting

· A SQL Server Analysis Services database to support OLAP reporting
Application file backup and restore

The application files are the files in which the Microsoft Dynamics AX business logic is stored. They are located by default in the Program Files\Microsoft Dynamics AX\40\Application\Appl\Standard directory. Examples of the files in this directory include indexes, headers, and labels for each layer. Like a database, you should regularly back up the application files, so that in the event of a failure, you can recover. Refer to your operating system documentation for details about how to choose and implement a file backup and restore strategy. 
Alerts

You can use alerts in Microsoft Dynamics AX, your database, and the Windows Event log to monitor specific events in the system. Use alerts to monitor available disk space, system up-time, and user activity. For details about how to use alerts, see Managing alerts, your database documentation, and your operating system documentation.

Planning disaster recovery

To ensure that all your systems and data can be quickly restored to normal operation in the event of a natural disaster, you must create a disaster recovery plan. When you create this plan, consider scenarios for different types of disasters that might impact your shop, including natural disasters, such as a fire, and technical disasters, such as a two-disk failure in a RAID-5 array. When you create a disaster recovery plan, identify and prepare for all the necessary steps to respond to each type of disaster. Testing the recovery steps for each scenario is essential. Microsoft recommends that you verify your disaster recovery plan through the simulation of a catastrophic event.

Consider disaster recovery planning in light of your particular environmental and business needs. For example, suppose a fire occurs and wipes out your 24-hour data center. Are you certain you can recover? How long will it take you to recover and have your system available? How much data loss can your users tolerate?

Ideally, your disaster recovery plan states how long recovery will take and the final database state the users can expect. For example, you might determine that after the acquisition of specified hardware, recovery will be completed in 48 hours, and data will be guaranteed only until the end of the previous week.

A disaster recovery plan can be structured in many different ways and can contain many types of information. Disaster recovery plan types include the following:

· A plan to acquire hardware.

· A communication plan.

· A list of people to be contacted in the event of a disaster.

· Instructions for contacting the people involved in the response to the disaster.

· Information on who owns the administration of the plan.

· A checklist of required tasks for each recovery scenario. To help you review how disaster recovery progressed, initial each task as it is completed, and indicate the time of completion on the checklist.

Ensuring Disaster Readiness

To ensure that you are ready for disaster, Microsoft recommends that you periodically perform the following activities:

· Test your backup and recovery procedures thoroughly before a real failure occurs. Testing helps to ensure that you have the required backups to recover from various failures, that your procedures are clearly defined and documented, and can that they can be executed smoothly and quickly by any qualified operator.

· Perform regular database, transaction log, and file system backups to minimize the amount of lost data. Microsoft recommends that you back up both system and user databases.

· Maintain system logs in a secure fashion. Keep records of all service packs installed on Microsoft Windows, your database, and Microsoft Dynamics AX.

· On another server or set of servers, assess the steps you need to take to recover from a disaster. If necessary, amend the steps as necessary to suit local server environment, and test the amended steps.
· Make sure that you understand and document the database and file access rights required to recover the database and application folder and get it to a working production state.

· Plan for for the loss of each Microsoft Dynamics AX server role including the AOS, database server, application file server, and Enterprise Portal server. In addition it is important to understand the implications of the loss of the Domain Controller to the Microsoft Dynamics AX implementation.

Review related documentation, such as the Windows SharePoint Services Administration Guide, so that you are able to recover the other databases used with Microsoft Dynamics AX.

Upgrading to Microsoft Dynamics AX

This section describes the process and factors to consider when upgrading your Microsoft Dynamics AX system from Microsoft Axapta version 3.0 to Microsoft Dynamics AX version 4.0. While the Microsoft Dynamics AX application provides you with tools to complete your upgrade, careful planning ensures a successful upgrade, including minimal downtime to your Microsoft Dynamics AX system during data upgrade.

The table below describes what you find in this section.

	Section
	Description

	Flowchart: Upgrade methodology
	This flowchart provides you with an overview of the entire upgrade process.

	Changes between 3.0 and 4.0, and implications for upgrade 
	This section provides you with information on what has changed since the previous release, and provides links to documentation that describes changes in tables.

	Before you begin upgrading 
	This section provides you with important prerequisites for upgrade.

	Upgrade your code in the test environment 
	This section describes the first phase of upgrade: code upgrade. This section leads you through the code upgrade process.

	Upgrade your data in the test environment 
	This section describes the second phase of upgrade: data upgrade. This section leads you through the data upgrade process.

	Move upgrades to a production environment 
	This section describes the final phase of upgrade: upgrade in the production environment. This section leads you through the final production environment upgrade process.

	Upgrade your help system 
	This section describes how you can move your customized help contents from the legacy help system to the new help system.

	Upgrade Enterprise Portal 
	This section describes how to upgrade your Enterprise Portal.

	Upgrade OLAP reporting 
	This section describes how to upgrade OLAP.

	Troubleshoot upgrade issues
	This section describes workarounds to some possible problems during upgrade.


Flowchart: Upgrade methodology

The figure below shows the process flow to upgrade your system:
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Changes between Microsoft Axapta 3.0 and Microsoft Dynamics AX 4.0, and implications for upgrade

For the most current information about the changes between versions, visit Microsoft Dynamics AX Online.

Upgrade from Axapta 3.0 to Microsoft Dynamics AX 4.0 is unique, unlike the upgrade process of any previous version of Axapta. Among the changes:

· Operating system requirement: Microsoft Dynamics AX application server and object server must run on the Microsoft Windows Server 2003 operating system. Client machines can run on Microsoft Windows XP.

· Cross-reference information is deleted during upgrades.

· New best-practice checks are automatically marked as enabled during upgrade.

· Record identification: Change of allocation principles - In Microsoft Dynamics AX 4.0 the record identification allocation has changed from per company to per table. This means that record identifications can no longer be assumed to be unique across a company. As a consequence, application code that refers to record identifications should be carefully reviewed and code that relies on unique allocation within a company must be modified.

· Unicode: Axapta supports all languages by running Unicode. The database must be updated to handle Unicode data types. Unicode upgrade is handled as part of the upgrade process.

· 3-tier: Microsoft Dynamics AX supports only 3-tier installations in production environments.

Additional resources

For information about upgrading from versions of Axapta prior to 3.0, see Note on upgrading from releases prior to 3.0.

For developer-oriented resources for upgrade, see Resources for tracking changes in Microsoft Dynamics AX.

For a list of changes to configuration keys and security keys since the last release, see Changes in configuration keys. 

The table below provides information on what changes have been implemented in Microsoft Dynamics AX.

	Section
	Description

	What's new in implementing Microsoft Dynamics AX 
	This section describes the major feature changes or enhancements that affect the way you implement and upgrade Microsoft Dynamics AX.

	What's new for information workers 
	This section describes the major feature changes or enhancements that affect how the user works with Microsoft Dynamics AX.

	What's new for IT professionals 
	This section describes the major feature changes or enhancements that affect information technology (IT) professionals and Microsoft Dynamics AX administrators.

	What's new in Microsoft Dynamics AX 
	This section describes the major feature changes or enhancements that affect developers working in Microsoft Dynamics AX.

	Migrate Intercompany from Commerce Gateway to Application Integration Framework (AIF)
	This section describes the intercompany functionality that can be migrated from Commerce Gateway to the Application Integration Framework (AIF).


Note about upgrading from releases prior to Microsoft Axapta 3.0

You can only upgrade to Microsoft Dynamics AX 4.0 from Microsoft Axapta 3.0. Upgrade cannot skip a major version. Major versions of Axapta are: 1.0, 1.5, 2.0, 2.1, 2.5, 3.0, and Microsoft Dynamics AX 4.0.

Because data dictionary changes are typical from one version to the next, you cannot skip a full version when you upgrade. For an upgrade to be completed properly, you must upgrade from, for example, Axapta version 2.5 to Axapta version 3.0 first, and then to Microsoft Dynamics AX version 4.0. If you skip a version, the data upgrade facilities cannot handle data upgrade, and you risk losing data.

Refer to the user documentation to upgrade from versions prior to 3.0.

Resources for tracking changes in Microsoft Dynamics AX

For information on table changes between Microsoft Axapta version 3.0 and Microsoft Dynamics AX 4.0, and other developer-related issues, see Microsoft Dynamics AX Upgrades.

For information about security changes that require modifications to your code, see Microsoft Dynamics AX Security.

Changes in configuration keys and security keys

If Microsoft has deleted configuration keys or security keys since the last release, there will be no information in the information log when you create an upgrade project.

If Microsoft has changed a configuration key or security key since the last release, and you have made identical modifications, such as with a hot fix, both identical versions of the configuration key or security key are included in the upgrade project. You should delete the modified version of the configuration key or security key.

List of changes to configuration keys

The table below shows changes to configuration keys since Axapta 3.0.

	Configuration key in Axapta 3.0
	Configuration key in Microsoft Dynamics AX
	Status

	BM
	-
	Deleted

	CACAdvanced
	-
	Deleted

	CACBasic
	-
	Deleted

	Gateway
	-
	Deleted

	GatewayBizTalk
	-
	Deleted

	smmEPCRM
	-
	Deleted

	SysASPManagement
	-
	Deleted

	SysDeletedObjects30
	-
	Deleted

	CSEAustralia
	CRSEAustralia
	Renamed

	CSEAustria
	CRSEAustria
	Renamed

	CSEBelgium
	CRSEBelgium
	Renamed

	CSECountry
	CRSECountry
	Renamed

	CSEDenmark
	CRSEDenmark
	Renamed

	CSEFinland
	CRSEFinland
	Renamed

	CSEFrance
	CRSEFrance
	Renamed

	CSEGermany
	CRSEGermany
	Renamed

	CSEItaly
	CRSEItaly
	Renamed

	CSENetherlands
	CRSENetherlands
	Renamed

	CSENorway
	CRSENorway
	Renamed

	CSESpain
	CRSESpain
	Renamed

	CSESweden
	CRSESweden
	Renamed

	CSESwitzerland
	CRSESwitzerland
	Renamed

	CSEUnitedKingdom
	CRSEUnitedKingdom
	Renamed

	CSEUnitedKingdom
	CRSEUnitedKingdom
	Renamed

	CSEUnitedStates
	CRSEUnitedStates
	Renamed


List of changes to security keys

The table below shows changes to security keys since Axapta 3.0.

	Security key in Axapta 3.0
	Security key in Microsoft Dynamics AX
	Status

	CAC
	-
	Deleted

	CACDaily
	-
	Deleted

	CACInquiries
	-
	Deleted

	CACJournals
	-
	Deleted

	CACMisc
	-
	Deleted

	CACPeriodic
	-
	Deleted

	CACReports
	-
	Deleted

	CACSetup
	-
	Deleted

	CACTables
	-
	Deleted

	JmgRegistration
	-
	Deleted

	ProjTabels
	-
	Deleted

	smmEPCRM
	-
	Deleted

	SmmEPCRMInfo
	-
	Deleted

	SmmEPCRMMisc
	-
	Deleted

	SmmEPCRMReports
	-
	Deleted

	SmmEPCRMTasks
	-
	Deleted

	SysDevelopmentBasic
	-
	Deleted

	SysDevelopmentMorphX
	-
	Deleted

	SysDevelopmentSetup
	-
	Deleted


Migrate Intercompany from Commerce Gateway to Application Integration Framework (AIF)

Existing Microsoft Dynamics AX 3.0 installations that use Commerce Gateway cannot be migrated in their entirety to the new AIF framework in Microsoft Dynamics AX to exchange documents. However, because intercompany functionality (which enables two companies within the same Microsoft Dynamics AX installation to exchange documents as trading partners) relies on a small portion of the Commerce Gateway implementation, you can migrate the tables that apply to intercompany functionality into Microsoft Dynamics AX 4.0 for use with AIF. Once the tables are migrated, the companies defined in the Commerce Gateway tables may be configured as AIF endpoints, and documents may be exchanged between them.

The tables GatewayOrganization, GatewayOrgRef, and GatewayDocSetup are targeted for migration using the existing upgrade framework.

The tables are mapped as follows:
· GatewayOrganization to AifEndpoint
· GatewayOrgRef to AifEndpointConstraint
· GatewayDocSetup to AifEndpointActionValueMap
Data migration

IntercompanyCommerceGatewaytoAIF_DataMigration#f4467f61-43cf-46ef-be6d-56f87b3b1b89

Mapping of the GatewayOrganization to AifEndpoint tables

This table shows the mapping of the GatewayOrganization to AifEndpoint tables.
	Commerce Gateway Field
	AIF Field
	Comments

	GatewayOrgId

String 20 right justified
	AifEndpointId

String 30 left justified
	The value of this field is the customer/vendor ID in the intercompany organization that represents the current company. This field will be mapped directly.

	BizTalkOrgId
	None
	This will be ignored.

	Active

Enum: NoYes 

No = 0

Yes = 1
	Status

Enum: AifEndpointStatus 

Disabled = 1

Enabled = 2
	This field is used to enable / disable an endpoint configuration. 
Need to appropriately map enumerations.

	TransportIdIn
	None
	This will be ignored.

	Name

String 30
	Name

String 30
	Free-text.

	TransportIdOut
	None
	This will be ignored.

	InterCompanyCompanyId
	InterCompanyCompanyId
	The company ID of the intercompany organization. This field will be mapped directly.

	InterCompanyOrg
	InterCompanyOrg
	When checked, denotes that the record represents an intercompany configuration. This field will be mapped directly.


Mapping of the GatewayOrgRef to AifEndpointConstraint tables
This table shows the mapping of the GatewayOrgRef to AifEndpointConstraint tables. 

	Commerce Gateway Field
	AIF Field
	Comments

	GatewayOrgId

String 20 right justified
	AifEndpointId

String 30 left justified
	Foreign key from the AifEndoint table. This field will be mapped directly.

	RefType

Enum: SysActionRefType

None = 0

Cust = 1

Vend = 2
	Type

Enum: AifConstraintType

NotSet = 0

Customer = 1

Vendor = 2

NoConstraint = 3

Warehouse =4
	This field provides context for the RefId. That is, it defines whether it is a customer / vendor, and so on. 

RefType::Cust will map to AifConstraintType::Customer

RefType::Vend will map to AifConstraintType::Vendor

If the RefType is set to none, that record will be ignored.

	RefId

String 20 right justified
	Status

String 20 right justified
	The value of this field is the customer/vendor ID in the current company that is associated with the intercompany organization. This field will be mapped directly.

	Active
	None
	This will be ignored


Mapping of the GatewayDocSetup to AifEndpointActionValueMap tables
This table shows the mapping of the GatewayDocSetup to AifEndpointActionValueMap tables.

	Commerce Gateway Field
	AIF Field
	Comments

	GatewayOrgId

String 20 right justified
	AifEndpointId

String 30 left justified
	Foreign key from the AifEndoint table.  This field will be mapped directly.

	ActionId

Enum: SysActionActionId

…

SalesOrder = 1

…

PurchOrder = 7
	ActionId

String 80
	This focuses only on SalesOrder and PurchOrder enumerations because intercompany is developed to use these two options specifically.

The SalesOrder and PurchOrder enumerations will be mapped to the #DefaultSalesOrderAction and #DefaultPurchaseRequisitionAction defined in the Intercompany macro.


Note   All other existing fields will be mapped directly.
Mapping of the GatewayDocSetup to AifEndpointActionPolicy tables

This table shows the mapping of the GatewayDocSetup to AifEndpointActionPolicy tables.

	Commerce Gateway Field
	AIF Field
	Comments

	GatewayOrgId

String 20 right justified
	AifEndpointId

String 30 left justified
	Foreign key from the AifEndoint table. This field will be mapped directly.

	ActionId

Enum: SysActionActionId

…

SalesOrder = 1

…

PurchOrder = 7
	ActionId

String 80
	This focuses only on SalesOrder and PurchOrder enumerations because intercompany is developed to use these two options specifically.

The SalesOrder and PurchOrder enumerations will be mapped to the #DefaultSalesOrderAction and #DefaultPurchaseRequisitionAction defined in the Intercompany macro.

	N/A
	Status
	Status of the endpoint action policy will be set to “enabled”.


Note   All other fields in the EndpointActionPolicy table will be set to their default values.

Mapping of the GatewayDocSetup to IntercompanyEndpointActionPolicy tables

This table shows the mapping of the GatewayDocSetup to IntercompanyEndpointActionPolicy tables.

	Commerce Gateway Field
	AIF Field
	Comments

	GatewayOrgId

String 20 right justified
	AifEndpointId

String 30 left justified
	Foreign key from the AifEndoint table.  This field will be mapped directly.

	ActionId

Enum: SysActionActionId

…

SalesOrder = 1

…

PurchOrder = 7
	ActionId

String 80
	This focuses only on SalesOrder and PurchOrder enumerations because intercompany is developed to use these two options specifically.

The SalesOrder and PurchOrder enumerations will be mapped to the #DefaultSalesOrderAction and #DefaultPurchaseRequisitionAction defined in the Intercompany macro.


Note   All other fields in the IntercompanyEndpointActionPolicy table will be set to their default values.

Before you begin upgrading

Before you begin upgrading, be aware of the following restrictions and requirements.

Restrictions

There are a number of upgrade restrictions that you should be aware of before actually starting the upgrade:

Version support

Upgrade to Microsoft Dynamics AX 4.0 must be from Microsoft Axapta 3.0 with or without one of the service packs.

Because data dictionary changes, and as a consequence DEL_ prefixed tables and fields, are typical from one version to the next, you cannot skip a full version when you upgrade. For example, you cannot upgrade Axapta version 2.5 information directly to Microsoft Dynamics AX version 4.0. You must upgrade to version 3.0 first, and then to version 4.0. If you skip a version, the data upgrade facilities cannot handle data upgrade, and you are liable to lose data. For more information about upgrading from versions prior to Axapta 3.0, see Note on upgrading from releases prior to 3.0.

Upgrade restriction: Axapta 3.0 with multi-code page data cannot be upgraded

Axapta 3.0 had the documented limitation that a single Microsoft Dynamics AX installation could not use multiple code pages, and that such installations were not supported. Partners may nevertheless have succeeded in making such installations work in version 3.0. These installations cannot be upgraded to Microsoft Dynamics AX.

During the upgrade to Unicode, the database code page is used and multi-code page data cause data corruption:

· If the "enable database for Unicode" option is not selected, all character data (string and memo) that is not in the code page of the database is lost.

· If the "enable database for Unicode" option is selected, any data of the memo data type that is not in the code page of the database is lost.

For more information about the Unicode upgrade, see About the Dynamics AX DB Upgrade Preparation Tool.

Requirements

Before you begin upgrading, check the following:

Set appropriate user permissions

Before beginning the Microsoft Dynamics AX upgrade process, ensure that the account you log on with on each server has appropriate permissions. The permissions listed below are implemented using the principle of least privilege.

Note   If you upgrade Microsoft Dynamics AX using a domain account other than your own, that account must have appropriate permissions in the system.

	Action
	Permissions required for account

	Install Application Object Server (AOS)
	Member of Administrators group on the local computer

	Create a Microsoft SQL Server database 
	Member of Database Creators role on the SQL Server instance

	Connect AOS to a SQL Server database 
	Member of Database Security Administrators role on the SQL Server instance

	Create Oracle database 
	Member of SYSDBA on Oracle database server

	Connect AOS to an Oracle database 
	Member of SYSDBA on Oracle database server

	Install application file server
	Member of Administrators group on the local computer

	Install Microsoft Dynamics AX client
	Member of Administrators group on the local computer

	Run the DB Upgrade Preparation Tool
	SQL Server – Ensure all objects are created with dbo as the owner. The minimum level of permissions for the user that is running the tool to ensure this happens is that they are a member of the ddl_admin, db_datareader and db_datawriter roles.

Oracle – Create a user called “dbo” with a random maximum length password (20 characters). All objects created must be created with the dbo user as the owner/schema.

	Run the Upgrade checklist
	During the client startup, the current Windows user is designated as the Microsoft Dynamics AX Administrator.


In Axapta 3.0: Move any packed identification references

The record identification upgrade handled by the Microsoft Dynamics Database Preparation Upgrade tool is unable to locate existing record identification references that are packed inside containers and stored in the database. Such record identification references must be moved to a dedicated field prior to the upgrade.

In your Axapta 3.0 modifications, this is what you should look for:

· A class that extends the SysPackable class, and 

· A field containing a record identification is packed inside the pack() method of that class, and

· The packed data is subsequently saved to a database table.

If your Axapta 3.0 code has such modifications, this is what you must do before running the Dynamics AX Database Preparation Upgrade tool:

28. Create a dedicated field in the relevant table to store the record identification reference.
29. Unpack existing packed data and move it into the dedicated field.

This is needed to ensure that data import and export can correctly handle record identifications.

In Axapta 3.0: Disable Keep update objects configuration key

If not already done, disable the Keep update objects configuration key (SysDeletedObjects30). This ensures that redundant tables and fields with prefix DEL_ are deleted from your system when the system is synchronized.

If these application objects with prefix DEL_ are left in your system, you are prompted to delete them later when you synchronize during upgrade to Microsoft Dynamics AX 4.0.

Back up your data

Before you begin upgrading you should:

· Back up your existing Axapta application files (*.aod, *.add, *.ald, *.ahd, and *.khd files).

· Back up your data. See SQL Server information at Microsoft SQL Server documentation.

· Back up your local hard drive.

Disconnect Internet connections

Do not have any Internet connection to the Application Object Servers or database servers during upgrade to reduce the chance of outside attack.

Clean up data

Remove data in the Microsoft Axapta 3.0 database that is not needed for audit trails, and that is slowing down performance or making the database unnecessarily large. Before you upgrade your database, select the type of data that you want to clean up by using the standard filtering mechanism.

30. Start Axapta 3.0 in your test environment (Start > All programs > Navision Axapta), and log on.
31. Open the Application Object Tree (AOT).

32. Under \Menu Items\Action, open and run the following forms to clean up the respective types of data:

· SysUserLogCleanUp

· SysDatabaseLogCleanUp

· ProdJournalCleanUp

· InventJournalCleanUp

· ProdTableCleanUp

· SalesParmCleanUp

· PurchParmCleanUp

· LedgerJournalCleanUp
Upgrade your code in the test environment

Before you start your upgrade project, see Before you begin upgrading.

Upgrading your code in the test environment entails the following procedures:

· Prepare a Microsoft Dynamics AX system for code upgrade. 

· Create an upgrade project.

· Correct code and customization conflicts:

· Use the Compare tool to compare the contents of the different layers, and apply changes to the current application layer.

This process is described in Code compare tool and Use the code compare tool.

· Use the Code upgrade tool to upgrade your X++ source code.

This process is described in Code upgrade tool and Use the code upgrade tool.

Note   Record identification: Change of allocation principles - In Microsoft Dynamics AX 4.0 the record identification allocation has changed from per-company to per-table. This means that record identifications can no longer be assumed to be unique across a company. As a consequence, application code that refers to record identifications should be carefully reviewed and code that relies on unique allocation within a company must be modified.

· Compile the application.

After upgrading your code, compile the current layer to update the application file (AOD).

· Test the system after code upgrade.

Flowchart: Upgrade your code

The figure below shows the process flow to upgrade your code when upgrading your system:

[image: image38.png]Before you
begin

existing
plication files 4.0 (includes
(~.a0d, *.ahd, ‘application,
*.2ld, *.add, clent, AOS,
nd new empty|
database)

) T o e
3.0 application
il from all
Back up local layers above
hard drive DIS layer to
\Wicrosoft
Dynamics\a.0\
‘Application,
Appi\Standard

J

y all Axaptal
3.0 application
files to.

\Microsoft

Dynamics\.0\

‘Applicatior,

Appi\Standardy
old

Delete index

file (xapd.a0i)

from standard
directory

i

Start A0S

]

Start the
Dynarnics AX
4.0 client

I

Synchronize:

T

Create an
Upgrade
project

Use Code
Upgrade and
Compare Tool
to correct
conflicts in
customization

R

Compile

JR T,

Test system

Data upgrade:

Test
environment

Production
upgrade

Install test
Axapta 3.0
system

Copy Axapta
3.0 database
from
production

environm
o test
environment

Copy Axapta
pplcation
from all

layers above

DIS layer from

production

environment
0 test
environm

Clean up.

excess data in

the Axapta 3.0
database

Leustined,xpo
in Axapta 3.0

fond run the jool

Import
Prictepect_

UssrateCoumnLstxpo
in Axapta 3.0 and

Copy
flles

Ao
s

flles

run the form

Instal
Dynamics AX
4.0 (Includes
application,
diient, AOS,
and new empty/
database)

Run the DB,
Preparation
Tool from the
Installation
VD

(Optional)
\Copy all Axaptal
3.0 application

Copy all code:
upgraded
Dynamics AX

Copy

Standar 8

from standard
directory

Start the

u

Tum
production
environment
offline

Back up data

excess data in
the Axapta 3.0
database.

Lettustied.xpo
in Axapta 3.0
fand run the job|

Pruatebroecs_
poradeCoumnLstxpo

in Axapta 3.0 and

s

Dynamics AX
4.0

Run through
Upgrade
checklist

(recompiles.

*.a0d files and

upgrades data)

Test system

run the form

and new empty|
database)

Run the DB
Preparation
Tool from the
installation

(Optional)

Applicatior |
ppl\Standara\

py all code:
upgraded
Dynamics AX
4.0 *.20d flles
10 \Microsoft
Dynamics\d.0\
Application\
tandard

Delete index

fle (axapd.aoi)

from standard
directory

Start A0S,

Start the
Dynamics AX
4.0 client

Run through
Upgrade
checklist

(recompiles.

*.20d files and

upgrades data)

Test system

Disable Keep

Golive




Prepare a Microsoft Dynamics AX system for code upgrade

In order to retain your modifications to the existing application objects, you must copy your application files to a directory where they can then be compared with the updated version.

33. Install Microsoft Dynamics AX.
Be sure to clear the Start the AOS Windows service as part of installation check box when you install the application object server.

For complete guidelines, see Installing a core system. This installs an application, a client, and an Application Object Server (AOS). In the case of a SQL installation, this also installs a new, empty Microsoft Dynamics AX database.

34. Copy the application files (*.aod, *.ahd, *.ald, *.add, *.khd) from all layers above the DIS layer from your Microsoft Axapta 3.0 system. These layers are the modified 3.0 layers. Copy the application files to:

Microsoft Dynamics\4.0\Application\Appl\Standard
35. Copy all of the Microsoft Axapta 3.0 application files (*.aod) from your Axapta 3.0 system to:

Microsoft Dynamics\4.0\Application\Appl\Standard\Old

Note   Existing axsys.aod and axusr.aod files in this folder are overwritten. If there is only an axusr.aod file, then it is overwritten, and an empty axsys.aod file is created.
36. Delete the index file (axapd.aoi) from the standard directory.

37. Start the Application Object Server (AOS).

38. Start the Microsoft Dynamics AX client.

39. Synchronize by opening the Application Object Tree (AOT), right-clicking Data Dictionary, and selecting Synchronize.

Create an upgrade project

The Create upgrade project tool analyzes your installation, deletes duplicate objects, and creates a project with application objects that must be upgraded manually.

The objects are those that have been changed in the new release and which also exist in your Application Object Layer.

Creating an upgrade project

40. From the Microsoft Dynamics AX client menu, click Tools > Development tools > Version update > Create upgrade project.
The dialog box informs you of the project name. Delete obsolete changes is selected.

Note   If you do not want changes removed, clear the Delete obsolete changes.

41. Click OK.

A new upgrade project is created.

Choosing alternatives to the create upgrade project tool

As an alternative to the Create upgrade project tool, you can use the Compare layers tool to compare any two layers and create a project with the objects that differ.

Note   Unlike Create upgrade project, you cannot select to delete duplicates. Consequently the Compare layers tool may also be useful as a general tool, for example to give an overview of modifications made in a certain layer.

If you have Developer rights, you can use the Project filter tool in the upgrade process as an alternative to both the Create upgrade project and Compare layers tools. Project filter lets you create a project based on criteria supplied in the query form. For example, such criteria could be all objects from a relevant layer, all objects with a specific prefix, or all objects created by a specific user. For information on creating a project using the project filter, see Using the project filter.

Correct your code and customization conflicts

Upgrading application modifications is a major step in the complete upgrade process that relies on comparisons between the previous and the current version. To make such comparisons possible, you must save your old application files in the Appl\Standard\Old directory when you upgrade. For complete information, see Prepare a Microsoft Dynamics AX system for upgrade.

When you create an upgrade project, the process analyzes the installation, deletes duplicate objects, and creates a project with application objects that must be upgraded. For complete information, see Create an upgrade project.

When the application object changes have been identified, they should be evaluated and ported to the new version. To make this easier, these tools are available:

CompareThe Compare tool compares an application object in different layers. Properties, as well as X++ source code, are compared. 

To learn more about the Compare tool, see Code compare tool and Use the code compare tool.

Code upgradeThe Code upgrade tool is used to upgrade X++ source code. The tool presents source code comparisons and provides convenient access to the X++ editor to make the actual updates. 

To learn more about the Code upgrade tool, see Code upgrade tool and Use the code upgrade tool.

Code compare tool

Use code compare to help you compare:

· Two different application objects.

· The same application object in two different layers. 

In the Application Object Tree (AOT), select the element you want to upgrade code for, right-click, point to Add-Ins, and select Compare. The comparison is a line-by-line analysis of source code, properties, and object sequence.

The system performs the comparison and extends the dialog box with a two-pane window. The left pane displays the two objects in a tree structure that can be expanded. The right pane displays the content of the currently-selected node. Differences are indicated by the use of colors (red and blue), both in the icons in the tree structure and in the actual node content. The shaded box with the check mark indicates that there are differences in the children of that node. 

Whenever there are differences, this is illustrated with an unequal icon (≠) where the two colors are mixed.

Code lines, properties, or controls that belong to only one object are specified in that object’s color. Identical code lines, properties, or controls are black.

Use the code compare tool

Use code compare to help you compare:

· Two different application objects.

· The same application object in two different layers.

Compare application objects

42. Select the application object or objects from the Application Object Tree (AOT).
43. Right-click the selected item and select Add-Ins > Compare to open the Comparison dialog box.

44. On the Name && Location tab, select:

· Layers you want to compare

- or -

· Versions of the object that you want to compare.

45. On the Advanced tab, select the options that specify comparison criteria.

46. Click Compare.

Microsoft Dynamics AX makes the comparison and extends the compare dialog with a two-pane window.

Options on the Advanced tab page

	Option
	What it means
	About using it

	Show differences only
	Show only where the objects differ.
	When this filter is not selected, similarities are also shown in the resulting tree. Since this would make the tree too large, we recommend that you select this filter.

	Suppress whitespace
	Disregard spaces in X++ code.
	The compiler does not distinguish between one or more spaces in the X++ code, so checking for spaces is usually unnecessary. 

Checking this box could make the comparison smaller but no less accurate.

	Case sensitive
	Perceive letters in upper and lower case as being different, for example 'a' and 'A'.
	The Microsoft Dynamics AX compiler is not case sensitive, so this option is usually unnecessary.

	Show line numbers
	List line numbers in X++ code samples.
	Listing line numbers in the X++ code could make it easier for you to compare code.


Work in the compare dialog

The left pane displays the objects in a tree structure that can be expanded.

The right pane displays the contents of the currently selected node.
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Differences between the objects are indicated by the use of colors, both in the icons in the tree structure and in the actual node contents. Here, one object is depicted in red and the other one in blue. Red represents the reference layer, while blue represents the layer you are comparing with.
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A shaded box with a check mark indicates that there are differences in the children of that node.

Whenever there are differences, they are depicted with an unequal icon (≠) where the two colors are mixed.

Code lines, properties, or controls that belong to one object appear in that object’s color. Identical code lines, properties, or controls appear in black.

In the right pane, code lines and property settings that differ have a gray background. Code lines that differ only in their position have a slightly lighter background.

Edit the specific object by right-clicking either the new or old object in the left pane, and selecting Edit, as shown in the graphic below.
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The changed code lines may have a small icon to the right. The straight arrow icons may be used to respectively insert and remove the code line. The bent arrow icons may be used to move code lines.

	Symbol
	Action

	->
	remove from current layer

	<-
	insert into current layer

	|->
	merge the two solutions


Note   Lines can be inserted and deleted from the current layer only.

Lines cannot be moved if two objects in the same layer are compared.

Code upgrade tool

Use code upgrade to help you compare and merge your X++ source code.

In the Application Object Tree (AOT), select the element you want to upgrade code for, right-click, point to Add-Ins, and select Code upgrade. This ports any source code modifications that you have made from the previous version to the new version to the Code upgrade dialog box. The application object in a tree structure in the left pane, and a workspace is displayed in the right pane. When you select a method in the tree structure, a tab is added next to the Workspace tab for each layer that the method exists in, along with a tab where the layers are compared, as the following graphic [image: image42.png]B Code upgrade - AssetCalendars
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The method names are displayed in bold if there is a conflict between changes made by Microsoft and changes made for customization. That is, the objects are not identical because some changes have been made in one or both layers (for example, SYS and old USR). Examine and compare these objects to see whether an upgrade of the code is required.

Example

A conflict is identified as a situation when the SYS layer has changed as compared to the previous version (the old SYS), and:

· The object exists in the current layer, for example the old USR layer, even though the object might be identical to that in the old SYS layer;

- or -

· The changes are not identical.

The layers in the example might also be, for example, CUS and USR or CUS and BUS.

The following illustration shows the comparisons that are made on a system with a SYS and a USR layer as well as the corresponding old layers.
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Use the code upgrade tool

Use code upgrade to help you compare and merge your X++ source code.

Examine and port your code modifications

47. Select the application object from the Application Object Tree (AOT).
48. Right-click the selected item and select Add-Ins > Code upgrade.

The Code upgrade dialog box opens.

Work in the workspace area

The Workspace tab page displays the code in the active layer with comments about changes and additions, for example 'New in sys' or 'Removed from sys'.

When the Workspace tab is active, the following functionality is available:

· Click Edit to open the X++ editor with the selected method, which allows you to make the desired modifications.

Note   Modifications cannot be made directly on the Workspace tab, but requires you to open the X++ editor. This is to prevent inadvertent code upgrades. For information about editing code, see Code Editor.

· Click Suggestion, and select from Merge and Merge with comments to merge the source code from the layers and present the result on the Workspace tab.

The additional options on the Suggestion menu button are the layers to be used as the basis for the upgrade, for example SYS and old USR. Use them to copy code from the layer into the workspace.

Click Compare, and select the layers to compare in the dialog box that opens, as shown in the following
 [image: image1.jpg]M.Microsoft Dynamics: Ax




A new tab is created displaying the comparison, and exists for that method only.

Use the layers tab pages

You can only view information on the tab pages that display the layers. You cannot edit source code. For information about editing code, see Code Editor.

On the tab pages that display comparisons, different colors are used for different layers. The lines that differ have a gray background color. The legend is explained below the code lines.

Compile the application

Compile the whole application because it ensures that all object references are updated and the application is ready to use.

Compiling the application takes the application source code, translates it into binary code that can be interpreted by the kernel and stores it in the .aod file.

This is also necessary during new installations with a Service Pack, since the references from the standard application must also be updated.

This option is available from either of the following:

· The installation checklist

Administration > Setup > System > Checklists > Installation checklist
· The Administration navigation pane

Administration > Periodic > Compile application
Close the Compiler output dialog box when the compilation is finished.

Important   The compilation takes an hour or more to complete, depending on your hardware, and it is critical that the compilation completes.

Test the system after code upgrade

After upgrading your code and before proceeding to upgrading your data, test whether your installation is functioning properly. 

To test whether the code upgrade to the Microsoft Dynamics AX system has succeeded, perform at least these minimum steps:

· Start all Application Object Server (AOS) instances.

· Launch a client that is connected to each running AOS instance.

· Test that users can execute the most common tasks for your system.

· Test that the administrator can run the system maintenance tasks.

· Test that users can execute the most vital tasks for your system.

· Test that the permissions settings is working right by checking that users have access to the data they had access to prior to upgrade.

Upgrade your data in the test environment

Before you start your data upgrade project, see Before you begin upgrading and Upgrade your code in the test environment.

Upgrading your data in the test environment entails the following procedures:

· Prepare the test Axapta 3.0 system 

· Prepare a Microsoft Dynamics AX system for data upgrade 

· Run the Dynamics AX DB Upgrade Preparation Tool 

· Upgrade checklist 

· Compile the application 

· Add license keys 

· Prepare database for data upgrade (Pre-synchronize data upgrade) 

· Synchronize your database 

· Update data in all company accounts (Post-synchronize data upgrade) 

· Create an upgrade project 

· Test the system after data upgrade 

Flowchart: Upgrade your data

The figure below shows the process flow to upgrade your data when upgrading your system: 
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Prepare the test Microsoft Axapta 3.0 system for data upgrade

Prepare the Microsoft Axapta 3.0 test environment by doing the following:

1. Preparation
49. Install Axapta 3.0 system in your test environment.
See your Axapta 3.0 user documentation for information on installation. Installation of an Axapta 3.0 system consists of the following:

· Application installation

· Application Object Server installation

· Client installation

50. Back up the Axapta 3.0 database in your production environment, and restore it to the Axapta 3.0 system in your test environment (see Microsoft SQL server information, located at Microsoft SQL Server documentation).
51. Copy the application files (*.aod, *.ahd, *.ald, *.add, *.khd) from all layers above the DIS layer from your Axapta 3.0 system. These layers are the modified 3.0 layers. Copy the application files to your Axapta 3.0 system in your test environment.

2. Clean up data

Remove data in the Microsoft Axapta 3.0 database that is not needed for audit trails, and that is slowing down performance or making the database unnecessarily large. Before you upgrade your database, select the type of data that you want to clean up by using the standard filtering mechanism.

52. Start Axapta 3.0 in your test environment (Start > All programs > Navision Axapta) and log on.
53. Open the Application Object Tree (AOT).
54. Under \Menu Items\Action, open and run the following forms to clean up the respective types of data:

· SysUserLogCleanUp
· SysDatabaseLogCleanUp
· ProdJournalCleanUp
· InventJournalCleanUp
· ProdTableCleanUp
· SalesParmCleanUp
· PurchParmCleanUp
· LedgerJournalCleanUp
3. Left justify tables

Left justify some or all tables in the Axapta 3.0 system. Do this to properly upgrade the database, because in Microsoft Dynamics AX all Microsoft shipped layers have left justified fields and data types only:

55. Start Axapta 3.0 in your test environment (Start > All programs > Navision Axapta) and log on.
56. Open the Application Object Tree (AOT).

57. Click the Import icon.

The Import window appears.

58. In the File name field, enter \AX4 DVD\DatabaseUpgrade\PrivateProject_LeftJustified.xpo and click OK.

This creates a project called LeftJustified.

59. Click the Project icon, and open Private > LeftJustified (usr).

60. In Project LeftJustified, right-click MainJob (usr) and select Open.

An Infolog appears stating how many records have been inserted, and the Left Justify form appears.

61. In the Left Justify form, select the base type for the fields to left justify.

This creates a list of tables and columns that are presently right justified.

62. To left justify individual tables, select the row and click Left Justify
- or -

To left justify all the tables in the base type, click Left Justify All.

4. Prepare database for Record Identification type changes

Import and run the UpgradeColumnList.xpo in the Axapta 3.0 system in the test environment. Do this to prepare the 3.0 database for RecID-type changes from 32 bit integer to 64 bit integer:

63. Start Axapta 3.0 in your test environment (Start > All programs > Navision Axapta), and log on.
64. Open the Application Object Tree (AOT).

65. Click the Import icon.

The Import window appears.

66. In the File name field, enter the path to your installation CD and \AX4 CD\DatabaseUpgrade\PrivateProject_UpgradeColumnList.xpo and click OK.

67. Open the AOT and click Forms > UpgradeColumnList.

68. Right-click UpgradeColumnList and select Open.

69. Click Generate, and wait until the operation is complete.

This could take up to two minutes. This job identifies the record identification and transaction identification fields that are based on the recId and on the TransactionId data type. Fields that contain transaction identification or record identification references but are incorrectly based on the int data type are not identified by the job. 

Such incorrectly typed Axapta 3.0 fields can be handled in one of the following ways:

· Append the list of such fields to the internal list of known incorrectly typed Axapta 3.0 fields of the same type that are hard-coded in the cleanup() method (UpGradeColumnListGenerator class). Then run the UpgradeColumnList job again to have the database updated.

· Manually update the int data type in Microsoft Dynamics AX after the upgrade checklist has been executed.

70. Close Axapta 3.0.

Prepare a Microsoft Dynamics AX system for data upgrade

This procedure creates a Microsoft Dynamics AX installation, and migrates the changes you made in the code in Upgrade your code in the test environment.

71. Install Microsoft Dynamics AX.
Be sure to clear the Start the AOS Windows service as part of installation check box when you install the application object server.

For complete guidelines, see Installing a core system. This installs an application, a client, and an Application Object Server (AOS). In the case of a SQL installation, this also installs a new, empty Microsoft Dynamics AX database.

72. Run the DB Upgrade Preparation Tool 

73. (Optional) Copy all of the Microsoft Axapta 3.0 application files (*.aod) from your Axapta 3.0 system to:

Microsoft Dynamics\4.0\Application\Appl\Standard\Old

Note   Existing axsys.aod and axusr.aod files in this folder are overwritten. If there is only an axusr.aod file, then it is overwritten, and an empty axsys.aod file is created.
74. Copy the updated Microsoft Dynamics AX application files (*.aod) from code upgrade in your test environment to:

Microsoft Dynamics\4.0\Application\Appl\Standard

75. Delete the index file (axapd.aoi) from the standard directory.

76. Start the Application Object Server (AOS).

77. Start the Microsoft Dynamics AX client.

Run the Dynamics AX DB Upgrade Preparation Tool

The Microsoft Dynamics AX DB Upgrade Preparation Tool can be run only once. The tool is not installed as part of the Microsoft Dynamics AX installation but must be run from the product DVD. 

Note   The tool requires read access to the source database and write access to the target database. The target database requires read/write access to the temporary directory.

78. On the computer on which the Application Object Server (AOS) is being upgraded or installed, insert the product DVD.
79. Start the Dynamics AX DB Upgrade Preparation tool from Microsoft Windows Explorer or from a command prompt. The file name of the tool is AxDbUpgrade.exe.

To enable multithreading, run the tool from a command prompt as:

AxDbUpgrade.exe /pn
Where n is the number of threads (minimum 1 and maximum 64 threads), for example: AxDbUpgrade.exe /p8 (8 threads).

80. On the Microsoft SQL Server or Oracle tab, enter the required server and database information and click Start.

For information about the dialog box options, see Dynamics AX DB Upgrade Preparation.

81. When the upgrade preparation completes, a message displays on the screen. Click OK to close the message.

Upgrade checklist

Use the Upgrade checklist during Setup to guide you through the tasks needed for an upgrade. As each option is completed, the item is checked by the system. Most of these items are one-time setup options. 

Icons are used to mark the status of the tasks involved. Some tasks are mandatory, and some tasks depend on other tasks being completed first. Tasks must be completed from the top down.

The Upgrade checklist starts automatically when you:

· Install a new version of Microsoft Dynamics AX on top of an existing version

· Install a new service pack on top of an existing version of Microsoft Dynamics AX
· Import a .dat file (*.dat) that is exported from an older version of Microsoft Dynamics AX.
An automatic pop-up is triggered by comparing the version number in the current application and the version number in the new application or in the *.dat file. You can also open the Upgrade checklist by clicking Administration > Setup > System > Checklists > Upgrade checklist. 

Upgrade checklist

· Compile application - Update references and ensure that the application is ready for use. This process takes 30 minutes or more to run, and must be completed if there is more than one layer in your system. This ensures that all object references are updated and the application is ready to use. This is also necessary during new installations with a Service Pack, since the references form the standard application must also be updated. This option is also available from under Administration > Periodic > Compile application. Close the Compiler output window when finished. For more information, see Compile the application. 

· License information - Import or enter the Microsoft Dynamics AX licenses that were purchased. The license information is used to enable the modules and functions that your company is implementing. This option is also available from under Administration > Setup > System > License information. For more information, see Add license keys.

· Presynchronize data upgrade - Gets database information ready for synchronization. For more information, see Prepare database for data upgrade (Pre-synchronize data upgrade).

· Synchronize - Synchronizes the database data. For more information, see Synchronize your database.

· Postsynchronize data upgrade - Finalizes the synchronization of database information. For more information, see Update data in all company accounts (Post-synchronize data upgrade).

· Create upgrade project - Uses the Compare tool in Microsoft Dynamics AX to find objects that conflict with lower layer objects and which need a manual upgrade. Obsolete objects are deleted. For more information, see Create an upgrade project.

Symbols used in the upgrade checklist

The following table gives an overview of the icons used in the checklist framework.
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	Ready
	This task is ready to run. Click the link to start the task.

When the task is finished (when the form related to the task is closed), the icon changes to Checklist [image: image46.png]
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	Optional. Click the icon to mark as finished.
	This task is optional. Click the link to start the task, or click the icon to bypass the task.
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	Waiting
	This task is dependent on other tasks and can only be run when these other tasks are complete.
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	Finished
	This task is finished, but you can still click the link to run the task.
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	Additional help
	Click this icon to get additional help relating to the task.


What does a service pack do?

As a general rule service packs never add new objects to the data dictionary but everything else can be modified by a service pack. All object identifications must be preserved through all service packs for a given version.

Field identifications

If a field is deleted and you subsequently restore a backup, the field gets a new identification even though it logically has not changed. This means that all your code that refers to this field will not execute.

During development you may decide that you do not need a specific field. Instead of deleting the field, rename the field using the following format:

DEL_<Original Name>

This makes sure that you maintain the same field identification, and if you need this field later on, it is just a matter of removing the DEL_ from the field name.

Tip   Create a new security key that can be added to the items that you want to delete. This is a safe way of "deleting." This strategy allows you to keep the field (and identification) in your project and when you are sure that your project runs without problems, you can disable the security key and get rid of the field in the physical database.

Compile the application

Compile the whole application because it ensures that all object references are updated and the application is ready to use.

Compiling the application takes the application source code, translates it into binary code that can be interpreted by the kernel and stores it in the .aod file.

This is also necessary during new installations with a Service Pack, since the references from the standard application must also be updated.

This option is available from either of the following:

· The installation checklist

Administration > Setup > System > Checklists > Installation checklist
· The Administration navigation pane

Administration > Periodic > Compile application
Close the Compiler output dialog box when the compilation is finished.

Important   The compilation takes an hour or more to complete, depending on your hardware, and it is critical that the compilation completes.

Add license keys

Enter license information manually using information from your license document, or if provided, import the license codes from a file. You must have Administrator access rights in order to save a license code. 

To be able to use Microsoft Dynamics AX, enter the license codes, and check the Status field to see that each code is verified.

Note   If you are changing your current license settings as a result of updating license keys, the new functionality does not take effect until the client has been restarted.

In addition to license codes for Microsoft Dynamics AX functionality, access to the Microsoft Dynamics AX development environment is divided into four different licenses. For more information, see Development access licenses.

If you do not have a license, you can still set up Microsoft Dynamics AX in demonstration mode. For more information, see Demonstration mode.

Import license information

82. Click Administration > Setup > System > License information.
83. Click Load license file to import the license codes from a file.

The Load license file dialog box appears.

84. Click the folder icon and browse for your license file.

85. Click OK.

The Configuration dialog box appears and you are asked if you want to synchronize your database. 

86. Click Yes.

87. Close the License information window.

Enter license information

An alternative to importing the license information, you can enter the license information manually:

88. Click Administration > Setup > System > License information.
89. Enter the name of the license holder, the system's serial number, and the expiration date. The information is in your license document.

90. On the System tab page, enter the License code and verify that the Status field displays the expected text.

The license code indicates whether you have a standard, professional, or enterprise solution.

Note   The first four entries (name of the license holder, the system's serial number, expiration date, and license code) determine what appears in the remaining codes, and it is therefore essential that they are entered correctly.

91. Enter the remaining codes.

For each, check the Status field to ensure that the code is accepted.

Development access licenses

Development access in Microsoft Dynamics AX is divided into four different licenses:

· Base Package

· MorphX

· Web MorphX

· X++

Base Package

Base Package gives access to:

· Create or modify menus (user menus, main menu, and so on).

· Create or modify user Forms.

MorphX

The MorphX development license gives access to the Data Dictionary node, where tables, fields, enums, and extended data types are maintained. MorphX development license also gives the ability to create or modify forms.

It is possible to add, change and delete forms, tables, extended data types, macros, menus, reports, jobs, and queries. Methods related to tables, for instance forms, can be changed. For example, this allows you to change the standard information when adding new customers. 

An example of a change in extended data types by using MorphX is changing the lengths of account numbers.

The Application Object Tree (AOT) displays the following nodes:

· Data Dictionary

· Forms

· Macros

· Reports

· Queries

· Jobs

· Menus

· Menu Items

· Resources

· System Documentation

· Application Developer Documentation

· Application documentation

Web MorphX

The Web MorphX Development Suite license gives access to the Microsoft Dynamics AX Web Development Framework.

The AOT displays the following nodes:

· Web Forms

· Web Reports

· Web Menus

· Web page

· Web Editor

· Style Sheet Editor

X++

The X++ development license gives you full access to all classes in Microsoft Dynamics AX, and the development code for the CUS layer. This gives you the ability to modify things like the invoice routine, or the posting process for a ledger journal. Having the development code for the CUS layer allows customers to place their modified application objects in the CUS layer, or the USR layer, or both. 

It is possible to add, change, and delete classes. For example, you could change the logic in an invoice update, which is defined in the class SalesFormLetter.

Prepare database for data upgrade (Pre-synchronize data upgrade)

Use the data upgrade cockpit before you synchronize the database and data. When you pre-synchronize data, this prepares the following:

· The Microsoft Axapta 3.0 database schema for synchronization.

For example, it deletes duplicates or disables unique indexes such as ReleaseUpdateDB_V30toV40::allowDupPurchParmTable.

· Any metadata changes with an "undo" in the post-synchronization phase. 

The data upgrade cockpit helps manage the upgrade by using batch functionality. The tool gives an overview of the jobs that must be run when you upgrade from Axapta 3.0 to Microsoft Dynamics AX, and helps you manage their processing. One line in the table represents one upgrade job. 

Open the data upgrade cockpit from the Upgrade checklist by clicking Administration > Setup > System > Checklists > Upgrade checklist > Presynchronize data upgrade.

Note   You must complete all preceding tasks in the Upgrade checklist in order to work with the data upgrade cockpit.

The upgrade cockpit opens in Pause mode. Click Run to submit jobs to batch.

The status of a job is either Ready, Waiting, Executing, Finished or Error.

After you pre-synchronize the database, the database is ready for changing the data table structure and executing the data upgrade by synchronizing the database. For more information, see Synchronize your database and Update data in all company accounts (Post-synchronize data upgrade)
Process upgrade jobs

92. Select Administration > Setup > System > Checklists > Upgrade checklist > Presynchronize data upgrade.
The upgrade cockpit opens in Pause mode and is populated with upgrade jobs.

93. Click Run.

Jobs are submitted to the batch queue.

94. Start the batch server in one of two ways:

· Start a new client

– or –

· Select Basic > Periodic > Batch > Processing.

The status of the upgrade jobs is either Ready, Waiting, Executing, Finished or Error.

Run jobs in parallel

Jobs in the data upgrade cockpit should be run in parallel, as opposed to in sequence. Upgrading can be processed faster when several jobs are running simultaneously. When the cockpit is activated, several client computers can be used to process the jobs. The client computer that is running the upgrade checklist fills the batch table with all the scripts that need to run, and assigns them to the batch group called DataUpgrade. Performance improvement peaks at 20 client computers running in the batch.

If the user account is the same for the original Microsoft Dynamics AX client that started the upgrade cockpit and the additional Microsoft Dynamics AX clients, then the new clients detect that upgrade is running, and then start a batch server.

To start the upgrade cockpit manually, do the following:

95. Start the new Microsoft Dynamics AX client.
96. Select Basic > Periodic > Batch > Processing. 

A batch dialog appears.

97. Add DataUpgrade in the Group field, and click OK.

This client checks the batch table for records that are assigned to DataUpgrade, and runs the jobs that are in the queue.

Note   If you are running a batch job on the same client as you are running the upgrade cockpit, you must ensure that you are running in the DAT company.
Data upgrade cockpit and batch execution

The data upgrade cockpit interacts with the batch queue. When you click Run, jobs are sent to the batch queue and updated jobs are received from the batch queue with their new status. The batch queue sends and receives jobs from the batch server, where the jobs are processed.

The stages in which jobs are sent to the batch queue are categorized as: Start, Standard, Shared, and Final. Standard jobs run once for each company, while the other categories run only once during the upgrade, no matter how many companies you have in the database.

The graphic below shows how jobs are transferred between the upgrade cockpit to and from the batch queue, and between the batch queue to and from the batch server.
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Handle errors

When the status of a job is Error, you can detect the source of the error by doing the following:

98. Highlight the row that shows the error, and click View job errors.
A new dialog appears that shows the source of the error.

99. After you have investigated the source of the error and fixed it, click Rerun job to run this job again. The status of this job becomes Waiting.

Detect bottlenecks

When the status of a job is Waiting, you can detect which jobs it is waiting for by selecting the job and clicking View job predecessors. A dialog appears showing you which jobs must be finished before this job can be put into the batch queue.

You can also detect how much time various jobs have been running by sorting through the Time running column. This indicates the time the jobs have been running, so that you can detect scripts that are running an unusually long time.

Synchronize your database

Synchronize the database from the Upgrade checklist by clicking Administration > Setup > System > Checklists > Upgrade checklist > Synchronize.

Synchronize the table and index information to the database. By doing this, Microsoft Dynamics AX creates all the tables it needs to operate. Do this when schema changes in the Application Object Tree (AOT) are populated to the database. Synchronization generates the Microsoft Dynamics AX index (axapd.aoi).

Update data in all company accounts (Post-synchronize data upgrade)

Use the data upgrade cockpit after you synchronize data. When you post-synchronize data, this is where the bulk of the data upgrade happens, and it undoes metadata changes from the pre-synchronization phase.

The data upgrade cockpit helps manage the upgrade by using batch functionality. The tool gives an overview of the jobs that must be run when you upgrade from Microsoft Axapta 3.0 to Microsoft Dynamics AX, and helps you manage their processing. One line in the table represents one upgrade job.

Open the data upgrade cockpit from the Upgrade checklist by clicking Administration > Setup > System > Checklists > Upgrade checklist > Postsynchronize data upgrade. 

Note   You must complete all preceding tasks in the Upgrade checklist in order to work with the data upgrade cockpit.
The upgrade cockpit opens in Pause mode. Click Run to submit jobs to batch.

The status of a job is either Ready, Waiting, Executing, Finished or Error.

After you complete post-synchronization, you are ready to create the upgrade project. For more information, see Create an upgrade project.
Process upgrade jobs

100. Select Administration > Setup > System > Checklists > Upgrade checklist > Postsynchronize data upgrade.
The upgrade cockpit opens in Pause mode and is populated with upgrade jobs.

101. Click Run.

Jobs are submitted to the batch queue.

102. Start the batch server in one of two ways:

· Start a new client

– or –

· Select Basic > Periodic > Batch > Processing.

The status of the upgrade jobs is either Ready, Waiting, Executing, Finished or Error.

Run jobs in parallel

Jobs in the data upgrade cockpit should be run in parallel, as opposed to in sequence. Upgrading can be processed faster when several jobs are running simultaneously. When the cockpit is activated, several client computers can be used to process the jobs. The client computer that is running the upgrade checklist fills the batch table with all the scripts that need to run, and assigns them to the batch group called DataUpgrade. Performance improvement peaks at 20 client computers running in the batch.

If the user account is the same for the original Microsoft Dynamics AX client that started the upgrade cockpit and the additional Microsoft Dynamics AX clients, then the new clients detect that an upgrade is running, and they start a batch server.

To start the upgrade cockpit manually, do the following:

103. Start the new Microsoft Dynamics AX client.
104. Select Basic > Periodic > Batch > Processing. 

The Set up batch processing dialog box opens.

105. Add DataUpgrade in the Group field, and click OK.

This client checks the batch table for records that are assigned to DataUpgrade, and runs the jobs that are in the queue.

Note   If you are running a batch job on the same client as you are running the upgrade cockpit, you must ensure that you are running in the DAT company.
Data upgrade cockpit and batch execution

The data upgrade cockpit interacts with the batch queue. When you click Run, jobs are sent to the batch queue, and updated jobs are received from the batch queue with their new status. The batch queue sends and receives jobs from the batch server, where the jobs are processed.

The stages in which jobs are sent to the batch queue are categorized as Start, Standard, Shared, and Final. 

· Standard jobs are run once for each company. 

· The other categories run only once during the upgrade, no matter how many companies you have in the database.

The graphic below shows how jobs are transferred between the upgrade cockpit to and from the batch queue, and between the batch queue to and from the batch server.
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Handle errors

When the status of a job is Error, you can detect the source of the error by doing the following:

106. Highlight the row that shows the error, and click View job errors.
A new dialog appears that shows the source of the error.

107. After you have investigated the source of the error and fixed it, click Rerun job to run this job again. The status of this job becomes Waiting. 

Detect bottlenecks

When the status of a job is Waiting, you can detect which jobs it is waiting for by selecting the job and clicking View job predecessors. A dialog box opens showing you which jobs must be finished before this job can be put into the batch queue.

You can also detect how much time various jobs have been running by sorting through the Time running column. This indicates the time the jobs have been running, so that you can detect scripts that are running an unusually long time.

Create an upgrade project

The Create upgrade project tool analyzes your installation, deletes duplicate objects, and creates a project with application objects that must be upgraded manually.

The objects are those that have been changed in the new release and which also exist in your Application Object Layer.

Creating an upgrade project

108. From the Microsoft Dynamics AX client menu, click Tools > Development tools > Version update > Create upgrade project.
The dialog box informs you of the project name. Delete obsolete changes is selected.

Note   If you do not want changes removed, clear the Delete obsolete changes.

109. Click OK.

A new upgrade project is created.

Choosing alternatives to the create upgrade project tool

As an alternative to the Create upgrade project tool, you can use the Compare layers tool to compare any two layers and create a project with the objects that differ.

Note   Unlike Create upgrade project, you cannot select to delete duplicates. Consequently the Compare layers tool may also be useful as a general tool, for example to give an overview of modifications made in a certain layer.

If you have Developer rights, you can use the Project filter tool in the upgrade process as an alternative to both the Create upgrade project and Compare layers tools. Project filter lets you create a project based on criteria supplied in the query form. For example, such criteria could be all objects from a relevant layer, all objects with a specific prefix, or all objects created by a specific user. For information on creating a project using the project filter, see Using the project filter.

Test the system after data upgrade

After upgrading your data, test whether your installation is functioning properly before proceeding to upgrade in the production environment. This is a good time to test any documentation and training you have created.

To test whether the data upgrade to the Microsoft Dynamics AX system has succeeded, perform at least these minimum steps:

· Start all Application Object Server (AOS) instances.

· Launch a client that is connected to each AOS instance that is running.

· Test that users can execute the most common tasks for your system.

· Test that the administrator can run the system maintenance tasks.

· Test that users can execute the most vital tasks for your system.

· Test that users can read the reports that are generated.

· Test that the permissions settings is working right by checking that users have access to the data they had access to prior to upgrade.

· Validate that your data is consistent with that prior to upgrade.

Move upgrades to a production environment

Before you start the upgrade project in the production environment, see:

· Before you begin upgrading,

· Upgrade your code in the test environment, and

· Upgrade your data in the test environment. 

Moving upgrades to a production environment entails the following procedures:

· Prepare your production environment for upgrade
· Migrate customizations  

· Run the Dynamics AX DB Upgrade Preparation Tool
· Upgrade checklist 

· Compile the application
· Add license keys
· Prepare database for data upgrade (Pre-synchronize data upgrade)
· Synchronize your database
· Update data in all company accounts (Post-synchronize data upgrade)
· Create an upgrade project
· Test the upgraded system before you Go live
· Disable Keep update objects (SysDeletedObjects40)
· GoLive
Flowchart: Upgrade in the production environment

The figure below shows the process flow to upgrade your system in the production environment: 
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Prepare your production environment for upgrade

To learn about important prerequisites before you begin this process, see Before you begin upgrading.

Perform the following tasks on a backup of your Microsoft Axapta 3.0 production system. Before you upgrade in the live environment, test the upgrade in the test environment. For more information, see Test the system after data upgrade.

Prepare your production environment by doing the following:

1. Preparation

110. Turn the production environment offline.
111. Back up your data. See SQL Server information, located at Microsoft SQL Server documentation.

2. Clean up data

Remove data in the Microsoft Axapta 3.0 database that is not needed for audit trails and that is slowing down performance or making the database unnecessarily large. Before you upgrade your database, select the type of data that you want to clean up by using the standard filtering mechanism.

112. Start Axapta 3.0 in your test environment (Start > All programs > Navision Axapta), and log on.
113. Open the Application Object Tree (AOT).

114. Under \Menu Items\Action, open and run the following forms to clean up the respective types of data:

· SysUserLogCleanUp

· SysDatabaseLogCleanUp

· ProdJournalCleanUp

· InventJournalCleanUp

· ProdTableCleanUp

· SalesParmCleanUp

· PurchParmCleanUp

· LedgerJournalCleanUp

3. Left justify tables

Left justify some or all tables in the Axapta 3.0 system. Do this to properly upgrade the database, because in Microsoft Dynamics AX all Microsoft shipped layers have left justified fields and data types only:

115. Start Axapta 3.0 in your test environment (Start > All programs > Navision Axapta) and log on.
116. Open the Application Object Tree (AOT).

117. Click the Import icon.

The Import window appears.

118. In the File name field, enter \AX4 DVD\DatabaseUpgrade\PrivateProject_LeftJustified.xpo and click OK.

This creates a project called LeftJustified.

119. Click the Project icon, and open Private > LeftJustified (usr).

120. In Project LeftJustified, right-click MainJob (usr) and select Open.

An Infolog appears stating how many records have been inserted, and the Left Justify form appears.

121. In the Left Justify form, select the base type for the fields to left justify.

This creates a list of tables and columns that are presently right justified.

122. To left justify individual tables, select the row and click Left Justify
- or -

To left justify all the tables in the base type, click Left Justify All.

4. Prepare database for Record Identification type changes

Import and run the UpgradeColumnList.xpo in the Axapta 3.0 system in the test environment. Do this to prepare the 3.0 database for RecID-type changes from 32 bit integer to 64 bit integer:

123. Start Axapta 3.0 in your test environment (Start > All programs > Navision Axapta), and log on.
124. Open the Application Object Tree (AOT).

125. Click the Import icon.

The Import window appears.

126. In the File name field, enter the path to your installation CD and \AX4 CD\DatabaseUpgrade\PrivateProject_UpgradeColumnList.xpo and click OK.

127. Open the AOT and click Forms > UpgradeColumnList.

128. Right-click UpgradeColumnList and select Open.

129. Click Generate, and wait until the operation is complete.

This could take up to two minutes. This job identifies the record identification and transaction identification fields that are based on the recId and on the TransactionId data type. Fields that contain transaction identification or record identification references but are incorrectly based on the int data type are not identified by the job. 

Such incorrectly typed Axapta 3.0 fields can be handled in one of the following ways:

· Append the list of such fields to the internal list of known incorrectly typed Axapta 3.0 fields of the same type that are hard-coded in the cleanup() method (UpGradeColumnListGenerator class). Then run the UpgradeColumnList job again to have the database updated.

· Manually update the int data type in Microsoft Dynamics AX after the upgrade checklist has been executed.

130. Close Axapta 3.0.

Prepare a Microsoft Dynamics AX system for upgrade in the production environment

This procedure creates a Microsoft Dynamics AX installation, and migrates the changes you made in the code and data structure in Upgrade your data in the test environment.

131. Install Microsoft Dynamics AX.
Be sure to clear the Start the AOS Windows service as part of installation check box when you install the application object server.

For complete guidelines, see Installing a core system. This installs an application, a client, and an Application Object Server (AOS). In the case of a SQL installation, this also installs a new, empty Microsoft Dynamics AX database.

132. Run the DB Upgrade Preparation Tool 

133. (Optional) Copy all of the Microsoft Axapta 3.0 application files (*.aod) from your Axapta 3.0 system to:

Microsoft Dynamics\4.0\Application\Appl\Standard\Old

Note   Existing axsys.aod and axusr.aod files in this folder are overwritten. If there is only an axusr.aod file, then it is overwritten, and an empty axsys.aod file is created.

134. Copy the updated Microsoft Dynamics AX application files (*.aod) from code upgrade in your test environment to:

Microsoft Dynamics\4.0\Application\Appl\Standard

135. Delete the index file (axapd.aoi) from the standard directory.

136. Start the Application Object Server (AOS).

137. Start the Microsoft Dynamics AX client.

Run the Dynamics AX DB Upgrade Preparation Tool

The Microsoft Dynamics AX DB Upgrade Preparation Tool can be run only once. The tool is not installed as part of the Microsoft Dynamics AX installation but must be run from the product DVD. 

Note   The tool requires read access to the source database and write access to the target database. The target database requires read/write access to the temporary directory.

138. On the computer on which the Application Object Server (AOS) is being upgraded or installed, insert the product DVD.
139. Start the Dynamics AX DB Upgrade Preparation tool from Microsoft Windows Explorer or from a command prompt. The file name of the tool is AxDbUpgrade.exe.

To enable multithreading, run the tool from a command prompt as:

AxDbUpgrade.exe /pn
Where n is the number of threads (minimum 1 and maximum 64 threads), for example: AxDbUpgrade.exe /p8 (8 threads).

140. On the Microsoft SQL Server or Oracle tab, enter the required server and database information and click Start.

For information about the dialog box options, see Dynamics AX DB Upgrade Preparation.

141. When the upgrade preparation completes, a message displays on the screen. Click OK to close the message.

Upgrade checklist

Use the Upgrade checklist during Setup to guide you through the tasks needed for an upgrade. As each option is completed, the item is checked by the system. Most of these items are one-time setup options. 

Icons are used to mark the status of the tasks involved. Some tasks are mandatory, and some tasks depend on other tasks being completed first. Tasks must be completed from the top down.

The Upgrade checklist starts automatically when you:

· Install a new version of Microsoft Dynamics AX on top of an existing version

· Install a new service pack on top of an existing version of Microsoft Dynamics AX
· Import a .dat file (*.dat) that is exported from an older version of Microsoft Dynamics AX.
An automatic pop-up is triggered by comparing the version number in the current application and the version number in the new application or in the *.dat file. You can also open the Upgrade checklist by clicking Administration > Setup > System > Checklists > Upgrade checklist. 

Upgrade checklist

· Compile application - Update references and ensure that the application is ready for use. This process takes 30 minutes or more to run, and must be completed if there is more than one layer in your system. This ensures that all object references are updated and the application is ready to use. This is also necessary during new installations with a Service Pack, since the references form the standard application must also be updated. This option is also available from under Administration > Periodic > Compile application. Close the Compiler output window when finished. For more information, see Compile the application. 

· License information - Import or enter the Microsoft Dynamics AX licenses that were purchased. The license information is used to enable the modules and functions that your company is implementing. This option is also available from under Administration > Setup > System > License information. For more information, see Add license keys.

· Presynchronize data upgrade - Gets database information ready for synchronization. For more information, see Prepare database for data upgrade (Pre-synchronize data upgrade).

· Synchronize - Synchronizes the database data. For more information, see Synchronize your database.

· Postsynchronize data upgrade - Finalizes the synchronization of database information. For more information, see Update data in all company accounts (Post-synchronize data upgrade).

· Create upgrade project - Uses the Compare tool in Microsoft Dynamics AX to find objects that conflict with lower layer objects and which need a manual upgrade. Obsolete objects are deleted. For more information, see Create an upgrade project.

Symbols used in the upgrade checklist

The following table gives an overview of the icons used in the checklist framework.
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	Ready
	This task is ready to run. Click the link to start the task.

When the task is finished (when the form related to the task is closed), the icon changes to Checklist [image: image55.png]
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	Optional. Click the icon to mark as finished.
	This task is optional. Click the link to start the task, or click the icon to bypass the task.
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	Waiting
	This task is dependent on other tasks and can only be run when these other tasks are complete.
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	Finished
	This task is finished, but you can still click the link to run the task.
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	Additional help
	Click this icon to get additional help relating to the task.


What does a service pack do?

As a general rule service packs never add new objects to the data dictionary but everything else can be modified by a service pack. All object identifications must be preserved through all service packs for a given version.

Field identifications

If a field is deleted and you subsequently restore a backup, the field gets a new identification even though it logically has not changed. This means that all your code that refers to this field will not execute.

During development you may decide that you do not need a specific field. Instead of deleting the field, rename the field using the following format:

DEL_<Original Name>

This makes sure that you maintain the same field identification, and if you need this field later on, it is just a matter of removing the DEL_ from the field name.

Tip   Create a new security key that can be added to the items that you want to delete. This is a safe way of "deleting." This strategy allows you to keep the field (and identification) in your project and when you are sure that your project runs without problems, you can disable the security key and get rid of the field in the physical database.

Compile the application

Compile the whole application because it ensures that all object references are updated and the application is ready to use.

Compiling the application takes the application source code, translates it into binary code that can be interpreted by the kernel and stores it in the .aod file.

This is also necessary during new installations with a Service Pack, since the references from the standard application must also be updated.

This option is available from either of the following:

· The installation checklist

Administration > Setup > System > Checklists > Installation checklist
· The Administration navigation pane

Administration > Periodic > Compile application
Close the Compiler output dialog box when the compilation is finished.

Important   The compilation takes an hour or more to complete, depending on your hardware, and it is critical that the compilation completes.

Add license keys

Enter license information manually using information from your license document, or if provided, import the license codes from a file. You must have Administrator access rights in order to save a license code. 

To be able to use Microsoft Dynamics AX, enter the license codes, and check the Status field to see that each code is verified.

Note   If you are changing your current license settings as a result of updating license keys, the new functionality does not take effect until the client has been restarted.

In addition to license codes for Microsoft Dynamics AX functionality, access to the Microsoft Dynamics AX development environment is divided into four different licenses. For more information, see Development access licenses.

If you do not have a license, you can still set up Microsoft Dynamics AX in demonstration mode. For more information, see Demonstration mode.

Import license information

142. Click Administration > Setup > System > License information.
143. Click Load license file to import the license codes from a file.

The Load license file dialog box appears.

144. Click the folder icon and browse for your license file.

145. Click OK.

The Configuration dialog box appears and you are asked if you want to synchronize your database. 

146. Click Yes.

147. Close the License information window.

Enter license information

An alternative to importing the license information, you can enter the license information manually:

148. Click Administration > Setup > System > License information.
149. Enter the name of the license holder, the system's serial number, and the expiration date. The information is in your license document.

150. On the System tab page, enter the License code and verify that the Status field displays the expected text.

The license code indicates whether you have a standard, professional, or enterprise solution.

Note   The first four entries (name of the license holder, the system's serial number, expiration date, and license code) determine what appears in the remaining codes, and it is therefore essential that they are entered correctly.

151. Enter the remaining codes.

For each, check the Status field to ensure that the code is accepted.

Development access licenses

Development access in Microsoft Dynamics AX is divided into four different licenses:

· Base Package

· MorphX

· Web MorphX

· X++

Base Package

Base Package gives access to:

· Create or modify menus (user menus, main menu, and so on).

· Create or modify user Forms.

MorphX

The MorphX development license gives access to the Data Dictionary node, where tables, fields, enums, and extended data types are maintained. MorphX development license also gives the ability to create or modify forms.

It is possible to add, change and delete forms, tables, extended data types, macros, menus, reports, jobs, and queries. Methods related to tables, for instance forms, can be changed. For example, this allows you to change the standard information when adding new customers. 

An example of a change in extended data types by using MorphX is changing the lengths of account numbers.

The Application Object Tree (AOT) displays the following nodes:

· Data Dictionary

· Forms

· Macros

· Reports

· Queries

· Jobs

· Menus

· Menu Items

· Resources

· System Documentation

· Application Developer Documentation

· Application documentation

Web MorphX

The Web MorphX Development Suite license gives access to the Microsoft Dynamics AX Web Development Framework.

The AOT displays the following nodes:

· Web Forms

· Web Reports

· Web Menus

· Web page

· Web Editor

· Style Sheet Editor

X++

The X++ development license gives you full access to all classes in Microsoft Dynamics AX, and the development code for the CUS layer. This gives you the ability to modify things like the invoice routine, or the posting process for a ledger journal. Having the development code for the CUS layer allows customers to place their modified application objects in the CUS layer, or the USR layer, or both. 

It is possible to add, change, and delete classes. For example, you could change the logic in an invoice update, which is defined in the class SalesFormLetter.

Prepare database for data upgrade (Pre-synchronize data upgrade)

Use the data upgrade cockpit before you synchronize the database and data. When you pre-synchronize data, this prepares the following:

· The Microsoft Axapta 3.0 database schema for synchronization.

For example, it deletes duplicates or disables unique indexes such as ReleaseUpdateDB_V30toV40::allowDupPurchParmTable.

· Any metadata changes with an "undo" in the post-synchronization phase. 

The data upgrade cockpit helps manage the upgrade by using batch functionality. The tool gives an overview of the jobs that must be run when you upgrade from Axapta 3.0 to Microsoft Dynamics AX, and helps you manage their processing. One line in the table represents one upgrade job. 

Open the data upgrade cockpit from the Upgrade checklist by clicking Administration > Setup > System > Checklists > Upgrade checklist > Presynchronize data upgrade.

Note   You must complete all preceding tasks in the Upgrade checklist in order to work with the data upgrade cockpit.

The upgrade cockpit opens in Pause mode. Click Run to submit jobs to batch.

The status of a job is either Ready, Waiting, Executing, Finished or Error.

After you pre-synchronize the database, the database is ready for changing the data table structure and executing the data upgrade by synchronizing the database. For more information, see Synchronize your database and Update data in all company accounts (Post-synchronize data upgrade)
Process upgrade jobs

152. Select Administration > Setup > System > Checklists > Upgrade checklist > Presynchronize data upgrade.
The upgrade cockpit opens in Pause mode and is populated with upgrade jobs.

153. Click Run.

Jobs are submitted to the batch queue.

154. Start the batch server in one of two ways:

· Start a new client

– or –

· Select Basic > Periodic > Batch > Processing.

The status of the upgrade jobs is either Ready, Waiting, Executing, Finished or Error.

Run jobs in parallel

Jobs in the data upgrade cockpit should be run in parallel, as opposed to in sequence. Upgrading can be processed faster when several jobs are running simultaneously. When the cockpit is activated, several client computers can be used to process the jobs. The client computer that is running the upgrade checklist fills the batch table with all the scripts that need to run, and assigns them to the batch group called DataUpgrade. Performance improvement peaks at 20 client computers running in the batch.

If the user account is the same for the original Microsoft Dynamics AX client that started the upgrade cockpit and the additional Microsoft Dynamics AX clients, then the new clients detect that upgrade is running, and then start a batch server.

To start the upgrade cockpit manually, do the following:

155. Start the new Microsoft Dynamics AX client.
156. Select Basic > Periodic > Batch > Processing. 

A batch dialog appears.

157. Add DataUpgrade in the Group field, and click OK.

This client checks the batch table for records that are assigned to DataUpgrade, and runs the jobs that are in the queue.

Note   If you are running a batch job on the same client as you are running the upgrade cockpit, you must ensure that you are running in the DAT company.
Data upgrade cockpit and batch execution

The data upgrade cockpit interacts with the batch queue. When you click Run, jobs are sent to the batch queue and updated jobs are received from the batch queue with their new status. The batch queue sends and receives jobs from the batch server, where the jobs are processed.

The stages in which jobs are sent to the batch queue are categorized as: Start, Standard, Shared, and Final. Standard jobs run once for each company, while the other categories run only once during the upgrade, no matter how many companies you have in the database.

The graphic below shows how jobs are transferred between the upgrade cockpit to and from the batch queue, and between the batch queue to and from the batch server.
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Handle errors

When the status of a job is Error, you can detect the source of the error by doing the following:

158. Highlight the row that shows the error, and click View job errors.
A new dialog appears that shows the source of the error.

159. After you have investigated the source of the error and fixed it, click Rerun job to run this job again. The status of this job becomes Waiting.

Detect bottlenecks

When the status of a job is Waiting, you can detect which jobs it is waiting for by selecting the job and clicking View job predecessors. A dialog appears showing you which jobs must be finished before this job can be put into the batch queue.

You can also detect how much time various jobs have been running by sorting through the Time running column. This indicates the time the jobs have been running, so that you can detect scripts that are running an unusually long time.

Synchronize your database

Synchronize the database from the Upgrade checklist by clicking Administration > Setup > System > Checklists > Upgrade checklist > Synchronize.

Synchronize the table and index information to the database. By doing this, Microsoft Dynamics AX creates all the tables it needs to operate. Do this when schema changes in the Application Object Tree (AOT) are populated to the database. Synchronization generates the Microsoft Dynamics AX index (axapd.aoi).

Update data in all company accounts (Post-synchronize data upgrade)

Use the data upgrade cockpit after you synchronize data. When you post-synchronize data, this is where the bulk of the data upgrade happens, and it undoes metadata changes from the pre-synchronization phase.

The data upgrade cockpit helps manage the upgrade by using batch functionality. The tool gives an overview of the jobs that must be run when you upgrade from Microsoft Axapta 3.0 to Microsoft Dynamics AX, and helps you manage their processing. One line in the table represents one upgrade job.

Open the data upgrade cockpit from the Upgrade checklist by clicking Administration > Setup > System > Checklists > Upgrade checklist > Postsynchronize data upgrade. 

Note   You must complete all preceding tasks in the Upgrade checklist in order to work with the data upgrade cockpit.
The upgrade cockpit opens in Pause mode. Click Run to submit jobs to batch.

The status of a job is either Ready, Waiting, Executing, Finished or Error.

After you complete post-synchronization, you are ready to create the upgrade project. For more information, see Create an upgrade project.
Process upgrade jobs

160. Select Administration > Setup > System > Checklists > Upgrade checklist > Postsynchronize data upgrade.
The upgrade cockpit opens in Pause mode and is populated with upgrade jobs.

161. Click Run.

Jobs are submitted to the batch queue.

162. Start the batch server in one of two ways:

· Start a new client

– or –

· Select Basic > Periodic > Batch > Processing.

The status of the upgrade jobs is either Ready, Waiting, Executing, Finished or Error.

Run jobs in parallel

Jobs in the data upgrade cockpit should be run in parallel, as opposed to in sequence. Upgrading can be processed faster when several jobs are running simultaneously. When the cockpit is activated, several client computers can be used to process the jobs. The client computer that is running the upgrade checklist fills the batch table with all the scripts that need to run, and assigns them to the batch group called DataUpgrade. Performance improvement peaks at 20 client computers running in the batch.

If the user account is the same for the original Microsoft Dynamics AX client that started the upgrade cockpit and the additional Microsoft Dynamics AX clients, then the new clients detect that an upgrade is running, and they start a batch server.

To start the upgrade cockpit manually, do the following:

163. Start the new Microsoft Dynamics AX client.
164. Select Basic > Periodic > Batch > Processing. 

The Set up batch processing dialog box opens.

165. Add DataUpgrade in the Group field, and click OK.

This client checks the batch table for records that are assigned to DataUpgrade, and runs the jobs that are in the queue.

Note   If you are running a batch job on the same client as you are running the upgrade cockpit, you must ensure that you are running in the DAT company.
Data upgrade cockpit and batch execution

The data upgrade cockpit interacts with the batch queue. When you click Run, jobs are sent to the batch queue, and updated jobs are received from the batch queue with their new status. The batch queue sends and receives jobs from the batch server, where the jobs are processed.

The stages in which jobs are sent to the batch queue are categorized as Start, Standard, Shared, and Final. 

· Standard jobs are run once for each company. 

· The other categories run only once during the upgrade, no matter how many companies you have in the database.

The graphic below shows how jobs are transferred between the upgrade cockpit to and from the batch queue, and between the batch queue to and from the batch server.
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Handle errors

When the status of a job is Error, you can detect the source of the error by doing the following:

166. Highlight the row that shows the error, and click View job errors.
A new dialog appears that shows the source of the error.

167. After you have investigated the source of the error and fixed it, click Rerun job to run this job again. The status of this job becomes Waiting. 

Detect bottlenecks

When the status of a job is Waiting, you can detect which jobs it is waiting for by selecting the job and clicking View job predecessors. A dialog box opens showing you which jobs must be finished before this job can be put into the batch queue.

You can also detect how much time various jobs have been running by sorting through the Time running column. This indicates the time the jobs have been running, so that you can detect scripts that are running an unusually long time.

Create an upgrade project

The Create upgrade project tool analyzes your installation, deletes duplicate objects, and creates a project with application objects that must be upgraded manually.

The objects are those that have been changed in the new release and which also exist in your Application Object Layer.

Creating an upgrade project

168. From the Microsoft Dynamics AX client menu, click Tools > Development tools > Version update > Create upgrade project.
The dialog box informs you of the project name. Delete obsolete changes is selected.

Note   If you do not want changes removed, clear the Delete obsolete changes.

169. Click OK.

A new upgrade project is created.

Choosing alternatives to the create upgrade project tool

As an alternative to the Create upgrade project tool, you can use the Compare layers tool to compare any two layers and create a project with the objects that differ.

Note   Unlike Create upgrade project, you cannot select to delete duplicates. Consequently the Compare layers tool may also be useful as a general tool, for example to give an overview of modifications made in a certain layer.

If you have Developer rights, you can use the Project filter tool in the upgrade process as an alternative to both the Create upgrade project and Compare layers tools. Project filter lets you create a project based on criteria supplied in the query form. For example, such criteria could be all objects from a relevant layer, all objects with a specific prefix, or all objects created by a specific user. For information on creating a project using the project filter, see Using the project filter.

Test the upgraded system before you go live

Before you go live, test whether your installation is functioning properly in the production environment. 

To test whether the upgrade to the Microsoft Dynamics AX system has succeeded, perform at least these minimum steps:

· Start all Application Object Server (AOS) instances.

· Launch a client that is connected to each running AOS instance.

· Test that users can execute the most common tasks for your system.

· Test that the administrator can run the system maintenance tasks.

· Test that users can execute the most vital tasks for your system.

· Test that users can read the reports that are generated.

· Test that the permissions settings is working right by checking that users have access to the data they had access to prior to upgrade.

· Validate that your data is consistent with that prior to upgrade.

Disable Keep update objects (SysDeletedObjects40)

After you have upgraded your system, you should disable the Keep update objects (SysDeletedObjects40) configuration key. Disable this configuration key in order to delete obsolete application objects that have the prefix DEL_.

Note   Do not disable this configuration key until your data upgrade is complete.

170. Click Administration > Setup > System > Configuration.
The Configuration form appears.

171. Expand Administration.

172. Disable Keep update objects, and click OK.

Go live with an upgraded system

After you have upgraded Microsoft Dynamics AX in the production environment and tested the system, the users of the system must be made aware of how the changes affect their work. To do this, ensure that:

· Everyone is properly trained, so they know how to work in the upgraded environment.

· The upgraded environment has been tested properly.

· The data migration has been properly handled, so that the data makes sense to those using it.

· Users realize the benefits of the new system. 

If problems do occur, then there must be a problem response mechanism in place to deal with them. This system should be simple and provide a means for tracking progress in resolving the problem, and informing the users once a solution is found.

For information about how to troubleshoot your system, see Troubleshooting.

Upgrade your Help system your Help system

Upgrade your Help system to have the same look and feel as Microsoft Dynamics AX Help, and connect your upgraded Help system to Microsoft Dynamics AX. 

The required tools are as follows:

· HTML editor (Notepad, Macromedia HomeSite, or Macromedia RoboHelp)

· HTML Help Workshop
· HelpKit.zip

The HelpKit.zip file contains the following:

· Icons

· Classic.css

· Script_main.js – Provides Help functionality

· MyHelpFile.hhp – The Help project file

· Sample templates as follows:

· Procedure.htm
· Topic.htm
· Topic_NoExpandCollapse.htm
· TopicSimple.htm
· TopicWithSyntax.htm
Upgrade your Help system by completing the following tasks.

173. Configure the Help
174. Create custom Help content
175. Link Help to forms and fields
Configure Help settings settings

You can configure the following Help settings:

· The .chm and .hhc file names

· The topic that appears by default when the .chm file is opened

· The Help window title

For more information about these modifications, see Help (Microsoft HTML Help) in HTML Help Workshop.
Configure Help

176. Open HelpKit.zip, and then save the contents to your local computer. (Download HelpKit.zip if you haven't already done so.)
Important   The files contain links with relative paths. You must preserve the \html and \local folder structure.

177. Rename MyHelpFile.hhp (included in HelpKit.zip).

178. Open the file that you renamed in step 2.

179. Replace all the bold placeholder text in the following code by using Notepad or HTML Help Workshop.

[OPTIONS]

Auto Index=Yes

Compatibility=1.1 or later

Compiled file=${MyHelpFile}$.chm

Contents file=${MyHelpFile}$.hhc

Display compile progress=No

Default Window=Main

Default Topic=html/${MyDefaultTopic}$.htm

Error log file=hhcLog.txt

Full-text search=Yes

Language=0x409

Title=${MyTitle}$
[WINDOWS]

Main="${MyTitle}$","${MyHelpFile}$.hhc",,html/${MyDefaultTopic}$.htm",
"html/${MyDefaultTopic}$.htm",,,,,0x23520,,0x3006,,,,,,,,0
Create custom Help content

Create custom Help content for Microsoft Dynamics AX by creating HTML Help topics, and then compiling those topics.

Use the templates in HelpKit.zip and an HTML editor, such as Notepad, Macromedia HomeSite, or Macromedia RoboHelp, to create Help topics. Compile them by using HTML Help Workshop. For more information about using the templates, see the Templates and HTML section later in this topic.

The templates contain various content elements, such as the following:

· Headings

· Paragraphs

· Tables

· Code blocks

· Hyperlinks

· Lists

· Notes

Download the following tools:

· HelpKit.zip
· HTML Help Workshop
For information about how to use HTML Help Workshop, see its Help.

Create a custom Help topic

180. Create a topic based on a template by making a copy of the following .htm files, which are located in the \HelpKit\htmlhelp\html folder. 
· Procedure.htm

· Topic.htm

· Topic_NoExpandCollapse.htm
· TopicSimple.htm

· TopicWithSyntax.htm

181. Double-click the file to view it in Microsoft Internet Explorer. 

The page displays a topic structure, and contains placeholder text demarcated by ${ … }$.
Note   If an error message about blocked content appears, right-click the banner that appears at the top of the .htm page, and then click Allow Blocked Content. 

182. Open the file in an HTML editor, such as Notepad, search for ${, and then type your text.
Note   To add existing content from a previous version of the Microsoft Dynamics AX Help system or an external content source, you can either manually or programmatically copy the content to the file.
183. Save the file, and open it again in Internet Explorer to see your changes.

184. Repeat steps 1 through 4 to create another topic.

Compile the Help topics

185. Open the .hhp file in HelpKit.zip. For more information, see Configure Help.
186. Create a table of contents, and then add topics to it by using HTML Help Workshop.

187. Create a compiled HTML Help (.chm) file by using HTML Help Workshop.
Templates and HTML
The templates that are included in HelpKit.zip contain <span> and <div> structures that must be preserved. Removing a <span> or <div> tag can result in the following issues:

· Display errors

· Script errors

· Topic sections do not expand and collapse

Expand and collapse topic sections
The templates include the following structure. It enables users to expand and collapse topic sections.
    <h1 class="heading">

        <span onclick="ExpandCollapse(section0Toggle)"…><img …>

            Heading Text

        </span>

    </h1>

    <div id="section0Section" class="section" name="collapseableSection"…>

        <content>

            <p>Paragraph Text</p>

    </content>

    </div>

The <h1> tag contains a <span> tag for toggling the ExpandCollapse region. It is identified by the succeeding <div> tag. The first part of the region identifier, section0), is the same in both tags.
Important   ExpandCollapse region identifiers must be unique. If you add a structure for expanding and collapsing content by copying an existing structure, you must update the identifier in the <span> and <div> tags to the next numeric value (for example, section1, section2, section3).
Nested headings

Nested headings (for example, Heading 2, Heading 3, and so on) must be contained in <SECTIONS> tags.

The following code example shows how a Heading 2 section is inserted. Note that the ExpandCollapse identifiers are unique for the Heading 2 section.

    <h1 class="heading">

            <span onclick="ExpandCollapse(section0Toggle)"…><img …>

            Heading Text

        </span>

    </h1>

    <div id="section0Section" class="section" name="collapseableSection"…>

        <content>

            <p>Paragraph Text</p>

        <sections>

            <p>

            <span onclick="ExpandCollapse(section1Toggle)"… >

                <img …>

                <b>${Insert Heading 2 Here}$</b>

            </span>

            </p>

            <div id="section1Section" class="section" …>

                <content>

                    <p>${Insert Paragraph Here}$</p>

                    <!-- For Heading 3, add the SECTIONS block here.--> 

                </content>

            </div>

        </sections>

        </content>

    </div>

Link Help to the AOT

Link Help topics to Application Object Tree (AOT) items, such as forms. This is done as follows:

188. Create an HTML Help item.
189. Link the topic to a form or other AOT item, such as a class.

Create an HTML Help item

190. In the AOT, right-click HTML Help Files, and then click New HTML Help File to create a Help item.
191. Right-click the Help item you created in step 1, and then click Properties.
192. Modify the Name property to specify a unique name for the Help item.
193. Type the name of the .chm file in the Filename property. Do not include the file path.

194. Select Yes in the AddtoCollection property list to display the Help item on the Microsoft Dynamics AX Help menu.

195. Set the Description property.

196. Right-click the Help item, and then click Save.
Link a topic to a form

197. In the AOT, click Forms.
198. Click the form that you want to link a topic to, and then click Designs > Design.
199. Right-click Design, and then click Properties.
200. Select the previously created Help item from the HTMLHelpFile property list.
201. Type the .htm file name for the topic in the HTMLHelpTopic property box. 
Note   If you created a compiled HTML Help (.chm) file with .htm files in a folder structure, you must include a path with the file name (for example, html/myFile.htm). You don't need to specify the .chm file name (for example, myCHM.chm::/html/myFile.htm).
For more information about creating .htm files for topics, see Create custom Help content.
Link a topic to other AOT items

202. In the AOT, navigate to the item to which you want to link a topic. 
203. Right-click the item, and then click Properties.

204. Repeat steps 4-5 in the Link a topic to a form procedure.

Upgrade Enterprise PortalEnterprise Portal

You can migrate a site from Enterprise Portal in Microsoft Axapta 3.0 to Enterprise Portal in Microsoft Dynamics AX by going through the following multi-step manual process. Before migrating a site to Microsoft Dynamics AX Enterprise Portal

205. Upgrade to Microsoft Dynamics AX. For details, see Upgrading to Microsoft Dynamics AX.
206. Install Microsoft Dynamics AX Enterprise Portal on the Web server. For details, see Set up an Enterprise Portal server. 

Changes in Enterprise Portal

Many features were changed between Enterprise Portal in Axapta 3.0 and Microsoft Dynamics AX. For details, see What's new in Enterprise Portal.

Automatic changes

The following changes are made to Enterprise Portal automatically:

· Data is automatically migrated as part of the upgrade process.

· All out-of-the box Axapta 3.0 Enterprise Portal objects are automatically upgraded.

Manual changes

The following changes must be made to Enterprise Portal manually.

Changes in the Application Object Tree (AOT)

Make the following changes to Enterprise Portal objects in the AOT: 

· Create Webforms for any forms that you want to use in your Enterprise Portal Web site.

· For any Webforms, Webreports, and Weblets that you have re-created, review your code, and remove references to the following: 

· Web user

· In memory variable

· Menuitem (change all to WebMenuItem)

· Create Web content. For complete instructions, see Using Microsoft Dynamics AX and Web Sites.

· Modify the Axapta 3.0 style sheets, as needed. For details, see Modify Style Sheets. 

Re-create functionality in SharePoint

The following functionality must be re-created in Microsoft Windows SharePoint Services.

· Web pages - Re-create your Web pages in SharePoint, and then remove all Web pages from the AOT, including standard, PDA, client and server. 

· Content management - Read the Help topic Manage Microsoft Dynamics AX documents on the Enterprise Portal and the SharePoint documentation for guidance on recreating content management functionality. Once you have recreated the functionality, remove all content management objects from Enterprise Portal.

Make changes to users

To move to an Microsoft Dynamics AX Enterprise Portal, you must:

· Set up external user access.

· Assign users to Enterprise Portal groups.

· Enable Web access for each user.

For details about how to perform these tasks, see Granting users access to Enterprise Portal. 

Moving the new site to production

Moving a new Enterprise Portal site to production follows the same steps as any other Web site. 

· Test the site on a staging server. 

· Move the site to a production server.

· Take down the Axapta 3.0 site from the production server, and add a redirect to the new site, if needed. 

Upgrade OLAP reporting

If your organization or business used Online Analytical Processing (OLAP) in Axapta 3.0 and you upgrade to Microsoft Dynamics AX, you must change the data source for all existing cubes to use integrated authentication. If you do not perform the configuration changes described here, your existing cubes will not retrieve and process data, even if you retransfer the cubes to the Analysis Services server.

Note   You do not have to perform these configuration changes in Microsoft Dynamics AX. By default, OLAP databases created in Microsoft Dynamics AX use integrated authentication.

To set integrated authentication for an OLAP data source

You have two options by which you can set integrated authentication for an OLAP data source:
· Create a new OLAP database in Microsoft SQL Server Analysis Services, and transfer all the cubes into that new database instance, or
· Manually update the OLAP database data source on the Analysis Services server to remove the username and password, and instead use Integrated Security=SSPI in the connection string. 
After you have set integrated authentication for your OLAP data source, you must configure the account running the OLAP service for Read access to the Microsoft Dynamics AX database.  

To configure account permissions for database access

207. From the Start menu, click All Programs > Microsoft SQL Server > SQL Enterprise Manager.
208. Expand the SQL Server hosting the Microsoft Dynamics AX database.

209. Expand the Security node.

210. Select Logins.

211. Click the New login button on the toolbar. The SQL Server Properties - New Login dialog box appears.

212. In the Name text box, enter a name in the form domain\machinename$. For example, EU\SQLServer4$.

213. Verify that Windows authentication is selected.

214. Verify the domain.

215. In the Default section, select the Microsoft Dynamics AX database.

216. Click the Database Access tab.

217. Select the Microsoft Dynamics AX database.

218. In the Database Roles for section, select the db_datareader role.

219. Click OK.
Important   Reprocess and retransfer all existing cubes. After you have retransferred the cubes, reset all user access permissions for those cubes in Analysis Services.
Note   If you experience problems trying to reprocess and retransfer the cubes, verify that the user who is trying to administer OLAP features is a member of the OLAP Admins group on the SQL Server Analysis Services computer.
Troubleshoot upgrade issues

This topic provides information about troubleshooting issues encountered in upgrading a Microsoft Dynamics AX system.

Virus scanner stops the Dynamics AX DB Upgrade Preparation Tool

The Dynamics AX DB Upgrade Preparation Tool creates interim files that may falsely be identified by your virus scanner, causing the Dynamics AX DB Upgrade Preparation Tool to fail.

If this problem occurs, disable your virus scanner, and restart the Dynamics AX DB Upgrade Preparation Tool.

Compile stalls during upgrade due to XRef error

If the compiler stalls during upgrade and produces an XRef error ("The database reported... INSERT INTO XREF..."), do the following:

220. In Axapta 3.0, open Tools > Options > Compiler > Setup, and deselect the "Cross-reference" check box.
221. Run the Dynamics AX DB Upgrade Preparation Tool.

222. Continue the upgrade process, as described in Upgrading to Microsoft Dynamics AX.

Client crashes at client startup in code upgrade

If you have completed all of the steps in Prepare a Microsoft Dynamics AX system for code upgrade and the client crashes, check for the following:

Class modifications that affect startup

Check whether you have modified any low-level code that is run during startup or code that is started from the class Info startup or Application startup.

If you have modified classes that prevent Microsoft Dynamics AX from starting up correctly, delete your modifications.

Database structure modifications

Check whether there are any name changes that conflict with the new database structure. It is possible that there are field name modifications that conflict with additions made by mcCoName. Field names must have unique IDs. Open the event viewer (Administrative tools > Event viewer) and check the event log, which identifies any fields that are duplicated.

Insufficient rights error during compile

If you get Insufficient rights errors when you compile Microsoft Dynamics AX during upgrade, check whether you have modified classes in either the VAR layer or BUS layer, and their patch layers, that require you to load a license. If you have modified classes that start up early and require a license, start the Application Object Server (AOS) and load the correct license before you copy the updated applications files to the Standard folder. The upgrade sequence would then be as follows:

223. Install Microsoft Dynamics AX (includes application, client, AOS, and new empty database).
224. Run the DB Preparation Tool from the installation DVD.

225. Start the AOS.

226. Start the Microsoft Dynamics AX client.

227. Load your license keys:

(Click Administration > Setup > System > License information).

228. Close the Microsoft Dynamics AX client.

229. Stop the AOS.

230. Copy the application files (*.aod) from all layers above the DIS layer to:

\Microsoft Dynamics\4.0\Application\Appl\Standard

231. Copy application files (*.aod) from all layers above the DIS layer to:

\Microsoft Dynamics\4.0\Application\Appl\Standard\Old

232. Delete the index file (axapd.aoi) from the Standard folder.

233. Start the AOS.

234. Start the Microsoft Dynamics AX client.

235. Run through the Upgrade checklist.

Installing and configuring Microsoft Dynamics AX

Setting up an Microsoft Dynamics AX system is a complex process.

Before you begin, you may want to read the following topics:

· Flowchart: Installation process
This topic provides a visual representation of the installation processes.

· Flowchart: Configuring a core installation
This topic provides a visual representation of the configuration process.

The table below describes what you will find in this section.

	Section 
	Description

	Rights required for installation
	Describes the rights you must have to install on each computer in the system.

	Installation order
	Describes the recommended installation order. 

	Considerations for multi-site or multi-language implementations
	Describes steps you may need to take when installing multi-site or multi-language implementations.

	Installing a core system
	Describes how to install a database, application file server, Application Object Server (AOS), and client, so that you can get your system started.

	Initial configuration
	Describes how to configure your Microsoft Dynamics AX installation so that you can start using it.

	Set up application security
	Describes how to secure your Microsoft Dynamics AX application.

The following sections provide detailed instructions for setting up and configuring extended functionality. 

	Setting up and configuring Business Connector
	Describes how to set up Business Connector and configure a Business Connector proxy account.

	Setting up and configuring an Enterprise Portal
	Describes how to set up and configure an Enterprise Portal.

	Setting up and configuring a reporting server
	Describes how to set up and configure a reporting server.

	Setting up and configuring an application integration server
	Describes how to set up and configure an application integration server.

	Setting up and configuring OLAP reporting
	Describes how to set up and configure an OLAP server.

	Setting up and configuring RFID
	Describes how to set up and configure Microsoft Dynamics AX to work with RFID.

	Managing version control
	Describes how to set up a version control system.

	Test an installation
	Describes how to test whether an installation has been successful.

	Troubleshooting
	Drovides information on troubleshooting during installation, and once a system is up and running.

	Silent installation
	Describes how to use parameters to run the Setup program without the user interface for broad deployments.

	Trial installations
	Describes how to download a Microsoft Virtual PC image of Microsoft Dynamics AX to use for demonstrations, and how to modify the Microsoft Dynamics AX demonstration data.


Rights required for installation

Before beginning the Microsoft Dynamics AX installation process, ensure that the account you log on with at each server has appropriate permissions. The permissions listed below are implemented using the principle of least privilege. Work with a system administrator to ensure that you have these rights.

Note   If you install Microsoft Dynamics AX using a domain account other than your own, that account must have appropriate permissions in the system.

	Action
	Permissions required for account

	Install an Application Object Server (AOS) instance.
	Member of Administrators group on the local computer.

Allow the AOS account (the domain account or Network Service account associated with the AOS service) Read and Write permissions on the folder in which the application files are installed.

	Create a Microsoft SQL Server database.
	Member of Database Creators role on the SQL Server instance.

	Connect an AOS instance to a SQL Server database. 
	Member of Database Security Administrators role on the SQL Server instance.

	Install application file server.
	Member of Administrators group on the local computer.

	Install a client.
	Member of Administrators group on the local computer.

	Install an Enterprise Portal server.
	Member of Administrators group on the local computer.

	Install an application integration server.
	Member of Administrators group on the local computer.

	Install a reporting server.
	Member of Administrators group on the local computer.

To set the reporting server to retrieve data from the Microsoft Dynamics AX SQL Server database, you must be logged on with an account that is a member of the Database Owner role on that SQL Server instance.

	Install the .NET Business Connector, or COM Business Connector.
	Member of Administrators group on the local computer.


Installation order

When installing Microsoft Dynamics AX, we recommend that you follow this process, whether in a development, test, staging, or production environment:

236. Set up and configure the core Microsoft Dynamics AX computer roles in the system, then using a small amount of test data, validate that the system works.
237. Set up and configure any additional computer roles and validate that the system works.

238. Apply any customizations and validate that the system works.

Recommended order for installing core computer roles

The recommended order for setting up the computers in the core roles in Microsoft Dynamics AX is: 

239. Database server.
240. Application file server.

241. Object Server.

Requires that you know the location of the database server and application file server.

242. Client.

Requires that you know the location of the Application Object Server (AOS).

Setting your system up in this order reduces the amount of post-installation configuration you must do. This is the order that the system uses when setting up a single-computer system.

Recommended order for installing additional roles

Although you can install all Microsoft Dynamics AX computer roles at the same time, we recommend that you install and configure the core Microsoft Dynamics AX system first. After the core system is running, we do not recommend any particular order for setting up computers in roles that provide additional functionality.

Considerations for multi-site or multi-language implementations

There are issues specific to multi-site or multi-language implementations of Microsoft Dynamics AX that you may encounter.

Running Microsoft Dynamics AX in a language different from the operating system

If you are running Microsoft Dynamics AX in multiple locales, you may need to install in a language different from the operating system's regional settings. There are specific issues you may encounter when running Microsoft Dynamics AX in Chinese on an English operating system.

Run Microsoft Dynamics AX in Chinese on an English operating system

On every computer in a Microsoft Dynamics AX implementation that is running in Chinese, you must ensure that the following options have been set before installing. Otherwise Setup cannot install Microsoft Dynamics AX to directories that contain Chinese characters.

243. Open the Regional and Language Options control panel (Start > Control Panel > Regional and Language Options).
244. On the Regional Options tab, select the language that you are installing in. If you do not see the language you need to use in the list, you must install supplemental language support files.

245. On the Languages tab, under Supplemental language support, select Install files for East Asian languages. If you need to perform this step, you must restart the computer.

246. On the Advanced tab, under Select a language to match the language version of the non-Unicode programs you want to use, select the same language you chose in Step 2.

247. Click OK.

Installing a core system

A core Microsoft Dynamics AX system consists of an instance of an Application Object Server (AOS), an application file server, a database, and at least one client. These components can be installed on computers arranged in a variety of topologies, but without all elements your system will not run.

Before you start installing your system, verify that your domain account has the correct permissions on each computer you will install to, or you will be unable to complete setup.

· For an overview of installation, see Flowchart: Installation process
· For an overview of the recommended topologies, see System topology recommendations.

· For an overview of Microsoft Dynamics AX architecture, see Microsoft Dynamics architecture. 

The table below describes what you will find in this section.

	Section
	Description

	Create an Axapta database (SQL Server)
	Describes how to create a SQL Server database using Microsoft Dynamics AX Setup.

	Create an Axapta database (Oracle)
	Describes how to set up an Oracle database to use with Microsoft Dynamics AX.

	Install a file server
	Describes how to install a file server using Microsoft Dynamics AX Setup, and how to choose regional functionality.

	Install an Axapta Object Server instance
	Describes how to install an AOS using Microsoft Dynamics AX Setup, how to install multiple AOS instances, and how to set up an AOS on a Network Load Balanced cluster.

	Install an Axapta client
	Describes how to install a client using Microsoft Dynamics AX Setup.

	Start Axapta
	Describes how to start Microsoft Dynamics AX after installing.

	Uninstall Microsoft Dynamics AX
	Describes how to uninstall axapta components.

	Install multiple instances of Microsoft Dynamics AX
	Describes how to install multiple instances of Microsoft Dynamics AX.

	Install Microsoft Dynamics AX on a single computer
	Describes how to install Microsoft Dynamics AX on a single computer.


Create a Microsoft SQL Server database

A Microsoft Dynamics AX database stores your Microsoft Dynamics AX data as part of an existing Microsoft SQL Server. You can set up a Microsoft SQL Server database from any computer, as long as you have appropriate rights to connect to the database server and create databases. The procedure that follows assumes that you are installing a single role on a computer. You can install multiple roles on a single computer, however, the order of the pages in the Setup Wizard changes based on your selections.

SQL Server collation support

This version of Microsoft Dynamics AX supports Unicode collations. The following are the requirements for the Unicode collation you select:

· Must be case-insensitive

· Must match the Microsoft Windows locale of the computers running instances of Application Object Server (AOS).

If you are setting up a new Microsoft Dynamics AX installation, we recommend that you choose a Windows collation, rather than a SQL collation. For more information about choosing a collation for a SQL Server database, see the SQL Server documentation.

Components installed

Setting up a SQL Server database creates a database to store your Microsoft Dynamics AX data structures and creates a SQL Server user login for the AOS account (the domain account or Network Service account that is associated with an AOS instance).

Verify prerequisites

SQL Server must be installed with Windows Authentication, and must be running under the Local System account.

Prerequisites for Microsoft SQL Server 2005

If you are creating a SQL Server 2005 database on a database server that is not on the same computer as the Application Object Server (AOS), configure the database server as follows: 

· Enable remote connections. 

· Open the SQL Server Management Studio (Start > All Programs > Microsoft SQL Server 2005 > SQL Server Management Studio), log in, then right-click the instance you want to connect to.

· Click Properties, click Connections, and then select Allow remote connections to this server.

· Enable named pipes.

· Open the SQL Server Configuration Manager (Start > All Programs > Microsoft SQL Server 2005 > Configuration Tools > SQL Server Configuration Manager).

· Expand SQL Server 2005 Network Configuration, select Protocols for MSSQLSERVER, right-click Named Pipes, and then click Enable. 

· If the SQL Server computer has a firewall running on it, be sure that port 1433 is open.

After making these changes, you must restart SQL Server.

Verify rights

You must log in with an account that is both:

· A member of the Administrators group on the computer from which you are running Setup.

· A member of the Database Creators server role in the SQL Server instance in which you want to create the database.

Create a SQL Server database

If you have not done so already, insert the Microsoft Dynamics AX DVD into your drive. If the Microsoft Dynamics AX Setup Wizard does not launch automatically, double-click the Autorun.hta file in the root directory of the DVD.

If you are installing from a network location, share the installation files and connect to the location from the computer on which you want to install the program.

248. To begin the installation process, click Microsoft Dynamics AX.
On the Prerequisites check page, Setup validates that the software required to install Microsoft Dynamics AX is present. If it is not, click Install. To continue after the update completes, click Next.

249. On the Welcome page of the Setup Wizard, click Next to continue.

250. On the License agreement page, read the license agreement and then click I accept the terms in the license agreement to accept the licensing terms and conditions. Accepting the license agreement activates the Next button. To continue, click Next. 

Note   To end Setup, click Cancel.

251. On the Select installation type page, click Custom installation, and then click Next. 

252. On the Select computer role page, select Database, and then click Next. 

Note   You can install multiple roles on the same computer. For additional information, see System topology recommendations.

253. On the Select database type page, select Microsoft SQL Server, and then click Next. 

254. On the Connect to an instance of SQL Server page, in the SQL Server name box, type or select the name of the SQL Server to connect to, and then click Next. 

If you need to connect to a named instance of SQL Server, enter it in the format Servername\Instancename.

255. On the Create SQL Server database page, in the Database name box, type a name for the database you are creating for Microsoft Dynamics AX to use.

We recommend that you determine a naming convention and use it for all aspects of an installation, including the database name, AOS name, and application file server directory name. 

A recommended naming convention includes a short form of the customer name, the Microsoft Dynamics AX version, the service pack version, and a code for what you are using the installation for, such as Cust_AX_Live.

Note   Setup places the database and transaction log in the same location. For a production environment, we recommend that you move the transaction log to a different drive. For more information, see the SQL Server documentation. 
256. On the Ready to install page, review the summary of roles for your computer. To proceed, click Next.
257. On the Installing page, you can monitor installation progress as Setup proceeds.

258. On the Completing Microsoft Dynamics AX Setup page, you can review the summary of roles for your computer. To exit the Setup wizard, click Finish.

Create a SQL Server database manually

If you want to create a SQL Server database manually to use for your Microsoft Dynamics AX installation, you must first create a database using Setup to use as a model for the manually created one. 

259. Follow the procedure above to create a SQL Server database to use as a template.
260. Manually create the SQL Server database you want to use for your installation. 

261. Copy all objects, users, and user permissions from the template database you created to the new database. 

262. Specify the account for the AOS instance to use to connect to the database. You can use either the Network Service account of the local computer or a domain account. 

	Topology
	Language
	Account

	SQL Server and AOS on different computers
	All
	Domain\AosMachineName$

	SQL Server and AOS instance on same computer
	English

Simplified Chinese

Traditional Chinese

Korean

Japanese
	NT AUTHORITY\NETWORK SERVICE

	SQL Server and AOS instance on same computer
	German
	NT-AUTORITÄT\NETZWERKDIENST

	SQL Server and AOS instance on same computer
	French
	AUTORITE NT\SERVICE RÉSEAU

	SQL Server and AOS instance on same computer
	Italian
	NT AUTHORITY\SERVIZIO DI RETE

	SQL Server and AOS instance on same computer
	Spanish
	NT AUTHORITY\SERVICIO DE RED


263. Set the following permissions in the database for the account to be used by the AOS: 

· User on the database server (already exists if you are installing on the same SQL Server as the first database). 

· Assign to the db_ddladmin, db_datareader, and db_datawriter database roles. 

· Grant the user execute rights on the createserversessions and createusersessions stored procedures.

Set up an Oracle database

To set Microsoft Dynamics AX up to work with an Oracle database, you must work with an Oracle database administrator (DBA), to follow this process: 

264. Microsoft Dynamics AX administrator and System Administrator. Determine which account you want the Application Object Server (AOS) service to run as. 
265. Oracle DBA: On the computer that will host the Oracle database: 

· Set up Oracle Database 10g with appropriate tablespaces and indexspaces.
· Create a user account with rights in the database for the MSDax administrator to use when installing an Application Object Server (AOS) instance,
· Optional. Add the AOS account of each computer as a user in the database.

· Optional. Create a schema for each database instance.
· Optional. Compile Setup stored procedures on the Oracle database.
266. Oracle DBA: Install an administrator version of an Oracle Database 10g client on the computer that will host the Application Object Server (AOS) instance. 

267. Microsoft Dynamics AX administrator: On the computer that will host the AOS instance, log in with the installing user account, and use the Setup wizard to set up the AOS and connect it to the Oracle database. 

268. Microsoft Dynamics AX administrator: Start Microsoft Dynamics AX, and as part of the installation checklist, configure the placement of tables in tablespaces. For more information, see Configure Oracle tablespaces.

You can set up multiple Microsoft Dynamics AX databases on an Oracle system by following the process below and creating each database under a different schema. 

Step performed by System Administrator

269. Work with a System Administrator to determine which account you want the AOS service to run as. 
By default, an AOS instance runs as the Network Service account of the computer that you install it on. You can also set the AOS instance to run as a domain account.
Note   If you are installing an AOS and an Oracle database on the same computer, you must use a domain account for the AOS account. 

270. Optional. If you choose to use a domain account, work with a System Administrator to have a new account created solely for use by the AOS instance. We recommend that the account be set up as follows:
· Log on as a service

· No interactive logon rights

Steps performed by an Oracle DBA

The following steps must be performed by an Oracle DBA. 

271. Set up Oracle Database 10g with the following characteristics: 
	Option
	Value

	Database name
	Any valid Oracle database name

	Tablespace
	Create tablespaces for Microsoft Dynamics AX to use, for example: 

· AXTAB, for tables

· AXIDX, for indexes

· AXTMP, for temporary tables

The Microsoft Dynamics AX administrator can configure the tablespaces after Microsoft Dynamics AX has been fully installed. For more information, see Configure Oracle tablespaces.

Note   If you are upgrading, you must use the same tablespace names in the Microsoft Axapta 3.0 system and the Microsoft Dynamics AX new system.


Note   Microsoft Dynamics AX supports Unicode collations. If you are setting up a new Microsoft Dynamics AX installation, we recommend that you choose a Windows collation for your location. For more information about choosing a collation for an Oracle database, see your Oracle documentation.

272. Setup uses the Windows account of the installing user to allow the AOS account (the domain account or Network Service account that is associated with an AOS instance) to connect to the Oracle database, and to write stored procedures to the Oracle database. To enable this, set the following rights: 

· Add the network account of the person who will install the AOS to the database administrators group in Oracle.

· Set Oracle to use Windows authentication.  

273. Optional. Add the AOS account of each computer that runs an AOS instance in your system as a user in the database. Grant the user accounts the following rights in the database: 
GRANT CREATE USER TO "<AOSaccount_name>";

GRANT SELECT ANY CATALOG TO "<AOSaccount_name>";

GRANT CREATE PROCEDURE TO "<AOSaccount_name>";
If you do not perform this step, Setup grants the following rights to the current AOS instance:
· ALL PRIVILEGES

· SELECT ANY DICTIONARY

274. Optional. Create a schema (user account) for each database instance and grant the following rights: 
CREATE USERS <schema name> IDENTIFIED BY "<schema password>";

GRANT ALTER ANY CLUSTER TO "<schema name>";

GRANT ALTER ANY DIMENSION TO "<schema name>";

GRANT ALTER ANY INDEX TO "<schema name>";

GRANT ALTER ANY INDEXTYPE TO "<schema name>";

GRANT ALTER ANY MATERIALIZED VIEW TO "<schema name>";

GRANT ALTER ANY PROCEDURE TO "<schema name>";

GRANT ALTER ANY TABLE TO "<schema name>";

GRANT ALTER TABLESPACE TO "<schema name>";

GRANT ALTER USER TO "<schema name>";

GRANT ANALYZE ANY DICTIONARY TO "<schema name>";

GRANT CREATE ANY CLUSTER TO "<schema name>";

GRANT CREATE ANY DIMENSION TO "<schema name>";

GRANT CREATE ANY INDEX TO "<schema name>";

GRANT CREATE ANY INDEXTYPE TO "<schema name>";

GRANT CREATE ANY MATERIALIZED VIEW TO "<schema name>";

GRANT CREATE ANY PROCEDURE TO "<schema name>";

GRANT CREATE ANY TABLE TO "<schema name>";

GRANT CREATE ANY VIEW TO "<schema name>";

GRANT CREATE CLUSTER TO "<schema name>";

GRANT CREATE DATABASE LINK TO "<schema name>";

GRANT CREATE DIMENSION TO "<schema name>";

GRANT CREATE INDEXTYPE TO "<schema name>";

GRANT CREATE MATERIALIZED VIEW TO "<schema name>";

GRANT CREATE PROCEDURE TO "<schema name>";

GRANT CREATE PUBLIC DATABASE LINK TO "<schema name>";

GRANT CREATE TABLE TO "<schema name>";

GRANT CREATE TABLESPACE TO "<schema name>";

GRANT CREATE USER TO "<schema name>";

GRANT CREATE VIEW TO "<schema name>";

GRANT DELETE ANY TABLE TO "<schema name>";

GRANT DROP ANY CLUSTER TO "<schema name>";

GRANT DROP ANY DIMENSION TO "<schema name>";

GRANT DROP ANY INDEX TO "<schema name>";

GRANT DROP ANY INDEXTYPE TO "<schema name>";

GRANT DROP ANY MATERIALIZED VIEW TO "<schema name>";

GRANT DROP ANY PROCEDURE TO "<schema name>";

GRANT DROP ANY TABLE TO "<schema name>";

GRANT DROP ANY VIEW TO "<schema name>";

GRANT DROP PUBLIC DATABASE LINK TO "<schema name>";

GRANT DROP TABLESPACE TO "<schema name>";

GRANT DROP USER TO "<schema name>";

GRANT EXECUTE ANY INDEXTYPE TO "<schema name>";

GRANT EXECUTE ANY PROCEDURE TO "<schema name>";

GRANT EXPORT FULL DATABASE TO "<schema name>";

GRANT GLOBAL QUERY REWRITE TO "<schema name>";

GRANT GRANT ANY OBJECT PRIVILEGE TO "<schema name>";

GRANT GRANT ANY PRIVILEGE TO "<schema name>";

GRANT IMPORT FULL DATABASE TO "<schema name>";

GRANT INSERT ANY TABLE TO "<schema name>";

GRANT LOCK ANY TABLE TO "<schema name>";

GRANT MANAGE SCHEDULER TO "<schema name>";

GRANT MANAGE TABLESPACE TO "<schema name>";

GRANT QUERY REWRITE TO "<schema name>";

GRANT SELECT ANY DICTIONARY TO "<schema name>";

GRANT SELECT ANY TABLE TO "<schema name>";

GRANT SELECT ANY TRANSACTION TO "<schema name>";

GRANT SYSDBA TO "<schema name>";

GRANT UPDATE ANY TABLE TO "<schema name>";

If you do not perform this step, Setup grants to the following rights to the schema. 

· ALL PRIVILEGES

· SELECT ANY DICTIONARY

· SELECT_CATALOG_ROLE 

275. Optional. (If you do not perform this step, it will be performed by Microsoft Dynamics AX Setup.) Import the Setup stored procedures. You can find the Setup stored procedures on the Microsoft Dynamics AX DVD, in the Support folder, OracleCreateServerSessions and OracleCreateUserSessions. The stored procedures have been wrapped.
Configure rights outside of Oracle

On the computer that runs Oracle, the Oracle DBA must: 

276. Enable Windows remote authentication. Add the following entry to the SQLNET.ORA file. 
SQLNET.AUTHENTICATION_SERVICES = (NTS)

277. If some users that log in from clients are not on the same domain as the database, you must also set REMOTE_OS_AUTHENT to true, and restart the Oracle service.

Install the Oracle client

On the computer that will host the AOS instance, the Oracle DBA must: 

278. Install an Oracle Database Client (10g release), Administrator version.
279. If your system uses a TNSNames connection, open the TNSNames.ora file, add the following statements to it, and then save the file: 

DatabaseName =

    (DESCRIPTION =

        (ADDRESS = (PROTOCOL = TCP)(HOST = serverhostname)(PORT = portnumber)

    )

    (CONNECT_DATA =

        (SERVER = DEDICATED)

        (SERVICE_NAME = databasename)

    )

)

Steps performed by a Microsoft Dynamics AX administrator

The following steps are performed by a Microsoft Dynamics AX administrator.

Run Setup to connect the AOS to the Oracle database

280. Log on with the installing user account that the Oracle DBA provides.
281. If you have not done so already, insert the Microsoft Dynamics AX DVD into your drive. If the Microsoft Dynamics AX Setup Wizard does not launch automatically, double-click the Autorun.hta file in the root directory of the DVD.

If you are installing from a network location, share the installation files and connect to the location from the computer on which you want to install the program.

282. To begin the installation process, click Microsoft Dynamics AX.

On the Prerequisites check page, Setup validates that the software required to install Microsoft Dynamics AX is present. If it is not, click Install. To continue after the update completes, click Next.

283. On the Welcome page of the Setup Wizard, click Next to continue.

284. On the License agreement page, read the license agreement and then click I accept the terms in the license agreement to accept the licensing terms and conditions. Accepting the license agreement activates the Next button. To continue, click Next. 

285. On the Select installation type page, click Custom installation, and then click Next. 

286. On the Create an instance of Application Object Server page, in the Application Object Server name box, enter a name for this AOS instance. 

287. Optional: To send information about any fatal error in an AOS instance to Microsoft, select the Automatically send information about fatal errors in any Application Object Server service instance to Microsoft check box. 

If you enable error reporting, information is sent over a secure (https) connection to Microsoft, where it is stored with limited access. Microsoft uses the reports only to improve Microsoft Dynamics AX, and treats all information as confidential. 

288. On the Select account for the Application Object Server page, choose whether to use the Network Service account of the local computer or a domain account for the AOS account, and then click Next.

If you choose to use a domain account, before you install, work with a System Administrator to have a new account created solely for use by the AOS instance. We recommend that the account be set up as follows:

· Log on as a service

· No interactive logon rights

Depending on the other roles that you have selected, Setup grants the following permissions for the AOS account: 

	Role
	Permissions granted

	AOS (database must exist)
	Adds the AOS account to the database as a user, and makes it a member of the db_ddladmin, db_datareader, and db_datawriter database roles.

Grants the user execute rights on the OracleCreateServerSessions and OracleCreateUserSessions stored procedures. 

	AOS (application files must exist)
	Grants the AOS account Full Control permissions on the application files directory.

	Application integration (AIF) Web services, 
	Grants the AOS account Full Control permissions on the AifWebService share, if the AOS is installed at the same time as the AIF Web services. 


289. On the Select database type page, select Oracle database server, and then click Next.
290. On the Connect to Oracle database server page, select the connection type you plan to use.

· If you select Connect using a net service (TNS), type in the service name. 

· If you select Connect using custom settings, type in the host name, database service name, and TCP/IP port to connect to. 

291. Enter a schema (user) name and password to use to connect to the database. If you enter a schema name that does not already exist, Setup creates it for you.

292. On the Ready to install page, review the summary of roles for your computer. To proceed, click Next.

293. On the Installing page, you can monitor installation progress as Setup proceeds. At this point, Setup performs these actions on the computer that runs Oracle: 

· Grants the AOS account Full Control on the Oracle installation directory. 

· Runs a script that creates a schema, if it does not already exist.

· Creates session persistence stored procedures.

294. On the Completing Microsoft Dynamics AX Setup page, you can review the summary of roles and components for your computer. To exit the Setup wizard, click Finish. 

Next steps

295. Verify that the AOS instance has started: 
· Open the Windows Event viewer on the AOS computer (Start > Administrative Tools > Event viewer). 

· To determine when the AOS has started, wait for the message "Object Server AOSname: Ready for operation."

296. After the AOS instance has connected, start a Microsoft Dynamics AX client.

297. Complete the installation checklist. For more information, see Installation checklist.

Installing multiple Microsoft Dynamics AX databases using Oracle

You can install multiple Microsoft Dynamics AX databases on an Oracle system by creating each database under a different schema. 

Install a file server

The application file server contains the files in which the Microsoft Dynamics AX business logic is stored. Examples of the files in this directory include indexes, headers, and labels for each layer. The directory must be accessible to all Application Object Server (AOS) computers.

You must be at the application file server computer to install the application files. 

The procedure that follows assumes that you are installing a single role on a computer. You can install multiple roles on a single computer. If you install multiple roles the order of the pages in the Setup Wizard changes based on your selections.

Determine the location for the application files, and restrict access


As you prepare to install, select a location for the application files that meets the following requirements: 

· The directory must be accessible to all Application Object Server (AOS) computers.

· Share the folder as a subfolder at least one level under the share root ((\\MyApplicationServer\MyShare\MySubfolder).

Important   When you install an AOS instance that connects to the application file server, if you specify that the application files are at the root of a share, such as \\MyApplicationServer\MyShare, Windows removes any permissions that the folder inherited from folders above it for all accounts (including members of the Administrators and Power Users groups).

· Set permissions on the directory to be highly restrictive—the data stored on the directory can include sensitive customer data. Allow access to the directory only to AOS accounts (the domain account or Network Service account associated with each AOS instance) and Microsoft Dynamics AX administrators. Client computers do not require access to the directory, and such access should not be granted. For recommendations on how to set permissions for systems running multiple AOS instances, see Install multiple instances of Microsoft Dynamics AX.

· The share where the application files are installed cannot be configured as a Distributed File System (DFS).

Components installed

Setting up a computer as an application file server installs application files that are used by an instance of Application Object Server (AOS) and the clients associated with it.

Verify prerequisites

The directory you install to must be accessible to all AOS instances.

Verify rights

You must log in with an account that is a member of the Administrators group on the computer on which you are running Setup.

Start Setup

If you have not done so already, insert the Microsoft Dynamics AX DVD into your drive. If the Microsoft Dynamics AX Setup Wizard does not launch automatically, double-click the Autorun.hta file in the root directory of the DVD.

If you are installing from a network location, share the installation files and connect to the location from the computer on which you want to install the program.

Install a file server

298. To begin the installation process, click Microsoft Dynamics AX.
On the Prerequisites check page, Setup validates that the software required to install Microsoft Dynamics AX is present. If it is not, click Install. To continue after the update completes, click Next.

299. On the Welcome page of the Setup Wizard, click Next to continue.

300. On the License agreement page, read the license agreement and then click I accept the terms in the license agreement to accept the licensing terms and conditions. Accepting the license agreement activates the Next button. To continue, click Next. 

Note   To end Setup, click Cancel.

301. On the Select installation type page, click Custom installation, and then click Next.

302. On the Select computer role page, select File server, and then click Next.

Note   You can install multiple roles on the same computer. For more information, see System topology recommendations.

303. On the Select region page, choose a region to install. For guidance on choosing a region, see Choosing regional functionality.

304. On the Install application files page, type or browse to the location where you would like to install the application files. Be sure to make a note of the location, because you will refer to it when setting up AOS. 

We recommend that you determine a naming convention and use it for all aspects of an installation, including the database name, AOS name, and application file server directory name. 

A recommended naming convention includes a short form of the customer name, the Microsoft Dynamics AX version, the service pack version, and a code for what you are using the installation for, such as, Cust_AX_Live.

305. On the Ready to install page, review the summary of roles for your computer. To proceed, click Next.

306. On the Installing page, you can monitor installation progress as Setup proceeds.

307. On the Completing Microsoft Dynamics AX Setup page, you can review the summary of roles for your computer. To exit the Setup wizard, click Finish.

Choosing regional functionality

When you install an application file server, you can choose whether to install additional regional functionality. Regions provide country-specific tax and financial functionality. Tax and financial functionality for many countries is available in all installations.

The following list includes the countries/regions whose tax and financial information is included in all installations.

· Australia

· Austria

· Belgium

· Canada

· Denmark

· Finland

· France

· Germany

· Ireland

· Italy

· Malaysia

· Netherlands

· New Zealand

· Norway

· Singapore

· South Africa

· Spain

· Sweden

· Switzerland

· Thailand

· United Kingdom

· United States

Install an Application Object Server (AOS) instance

An Application Object Server (AOS) is a Microsoft Windows service that controls communications among Microsoft Dynamics AX clients, databases, and applications. An AOS can be installed on a single computer, or on a cluster using Windows load-balancing. 

A system used for demonstrations, development or test can be set up to use more than one AOS instance. 

Before installation, determine which account you want the AOS service to run as (the AOS account). By default, an AOS instance runs as the Network Service account of the computer that you install it on. You can also set the AOS instance to run as a domain account. 
Note   To use MSMQ for document exchange in your system, you must set the AOS account to be a domain account. 
You must be at the AOS computer to install. The procedure that follows assumes that you are installing a single role on a computer. You can install multiple roles on a single computer, however, the order of the pages in the Setup Wizard will change based on your selections.

Components installed

Installing an AOS instance installs the following components: 

· AOS.

· Microsoft Dynamics AX Server Configuration Utility.

Verify prerequisites

Before setting up a computer in the object server role, we recommend that you install the database server and application file server.

Note   If you do not install in this order, you can use the Server Configuration Utility to set the database and application file share locations. 

If the computer on which you are installing has a firewall, you must open port 2712 before the system can function.

Verify rights

You must log in with an account that is both:

· A member of the Administrators group on the computer that you are running Setup on.

· A member of the Security Administrators server role on the Microsoft SQL Server you want to connect to.

Start Setup

If you have not done so already, insert the Microsoft Dynamics AX DVD into your drive. If the Microsoft Dynamics AX Setup Wizard does not launch automatically, double-click the Autorun.hta file in the root directory of the DVD.

If you are installing from a network location, share the installation files and connect to the location from the computer on which you want to install the program.

Install an AOS instance

308. To begin the installation process, click Microsoft Dynamics AX.
On the Prerequisites check page, Setup validates that the software required to install Microsoft Dynamics AX is present. If it is not, click Install. To continue after the update completes, click Next.

309. On the Welcome page of the Setup Wizard, click Next to continue.

310. On the License agreement page, read the license agreement and then click I accept the terms in the license agreement to accept the licensing terms and conditions. Accepting the license agreement activates the Next button. To continue, click Next. 

Note   To end Setup, click Cancel.

311. On the Select installation type page, click Custom installation, and then click Next.

312. On the Select computer role page, select Object server, and then click Next.

Note   You can install multiple roles on the same computer. For more information, see System topology recommendations.

313. On the Create an instance of Application Object Server page, in the Application Object Server name box, enter a name for this AOS. 

314. Optional: To send information about any fatal error in an AOS instance to Microsoft, select the Automatically send information about fatal errors in any Application Object Server service instance to Microsoft check box. 

If you enable error reporting, information is sent over a secure (https) connection to Microsoft, where it is stored with limited access. Microsoft uses the reports only to improve Microsoft Dynamics AX, and treats all information as confidential. 

315. On the Select account for the Application Object Server page, choose whether to use the Network Service account of the local computer or a domain account for the AOS account, and then click Next.

If you choose to use a domain account, before you install, work with a System Administrator to have a new account created solely for use by the AOS instance. We recommend that the account be set up as follows:

· Log on as a service
· No interactive logon rights

Depending on the other roles that you have selected, Setup grants the following permissions for the AOS account: 

	Role
	Permissions granted

	AOS (database must exist)
	Adds the AOS account to the database as a user, and makes it a member of the db_ddladmin, db_datareader, and db_datawriter database roles.
Grants the user execute rights on the createserversessions and createusersessions stored procedures.

	AOS (application files must exist)
	Grants the AOS account Full Control permissions on the application files directory.

	Application integration (AIF) Web services, 
	Grants the AOS account Full Control permissions on the AifWebService share, if the AOS is installed at the same time as the AIF Web services. 


316. On the Select database page, select the type of database to connect to and then click Next. Follow one of the following paths:
	To
	Do this: 

	Connect to a SQL Server database
	On the Connect to an instance of SQL Server page, in the Server name box, type or select the name of the SQL Server to connect to.

On the Connect to SQL Server database page, in the Database name box, type or select the name of the database to connect to.

Setup adds the AOS account to the database as a user, and makes it a member of the db_ddladmin, db_datareader, and db_datawriter database roles.

	Connect to an existing Oracle database server
	On the Connect to Oracle database server page, choose whether to connect using a net service or custom settings. 

In the Schema (user) name box, specify a name for the schema under which the Microsoft Dynamics AX objects will be created in the database. You can accept the default value of DBO. 

In the Password box, specify a password for the schema. 

Setup adds the AOS account specified for the AOS to the database as a user, and makes it a member of the db_ddladmin, db_datareader, and db_datawriter database roles.


317. On the Locate application files page, type or browse to the location where you installed the Microsoft Dynamics AX application files. Click Next to continue. 
318. Click Next to continue. 

We recommend that you determine a naming convention and use it for all aspects of an installation, including the database name, AOS name, and application file server directory name. 

A recommended naming convention includes a short form of the customer name, the Microsoft Dynamics AX version, the service pack version, and a code for what you are using the installation for, such as Cust_AX_Live.

319. On the Ready to install page, review the summary of roles for your computer. To proceed, click Next.

Note   If you are upgrading, be sure to clear the Start the AOS Windows service as part of installation checkbox.

320. On the Installing page, you can monitor installation progress as Setup proceeds.

321. On the Completing Microsoft Dynamics AX Setup page, you can review the summary of roles for your computer. To exit the Setup wizard, click Finish.

Note   The AOS Windows service can take several minutes to start the first time after installing. To determine whether it has started, go to Administrative tools > Services, and review the status of the Dynamics service.

Install multiple Application Object Server instances on a computer

For a development environment, you may need to install several Application Object Server (AOS) instances on the same computer. For information on working with multiple AOS instances on different computers, see Install multiple instances of Microsoft Dynamics AX.

Each AOS instance can point to a different application file location.

Note   If you install an additional AOS instance silently and provide a value for the AosInstallPath, the value is ignored. For more details, see Setup parameters.

322. To begin the installation process, click Microsoft Dynamics AX.
323. On the Welcome Back page of the Setup Wizard, click Next to continue.

324. On the Add computer role page, select Object server, and then click Next.

325. On the Create an instance of Application Object Server page, in the Application Object Server name box, enter a name for this AOS. 
Select a different name than the first installed instance. Setup increments the TCP/IP port assigned to the AOS by one. For example, when the first instance is installed on TCP/IP port 2712, the second instance is installed to TCP/IP port 2713.

326. Optional: To send information about any fatal error in an AOS instance to Microsoft, select the Automatically send information about fatal errors in any Application Object Server service instance to Microsoft check box. 

If you enable error reporting, information is sent over a secure (https) connection to Microsoft, where it is stored with limited access. Microsoft uses the reports only to improve Microsoft Dynamics AX, and treats all information as confidential. 

327. On the Select account for the Application Object Server page, choose whether to use the Network Service account of the local computer, or a domain account for the AOS account, and then click Next.

If you choose to use a domain account, before you install, work with a System Administrator to have a new account created solely for use by the AOS instance. We recommend that the account be set up as follows:

· Log on as a service
· No interactive logon rights

Depending on the other roles you have selected, Setup grants the following permissions for the AOS account: 

	Role
	Permissions granted

	AOS (database must exist)
	Adds the AOS account to the database as a user, and makes it a member of the db_ddladmin, db_datareader, and db_datawriter database roles.

	AOS (application files must exist)
	Grants the AOS account Full Control permissions on the application files directory.

	Application integration (AIF) Web services, 
	Grants the AOS account Full Control permissions on the AifWebService share, if the AOS is installed at the same time as the AIF Web services. 


328. On the Select database type page, select the type of database to connect to and then click Next.
	To
	Do this: 

	Connect to a SQL Server database
	On the Connect to an instance of SQL Server page, in the Server name box, type or select the name of the SQL Server to connect to.

On the Connect to SQL Server database page, in the Database name box, type or select the name of the database to connect to.

Setup adds the AOS account to the database as a user, and makes it a member of the db_ddladmin, db_datareader, and db_datawriter database roles.

	Connect to an existing Oracle database server
	On the Connect to Oracle database server page, choose whether to connect using a net service or custom settings. 

In the Schema (user) name box, specify a name for the schema under which the Microsoft Dynamics AX objects will be created in the database. You can accept the default value of DBO. 

In the Password box, specify a password for the schema. 

Setup adds the AOS account specified for the AOS to the database as a user, and makes it a member of the db_ddladmin, db_datareader, and db_datawriter database roles.


329. On the Locate application files page, type or browse to the location where you installed the Microsoft Dynamics AX application files. Click Next to continue.
330. Click Next to continue.

331. On the Ready to install page, review the summary of roles for your computer. To proceed, click Next.

332. On the Installing page, you can monitor installation progress as Setup proceeds.

333. On the Completing Microsoft Dynamics AX Setup page, you can review the summary of roles for your computer. 

334. To exit the Setup wizard, click Finish.

Install a client

A client is the interface to Microsoft Dynamics AX data and functionality. You must be at the Microsoft Dynamics AX client computer to install the client. If you are installing multiple clients, we recommend that you install them from a file server. For details, see Install clients silently. The procedure that follows assumes that you are installing a single role on a computer. You can install multiple roles on a single computer, however, the order of the pages in the Setup Wizard will change based on your selections.

Components installed

Setting up a computer as an Microsoft Dynamics AX client installs the following components:

· The Microsoft Dynamics AX interface that connects to an Application Object Server (AOS).

· Microsoft Dynamics AX Client Configuration Utility.

· Components to support OLAP reporting functionality:

· Microsoft SQL Server Native Client

· Microsoft SQL Server 2005 Analysis Services 9.0 OLEDB Provider

· Microsoft SQL Server Management Objects Collection 

· MSXML 6.0 Parser

Verify prerequisites

Before installing clients, be sure that you have installed the database, application file server, and AOS.

Verify rights

You must log in with an account that is a member of the Administrators group on the computer on which you are running Setup.

Start Setup

If you have not done so already, insert the Microsoft Dynamics AX DVD into your drive. If the Microsoft Dynamics AX Setup Wizard does not launch automatically, double-click the Autorun.hta file in the root directory of the DVD.

If you are installing from a network location, share the installation files and connect to the location from the computer on which you want to install the program.

Install a client

335. To begin the installation process, click Microsoft Dynamics AX Client.
On the Prerequisites check page, Setup validates that the software required to install Microsoft Dynamics AX is present. If it is not, click Install. To continue after the update completes, click Next.

336. On the Welcome page of the Setup Wizard, click Next to continue.

337. On the License agreement page, read the license agreement and then click I accept the terms in the license agreement to accept the licensing terms and conditions. Accepting the license agreement activates the Next button. To continue, click Next. 

Note   To end Setup, click Cancel.

338. On the Select display language page, select the language in which you would like to first run Microsoft Dynamics AX. If you later decide to change languages, you can modify the user language within the client.

339. On the Select Help language page, select the Help languages you would like to have available for Microsoft Dynamics AX. We recommend that you install all the Help languages required for your system during initial installation.

Note   To switch between Help languages, you can change the user settings within the Microsoft Dynamics AX client. If you do not install the Help files for the languages you need during initial installation, you can install additional Help files by running the Microsoft Dynamics AX Setup program again, selecting the Client installation path, and then selecting any additional languages you require.

340. On the Install files page, click Next to accept the default location, or click Browse to designate a different location.

341. On the Connect to Application Object Server page, type the name of the computer running the AOS instance you would like to connect to. To specify a connection to a specific AOS instance, enter the server information in one of the following formats: 

	Format
	Example

	Instancename@Servername
	AOS2@Dynamics

	Servername:Portnumber
	Dynamics:2713

	Instancename@Servername:Portnumber
	AOS2@Dynamics:2713


If you do not know the name of the Application Object Server and it is running locally, you can check its name under Administrative Tools > Services. Otherwise, contact the Microsoft Dynamics AX administrator.

342. On the Ready to install page, review the summary of roles and components for your computer. To proceed, click Next.

343. On the Installing page, you can monitor installation progress as Setup proceeds.

344. On the Completing Microsoft Dynamics AX Setup page, you can review the summary of roles and components for your computer. To exit the Setup wizard, click Finish.

Start Microsoft Dynamics AX

You can start Microsoft Dynamics AX after you have installed the core Microsoft Dynamics AX roles: database server, Application Object Server (AOS), application file server, and client.

The AOS Windows service (displayed as Dynamics service under Administrative Tools > Services) starts running when it has been installed, but can take several minutes to start the first time.

Start Axapta

345. On the computer running the Microsoft Dynamics AX client, start Microsoft Dynamics AX (Start > All Programs > Microsoft Dynamics AX).
Note   The AOS Windows service can take several minutes to start after you install it the first time. To determine whether it has started, go to Administrative tools > Services, and review the status of the Dynamics service.

346. If this is the first time you have started Microsoft Dynamics AX, the Installation checklist is displayed to the left of the navigation pane and workspace.

For instructions about completing the Installation checklist, see Configuring a core Axapta Installation.

Uninstall Microsoft Dynamics AX

To uninstall Microsoft Dynamics AX, on each computer in the system, you must uninstall the components installed on that computer. 

Remove components

The following procedure can be followed for any Microsoft Dynamics AX component.

347. Open Add or Remove Programs. (Start > All Programs > Control Panel > Add or Remove Programs).
348. Select the component that you want to remove, and then click Remove. Possible components to remove include:

· Microsoft Dynamics 4.0 Client

Setting up the Microsoft Dynamics Client also installs the following components that you may want to remove.

- Microsoft SQL Server Native Client

- Microsoft SQL Server 2005 Analysis Services 9.0 OLEDB Provider

- Microsoft SQL Server Management Objects Collection 

- MSXML 6.0 Parser

· Microsoft Dynamics 4.0 COM Business Connector

· Microsoft Dynamics 4.0 .NET Business Connector

· Microsoft Dynamics 4.0 Object Server (##-instancename), where ## is an integer from 01 to 20

· Microsoft Dynamics 4.0 Application Integration Server

349. A message box asks you to confirm that you want to uninstall the product. To proceed with the uninstallation process, click Yes.

The Setup wizard removes the component from your computer. If Setup requires access to the DVD, you are prompted to insert it.

350. Repeat for all components installed on the computer.

Remove other files

If you choose to remove an entire installation, some files and accounts remain after Add or Remove Programs is finished. Databases, log files, and application files must be removed manually. The following table provides more information:

	To remove this 
	Do this 

	Application files
	Delete the application file directory from the location you installed it to.

	Database and log files
	Use your database server (Microsoft SQL Server or Oracle) to delete the database and log files.


Install multiple instances of Microsoft Dynamics AX

In a single environment you can install multiple instances of Microsoft Dynamics AX. Each instance of Microsoft Dynamics AX consists of an Application Object Server (AOS), application file server, and database that are not shared, and a client that can be shared. You then use the Microsoft Dynamics AX Configuration Utility to point the client to each different instance.

The primary use for multiple Microsoft Dynamics AX instances is in a development environment.

A change from Microsoft Axapta 3.0 is that we recommend that you use Microsoft Dynamics AX Setup to install all application file servers, rather than creating new applications by copying the standard application file directory and modifying it. Installing all application files using Setup provides a consistent location for Microsoft to use when providing updates.

Set up appropriate permissions

When you are setting up multiple instances of Microsoft Dynamics AX, make sure you have properly configured the rights of the computers in your system.

If you plan to have multiple computers running AOS instances in your system, we recommend that you create a group in Active Directory, and add each AOS instance's account (the domain account or Network Service account associated with the AOS service) to it. You can then set that Active Directory group up as a user in the database, and add it to the following database roles db_ddladmin, db_datareader, and db_datawriter.

We also recommend that you grant the Active Directory group full permissions to the folder that contains the application files. To set these permissions, on the application file server, go to the application folder and grant the same permissions to the group that each individual AOS account was given when the AOS was installed (Read, Write). Last, remove the permissions on the application folder for the AOS accounts.

Install multiple instances of Microsoft Dynamics AX

To install more than one instance of an Microsoft Dynamics AX role on a single computer, run Setup to install each instance on the computer. The Setup wizard will not display the License Terms page.

The following roles can only be installed once on a computer:

· Client

· .NET Business Connector

· COM Business Connector

· Enterprise Portal server

· Reporting server

· Application integration server

The following table lists considerations when installing a second instance of any role:

	Role
	Consideration

	Database
	To point an Application Object Server to a named instance of SQL Server, use the following naming convention in the Setup Wizard: Server\Instance

	Application file server
	To copy the modifications from an existing application to a newly-installed application, copy all files with the following extensions:

.add
.adi
.ahd
.ahi
.alc
.ald
.ali
.alt
.aod
.aoi
.khd
.khi

	Application object server
	Each AOS instance runs on a different TCP/IP port, which you will need to know when connecting to it from a client. To find the TCP/IP port that an AOS is running on, use the Services application at Start > All Programs > Administrative Tools > Services to find the Dynamics service.


Manage a new Microsoft Dynamics AX instance

Use the Server Configuration Utility to validate that your AOS points to the correct database and application file server.

351. Open the Server Configuration utility (Start > Administrative Tools > Microsoft Dynamics AX Server Configuration Utility).
352. Click Manage, click Create configuration, and then enter a name for the configuration, and determine whether to copy it from the active or original configuration.

353. On the Application Object Server tab, validate that the Application file location is correct.

354. In the TCP/IP port field, note which port the AOS is running on. You will need this information to connect to the AOS.

355. On the Database tab, validate that the AOS is connected to the correct database. If not, change it.

Point a client to a Microsoft Dynamics AX instance

Use the Configuration Utility to point your client to the new AOS instance.

Note   You must be an administrator or power user on the computer to use the Configuration Utility.

356. Open the Configuration Utility (Start > Control Panel > Administrative Tools > Microsoft Dynamics AX Configuration Utility).
357. In the Configuration target list, select Local client.

358. Click Manage, click Create configuration, and then enter a name for the configuration, and determine whether to copy it from the active or original configuration.

359. On the Connection tab, click New, and then enter the Server name, Instance name, and TCP/IP port of the AOS instance you want to point the client to, and then click OK and exit the configuration utility.

360. Start your client - it should now be pointed at the new Microsoft Dynamics AX instance.

Install Microsoft Dynamics AX on a single computer

You can set up the four core Microsoft Dynamics AX roles on a single computer to create a development, test, pilot, or trial environment.

Prerequisites

The computer running Microsoft Dynamics AX must also have access to computers in the same Active Directory directory service domain running Active Directory configured in native mode.

Microsoft SQL Server 2000, Enterprise edition; Microsoft SQL Server 2005, Standard or Enterprise editions must also be running in the environment or on the computer.

Verify rights

You must log in with an account that is both:

· A member of the Administrators group on the computer on which you are running Setup.

· A member of the Database Creators server role in the SQL Server instance in which you want to create the database.

Start Setup

If you have not done so already, insert the Microsoft Dynamics AX DVD into your drive. If the Microsoft Dynamics AX Setup Wizard does not launch automatically, double-click the Autorun.hta file in the root directory of the DVD.

If you are installing from a network location, share the installation files and connect to the location from the computer on which you want to install the program.

Install Microsoft Dynamics AX on a single computer

361. To begin the installation process, click Microsoft Dynamics AX.
On the Prerequisites check page, Setup validates that the software required to install Microsoft Dynamics AX is present. If it is not, click Install.

To continue after the update completes, click Next.

362. On the Welcome page of the Setup Wizard, click Next to continue.

363. On the License agreement page, read the license agreement and then click I accept the terms in the license agreement to accept the licensing terms and conditions. Accepting the license agreement activates the Next button. To continue, click Next.

Note   To end Setup, click Cancel.

364. On the Select installation type page, click Single computer installation, and then click Next.

365. On the Select region page, choose a region to install. For guidance on choosing a region, see Choosing regional functionality.

366. On the Install application files page, type the location, or click Browse to navigate to the location where you would like to install the application files.

367. On the Create an instance of Application Object Server page, enter the name for the Application Object Server (AOS) you are installing and click Next.

368. On the Select database page, select Microsoft SQL Server or Oracle database server. For SQL Server, determine whether you want to connect to a new database or an existing database. If you choose Oracle, you must connect to an existing database.

For more information, see Set up an Oracle database.

	To
	Do this

	Create a SQL Server database
	On the Connect to an instance of SQL Server page, in the Server name box, type or select the name of the SQL Server to connect to, and then click Next.

On the Create SQL Server database page, in the Database name box, type a name for the database you are creating for Microsoft Dynamics AX to use.

We recommend that you determine a naming convention and use it for all aspects of an installation, including the database name, Application Object Server (AOS) name, and application file server directory name. 

An example of a recommended naming convention includes a short form of the customer name, the Microsoft Microsoft Dynamics AX version, the service pack version, and a code for what you are using the installation for, such as, Cust_AX30_SP4_Live.

	Connect to an existing SQL Server database
	On the Connect to an instance of SQL Server page, in the Server name box, type or select the name of the SQL Server to connect to, and then click Next.

On the Connect to SQL Server Database page, in the Server name box, type or select the name of the SQL Server to which you want to connect. In the Database name box, type or select the name of the database to which you want to connect.


369. On the Select language page, select the language in which the client is to be displayed, and then click Next.
370. On the Select Help languages page, select the Help languages to install on the client.

371. On the Install client files page, click Next to accept the default location, or click Browse to designate a different location.

372. On the Ready to install page, review the summary of roles and components installed on the computer. To proceed, click Next.

373. On the Installing page, you can monitor installation progress as Setup proceeds.

374. On the Completing Microsoft Dynamics AX Setup page, you can review the summary of roles installed on the computer. 

375. To exit the Setup wizard, click Finish.

Initial configuration

Before you begin setting up Microsoft Dynamics AX, make sure that the installation was properly completed and that Microsoft Dynamics AX is running. For more information, see Installing a core system.

Configuration of your Microsoft Dynamics AX installation entails setting up the system by using the Installation checklist, and then setting up the various modules. For information about working with the Installation checklist, see Installation checklist.

The installation checklist can be run with no user interaction. This requires defining input parameters in an XML file and starting up Microsoft Dynamics AX from a command line. For more information, see Run the checklist items without user interaction.

The table below describes what you will find in this section.

	Section
	Description

	Rights required for configuration 
	This section describes what rights you need in order to configure a Microsoft Dynamics AX system.

	About configuration 
	This section provides a conceptual introduction to configuring Microsoft Dynamics AX.

	Installation checklist 
	This section provides a procedural description on how to configure your system using the Installation checklist.

	Re-executing checklist items 
	This section describes how to re-execute Installation checklist items once they have been completed.

	Test a configured installation 
	This section provides information on what to test once your system has been configured.

	Set up core modules 
	This section provides information on prerequisites and setup of the core modules and extended functionality in a Microsoft Dynamics AX system. 

	Set up additional modules 
	This section provides information on prerequisites and setup of the additional modules in a Microsoft Dynamics AX system.

	Run the checklist items without user interaction 
	This section provides information on how to run checklists silently.


Rights required for configuration

You must have Administration or Developer access rights in order to set up and configure Microsoft Dynamics AX.

The Administrator who starts the Microsoft Dynamics AX client for the first time becomes the Administrator who can complete the Installation checklist. For information about using the Installation checklist, see Initial setup of the system.

About configuration

The configuration of Microsoft Dynamics AX is done by entering license codes in the License information form, and by enabling or disabling configuration keys in the Configuration form. You have to be an administrator to enter license codes and change the configuration keys.

By entering license codes, the administrator enables the general functionality covered by the license. The, the administrator can enable or disable access to more specific features by changing the configuration.

When the license codes are entered and the configuration keys are set up, you must create and set up User groups and Domains to control access to the individual parts of the functionality for individual users.

Configuration keys should be defined so that the installation can be set up with only the features needed for each particular installation. By disabling configuration keys, administrators can reduce the potential surface of attack, thereby helping to increase the security of their Microsoft Dynamics AX installation

Example

For example, you have a license for the General ledger module. By selecting the General ledger - Collection letter configuration key, the collection letter functionality is enabled. Finally you grant access rights to one or more user groups to create and send out collection letters.

Installation checklist

Use the Installation checklist to guide you through the initial setup of the Administration module. As each option is completed, the item is checked by the system. Most of these items are one-time setup options. For more help, click the help icon next to each option.

Important   You must complete the Installation checklist before you add any users to the system. If you add users to the system before completing the Installation checklist, they receive full user rights to the application, regardless of what user group they are assigned to, until you complete the checklist.

The Installation checklist opens after you have installed the Microsoft Dynamics AX client, or you can open it by clicking Administration > Setup > System > Checklists > Installation checklist.

The options on the Installation checklist vary slightly, depending on whether Microsoft Dynamics AX is running on a Microsoft SQL Server database or on an Oracle database. 

Click the active link in the checklist to open the appropriate form and start the task.
When you complete the Installation checklist, you must restart the Microsoft Dynamics AX client.

Installation checklist for SQL Server

· Compile application - Update references and ensure that the application is ready for use. This process takes an hour or more to run, and must be completed if there is more than one layer in your system. This option is also available from under Administration > Periodic > Compile application. For more information, see Compile the application.

· License information - Import or enter the Microsoft Dynamics AX licenses that were purchased. The license information is used to enable the modules and functions that your company is implementing. This option is also available from under Administration > Setup > System > License information. For more information, see Add license keys.

· Configuration - Tune the functionality of your system. The licenses entered automatically enable the corresponding configuration keys. Review the functionality tied to each key and enable or disable as appropriate for your company. Parent-child relationships sometimes control whether a key can be disabled. Functionality not enabled does not appear on the Microsoft Dynamics AX menus, so it is extremely important to review all of the configuration keys and enable the functions to be used. This option is also available from Administration > Setup > System > Configuration. For more information, see Set up configuration keys. 

· Adjust global types - Change the properties for the data types displayed without accessing the Application Object Tree (AOT). You must be an Administrator to make these changes. All changes must be made before data is entered into the system. This option is also available from Administration > Setup > System > Adjust global types. For more information, see Adjust global types. 

· Synchronize - Synchronize the database to the most recent version of Microsoft Dynamics AX. For more information, see Synchronize tables and indexes. When you complete synchronization, you can select the Prevent startup of Installation checklist checkbox so that the Installation checklist does not open each time you start the client.

· Company accounts - Identify each company used in Microsoft Dynamics AX. A company can be a separate legal entity, or it may be a division within a company. The company identification is a 3 character alphanumeric field. A company can be attached to virtual companies or domains. A virtual company is used to share tables between companies; such as, zip codes, country/region codes, tax codes, and so on. A domain is used to group companies for security purposes. If the company setups are similar, then only create the main company. After setup screens are populated, copy the main company to create new companies. Companies can be added at any time. This option is also available from Administration > Company accounts. For more information see Manage company accounts.

· Import - Import Microsoft Dynamics AX demo data or data that was originally exported from Microsoft Dynamics AX (*.dat files). This option is also available from Administration > Periodic > Data export/import > Import. For more information, see Import company data. 

Installation checklist for Oracle
· Compile application - Update references and ensure that the application is ready for use. This process takes an hour or more to run, and must be completed if there is more than one layer in your system. This option is also available from under Administration > Periodic > Compile application. For more information, see Compile the application.

· License information - Import or enter the Microsoft Dynamics AX licenses that were purchased. The license information is used to enable the modules and functions that your company is implementing. This option is also available from under Administration > Setup > System > License information. For more information, see Add license keys.

· Statistics- Specify which Oracle usage statistics Microsoft Dynamics AX gathers automatically. For more information, see Statistics (Oracle and SQL Server). 

· Oracle Storage - Manage the placement of Microsoft Dynamics AX tables within Oracle tablespaces. For more information, see Configure Oracle tablespaces.

·  Configuration - Tune the functionality of your system. The licenses entered automatically enable the corresponding configuration keys. Review the functionality tied to each key and enable or disable as appropriate for your company. Parent-child relationships sometimes control whether a key can be disabled. Functionality not enabled does not appear on the Microsoft Dynamics AX menus, so it is extremely important to review all of the configuration keys and enable the functions to be used. This option is also available from Administration > Setup > System > Configuration. For more information, see Set up configuration keys. 

· Adjust global types - Change the properties for the data types displayed without accessing the Application Object Tree (AOT). You must be an Administrator to make these changes. All changes must be made before data is entered into the system. This option is also available from Administration > Setup > System > Adjust global types. For more information, see Adjust global types. 

· Synchronize - Synchronize the database to the most recent version of Microsoft Dynamics AX. For more information, see Synchronize tables and indexes. When you complete synchronization, you can select the Prevent startup of Installation checklist checkbox so that the Installation checklist does not open each time you start the client.

· Company accounts - Identify each company used in Microsoft Dynamics AX. A company can be a separate legal entity, or it may be a division within a company. The company identification is a 3 character alphanumeric field. A company can be attached to virtual companies or domains. A virtual company is used to share tables between companies; such as, zip codes, country/region codes, tax codes, and so on. A domain is used to group companies for security purposes. If the company setups are similar, then only create the main company. After setup screens are populated, copy the main company to create new companies. Companies can be added at any time. This option is also available from Administration > Company accounts. For more information see Manage company accounts.

· Import - Import Microsoft Dynamics AX demo data or data that was originally exported from Microsoft Dynamics AX (*.dat files). This option is also available from Administration > Periodic > Data export/import > Import. For more information, see Import company data. 

Symbols used in the installation checklist

The following table gives an overview of the icons used in the checklist framework.
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	Ready
	This task is ready to run. Click the link to start the task.

When the task is finished (when the form related to the task is closed), the icon changes to Checklist [image: image63.png]
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	Optional. Click the icon to mark as finished.
	This task is optional. Click the link to start the task, or click the icon to bypass the task.
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	Waiting
	This task is dependent on other tasks and can only be run when these other tasks are complete.
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	Finished
	This task is finished, but you can still click the link to run the task.
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	Additional help
	Click this icon to get additional help relating to the task.


Compile the application

Compile the whole application because it ensures that all object references are updated and the application is ready to use.

Compiling the application takes the application source code, translates it into binary code that can be interpreted by the kernel and stores it in the .aod file.

This is also necessary during new installations with a Service Pack, since the references from the standard application must also be updated.

This option is available from either of the following:

· The installation checklist

Administration > Setup > System > Checklists > Installation checklist
· The Administration navigation pane

Administration > Periodic > Compile application
Close the Compiler output dialog box when the compilation is finished.

Important   The compilation takes an hour or more to complete, depending on your hardware, and it is critical that the compilation completes.

Add license keys

Enter license information manually using information from your license document, or if provided, import the license codes from a file. You must have Administrator access rights in order to save a license code. 

To be able to use Microsoft Dynamics AX, enter the license codes, and check the Status field to see that each code is verified.

Note   If you are changing your current license settings as a result of updating license keys, the new functionality does not take effect until the client has been restarted.

In addition to license codes for Microsoft Dynamics AX functionality, access to the Microsoft Dynamics AX development environment is divided into four different licenses. For more information, see Development access licenses.

If you do not have a license, you can still set up Microsoft Dynamics AX in demonstration mode. For more information, see Demonstration mode.

Import license information

376. Click Administration > Setup > System > License information.
377. Click Load license file to import the license codes from a file.

The Load license file dialog box appears.

378. Click the folder icon and browse for your license file.

379. Click OK.

The Configuration dialog box appears and you are asked if you want to synchronize your database. 

380. Click Yes.

381. Close the License information window.

Enter license information

An alternative to importing the license information, you can enter the license information manually:

382. Click Administration > Setup > System > License information.
383. Enter the name of the license holder, the system's serial number, and the expiration date. The information is in your license document.

384. On the System tab page, enter the License code and verify that the Status field displays the expected text.

The license code indicates whether you have a standard, professional, or enterprise solution.

Note   The first four entries (name of the license holder, the system's serial number, expiration date, and license code) determine what appears in the remaining codes, and it is therefore essential that they are entered correctly.

385. Enter the remaining codes.

For each, check the Status field to ensure that the code is accepted.

Demonstration mode

Initiate demonstration mode of Microsoft Dynamics AX by clicking the Optional icon (Checklist [image: image68.png]


) next to License information.

Demonstration mode gives you all of the functionality of Microsoft Dynamics AX, and enables all configuration keys by default.

Development access licenses

Development access in Microsoft Dynamics AX is divided into four different licenses:

· Base Package

· MorphX

· Web MorphX

· X++

Base Package

Base Package gives access to:

· Create or modify menus (user menus, main menu, and so on).

· Create or modify user Forms.

MorphX

The MorphX development license gives access to the Data Dictionary node, where tables, fields, enums, and extended data types are maintained. MorphX development license also gives the ability to create or modify forms.

It is possible to add, change and delete forms, tables, extended data types, macros, menus, reports, jobs, and queries. Methods related to tables, for instance forms, can be changed. For example, this allows you to change the standard information when adding new customers. 

An example of a change in extended data types by using MorphX is changing the lengths of account numbers.

The Application Object Tree (AOT) displays the following nodes:

· Data Dictionary

· Forms

· Macros

· Reports

· Queries

· Jobs

· Menus

· Menu Items

· Resources

· System Documentation

· Application Developer Documentation

· Application documentation

Web MorphX

The Web MorphX Development Suite license gives access to the Microsoft Dynamics AX Web Development Framework.

The AOT displays the following nodes:

· Web Forms

· Web Reports

· Web Menus

· Web page

· Web Editor

· Style Sheet Editor

X++

The X++ development license gives you full access to all classes in Microsoft Dynamics AX, and the development code for the CUS layer. This gives you the ability to modify things like the invoice routine, or the posting process for a ledger journal. Having the development code for the CUS layer allows customers to place their modified application objects in the CUS layer, or the USR layer, or both. 

It is possible to add, change, and delete classes. For example, you could change the logic in an invoice update, which is defined in the class SalesFormLetter.

Enable and disable configuration keys

Disable specific features in applications for all users by using the configuration keys. Each configuration key controls access to a specific feature, and once disabled, the feature is automatically removed from the database and the user interface. From a security perspective, the removal of unused functionality reduces the surface that is open to attack.

License codes are used to enable configuration keys. The configuration keys that are controlled by license codes are marked with a red padlock symbol. This means that the feature cannot be disabled, however, it is possible to disable any child nodes below the feature.

You must have Administrator or Developer access rights in order to set up configuration keys. For information about specific configuration keys, see Configuration keys.

Set up configuration keys

Click Administration > Setup > System > Configuration.
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The dialog displays:

· In the right pane - A text explaining the effect of the configuration key when enabled for the entire system and details of what effects the key has on the system when it is enabled. The text given in parenthesis is the configuration key name and is shown only when you have developer rights.

· In the left pane - A hierarchical overview of the configuration keys that you can use to enable features. With licensed installations and demonstration mode, only parent configuration keys are active from the outset, while with partner licenses, all configuration keys are active

To enable a configuration key, select the check box next to the relevant feature.

If a configuration key is displayed with a red padlock, this indicates that the key controls basic functionality, and therefore cannot be disabled. However, configuration keys beneath it in the hierarchy that control subsets of the basic functionality can be disabled. 

Click Standard to revert Microsoft Dynamics AX to its original, minimized state.

Configuration keys 

When a license code is purchased, the license code determines the contents of the configuration keys. Configuration keys consist of parent configuration keys and their children. A parent key that has no children will not be available from the Configuration window. A configuration key with one or more children, however, will be displayed, because the features below the parent can be disabled.

Configuration keys can control a number of child configuration keys, which can be either disabled or enabled as required.

A minimized system

Having loaded the license code file, the system will start up minimized. This means that all child configuration keys are disabled. Any required extra features can safely be enabled later. A specific setup can still be exported and imported, or, if necessary reset to standard, which is the minimized system. 

Note   A system with an expiry data, typically a partner license, behaves differently in the sense that the system will start up maximized.

Configuration key flowchart

The flowchart below shows how the system determines whether a configuration key is enabled or not. This depends on the configuration keys parent - so the determination must be done hierarchically.

A configuration key has two properties:

· License code

· Parent (Only one parent can be specified)
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To learn about the configuration keys, see Set up configuration keys and Best Practices for Configuration and Security Keys.

Configuration key options

Administration Configuration Key (SysAdmin)
· Advanced form customizations Configuration Key (SysFormSetupAdvanced)
· Keep Update Objects configuration key (SysDeletedObjects40)
· Keep update objects 4.1

· User Log Configuration Key (SysUserLog)
Bank Configuration Key (Bank)
· Check Configuration Key (BankCheque)
· Deposit Slip Configuration Key (BankDeposit)
· Negotiable Instrument Configuration Key (CustVendNegotiableInstrument)
· Bill of Exchange Configuration Key (CustBillOfExchange)
· Promissory Note Configuration Key (VendPromissoryNote)
Business Analysis Configuration Key (BAS)
· OLAP Configuration Key (OLAP)
Business Process Management Configuration Key (KMBPM)
· Action Plans Configuration Key (KMBPMActionPlan)
· Strategic Plan Configuration Key (KMBPMGameplan)
Cost Accounting Configuration Key (COSBaseModule)
· Accruals Configuration Key (COSAccruals)
· Budgeting Configuration Key (COSBudget)
· Calculation Configuration Key (COSCalculation)
· Allocation Configuration Key (COSAllocation)
· Cost Distribution Configuration Key (COSCostDistribution)
· Service Distribution Configuration Key (COSWorkDistribution)
· Service Categories Configuration Key (COSWorkUnits)
Country/region-specific Features Configuration Key (CRSECountry)
· Australia Configuration Key (CRSEAustralia)
· Austria Configuration Key (CRSEAustria)
· Belgium Configuration Key (CRSEBelgium)
· Denmark Configuration Key (CRSEDenmark)
· Finland Configuration Key (CRSEFinland)
· France Configuration Key (CRSEFrance)
· Germany Configuration Key (CRSEGermany)
· Italy Configuration Key (CRSEItaly)
· Fiscal LIFO configuration key (InventFiscalLIFO)
· Malaysia configuration key (CRSEMalaysia)
· Multiple Countries/Regions configuration key (CRSEMultiple)
· Credit invoicing configuration key (CustVendCreditInvoicing)
· Multiple Interest Rates configuration key (CustMultipleInterestRates)
· United States and Canada configuration key (CRSEUnitedStatesAndCanada)
· Unrealized sales tax configuration key (TaxUnrealized)
· Netherlands Configuration Key (CRSENetherlands)
· Norway Configuration Key (CRSENorway)
· Singapore configuration key (CRSESingapore)
· Spain Configuration Key (CRSESpain)
· Sweden Configuration Key (CRSESweden)
· Switzerland Configuration Key (CRSESwitzerland)
· Thailand configuration key (CRSEThailand)
· Daily Depreciation configuration key (AssetDepDaily)
· United Kingdom Configuration Key (CRSEUnitedKingdom)
· United States Configuration Key (CRSEUnitedStates)
CRM Series configuration key (SmmCRM)
· Outlook Synchronization configuration key (smmOutlook)
· Telephony Integration Configuration Key (smmPhone)
Currency Configuration Key (Currency)
· Euro Configuration Key (CurrencyEuro)
· Secondary Currency Configuration Key (CurrencySecondaryCurrency)
Fixed Assets Configuration Key (Asset)
General Ledger - Advanced Configuration Key (LedgerAdvanced)
· Allocation Configuration Key (LedgerAdvAllocation)
· Cashflow Forecast Configuration Key (LedgerAdvCashflowForecast)
· Consolidate Configuration Key (LedgerAdvConsolidations)
· Intercompany accounting configuration key (LedgerAdvIntercompanyAccounting)
General Ledger Configuration Key (LedgerBasic)
· Budget Configuration Key (LedgerBasicBudget)
· Collection Letter Configuration Key (CustCollectionLetter)
· Giro Configuration Key (CustGiro)
· Interest Configuration Key (CustInterest)
· Invoice Journal Configuration Key (VendInvoiceRegister)
· Invoice Pool Excl. Posting Configuation Key (VendInvoicePool)
· Invoice Register and Invoice Approval Journal Configuration Key (VendInvoiceRegisterApproval)
· Journalizing Configuration Key (LedgerBasicJournalizeTransactions)
· Ledger transaction reversal

· Payment Management configuration key (PaymMan)
· Payment Schedule Configuration Key (PaymSched)
· Sales Tax Configuration Key (LedgerBasicSalesTax) Sales Tax Jurisdictions configuration key (LedgerBasicSalesTaxJurisdictions)
· Expense management

· Authorization

· Description

· Electronic banking

· Project

· Cash advance

· Vendor Transaction Reversal Configuration Key (TransactionReversal_Vend)
· Withholding Tax Configuration Key (LedgerBasicWithholdingTax)
Human Resource I Configuration Key (HRMAdministration)
· Payroll Information Configuration Key (HRMAdministrationPayrollInfo)
Human Resource II configuration key (HRMManagement)
· Absence

· Recruiting

Human Resource III configuration key (HRMCollaborative)
· Course Configuration Key (HRMCollaborativeCourse)
Logistics Configuration Key (LogisticsAdvanced)
· Bill of materials configuration key (BOM)
· BOM Versions Configuration Key (BOMVersion)
· Delivery Date Control configuration key (SalesDeliveryDateControl)
· Inventory Forecast Configuration Key (Forecast)
· Item Item Dimension - Color Configuration Key (InventItemDimColor)
· Item Dimension - Configuration Configuration Key (Config)
· Item Dimension - Size Configuration Key (InventItemDimSize)
· Transfer Orders configuration key (InventTransferOrders)
Master Planning Configuration Key (Req)
· Action Message Configuration Key (ReqSchedAction)
Production Series II Configuration Key (ProdRouting)
· Route Versions Configuration Key (RouteVersion)
· Approval of Routes Configuration Key (RouteApprove)
Project - Advanced Configuration Key (ProjAdvanced)
· Estimate Projects Configuration Key (ProjAdvEstimate)
· Fixed-price configuration key (ProjAdvEstimateFixedPrice)
· Investment configuration key (ProjAdvEstimateInvestment)
· Work In Progress Configuration Key (ProjAdvWorkInProgress)
Project Configuration Key (ProjBasic)
· Cost and Internal Project configuration key (ProjBasicInternalProject)
· Expense configuration key (ProjBasicCost)
· Fee configuration key (ProjBasicRevenue)
· Forecast configuration key (ProjBasicForecast)
· Hours configuration key (ProjBasicHour)
· On-account configuration key (ProjBasicOnAcc)
· Time and Material Configuration Key (ProjBasicTimeMaterial)
Quotations configuration key (QuotationBasic)
· Project Quotation configuration key (ProjQuotation)
· Sales Quotation configuration key (SalesQuotation)
RFID Configuration key (RFID)
· RFID Business processing configuration key (RFIDBusinessProcessing)
· RFID tagging configuration key (RFIDTagging)
Service Management configuration key (SMAManagement)
· Service Management - BOM configuration key (SMABom)
· Service Management - Repair configuration key (SMARepair)
Subscription configuration key (SMASubscription)
· Subscription indexation configuration key (SMASubscription_Indexation)
Trade Configuration Key (LogisticsBasic)
· Blanket Order Configuration Key (TradeBlanketOrder)
· Commission Configuration Key (Commission)
· Foreign Trade Configuration Key (ForeignTrade)
· Misc. Charges Configuration Key (Markup)
· Multiple Ship-to configuration key (TradeMultiShipTo)
· Over/Under Delivery Configuration Key (LogisticsOverUnderDelivery)
· Packing Duty configuration key (InventPackaging)
· Print Management configuration key (TradePrintManagement)
· Registration/Picking Configuration Key (LogisticsRegistration)
· Returned Item Configuration Key (ReturnItem)
· Shipments Configuration Key (SalesShipments)
Trade Agreements Configuration Key (TradeAgreements)
· Price/Discount Configuration Key (PriceDisc)
· Supplementary item Configuration Key (SuppItem)
Warehouse Management II Configuration Key (WMSAdvanced)
· Pallets Configuration Key (WMSPallet)
X++ Development Configuration Key (SysDevelopmentXPP)
· Test Framework configuration key (SysTest)
Adjust global types

Adjust extended data types to change the properties for the data types displayed without accessing the Application Object Tree (AOT). You must be an administrator to make these changes.

All changes must be made before data is entered in the system.
386. Click Administration > Setup > System > Adjust global types.
387. Select the data type in the middle pane.
Help text appears in the left pane, and the properties for the selected data type appears in the Properties pane.
Global types

The adjustable data types and their default settings are:

	Global Type
	Length
	Adjustment
	Decimals

	Account number 
	20
	Left
	-

	Amount
	20
	-
	0 (= default Windows setup)

	Bank account number
	34
	Left
	-

	Bonus
	10
	Left
	-

	Calendar
	10
	Left
	-

	Customer or vendor account number
	20
	Left
	-

	Depreciation profile
	10
	Left
	-

	Description
	60
	Left
	-

	Group
	10
	Left
	-

	Item number
	20
	Left
	-

	Location
	10
	Left
	-

	Name
	60
	Left
	-

	Project
	10
	Left
	-

	Reference
	60
	Left
	-

	Text
	1000
	Left
	-

	Value model
	10
	Left
	-


These properties on the data types displayed in this window can be adjusted by the administrator without accessing the Application Object Tree (AOT). 

Note   Any changes must be made before entering data in the system.

Point to the data type. In the left pane a help text is displayed and in the right pane the properties for the current data type are displayed.

Example

To change the number of decimals on the Amount data type, enter the number decimal places you require in the Display length field. Changing the number from 2 to 0 makes an amount that inherits from the Amount data type appear as 200 instead of 200.00. The change is reflected everywhere in the application where the Amount data type is used.

Synchronize tables and indexes

Synchronize the table and index information to the database. This is a mandatory step to set up the system. By doing this, Microsoft Dynamics AX creates all the tables it needs to operate. 

This can take 10 or more minutes to complete.

Manage company accounts

Create new company accounts and view existing company accounts from the Company: dialog box. There are two types of company accounts that can be created:

· Real company accounts

· Virtual company accounts.

A virtual company account is a collection of data that is common to several company accounts. For more information, see Company accounts and Virtual company accounts.

Create a new company account

388. Click Administration > Company accounts.
389. Press CTRL+N to create a new record.

390. Enter a company code in the Company accounts field.

391. Enter the name of the company in the Name of company accounts field.

392. If you have a Domain license, click the Domains tab.

393. Select the domains that the new company should be included in.

A domain is a collection of one or more company accounts. For more information, see Domains.

Note   There are no domains present in Microsoft Dynamics AX when you first install the system. You must create domains separately.

394. Click the Virtual company accounts tab and select the virtual company accounts that this company should be a part of.

Company accounts and Virtual company accounts

A single Microsoft Dynamics AX database is capable of holding many individual companies. Once company accounts are created, you can set up virtual companies that share tables from the main Microsoft Dynamics AX database.

Virtual company accounts

Virtual company accounts contain data in certain tables that are shared by any number of company accounts. This allows users to post information in one company that will be available to another company.

This is useful when a client has multiple companies that can share non-transactional information such as vendor accounts, customer accounts, postal (Zip) codes, tax codes, and so on. This saves you from having to set up the same records in each company.

If you would like to use virtual companies at some time in the future, it is best to set up the virtual companies from the beginning of the implementation of Microsoft Dynamics AX. This avoids problems with combining records into a shared table at some time in the future.

Before you can create or modify a virtual company account, the following must be established:

· The application object server that the administrator is connected to must be the only one running. All other application object servers must be shut down.

· Only the administrator who is creating the virtual company account can be connected; only one active client connection is allowed.

After you create or modify a virtual company account, you must restart the Microsoft Dynamics AX client in order to update the client with the new virtual company account information.

Domains and Company accounts

A domain in the Microsoft Dynamics AX system is a group of company accounts. By establishing a domain, you can define user groups and permissions. Domains make it easier to maintain user group security if several companies use the same security profile. For more information about the security functionality of domains, see Plan Microsoft Dynamics AX application security.

A single company can belong to more than one domain.

In addition to user groups, domains are used when setting up a log of database action (insert, update, and delete).

If you have purchased a domain license, you have this tab page available in Company accounts.

The Domains tab page displays all the domains in the Microsoft Dynamics AX system. The domains in the Selected domains section are the domains selected for the current company accounts, whereas the domains in the Remaining domains section are those that are not selected for the current company accounts. The domains in both sections can be moved back and forth using the arrows.

Create virtual company accounts

Virtual company accounts contain data in certain tables that are shared by any number of company accounts. This enables users to post information in one company that is available to another company.

Prerequisites

Before you can create or modify a virtual company account, the following must be established:

· The application object server that the administrator is connected to must be the only one running. All other application object servers must be shut down.

· Only the administrator who is creating the virtual company account can be connected; only one active client connection is allowed.

Create a virtual company account

395. Click Administration > Setup > Virtual company accounts.
396. Enter the company identification in the Company accounts field.

397. Enter the name of the virtual company in the Name of company accounts field.

398. Click the Company accounts tab.

399. Select the company accounts that you would like to participate in the virtual company. 

· To add a virtual company account, select the company name under Remaining company accounts and click the left arrow (<) to move it to the Selected company accounts list.

· To remove a virtual company account, select the company name under Selected company accounts and click right arrow (>) to move it to the Remaining company accounts.

400. Click the Table collections tab.

401. Select the table collections that contain the specific tables that you wish to relate in the virtual company.

· To add a table collection, select the table collection name under Remaining table collections and click the left arrow (<) to move it to the Selected table collections list.

· To remove a table collection, select the table collection name under Selected table collections and click the left arrow (>) to move it to the Remaining table collections list.

Table collections are groups of tables. They can be created through drag-and-drop functionality in the Application Object Tree (AOT).

402. Shut down and restart the Microsoft Dynamics AX client.

You must restart the Microsoft Dynamics AX client in order to update the client with the new virtual company account information.

Create domains

403. Click Administration > Setup > Domains.
404. Press CTRL+N to create a new domain record.

405. Enter a domain identification and a name.

406. Click the Company accounts tab and add accounts to the domain.

· To add an account to a domain, highlight the account name under Remaining company accounts and click the left arrow (<) to add it to the Selected company accounts list.

· To remove an account from a domain, highlight the account name under Selected company accounts and click the right arrow (>) to remove it to the Remaining company accounts list.

Import company data

Importing company data is typically done used in the following three situations:

· At startup, prior to going live.

Typically this is a partial data import of:

· Parameters, for example parameter tables.

· Setup data, for example setup tables.

· Default data, for example zip codes.

· Master data, for example customer or vendor tables.

· When performing a restore using fully exported company data.

· When importing additional data from another Microsoft Dynamics AX system. 

Tip   In all situations it is highly recommended to use identical versions and builds to avoid any data conversion issues.
407. Click Administration > Periodic > Data export/import > Import
408. In the Definition group field, select a definition group defined previously.

A definition group defines which tables and fields to import data into; using a definition group is optional. 

A definition file is defined from Administration > Periodic > Data export/import > Definition groups. 

409. In the File name field, browse to the location of the file and click Open.

The file type must be .dat which is the file type used for Standard (as opposed to Excel or Custom) export from Microsoft Dynamics AX. 

410. Select whether or not to have the import executed on the server by selecting the Execute on AOS checkbox.

If this option is selected, the file given above must be on the server and the user must have appropriate access rights to the server folder and the file.

411. Click the Advanced tab to set up options for data import.

412. Click OK to start the data import, or click the Batch tab to define batch processing parameters for the import.

Configure Oracle tablespaces

Configure Oracle tablespaces to make Microsoft Dynamics AX aware of and able to manage the Oracle tablespaces that are created for the database.

This option is available from the Installation checklist only. (Administration > Setup > System > Checklists > Installation checklist).
If you have already associated a table or group of tables with a particular tablespace in Oracle, be sure to mirror the existing configuration.
413. In the Selection for group, select the object that you are associating with a tablespace. 
414. In the Oracle setup group, in the Tablespace list, select the appropriate tablespace. Set any other options as appropriate.

415. Repeat steps 1 and 2 for all objects that you are associating with tablespaces. 

416. Close the form to save your changes. 

We recommend that you assign the Microsoft Dynamics AX tables to one or more tablespaces, and that you assign the indexes to one or more indexspaces. 

Configure Oracle statistics

Configure statistics for Oracle to specify whether Microsoft Dynamics AX should cause the Oracle database to calculate statistics, and which method to use. 

This option is available from the Installation checklistonly.
417.  Administration > Setup > System > Checklists > Installation checklistTo turn on statistics calculation, click Enabled. 
418. In the Statistics calculation method list, select an option. 

419. In the Schedulegroup, select options for Interval, Starting date, and Starting time. 

420. Click Run now to start statistics calculation immediately, or close the form to save your changes. 

We recommend that you select the following options: 

· Select Enabled.
· For Statistics calculation method, select Estimate.

· For Interval, select Daily. 

Re-executing checklist items

You can re-execute tasks in the installation checklist that have been completed. When you re-execute a task, a dialog box appears that asks you if you want to reset all of the dependent tasks in the checklist. 

· If you click Yes, then the checklist changes those dependent tasks to their uncompleted state, and you must then complete them. 

· If you click No, then the state of the dependent tasks does not change.

Test a configured installation

After installation and before proceeding to setting up extended Microsoft Dynamics AX functionality, test whether your configurations are functioning. This is also a good point to test any user documentation and training you have created.

Standard validation tests

· Can an external user log on locally to your network? 

· Can users run the most common tasks for your system?

· Can administrators run the system maintenance tasks? 

· Run the most vital tasks for your system (for example, month-end close)

· Can users read the reports that are generated?

· Check data import results—were all columns mapped appropriately

· Check permissions: Can users outside of sensitive roles see sensitive data?

Set up core modules and extended functionality

The core modules for Microsoft Dynamics AX are listed in the table below. All of the modules in your system are dependent on some or all of these core modules. Set up the core modules in the order listed.

	Module
	See for more information

	Administration
	Set up Administration module

	Basic
	Set up Basic module

	General ledger
	Set up General ledger module

	Bank
	Set up Bank module

	Accounts receivable
	Set up Accounts receivable module

	Accounts payable
	Set up Accounts payable module


Flowchart: Configuring the Administration module

The Administration module contains forms for administrators to use to enable or disable features and functionality in Microsoft Dynamics AX. For example, the module contains forms for setting up Microsoft Dynamics AX users, groups, company accounts, and security. The module also contains data import and export forms, a license form, a configuration form, Enterprise Portal set up forms, and advanced reporting forms, to name only a few.

Prerequisites

Install Microsoft Dynamics AX software.

Complete the Installation checklist. The forms used during installation are described in more detail in the following topics:

· Compile the application
· Add license keys
· Enable and disable configuration keys
· Adjust global types
· Synchronize tables and indexes

 HYPERLINK  \l "b_27aec633" 
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Import company data
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The main setup forms of the Administration module

The forms that a company must set up to be able to use the basic functionality of the Administration module are listed in the recommended order of setup. 

Important   If these forms are not set up and configured properly, features or functionality may not be available to end users, or users may not be able to access Microsoft Dynamics AX.

1. Users

Enter details about each user who will access Microsoft Dynamics AX in the Users form. To add an additional layer of security to your computing environment, Microsoft Dynamics AX requires that all users be listed in Microsoft Active Directory directory service on your domain controller before they can be enabled in the User form. If a user is not enabled on this form, that user cannot access Microsoft Dynamics AX.

For more information, see Active Directory user topology and User (Form).

2. User groups

User groups, see User groups (Form).

By creating users groups, you establish who can access Microsoft Dynamics AX and what permissions users have when working in the product. By adding a user to a group, you give the user all the permissions and user rights assigned to that group. Before users can access Microsoft Dynamics AX, they must be added to the list of users and they must be added to at least one user group.

3. User group permissions

Permissions determine who can access menus, forms, reports, and tables. In Microsoft Dynamics AX, you assign permissions to user groups instead of individual users in the User group permissions form. Assigning permissions to groups saves time because you do not have to adjust permissions for each user. 

When you create a new user group in Microsoft Dynamics AX, the group, by default, is set to No access for all menus, forms, reports, and tables. This means that after you create a new group, you must use the procedure in Set up security keys to enable permissions; otherwise all members of the group are denied access to all menus, forms, reports, and tables.

For complete guidelines, see User group permissions (Form). 

The optional setup forms of the Administration module

The setup of the Administration module includes a number of other steps beyond the basic functionality.

The additional setup forms are organized by functionality.
Record level security

Record-level security builds on the restrictions enforced by user-group permissions in the Record level security form. With user-group permissions, you restrict which menus, forms, and reports that members of a group can access. Record-level security enables you to restrict the information shown in reports and in forms.

For complete guidelines, see Record Level Security (Form).

Domains

If your organization or business has more than one company account, you can restrict account access using domains in the Domains form. Domains restrict account access in the same way user groups restrict user access. With the combination of domains and user groups, you can create a strict security policy where each user group in each domain is a distinct entity with absolutely no access between groups/domains. Or you can create a customized security policy where, for example, one group has account access to similar group data, forms, and modules across multiple domains.

For complete guidelines, see Domains (Form).

Virtual company accounts

Virtual company accounts contain data that is shared by more than one company account and are set up in the Virtual company accounts form. Real company accounts that belong to the same virtual company account create and manage data in the same database. Virtual company accounts are usually used with a limited number of tables.

For complete guidelines, see Virtual company accounts (Form).

Database log

You can display a list of database changes within the current set of company accounts in the Database log form.

For complete guidelines, see Database log (Form).

E-mail parameters

You can set up Simple Mail Transfer Protocol (SMTP) to send e-mail in the E-mail parameters form.

For complete guidelines, see E-mail parameters (Form).

Flowchart: Configuring the Basic module

The Basic module contains forms to configure features and functionality in the other modules in Microsoft Dynamics AX. Some of the configurations in Basic must be set up and completed before you can use the features of the other modules.

Prerequisites

Set up the Administration module. For more information, see Flowchart: Configuring the Administration module
Forms in Basic required to configure other modules
Most of the features in Microsoft Dynamics AX have setup requirements in the Basic module. For complete guidelines about what forms in Basic that need to be set up as part of the configuration of each module or feature area, when to complete the setup, and whether it is required or optional, see: 
General ledger: Flowchart: Configuring the General ledger module
Fixed assets: Flowchart: Configuring Fixed assets
Cost accounting: Flowchart: Configuring the Cost accounting module
Bank: Flowchart: Flowchart: Configuring the Bank module
CRM: Flowchart: Flowchart: Configuring the Sales and marketing (CRM) module
Accounts receivable: Flowchart: Configuring the Accounts receivable module
Accounts payable: Flowchart: Configuring the Accounts payable module
Inventory management: Flowchart: Configuring the Inventory management module
Master planning: Flowchart: Configuring the Master planning module
Production: Flowchart: Configuring the Production module
Product Builder: Flowchart: Configuring the Product Builder module
Shop Floor Control: Flowchart: Configuring the Shop floor control module
Human Resources: Flowchart: Configuring the Human resources module
Questionnaire: Flowchart: Configuring the Questionnaire module
Balanced scorecard: Flowchart: Configuring Balanced scorecard
Project: Flowchart: Configuring the Project module
Service: Flowchart: Configuring Service management
Service subscriptions: Flowchart: Configuring Service subscription
Alerts: Flowchart: Flowchart: Configuring Alerts
Application Integration Framework: Flowchart: Flowchart: AIF for inbound Web services and Flowchart: AIF for adapter-based exchanges
Intercompany: Flowchart: Configuring Intercompany
Enterprise Portal: Flowchart: Configuring Enterprise Portal
OLAP reporting: Flowchart: Configuring OLAP reporting
Ad hoc reporting: Flowchart: Configuring ad hoc reporting 
Flowchart: Configuring the General ledger module

 General ledger is the core financial module.

In this module, you define:

· Company currencies

· The ledger accounts within the chart of accounts

· Fiscal periods and fiscal years

· Sales taxes (for both sales and purchases)

· Journals for posting to ledger accounts 

· System accounts for automatic posting

· Parameters, defaults, and number sequences that apply to ledger accounts and ledger transactions.

· Dimensions, dimension sets and hierarchies, and financial statements

· Optional features related to journals and posting

· Sales tax specific to countries/regions

· Vendor withholding tax

· Ledger budgets and period allocation keys

· Fixed assets

The following steps are performed per company:

Prerequisites

· Set up the Administration and Basic modules.

· Select the company default currency in the Currency field in the Company information form.
Flowchart
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See General ledger module flowchart for print version.

The main setup forms of the General ledger module

The forms that a company must set up to be able to use the basic functionality of the General ledger module are listed in the recommended order that you should set them up.

1. Currency

Review the foreign currencies that have been created in the Exchange rates form. If necessary, create the currencies that you want to use for particular ledger accounts, for example, a bank account or foreign trade accounts.

Note   If you are creating a consolidated company, create the currencies that are the company currencies of foreign subsidiaries.

For complete guidelines for setting up the Exchange rates form, see Exchange rates (Currency) Form.

2. Chart of accounts

Create the company’s general ledger accounts in a structured list in the Chart of accounts form. The general ledger accounts contain the financial data about the company's activities.

To create an account, you must enter at least an account number and account type. Later on, you can enter other account details.

For complete guidelines for setting up the Chart of accounts form, see Chart of accounts (LedgerTable) Form.

3. Periods
421. Create the fiscal periods and determine which user groups can update each module during each period in the Periods form. For complete guidelines for setting up the Periods form, see Periods (LedgerPeriod) Form.

422. Define the date intervals in the Date intervals form that you can use in reports in the General ledger and other modules.

For complete guidelines for setting up the Date intervals form, see Date intervals (LedgerPeriodCode) Form.

4. Set up sales tax

To ensure that every transaction that needs to be included in the sales tax calculations for sales tax authorities has an appropriate sales tax code, you must: 

· Create at least one sales tax group and one item sales tax group 

· Enter default values for each sales tax group on appropriate ledger accounts.

423. Set up the ledger posting groups in the Ledger posting groups form that define how sales taxes are posted in the Chart of accounts form. You must attach a ledger posting group to each sales tax code. 

For complete guidelines for setting up the Ledger posting groups form, see Account group (TaxAccountGroup) Form.

424. Set up the governmental bodies to which sales taxes are paid in the Sales tax authorities form.

For complete guidelines for setting up the Sales tax authorities form, see Authority (TaxAuthority) Form.

425. Create the periods that the company uses when reporting sales tax and link them to the sales tax authorities in the Sales tax settlement periods form.

For complete guidelines for setting up the Sales tax settlement periods form, see Sales tax settlement periods (TaxPeriod) Form.

426. Create the sales tax codes that contain all information about a particular sales tax in the Sales tax codes form, including the tax base, the percentage or amount, the ledger posting group, settlement period, and reporting details. 

For complete guidelines for setting up the Sales tax codes form, see Sales tax codes (TaxTable) Form.

Note   If the company files U.S. sales taxes, you must also set up sales tax jurisdictions, which are used in the setup of Sales tax groups. See United States sales tax.

427. Create the sales tax groups that contain sales tax codes and that are attached to ledger accounts, customers, and vendors in the Sales tax groups form. The sales tax on a transaction is determined by the sales tax codes that are common to the sales tax group on the transaction account and the item sales tax group on the transaction item. 

For complete guidelines for setting up the Sales tax groups form, see Sales tax groups (TaxGroup) Form.

428. Create the item sales tax groups that contain sales tax codes and that are attached to items in the Item sales tax groups form. The sales tax on a transaction is determined by the sales tax codes that are common to the sales tax group on the transaction account and the item sales tax group on the transaction item. If a transaction does not contain items with item sales tax groups, for example, a free text invoice, the item sales tax group that you attach to a ledger account can function as the default item sales tax group for the transaction.
For complete guidelines for setting up the Item sales tax groups form, see Item sales tax groups (TaxItemGroup) Form.

429. For each ledger account that could receive transactions that must be reported to the sales tax authorities, select default values for the sales tax group and item sales tax group in the Setup tab of the Chart of accounts form.
5. Journals and automatic posting

430. Define the templates that you use for journals in all modules, not just the General ledger module, in the Journal names form. This includes setting up the number sequences for journals.
For complete guidelines for setting up the Journal names form, see Journal names (LedgerJournalSetup) Form.

431. Create system accounts for automatic transactions that are not set up elsewhere in the program System accounts form.

For complete guidelines for setting up the System accounts form, see System accounts (LedgerSystemAccounts) Form.

6. Parameters, defaults, and number sequences

Set up default settings that are applied if a more specific setting is not specified, parameters for various kinds of functionality, and various number sequences for the General ledger module in the Parameters form.

For complete guidelines for setting up the Parameters form, see General ledger parameters (LedgerParameters) Form.

Note   Enable or disable functionality by selecting or clearing check boxes; select from system options in drop-down lists (characterized by a downward-pointing arrow); and select from options that are particular to your company in lookup fields (characterized by a small, curved, downward-pointing arrow). 

If the lookup fields have no options, set up the options for your company: 

With your cursor in the field, right-click and select Go to the Main Table Form.

Create the values that are agreed on for your company in the form that you have opened.

The optional setup forms of the General ledger module

The setup of the General ledger module includes a number of other steps beyond the basic functionality.

The additional setup forms are organized by functionality and are not required to be completed in a specific order.
Dimensions

Create dimension values for the dimensions that are available in the company in the Dimensions form. Dimension values can be placed on accounts and transactions to allow a different kind of analysis of company data than is possible with ledger accounts alone. 

Note   This form may already have values because the values were created in the Dimensions form when the Basic module was set up. 

Dimension sets and dimension hierarchies

· Create dimension sets and relations between dimension sets, and attach hierarchies to a dimension set in the Dimension sets form. Use the Structure designer form to build the hierarchies. This same designer is used to build a financial statement.

For complete guidelines, see Dimension sets (Form).

· Dimension set rules control dimension value combinations at entry time on application objects such as forms, journal lines, and ledger accounts in the Dimension set rules form.

For example, you can make sure that the accountant can only select between specific cost centers for the administration department when you make general ledger entries, whereas the order processor can select between other cost centers for the sales department. Also see Dimension hierarchies.

For complete guidelines, see Dimension set rules (Form).

Financial statements

· Create dimension focuses containing dimension type combinations in the Dimension focuses form, including the ledger account in order to report on financial transactions by selecting a primary and eventually secondary focus to be considered when presenting the results.

For complete guidelines, see Dimension focuses (Form).

· Set up financial statements based on main and secondary focuses, and define row and column structures in the Financial statement form.

For complete guidelines, see Financial statement (Form).

· Create and manage row structure definitions for financial statements in the Row definition form.

For complete guidelines, see Row definition (Form).

Journals

· Create transaction texts that you can select on journal lines in the Journal texts form.

For complete guidelines, see Ledger journal texts (Form).

· Create posting journals for sales, purchases, and journals to group ledger transactions by voucher series in the Posting journals form.

For complete guidelines, see Posting journals (Form).

· Enter the ledger accounts that are displayed when you make an inquiry on balance control in a journal, such as petty cash account, in the Balance control accounts form.

For complete guidelines, see Balance control accounts (Form).

· Set up the methods that is used to import an account statement from a file into the general journal in the Methods of importing account statements form.

For complete guidelines, see Import methods for account statements (Form).

Posting

· Create accrual schemes to post expenses or income in the Accrual schemes form in the period in which they occur, regardless of when the related payment is made or received.

For complete guidelines, see Accrual schemes (form).

· Select and update the database tables to be inspected in an inquiry to find the tables that contain a reference to a specific ledger account in the Account reference form. 

For example, you can find the tables that contain references from automatic transactions to a ledger account if you set up the most likely tables for the reference inquiry in this form.

For complete guidelines, see Ledger account references (Form).

Note   To make such an inquiry, click General ledger > Chart of accounts, select a ledger account, and then click Inquiry > References.

· Set up the first characters of account numbers for automatic account type selection in the setup of the chart of accounts in the Automatic account type selection form. 

For complete guidelines, see Automatic account type selection (Form).

· Select the accounts that are used to calculate cash flow forecasts and currency requirements in the Liquidity form.

For complete guidelines, see Liquidity (Form).

· Select other company accounts in the database to which the current company can make direct postings in the Intercompany accounting form.

For complete guidelines, see Intercompany accounting (Form).

· Create a purchase duty abbreviation to use in the sales tax report, and select posting accounts and sales tax authority in the Purchase duty form. Purchase duty is a tax on incoming sales tax and is calculated as a percentage of the paid sales tax. 

For complete guidelines, see Purchase duty (Form).

· Set up taxonomies for XBRL (eXtensible Business Reporting Language) reporting in the XBRL taxonomy form. XBRL is a powerful and flexible version of XML that is defined to meet the requirements of business and financial information. With it, you can apply unique identifying tags to items of financial data, such as ledger accounts.

For complete guidelines, see XBRL taxonomy (Form).

Sales tax

· Create sales tax reporting codes to implement pre-formatted sales tax reports for specific countries/regions in the Sales tax reporting codes form.

For complete guidelines, see Sales tax reporting codes (Form).

· Create tax exempt numbers that are printed on external documents, such as invoices, in the Tax exempt numbers form.

For complete guidelines, see Tax exempt numbers (Form).

Sales tax specific to country/region

· For European Union countries only - Create sales tax exempt codes to be printed on external documents, such as invoices that must meet the requirements in the EU 115 directive, in the Sales tax exempt codes form.

For complete guidelines, see Sales tax exempt code (Form).

· For United States only - Create the sales tax jurisdictions for which the company must collect sales tax in the Sales tax jurisdictions form.

For complete guidelines, see Sales tax jurisdictions Form.

· For Australia only - Specify the ledger account to use for posting sales tax amounts in the Additional BAS reconciliation account form that are entered manually, rather than calculated by the system, when reporting. This is used in Australia for the Business Activity Statement. 

For complete guidelines, see Additional BAS reconciliation account (Form).

· For Australia only - Enter the Pay As You Go reason codes in the Office BAS PAYG reason codes form, as stated in the information paper from the Australian Taxation.

For complete guidelines, see BAS PAYG reason codes (Form).

· For Australia only - Enter the BAS (Business Activity Statement) fringe benefit reason codes in the BAS fringe benefit reason codes form as stated in the information paper from the Australian Taxation Office. 

For complete guidelines, see BAS fringe benefit reason codes (Form).

· For Italy only - Create sales tax books for all sales and purchase transactions in the Italian sales tax books form. 

For complete guidelines, see Italian sales tax books (Form).

· For Italy only - Create the sales tax book sections for all sales and purchase transactions in the Italian sales tax book sections form. 

For complete guidelines, see Sales tax book sections (Form).

· For Spain only - Set up value-added tax books in the Spanish VAT books form.

For complete guidelines, see (TaxBookTable) Form.

· For Belgium only - Create the syntax (segments and elements) that is used for electronic sales tax declarations in the EDIVAT software format in the EDIVAT setup form.

For complete guidelines, see (TaxEdivatConfiguration) Form.

· For Belgium only - Set up error identifiers for the EDIVAT format for electronic sales tax declaration in the EDIVAT errors form.

For complete guidelines, see (TaxEdivatErrors) Form.

· For Belgium only - Set up an XML file with the INTERVAT format for electronic sales tax declaration in the INTERVAT setup form. 

For complete guidelines, see (TaxIntervatConfiguration) Form.

· For the Netherlands only - Set up the parameters that define an electronic tax declaration in the Netherlands in the Electronic tax declaration parameters form.

For complete guidelines, see (TaxEvatParameters_NL) Form.

· For the Netherlands only - Set up the electronic tax error messages that are used in electronic tax declarations in the Netherlands in the Electronic tax error messages form.

For complete guidelines, see (TaxEvatError_NL) Form.

Vendor withholding tax

· Create codes and values for withholding tax on non-inventory deliveries (often services) from a supplier that is not a company employee in the Withholding tax codes form. The buying company withholds a percentage of the invoice amount at the time of payment.

For complete guidelines, see Withholding tax codes (Form).

· Create withholding tax groups, and attach one or more withholding tax codes to the groups in the Withholding tax groups form. 

For complete guidelines, see Withholding tax groups (Form).

Budgets

· Create budget models and submodels by which you define the structure of your ledger budgets in the Budget model form.

For complete guidelines, see Budget model (form).

· Create and maintain ledger budgets in the Ledger budget form.

For complete guidelines, see Ledger budget (Form).

Periods

Create period allocation keys that distribute amounts in future periods (for example, budget transactions in the months or quarters of a fiscal year) in the Period allocation keys form.

For complete guidelines, see Period allocation key (Form).

Fixed assets

For complete guidelines for setting up the Fixed assets module, see Set up Fixed assets. Although Fixed Assets is a separate module, the forms for the module are located in the General ledger section.

Flowchart: Configuring the Bank module

Use the Bank module to create and manage company bank accounts and the financial instruments that are associated with bank accounts, such as deposit slips, checks, bills of exchange, and promissory notes.

You create bank groups, bank transaction types, the bank accounts that the company has in each bank group, and check layouts for the bank accounts.

You can view bank data by using a number of standard inquiries, reconcile bank account statements, and print bank data in standard reports, including balances, payment lists, summaries, deposit slips, payment advice, and bank transactions that are not reconciled.

Prerequisites

Set up the following modules:

Bank Flowchart
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See Bank module flowchart for print version.

The main setup forms of the Bank module

The forms that a company must set up to be able to use the basic functionality of the Bank module are listed in the recommended order of setup.

432. Set up the types of transactions that are made in company bank accounts, such as checks, manual checks, deposit slips, electronic deposits, and various kinds of fees and interest charges in the Bank transaction type form.
For complete guidelines, see Bank transaction type (Form).

433. Set up groups of bank transaction types, such as checks, deposits, and fees in the Bank transaction groups form.

For complete guidelines, see Bank transaction groups (Form).

434. Enter information about the banks in which you have accounts. When you set up a new bank account and enter the bank group on the account, the bank group information is copied to the bank account in the Bank groups form.

For complete guidelines, see Bank groups (Form).

435. On the Number sequences tab, enter the number sequences that are used for deposit slips and bank reconciliations in the Parameters form.

For complete guidelines, see Bank parameters (Form).

436. Create and manage bank accounts in the Bank accounts form.

For complete guidelines, see Bank accounts (Form).

The optional setup forms of the Bank module

The setup of the Bank module includes a number of other steps beyond the basic functionality.

The additional setup forms are organized by functionality.

Payment purpose codes
Create payment purpose codes for the official central bank of a country/region in the Payment purpose codes form.

For complete guidelines, see Payment purpose codes (Form).

Forms specific to country/region

· For Belgium only:  Set up sequence numbers for State 11 reporting to the Belgian Luxembourg Exchange Institute (BLWI/IBLC) in the State 11 form.

For complete guidelines, see (BankState11) Form.

· For Belgium only:  Set up parameters for processing a CODA statement. CODA is a software format for electronic banking in Belgium in the CODA parameters form.

For complete guidelines, see Coda Parameters (Form).

· For Belgium only:  Set up the CODA definitions that are used to convert a CODA transaction into a Microsoft Dynamics AX transaction in the CODA definitions form.

For complete guidelines, see CODA definitions (Form).

· For Belgium only:  Set up CODA transaction groups and categories in the Transaction group form.

For complete guidelines, see Transaction group (Form).

Flowchart: Configuring the Accounts receivable module

In the Accounts receivable module, you can easily and carefully track all sales and incoming payments from customers.

You can set up customer groups, customers, posting profiles, various payment options, interest notes, collection letters, commissions, parameters concerning customers and sales orders, prices and discounts, charges, supplementary items, deliveries and destinations, bills of exchange, and so on.

Depending on your setup, you can then perform many tasks that are related to customers and sales. Among other things, you can create and manage sales orders, sales quotations, and free text invoices, settle customer invoices, and make inquiries and reports about all data that is accessible in the Accounts receivable module.
Prerequisites

Set up the following modules:

· Administration
· Basic
· General ledger
· Bank accounts created in the Bank module - used in methods of payment.

Flowchart
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See Accounts receivable module flowchart  for print version.

The main setup forms of the Accounts receivable module

The forms that a company must set up to be able to use the basic functionality of the Accounts receivable module are listed in the recommended order of setup.

437. Define the terms of payment that you assign to sales orders and customers, and that determine invoice due dates in the Terms of payment form.
For complete guidelines, see Terms of payment (PaymTerm) Form.

438. Create and maintain information about how the company receives payments from customers in the Methods of payment form.

For complete guidelines, see Customer methods of payment (Form).

439. Create and maintain groups of customers that share key parameters for posting, settlement and payment, reporting, and forecasting in the Customer groups form.

For complete guidelines, see Customer groups (Form).

440. Set up the way customer transactions are posted to the general ledger in the Posting profiles form.

For complete guidelines, see Customer posting profile (Form).

441. Set up defaults, various kinds of functionality, and number sequences for Accounts receivable in the Parameters form.

For complete guidelines, see Accounts receivable parameters (Form).

442. Define the format of various documents related to customers in the Form setup form.

For complete guidelines, see Sales form setup (Form).

443. Create and maintain the customers that the company does business with in the Customers form.

For complete guidelines, see Customers (Form).

The optional setup forms of the Accounts receivable module

The setup of the Accounts receivable module includes a number of other steps beyond the basic functionality.

The additional setup forms are organized by functionality.

Customer classification group

Create and maintain customer classification groups in order to prioritize customers in the Customer classification groups form.

For complete guidelines, see Customer classification group (Form).

Price/Discount

· Create and maintain price, line-discount, multiline discount, and total discount groups for customers in the Customer price/discount groups form.

For complete guidelines, see Price/discount groups (PriceDiscGroup) Form.

· Create and maintain price, line-discount, multiline discount, and total discount groups for items in the Item discount groups form.

For complete guidelines, see Price/discount groups (PriceDiscGroup) Form.

· Create and edit the names of trade agreement journals in the Trade agreement journal names form.

For complete guidelines, see Trade agreement journal names (Form).

· Activate trade agreements by selecting the relevant combination of discount, customer, and item in the Activate price/discount form.

For complete guidelines, see Activate sales price/discount (Form).

Misc. charges

· Set up codes for the miscellaneous charges that you want to use in sales orders in the Misc. charges codes form.

For complete guidelines, see Misc. charges code (Form).

· Create and maintain miscellaneous charges groups for vendors in the Customer misc. charges groups form.

For complete guidelines, see Misc. charges groups (Form).

· Create and maintain groups of miscellaneous charges for items in the Item misc. charges groups form.

For complete guidelines, see Misc. charges groups (Form).

· Define the miscellaneous charges you want to automatically assign to orders in the Auto-misc. charges form.

For complete guidelines, see Auto-misc. charges (Form).

Supplementary items

· Create and maintain supplementary item groups for customers in the Supplementary item - Customer groups form.

For complete guidelines, see Supplementary item groups (Form).

· Create and maintain supplementary item groups for items in the Supplementary item - Item groups form.

For complete guidelines, see Supplementary item groups (Form).

External item description

Create and maintain groups of customers that have common item descriptions in the Item - Customer groups form.

For complete guidelines, see External item description group (Form).

Distribution
· Create and maintain the conditions for an item's transfer from seller to buyer in the Terms of delivery form.

For complete guidelines, see Terms of delivery (Form).

· Create and maintain the means of transport used when delivering an order from the seller to the buyer in the Modes of delivery form.

For complete guidelines, see Modes of delivery (Form).

· Create and maintain reasons for the deliveries, for example gifts, in the Reasons for delivery form.

For complete guidelines, see Reasons for delivery (Form).

· Create and maintain ID codes and descriptions for delivery destinations in the Destination codes form.

For complete guidelines, see Destination codes (Form).

· Create and maintain descriptions for the various package types in the Package appearance form.

For complete guidelines, see Package appearance (Form).

· Create and maintain a list of carrier names and addresses in the Carrier form.

For complete guidelines, see (SalesCarrier) Form.

Forms

· Create the standard text that appears on different forms in the Form notes form.

For complete guidelines, see Form notes (FormLetterRemarks) Form.

· Set up the sorting orders for requisitions, receipts lists, packing slips, and invoices in the Form sorting form.

For complete guidelines, see Sales form sorting parameters (Form).

Sales order
· Create and maintain sales origin codes that can be used to track the origin of sales orders in the Sales origin form.

For complete guidelines, see Order origin codes (Form).

· Create and maintain sales order pools (groups) in the Order pools form.

For complete guidelines, see Order pools (Form).

· Create and maintain IDs and descriptions of actions to be taken in the Return action form when sold items are returned.
Depending on how your items are set up, it may also be necessary to set up inventory dimensions (Inventory management > Setup > Dimensions > Dimension groups).

For complete guidelines, see Return action (Form).

Quotations

· Set up the quotation types you want to use in the Type form.

For complete guidelines, see Quotation type (Form).

· Set up groups of similar quotation templates in the Template groups form.

For complete guidelines, see Quotation template groups (Form).

Payment

· Set up and manage the terms for obtaining cash discounts in the Cash discounts form.

The cash discount codes are linked to customers and are applied to sales orders.

For complete guidelines, see Cash discounts (CashDisc) Form.

· Set up payment schedules to manage installment payments from customers in the Payment schedules form.

For complete guidelines, see Payment schedules (PaymSched) Form.

· Define the payment days that are used for the calculation of due dates, and specify payment days for a specific day of the week or month in the Payment days form.

For complete guidelines, see Payment days (PaymDay) Form.

· Create and maintain payment fees that are associated with customers in the Payment fee form.

For complete guidelines, see Customer payment fee (Form).

· Create and maintain payment steps in the Payment step form.

For complete guidelines, see Payment step (Form).

Interest and collection letter

· Create and manage collection letter sequences and connect them with a number of collection letter lines in the Collection letter form.

For complete guidelines, see Collection letter (Form).

· Set up and manage interest codes in the Interest form.

For complete guidelines, see Interest setup (Form).

Commission

· Create and maintain sales commission groups for sales to a specific customer or group of customers in the Customer groups for commission form.

For complete guidelines, see Commission customer group (Form).

· Create and maintain sales commission groups for the various sales groups in the Sales groups form.

For complete guidelines, see Commission sales group (Form).

· Create and maintain sales commission groups for specific items or range of items in the Item groups form.

For complete guidelines, see Commission item group (Form).

· Create and maintain data used for calculation of sales commission in the Commission calculation form.

For complete guidelines, see Commission calculation (Form).

· Create and maintain ledger account data relevant to commission posting in the Commission posting form.

For complete guidelines, see Inventory posting (Form).

Statistics

· Set up user-defined intervals to analyze the maturity distribution of customer accounts in the Aging buckets form.

For complete guidelines, see Aging buckets (CustVendReportInterval) Form.

· Create line of business codes that you assign to customers in the Line of business form.

For complete guidelines, see Line of business (LineOfBusiness) Form.

· Create and manage customer statistics groups to use as criteria in inquiries and reports in the Statistics group form.

For complete guidelines, see Statistics group (Form).

Optional setup in other modules

Inventory management

Set up warehouses in the Warehouses form (Inventory management > Setup > Inventory breakdown > Warehouses).

For complete guidelines, see Warehouses (Form).

Basic

· Set up the receipt calendar in the Calendar form (Basic > Calendar).

For complete guidelines, see Calendar (Form).

· Set up invoice number sequence groups in the Number sequences form (Basic > Setup > Number sequences > Number sequences).

For complete guidelines, see Number sequences (Form).

· Set up address setup forms (Basic > Setup > Addresses >):

· ZIP/postal Codes
For complete guidelines, see Postal (codes (AddressZipCodes) Form)
· Country/region
For complete guidelines, see Country/region (form)
· Address format
For complete guidelines, see Address format (Form)
· Address abbreviation
For complete guidelines, see Address abbreviation (Form)
· Contact person
For complete guidelines, see Contact persons (Form)
· Titles of persons
For complete guidelines, see Titles (Form)
· NAF codes
For complete guidelines, see (CompanyNAFCode) Form
· ZIP/postal Codes import log
For complete guidelines, see (AddressZipCodeImportLog_NL) Form
General ledger

· Set up financial dimensions in the Dimensions form (General ledger > Dimensions).

For complete guidelines, see Dimensions (Form).

· Tax setup forms (General ledger > Setup > Sales tax >):

· Sales tax codes
For complete guidelines, see Sales tax codes (Form)
· Sales tax groups
For complete guidelines, see Sales tax groups (Form)
· Item sales tax groups
For complete guidelines, see Item sales tax groups (Form)
· Ledger posting groups
For complete guidelines, see Account group - Ledger posting group (Form)
· Sales tax exempt codes
For complete guidelines, see Sales tax exempt code (Form)
· Sales tax jurisdictions
For complete guidelines, see Sales tax jurisdictions Form
· Sales tax authorities
For complete guidelines, see Sales tax authority (Form)
· Sales tax settlement periods
For complete guidelines, see Sales tax settlement periods (Form)
· Electronic tax declaration setup
For complete guidelines, see Electronic tax declaration setup (Form)
· Electronic tax certificates
For complete guidelines, see Electronic tax certificates (Form).

Bank

Set up the Central Bank purpose code in the Payment purpose codes form (Bank > Setup > Setup).

For complete guidelines, see Payment purpose codes (Form).

Flowchart: Configuring the Accounts payable module

In the Accounts payable module, you can track all purchases and outgoing expenditures to vendors.

You can set up vendor groups, vendors, posting profiles, various payment options, parameters concerning vendors and purchase orders, prices and discounts, charges, supplementary items, deliveries and destinations, promissory notes, and so on.

Depending on your setup, you can then perform many tasks that are related to vendors and purchases. For example, you can create and manage purchase orders and planned purchase orders, use various kinds of journals, and settle vendor invoices.
Prerequisites

Set up the following modules:

· Administration
· Basic
· General Ledger
· If you want to set up payment journals, you must first set up the journal under finance (General ledger > Setup > Journals > Journal names).

· If you want to run exchange rate adjustment, you must set up the currency codes (General ledger > Setup > Exchange rates).

· Bank accounts created in the Bank module - used in methods of payment
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See Accounts payable module flowchart for print version.

The main setup forms of the Accounts payable module

The forms that a company must set up to be able to use the basic functionality of the Accounts payable module are listed in the recommended order of setup.

444. Define the terms of payment that you assign to sales orders, purchase orders, customers, and vendors, and that determine invoice due dates in the Terms of payment form.
For complete guidelines, see Terms of payment (Form).

445. Create and maintain information about how the company pays its vendors in the Methods of payment form.

For complete guidelines, see Vendor methods of payment (Form).

446. Create and maintain groups of vendors that share key parameters for posting, settlement and payment, reporting, and forecasting in the Vendor groups form.

For complete guidelines, see Vendor groups (Form).

447. Set up the way vendor transactions are posted to the general ledger in the Posting profiles form.

For complete guidelines, see Vendor posting profiles (form).

448. Set up default settings that are applied if a more specific setting is not specified, parameters for various kinds of functionality, and various number sequences for Accounts payable in the Parameters form.

Tip   Enable or disable functionality by selecting or clearing check boxes; select from system options in drop-down lists (characterized by a downward-pointing arrowhead); and select from options that are particular to your company in lookup fields (characterized by a small, curved, downward-pointing arrow). If the lookup fields have no options, you need to set up the options for your company: With your cursor in the field, right-click, select Go to the Main Table Form, and create the values that are agreed on for your company in the form that you have opened.

For complete guidelines, see Accounts payable parameters (Form).

449. Define the format of various documents that are related to vendors and that are used within the company to keep track of receipts from vendors and to give reason for the flow of payments to vendors in the Form setup form.

Not all the details on this form have to be decided right away. You can return to this form at any time to add functionality or to change the setup of vendor documents.

For complete guidelines, see Purchase form setup (Form).

450. Create and maintain vendors, including the tax authorities to whom your company reports sales taxes in the Vendors form.

To make the setup process simpler, create company or user templates from the first records that are created. A template typically includes entries in a large number of fields that reflect the features that the company wants to implement for a particular type of vendor. 

For complete guidelines, see Vendors (Form). For more information, see Using record templates.

The optional setup forms of the Accounts payable module

The setup of the Accounts payable module includes a number of other steps beyond the basic functionality.

The additional setup forms are organized by functionality.

Price/Discount

· Create and maintain price, line-discount, multiline discount, and total discount groups for vendors in the Vendor price/discount groups form.

For complete guidelines, see Price/discount groups (PriceDiscGroup) Form.

· Create and maintain price, line-discount, multiline discount, and total discount groups for items in the Item discount groups form.

For complete guidelines, see Price/discount groups (PriceDiscGroup) Form.

· Create and edit the names of trade agreement journals in the Trade agreement journal names form.

For complete guidelines, see Trade agreement journal names (Form).

· Activate trade agreements by selecting the relevant combination of discount, vendor, and item in the Activate price/discount form.

For complete guidelines, see Activate purchase price/discount (Form).

Misc. charges

· Set up codes for the miscellaneous charges that you want to use in purchase orders in the Misc. charges codes form.

For complete guidelines, see Misc. charges code (Form).

· Create and maintain miscellaneous charges groups for vendors in the Vendor misc. charges group form.

For complete guidelines, see Misc. charges groups (Form).

· Create and maintain miscellaneous charges groups for items in the Item misc. charges groups form.

For complete guidelines, see Misc. charges groups (Form).

· Define the miscellaneous charges you want to automatically assign to orders in the Auto-misc. charges form.

For complete guidelines, see Auto-misc. charges (Form).

Supplementary items

· Create and maintain supplementary item groups for vendors in the Supplementary item - Vendor groups form.

For complete guidelines, see Supplementary item groups (Form).

· Create and maintain supplementary item groups for items in the Supplementary item - Item groups form.

For complete guidelines, see Supplementary item groups (Form).

External item description

· Create and maintain groups of vendors that have common item descriptions in the Item - Vendor groups form.

For complete guidelines, see External item description group (Form).

Distribution
· Create and maintain the conditions for an item's transfer from seller to buyer in the Terms of delivery form.

For complete guidelines, see Terms of delivery (Form).

· Create and maintain the means of transport used when delivering an order from the seller to the buyer in the Modes of delivery form.

For complete guidelines, see Modes of delivery (Form).

· Create and maintain ID codes and descriptions for delivery destinations in the Destination codes form.

For complete guidelines, see Destination codes (Form).

Forms

· Create the standard text that appears on different forms in the Form notes form.

For complete guidelines, see Form notes (FormLetterRemarks) Form.

· Set up the sorting orders for requisitions, receipts lists, packing slips, and invoices in the Form sorting form.

For complete guidelines, see Purchase form sorting parameters (Form).

Purchase order (purchase pools and return action)
· Create and maintain purchase order pools (groups) in the Purchase pools form.

For complete guidelines, see Purchase pools (Form).

· Create and maintain identifications and descriptions of actions to be taken when purchased items are returned in the Return action form.

For complete guidelines, see Return action (Form).

Payments

· Set up and manage the terms for obtaining cash discounts in the Cash discounts form.

The cash discount codes are linked to vendors and are applied to purchase orders.

For complete guidelines, see Cash discounts (CashDisc) Form.

· Set up payment schedules to manage installment payments to vendors in the Payment schedules form.

For complete guidelines, see Payment schedules (PaymSched) Form.

· Define the payment days that are used for the calculation of due dates, and specify payment days for a specific day of the week or month in the Payment days form.

For complete guidelines, see Payment days (PaymDay) Form.

· Create and maintain payment fees that are associated with vendors in the Payment fee form.

For complete guidelines, see Payment fee (VendPaymFee) Form.

· Create and maintain payment instructions in the Payment instruction form.

For complete guidelines, see Payment instruction (PaymInstruction) Form.

Statistics

· Set up user-defined intervals to analyze the maturity distribution of vendor accounts in the Aging buckets form.

For complete guidelines, see Aging buckets (CustVendReportInterval) Form.

· Create line of business codes that you assign to vendors in the Line of business form.

For complete guidelines, see Line of business (LineOfBusiness) Form.

Tax 1099

Verify and update, according to the latest IRS requirements, the minimum amounts that must be reported to the IRS in the 1099 fields form.

For complete guidelines, see 1099 fields (Form).

Optional setup in other modules

Inventory management

Set up warehouses in the Warehouses form (Inventory management > Setup > Inventory breakdown > Warehouses).

For complete guidelines, see Warehouses (Form).

Basic

· Set up the receipt calendar in the Calendar form (Basic > Calendar).

For complete guidelines, see Calendar (Form).

· Set up invoice number sequence groups in the Number sequences form (Basic > Setup > Number sequences > Number sequences).

For complete guidelines, see Number sequences (Form).

· Set up address setup forms (Basic > Setup > Addresses >):

AddressesFor complete guidelines, see Postal (codes (AddressZipCodes) Form)
· Country/region
For complete guidelines, see Country/region (form)
· Address format
For complete guidelines, see Address format (Form)
· Address abbreviation
For complete guidelines, see Address abbreviation (Form)
· Contact person
For complete guidelines, see Contact persons (Form)
· Titles of persons
For complete guidelines, see Titles (Form)
· NAF codes
For complete guidelines, see (CompanyNAFCode) Form
· ZIP/postal Codes import log
For complete guidelines, see (AddressZipCodeImportLog_NL) Form
General ledger

· Set up financial dimensions in the Dimensions form (General ledger > Dimensions).

For complete guidelines, see Dimensions (Form).

· Tax setup forms (General ledger > Setup > Sales tax >):

· Sales tax codes
For complete guidelines, see Sales tax codes (Form)
· Sales tax groups
For complete guidelines, see Sales tax groups (Form)
· Item sales tax groups
For complete guidelines, see Item sales tax groups (Form)
· Ledger posting groups
For complete guidelines, see Account group - Ledger posting group (Form)
· Sales tax exempt codes
For complete guidelines, see Sales tax exempt code (Form)
· Sales tax jurisdictions
For complete guidelines, see Sales tax jurisdictions Form
· Sales tax authorities
For complete guidelines, see Sales tax authority (Form)
· Sales tax settlement periods
For complete guidelines, see Sales tax settlement periods (Form)
· Electronic tax declaration setup
For complete guidelines, see Electronic tax declaration setup (Form)
· Electronic tax certificates
For complete guidelines, see Electronic tax certificates (Form).

Bank

Set up the Central Bank purpose code in the Payment purpose codes form (Bank > Setup > Setup).

For complete guidelines, see Payment purpose codes (Form).

Flowchart: Configuring Alerts

Alerts are generated as part of a notification system that helps users track critical events in Microsoft Dynamics AX.

To set up Alerts you can use the links below to complete form setup or view information about setup prerequisites.

The setup prerequisites for Alerts depend on what features you want to apply.

Number sequences and the Alerts batch processing must be set up in the Basic module before you can start using Alerts. Apart from these mandatory setup requirements you can enable e-mail alerts, which is an optional feature.

Prerequisites

Number sequences must be set up in the Number sequences form before you can start using Alerts. See setup information in Number sequences (Form).
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See Alerts flowchart for print version.

The main setup forms for Alerts

The forms that you must set up to be able to use the basic Alerts functionality are listed in the recommended order that you should set them up.

Batch processing

Batch processing must be set up for alerts to be delivered.

451. Configure the Due date alerts form to batch process all events caused by due dates. The batch process generates an alert when an event matches the rule conditions.
For complete guidelines, see About alert batch execution.

452. Configure the Change based alerts form to batch process all change-based events (field updates, records deleted, or records created) that have occurred since batch processing was executed the last time. The batch process generates an alert when an event matches the rule conditions.

For complete guidelines, see About alert batch execution.

When setting up batch processing, consider whether you want to set up a batch-processing window. The batch-processing window is optional, and you can set up the batch process without applying the batch-processing window.

The optional setup forms for Alerts

The setup of Alerts includes a number of other steps beyond the basic functionality. The additional setup forms are organized by functionality.

1. Batch-processing window

With a batch-processing window you set up an interval by which the time limit setup in a due-date alert rule criterion can be exceeded. The interval you specify on the Alert parameters form defines a number of days where alerts are delivered even though batches do not run. 

For complete guidelines, see About alert batch execution.

2. E-mail alerts

The e-mail alerts functionality enable users to receive alerts as e-mail messages. The e-mail functionality is optional, so you can use the Alerts feature without applying the e-mail alerts functionality. If you do not set up the e-mail functionality, users can receive their alert as pop-ups only. For additional information about setup information, see About alert e-mail messages.

453. Configure the parameters that Microsoft Dynamics AX needs to communicate with an SMTP server on the E-mail parameters form.
454. Define a valid recipient e-mail address on the Options... form.

455. Set up an e-mail identification for Alerts, a sender e-mail address and an e-mail template on the E-mail templates form.

3. Drill-down links and the drill-down target for e-mail alerts

If you want to use the e-mail functionality, consider whether you want to enable drill-down links and the retry schedule. These features are optional, and you can use the alert e-mail functionality without adding drill-down links in the e-mail template and without setting up a retry schedule for the e-mail messages.

· Drill down links can be applied in the e-mail template on the Alert parameters form to enable users to drill down to alerts, alert rules or the alert origin from an alert e-mail message. 

Drill-down links in e-mail alerts are optional and you can set up an e-mail template and use the e-mail alert functionality without using drill-down links.

When you insert drill-down links into the e-mail template, you should also choose a drill-down target value for the links. The primary purpose of the drill-down target is to prevent users from drilling down to a wrong Microsoft Dynamics AX database in situations where they can receive alerts from two different databases. The drill-down link in alert e-mails must drill down to the database where the event occurred and the drill-down target value identifies the database. 

If users only receive alerts from one database, you need not change the default setting of the drill-down target (= 0).

For complete guidelines, see About drilling down from an alert e-mail message.

4. Retry schedule for e-mail alerts

In the retry schedule on the Retry Schedule form, you can define how many times the system should try to send an e-mail message that has failed to be sent and the time period between the retries. 

The retry schedule setup is optional and you can use the e-mail alert functionality without setting up a retry schedule.

For complete guidelines, see Outgoing e-mail messages and the retry schedule.

Flowchart: Configuring Intercompany

The Intercompany functionality enables several subsidiaries or distribution centers to trade internally within one Microsoft Dynamics AX installation. The Intercompany module adds intercompany features to Microsoft Dynamics AX, which allows you to specify that a specific vendor is a customer in another company and that a specific customer is a vendor in another company. When you have created intercompany relationships, you are able to create intercompany order chains such that a sales order in one company automatically creates a purchase order in another company and vice versa. Changes to orders in an intercompany chain are controlled by the intercompany functionality.

Prerequisites

Set up the following modules:

· @SYS90142Basic
@SYS24097Accounts receivableTo enable Microsoft Dynamics AX to run Intercompany, you must set up customers and vendors to run intercompany. 

Before you set up Intercompany, you must decide which of your customers are intercompany customers and which of your vendors are intercompany vendors. You must decide with each of your other Microsoft Dynamics AX company accounts, which trading policy to apply to the intercompany trading relation with the particular intercompany customer or vendor.
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See Intercompany flowchart for print version.

The main setup forms of Intercompany

The forms that a company must set up to be able to use the basic functionality of Intercompany are listed in the recommended order that you should set them up.

456. In each Microsoft Dynamics AX company account, define an endpoint for the company that you want to do intercompany trade with in the Endpoints form.
Ensure that the company is selected as an intercompany organization and that it points to the appropriate Axapta company account. Also ensure that the constraint (vendor or customer) that the endpoint refers to exists.

For complete guidelines, see Endpoints (form).

457. Set up the relevant intercompany actions for the endpoint, PurchaseRequisition or SalesOrder, in the Action policies form.

For complete guidelines, see Endpoint action policy (form).

458. Set up relevant parameters for intercompany trade for the specific endpoint and action involved in the Setup tab in the Action policies form.

For complete guidelines, see Intercompany action policy (Form).

459. Set up the necessary rules for how you want values converted between companies in the Intercompany setup configuration form.

A prerequisite for defining these conversion rules is that you have set up the values on the specific Microsoft Dynamics AX object (customer, vendor, item, unit, mode of delivery, and so on).

For complete guidelines, see Value Mapping (Form)
Set up additional modules

The additional modules for Microsoft Dynamics AX are listed in the following table. All of these modules are dependent on the core modules, and access to these modules is dependent on your license agreement.

	Module
	See for more information

	CRM
	Set up Sales and marketing (CRM) module

	Inventory management
	Set up Inventory management module

	Master planning
	Set up Master planning module

	Production
	Set up Production module

	Product Builder
	Set up Product Builder module

	Shop Floor Control
	Set up Shop floor control module

	Human Resources
	Set up Human resources module

	Questionnaire
	Set up Questionnaire module

	Project
	Set up Project module

	Cost accounting
	Set up Cost accounting module

	Fixed assets
	Set up Fixed assets

	Balanced scorecard
	Set up Balanced Scorecard

	Service subscriptions
	Set up Service subscription

	Service
	Set up Service management


Flowchart: Configuring the Sales and marketing (CRM) module

In the CRM module, you can set up and manage your business relations and contact persons. With the module, you can coordinate the different tasks connected to your contacts, such as managing the communication with and about your business relations and contact persons.

Prerequisites

· Set up the Administration module.

· Set up the following in the Basic module:

· Employee
For complete guidelines, see Employee (EmplTable) Form.

· Document types
For complete guidelines, see Document type (Form).

· Periods
For complete guidelines, see Periods (Form).

· Titles of persons
For complete guidelines, see Titles (Form).

· ZIP/postal Codes
For complete guidelines, see ZIP/Postal codes (form).

· Address format
For complete guidelines, see Address format (Form).

· Set up Customer groups in the Accounts receivable module.

For complete guidelines, see Customer groups (Form).

· Set up Vendor groups in the Accounts payable module.

For complete guidelines, see Vendor groups (VendGroup) Form.

Optional

If you want to use CRM with Questionnaire, Project, or Master planning, you must set up those modules. For more information, see Set up Questionnaire module, Set up Project module, and Set up Master planning module.
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See Sales and marketing (CRM) module flowchart for print version.

The main setup forms of the CRM module

The forms that a company must set up to be able to use the basic functionality of the CRM module are listed in the recommended order that you should set them up.

460. Set up number sequences on the Number sequences tab in the Parameters form. For guidelines, see Parameters (Form).

Set up the following:

· Business account 
· Relation account 
· Activity number
· Relation journal ID 
· Phone call ID
· Member ID 
· Campaign ID
· Encyclopedia item ID 
· Sales unit member ID 
· Key (used in relation with Business sectors)

· Call list ID 
461. Define business relation types in the Relation types form.

For complete guidelines, see Relation types (Form).

The optional setup forms of the CRM module

The setup of the CRM module includes a number of other steps beyond the basic functionality.

The additional setup forms are organized by functionality and are not required to be completed in a specific order.

Employee

Create and maintain data for all employees in the company accounts in the Employee form.

For complete guidelines, see Employee.

Contact Management

Business relations

· Create a list of phrases that describes the business relation's current position in the company's lead pipeline in the Status form. For complete guidelines, see Business relation status (Form).

· Set up and maintain a list of relevant geographical areas that you can use for sales and sales statistics purposes in the Sales districts form. For complete guidelines, see Sales Districts (Form).

· Set up and maintain a list of general business segments you can use to categorize the business relation in the Segments form. For complete guidelines, see Segment (Form).

· Set up a list of subcategories for each business segment in the Subsegments form. For complete guidelines, see Subsegment (Form).

· Register the business sectors that are relevant for the business relations within the company in the Business sectors form. For complete guidelines, see Business sectors (Form).

· Set up a list of companies that are connected in chains in the Company chains form. For complete guidelines, see Company chains (Form).

Contact persons

· Set up and maintain official job titles for the contact persons in the Titles of persons form. For complete guidelines, see Titles (Form).

· Set up and maintain a list of job functions that can be assigned to the contact persons in the Functions of persons form. For complete guidelines, see Functions (Form).

· Set up and define a list of relevant character descriptions for the contact persons in the Character form. For complete guidelines, see Character (Form).

· Create and maintain a list of decision codes in the Decision form. These can be used to describe a contact person's influence in the decision-making process of the business relation. For complete guidelines, see Decision (Form).

· Set up and define a list of relevant interests: professional, personal, or hobbies, for a contact person in the Interest form. For complete guidelines, see Interest (Form).

· Set up and define a list of phrases that can be used to describe the contact person's attitude towards your company in the Loyalty form. For complete guidelines, see Loyalty (Form).

· Create and maintain a list of courtesy titles in the Person's title form. For complete guidelines, see Title ((smmContactTitleGroup) Form).

· Set up standard closings to use in written communication with the contact person in the Complimentary close form. For complete guidelines, see Complimentary close (Form).

· Create and maintain salutations for written communication with contact persons in the Salutation form. For complete guidelines, see Salutation (Form).

Activities

· Set up and store a list of phases that defines the progress of an activity in the Activity phases form. For complete guidelines, see Activity Phases (Form).

· Set up and maintain activity plans in the Activity plans form. An activity plan is a group of related activities. For complete guidelines, see Activity Plan (Form).

· Set up and register a list of possible activity types or groups of activities in the Activity types form. For complete guidelines, see Activity Types (Form).

Sales Quotations

· Create and maintain sales quotation phases to be used when tracking the progress of a quotation in the Phase form. For complete guidelines, see Phase (Form).

· Create and maintain codes in the Prognosis form, for the assumed time interval when the quotation is expected to be successful. For complete guidelines, see Quotation prognosis (Form).

· Create and maintain numerical codes in the Probability form, for the probability of winning the quotation. For complete guidelines, see Quotation probability (Form).

· Create and maintain information about why a particular quotation was won by the company or lost to the competition in the Reason won/lost form. For complete guidelines, see Quotation reason (Form).

· Set up and define competitors in the Competitors form, with a possible reference to a company registered in the Business relation form. For complete guidelines, see Quotation competitors (Form).

Mailings

· Set up and maintain mailing categories of items to send to contact persons in the Mailing category form. For complete guidelines, see Mailing category (Form).

· Set up and maintain subcategories for each mailing category in the Mailing items form. For complete guidelines, see Mailing items (Form).

E-mail groups

· Set up and maintain e-mail categories in the E-mail category form. These are headings to help you keep track of the individual e-mail groups. For complete guidelines, see Email category (Form).

· Set up and maintain new e-mail groups in the E-mail groups form. For complete guidelines, see E-mail groups (Form).

Telephony

Set up new telephone devices as registered on the Microsoft Windows Client in the Phone parameters form. For complete guidelines, see Phone parameters (Form).

Import

· Set up and define different file formats in the File format definition form. These are used to import data into the Relation/Prospect journal form. For complete guidelines, see File format definition (Form).

· Set up and maintain the record groups in the Record group form. These are used for import file definitions in the File format definition form. For complete guidelines, see Record group (Form).

Sales management

· Define queries in the Query administration form, which defines what queries users are allowed to use in the Management statistics form. For complete guidelines, see Query Administration (Form).

· Create and maintain sales units in the Sales unit/team form. These consist of a manager and sales representatives. For complete guidelines, see Sales unit/team (Form).

Campaigns

· Create campaign types in the Campaign type form. These are further categorizations of campaigns that define them in greater detail than the campaign group. For complete guidelines, see Campaign type (Form).

· Create the campaign group types that are used to broadly categorize campaigns into manageable portions in the Campaign group form. For complete guidelines, see Campaign group (Form).

· Set up categories describing the targets of campaigns in the Campaign target form. For complete guidelines, see Campaign target (Form).

· Set up and maintain a list of work roles or job functions in the Responsibilities form. These roles are of the company's employees in their contact with the business relation of a given campaign. For complete guidelines, see Responsibilities (Form). 

· Set up and define the various media types to be used in campaigns in the Media type form. For complete guidelines, see Media type (Form).

· Set up and define reasons why a particular campaign was canceled in the Reason canceled form. For complete guidelines, see Reason canceled (Form).

· Set up e-mail templates in the E-mail template form, to be used in the campaign module. For complete guidelines, see Email templates (Form).

Telemarketing

Set up a number of reasons that describe why a particular telemarketing call was canceled in the Reason canceled form. For complete guidelines, see Telemarketing Reason (Form).

Microsoft Office Outlook

· Set up the technical parameters for synchronization in the Microsoft Office Outlook Setup Wizard form. For complete guidelines, see Outlook setup wizard (Form).

· Map Microsoft Outlook synchronization fields in the Microsoft Dynamics to Microsoft Office Outlook mapping form. These define which tables and fields in Microsoft Dynamics AX are mapped to which fields in Microsoft Outlook. For complete guidelines, see Microsoft Dynamics to Microsoft Office Outlook mapping (Form).

· Get an overview in the Microsoft Office Outlook administration form of the contact persons synchronized to Microsoft Outlook by the employee of the company. For complete guidelines, see Outlook administration (Form).

Flowchart: Configuring the Inventory management module

In the Inventory management module, you can set up physical and financial details of items in your inventory and control their status from item receipt to item issue, as well as setting up storage and transport details.

Prerequisites

· Set up the following modules:

· Administration
· BasicGeneral ledger
· If you use pricing, set up the following:

· Accounts receivable > Customers
· Accounts payable > Vendors.

· If you use primary suppliers, set up the following:

· Accounts payable > Vendors.

· If you use bill of materials (BOM) or routes, set up the following:

· Basic > Employee.

Flowchart
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See Inventory management module flowchart for print version.

The main setup forms of Inventory management

The forms that a company must set up to be able to use the basic functionality of the Inventory management module are listed in the recommended order of setup.

462. Divide inventory items into groups based on their characteristics on the Item groups form.
For complete guidelines, see Item group (Form).

463. Set up item dimensions and storage dimensions on the Dimension groups form.

For complete guidelines, see Inventory dimensions (Form).

464. Create and maintain inventory model groups that determine how items are controlled and handled on item receipts and issues on the Inventory model groups form.

For complete guidelines, see Inventory model groups (Form).

465. Create warehouses on the Warehouses form.

For complete guidelines, see Warehouses (Form).

466. Create inventory journal names on the Journal names, Inventory form.

For complete guidelines, see Journal names, Inventory (Form).

467. Create items and related item data on the Items form.

For complete guidelines, see Items (Form).

468. Activate the item code, account code and sales tax group combinations to be used on the Inventory posting form by configuring the Transaction combinations form.

For complete guidelines, see Activate inventory transaction combinations (Form).

469. Set up ledger account numbers for the automatic ledger transactions generated in connection with receipt and issue transactions on the Posting form.

For complete guidelines, see Inventory posting (Form).

470. Set up inventory management parameters on the Parameters form.

For complete guidelines, see Inventory parameters (Form).

The optional setup forms of Inventory management

Setting up the Inventory management module includes a number of other steps beyond the basic functionality.

The additional setup forms are organized by functionality.
Company item

Create and maintain common item identifications used in an intercompany organization on the Company item form.

For complete guidelines, see Company item (Form).

Dimensions

Create and maintain groups for automatically allocating batch and serial numbers on the Number groups form.

For complete guidelines, see Number groups (Form).

Item dimensions

Create and maintain:

· Configurations for on-hand inventory items and BOM items on the Configurations form.

For complete guidelines, see Item configuration (Form).

· Item sizes on the Sizes form.

For complete guidelines, see Sizes (Form).

· Item colors on the Colors form.

For complete guidelines, see Colors (Form).

· Item variations on the Item dimension combinations form.

For complete guidelines, see Combinations of item dimensions (Form).

Price/Discount

Create and maintain:

· Price, line-discount, multiline discount, and total discount groups for items on the Item discount groups form.

For complete guidelines, see Price/discount groups (Form).

· Price, line-discount, multiline discount, and total discount groups for customers on the Customer price/discount groups form.

Note that this form is also set up in the Accounts receivable module.

For complete guidelines, see Price/discount groups (Form).

· Price, line-discount, multiline discount, and total discount groups for vendors on the Vendor price/discount groups form.

Note that this form is also set up in the Accounts payable module.

For complete guidelines, see Price/discount groups (Form).

Misc. charges

Create and maintain miscellaneous charge groups for:

· Items on the Item misc. charges groups form.

Note that this form is also set up in the Accounts receivable and Accounts payable modules.

For complete guidelines, see Misc. charges groups (Form).

· Customers on the Customer misc. charges groups form.

Note that this form is also set up in the Accounts receivable module.

For complete guidelines, see Misc. charges groups (Form).

· Vendors on the Vendor misc. charges group form.

Note that this form is also set up in the Accounts payable module.

For complete guidelines, see Misc. charges groups (Form).

Supplementary items

Create and maintain supplementary item groups for:

· Items on the Supplementary item - Item groups form.

Note that this form is also set up in the Accounts receivable and Accounts payable modules.

For complete guidelines, see Supplementary item groups (Form).

· Customers on the Supplementary item - Customer groups form.

Note that this form is also set up in the Accounts receivable module.

For complete guidelines, see Supplementary item groups (Form).

· Vendors on the Supplementary item - Vendor groups form.

Note that this form is also set up in the Accounts payable module.

For complete guidelines, see Supplementary item groups (Form).

Distribution

Create and maintain transport details, such as, mode of transport, shipping and receiving point details, and transport duration on the Transport form.

Note that before this form is set up, you need to set up the Modes of delivery form in the Accounts receivable module.

For complete guidelines, see Transport (Form).

Inventory breakdown

Create and maintain inventory:

· Store areas on the Store areas form.

For complete guidelines, see Store area (Form).

· Store zones on the Store zones form.

For complete guidelines, see Store zone (Form).

· Aisles on the Inventory aisles form.

For complete guidelines, see Inventory aisle (Form).

· Locations on the Locations form.

The Warehouses form can now be updated with the new locations.

For complete guidelines, see Locations (Form).

Inventory

Create and maintain:

· Buyer groups on the Buyer groups form.

For complete guidelines, see Buyer groups (Form).

· Counting groups on the Counting groups form.

This is a mandatory setup if you want to use counting.

For complete guidelines, see Counting groups (Form).

· Blocking causes on the Blocking causes form.

For complete guidelines, see Blocking cause (Form).

· Shipment templates on the Shipment templates form.

For complete guidelines, see Template (Form).

· Fiscal LIFO reporting groups on the Fiscal LIFO reporting group form.

For complete guidelines, see Fiscal LIFO reporting group (Form).

RFID

Create and maintain radio frequency identification (RFID) servers on the RFID Servers form.

For complete guidelines, see RFID Servers (Form).

Inventory equipment

Create and maintain:

· Pallet types on the Pallet types form.

For complete guidelines, see Pallet type (Form).

· Pallet type groups on the Pallet type groups form.

For complete guidelines, see Pallet type group (Form).

· Pallets on the Pallets form.

For complete guidelines, see Pallet (Form).

· Forklifts on the Forklift form.

For complete guidelines, see Forklift (Form).

Bills of materials

· Create and maintain configuration groups used in the allocation of configuration groups to the individual BOM lines on the Configuration groups form.

For complete guidelines, see Configuration groups (Form).

· Create and maintain cost groups on the Cost groups form.

For complete guidelines, see Cost groups (Form).

· Define parameters to control how items are handled during BOM calculation on the Calculation groups form.

For complete guidelines, see BOM calculation groups (Form).

Journals

Create and maintain:

· Journal names on the Journal names, warehouse management form.

For complete guidelines, see Journal names, warehouse management (Form).

· Fiscal LIFO journal names on the Journal names, Fiscal LIFO form.

For complete guidelines, see Journal names, Fiscal LIFO (Form).

Packing material

· Create and maintain item packing material groups on the Packing groups form.

For complete guidelines, see Packing groups (Form).

· Create and maintain item packing material codes on the Packing material codes form.

For complete guidelines, see Packing material codes (Form).

· Define which materials are included in a packing unit, assign weights, and view the total number of items contained in the packing unit on the Packing units form. You can define packing units for individual items, packaging groups, or for all items.

For complete guidelines, see Packing units (Form).

· Enter packing material fees per packaging material code on the Packing material fees form.

For complete guidelines, see Packing material fee (Form).

Forecast

· Create and manage forecast models and submodels on the Forecast models form. Also, generate cash flow forecasts.

For complete guidelines, see Forecast models (Form).

· Create item allocation keys on the Item allocation keys form.

For complete guidelines, see Item allocation keys (Form).

· Create period allocation keys that, for example, distribute forecast transactions in fiscal year periods on the Period allocation keys form.

For complete guidelines, see Period allocation key (Form).

Optional setup in other modules

Master planning

Set up coverage groups in the Coverage groups form (Master planning > Setup > Coverage > Coverage groups).

For complete guidelines, see Coverage groups (Form).

Accounts receivable

Set up commission item groups in the Item groups form (Accounts receivable > Setup > Commission > Item groups).

For complete guidelines, see Commission item group (Form).

Product builder

Set up product model groups in the Item product model groups form (Product Builder > Setup > Groups > Groups).

For complete guidelines, see Product model group (Form).

Production

· Set up production pools in the Production pools form (Production > Setup > Production > Production pools).

For complete guidelines, see Production pools (Form).

· Set up production groups in the Production groups form (Production > Setup > Production > Production groups ).

For complete guidelines, see Production groups (Form).

· Set up production properties in the Properties form (Production > Setup > Work centers > Properties).

For complete guidelines, see Properties (Form).

Project

Set up project categories in the Categories form (Project > Setup > Category > Categories).

For complete guidelines, see Categories (Form).

Basic

Set up foreign trade information in the Intrastat parameters form (Basic > Setup > Foreign trade > Intrastat parameters).

For complete guidelines, see Foreign trade parameters (Form).

Flowchart: Configuring the Master planning module

In the Master planning module, you can set up and run the scheduling feature to calculate requirements and generate planned orders. Forecast scheduling calculates gross requirements based on forecasts and enables you to carry out long-term planning of materials and capacity. Master scheduling calculates net requirements based on actual orders and enables you to control inventory replenishment on a day-to-day basis. With the Master planning module you can:

· Create item coverage settings.

· Create forecast scheduling and master scheduling plans.

· Set up forecast consumption.

· Calculate gross requirements and net requirements.

· Create action messages.

· Create futures messages.

· Generate planned orders.

Prerequisites

You must configure these forms before proceeding to the required Master planning forms:

· Set up the Administration module.

· In the Basic module:

· Set up the Calendar form. For more information, see Calendar (form).

· Set up the Number sequences form. For more information, see Number sequences (form).

· In the Accounts receivable module:

· Set up the Customers form. For more information, see Customers (form).

· In the Accounts payable module:

· Set up the Vendors form. For more information, see Vendors (form).

· In the Inventory management module:

· Set up the Items form. For more information, see Items (form).

· Set up the Item coverage form. For more information, see Item coverage (form).  

· Set up the Forecast models form. For more information, see Forecast models (form).  

Optional

If you want to use Master planning with Production or with Demand planner, you must set up those modules. For more information, see Set up Production module and the Microsoft Dynamics Demand Planner Release 2.0, Installation and Configuration Manual.

Flowchart
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See Master planning module flowchart for print version.

The main setup forms of Master planning

The forms that a company must set up to be able to use the basic functionality of the Master planning module are listed in the recommended order that you should set them up.

471. Create safety stock journal names and set up basic rules for them in the Journal names form.
For more information, see Journal names, item coverage (form).

472. Create forecast plans and specify settings for them in the Forecast plans form. For each plan, you can set parameters that define how the program calculates forecast requirements.

For more information, see Forecast plans (form).

473. Create and manage master plans in the Master plans form. For each plan, you can set parameters that define how the program calculates requirements. 

For more information, see Master plans (form).

474. Create coverage groups and set up parameters that are used in master scheduling in the Coverage groups form. These parameters determine how to calculate requirements for the items that are linked to the coverage group. 

For more information, see Coverage groups (form).

475. Specify default plans and settings for calculating master scheduling in the Parameters form.

For more information, see Master planning parameters (form).

The optional setup forms of Master planning

The setup of the Master planning module includes a number of other steps beyond the basic functionality.

The additional setup forms are organized by functionality, and are not required to be completed in a specific order.

Coverage

· Create and set up minimum and maximum keys to increase or decrease the minimum and maximum inventory levels that you define for an item in the Minimum/Maximum keys form. 

For more information, see, Minimum/maximum keys (form).

· Create and maintain coverage settings to calculate item requirements in the Item setup form.
For more information, see, Item coverage - Setup (form).
Safety stock
476. Create journal lines for the items that you want to check, and then calculate proposals for minimum inventory levels in the Journals form.
For more information, see Item coverage journal (form).

477. Create and update minimum inventory journal lines in the Lines form.
For more information, see Item coverage journal lines (form).

Forecasting
· Create item allocation keys in the Item allocation keys form. These keys assign a percentage of a forecast, which is made at the group level, to individual items or item dimensions.
For more information, see Item allocation keys (form).

· Create period allocation keys in the Period allocation keys form. These keys automatically explode sales orders during defined periods. 
For more information, see Period allocation key (form).

· Create and manage reduction keys in the Reduction keys form to set up consumption of sales and purchase forecast requirements during master scheduling.
For more information, see Reduction keys (form).

Demand planner

Import an external forecast in the Import forecast form, which is in the Inventory management module.

Import an external forecast using Microsoft Dynamics Demand Planner. To do so, you must have Read permission to the following tables, which Microsoft Dynamics Demand Planner creates during integration with Microsoft Dynamics AX:

· MBS_SKU_MAPPING

· MBS_LAST_FORECAST

For more information, see Import a forecast.

You can find additional information in the Microsoft Dynamics Demand Planner Release 2.0, Installation and Configuration Manual.

BOM

Create BOMs for items with components in the Bills of materials form.
For more information, see BOM (form).

Production
Create routes for produced items in the Routes form.

For more information, see Create and update routes (form).

Flowchart: Configuring the Production module

The Production module integrates and interconnects with other modules in the application. This interconnectivity enables you to change production orders and ensure that they are automatically updated in all other related processes and calculations in the application. The processes below are listed in the order they should be conducted.

Prerequisites

You must configure this information in other modules before you can work with the Production module. This includes:

478. In the Basic module:
· Set up general company information.
· Working time templates - Set up working time templates to define the times that are available for production scheduling. Set up templates before you create working time calendars. For more information, see Create working time templates.

· Calendar - Set up working time calendars to define which days of the year are available for production scheduling. For more information, see Create working time calendars.

· Work center groups - Set up work center groups to define the default parameters that are applied to each work center that is subsequently created and assigned to the group. Set up work center groups before you set up work centers. For more information, see Set up and define work center groups.
· Work centers - Set up work centers to define the different resources that are used to complete the production process and to plan for capacity. For more information, see Create work centers.
479. In the General ledger module:

· Set up the general ledger.
· Set up ledger accounts for item groups.

480. In the Inventory management module:

· Set up the inventory item table.
· Define item groups.

· Create items of type BOM.

· Create BOMs and BOM versions.
Flowchart

See Production module flowchart for print version.

The required setup forms of the Production module

The forms that a company must set up to be able to use the basic functionality of the Production module are listed in the recommended order of setup.

481. Parameters - Set up basic production parameters to define how the application should handle and process production orders. Define how they are created, estimated, scheduled, and consumed. You can also select what kind of feedback you want and how cost accounting should be conducted. For more information, see Set up production parameters.
482. Journal names - Identify the production journal names that you want to use to record and post transactions. For more information, see Create journal names.
The optional setup forms of the Production module

The setup of the Production module includes a number of other steps beyond the basic functionality.

The additional setup forms are organized by functionality.
Setup if you use operations
If you are working with operations, ensure that work center groups and work centers are set up first. The parameters assigned to the work centers are inherited by both the work center and its operations. Operations represent the specific activities that occur to produce the finished product.
Note   You will need to know the kinds of activities that are needed to produce your item, the order and priorities of these activities,  and which and how many work centers are involved. 
483. Operations - Set up operations to represent the tasks that must be completed to produce the finished item. For more information, see Set up operations.
484. Relations - Set up operation relations to establish detailed properties. To define operation relations, click the Relations button. For more information, see Set up operations.
Setup if you use routes
If you are working with routes, operations must be defined for each production route that you set up. The route represents the path that the item takes from operation to operation starting with the start of the production process to the end.
485. Cost categories - Set up cost categories to define the cost per hour of specified processes and setup times. For more information, see Create cost categories.
486. Wizard - Set up cost groups to create and maintain different types of costing.

487. Routing groups - Set up route groups to define parameters that pertain to groups of routes. You must set up route groups before creating production routes. For more information, see Create route groups.

488. Routes - Set up production routes and define default settings to control scheduling, costing and pricing of route operations, and progress reporting. For more information, see Create and update production route
489. Routes - Set up route versions to enable item variations in production. For more information, see Create route versions.
Define optional, advanced settings
490. Production groups - Set up production groups to establish relationships between the production order and ledger accounts. The ledger accounts will be used to post or to group orders for reporting. For more information, see Create production groups.
491. Production pools - Create production pools to group production orders for processing urgent production orders, or for deleting and posting groups of orders. For more information, see Create production pools
492. Properties - Define properties to create special attributes that you can assign to your work centers for use in the scheduling process. These attributes are connected to the working time template. For more information, see Set up work center properties.

493. Task groups - Create task groups to use in scheduling productions on alternative work centers when the assigned work center or work center group is not available. For more information, see Set up task groups.
Flowchart: Configuring the Product Builder module

The Product Builder module enables dynamic configuration of items based on the product model attached to this item. The user may configure items in sales order, purchase order, production order, sales quotation, project quotation or item requirement.

Prerequisites

Provide and set up basic functionality for Administration, Basic, Accounts receivable, Accounts payable, Inventory management, Production, Human Resources, Project, Master planning and CRM modules to be able to use the Product Builder module.

Set up Product Builder-related functionalities in the Microsoft Dynamics AX modules

Administration

Users who work with the Product Builder module must belong to the user group that has the appropriate permission levels. Set up these permission levels in the Administration > Setup > Security > User group permissions form (the Development parent key).

Basic

· Create the number sequences for the Product Builder module in the Number sequences form (Basic > Setup > Number sequences > Number sequences).

· Create the document types to use in the Document types form (Basic > Setup > Document management > Document types).

Accounts receivable

Set up to include configuration details while printing a quotation, confirmation, picking list, packing slip, or invoice in the Form setup form (Accounts receivable > Setup > Forms > Form setup).

· To set up printing configuration details for quotations, on the Quotation tab, select Line, Header, or All in the Include document on sheets field and Note in the Include documents of type field.

· To set up printing configuration details for confirmations, on the Confirmation tab, select Line, Header, or All in the Include document on sheets field and Note in the Include documents of type field.

· To set up printing configuration details for the picking list, on the Picking list tab, select Line, Header, or All in the Include document on sheets field, and Note in the Include documents of type field.

· To set up printing configuration details for the packing slip, on the Packing slip tab, select Line, Header, or All in the Include document on sheets field and Note in the Include documents of type field.

· To set up printing configuration details for the invoice, on the Invoice tab, select Line, Header, or All in the Include document on sheets field and Note in the Include documents of type field.

Note   For configuration details to be printed, you must also select Note in the Generate documents of type field of the Product Builder module's Parameters form.

Accounts payable

To include configuration details while printing a purchase order, set up the Form setup form (Accounts payable > Setup > Forms > Form setup). 

To do this, select Line, Header, or All in the Include document on sheets field, and select Note in the Include documents of type field.

Inventory management

In the Product Builder field group on the General tab of the Items form (Inventory management > Items), select from the following check boxes to suit your project needs:

· To make the item configurable in the Product Builder module, select the Modeling enabled check box.

· To make the system configure the item automatically after clicking Configure line, select the Hide dialog box check box. 

If you select the check box, the user does not see the user dialog box and does not have to make any choices there; all the default settings are applied instead.

· To skip the approval dialog box, select the Hide approval dialog check box. 

The user makes all the required choices in the user dialog box, but the configuration approval, sales price, and delivery date calculation are performed automatically.

· To set up automatic starting of the configuration process, select the Autostart configuration check box. 

In this case, the user dialog box appears automatically after the user selects a configurable item in the order or quotation line and clicks Save. The user need not click Configure line for the user dialog box to appear.

· To make the item configuring mandatory, select the Mandatory configuration check box. 

The user cannot save the line without making all the required choices in the user dialog box.

Production

The Production module should be completely set up, because it relates entirely to the Product Builder module.

Human resources

The Human Resources module relates to the Product Builder as a postrequisite, that is, the module must be set up before Product Builder, but final configuration is done after Product Builder is set up.

Project

To include configuration details while printing an invoice or packing slip, set up the Form setup form (Project > Setup > Forms > Form setup).

· To set up printing configuration details in the invoice, on the Invoice tab, select:

· Line, Header, or All in the Invoice field 

· Note in the Include documents of type field.

· To set up printing configuration details in packing slip, on the Packing slip tab, select:

· Line, Header, or All in the Packing slip field. 

· Note in the Include documents of type field.

Master planning

Set up the complete Master planning module because decisions you make there relate closely to the Product Builder module.

CRM

The CRM module relates to the Product Builder as a postrequisite, that is, the module must be set up before Product Builder, but final configuration is done after Product Builder is set up.

Flowchart
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See Product builder module flowchart for print version.

The main setup forms of the Product Builder module

The forms that a company must set up to be able to use the basic functionality of the Product Builder module are listed in the recommended order of setup.

1. Product Builder parameters

In the Parameters form, define general settings for the Product Builder module, such as:

· Number sequences for various Product Builder functions.

· User dialog box and approval dialog settings.

· Layer for code generation.

· Contents of the Composed of report.

For complete guidelines for setting up the Parameters form, see Product Builder Parameters (Form).

2. User profiles

In the User profiles form, create a set of user profiles that correspond to the different types of users who is given the access to the module. User profiles should be attached to the modeling variables. Users should be attached to a user profile through the User profiles form.

For complete guidelines for setting up the User profiles form, see User profiles (Form) 

3. Modeling variables

494. In the Modeling variables form, create different types of modeling variables that are used in the product models. 
For complete guidelines for setting up Modeling variables form, see Modeling variables (Form).

495. In the Outcomes form, create outcomes for modeling variables. The created outcomes are used during item configuration to provide the user with a variety of choices. 

For complete guidelines for setting up the Outcomes form, see Variable outcomes (Form).

Note   This form is available only for modeling variables of the Enumerated text type.

4. Variable group

In the Variable group form, create variable groups to use for grouping modeling variables in the Variables form.

For complete guidelines for setting up the Variable group form, see Variable groups (Form).
5. Global rules

In the Global rules form, create global validation rule sets, and attach the product models for which they must be active.

For complete guidelines for setting up the Global rules form, see General rules version (Form).

6. Item/Customer product model groups

496. In the Customer product model group form, create customer product model groups.
For complete guidelines for setting up the Customer product model group form, see Customer product model group (Form).

497. In the Item product model groups form, create item product model groups.

For complete guidelines for setting up the Item product model groups form, see Product model group (Form).

Note   Both customers and items should be attached to the customer and item product model groups. These groups are used for setting up default values.

7. Defaults

498. In the Default values form, create default values for product modeling variables. These default values for product modeling remain in force unless they are overwritten later (during item configuration) either by user selections or by computed values.
For complete guidelines for setting up the Default values form, see Default values (Form).

499. In the Default routes form, create and approve default routes, which you can then use while building the modeling tree.

For complete guidelines for setting up the Default routes form, see Default values (Form).

Postrequisites

You must set up the following forms after you have set up the Product Builder module:

Accounts receivable

Complete the setup of the Accounts receivable module after you set up the Product Builder module:

· Select the product model group the customer belongs to in the Product model group field of the Sales order field group on the Sales order tab of the Customers form (Accounts receivable > Customers).

· View the product model that is used for item configuring. Here, you can select to configure the item by the product model that is currently inactive for this item in the Product model number field of the Groups field group on the Other tab of the Sales order form (Accounts receivable > Sales order).

· View the product model that is used for item configuring in the Product model number field of the Groups field group on the Other tab of the Sales quotation form (Accounts receivable > Sales quotation). Here, you can also select to configure the item by the product model that is currently inactive for this item.

CRM

Complete the setup of the CRM module after you set up the Product Builder module:

· View the product model that is used for item configuring in the Product model number field of the Groups field group on the Other tab of the Sales quotation form (CRM > Sales quotation). Here, you can also select to configure the item by the product model that is currently inactive for this item.

· Attach the previously created user profiles to the employees in the User profile field of the Employee form (CRM > Setup > Employee).

Project

Complete the setup of the Project module setup after you set up the Product Builder module:

· In the Project quotation form (Project > Project quotation): View the product model that is used for item configuring.  This is in the Product model number field of the Groups field group on the Other tab. Here, you can also select to configure the item by the product model that is currently inactive for this item.

· In the Sales order form (Project > Inquiries > Item task > Sales order):  View the product model that is used for item configuring. This is in the Product model number field of the Groups field group on the Other tab. Here, you can also select to configure the item by the product model that is currently inactive for this item.

· In the Item requirement form (Project > Inquiries > Item task > Item requirement):  View the product model that is used for item configuring. This is in the Product model number field of the Groups field group on the Other tab. Here, you can also select to configure the item by the product model that is currently inactive for this item.

Basic

Complete the setup of the Basic module after you set up the Product Builder module:

· Attach the previously created user profiles to the employees in the User profile field of the Employee form (Basic > Employee).

Human Resources

Complete the setup of the Human Resources module after you set up the Product Builder module:

· Attach the previously created user profiles to the employees in the User profile field of the Employee form (Human Resources > Employee).

Inventory management

Complete the setup of the Inventory management module after you set up the Product Builder module:

· Select the product model group the item belongs to in the Autostart configuration field of the Groups field group on the General tab of the Items form (Inventory management > Items).

Flowchart: Configuring the Shop floor control module

In the Shop Floor Control module, you can electronically collect data in a production environment.

You set up employees, work profiles, indirect activities, various employee groups, parameters for posting on production orders and projects, pay agreements, and registration forms.

You can collect data on time and attendance, on production orders, projects, indirect activities, and absence. Also, you can post collected data on production orders and projects, generate payroll data for employees, and schedule shift plans.

Prerequisites

Set up Administration and Basic modules.

Optional

If you want to use Shop Floor Control with  General ledger, Inventory management, Production, Human Resources, or Project modules, you must set up those modules. For more information, see Set up General ledger module, Set up Inventory management module, Set up Production module, Set up Human resources module, and Set up Project module.

Flowchart
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See Shop floor control module flowchart for print version.

The main setup forms of Shop Floor Control

The forms that a company must set up to use the basic functionality of the Shop Floor Control module are listed in the recommended order that you should set them up.

1. Job IDs and parameter settings

500. Use the Configuration wizard wizard to ensure that necessary parameters are set up. Number sequences are required to move on.
The wizard also creates job IDs for absence groups and categories, production jobs, project activities, and system activities, such as clock-in and clock-out.

501. Review the general parameter settings in the Parameters form. For complete guidelines, see. Shop Floor Control - Parameters (Form).

For additional information, see About parameters.

502. Set calculation parameters in the Calculation parameters form to provide the basis for calculating work and pay time for employees. Go through these parameters and make changes if necessary. For complete guidelines, see Calculation parameters (Form).

For additional information, see About Calculation Parameters.

2. Absence control

503. Create new or edit existing Human resource absence groups in the Absence groups form. For complete guidelines, see Absence groups (Form).

Note   In Shop Floor Control it is possible for employees to register on both absence groups and absence codes.

504. Create new or edit existing absence codes for human resources on the Absence codes tab in the Absence groups form. For complete guidelines, see Absence codes (Form).

3. Indirect activities

505. Create indirect activity categories in the Indirect activities form for different types of indirect activities. A group with system activities is already created by the wizard. For complete guidelines, see Indirect activities (Form).

Note   An indirect activity category can only contain activities of the same type.

For additional information, see About indirect activities.

506. Create indirect activities for each category on the Activities tab, in the Indirect activities form. For complete guidelines, see Indirect activities setup (Form).

4. Profiles

507. Create profiles that cover working hours for all employees to be connected to shop floor control in the Profile form. For complete guidelines, see Working hours profile (Form).
For additional information, see About profiles.

508. Create profile groups in the Profile group form to secure that correct profiles are applied to employees when they clock-in. For complete guidelines, see Profile group (Form).

For additional information, see About groups.

5. Groups

509. Create calculation groups in the Calculation groups form for each team manager or supervisor who is going to calculate employee registrations. For complete guidelines, see Calculation groups (Form).
For additional information, see About groups.

510. Create approval groups in the Approval groups form for each payroll officer or other person designated to approve employee registrations. For complete guidelines, see Approval groups (Form).

For additional information, see About groups.

6. Payroll

511. Set up periods in the Pay periods form. These are used when transferring payroll data and for calculating count units, pay adjustments, and payroll statistics. For complete guidelines, see Pay periods (Form).

512. Set up specific pay types and rates in the Pay types form. These are used when calculating pay. For complete guidelines, see Pay types (Form).

513. Create pay agreements with lines for calculating specific employee wages in the Pay agreements form. For complete guidelines, see Pay agreements (Form).

For additional information, see Pay agreements.

7. Employees and machines

Set up the employees and machines that provide registrations in shop floor control in the Employee form. For complete guidelines, see Shop Floor Control employees (Form).

8. Synchronize job table

Synchronize your data in the Synchronize job table form. For complete guidelines, see Synchronize job table (Class Form).

Run this job once (online mode) or set up as batch (offline mode), depending on your selection in Job table synchronization mode.

The optional setup forms of Shop Floor Control

The setup of the Shop Floor Control module includes a number of other steps beyond the basic functionality.

The additional setup forms are organized by functionality and do not require completion in a specific order.
Production integration

· If you have selected to start production orders from shop floor control, consider the parameter settings in the Start - default values form. For complete guidelines, see Start - default values (Form).

For additional information, see About production default values.

· If you have selected to report production orders as finished from shop floor control, consider the parameter settings in the Report as finished - default values form. For complete guidelines, see Report as finished - default values (Form).

For additional information, see About production default values.

· Set up allocation keys for calculating time on bundled jobs in the Allocation keys form. For complete guidelines, see Allocation keys (Form).

For additional information, see About allocation keys.

Flex groups

Create flex groups in the Flex groups form. These are for employees that are allowed to work flexible hours. For complete guidelines, see Flex groups (Form).

For additional information, see About groups.

Payroll statistics

Create payroll statistics in the Payroll statistics form, to show balances for employees on specific pay types over specified periods of time. For complete guidelines, see Payroll statistics (Form).

Registration forms

Create new or edit existing registration form configurations in the Configure registration forms form, to fit the specific needs of the company. For complete guidelines, see Registration form configuration (Form).

For additional information, see Configure registration forms.

Statistical balance setup

Set up which statistical balances employees can see in registration forms in the Statistical balance setup form. For complete guidelines, see Statistical balance setup (Form).

For additional information, see Configure registration forms.

Flowchart: Configuring the Human resources module

Use the Human Resources module to manage business information and perform actions related to the business workforce and its organizational structure.
Some of the core Human Resources tasks involve working with:

· Organization units 

· Positions 

· Employees in human resources 

· Development plans 

· Absence 

· Recruitment 

· Courses 

· Actions and action plans

· Strategic plans 

· Human resources statistics 

· Human resources parameters 
The main setup forms in the Human Resources module are divided into several distinct feature areas, and each feature area is controlled by a license code. Therefore, the setups that you must complete (mandatory setups) and those that are optional depend on how you want to use the system and the license code(s) that you enable. 

The below sections describe the mandatory and optional forms that you must set up in order to work with the module’s features. Setup form descriptions are sorted according to the license code that enables their use, and the mandatory setups are listed in the order in which you must set them up.
Prerequisites

· Set up the Administration and Basic modules.

Additionally, before beginning, make sure that the appropriate configuration keys are enabled.
Flowchart

See Human resources module flowchart for print version.

The main setup forms of Human Resource I

The forms that a company must set up to be able to work with the features enabled by the Human Resource I license code are listed in the recommended order that you should set them up.

1. Organization

Line organization units represent the formal employment relation for all employees. Therefore, you must set up the line organization units that reflect your company’s formal organization structure. Specify information such as identification, address and contact information, and dimensions if relevant. You can also create organizational hierarchies by establishing primary and secondary unit relationships.

For complete guidelines for setting up the Organization form, see Organization units (Form).
2. Employee

Set up and hire the employees that work in the company. For each employee you must specify identification. All other information in the form is optional, and depends on the information that you want to manage about employees.

For complete guidelines for setting up the Employee form, see Employees (Form).

The optional setup forms of Human Resource I

The setup of the Human Resource I feature set includes a number of other steps in addition to the mandatory setups.

The additional setup forms are organized by functionality and are not required to be completed in a specific order.
Employee

· Certificates

Create the certificates that have been earned by company employees. Certificates are registered on employee resumes from the @SYS5705 form. You can also create the certificates that can be achieved by successfully completing a training course. Using certificates with courses requires that the Human Resources III license code is enabled.

For complete guidelines for setting up the Certificates form, see Certificates (form).

· Language codes

Create language codes for use when recording the native language of employees on the Employee form.

For complete guidelines for setting up the Language codes form, see Language codes (Form).

· Entitled negotiators

Record information about the representatives that are entitled, or authorized, to negotiate with the company on an employee’s behalf.

For complete guidelines for setting up the Entitled negotiators form, see Entitled negotiators (Form).

· Vocational organizations

Record the vocational organizations, such as unions or employee associations, with which some or all company employees are associated.

For complete guidelines for setting up the Vocational organizations form, see Vocational organizations (Form).

· Employee record types

Create types of developments or reminders of, for example, events, agreements, or actions related to an employee. Reminder types are used by employee records.

For complete guidelines for setting up the Employee record types form, see Employee record types (Form).

Reason codes

Define codes that indicate the reason for an event or occurrence. Reason codes are used when hiring or moving employees, or terminating employment, and when rejecting an application for employment.

For complete guidelines for setting up the Reason codes form, see the Human Resources reason codes (Form).

Skills

· Skill types

Create and manage general categories of skills. All skills must be assigned to a skill type.

For complete guidelines for setting up the Skill types form, see Skill types (Form).

· Skills

Create skills that can be associated with an employee, applicant, or contact person, or used to describe position requirements.

For complete guidelines for setting up the Skills form. see Skills (Form). 

Education

· Education

Create the educations you want to record as qualifications on an employee or applicant resume, or to indicate a requirement for performing the tasks involved in specific positions in the company. Educations can include all types of studies, instruction, or training that result in new skills, regardless of whether they are achieved privately or in-company.

For complete guidelines for setting up the Education form, see Educations (Form).

· Institutions

Set up institutions so that you can specify where employees received education, or where they attended training courses.

For complete guidelines for setting up the Institutions form, see Institutions (Form).

· Degrees

Create the educational degrees that have been achieved by one or more employees. Educational degrees are specified for employees as a part of their resume data, and can also be used as search criteria in a skill mapping.

For complete guidelines for setting up the Degrees form, see Degrees (Form).

· Education group

Create education groups in order to categorize educations.

For complete guidelines for setting up the Education group form, see Educations (Form) and Education group (Form).

Loan

· Loan items
Record the items or other company assets that can be loaned to employees. Loan items can include, for example, cell phones, company cars, computer equipment, uniforms, cameras, and books. The loan item describes what is being loaned, who is responsible for the item and, if relevant, the number of days the item may be on loan.

For complete guidelines for setting up the Loan items form, see Loan items (Form).

· Loan types

Create categories of items that can be loaned to people in the network. When you create loan items, you must assign the item to a loan type.

For complete guidelines for setting up the Loan types form, see Loan types (Form).

Development

· Interview types

Set up general categories of interviews. When you create an interview, you must assign the interview to the appropriate interview type. Examples of interview types are appraisal interview, job development discussions, and exit interviews.

For complete guidelines for setting up the Interview types form, see Interview types (Form).

· Development plan
Set up general categories of development plans. When you create a development plan, you must assign the plan to the appropriate development plan type. Examples of development plan types are educational plans, career plans, and personal plans.

For complete guidelines for setting up the Development plan types form, see Development plan types (Form).

Payroll

· Payroll category

Create categories in order to classify employee salaries. Examples of payroll categories are hourly, increment, and salaried.

For complete guidelines for setting up the Payroll category form, see Payroll category (Form).

· Income tax codes

Create tax categories for employees. Income tax codes are used when recording wage information for employees. Only one tax code can be assigned to an employee.

For complete guidelines for setting up the Income tax codes form, see Income tax codes (Form).

· Benefit types

Set up the types of benefits that the company grants to its employees. Examples of benefits are free telephone, gym membership, or a newspaper subscription.

For complete guidelines for setting up the Benefit types form, see Benefit type (Form).

· Salary deduction types

Define the types of deductions that can be made from employee salaries, and provide a description of each deduction.

For complete guidelines for setting up the Salary deduction types, see Salary deduction types (Form).

· Insurance types

Catalog general types of insurance policies that the company employees possess, either currently or historically. You use insurance types when recording wage information for an employee. Examples of insurance types are health, live, and dental.
For complete guidelines for setting up the Salary deduction types form, see Insurance types (Form).
· Income tax categories
Create tax categories applicable to company employees. You can use income tax categories when you record wage information for employees. An employee can only belong to one tax category.
For complete guidelines for setting up the Income tax category form, see Income tax category (Form).

· Terms of employment
Create categories of employment terms. Examples of terms of employment are full-time, part-time, and contractor.
For complete guidelines for setting up the Terms of employment form, see Terms of employment (Form).

· Personnel category
Create categories of employees in order to provide a basis for assigning payroll information. You can divide each category into wage groups, which can be further divided according to payroll scale level. For example, if you employ a number of accountants you could create an accountant category in payroll scale level. You could then create wage groups to indicate a level of qualification or experience related to the accountant category. When you assign a payroll scale level to a wage group, you can also differentiate between junior and senior accountants.
For complete guidelines for setting up the Personnel category form, see Personnel category (Form).

· Leave types
Set up the types of leave that employees are allowed to take from the company. Examples of leave types are maternity, educational, and medical.
For complete guidelines for setting up the Leave types form, see Leave types (Form).

· Payroll allowance
Enter the amount of the employee’s salary that is non-taxable.
For complete guidelines for setting up the Payroll allowance for, see Payroll allowance (Form). 

The main setup forms of Human Resource II
The forms that a company must set up to be able to work with the features enabled by the Human Resource II license code are listed in the recommended order that you should set them up.
1. Parameters
Set up parameters to specify default information, define number sequences, and other functionality to be used across the module.
For complete guidelines for setting up the Parameters form, see Human Resource parameters (Form).

2. Position groups
Set up categories in which to group positions in the company that are similar in nature or function.
For complete guidelines for setting up the Position groups form, see Position groups (Form).

3. Positions
Create the positions in which you want to hire employees. You can create job-type positions for line organization units, or role-type positions for project or matrix organization units.
For complete guidelines for setting up the Positions form, see Positions (Form).

4. Absence setup
Set up rules to control the way in which employees register absence. For each employee to whom you assign the setup, you can define registration rules that control the period in which the employees can register absences, who approves their registrations, and whether they record absence in terms of days or hours.

For complete guidelines for setting up the Absence setup form, see Absence setup (Form).
The optional setup forms of Human Resource II
The setup of the Human Resource II feature set includes a number of other steps in addition to the mandatory setups.

The additional setup forms are organized by functionality and are not required to be completed in a specific order.

Organization

· Position status

Create status types that indicate the current state of a position. For example, a status called vacant could be assigned to a position that is currently active but unoccupied.
For complete guidelines for setting up the Position status form, see Position status (Form).

· Work tasks
Define specific tasks that employees working in a position must perform.
For complete guidelines for setting up the Work tasks form, see Work tasks (form).

Absence

· Absence groups

Categorize absence codes into logical groups. This is especially useful if you have many different types of absence. For example, the leave category might include the following: Short term, maternity, or educational. Absence groups are also used when you set up columns for the Absence status report.
For complete guidelines for setting up the Absence groups form, see Absence groups (Form).

· Absence codes

Create absence codes to indicate the reason for an absence, and to specify registration rules for absence registrations. For example, you can define registration rules to control the number of absences allowed during a specific period of time, the number of multi-day absences, and whether to permit multiple occurrances of multi-day absences during a period.
For complete guidelines for setting up the Positions form, see Absence codes (Form).

Recruitment

· Media types

Set up categories of the advertising media that you use to recruit new employees. An example of a media type is “newspaper”, to which you can then assign specific media, such as the name of the newspaper in which you advertised.
For complete guidelines for setting up the Positions form, see Media types (Form).

· Media

Create the specific advertising media sources that you use in recruitment projects to attract potential new employees.
For complete guidelines for setting up the Media form, see Advertising media (Form).

· Application bookmarks
Facilitate communications with applicants by defining the fields from which to draw information when using application documents or application e-mails to correspond with applicants. You can use the bookmarked fields to insert specific information into prepared text, which you can then include in responses to applicants.
For complete guidelines for setting up the Application bookmarks form, see Application bookmarks (Form).

· Application e-mail templates
Create templates for e-mail correspondence with applicants. You can create one or more templates for each of the following types of communications: Received, Interview, Rejection, Employed.
For complete guidelines for setting up the Application e-mail templates form, see Application e-mail templates (Form).

The main setup forms of Human Resource III

The forms that a company must set up to be able to work with the features enabled by the Human Resource III license code are listed in the recommended order that you should set them up.
1. Parameters
Specify default information, define number sequences, and other functionality to be used across the module.
For complete guidelines for setting up the Parameters form, see Human Resource parameters (Form).

2. Course types
Set up course types in order to classify courses according to their type, structure, subject matter. Examples of course types include courses in personal development, management training, foreign languages, and programming.
For complete guidelines for setting up the Course types form, see Course types (Form).

3. Courses
Set up internal training courses, and manage information about participants in each course.
For complete guidelines for setting up the Courses form, see Training courses (Form).

The optional setup forms of Human Resource III
The setup of the Human Resource III feature set includes a number of other steps in addition to the mandatory setups.

The additional setup forms are organized by functionality and are not required to be completed in a specific order.

Course

· Course groups

Assemble course types into logical groups. If you have many different types of courses, this can make it easier to find the course you want. For example, a group called “company” might contain the following course types: Company Business Processes, Company HR Management, Company Balanced Scorecard.
For complete guidelines for setting up the Course groups form, see Course groups (Form).

· Course locations

Specify information about the locations at which you hold training courses, such as the rooms used at the location, the instructors who teach there, a picture of the location, and a recommended hotel in the area.
For complete guidelines for setting up the Course locations form, see Course locations (Form).

· Classroom groups

Set up groups of classrooms. Each group can represent, for example, all rooms in a particular building, or those that are appropriate for a special type of instruction. This makes it easy to find and assign the most suitable classroom to a course.
For complete guidelines for setting up the Classroom groups form, see Classroom groups (Form).

· Classrooms

Record information about the specific rooms in course locations in which you conduct training courses, such as its location, maximum capacity, and notes to indicate any special conditions.
For complete guidelines for setting up the Classroom groups form, see Classrooms (Form).

· Instructors

Assign course instructors to specific course location. However, if the same instructure teaches at several locations, do not assign a course location to the instructor. You can only assign employees, contact persons, and applicants as instructors.
For complete guidelines for setting up the Classroom groups form, see Instructors (Form).

Flowchart: Configuring the Questionnaire module

Use the Questionnaire section to design, create, distribute, and complete questionnaires, and then analyze the results.
The main set up forms in the Questionnaire module are divided into several distinct feature areas, and each feature area is controlled by a license code. Therefore, the setups that you must complete (main setups) and those that are optional depend on how you want to use the system and the license code(s) that you enable.
The sections below describe the mandatory and optional forms that you must set up in order to work with the module’s features. Setup form descriptions are sorted according to the license code that enables their use, and the mandatory setups are listed in the order in which you must set them up.

Prerequisites

Set up the Administration and Basic modules.
Additionally, before beginning, ensure that the appropriate configuration keys are enabled.
Flowchart

See Questionnaire module flowchart for print version.

The main setup forms of Questionnaire I

Enabling the Questionnaire I license code gives access to all setups required to design, create, and make a questionnaire available to respondents that can access the Questionnaire module. This topic provides a complete and prioritized list of the main setup forms enabled by the Questionnaire I license code.

1. Parameters 
Define parameters to control basic functions and default settings for questionnaires, such as the stylesheet to apply to questionnaires and the number sequence selections for answers, questions, and respondents. 
For complete guidelines for setting up the Parameters form, see Questionnaire parameters (Form).
3. Questionnaire types

Create categories in order to classify questionnaires that share common characteristics, such as similar purpose, subject matter, or target group. Examples of questionnaire types are customer surveys, evaluations, and examinations. Classifying questionnaires according to type also enables you to quickly find a specific questionnaire by filtering by type on the Questionnaire form.
For complete guidelines for setting up the Questionnaire types form, see Questionnaire types (Form).
4. Question types

Create categories in order to classify questions that share common characteristics, such as similar purpose, subject matter, or target group. Examples of question types are business management, course evaluation, and customer surveys. Question types also make it easier to find the question you want to use by enabling you to filter questions by type in the Questions form.
For complete guidelines for setting up the Question types form, see Question types (Form).
5. Questions

Create the questions to ask on a questionnaire. For each question, you can define the input type that a respondent will use to provide his or her answer, the answer group that contains the answers to the question, the question’s text, and media to use to support the question.
For complete guidelines for setting up the Questions form, see Create questions (Form).

6. Questionnaires

Set up an executable questionnaire. Specify the type of questionnaire, select questions and specify their presentation sequence, decide whether to use result groups to capture points, define the total time that respondents have in which to complete the questionnaire, select a background graphic, enable navigation and overview controls, and select enable subsequent analyses.
For complete guidelines for setting up the Questionnaires form, see Questionnaires (Form).
Optional Setup Forms of Questionnaire I
This topic describes optional setup forms that can be set-up when the Questionnaire I license code is enabled.
Network groups

Create groups of employees, applicants, and contact persons in order to make it easy to assign access privileges to questionnaires. When distributing questionnaires, you can specify the network groups that contain the appropriate respondents. 
For complete guidelines for setting up the Network groups form, see Network groups (Form).
Form templates
Select a background to be displayed behind questions during an answer session. If you do not specify a form template, the questions are displayed against a blank background. Templates support many popular graphic file formats, with the exception of .gif. Check with your system administrator to ensure that the file format you want is supported by your system. 

For complete guidelines for setting up the Form templates form, see Form templates (Form).

Answer groups

Create groupings of possible response options to closed questions. After you create the group, create response options (answers) for the group, and then assign the answer group to a question. When a respondent answers the question during an answer session, he or she can choose from the response options you created in the answer group. In this respect, answer groups are in fact mandatory for using closed questions on a questionnaire. 

For complete guidelines for setting up the Answer groups form, see Answer groups (Form).

Main setup forms of Questionnaire II

This topic describes the setup forms that you must set up in order to work with the features enabled by the Questionnaire II license code.

1. Planning types

Define different types of questionnaires in order to divide questionnaires into categories. When you create a scheduling, you must select one of these categories.
For complete guidelines for setting up the Planning types form, see Planning types (Form).

2. Planned answer sessions
Create answer sessions for individual employees, applicants, or contact persons. When you do so, you can specify the questionnaire that you want to use and the respondent who is to participate in the answer session. If you plan a questionnaire in which the respondent is asked to evaluate a colleague, you can also specify who the questionnaire is to evaluate and their role relative to the respondent. 

For complete guidelines for setting up the Scheduling form, see About planned answer sessions.

3. Scheduling
Schedule planned answer sessions for multiple users at the same time. You can specify information such as the respondents that are to complete the questionnaire, the questionnaire to distribute, the person responsible for the scheduling, the type of questionnaire to plan. Additionally, if you want to make the questionnaire available on the Internet, specify whether to use a private or public website.
For complete guidelines for setting up the Scheduling form, see Questionnaire scheduling (Form).

Optional setup forms for Questionnaire II
Enabling the Questionnaire II license code gives access to the features used to plan answer sessions for specific respondents, and the module’s statistics tools. To plan answer sessions for specific respondents requires that you complete the mandatory setup forms listed in the topic titled Mandatory Setup Forms Enabled by the Questionnaire II License Code. There are no optional set up forms enabled by the Questionnaire II license code.

Flowchart: Configuring the Project module

There are no prerequisites for setting up the Project module in Microsoft Dynamics AX. However, before beginning, make sure that the appropriate configuration keys are enabled. Check that configuration keys for other modules that integrate with the Project module are selected as well.

Modules that integrate with Project:
· General ledger 

· CRM 

· Accounts receivable 

· Accounts payable 

· Inventory management 

· Service 
Flowchart

See Project module flowchart for print version.

The main setup forms of Project

The forms that a company must set up to be able to use the basic functionality of the Project module are listed below in the recommended order of setup.

1. Parameters

Set up project parameters depending on the types of projects to be created. Specify default information, set up number sequences, and functionality to be used across the module.

For complete guidelines for setting up the Parameters form, see Project parameters (Form).

2. Project groups

Project groups are mandatory when setting up projects since every project must be assigned to a project group. Typically, a project group is created for a specific project type. Enter specifications for posting in the general ledger accounts when creating a project group. There is no limit to the number of project groups that can be created.

For complete guidelines for setting up the Project groups form, see Project groups (Form).

3. Categories

Create categories to identify different types of costs and revenues in a project. Setting up categories is mandatory in the system since all project transactions require a category. There is no limit to the number of categories that can be set up.

For complete guidelines for setting up the Categories form, see Categories (Form).

4. Category groups
Create a category group for an indefinite number of categories. Typically, a category group is created for each transaction type, and each category must be attached to a category group. Setting up ledger accounts at the category group level is optional. Use category groups to help simplify the process of specifying the transaction type and posting specifications.

For complete guidelines for setting up the Category groups form, see Category group (Form).

5. Prices
Although cost and sales prices are typically specified at the employee or item level, they can also be specified at the project level. Set up standard cost prices for hour and expense transactions, and set up sales prices for hour, expense, fee, and subscriptions. Enter cost and sales prices individually by employee, project, category, valid transaction date or any combination of these. This task is optional since prices can be entered at the time of transaction entry.

For complete guidelines for setting up the  Category groups form, see Category group (Form).
6. Cost template
Create a cost template to determine estimate information for fixed-price projects.

For complete guidelines for setting up the Cost template form, see Control types (Form).
7. Line property
Create line properties to specify whether to invoice a transaction, accrue sales value at posting for Time and Material projects and apply additional cost and sales percentage.

For complete guidelines for setting up the Line property form, see Line property (Form).

8. Line property setup
Then specify where the line properties should be applied: All projects or categories, a specific project or category group or table. The setup is designed by Table / Group / All relations, and the search direction is from the most specific to the least specific criterion. This is why it is recommended that an All / All relation with a line property of Charge/ Chargeable be created.
For complete guidelines for setting up the Line property setup form, see Line property setup (Form).
9. Projects
Create projects and sub-projects for the selected company. You can create Time and material, Fixed-price, Investment, Cost project, and Time projectprojects. Time and Material and Fixed-price projects are considered external project types. Specify settings and defaults for each project. 

For complete guidelines for setting up the Projects form, see Projects (Form).

10. Invoice projects
Create invoice projects for Time and material projects and for Fixed-price projects.
For complete guidelines for setting up the Invoice projects form, see Invoice projects (Form).

The optional setup forms of Project

The setup of the Project module includes a number of other steps beyond the basic functionality.

The additional setup forms are organized by functionality and are not required to be completed in a specific orderI.

Projects
All project types can be combined in a project hierarchy, and more subprojects can be added as a project progresses. In the Projects form, specify a format and then go on to create subprojects and parent projects.

For complete guidelines, see Projects (Form).

Ledger posting
Ledger posting accounts can be set up in various places; projects, project groups, categories, and category groups. 
For complete guidelines, see Posting transactions to ledger accounts (Form).

Parameters
Some project procedures are dependent on keeping a clear audit trail and number sequences control this. Use the Number sequences tab on the Project parameters form to set up.
For complete guidelines, see Project parameters (Form).

Journal names
The journal approval procedure is closely linked to the user group rights setup in the Administration module. On the Journal names form, use the Approve field to set up journal approval. You can set the levels of journal approval as deep as you need them to be. For each approval level, you can specify what kind of action should be possible.
For complete guidelines, see Journal names (Form).

Projecs
Project hierarchies such as parent projects and subprojects can be set up to achieve different project structures and initiatives or to handle special accounting situations. Use the format field in the Projects form to define project hierarchies.

For complete guidelines, see Projects (Form).

Project copy wizard
Using the project copy wizard to create new projects or project hierarchies allows you to transfer values already setup in an existing project. 

Open the wizard from the Wizard button on the Projects form.

Flowchart: Configuring the Cost accounting module

The core of Cost accounting is the capability to reallocate costs from one dimension to another dimension. In this module the focus is on the combination of dimension, e.g. cost center, and cost category. 

In this module, you define:

· Parameters, defaults, and number sequences that apply to cost categories, dimensions and cost transactions.

· Cost categories.

· Service categories.

· Dimensions.

· Journal names.

· Journal text.

· Dimension posting control.

· Expense distribution sheet.

· Budget model.

· Accrual schemes.

· Line structures.

· Hierarchies.

· Calculation version.

· Reference Table.

· The following steps are performed per company:

Prerequisites

Set up the Administration, Basic and General ledger modules.

Flowchart

See Cost accounting module flowchart for print version.

The main setup forms of Cost accounting

The forms that a company must set up to be able to use the basic functionality of the Cost accounting module are listed below in the recommended order of setup.

1. Parameters, defaults and number sequences

The purpose of the Parameters is to enter the necessary setup options, to indicate default values, and to define the number sequences for Cost accounting module on the

Note   The General Tab settings cannot be changed after you begin to work in Cost accounting. For example setup of dimensions, it is not possible to deactivate later the dimension already used before. But it is possible to activate additional dimension.

Only selected dimensions can be used in Cost accounting. To use more than one dimension in the Cost accounting module, you need to license the sub module open dimension.

At least one posting level has to be selected. Usually Cost accounting is based on the current posting level. 

The Button Account Reconciliation needs to be executed if the Cost accounting is set up in an existing Microsoft Axapta environment. This button is only selected if the Cost Categories are identical with ledger accounts. Click this button and all ledger accounts with account types Profit & Loss, Revenue, and Cost are created in the Cost Category table.

Ledger accounts, that are created later, are automatically created in Cost Categories so no action has to be taken when the chart of accounts is changed.

For complete guidelines for setting up the Parameters form, see COSParameters Form.

2. Cost categories

The Cost categories are usually equivalent to the chart of accounts in the General Ledger, but you can also set up completely different Cost categories. 

514. Create the cost categories in a structured list on the Cost category form. 
To create cost category you must enter at least cost category number and account type. Later on, you can enter other account details.
Note    There are two different cost types one of which has to be assigned to each Cost Category: Primary costs and Secondary costs. 
515. If you intend to work with Flexible budget, you have to define the fix and variable percentage of costs for each cost category.

For complete guidelines for setting up the Cost category form, see COSLedgerTable Form.

3. Service categories
The Service Categories are used to work with services in Cost accounting and are handled as the third Cost type in the Cost category form. A Service is a quantity expressed in whichever unit that cannot be posted as a cost amount, for example hours, miles, square feet, etc.

516. Create the service categories in a structured list on the Cost category form. 
Note   If you use the modules production and/or project, you need the service categories to import the hours posted in production orders and projects.
517. Choose the cost type Service category.

518. Define parameters for service category on Tab Service category.

519. For specifying cost amount for a certain unit of services we use Cost rate. We can define cost rate on the button Setup Service category.

For complete guidelines for setting up the Cost category form, see COSLedgerTable Form.

4. Dimensions

Dimensions are used to analyze and classify financial transactions. Cost accounting uses the same dimensions as General Ledger to additionally analyze services (Service categories) and to calculate allocations. 

Create dimension values for the dimensions that are available in the company on the Dimensions form.
To create dimension you must choose dimension and enter at least dimension number. Later on, you can enter other dimension details.

For complete guidelines, see COSDimension form.

Note   This form may already have values because the values were created in the Dimensions form when the Basic module was set up. See (COSLedgerDimensions) Form.

5. Journals names

The Basic form is used as a template for all journals created with the names given in this window. It means that all of the journals use the voucher series, offset account, and other information which is set up here.

520. Open the Basic form and enter the name and description of new Journal name.

521. On Overview Tab choose the Journal type – Cost or Service and enter Voucher series. 

522. On General Tab choose the dimension of posting.

523. On the same tab activate the Offset transaction and choose the appropriate offset dimension if needed.

Note   You can create several Journal names of the same type, if you have several users entering transactions at the same time and want to keep them apart. In Cost Accounting you can create transactions without an offset account, which subsequently can lead to differences between Cost accounting and General Ledger. However, for cost accountants it is quite common to do one-sided postings, so this is a desired functionality

For complete guidelines, see COSJournalName Form.

The optional setup forms of Cost accounting

The setup of the Cost accounting module includes a number of other steps beyond the basic functionality.

The additional setup forms are organized by functionality.
Line structure

The COSLinestructure form gives the possibility to create groups of Cost categories and Service categories similar to the ledger account groups.

524. Create Line structure on the Line structures form.
525. Switch to the Line definition, click the Button: Cost Lines.

526. Create a new Cost line on the Cost lines form.

527. In order to assign the cost/service categories without setting a filter click on the Button Load cost categories /Load service categories.

The tabs Cost and Service categories display all categories that are not assigned to a Cost line yet.

In order to assign the cost/service category execute double click on the respective category.

For complete guidelines, see COSLineStructure Form.

Note   It is possible to create an unlimited number of cost lines, but each Cost or Service category can only be used once per line structure.

Hierarchies

The Hierarchies gives the possibility to create groups of dimensions called divisions. You can build hierarchy trees with groups and subgroups.

528. Create Hierarchies on the Hierarchiesform.
529. Choose the dimension you like to use in this structure.

530. Switch to the Division definition, click the Button: Divisions.

531. Create a new Division on the Divisions form.

532. Switch to the Hierarchy definition, click the Button: Process structure.

533. Create a new Structure on the Structure form.

With the function Process structure it is possible to create the tree from divisions and dimensions. The tabs Dimension and Division display all dimensions and divisions that were not used in the Hierarchy structure yet.

In order to build up the structure double click on the respective divisions and dimensions.

For complete guidelines, see COSHierarchy Form.

Budget model

A @SYS5705 has to be defined in order to be able to create budgets in Cost accounting. The budget model contains a control to decide, what the purpose of the budget model is.

534. Create Budget model on the @SYS5705 form.
Note   There are three different types of budget models: 
•
Cost accounting budget
•
Ledger budget
•
Flexible budget

535. On the Overview Tab, create a new budget model by the Budget model ID, Description and Budget model type.
536. On the General Tab select Ledger budget model (for Ledger budget model type) or Line structure (for Flexible budget model type).

537. Go to the Tab Sub-model to set up sub- models for the current budget model if necessary. 

For complete guidelines, see COSPlanModel Form.

Reference table

The purpose of Reference tables is the determination of fixed debiting amounts which are then used for the calculation of distributions and allocations.

The setup of Reference tables is done in two different forms: 

· Reference tables form, which is the initial one.

· Calculation versions form, using the Button Reference table.

538. Create Reference Table on the Reference tables form.

539. On the Overview Tab, create a new reference table by entering a reference table ID and Description.

540. On the General Tab, set up the Unit and activate required types of dimensions.

541. Go into menu Calculation versions and click on the Button Reference table.

542. On the Overview Tab, click on the newly created Reference table and go to the Tab General.

543. On the General Tab, choose the type of dimension, enter the total Reference quantity and create one line for each debiting dimension with appropriate partial Reference quantity.

For complete guidelines, see COSReference Form.

Calculation versions

A Calculation versions summarize all distributions, allocations and cost rate calculations that are valid for a certain period. 

Before it is possible to define distributions and allocations it is necessary to create and set up a Calculation version.

544. Create Calculation versions on Calculation versions form.
545. On the Overview Tab, create a new line and enter the ID and Description of new Calculation version.

546. Activate the check box Target, if this Calculation version is default for a certain period. 

547. On the General Tab, select a Budget model, if this Calculation version will be used for plan values.

548. On the Calculation Tab, check the dimensions that you intend to calculate with this Calculation version. 

549. On the same tab, check Value types that need to be calculated.

For complete guidelines, see COSVersion Form.

Reference table

The setup of Reference Table is described in: The optional setup forms of the Cost accounting module; Reference Table.

Cost distribution

The functionality of Cost distribution is used to distribute costs that are posted with or without dimension, to other dimensions, but on the same cost category. 

550. Create a new Cost distribution line on the Calculation versions; Button Cost distribution.
551. On Overview Tab select the distribution level.

552. On the General Tab select the Cost share, Offset transaction dimensions and Offset transaction calculations.

553. On the Dimension Tab enter the dimensions.

For complete guidelines, see COSCostDistribution Form.

Service distribution

The functionality of Service distribution is used to distribute services (quantities) that are posted with or without dimension, to other dimensions, but on the same service category

554. Create a new service distribution line on the Calculation versions; Button service distribution.
555. On Overview Tab select the distribution level.

556. On the General Tab select the Cost share, Offset transaction dimensions and Offset transaction calculations.

557. On the Dimension Tab enter the dimensions.

For complete guidelines, see COSWorkDistribution Form.

Allocation

With the allocation functionality you allocate the costs from one dimension to another, and to another cost category called secondary. Amounts without any dimensions are not allocated and have to be distributed on specific dimension.

There are used three different types of allocation in the Cost accounting:

Internal cost allocation

For complete guidelines, see COSAllocation Form.b_Type: AlType: Allocation

558. Create new Allocation line on Calculation versions; Button Allocation.
559. On Overview Tab choose the appropriate Calculation version and click on the Button Allocation and create Allocation line with the allocation type Allocation
560. On Overview Tab select the allocation level.

561. On the General Tab select the allocation account and offset account.

562. On the Allocation Tab select the Cost shares, Value calculation, Offset transaction dimension, Offset transaction calculation.

563. On the Dimension Tab enter the dimensions.

Type: Internal cost allocation

564. Create new Allocation line on Calculation versions; Button Allocation.
565. On Overview Tab choose the appropriate Calculation version and click on the Button Allocation and create Allocation line with the allocation type Internal cost allocation.

566. On Overview Tab select the allocation level.

567. On General Tab select the allocation account and offset account.

568. On Internal cost allocation Tab select the Cost shares, service category and cost rate type.

Type: Surcharge allocation

569. Create new Allocation line on Calculation versions; Button Allocation.
570. On Overview Tab choose the appropriate Calculation version and click on the Button Allocation and create Allocation line with the allocation type Surcharge calculationOverview Tab selects the allocation level.

571. On General Tab select the allocation account and offset account.

572. On Surcharge calculation Tab select the Cost shares, Value calculation and Offset transaction dimension.

573. On Dimension Tab enter dimensions.

Cost rate

Cost rate calculations are used to calculate periodic cost rates.

574. Create new Cost rate line on Calculation versions; Button cost rate.
575. On Overview Tab choose the appropriate Calculation version and click on the Button Cost rate and create Cost rate line.

576. On Overview Tab select the service category, cost rate type, calculation from value and calculation from service.

577. On General Tab define Calculation bases.

For complete guidelines, see COSRateCalcDefinition Form.

Dimension posting control

The purpose of the function Dimension posting control is to control how the posting lines are managed in Cost accounting. It is used if you use the cost category for example for cost center and purpose, but you do not always need to post the transaction on both these dimensions. 

It is possible to set up Dimension Posting Control per Cost category; however in the majority of all cases the set up on a general level should be sufficient.

578. Create Dimension posting control on the Cost accountingform.
579. On Overview Tab add new dimension posting control line.

580. On the right side column define the rule for new added line.

581. The column Cost category dimensions verifies the cost category settings.

582. The column Dimensions used verifies actual posting entries, which means dimension entries in journals.

583. The column Execute transaction defines whether the transaction is posted   e.g. on Cost center or Purpose.

For complete guidelines, see COSLedgerAllocDim Form. 
Accrual schemes

The Accrual schemes are used for linear or assessed accruals of costs in General Ledger, which are accounted once a year, but have to be allocated in several periods in the Cost Accounting.

The functionality of Accruals works the same as in the General Ledger and it is necessary first to make a setup in Accrual schemes form.

584. Create a new Accrual scheme line on the Accrual schemes form.
585. On Overview Tab add new line define accruals identification and description.

586. On General Tab define Cost posting, Duration and Posting.

For complete guidelines, see (COSAccrualTable) Form.

Expense distribution sheet

All reports in the group Expense distribution sheet have to first create by a user. It is basically a similar functionality as the Financial Statement function in General Ledger.

All other Cost accounting reports are ready to use as they are provided by the application.

587. Create a new Expense distribution sheet on the Expense distribution sheet form.
588. On Overview Tab create new line and enter ID and name; select the line structure and report type – Dimension Statement or Cost Statement.

589. Execute the Report Lines Button and use the Transfer lines Button to import the cost line.

590. On the General Tab you can define column Display format and after finishing the design of the lines close this form.

591. Click the Report Column Button to create the rows.

For complete guidelines, see COSReport Form.

Journal texts

Journal texts allow you to enter and re-use transaction texts when entering it in journals. The usage is the same as in General Ledger.

1. Create a new Journal texts on the [EMenuITem: Display, COSJournalTxt] form.

2. On Overview Tab create a new line. Define identification, search name and transaction text. Journal texts allow you to enter and re-use transaction texts when entering it in journals. The usage is the same as in General Ledger.

For complete guidelines, see COSJournalTxt Form. 
Flowchart: Configuring Fixed assets

Fixed assets are items of value owned by an individual or corporation; these items include buildings, vehicles, land, and equipment. Fixed assets can be converted to cash. 

In the Fixed assets module, you can set up and enter acquisition information for asset records, and then manage your assets by depreciating them, calculating adjustments, and also disposing of them.

When you use General ledger with Fixed assets, you can view the current value of all assets. Some features of Fixed assets are country/region-specific. You can use Fixed assets with Accounts receivable, Accounts payable, and Inventory management.

Prerequisites

· Set up the Administration module.

· In the Basic module, create and modify number sequences in the Number sequences form. These handle automatic allocation of voucher numbers, invoice numbers, and journal numbers.

· Set up the General ledger module.

Optional

If you want to use Fixed assets with Inventory management, Accounts receivable, or Accounts payable, you must set up those modules. For more information, see Set up Inventory management module, Set up Accounts receivable module, and Set up Accounts payable module.

For specific details about the relationship between modules, see Fixed asset integration.

Flowchart
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See Fixed assets flowchart for print version.

The main setup forms of Fixed assets

The forms that a company must set up to use the basic functionality of the Fixed assets module are listed in the recommended order that you should set them up.

592. Create and manage templates for journals in the Journal names form. Each journal name contains a voucher series, offset account, and other information that is reflected in the journals that are created from those templates.
For complete guidelines, see Journal names setup (Form).

593. Set up depreciation book journal names in the Depreciation book journal names form. This form is available only if the Fixed asset depreciation books configuration key is selected.

For complete guidelines, see Depreciation book journal name (form).

594. Create and modify depreciation profiles in the Depreciation profiles form. These contain the calculations that the value of depreciable fixed assets is reduced by over time.

For complete guidelines, see Depreciation profiles (Form).

595. Create calendars to use for depreciating fixed assets in the Fixed asset calendars form.

For complete guidelines, see Fixed asset calendars (form).

596. Create value models and attach them to fixed assets in the Value models form. Value models change the financial value of a fixed asset over time for various purposes, such as accounting depreciation, tax depreciation, revaluation, and disposal.

For complete guidelines, see Fixed asset value models (Form).

597. Create depreciation books in the Depreciation books form. Each depreciation book must have an ID that is unique from all value model IDs and depreciation book IDs. This form is available only if the Fixed asset depreciation books configuration key is selected.

For complete guidelines, see Depreciation books (Form).

598. Set up the asset group that defines asset characteristics in the Fixed asset groups form. These are groups such as type, number sequence, default value models, and default depreciation books.

For complete guidelines, see Fixed asset groups (Form).

599. Create a posting profile in the Posting profiles form. This includes the ledger accounts that fixed assets transactions are posted to.

For complete guidelines, see Fixed asset posting profiles (Form).

600. Set up fixed asset parameters in the Parameters form. These include various types of functionality, default information to be used, and number sequences.

For complete guidelines, see General ledger parameters (Form).

The optional setup forms of Fixed assets

The setup of the Fixed assets module includes a number of other steps beyond the basic functionality.

The additional setup forms are organized by functionality and are not required to be completed in a specific order.
Journals

· Create transaction text in the Transaction text form to use for automatic postings to the General ledger.

For complete guidelines, see Transaction texts (Form).

· Set up inventory journal names in the Journal names, Inventory form to transfer inventory to fixed assets.

For complete guidelines, see Journal names, Inventory (Form).

· Create, manage, and view the company’s general ledger accounts in a structured list in the Chart of accounts form. The general ledger accounts contain the financial data about the company's activities.

For complete guidelines, see Chart of accounts (Form).

Depreciation

Set up bonus depreciation in the Bonus depreciation form. This is used to calculate bonus depreciation amounts through the bonus depreciation proposal process. This form is available only if the Fixed asset depreciation books configuration key is selected.

For complete guidelines, see Bonus depreciation (form).

Consumption

· Set up units in the Consumption units form to use for unit prices and proposals for fixed assets. Examples of units include km, kg, and hour.

For complete guidelines, see Consumption units (Form).

· Set up the consumption factors that you can select for value models in the Consumption factors form.

For complete guidelines, see Consumption factors (Form).

Other

· Set up the revaluation groups in the Revaluation groups form. These are used in the fixed asset journal for revaluation proposals and for individual value adjustments of revaluation transactions. This form is available only if the Spain configuration key is selected. 

For complete guidelines, see Revaluation groups (Form).

· Create identifiers for the locations of your fixed assets in the Locations form.

For complete guidelines, see Fixed asset location (Form).

· Create sorting options in the Sorting form. These options are then available from the Fixed assets form.

For complete guidelines, see Fixed asset sorting (Form).

· Create the rows of the fixed asset statement and define the row type for each row that you create in the Fixed asset statement rows form.

For complete guidelines, see Fixed asset statement rows (Form).

· Set up controls for ownership period in the Provision types form. The provision type is used to determine whether a provision for reserves should be generated during the disposal process for any profit amount. Then it is used to determine the maximum length of time that can pass before the provision reserve is transferred to a new asset or the profit must be recognized.

For complete guidelines, see Provision types (Form).

Flowchart: Configuring Balanced scorecard

A scorecard is a tool you can use to translate your company's visions and strategies into a set of performance measurements.

Prerequisites

· Set up the Administration and Basic modules.

Flowchart

See Balanced scorecard flowchart for print version.

The main setup forms of Balanced scorecard

The forms that a company must set up to be able to use the basic functionality of the Balanced scorecard module are listed below in the recommended order of setup.

601. Create Perspectives in the Perspectives form.
The Perspectives are used for grouping the objectives with a similar strategy viewpoint. Perspectives represent the key aspects of the strategy in a scorecard, and are in theory the highest level of a balanced scorecard.
For complete guidelines for setting up the Perspectives form, see Perspectives (Form).
602. Specify default appearance information for graphical indicators, in the Parameters Form.

Select number sequences for measurement journals and vouchers, and specify default colors and watermark percentage for perspectives and objectives displayed in the scorecard overview.
For complete guidelines for setting up the Perspectives form, see Balanced Scorecard Parameters (Form).
603. Design and manage the appearance of graphical indicators, in the Graphical indicator form.

The graphical indicators are used to display the results of a query or statistics related to measurements.

For complete guidelines for setting up the Graphical indicator form, see Graphical indicator (Form).
604. Create period intervals, in the Periods Form.
Periods are assigned to objectives to define the posting frequency and the time interval to be measured.
For complete guidelines for setting up the Periods form, see Objective periods (Form).
605. Create names that can be assigned to measurement journals, in the Measurement journal names form.
Measurement journal names also control whether an approval procedure is enabled for the related journals.
For complete guidelines for setting up the Measurement journal names form, see Measurement journal names (Form).
606. Assemble the components of a balanced scorecard by defining your scorecard’s base data, in the Scorecard form.
The base data consists of a unique identifier, a description, and the subject whose performance you want to measure. The subject can be an individual employee, an organization unit or team, or the organization as a whole.
For complete guidelines for setting up the Scorecard form, see Scorecard (Form).

607. Define the achievements needed to realize the strategy for each perspective in a scorecard, in the Objectives form.
You can specify the importance, of each objective, in relation to other objectives in the scorecard. You also specify which perspectives the objective contributes to, the update frequency, the measurements used for measuring progress, and target values.
For complete guidelines for setting up the Objectives form, see Objectives (Form).

608. Set up the measurement matrices, in the Measurements form.
The measurement matrices measure and monitor the progress toward a strategic objective. For each measurement you define a target value, a calculation method and posting frequency, and the graphical indicator that you want to use to display results.
For complete guidelines for setting up the Measurements form, see Measurements (Form).

The optional setup forms of Balanced scorecard

The setup of the Balanced scorecard module includes a number of other steps beyond the basic functionality.

The additional setup forms are organized by functionality.
· Create cockpit users groups, in the Cockpit groups form.
Specify the users that you want to make able to access and view particular cockpits.
For complete guidelines for setting up the Cockpit groups form, see Cockpit groups (Form).
· Set up access rights to graphics, that display the performance information, in the Cockpits form.

For complete guidelines for setting up the Cockpits form, see Cockpits (Form).

· Set up a connection to an external database, in the Data Links form.
Data links are used by measurement elements to automatically post values to measurements.
For complete guidelines for setting up the Data Links form, see Data Links (Form).

Flowchart: Configuring Service subscription

With Service subscriptions you can create, maintain, and invoice subscription fees.

Prerequisites

Before you start setting up Service subscriptions, you need to set up:

· Administration 

· Basic 

· Create period transactions in the Period transactions form. The period setup is required in order to create subscription fees and to set the invoicing intervals for service subscriptions.

· Project I in Project.

· Set up a category to be applied for subscription fees.

The subscription fee category is created in the Categories form. You must select the Subscription check box to indicate that the category is a subscription category.

Optional

· If you want to accrue subscription revenue, you must set up Project II in Project. In the Ledger posting form, set up:

· Accrued revenue - Subscription
· WIP - Subscription
· You can set up number sequences in the Number sequences form, but you need not set up the number sequences to work with Service subscriptions. For guidelines, see Number sequences (Form).
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See Service subscription flowchart for print version.

The main setup forms of Service subscription

The forms that a company must set up to be able to use the basic functionality of Service subscriptions are listed in the recommended order that you should set them up.

609. Set up service subscriptions in the Service subscriptions form. 
For guidelines, see Subscription (Form).

610. Set up service subscription groups in the Subscription groups form.

For guidelines, see Subscription groups (Form).

The optional setup forms of Service subscription

The setup of Service subscriptions includes other steps beyond the basic functionality.

Subscription sales prices

You can set up sales prices for subscription fees in the Sales price - Subscription form. If you do not create a price setup, you can only apply an indexed base price and you need to manually enter the base price when you create a subscription.

For guidelines, see Create subscription fee (Class Form).

Flowchart: Configuring Service management

With the Service module, you can record logistical and financial information to manage service engagements.

Prerequisites

Before you start setting up Service, you need to set up:

· Administration 

· Basic 

· Create number sequences in the Number sequences form.

· Project I in Project.

Optional

· You can create period transactions in the Period transactions form. The period setup is used to create subscription fees and to set the invoicing intervals for service subscriptions.

The calendar is an optional feature in Service. You can use the calendar to be notified when automatically generated service orders are created in periods that are not open. To use the calendar in Service, create period transactions in the Period transactions form.

· If you want to base service agreements on fixed-price projects, you must set up Project II in Project.
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See Service management flowchart for print version.

The setup forms of Service management

The mandatory and optional forms that a company sets up to enable use of the basic functionality of the Service module are listed in the recommended order that you set them up.

1. Service agreements

611. Set up service agreements in the Service agreements form.
For guidelines, see Service agreements (Form).

612. Set up service agreement groups in the Service agreement groups form.

For guidelines, see Service agreement groups (Form).

613. Optionally, you can set up service intervals and a time window.

The service interval on a service agreement defines the amount of time between service orders based on the current service agreement.

a. Set up service intervals in the Service intervals form. For guidelines, see Service intervals (Form).

b. Set up time windows in the Time window form. The time window is relevant only if you have set up service intervals. For guidelines, see Time window (Form).

614. Optionally, you can also set up service template groups in the Service template groups form.

Service template groups categorize service templates and can be used for sorting and filtering when you copy templates to service orders or service agreements. For guidelines, see Service template groups (Form).

2. Service agreement and service order relations

615. Optionally, you can create service objects and service tasks.
c. Set up service objects in the Service objects form. 
For guidelines, see Service objects (Form).

d. Set up service tasks in the Service tasks form. 

For guidelines, see Service tasks (Form).

Attach these to service agreements and service orders. 

616. If you want to create service objects, you must create service object groups in the Service object groups form.

For guidelines, see Service object groups (Form).

617. Optionally, you can create template BOMs in the Template BOMs form.

A template BOM provides information on the default spare-part structure of a construction at a customer site. Using template BOMs is optional, and because template BOMs are closely related to the use of service objects, they are relevant only if you use service objects. 

For guidelines, see Template BOMs (Form).

3. Service orders

618. Set up service orders in the Service orders form. 
For guidelines, see Service orders (Form).

619. Set up service stages in the Service stages form. 

For guidelines, see Service stages (Form).

620. Optionally, you can set up stage reason codes in the Stage reason codes form. Stage reason codes describe why a service order is updated to a new stage. 

For guidelines, see Stage reason codes (Form).

4. Repair

With repair management you register and structure information on customer problems and the corresponding solutions. The repair management functionality is optional.

· Set up conditions in the Conditions form. For guidelines, see Condition (Form).

· Set up symptom areas in the Symptom areas form. For guidelines, see Symptom (Form).

· Set up symptom codes in the Symptom codes form. For guidelines, see Symptom code (Form).

· Set up diagnosis areas in the Diagnosis areas form. For guidelines, see Diagnosis area (Form).

· Set up diagnosis codes in the Diagnosis codes form. For guidelines, see Diagnosis code (Form).

· Set up resolutions in the Resolutions form. For guidelines, see Resolution (Form).

· Set up repair stages in the Repair stages form. For guidelines, see Work status (Form).

5. Parameters

In the Service parameters form, consider the following fields:

· To post journals, you must set up journals for the four transaction types on the Journals tab.

· Optionally, you can select a default service agreement group in the Service agreement group field. The default service agreement group is suggested when you create a new service agreement.

· Optionally, you can select a calendar in the Calendar field. 

For guidelines, see Service parameters (form).

Run the checklist items without user interaction

Microsoft Dynamics AX can be started and all items in the installation checklist executed with no user interaction. This is done by starting Microsoft Dynamics AX from the command line with an XML file as input parameter. The XML file specifies the items on the checklist to be executed. The result of executing the checklist items is written to a log file or shown to the user in the InfoLog.

Executing with no user interaction is useful for any automation of customer tasks, in particular during the test phase.

Run the installation checklist

621. On the Microsoft Dynamics AX client, create a file of type XML.
622. Add tags to XML file specifying:

· Microsoft Dynamics AX version.

· Name and location of the log file. 

· Each checklist item to be executed along with the appropriate attributes.

Note   The XML file syntax is described in the documentation for the SysAutoRun class; please refer to the developer documentation. See small, sample file below.

623. Open a command line window and type 

ax32.exe –StartupCmd=AutoRun_c:\Ax\Configuration.XML
where "configuration.xml" is the name of the input XML file and "c:\ax\" is the location of the file.
Note   The XML code allows you to skip steps that are marked as mandatory when running the checklist from Microsoft Dynamics AX. However, the checklist is used to enforce a specific execution order.

Sample XML input file

<AxaptaAutoRun exitWhenDone=”false” version="4.0" logFile="D:\AX\AXAutorun.log">

  <CompileApplication crossReference="false" /> 

  <LicenseInformation file="d:\ax\license.txt" /> 

+ <Configuration>

+ <AdjustGlobalTypes>

  <Synchronize /> 

+ <UserGroups>

  <PasswordParameters /> 

+ <Users>

+ <CompanyAccounts>

  <XpoImport file="d:\ax\setup\XPO\Logger\Enum_TestLogEntryType.xpo" /> 

  <DataImport companyId="BVT" file="d:\ax\basedata.dat" /> 

  <Run type="class" name="RunMyTests" method="main" /> 

  <PreventCheckList /> 

</AxaptaAutoRun>

Set up application security

Microsoft Dynamics AX allows you to add, remove and modify functionality by adjusting the relationships of the licensing, configuration and security subsystems. For information about how these subsystems are related, see Microsoft Dynamics AX configuration hierarchy.

· Licensing – The licensing system allows a customer to unlock purchased sets of functionality for use within an installation. For more information, see Add license keys.

· Configuration Keys – The Configuration Key system allows an administrator to set the availability of functionality for the entire system. These modifications are to subsets of a module's functionality that are not currently necessary to have enabled within the system. From a security perspective, the removal of unused functionality reduces the surface that is open to attack. For more information, see Enable and disable configuration keys.

· Security system – The security system allows an administrator to control access to system elements (such as windows, menu items, and tables). These settings are set by user group and domain combinations.

Set up the security system

624. Create users - See User configuration and security.
625. Create user groups - See User group configuration and security.

626. Create company accounts - See Company accounts and security.

627. Create domains - See Domains and security.

628. Set security keys for user group/domain combinations - See Security keys.

629. Set table and field access - See Table and field access.

630. Set record level security - See Manage record level security.

Flowchart: Security setup in the application

The figure below shows the process flow to set up security in your system.
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Microsoft Dynamics AX allows you to add, remove and modify functionality by adjusting the relationships of the licensing, configuration and security subsystems.

Microsoft Dynamics AX configuration hierarchy

The figure below shows the configuration hierarchy for security in your system.
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Microsoft Dynamics AX allows you to add, remove and modify functionality by adjusting the relationships of the licensing, configuration and security subsystems.

User configuration and security

To add an additional layer of security to your computing environment, Microsoft Dynamics AX requires that all users be listed in Active Directory directory service on your domain controller before they can be enabled on the Microsoft Dynamics AX Users form. If a user is not enabled on this form, that user cannot access Microsoft Dynamics AX.

For more information, see Active Directory user topology.

This section includes the following:

Import users from Active Directory
Create new users
Set up Web users
Monitor users
Set user defaults
Remove users
Import users from Active Directory

To add an additional layer of security to your computing environment, Microsoft Dynamics AX requires that all users be listed in Active Directory directory services on your domain controller before they can be enabled on the Microsoft Dynamics AX User form. If a user is not enabled on this form, they cannot access Microsoft Dynamics AX.

Active Directory for Microsoft Windows catalogs information about all the objects on a network, including people, computers, and printers, and distributes that information throughout your network. Security is integrated with Active Directory through logon authentication and access control. Active Directory is a feature of Microsoft Windows Server 2003 and Microsoft Windows Server 2000. For more information, see Windows Server 2003 Active Directory or Windows Server 2000 Active Directory. For more details about implementing Active Directory with Microsoft Dynamics AX, see Active Directory user topology in the Microsoft Dynamics AX Implementation Guide.

Note   Existing Active Directory structures do not require modifications to be used to support Microsoft Dynamics AX users within the domain. If your customer has a site with Active Directory domains, and all the domains in the forest are set up with two-way trust, the application will recognize all the users in the domain once they have been imported.

Once a user is listed in Active Directory, you can add that user to Microsoft Dynamics AX manually (see Create new users) or you can import multiple Active Directory users into Microsoft Dynamics AX using the following procedure.

To import users from Active Directory

631. From a Microsoft Dynamics AX client, click Administration > Users.
632. On the Overview tab, click Import to access the Active Directory Import Wizard.

633. Complete the wizard.

Create new users

Microsoft Dynamics AX users are employees of your organization or company (or a partner) who require access to Microsoft Dynamics AX as part of their job. Your organization or company could have many hundreds of employees, but there might only be a few individuals who need to work with Microsoft Dynamics AX as part of their job. Any individual who needs to access Microsoft Dynamics AX must be added to the list of Microsoft Dynamics AX users on the Users form, as described in this topic. A user must also exist in at least one user group before they can access Microsoft Dynamics AX. For more information, see Manage user groups
Important   Before you can add an individual to the list of Microsoft Dynamics AX users, that individual must be listed in Active Directory directory services on your domain controller. For more information, see Active Directory directory service user topology in the Microsoft Dynamics AX Implementation Guide.

Microsoft Dynamics AX includes the option to create external users or remote Web users. An external user is any individual who accesses Microsoft Dynamics AX using Enterprise Portal or a Web browser. To learn more about external users, see Granting users access to Enterprise Portal.

Note   If you need to create multiple new users and those users already exist in Active Directory, use the Active Directory Import Wizard to import those users into Microsoft Dynamics AX. For more information, see Import users from Active Directory.

To create a new user

634. From a Microsoft Dynamics AX client, click (Administration > Users).
635. Press CTRL + N to create a new user.

Important   If you are creating new users in Microsoft Dynamics AX while working through the Installation Checklist, make certain you have entered license information before adding users. If you add a user before entering license information, the user might have elevated permissions (Administrator permissions) in the application.

636. In the Alias text box, enter the user's alias as it is stored in Active Directory (required if the user will be enabled and allowed to access Microsoft Dynamics AX through a Microsoft Dynamics AX client).
637. In the Network domain field, enter the user's Active Directory domain (required if the user will be enabled and allowed to access the application through a Microsoft Dynamics AX client).

638. In the User ID field, enter any unique identification for this individual (required). The user ID is restricted to a maximum of five characters.

639. In the User name field, enter the user's name (optional).

640. From the Company drop-down list, select the company this user can access in Microsoft Dynamics AX. If you do not select a company, Microsoft Dynamics AX uses the current company that the administrator is logged into.

641. To allow this user to access Microsoft Dynamics AX, select Enabled. The application checks to ensure the user is listed in Active Directory. If the user is not listed, the application returns an error.

Note   The External option is read only. An external user is any individual who accesses Microsoft Dynamics AX using Enterprise Portal or a Web browser. This option is automatically set if the user is stored in Active Directory as described in Granting users access to Enterprise Portal.

642. Press CTRL + S to save changes.
Note   The user cannot access Microsoft Dynamics AX until added to at least one user group. To add the user to a group, click the Groups tab. To create a new group, see Manage user groups.

If you have set up multiple companies in Microsoft Dynamics AX to reflect the structure of your organization or business, you must grant users access to these companies. 

Granting users access to Enterprise Portal

This topic describes how to set up external Web users and enable access for those users on an Enterprise Portal site. 

Note   For information about how to enable guest-user access to the Enterprise Portal customer site, see Set up the guest account for anonymous Web access.

Set up user groups for Enterprise Portal

In Microsoft Dynamics AX, permissions and user rights are granted to user groups. Microsoft Dynamics AX ships with predefined user groups that control users’ access level to the Enterprise Portal. 

These predefined user groups are set up by default when you run the Enterprise Portal Configuration Wizard.

Note   If you are running on Windows SharePoint Services (version 2), (SP2), you must specify user groups. User groups are optional if you are running on Windows SharePoint Services (version 3), Beta 2 or Microsoft Office SharePoint Server 2007, Beta 2.

643. From the Navigation Pane, click Administration > Setup> Internet> Enterprise Portal> Configuration wizard.
644. Click Next to start the wizard.

Note   You can customize the permissions for these default Enterprise Portal user groups by using the User groups form. For more information, see Manage user groups.

Create external users for Web access

Microsoft Dynamics AX users can be internal, such as employees, or external, such as vendors or customers. An external Web user is any individual who accesses Microsoft Dynamics AX only by using Enterprise Portal or a Web browser.

This topic includes information for creating external users. For more information about creating internal users, see Create new users.

Verify prerequisites

Ensure that external users are defined in Active Directory. For more information, see Plan Active Directory user topology.

Set up your Internet-facing topology for external users

645. From the Navigation Pane, click Administration > Setup> Internet> External Web users.
646. Select the type of Internet-facing topology that you are using and fill in the required information.

For more information, see Plan Active Directory user topology.

Add external users to the list of users

647. From a Microsoft Dynamics AX client, click Administration > Users.
648. On the Overview tab, create individual new users or click Import to access the Active Directory Import Wizard. 

For more information, see Create new users or Import users from Active Directory.

Assign user groups based on Enterprise Portal roles

649. From a Microsoft Dynamics AX client, click Administration > Users. 
650. On the Overview tab, select a user. 

651. On the Groups tab, select all of the user groups in the Remaining groups list box that correspond to the user's Enterprise Portal roles.

For more information about how to determine which user groups correspond to the user's Enterprise Portal roles, see About Enterprise Portal roles and user groups.

652. Click the left arrow button (<) to move the selected groups into the Selected groups list box. All users moved into the Selected users list box are assigned to the current user.

653. Close the form to save changes.

Enable Web access for each Web user

To enable Web access for a Web user, you must set the user type and associate the user with the appropriate Web sites. For each Web site, you must also assign the user to the appropriate site group. 

Enterprise Portal for Microsoft Dynamics AX uses Microsoft Windows SharePoint Services site groups to manage security across the Enterprise Portal site. Each user must be a member of at least one site group in order to view or access the Enterprise Portal site. For more information about how to create site groups, see Microsoft Windows SharePoint Services Help.

Note   Before you can enable Web access for the Web users, the Enterprise Portal sites must be created and deployed, and the SharePoint site groups must be created.

654. From a Microsoft Dynamics AX Client, click Administration > Setup > User relations.
655. On the Overview tab, select the user for whom you want to enable Web access. 

656. On the General tab, select either Internal users or External users as the user type.

If the user is External, select whether the user is a Customer or a Vendor, and then select the appropriate account.

657. On the Web sites tab, select the Web site that you want to associate with the selected user.

658. Associate users with sites. You can either associate users with sites in Microsoft Dynamics AX, or in SharePoint. 

Note   All changes made to the users that are associated with sites in Microsoft Dynamics AX will be visible in SharePoint user management. Changes made in SharePoint user management will not be visible in Microsoft Dynamics AX. For this reason, you should always use SharePoint user management to audit which users have access to a site.

e. To associate users with sites in Microsoft Dynamics AX: 

f. For the selected Web site, click the Site Group arrow and select the appropriate SharePoint site group for that user. 

g. Repeat steps 4 and 5 for each Web site that the user needs to access. 

h. If you want to assign a user to multiple SharePoint site groups, press CTRL+N to create a new line, select the desired Web site, and then select an additional site group for that user.

i. Press CTRL+S to save changes.

Monitor users

Microsoft Dynamics AX includes several features to help you monitor which users are currently logged on to Microsoft Dynamics AX, how often a user has logged on, and how long a user has been logged on. The procedures in this topic show how to:

· View which users are currently logged on. 

· Disconnect one or more connected users.

· View logon statistics for a specified user.

To view which users are currently logged on

From a Microsoft Dynamics AX client, click Administration > Online users.

To disconnect one or more connected users

You can end one or more user sessions from the Online users form. Before you disconnect a user, warn that user of the impending disconnection so you do not disrupt an important operation such as a posting or report generation.

659. From a Microsoft Dynamics AX client, click Administration > Online users.
660. Select the user(s) you want to disconnect. Press and hold the CTRL key on your keyboard to select multiple users.

661. Click End sessions.

Important   If you disconnect a user because you changed permissions for a user group, restart the Microsoft Dynamics AX server after making the change. If you do not restart the server, members of the group might retain their former permissions. Before you restart the server, warn all connected users of the impending restart so you do not disrupt important operations. For more information, see Remove users.

To view logon statistics for a specified user

662. From a Microsoft Dynamics AX client, click Administration > Users.
663. Select the user for whom you want to view logon statistics.

664. Click User log.

· The Overview tab lists each time the user logged on during the last 100 days (by default). You can change this default by clicking the Clean up button and selecting a new duration.

· The General tab includes information about the user's computer ID, client type, and more.

· The Statistics tab includes details about the user's logon quantity.

665. Press CTRL + S to save changes.

Set user defaults

Use the Options form to set a variety of user options in Microsoft Dynamics AX (Administration > Users > User options). For example, you can specify which company account a user accesses when Microsoft Dynamics AX opens, the user-interface language, and how much detail appears in a user's Infolog.

The topics in this section describe a few of the important user options to set. For more information about the User options form, press Shift + F1 to view form Help.

Set a user's default company
Set a user's default language
Set a user's Help language
Remove users

To maintain a secure Microsoft Dynamics AX environment, immediately remove any user listed on the User form (Administration > Users) if that individual no longer requires access to Microsoft Dynamics AX. If you do not remove the user from Microsoft Dynamics AX, the user can access forms, data, and reports through a Microsoft Dynamics AX client on a different workstation or through a custom application, including Web applications like Enterprise Portal.

Important   If you remove a user from the application, terminate that user's active sessions in the Online usersform. For more information on terminating active sessions, see Monitor users. 

To remove a user

666. From a Microsoft Dynamics AX client, click (Administration > Users). 
667. On the Overview tab, select a user you want to remove from Microsoft Dynamics AX.

668. Delete the user by pressing Alt+F9.

669. Press CTRL + S to save changes.

670. Restart the Microsoft Dynamics AX server to ensure the user has been removed from the system.

User group configuration and security

User groups allow the system administrator to define a set of users that share common security privileges. To add this layer of security to your computing environment, Microsoft Dynamics AX requires that all users be listed in Active Directory directory service on your domain controller before they can be enabled on the Users form. If a user is not enabled on this form, they cannot access Microsoft Dynamics AX. For more information, see Active Directory user topology.

In Microsoft Dynamics AX, permissions and user rights are granted to groups. By adding a user to a group, you give the user all the permissions and user rights assigned to that group. Before a user can access the product, that person must be added to the list of product users and they must be added to at least one Microsoft Dynamics AX group.

Defaults

By default, Microsoft Dynamics AX creates an Administrators group and an Administrator User during installation. Administrators have complete access to all product forms, menus, tables, reports, the Application Object Tree (AOT), and all security keys.

Important   Restrict the number of users who are members of the Administrators group, since this group has access to all product fields, tables, reports, and modules by default. If users are made a member of the Administrators group, they can potentially view reports or data they should not be allowed to see, or change configurations and business logic in the system. Ideally, only those individuals who are configuring and administering Microsoft Dynamics AX should be members of the Administrators group.

Security profiles

Microsoft Dynamics AX bases permissions on a Security profile, which is a combination of a user group and a domain. If you do not have a license to use domains, Microsoft Dynamics AX internally uses the Admin domain. Each security profile uses no permissions, with the exception of the complete permissions available to the Administrators group with the Admin domain.

As users can belong to more than one group, and companies can belong to more than one domain, it follows that more than one security profile can apply to the same user. In this case, Microsoft Dynamics AX uses the permission that grants more complete access. For more information about security profiles, see Security keys, and for information on setting permissions, see Set up security keys.

Deciding on the structure of your user groups

The groups you create and the permissions you assign to these groups should reflect the structure of your organization. For example, you may want to create groups, such as Human Resources, Finance, Sales, and Production, and then set the appropriate permissions for these groups. Create user group names that describe the permissions granted for that group, for example, "Finance - Full," "General ledger - Read Only," and "Accounts payable - Edit". In this way, you avoid confusion if you need to create additional groups.

When setting permissions for each group, work with business decision-makers in each department to determine what permissions each group needs and who should be included in each group.

Create user groups

You can add users to a group at the time the group is created, but you are not required to do so. To add users to a group at a later time on the Users form, see Create new users.

671. From an Microsoft Dynamics AX client, click Administration > Setup > User groups.
672. On the Groups tab, press CTRL+N to create a new group.

673. Enter an identification in the Group column (required). For example, Fin for Finance or HR for Human Resources.

674. Enter a name in the User group name column (required). For example Finance Department or Human Resources Department.

675. Click the Users tab.

676. Select users in the Remaining users list box and click the left-arrow button (<) to move the selected users into the Selected users list box. All users moved into the Selected users list box are added to the current group. 
677. Press CTRL+S to save changes.

Company accounts and security

Company accounts in Microsoft Dynamics AX represent the organizational structure of your company. 

After you have created a new company in the Company accounts form, configure entities such as countries/regions and states that your company uses in the Microsoft Dynamics AX system, and configure various address formats. 

You then need to enter company information such as addresses, phone numbers, e-mail addresses, and Web sites for the purpose of:

· Reporting to different authorities

· Currency and language

· Payment instruction codes

· Number sequences

Note   If you represent a parent company with subsidiaries, if your company is a main company with companies in multiple locations, or if you otherwise need to represent several companies, you might also want to create multiple company accounts.

For instructions about how to set up a company account in Microsoft Dynamics AX, see Manage company accounts.

After company accounts are created, you can set up virtual companies that share tables from the main Microsoft Dynamics AX database. See Company accounts and Virtual company accounts for information about the relationship between these types of account.

Security management of company accounts is maintained by domains. Domains define sets of company accounts that are logically connected. 

· For more information about domains and security, see Domains and security.

· For instructions about how to define groups of company accounts, see Create domains.

Manage company accounts

Create new company accounts and view existing company accounts from the Company: dialog box. There are two types of company accounts that can be created:

· Real company accounts

· Virtual company accounts.

A virtual company account is a collection of data that is common to several company accounts. For more information, see Company accounts and Virtual company accounts.

Create a new company account

678. Click Administration > Company accounts.
679. Press CTRL+N to create a new record.

680. Enter a company code in the Company accounts field.

681. Enter the name of the company in the Name of company accounts field.

682. If you have a Domain license, click the Domains tab.

683. Select the domains that the new company should be included in.

A domain is a collection of one or more company accounts. For more information, see Domains.

Note   There are no domains present in Microsoft Dynamics AX when you first install the system. You must create domains separately.

684. Click the Virtual company accounts tab and select the virtual company accounts that this company should be a part of.

Company accounts and Virtual company accounts

A single Microsoft Dynamics AX database is capable of holding many individual companies. Once company accounts are created, you can set up virtual companies that share tables from the main Microsoft Dynamics AX database.

Virtual company accounts

Virtual company accounts contain data in certain tables that are shared by any number of company accounts. This allows users to post information in one company that will be available to another company.

This is useful when a client has multiple companies that can share non-transactional information such as vendor accounts, customer accounts, postal (Zip) codes, tax codes, and so on. This saves you from having to set up the same records in each company.

If you would like to use virtual companies at some time in the future, it is best to set up the virtual companies from the beginning of the implementation of Microsoft Dynamics AX. This avoids problems with combining records into a shared table at some time in the future.

Before you can create or modify a virtual company account, the following must be established:

· The application object server that the administrator is connected to must be the only one running. All other application object servers must be shut down.

· Only the administrator who is creating the virtual company account can be connected; only one active client connection is allowed.

After you create or modify a virtual company account, you must restart the Microsoft Dynamics AX client in order to update the client with the new virtual company account information.

Domains and security

A domain in Microsoft Dynamics AX is a group of company accounts. By establishing a domain, you can define user groups and permissions. Domains make it easier to maintain user group security when several companies use the same security profile. This is done by configuring security keys, as described in Security keys and Set up security keys.

Just as user groups define sets of users, domains define sets of company accounts that are logically connected. By defining domains of company accounts, in tandem with logical user groups, it is possible to set security permissions based on the combination of the two, as shown in the table below.

In the following example, the user groups can be viewed across the top of the table and the domains in which they reside are viewed along the side. Here, each box represents separate security settings that apply to the given user group/domain combination.

	 
	Admin
	HR
	Finance
	Purchasing
	Engineering
	IT
	R&D

	Asia
	Admin Asia
	HR Asia
	Finance Asia
	Purchasing Asia
	Engineering Asia
	IT Asia
	R&D Asia

	Africa
	Admin Africa
	HR Africa
	Finance Africa
	Purchasing Africa
	Engineering Africa
	IT Africa
	R&D Africa

	Australia
	Admin Australia
	HR Australia
	Finance Australia
	Purchasing Australia
	Engineering Australia
	IT Australia
	R&D Australia

	Europe
	Admin Europe
	HR Europe
	Finance Europe
	Purchasing Europe
	Engineering Europe
	IT Europe
	R&D Europe

	South America
	Admin South America
	HR South America
	Finance South America
	Purchasing South America
	Engineering South America
	IT South America
	R&D South America

	North America
	Admin North America
	HR North America
	Finance North America
	Purchasing North America
	Engineering North America
	IT North America
	R&D North America


By using domains, you can allow a conglomerate company that has several subsidiary businesses to share a single Microsoft Dynamics AX system. Each subsidiary could be represented by a domain, which in turn could limit access based on the user group. 

One domain, Admin, exists in the Microsoft Dynamics AX system at shipping. The Admin domain always includes all companies; you cannot remove the domain or delete any companies from this domain. Use the Admin domain for any user groups that need access to all companies.

Create domains

685. Click Administration > Setup > Domains.
686. Press CTRL+N to create a new domain record.

687. Enter a domain identification and a name.

688. Click the Company accounts tab and add accounts to the domain.

· To add an account to a domain, highlight the account name under Remaining company accounts and click the left arrow (<) to add it to the Selected company accounts list.

· To remove an account from a domain, highlight the account name under Selected company accounts and click the right arrow (>) to remove it to the Remaining company accounts list.

Domains and Company accounts

A domain in the Microsoft Dynamics AX system is a group of company accounts. By establishing a domain, you can define user groups and permissions. Domains make it easier to maintain user group security if several companies use the same security profile. For more information about the security functionality of domains, see Plan Microsoft Dynamics AX application security.

A single company can belong to more than one domain.

In addition to user groups, domains are used when setting up a log of database action (insert, update, and delete).

If you have purchased a domain license, you have this tab page available in Company accounts.

The Domains tab page displays all the domains in the Microsoft Dynamics AX system. The domains in the Selected domains section are the domains selected for the current company accounts, whereas the domains in the Remaining domains section are those that are not selected for the current company accounts. The domains in both sections can be moved back and forth using the arrows.

Security keys

Security keys are the permissions that control access to functionality within the application, and are set to individual user groups and users.

Security keys are set up from Administration > Setup > Security > Security on the Permissions tab.

Within a security profile, you can assign permissions that define access to Menu items, Form controls, Tables and Fields.

There are five available access levels:

· No access - Completely restricts access to that item and any sub-items it controls. The Open command is disabled. Also, the node is not displayed in the Application Object Tree (AOT).

· View access - Members of the user group are allowed to view the item, but not use it. The Save, Compile, Lock and Unlock commands are disabled.

· Edit access - Members of the user group are allowed to view and use the item. The New, Duplicate and Rename commands are disabled.

· Create access - Members of the user group are allowed to view and use, as well as add new items. The Delete command is disabled.

· Full control - Members of the user group have full access and consequently no commands are disabled. Additionally, members can provide additional rights in special cases.

Security access for each user must be decided before they first log on. Access depends on which user groups the user is a member of, and which company or domain the user is a member of. Access to functionality of each security key can depend on its parent, so the calculation must be done hierarchically.

To configure security keys, the administrator first selects a User Group and a corresponding Domain (it is possible to select all domains at once). The security tree is then built, and the administrator is able to view the tree and make the necessary changes. 

Note   When a security key property is changed for any AOT object, the client must be restarted for the changes to become visible.

For information about how to set security keys and for information about best practices, see Set up security keys.

Security key logic and organization

Security keys are used to restrict user group access in Microsoft Dynamics AX. Security keys have two main properties:

· Configuration Keys – The Configuration Key system allows an administrator to set the availability of functionality for the entire system. These modifications are to subsets of a module's functionality that are not currently necessary to have enabled within the system. From a security perspective, the removal of unused functionality reduces the surface that is open to attack. For more information, see Enable and disable configuration keys.

· Parent (only one parent can be specified) – Parent/child relationships control whether a key can be disabled. If you assign permission to a parent-node key (for example, if you select Absence approver and then select Full control) all child nodes inherit the same permission. If you do not want all child nodes to inherit the same permission, you can change permissions on individual child nodes.

The following graphic shows the path that is taken to validate security access.
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Note   If you have set up domains within Microsoft Dynamics AX, security is applied to the individual domains. Otherwise, security is set up for all companies.

Each parent security key represents a broad umbrella of functionality within Microsoft Dynamics AX, and the underlying child security keys are divided into eight categories: Daily, Setup, Journals, Inquiries, Reports, Periodic, Miscellaneous and Tables. Each module in Microsoft Dynamics AX is broken down within these categories. The Security keys are laid out similar to the structure in the User Interface. Opening the main menu side-by-side with the security keys makes it easy to see how the categories relate to menu items.
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· Daily — Contains the most accessed forms in the menu

· Setup — Corresponds with the Setup folder in the menu

· Journals — Corresponds with the Journals folder in the menu

· Inquiries — Corresponds with the Inquiries folder in the menu

· Reports — Corresponds with the Reports folder in the menu

· Periodic — Corresponds with the Periodic folder in the menu

· Miscellaneous — Controls access to all menu items used in the module that are not accessed from the menu. This is typically menu items accessed through buttons on forms. You do not have to change access in this category directly if you click Cascade.

Note   When you give access to a form, clicking Cascade updates all items with the same access related to that form.

· Tables — Lists all the tables used in that module. Clicking Cascade ensures that all tables are accessible for needed forms and reports.

See Best Practices for Configuration and Security Keys for more information about Security key and Menu relationships.

For each module, a set of nine security keys exists. They all have the same naming, and the prefixes denote the module. For the Accounts Receivable module, the security keys are:

· Cust

· CustDaily

· CustSetup

· CustJournals

· CustInquiries

· CustReports

· CustPeriodic

· CustMisc

· CustTables

Each menu item is present beneath one (and only one) security key. The access to the menu item ranges from No access to Full control.
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Set up security keys

Security keys are the permissions that determine who can access menus, forms, reports, and tables. In Microsoft Dynamics AX, you assign permissions to user groups instead of to individual users. Assigning permissions to groups saves time because you do not have to adjust permissions for each user.

When you create a new user group in Microsoft Dynamics AX, the group, by default, is set to No access for all menus, forms, reports, and tables. This means that after you create a new group you must use the procedure in this topic to enable permissions, otherwise all members of the group are denied access to all menus, forms, reports, and tables.

If you assign permission to a parent-node key (for example, if you select Absence approver and then select Full control) all child nodes inherit the same permission. If you do not want all child nodes to inherit the same permission, you can change permissions on individual child nodes.

A user group can have different permissions within different domains. For more information about domains, see Domains and security.

Permission levels

Higher-level permissions inherit lower-level permissions. For example, a group that has Create permissions for an item like a form also has Edit and View permissions as well. The table below shows the inherited permissions.

	-
	View
	Edit
	Create
	Full control
	No access

	View
	x
	x
	x
	x
	-

	Edit
	-
	x
	x
	x
	-

	Create
	-
	-
	x
	x
	-

	Full control
	-
	-
	-
	x
	-


Set access permissions for user groups

689. From a Microsoft Dynamics AX client, click Administration > Setup > Security > User group permissions.
690. On the Overview tab, select a user group and then select a domain.

691. Click the Permissions tab.

692. In the list box, select the item or items for which you want to set permissions for example, Absence approver. 

Note   To select multiple items, press and hold the CTRL key.

693. Under Access, select a permissions level. After you have selected a permissions level, the selected item shows a checkmark to indicate that permissions have been set. 

694. Click Cascade to ensure that all dependent keys are set, and to inherit this permission level to all child tables, forms, and nodes.

695. In the Viewing drop-down list, select a new area of Microsoft Dynamics AX for which you need to set permissions.

696. Press CTRL+S to save changes.

697. Restart the Microsoft Dynamics AX server if you changed the permissions of an existing group, especially if you set more restrictive permissions on that group.

Note   When a security key property is changed for any AOT object, the client must be restarted for the changes to become visible.

Note   If you need to set permissions for a group in a different domain, repeat this procedure and select the new domain in step 2.

Set access permissions for developers

Restrict user group access permissions to Application Object Tree (AOT), the central repository for classes, tables, and other development elements in Microsoft Dynamics AX. By default, only members of the Administrators group have access to AOT. As a security best practice, create a Developers group (see Manage user groups) and give this group access permission to make changes in AOT. The Developers group could have Edit permission if you adhere to a strict security policy of least privilege. However, if developers need to create or delete AOT elements, the group requires Create or Full control permission.

Ideally, you should not give any other group access permission to AOT, especially access permission where members of that group can make changes in AOT. If necessary, you can grant View permission so individuals can look at elements in the AOT.

Best practices

· Work with managers who oversee the different groups in your business or organization to determine permissions levels. For example, work with a manager in the Finance department to determine permissions levels for the Finance groups or groups. The manager knows which groups should have permissions to items like General ledger and Bank, including permissions on child nodes.

· If you are uncertain about whether to allow permission to a certain item, leave the permissions level set to No access. It is better to deny permission to an item and force an individual to request permission for their group than to give permission to an area that a group should not be able to access.

· Restrict the number of users who are members of the Administrators group, which has access to all fields, tables, reports, and modules in Microsoft Dynamics AX by default. If users are made members of the Administrators group, they can potentially view reports or data they should not be allowed to see or change configurations and business logic in the system. Ideally, only those individuals who will be configuring and administering Microsoft Dynamics AX should be members of the Administrators group.

Important   If you change permissions for a user group, especially if you demote permissions, restart the server after making the change. If you do not restart the server, members of the group might retain their former permissions. As a best practice, ask members of a group to log off Microsoft Dynamics AX before changing permissions and inform all Microsoft Dynamics AX users of the impending server restart. If necessary, before changing user group permissions, select users to disconnect from the server in Online users (Administration > Online users) and click End sessions. For more information, see Remove users.

Table and field access
While security keys control access to functionality within the application, this security access is limited to menu items. In order to help protect your system at a more granular level, it is important to set up security for table and field access.

All tables and fields are available in the security system, and access can be set up individually for each user group working within a company or domain without affecting other user groups. Table and field access is configured when you set security keys (Administration > Setup > Security > Security on the Permissions tab).

The following graphic shows how to access and configure table and field access from within the User group permissions window.
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Table access

A user group's access to a table is defined by several factors:

· The table rights defined for the user group within the domain or company.

· The table's security key and the user group's security key rights within the domain or company with respect to the table.

· The setting of the MaxAccessMode table property.

These factors are used for the calculation of a user group's access rights to each table in the application. 

The following chart shows how table rights are calculated during startup. Tables have two properties: Configuration key and Security. 
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Field access

Like a user group's table access, a user group's access to a field is defined by a number of factors:

· The field rights defined for the user group within the domain.

· The field's security key and the user group's security key rights within the domain with respect to the field.

· The setting of the Visible field property.

· The setting of the AllowEdit field property.

These factors are used for the calculation of a user group's access rights to each field in the application. The calculation is performed during startup.

The following chart shows how field rights are calculated during startup.
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After the user group's access to a field has been calculated, this access is compared to the one defined for the table. A user group's access to a field can never exceed the group's access to the table the field belongs to. The final field access becomes the lesser of the field and table rights.

Best practices

· Work with managers who oversee the different groups in your business or organization to determine permissions levels. For example, work with a manager in the Finance department to determine permissions levels for the Finance group or groups. The manager knows which groups should have permissions to items like General ledger and Bank, including permissions on child nodes.

· If you are uncertain about whether to allow permission to a certain item, leave the permissions level set to No access. It is better to deny permission to an item and force an individual to request permission for their group than to give permission to an area that a group should not be able to access.

· Restrict the number of users who are members of the Administrators group, which has access to all fields, tables, reports, and modules in Microsoft Dynamics AX by default. If users are made members of the Administrators group, they can potentially view reports or data they should not be allowed to see or change configurations and business logic in the system. Ideally, only those individuals who are configuring and administering Microsoft Dynamics AX should be members of the Administrators group. For information on user groups and security profiles, see User group configuration and security.

Important   If you change permissions for a user group, especially if you demote permissions, restart the server after making the change. If you do not restart the server, members of the group might retain their former permissions until the next time the server is restarted. As a best practice, ask members of a group to log off Microsoft Dynamics AX before changing permissions and inform all Microsoft Dynamics AX users of the impending server restart. If necessary, before changing user group permissions, select users to disconnect from the server in Online users (Administration> Online users) and click End sessions. For more information, see Remove users.

After table and field restrictions are applied, consider adding special restrictions to certain records within the database. To learn more about record level security, see Manage record level security.

Manage record-level security

Record-level security builds on the restrictions enforced by user-group permissions. With user-group permissions, you restrict which menus, forms, and reports that members of a group can access. Record-level security enables you to restrict the information shown in reports and on forms.

Record-level security is commonly used in the following situations (to name a few). You can:

· Allow members of a Sales user group to see only the accounts they manage.

· Prohibit financial data from appearing on forms or reports for a specific user group.

· Prohibit account details or account IDs from appearing on forms and reports for a specific user group.

· Restrict form and report data according to location or country/region.

Before you begin

The process of setting record-level security involves selecting a database table in the Record Level Security wizard. Tables store the data shown in reports and on forms. You might find it helpful to work with a developer who has knowledge of the database tables while configuring record-level security. The developer can help you choose the table that directly corresponds to the report or form elements to which you want to restrict access.

Also, verify the following before you begin:

· Does the user group that will be assigned record-level security already exist or do you need to create a new user group? For information about creating a new user group, see Manage user groups.

· Does the user group have, at the very least, View permission for the report or form? If, for example, a Finance user group does not have any access permission for the General Ledger module, then it does not make sense to assign record-level security to any report or form in that module because the group cannot access those reports/forms in the first place. For information about group permissions, see Manage permissions.

To set record-level security

Setting record-level security is a two-part process. The first part involves selecting a user group and the appropriate database table using the Record Level Security wizard. The second part involves creating a query that specifies the fields and criteria to be applied when record-level security is enforced.

The Record Level Security Wizard

698. From a Microsoft Dynamics AX client, click Administration > Setup > Security> Record level security.
699. Press CTRL + N to open the Record Level Security (RLS) setup wizard.

700. Select a user group and click Next.

701. Select a table. By default, the most frequently accessed database tables are shown. Click Show all tables to expand the selection. Click Next.

702. Click Finish.

The Query

703. In the Record level security dialog box, select the user group and click Query. The Inquiry dialog box appears. The Range tab shows some of the common fields for the specified table. Your objective on this tab is to specify the exact fields to be shown to the selected user group on the report or form.
704. Select the first item listed on the Range tab. If no item is listed, press CTRL + N.

705. Use the Field drop-down menu to select the field you want to show on the form or report.

706. Use the Criteria drop-down menu to select the criteria for the designated field. If no drop-down menu appears, enter the designated criteria.

707. As necessary, press CTRL + N to add additional fields and criteria.

708. Click OK.

709. Inform members of the selected user group that they must close their current client sessions and start a new session. If necessary, end active sessions from the Online users form.

710. Verify that record-level security is enforced on the desired report or form by logging on to Microsoft Dynamics AX as a member of the specified user group. You should see only the information specified in the query for the designated criteria. If you see additional information, verify your query.

Setting up and configuring Business Connector

Business Connector is a Microsoft Dynamics AX component that enables applications to interact with Application Object Server instances. Microsoft Dynamics AX ships with two versions of Business Connector:

· The .NET Business Connector provides a set of managed classes that facilitate access to X++ functionality in Microsoft Dynamics AX. It is installed with and used to support the functionality in the Enterprise Portal server and application integration server roles. The .NET Business Connector can be installed as a stand-alone component, and used to develop third-party applications that integrate with Microsoft Dynamics AX.

· The COM Business Connector is an optional Microsoft Dynamics AX component that can be used to enable applications running outside Microsoft Dynamics AX to interact with an Application Object Server (AOS) instance. The COM Business Connector provides a set of COM interfaces to X++ functionality in Microsoft Dynamics AX. The COM Business Connector is included in Microsoft Dynamics AX for backward-compatibility only.

For an overview of Business connector architecture, see Microsoft Dynamics architecture.

Changes to Business Connector

Many changes have been made to the Business Connector in the new version of Microsoft Dynamics AX, including: The addition of the .NET Business Connector to support applications built with the Microsoft .NET Framework or ASP.NET.

· Requiring Microsoft Windows authentication for all versions of the Business Connector. Any existing COM applications that use the Microsoft Axapta 3.0 version of the Business Connector must be written to use Windows authentication before they work with Microsoft Dynamics AX.

· Automatic registration. In previous versions of the product, the COM Business Connector was installed and registered using the Configuration Utility. In Microsoft Dynamics AX, the .NET Business Connector in installed into the Global Assembly Cache (GAC), and the COM Business Connector does not require registration.

· Use of the Business Connector Proxy for "act-on-behalf of" privileges. The Business Connector Proxy is a Windows domain user account that is used to enable Business Connector to “act-on-behalf” of Microsoft Dynamics AX users that cannot be fully authenticated. This domain user account must be created prior to configuring the Business Connector in Microsoft Dynamics AX and prior to setting up Enterprise Portal.

This section includes the following topics:

· Install business connector to support a custom client
· Manage a Business Connector configuration
· Set up the Business Connector proxy user
Install Business Connector to support a custom application

You must install the version of Business Connector required by your custom application on all computers that upon which the application will be installed. The application will then communicate with the Application Object Server (AOS) through Business Connector on each of the computers.

Note   The .NET Business Connector is installed automatically for those roles that require it, including Enterprise Portal server and application integration server.

Components installed

Installing Business Connector installs the Microsoft Dynamics AX Configuration utility, and one or all of the following components:

· .NET Business Connector

· COM Business Connector

Verify prerequisites

Before installing Business Connector, the following must be available in the domain: 

· A core Microsoft Dynamics AX installation. This installation can be completed at the same time as the Business Connector installation, or it can be done prior to this installation. 

· Active Directory configured in native mode.

For "act-on-behalf-of" functionality, ensure that a Business Connector Proxy Windows domain account exists

A Microsoft Windows domain account to act as the Business Connector Proxy is required when you configure the Business Connector if your application requires "act-on-behalf-of" functionality for external users or users that are at times unable to connect to your application. 

The Business Connector proxy enforces a strict security policy for users connecting to Microsoft Dynamics AX using an external application dependent on Business Connector. 

Important   If a malicious user learns the Business Connector proxy credentials (name and password), that user could gain unauthorized access to sensitive data. For this reason, only Microsoft Dynamics AX administrators should know the proxy credentials.

Work with a System Administrator to have a new account created solely for use by the Business Connector before you install it. We recommend that the account be set up as follows:

· Password does not expire.

· No interactive logon rights

The Business Connector Proxy domain account should not be set up as a Microsoft Dynamics AX user.

Create the proxy account in Active Directory

711. Create a unique user in Active Directory in the form domain\username, for example, domain\bcproxy. This user must not have the same name as an existing user in Microsoft Dynamics AX. For the procedure to add a new user, see the Active Directory documentation.
712. Assign a password to the user.

713. Select the Password does not expire option.

714. Select the No interactive logon rights option.

715. Close Active Directory.

(Optional) Add the proxy account to the IIS local Windows group

For Web applications, you must add the Business Connector proxy account to the IIS local Windows group. If you are using Windows SharePoint Services, you must also add the account to the Windows SharePoint local Windows group.

716. Open the Computer Management application (Start > Administrative Tools > Computer Management).
717. Expand the Groups folder under Local Users and Groups.

718. Add the Business Connector proxy account to the following groups:

· IIS_WPG (IIS Worker Process Group)

· STS_WPG (STS Worker Process Group), if running Windows SharePoint Services

(Optional) Configure the IIS application pool

For Web applications, you must associate the Business Connector proxy account to the appropriate application pool identity.

719. In the left pane of the IIS Manager, expand Application Pools.
720. Right-click Application Pools, and then click New > Application Pool.

721. Enter a name for the application pool, and click OK.

722. Right-click the application pool that you are using and click Properties. 

723. Click the Identity tab.

724. Select Configurable.

725. Enter the Business Connector proxy account username and password. 

726. Verify the password, and click OK.

727. Click Finish to close the wizard.

Verify rights

You must log in with an account that is a member of the Administrators group on the computer on which you are running Setup.

Start Setup

If you have not done so already, insert the Microsoft Dynamics AX DVD into your drive. If the Microsoft Dynamics AX Setup Wizard does not launch automatically, double-click the Autorun.hta file in the root directory of the DVD.

If you are installing from a network location, share the installation files and connect to the location from the computer on which you want to install the program.

Install Business Connector

728. Because Business Connector is a type of Microsoft Dynamics AX client, if it is the first client you are installing on a computer, Setup requires that you set the display and Help language. To begin the installation process, click Microsoft Dynamics AX.
On the Prerequisites check page, Setup validates that the software required to install Microsoft Dynamics AX is present. If it is not, click Install. To continue after the update completes, click Next.

729. On the Welcome page of the Setup Wizard, click Next to continue.

730. On the License agreement page, read the license agreement and then click I accept the terms in the license agreement to accept the licensing terms and conditions. Accepting the license agreement activates the Next button. To continue, click Next. 

Note   To end Setup, click Cancel.

731. On the Select installation type page, click Custom installation, and then click Next. 

732. Select the version of Business Connector you want to install, and then click Next.

733. On the Install files page, click Next to accept the default location, or click Browse to designate a different location.

734. On the Connect to Application Object Server page, type the name of the Application Object Server you want to connect to, and then click Next.

If you do not know the location of the Application Object Server, contact the Microsoft Dynamics AX administrator.

735. On the Install files page, click Next to accept the default location, or click Browse to designate a different location.

736. On the Ready to install page, review the summary of roles and components for your computer. To proceed, click Next.

737. On the Installing page, you can monitor installation progress as Setup proceeds.

738. On the Completing Microsoft Dynamics AX Setup page, you can review the summary of roles and components for your computer. To exit Setup, click Finish.

Configure the Business Connector Proxy User 

739. Start Microsoft Dynamics AX (Start > All Programs > Microsoft Dynamics > Microsoft Dynamics AX 4.0 Client).
740. Open the Business Connector Proxy dialog box: Administration > Setup > Security > Business Connector Proxy.
741. In the Alias box, enter the alias. In the Network domain box, enter the domain of the user and then close the dialog box.

Manage a Business Connector non-interactive configuration

To modify the configuration options for a Business Connector that is running non-interactively (not being run in conjunction with a client), you must be a member of the Administrators or Power Users group on the local computer.

Note   Although the option to change the Business Connector non-interactive configuration becomes available when Business Connector is installed, if a Microsoft Dynamics AX client is also installed on the computer, the configuration settings for the client will be used for it and for the Business Connector if Business Connector is running under the currently logged-in account.

Start the configuration utility

742. Open the configuration utility (Start > Control Panel > Administrative Tools > Microsoft Dynamics AX Configuration Utility).
743. In the Configuration target list, select Business Connector (non-interactive use only).

Create a new configuration

You cannot modify the original configuration of a system. To change a configuration, you must create a new one and modify it.

744. Click Manage, and then click Create configuration:
745. In the Create configuration dialog box, in the Name box, type a name.

746. Decide whether you want to copy settings from the active configuration or the original (default) configuration, and then click OK.

Copy a configuration

747. In the Configuration list, select the configuration you would like to create a copy of.
748. Click Manage, and then click Create configuration:

749. In the Create configuration dialog box, in the Name box, type a name.

750. Click Copy settings from the active configuration, and then click OK.

Rename a configuration

751. In the Configuration list, select the configuration you would like to rename.
752. Click Manage, and then click Rename configuration. 

753. In the Rename configuration dialog box, in the New name box, type a name, and then click OK.

Load a configuration

You can either load a configuration that is stored in the local registry or import a configuration file. Although you can use the Open command to view a saved configuration, Microsoft Dynamics does not store the settings from the opened file to the registry. To store saved configuration files to the registry, you must use the Import command.

Load a configuration from the registry

· In the Configuration list, select the configuration you would like to open.

Import a configuration file

754. Click Manage, and then click Import. 
755. Browse to the configuration file you would like to use (*.axc), and open it.

Save or export a configuration

You can save startup settings for a client or Business Connector instance as a configuration stored in the registry, or as a configuration file. Saved startup settings enable you to: 

· Tune Microsoft Dynamics AX. Change settings, and then tune your system by comparing performance with saved configurations that contain varied compression, database turning, and tracing settings.

· Move a configuration from one client to another.

Save a configuration to the registry

756. Verify that the currently selected configuration is the one you want to save.
757. Make any changes to the currently selected configuration that you want.

758. Click OK.
Export a configuration to a file

Use this procedure if you want to copy a configuration to a client on another computer.

759. Verify that the currently selected configuration is the one you want to save.
760. Click Manage, and then click Export configuration to a file. Choose a location and name for the configuration file, and then click Save. The file is saved with an .axc extension.

Export all configurations to a file

Use this procedure if you want to copy all configurations from one client.

761. Verify that the currently selected configuration is the one you want to save.
762. Click Manage, and then click Export All. Choose a location and name for the configuration file, and then click Save. The files are saved with an .axc extension. 

Save a configuration file with a new name

Use this procedure if you want to create a copy of the configuration file you have been using. 

763. Import or open a configuration file. 
764. Make changes to settings.

765. Click Manage, and then click Save configuration file as. Choose a location and name for the configuration file, and then click Save. 

Delete a configuration

766. Verify that the currently selected configuration is the one you want to delete.
767. Click Manage, and then click Delete configuration.

Set up the Business Connector proxy user

The proxy is a Microsoft Windows domain account that enables Business Connector to “act on behalf” of Microsoft Dynamics AX users when authenticating with Application Object Server (AOS). You must set up and configure the proxy as described in this topic. If you do not set up and configure the proxy as described here, remote users cannot connect to Microsoft Dynamics AX using external Web application if the application depends on user impersonation in Business Connector.

Important   If a malicious user learns the Business Connector proxy credentials (name and password), that user could gain unauthorized access to sensitive information. For this reason, only Microsoft Dynamics AX administrators should know the proxy credentials.

To set up and configure the Business Connector proxy, you must:

768. Create the proxy account in Active Directory directory service.
769. Create the proxy account in the Microsoft Dynamics AX database.

Create the proxy account in Active Directory directory service

You must create a proxy account in Active Directory on your domain controller before Business Connector can "act on behalf" of remote users. If the proxy account does not exist in Active Directory, remote users cannot authenticate with Microsoft Dynamics AX.

To create the proxy account in Active Directory

770. Create a unique user in Active Directory in the form domain\username, for example, redmond\bcproxy. This user must not have the same name as an existing Microsoft Dynamics AX user. For the procedure to add a new user, see the Active Directory documentation.
771. Assign a password to the user.

772. Select the Password does not expire option.

773. Select the No interactive logon rights option.

774. Close Active Directory.

Set the proxy account in the Microsoft Dynamics AX database

After you created the proxy account in Active Directory, you must add the account to the Microsoft Dynamics AX database. By storing the proxy account in the database, multiple AOS instances can access the proxy and thereby authenticate multiple users.

To set the proxy account in the Microsoft Dynamics-AX database

775. From a Microsoft Dynamics AX Client, click Administration > Setup > Security > Business Connector Proxy.
776. In the Alias field, enter the name of the proxy user previously entered in Active Directory, for example, bcproxy.

777. In the Network domain field, enter the domain.

778. Click Apply.

Setting up and configuring an Enterprise Portal

Microsoft Dynamics AX provides a set of built-in Web applications that are collectively called Enterprise Portal.

The Microsoft Dynamics AX Microsoft Windows-based client provides a rich user experience that is tailored to the frequent knowledge-based worker. The Web-based Enterprise Portal is geared toward, but not limited to, the less-frequent user (internal or external partner) who needs a specialized subset of the application functionality and data that resides in Microsoft Dynamics AX. 

For an overview of:

· Installing Enterprise Portal, see Flowchart: Installation process
· The recommended topologies, see System topology recommendations
· Enterprise Portal architecture, see Microsoft Dynamics architecture
This section includes the following:

	Section
	Description

	Install an Enterprise Portal server
	This procedural topic describes how to install Enterprise Portal.

	Configuring Enterprise Portal
	This section describes how to configure Enterprise Portal using the Configuration Wizard, and how to configure search, product groups, transaction summaries, and documents.

	Deploy Enterprise Portal
	This procedural topic describes how to deploy Enterprise Portal to a Web server.

	Create an Enterprise Portal site
	This procedural topic describes how to create an Enterprise Portal Web site.

	Managing Enterprise Portal users
	This section describes how to manage Enterprise Portal users.

	Customizing an Enterprise Portal site
	This section describes how to customize an Enterprise Portal site.

	Manage Enterprise Portal security
	This procedural topic describes how to manage Enterprise Portal security

	Remove an Enterprise Portal site
	This procedural topic describes how to remove an Enterprise Portal site.


Flowchart: Configuring Enterprise Portal

The Enterprise Portal provides Web-enabled access to data stored in Microsoft Dynamics AX. From the Enterprise Portal, you can also manage documents that are attached to records in the Microsoft Dynamics AX database, search for data stored in Microsoft Windows SharePoint Services, and use SharePoint announcements, surveys, and discussion lists to collaborate with customers, business partners, and other employees.
For detailed procedures on how to set up and configure Enterprise Portal, see Install and Configure a Dynamics AX Enterprise Portal Server.
Prerequisites

779. Install and configure Active Directory directory services.
780. Install and configure a core Microsoft Dynamics AX installation (file server, object server, client, and database)

781. Install and configure Internet Information Services (IIS)

782. Enable ASP.NET 2.0

783. Install and configure Windows SharePoint Services (WSS)

784. Add the business connector proxy account to Active Directory and to the IIS and WSS local windows groups

785. Install the Enterprise Portal role using Setup.exe on your Microsoft Dynamics AX DVD.

786. Set up Enterprise Portal users and groups.
Flowchart

See Enterprise Portal flowchart for print version.

The main setup forms of Enterprise Portal

Enterprise Portal forms include the following (in order of setup).
787. Configure Enterprise Portal using the Configuration wizard 
For an explanation of the fields on this form, see Enterprise Portal Configuration Wizard (form).
Deploy Enterprise Portal using the Configuration wizardFor an explanation of the fields on this form, see Enterprise Portal Deployment Wizard (form).

788. Create a Web site using the Web sites form.
For an explanation of the fields on this form, see Web sites (form).

The optional setup forms of Enterprise Portal

Additional setup forms include the following:
789. Publish images to your Enterprise Portal site using the Publish images form.
790. Adjust content and data for Enterprise Portal sites using the Parameters form.
Install an Enterprise Portal server

After you have installed a Microsoft Dynamics AX system, you can install an Enterprise Portal. Installing an Enterprise Portal requires that you perform the following steps on the computer that will run Enterprise Portal:

· Verify prerequisites

· Set up the Business Connector Proxy

· Configure Microsoft Internet Information Services (IIS)

· Configure Microsoft SharePoint Technology

· Install Enterprise Portal

After you have installed, to finish setting up your Enterprise Portal, you must also:

· Configure Enterprise Portal. For details, see Configuring Enterprise Portal.

· Deploy Enterprise Portal. For details, see Deploy Enterprise Portal.

· Create an Enterprise Portal site. For details, see Create an Enterprise Portal site.

Note   If you require that the Application Integration Framework (AIF) and Enterprise Portal reside on the same computer, you must exclude the virtual directory that AIF is using from the SharePoint managed path. For details, see Install an application integration server.

Verify prerequisites

Before installing the Enterprise Portal server, the following must be available in the domain:

· Active Directory directory service configured in native mode.

· A core Microsoft Dynamics AX installation (file server, object server, client, and database).

· For external user access to the Enterprise Portal, a perimeter network domain with a firewall must have been configured. For details, see Setting up a perimeter network.

· ASP.NET 2.0. If you do not meet this prerequisite, see the section Configure IIS in this topic.

· Windows SharePoint Services (version 2), (SP2), Windows SharePoint Services (version 3), Beta 2, or Microsoft Office SharePoint Server 2007, Beta2. 

Set up the Business Connector Proxy

The Business Connector proxy enforces a strict security policy for users connecting to Microsoft Dynamics AX using Enterprise Portal or any other external Web application dependent on Business Connector. If you do not set up and configure the proxy as described here, remote users cannot connect to Microsoft Dynamics AX using Enterprise Portal.

Important   If a malicious user learns the Business Connector proxy credentials (name and password), that user could gain unauthorized access to sensitive data. For this reason, only Microsoft Dynamics AX administrators should know the proxy credentials.

To set up a Business Connector Proxy, you must: 

· Create an account for the proxy in Active Directory

Note   Do not add the Business Connector Proxy domain account to Microsoft Dynamics AX as a user. You associate the Business Connector Proxy with Microsoft Dynamics AX in the Configuration wizard.

· Add the proxy account to IIS and Windows SharePoint Services local Windows groups. 

If, after you have set up the Business Connector Proxy, you need to change the instance of the Application Object Server (AOS) that the Business Connector connects to, you can use the Microsoft Dynamics AX Client Configuration Utility. For details, see Manage a Business Connector non-interactive configuration.

Create the proxy account in Active Directory

791. Create a unique user in Active Directory in the form domain\username, for example, domain\bcproxy. This user must not have the same name as an existing user in Microsoft Dynamics AX. For the procedure to add a new user, see the Active Directory documentation.
792. Assign a password to the user.

793. Optional. Select the Password does not expire option.

794. Select the No interactive logon rights option.

795. Close Active Directory.

Add the proxy account to IIS and Windows SharePoint Services local Windows groups

You must add the Business Connector proxy account to the IIS and Windows SharePoint Services local Windows groups. IIS and WSS must be installed on your computer before you can perform this procedure.

796. Open the Computer Management application (Start > All Programs > Administrative Tools > Computer Management).
797. Expand the Groups folder under Local Users and Groups.

798. Add the Business Connector proxy account to the following groups:

· IIS_WPG (IIS Worker Process Group)

· STS_WPG (STS Worker Process Group), if running Windows SharePoint Services

Configure IIS

If you do not have IIS installed, you can install it from Start > Control Panel > Add or Remove Programs > Add/Remove Windows Components > Application server. 

799. Validate that Application Server has been installed as follows:
	Option
	Value

	Application Server Console
	Installed

	ASP.NET 
	Installed

	Enable network COM+ access
	Installed

	Internet Information Services (IIS)
	Installed


800. To configure an existing installation of IIS, use IIS Services Manager, available from Start > All Programs > Administrative tools > Internet Information Services Manager. For more information, see the IIS documentation. 
If Enterprise Portal is external facing for employees, authorized vendors and customers, then verify that IIS is configured to use Secure Sockets Layer (SSL) encryption and Basic authentication:

	Option
	Value

	FrontPage 2002 Server Extensions
	Not installed

	Authenticated access
	· Integrated Windows authentication for intranet-facing Enterprise Portal sites.

· Basic authentication for Internet facing authenticated Enterprise Portal sites.

· Anonymous authentication for Internet facing Enterprise Portal sites with public access.

	Server Certificate
	Assigned (Required for Internet facing authenticated Enterprise Portal sites, otherwise optional)

	Require secure channel (SSL)
	Enabled (Required for Internet facing authenticated Enterprise Portal sites, otherwise optional.)


801. Change the application pool identity for SharePoint Services to use the Business Connector Proxy account.
j. In the left pane of the IIS Manager, expand the Application Pools directory.
k. Right-click the SharePoint Services application pool that you are using for Enterprise Portal (often StsAppPool1) and click Properties. 

l. Click the Identity tab.

m. Select Configurable.

n. Enter the Business Connector proxy account username and password. 

o. Click Apply.

p. Click OK.

q. Right-click the SharePoint Services application pool again and select Recycle. The application pool now accepts requests from the Business Connector proxy account.

Important   If the security policy in your organization or company compels you to change the proxy password at any time, you must repeat this procedure and enter the new password.

802. Validate that ASP.NET 2 is enabled.

r. In the left pane of the IIS Manager, click Web Server Extensions.
s. In the right pane, validate that ASP.NET 2 is enabled. If it is not enabled, you must install ASP.NET 2.0. For details, see the instructions in the Knowledge base article located here.

Configure SharePoint technology

Microsoft Dynamics AX Enterprise Portal can run on any of the following SharePoint technologies: 

· Windows SharePoint Services (version 2), SP2

· Windows SharePoint Services (version 3), Beta 2

· Microsoft Office SharePoint Server 2007, Beta 2

Configuration settings vary for each technology. See the appropriate procedure below for details. 

Note   If you have installed both Windows SharePoint Services (version 3), Beta 2, and Windows SharePoint Services (version 2), SP2 on a computer, Microsoft Dynamics AX will not deploy to Windows SharePoint Services (version 2). 
Configure Windows SharePoint Services (version 2), SP2

You can download Windows SharePoint Services (version 2), SP2 from Microsoft.com. SharePoint technologies can be installed with MSDE, Microsoft SQL Server 2000 with SP4, or Microsoft SQL Server 2005. For details about installing Windows SharePoint Services with SQL Server 2000 with SP4, see Install Windows SharePoint Services, or see the Deployment Scenarios section of the SharePoint Technologies documentation on TechNet.

To configure an existing installation of Windows SharePoint Services, use SharePoint Central Administration, available from Start > All Programs > Administrative tools > SharePoint Central Administration.

803. Validate that the Virtual Server provisioning settings are as follows:
	Option
	Value

	Security account
	Predefined, Business Connector proxy account

	Security configuration
	NTLM


804. If you have already installed IIS, and have not yet installed ASP.NET version 2, execute the following command:
%SYSTEMROOT%\Microsoft.NET\Framework\v2.0.50727\aspnet_regiis.exe -i 

805. Verify that ASP.NET v2.0.50727 is listed in IIS Manager on the ASP.NET tab:

t. Right-click the Default Web site and click Properties.
u. Click the ASP.NET tab.

v. In the ASP.Net version drop-down list, verify that v2.0.50727 is selected. If it is not selected, do that now.

806. Click OK.

807. Open the web.config file. (%SYSTEMDRIVE%\Inetpub\wwwroot\) to make the following change. 

808. Press CTRL+F to open the Find dialog box.

809. Search for the following tag:

<trust level="WSS_Minimal" originUrl="" />

810. Replace it with the following tag (changes in bold): 

<trust level="WSS_Medium" originUrl="" />

811. Optional. If you have already installed Windows SharePoint Services but are not running Service Pack 2, you must make further changes to the web.config file. Read the information available in the Knowledge Base article located here, and make the following changes.

w. Search for the following tag:
<trust level="WSS_Medium" originUrl="" />

x. Replace it with the following tag (changes in bold): 

<trust level="WSS_Medium" originUrl="" processRequestInApplicationTrust="false" />

y. Search for the following tag: 

<pages enableSessionState="false" enableViewState="true" enableViewStateMac="true" validateRequest="false"> </pages>

z. Replace it with the following tag (changes in bold):

<pages enableSessionState="false" enableViewState="true" enableViewStateMac="true" validateRequest="false" enableEventValidation="false"> <namespaces> <remove namespace="System.Web.UI.WebControls.WebParts" /> </namespaces> </pages>

aa. Search for the following tag:

<httpRuntime maxRequestLength="51200" />

ab. Replace it with the following tag (changes in bold):

<httpRuntime executionTimeout="6000" maxRequestLength="51200" />

812. Save your changes.

813. Close the web.config file.

814. In a command prompt, type IISReset, and wait for IIS to restart.

Configure Microsoft Windows SharePoint Services (version 3), Beta 2 or Microsoft Office SharePoint Server, Beta 2

Information about how to configure Enterprise Portal to work with Windows SharePoint Server (version 3), Beta 2 or Microsoft Office SharePoint Server, Beta 2 is available on Using Microsoft Dynamics AX.

Install Enterprise Portal

You must be at the Enterprise Portal server computer to install the Enterprise Portal software. 

Components installed

Setting up a computer as an Enterprise Portal server installs the following components: 

· Microsoft Dynamics AX client. 

· Microsoft Dynamics AX Client Configuration Utility.

· .NET Business Connector.

Verify rights

You must log in with an account that is a member of the Administrators group on the computer on which you are running Setup.

Start Setup

If you have not done so already, insert the Microsoft Dynamics AX DVD into your drive. If the Microsoft Dynamics AX Setup Wizard does not launch automatically, double-click the Autorun.hta file in the root directory of the DVD.

If you are installing from a network location, share the installation files and connect to the location from the computer on which you want to install the program.

Install Enterprise Portal server files

Because Enterprise Portal requires that the Microsoft Dynamics AX client also be installed, if it is the first client you are installing on a computer, Setup requires that you provide the display language, Help language and file location for the client.

815. To begin the installation process, click Microsoft Dynamics AX.
On the Prerequisites check page, Setup validates that the software required to install Microsoft Dynamics AX is present. If it is not, click Install. To continue after the update completes, click Next.

816. On the Welcome page of the Setup Wizard, click Next to continue.

817. On the License agreement page, read the license agreement and then click I accept the terms in the license agreement to accept the licensing terms and conditions. Accepting the license agreement activates the Next button. To continue, click Next. 

Note   To end Setup, click Cancel.

818. On the Select installation type page, click Custom installation, and then click Next.

819. On the Select computer role page, select Enterprise Portal server, and then click Next. 

Note   You can install multiple roles on the same computer. For additional information, see System topology recommendations.

820. On the Select display language page, select the language in which you would like to first run Microsoft Dynamics AX. If you later decide to change languages, you can modify the user language within the client.

821. On the Select Help language page, select the Help languages you would like to have available for Microsoft Dynamics AX.

Note   To switch between Help languages, you can change the user settings within the Microsoft Dynamics AX client. 

822. On the Install client files page, click Next to accept the default location, or click Browse to designate a different location. 

823. On the Connect to Application Object Server page, type the name of the Application Object Server (AOS) you would like to connect to, and then click Next.

If you do not know the name of the AOS and it is running locally, you can check its name under Administrative Tools > Services. Otherwise, contact the Microsoft Dynamics AX administrator.

824. On the Ready to install page, review the summary of roles for your computer. To proceed, click Next.

825. On the Installing page, you can monitor installation progress as Setup proceeds.

826. On the Completing Microsoft Dynamics AX Setup page, you can review the summary of roles for your computer. To exit the Microsoft Dynamics AX Setup wizard, click Finish.

Next steps

After you have installed, to finish setting up your Enterprise Portal, you must also:

· Configure Enterprise Portal. For details, see Configuring Enterprise Portal.

· Deploy Enterprise Portal. For details, see Deploy Enterprise Portal.

· Create an Enterprise Portal site. For details, see Create an Enterprise Portal site.

Set up an Enterprise Portal server farm

If your customer has many internal and external users that need access to Enterprise Portal, they may need to have Enterprise Portal installed on a server farm.

Enterprise Portal runs on any supported SharePoint Services server farm configuration. To install an Enterprise Portal on a server farm, complete the following steps.

827. Install and deploy Enterprise Portal on each server in the farm.
For details, see Set up an Enterprise Portal server.

828. Using the virtual server name, create the Enterprise Portal site on one of the machines.

The following illustration provides an example of where to place the Enterprise Portal components.

[image: image94.png]



Enterprise Portal server farm

For more information, see the Windows SharePoint Services Administration Guide.

Install Windows SharePoint Services, version 2 (SP2)

This topic provides basic instructions for deploying Microsoft Windows SharePoint Services (WSS) on a single server. For more detailed instructions for deploying Windows SharePoint Services in other configurations, see the Deployment Scenarios section of the SharePoint technologies documentation on TechNet.

Configure a server as a Web server

Internet Information Services (IIS) is not enabled by default in Microsoft Windows Server 2003. To configure your front-end server as a Web server, you must enable IIS.

829. Click Start > All Programs > Administrative Tools > Manage Your Server.
830. Click Add or remove a role.

831. On the Preliminary Steps page of the Configure Your Server Wizard, click Next.

832. On the Server Role page, click Application server (IIS, ASP.NET), and then click Next.

833. On the Web Application Server Options page, accept the default of ASP.Net, and then click Next.

834. On the Summary of Selections page, click Next.

835. Click Finish.

836. Click Start > All Programs > Administrative Tools > Internet Information Services (IIS) Manager.

837. In Internet Information Services Manager, click the plus sign (+) next to the server name, right-click the Web Sites folder, and then select Properties.

838. On the Service tab, clear the Run WWW service in IIS 5.0 isolation mode check box, and then click OK.

Note   This check box is selected only if you have upgraded to IIS 6.0 on Windows Server 2003 from IIS 5.0 on Windows 2000. New installations of IIS 6.0 use IIS 6.0 worker process isolation mode by default.

Install Windows SharePoint Services to Use SQL Server

Before you install Windows SharePoint Services 2.0, you must ensure that either SQL Server 2000 with Service Pack 4 or later or SQL Server 2005 is installed and that it is ready to host Windows SharePoint Services data. You can install Enterprise Portal on a server running WSS on the Microsoft Data Engine (MSDE); however, Enterprise Portal will not support search.

Note   You must use MSDE for WSS on systems that use an Oracle database for Microsoft Dynamics AX. 

If you want to use Windows SharePoint Services with SQL Server 2000 on the same computer, you must take specific steps to configure your server computer before, during, and after installing Windows SharePoint Services. This section describes the steps needed to configure a single server running both Windows SharePoint Services and SQL Server 2000. This topic does not cover using a remote SQL Server computer. 

Prepare SQL Server

You must configure your SQL Server installation to work with Windows SharePoint Services. The SQL Server database must use Windows authentication so that Windows SharePoint Services can connect to it. 

SQL Server 2005

839. Open Microsoft SQL Server Management Studio (click Start > All Programs > Microsoft SQL Server 2005 > Microsoft SQL Server Management Studio).
840. Right-click the SQL Server and click Properties.

841. Click Security.

842. Under Server Authentication, click Windows Authentication Mode.

843. Click OK. 

SQL Server 2000 with Service Pack 4

844. On your server computer, open Enterprise Manager (click Start > All Programs > SQL Server > Enterprise Manager).
845. In Enterprise Manager, click the plus sign (+) next to Microsoft SQL Servers.

846. Click the plus sign (+) next to SQL Server Group.

847. Right-click the SQL Server name, and then click Properties.

848. On the Security tab, in the Authentication section, select Windows only, and then click OK. 

Run Windows SharePoint Services 2.0 Setup

849. Download STSV2.exe to your computer.
You can download STSV2.exe from the Microsoft Windows Update Web site.

850. Run STSV2.exe to extract the installation files.

851. When the Windows SharePoint Services installation starts, on the Type of Installation page, click Server Farm, and then click Next.

852. On the Summary page, verify that only Windows SharePoint Services will be installed, and then click Install.

Setup runs and installs Windows SharePoint Services 2.0.

Configure the administrative virtual server

After the Setup process is complete, you can configure your administrative virtual server (including specifying an application pool to use for the virtual server processes), connect to SQL Server, and then configure your virtual servers with Windows SharePoint Services. You perform these steps by using HTML Administration pages.

853. To configure an installation of Windows SharePoint Services, use SharePoint Central Administration, available from Start > All Programs > Administrative tools > SharePoint Central Administration.
854. On the Configure Admin Virtual Server page, in the Application Pool section, select Create a new application pool.

Note   You can also use an existing application pool, but any Web application that is using the same application pool can modify the Windows SharePoint Services databases. This is a potential security risk.

855. Type the name to use for the new application pool, and then specify a security account for the application pool.

856. Select Configurable, and then type the user name and password to use. 

Often, the account used is that of the person installing, who must be a member of the Administrators group on the local computer and in Microsoft Dynamics AX. 

857. Click OK.

858. Optional. The account you use must have rights to create databases in SQL Server. In other words, this account must be a member of the Security Administrators, Process Administrators, and Database Creators roles in SQL Server. If the account does not have those rights, set them now.

ac. On your server computer, open Enterprise Manager (click Start > All Programs > SQL Server > Enterprise Manager).
ad. In Enterprise Manager, click the plus sign (+) next to Microsoft SQL Servers, click the plus sign (+) next to SQL Server Group, and then click the plus sign (+) next to your SQL Server computer.

ae. Click the plus sign (+) next to Security, right-click Logins, and then click New Login.

af. In the Name box, type the account used by administrative application pool in the form DOMAIN\name.

ag. On the Server Roles tab, in the Server Role list, select the Security Administrators, Process Administrators, and Database Creators check boxes, and then click OK. 

859. Restart Internet Information Services (IIS) by typing iisreset on the command line. 

860. After IIS has restarted, click the link on the Application Pool Changed page to continue configuring Windows SharePoint Services to work with SQL Server.

861. On the Set Configuration Database Server page, in the Configuration Database section, enter the server name and database name to use.

862. Under Database connection type, select Use Windows integrated authentication.

863. Click OK. 

Extend the virtual server

After you set up the connection to SQL Server, you are ready to extend your virtual servers with Windows SharePoint Services. When you extend a virtual server, Windows SharePoint Services is applied to a virtual server and a top-level Web site is created. To extend a virtual server, you use HTML Administration pages.

864. On the SharePoint Central Administration page, click Extend or upgrade virtual server.
865. On the Virtual Server List page, click the name of the virtual server to extend.

866. On the Extend Virtual Server page, in the Provisioning Options section, select Extend and create a content database.

867. In the Application Pool section, select Create a new application pool, and then enter the new application pool name, and specify the Business Connector Proxy user name, and password.

Note   It is recommended that you create a new application pool for each virtual server, so that they run in separate processes. 

868. In the Site Owner section, in the Account name box, type the user name for the site owner (in the format DOMAIN\username if the user name is part of a Windows domain group).

869. In the E-mail address box, type the e-mail address that corresponds to the account.

870. In the Database Information section, select the Use default content database server check box or type the database server name and database name to use for a new content database.

871. If you want to specify a path for the URL, in the Custom URL path box, type the path to use.

Note   If you are using quotas, you can also specify the quota template to apply in the Quota Settings section.

872. In the Site Language section, select the language to use.
873. Click OK.

After a few moments, the virtual server is extended and a confirmation page is displayed. You can open the home page for your new Web site in your browser by using a link on the confirmation page. You can continue to extend other virtual servers or configure Self-Service Site Creation so users can create their own sites. 

Configuring Enterprise Portal

After you have installed Enterprise Portal, you must configure it. The following settings must be defined before you deploy Enterprise Portal:

· Business Connector Proxy

· Enterprise Portal user groups

You can configure the following settings before or after deploying:

· Document management.  Configure which document types are associated with different modules in Enterprise Portal, and how long they appear on Enterprise Portal.

· Transaction summaries.  Specify a schedule for generating the transaction summaries that are displayed on Enterprise Portal.

· Product groups.  To present products from the inventory table on Enterprise Portal, organize and filter them using product groups.

· Enterprise Portal parameters.  Set category browsing, encryption settings, image handling, document management, e-mail setup, defaults for new users, and the number sequences to use for sales baskets.

· Search.  Set up the search feature on Enterprise Portal so that users can search for Microsoft Dynamics AX records as well as documents and list items which are stored in Windows SharePoint Services.

· Other functionality that can be published to Enterprise Portal, including questionnaires, recruitment projects, and courses.

You can use the Configuration wizard to configure the Business Connector Proxy, user groups, document management, and transaction summaries quickly. 

This section includes the following sections and topics:

	Topic
	Description

	Configure Enterprise Portal using the Configuration Wizard
	This topic describes how to use the Enterprise Portal Configuration Wizard to set up the Business Connector Proxy, Enterprise Portal user groups, document management, and the generation of transaction summaries. 

	Managing documents on the Enterprise Portal
	This topic describes how to set the time period a document appears on an Enterprise Portal list after being updated. . 

	Set up transaction summaries for Enterprise Portal
	This topic describes how to set up the generation of transaction summaries that appear on Enterprise Portal.

	Set up product group and item presentations
	This topic describes how to set up which product groups and items can be displayed on an Enterprise Portal site. 

	Set Enterprise Portal parameters
	This topic describes how to set the parameters for Enterprise Portal, including category browsing, encryption settings, image handling, document management, e-mail setup, defaults for new users, and the number sequences to use for sales baskets.

	Set up search for Enterprise Portal
	This topic describes how to set up search for Enterprise Portal. 

	Configuring functionality that can be published to Enterprise Portal
	This topic describes the functionality that you may want to configure before publishing to Enterprise Portal, including questionnaires, recruitment projects, and courses.


Configure Enterprise Portal using the Configuration Wizard

The Configuration wizard helps you set up the Business Connector proxy, the default user groups, document management, and transaction summary parameters for Enterprise Portal. You can also use individual dialog boxes to configure Enterprise Portal.

You must configure Enterprise Portal before you deploy Enterprise Portal, add users to Enterprise Portal user groups, or associate users with Web sites.

874. From a Microsoft Dynamics AX Client, click Administration > Setup > Internet > Enterprise Portal > Configuration wizard.
875. On the Welcome to the Enterprise Portal Configuration Wizard page of the Enterprise Portal Configuration Wizard, click Next > to continue.

876. On the Configure user groups page, specify the user groups that you want to use to enforce security and permissions within the Enterprise Portal. 

Note   If you are running on Windows SharePoint Services (version 2), (SP2), you must specify user groups. User groups are optional if you are running on Windows SharePoint Services (version 3), Beta 2 or Microsoft Office SharePoint Server 2007, Beta 2.
The list of Enterprise Portal user groups is based on the available licenses.

You can use the default user groups listed, press CTRL+N to add user groups to the list, or delete groups. 

Note   Although this wizard sets up the default user groups for Enterprise Portal, you need to add users to these groups after you complete this wizard. For more information, see Set up Web users.

877. On the Configure the Business Connector Proxy page, enter the domain account to use for the Business Connector proxy.

878. On the Map document types to document categories page, select a document category for each document type in the list, and then click Next >.

879. On the Configure module document categories page, right-click each module that you want to add a category to, click New category, and select a category. Click Next > to continue.

880. On the Configure document management page, type the number of days that documents should be included in the list of latest documents. Click Next > to continue.

881. On the Configure transaction summaries  page, specify a schedule for generating the transaction summaries that are displayed on Enterprise Portal. Enter the starting time for the transaction summary to be performed and the total number of times to perform the transaction summary. To run this transaction summary for a specific batch group, select it from the list. Select item designating whether to perform the batch process at daily or hourly intervals. Click Next > to continue.

882. To save your settings and exit the Enterprise Portal Configuration Wizard, click Finish. 

Configure document management for Enterprise Portal

Enterprise Portal integrates Microsoft Dynamics AX document management functionality with the Microsoft SharePoint user interface. Therefore, users can accomplish many of the same document management tasks from Enterprise Portal that they can accomplish from the Document handling form in the Microsoft Dynamics AX client application.

For example, users can accomplish the following tasks from Enterprise Portal:

· Add or delete a document (note or file) from an Microsoft Dynamics AX record.

· View or edit the properties of a document that is attached to an Microsoft Dynamics AX record.

· Open a document that is attached to an Microsoft Dynamics AX record.

· View a list of all documents for single record or a specific record type.

· View a list of the latest documents for a single record or a list of Microsoft Dynamics AX records.

Specify which documents to include in the list of latest documents

Administrators can specify the number of days that new documents will be shown in the list of latest documents on Enterprise Portal. 

883. From an Microsoft Dynamics AX client, click Administration > Setup > Internet > Enterprise Portal > Parameters.
884. Click the Documents tab.

885. In the Number of days field, type the number of days that you want new documents to be included in the list of latest documents. 

Note   Administrators can also change this setting from within Enterprise Portal by using the SharePoint interface.

Configure document types and categories

You can use the Configuration wizard to determine which document types are associated with document categories in Enterprise Portal, and map document categories to specific modules.

886. From a Microsoft Dynamics AX Client, click Administration > Setup > Internet > Enterprise Portal > Configuration wizard.
887. On the Welcome to the Enterprise Portal Configuration Wizard page of the Enterprise Portal Configuration Wizard, click Next > to continue.

888. On the Map document types to document categories page, select a document category for each document type in the list, and then click Next >.

889. On the Configure module document categories page, right-click each module that you want to add a category to, click New category, and select a category. Click Next > to continue.

Set up transaction summaries for Enterprise Portal

You must configure the transaction summary batch job to display any of the following transaction summaries in Web parts on Enterprise Portal:

· Purchase totals including quantity, amount, weight and volume

· Customer balances

· Inventory on hand

· Vendor balances.

Setting up a transaction summary batch job requires that you: 

· Create a batch group - batch groups enable you to add a group of batch jobs to the processing list at the same time.

· Associate the transaction summary batch job with a batch group, and configure the frequency with which the batch job is processed. 

· Add the batch group to the processing list.

Optional. Set up a batch group

Batch groups enable you to add a group of batch jobs to the processing list at the same time. 

890. In a Microsoft Dynamics AX client, open Basic > Setup > Batch > Batch groups dialog box. 
891. Press CTRL+N to create a new batch group, and then close the dialog box. 

Configure transaction summaries

You can use the Transaction summary form to set the frequency with which transaction summaries are generated. 

Note   You can also configure transaction summaries by using the Enterprise Portal Configuration Wizard. For details, see Configure Enterprise Portal using the Configuration Wizard.

892. Open the Administration > Setup > Internet > Enterprise Portal > Transaction summary dialog box.
893. Associate the transaction summary to a group from the Batch group list.

894. Select the Batch processing check box to run the job as a batch without being associated with a batch group.

895. Click Recurrence to set the frequency with which the transaction summary is run.

896. Click OK to close the dialog box. An Infolog appears that the Transaction summary job has been added to the batch queue.

Start batch processing

897. Open the open Basic > Periodic > Batch > Processing dialog box.
898. In the Group list, select the batch group you have associated with the transaction summary job, and then click OK.

The job starts processing on the schedule you defined.

Administer product groups

The products that reside in the inventory table must be organized and filtered in a way that is suitable for presentation on the Enterprise Portal. This is done in product groups in Microsoft Dynamics AX. The product groups are organized in a tree structure with two possible node types: 

· Group node - Used to hold item nodes and group nodes on a lower level in the product group hierarchy. 

· Item node - Used to hold the selected product items from your inventory. 

To set up product groups 

899. From a Microsoft Dynamics AX Client, click Administration > Setup > Internet > Enterprise Portal > Product groups.
900. To create a new product group, on the File menu click New (or activate the upper window and press CTRL+N). Then:

ah. In the Product group field, enter an identifier for the product group. 
ai. In the Name field, enter a descriptive name for the product group. 

aj. In the Type list, select Group node or Item node. 

· The Top node field indicates whether the product group is the top node in the hierarchy. If it is a top node, it is marked with a green check mark.

· The Selection field indicates whether a selection is made by using the Query tool (available only when the selected type is Item node). 

901. To create more product groups, repeat step 2. 

902. To add component groups to the Group node, press CTRL+N and select the product group that you want to include.

Important   Component groups can be added to the lower pane only if Group node is selected in the Typelist for the product group that is selected in the upper pane. Component groups that are added in the lower pane must be available as product groups in the upper pane; the list of available component groups consists of the product groups in the upper pane.

903. If the selected product group in the upper pane is of the type Item node, click Select items to open the Item selection form.

This option can be selected only if Item node is selected in the Type list for the selected product group. 

904. In the Item selection form, click Select and select the items that you want to allocate to the selected Item node. Click OK to return to the Item selection form. 

905. In the Selection form, click OKto finish selecting items.

906. To create more product groups of the type Item node, repeat from step 5. When you have created all the necessary product groups, assign each item node to a group node.

Set Enterprise Portal parameters

When you first set up and configure Enterprise Portal using the Configuration Wizard, you have the option to set Enterprise Portal parameters. These parameters specify the following:

· Encryptions settings

· Image sizing

· Document categories and modules

· The administrator's e-mail interface

· Number sequences for items displayed on the portal

You can change parameters at any time, but be aware that these changes can affect all portal pages and temporarily disrupt user connectivity to a portal page.
To set Enterprise Portal parameters

907. From a Microsoft Dynamics AX client, click Administration > Setup > Internet > Enterprise Portal > Parameters.
908. Select the desired parameters. For a description of the fields and options on this form, see the Enterprise Portal parameters (form) topic.

909. Click OK.

Set up search for Enterprise Portal

By using the Search feature on the Enterprise Portal, users can search for Microsoft Dynamics AX records as well as documents and list items that are stored in Windows SharePoint Services, including announcements and discussions. 

To enable search for both Microsoft Dynamics AX and Microsoft Windows SharePoint documents, make sure that:

· The Microsoft Dynamics AX search indexes are configured and enabled.

· Search is enabled for Microsoft SQL Server and Microsoft Windows SharePoint Services.

If both of these steps are not completed, you get mixed results. For example, if you enable search for SQL Server and Windows SharePoint Services but you do not set up the Microsoft Dynamics AX search indexes, then Enterprise Portal users are able to search for SharePoint documents but not for records stored in Microsoft Dynamics AX.

Set up the search indexes

To set up search indexes for the Enterprise Portal, you must use the Microsoft Dynamics AX data crawler setup. The following two procedures describe how to set up the data crawler manually.

Note   The resulting search index is company account specific. This means that the index of the tables and fields is available only within the company account where the index was created. If two Web sites are running on different company accounts, tables must be indexed for both Web sites. For each company account, a data crawler must be started to perform the index.

Select the tables and fields to include in the search index

910. From a Microsoft Dynamics AX client, click Basic > Setup > Data Crawler > Table setup.
911. Add a new table from the list of tables. 

912. Select a table in the list and click the Text index tab.

913. To enable text index, select the Enable text index check box. 

914. Select the fields to be indexed from the Text index pane, and click the less than (<) button to add the fields to the Other fields pane. 

915. Close the form to save changes.

Start the data crawler to create the search index

916. From a Microsoft Dynamics AX client, click Basic > Setup > Data Crawler tab, select a company account. 
The Overview tab provides the status for the data crawlers that have been created for different company accounts.

917. Click the Crawler tab. 

918. If the status is Stopped, select a crawler speed and click Start crawler to start the data crawler for the selected company account. 

Enable search for SQL Server and Windows SharePoint Services

In order to make search available to users on your Enterprise Portal site, you must enable full-text indexing for the SQL server that hosts the Windows SharePoint Services database that is used by the Enterprise Portal.

To enable search for Microsoft SQL Server 2000, you must install the full-text searching feature for SQL Server 2000 and then enable search in Windows SharePoint Services. 

Aside from enabling and disabling full-text search, any search management or monitoring must be done from within SQL Server 2000 with the SQL Server administration tools.

Note   SQL Server 2000 full-text searching supports only one language for each database. If you are supporting Windows SharePoint Services Web sites in several languages and you want to enable full-text searching in those languages, consider hosting each language on a separate virtual server with a separate database per language.

Enable search for SQL Server 2000

919. On your SQL Server computer, run the SQL Server 2000 Setup program. 
920. On the setup screen, click SQL Server 2000 Components, and then click Install Database Server.

The SQL Server 2000 Installation Wizard opens.

921. On the Welcome screen, click Next. 

922. On the Computer Name screen, select the computer type, and then click Next. 

923. On the Installation Selection panel, select Upgrade, remove, or add components to an existing instance of SQL Server, and then click Next. 

924. On the Instance Name panel, clear the Default check box, and then in the Instance Name box, select your SQL Server instance for Windows SharePoint Services and click Next. 

925. Select Add components to your existing installation, and then click Next. 

926. On the Select Components panel, in the Sub-Components list, select Full-Text Search, and then click Next. 

927. Click Next again to begin the installation. 

928. Click Finish. 

Enable search for Windows SharePoint Services

After you have configured SQL Server 2000 to support full-text searching, you are ready to enable search for Windows SharePoint Services.

929. On your server computer running Windows SharePoint Services, click Start, point to All Programs, point to Administrative Tools, and then click SharePoint Central Administration.
930. Under Component Configuration, click Configure full-text search.

931. In the Search Settings section, select the Enable full-text search and index component check box.

932. Click OK.

Configuring functionality that can be published to Enterprise Portal

Without programming in the Application Object Tree (AOT), you can publish the following functionality of Microsoft Dynamics AX to an Enterprise Portal:

· Questionnaires - For details about setting up and configuring questionnaires to be published on Enterprise Portal, see About distributing questionnaires.

· Recruitment projects - For details about setting up and configuring recruitment projects to be published on Enterprise Portal, see About recruitment projects.

· Courses - For details about setting up and configuring course catalogs to be published on Enterprise Portal, see About courses.

Deploy Enterprise Portal

After you have configured Enterprise Portal, you must deploy it to a Web server. You can launch Enterprise Portal's deployment wizard from the Enterprise Portal Configuration Wizard, or from the menu.

933. From the Microsoft Dynamics AX client on an Enterprise Portal computer, click Administration > Setup > Internet > Enterprise Portal > Manage deployments. 
934. The Enterprise Portal Deployment Wizard opens. Click Next. 

If you have previously deployed Enterprise Portal, the Manage Enterprise Portal deployments dialog box opens. 

935. On the Choose deployment options page, in the IIS virtual server list, select the virtual server that you want to deploy Enterprise Portal to. 

936. Under Deployment option, select Full (Web parts and site templates) and then click Next. 

937. Internet Information Services (IIS) must be restarted before you can create a Web site. 

To have the wizard automatically restart IIS, select Restart IIS when I close the wizard. You can also have the wizard start the SharePoint New Site Wizard after IIS restarts. 

Create an Enterprise Portal site

You can create an Enterprise Portal Web site through Microsoft Windows SharePoint Services.

938. On the SharePoint site you would like to add Microsoft Dynamics AX as a subsite of, click Site Settings.
939. Under Administration, click Manage sites and workspaces.

940. On the Manage Sites and Workspaces page, click Create.

941. On the New SharePoint Site page, in the Title and Description section, type the title and description for the new subsite.

942. In the URL name box, type the URL for your subsite.

943. In the User Permissions section, if you are running on Windows SharePoint Services (version 2), (SP2), select Unique Permissions. If you are running on Windows SharePoint Services (version 3), Beta 2, or Microsoft Office SharePoint Server 2007, Beta2, you may use any method of managing permissions.

944. In the Language section, select the language to use.

945. Click Create.

946. On the Template Selection page, select one of the following options, and then click OK.

	Option
	Description

	Microsoft Dynamics Enterprise Portal
	Choose this option to create personalized, role-based Web portals so that specific customers, vendors, business partners, and employees can access business information and conduct transactions. 

Note   All members of Enterprise Portal must be validated through Active Directory directory service.

	Microsoft Dynamics Public
	Choose this option to create Web sites for customers and prospective customers. You can publish relevant product and campaign information from Microsoft Dynamics AX, or create surveys that store data in Microsoft Dynamics AX. Customer Web allows anonymous access to the site by default.


947. On the Register Site page, select a company to associate the site with, and then click Register.
948. After registering, you must then set up user relations in Microsoft Dynamics AX. For details, see Granting users access to Enterprise Portal.

Managing Enterprise Portal users

The Web-based Enterprise Portal is geared toward, but not limited to, the less-frequent user (internal or external partner) who needs a specialized subset of the application functionality and data that resides in Microsoft Dynamics AX. They may be internal employees accessing Microsoft Dynamics AX data from a remote location, or they may be external customers ordering a product from your company Web site.

Any user who needs to have access to Microsoft Dynamics AX data from your Enterprise Portal Web site must be set up as a Web user. Other anonymous users, who merely want to browse your product catalog or sign up to become customers, can use the Guest user account.

About Enterprise Portal roles and user groups

The Enterprise Portal for Microsoft Dynamics AX is a role-based application, meaning that the collection of content available to a user on the Enterprise Portal site varies according to the user's job function. 

As an administrator, once you identify which role (or roles) a user needs to have on the Enterprise Portal site, the role indicates the set of user groups to which that user needs to be assigned in order to access the appropriate content on the Enterprise Portal site. 

Roles and corresponding user groups

The following table introduces the Enterprise Portal roles and lists the predefined user groups that correspond to each role. The user groups listed here are created by default when you configure the Enterprise Portal. However, you can also create your own roles by creating additional user groups and combinations of user groups. 

	Role Name
	Description
	User Groups

	Employee
	Internal role assigned to all employees. Can be extended with other internal roles. The employee role gives access to the functionality included in the employee self-service Web application.
	EP_Empl 

EP_Int

	Sales
	Internal role assigned in addition to the employee role. The sales representative role gives access to all sales-related functionality such as Sales order, Customers, and sales-related reports.
	EP_Empl 

EP_Int 

EP_Sales

	Consultant
	Internal role assigned in addition to the employee role. The consultant role gives access to the functionality in the projects module such as hour registration.
	EP_Empl 

EP_Cons 

EP_Int

	Vendor
	External role giving access to the Vendor Self Service Web application.
	EP_Vendor 

EP_Ext

	Customer
	External role giving access to the Customer Self-Service Web application.
	EP_Cust 

EP_Ext

	Guest
	External role giving access to view the product catalog and sign up to become customers. The guest role allows anonymous Web users to log onto the Enterprise Portal customer site with limited functionality. 
	EP_Cust 

EP_Ext 

(The same user groups as the customer role)

	Administrator
	Internal role assigned to the individuals who will be configuring and administering Microsoft Dynamics AX. It is important to restrict the number of Microsoft Dynamics AX users who are members of the Administrator group.
	EP_Admin 

EP_Empl 

EP_int


Note   Users can be assigned to more than one role, in which case, they must be assigned to the corresponding user groups for both roles. It is not possible to assign users to both internal and external roles.

Employee role

By default, the functionality available to the Employee role is very limited. However, it is possible to add additional functionality to the employee role.

Users who are assigned the Employee role can:  

· Look up contact information about their colleagues.  

· Complete and analyze questionnaires.

· View and delete their alerts, and view and disable their alert rules.

Sales role

Users who are assigned to the Sales role can perform tasks within these areas: 

· Quotation: create, edit, accept, and send (mail/letter).

· Sales order: create, edit, and send (mail/letter).

· Customer: create and edit.

· Credit note: create, update, and send (mail/letter).

· Contact person: create, edit and delete.

· Prices: update price and discount.

· Product information: send (mail/letter).

· Questionnaire: complete and analyze.

· Alerts: View and delete their alerts, and view and disable their alert rules.

Users who are assigned to the Sales role can view and create the following reports: 

· Sales by week, month, quarter and year (current year and the year before) (list and graph) 

· Sales by region 

· Sales by customer 

· Price list by customer 

· Sales price list by customer (all customers/by customer) 

· Customer turnover 

· Sales by person 

· Pricelist 

· Sales prices 

· Price/Discount list 

· Top 100 (by revenue and margin) 

· Blanket orders 

· Sales forecast per item (all customers/by customer) 

Consultant role

Users who are assigned to the Consultant role can: 

· Register hours on projects.

· Browse invoices and invoice proposals.

· Browse hour, cost, revenue, item, and on-account transactions.

· View and create reports for total of hours per project.

· View and create reports for hours per journal.

· Complete and analyze questionnaires.

· View and delete their alerts, and view and disable their alert rules.

Vendor role

Users who are assigned to the Vendor role can: 

· Change their address, telephone number, www address, telex, fax, language, and e-mail. Some fields, such as account number, currency, balance, and balance in currency, are view-only fields. 

· Set up and change contact person (Title, name, phone extension, phone, mobile phone, pager, e-mail and personal address information). 

· View purchase orders (header and lines). 

· View items (view-only mode). 

· View journals (purchase order, packing slip, and invoice). 

· Update prices and discounts. 

· View delivery due date. 

· View supply performance. 

· View supply capacity. 

· Complete questionnaires.

Customer role

Users who are assigned to the Customer role can: 

· Browse the product catalog. 

· Add items to the shopping basket. 

· Create orders online. 

· Add items to the shopping basket without ordering and then return to the shopping module at a later time and then finish the order. 

· Complete questionnaires.

Guest role

Users who are assigned to the Guest role can: 

· Browse the product catalog, but they cannot order. 

· Create a registration request to become a customer. 

Note    For more information about the Guest user account and the Guest user group, see Set up the guest account for anonymous Web access.

Administrator role

Users who are assigned to the Administrator role can:

· Manage Web users.

· Control some of the parameters for Users, General, Accounts receivable, Inventory, and Customer Self-Service.

· Control setup parameters such as Style sheet and Language.

· Refresh the Microsoft Dynamics AX data from within the Web interface.

For more information about creating members in the Administrators group, see Manage user groups. 

Important   Restrict the number of Microsoft Dynamics AX users who are members of the Administrators group. If a regular Microsoft Dynamics AX user is made a member of the Administrators group, that user can potentially view reports or data they should not be allowed to see. Ideally, only those individuals who will be configuring and administering Microsoft Dynamics AX should be members of the Administrators group. 

Create a public Enterprise Portal site for guest accessEnterprise Portal site for guest access

Microsoft Dynamics AX creates a Guest user account during installation. The Guest user account allows anonymous Web users to log onto the Enterprise Portal customer site with limited access. Web users who log on with the Guest account can view the product catalog and sign up to become customers, but they cannot add items to the sales basket. All anonymous Web users connect to Enterprise Portal using the same Guest user account.

Create the public Web site

949. From a Microsoft Dynamics AX client, open the Web sites form (Administration> Setup > Internet > Enterprise Portal > Web sites).
950. Click Create site.

951. Click the virtual server (for example, Default Web site).

952. Select the Create site under this URL option.

953. Enter the information and click OK.

954. Click the URL.

955. On the Template Selection page, click Microsoft Dynamics Public.

956. On the Register Site page, select a company to associate the site with, and then click Register.

Configure IIS for guest access

957. Open Internet Information Services (IIS) (Start > Administrative Tools > Internet Information Services Manager).
958. Right-click the Web sites directory and click Properties.

959. Click the Directory Security tab.

960. In the Authentication and access control section, click Edit.

961. If it is not already selected, select Enable anonymous access. Do not change the user name or password associated with this account.

962. Select Integrated Windows authentication.

963. Click OK.

964. Accept the changes for all Web sites.

965. Click the Home Directory tab.

966. Verify that the Execute permissions list box is set to Scripts only.

967. Note the name of the application pool servicing this site because you must configure the application pool for guest access.

968. Click OK.

969. Expand the Application Pools directory.

970. Right-click the application pool servicing the public site and click Properties.

971. Click the Identity tab.

972. Select Configurable.

973. Enter the credentials for the Business Connector proxy account. The proxy account must be an active account in Microsoft Active Directory directory services. To view the name of the proxy account as it is stored in Microsoft Dynamics AX, open the Business Connector Proxy form (Administration > Setup > Security).

Configure your Enterprise Portal site for guest access

974. Open your Enterprise Portal home page. (By default, the URL is http://servername/sites/site_name/default.aspx).
975. Click Site Settings.

976. Click Go to Site Administration.

977. Click Manage anonymous access.

978. Click Entire Web site and click OK.

979. Open your Enterprise Portal home page. The site should contain only a few standard images and a Sign-in button.

Enable the Guest user account

By default, the Guest user account is disabled. Administrators must enable the Guest account in order for anonymous users to have access to the Enterprise Portal customer site.

980. From a Microsoft Dynamics AX client, click Administration > Users.
981. On the Overview tab, select the Guest user account.

982. Select the Enabled check box.

983. Close the form to save changes.

Create a Guest user group

984. From a Microsoft Dynamics AX client, click Administration > Setup > User groups.
985. On the Groups tab, create a new group.

986. Enter an identification in the Group column (required). For example, Guest.

987. Enter a name in the User group name column (required). For example, Guest.

988. Click the Users tab.

989. Select the Guest user account in the Remaining users list box and click the left-arrow button (<) to move the account into the Selected users list box. 

990. Press CTRL+S to save changes.

Assign permissions to the Guest user group

By default, no permissions are set for the Guest user group, which means the Guest user cannot access any area of Microsoft Dynamics AX. Administrators must set the appropriate permissions to enable members of the Guest user group to access each functional area on the Enterprise Portal customer site.

Assign Guest permissions for each functional area

991. From a Microsoft Dynamics AX client, click Administration > Setup > Security > User group permissions.
992. On the Overview tab, select the Guest user group and then select a domain.

993. Click the Permissions tab.

994. In the Viewing drop-down list, select Security (incl. Web).

995. In the list box, select the item(s) for which you want to set permissions. Refer to the following tables to identify which permissions must be set to enable access to each functional area of the Enterprise Portal site.

996. Under Access, select a permissions level. After you select a permissions level, the selected item shows a check mark to indicate that permissions have been set.

997. Click the Cascade button to ensure all dependent keys are set and to inherit this permission level to all child tables, forms, and nodes.

998. Press CTRL+S to save changes.

Accounts Receivable

Location in Permissions tree: Accounts Receivable | Tables

	Item
	Permission

	Customers (CustTable)
	View

	Sales basket lines (SalesBasketLine)
	View

	Sign up requests (ECPCustSignUp)
	Create


Applicant

Location in Permissions tree: Applicant | Miscellaneous

	Item
	Permission

	"Available position", HRMEPRecruitingJobAdInfoPublic (2nd item in list)
	View

	"Your application is registered", HRMEPRecruitingJobApplyConfirmPublic (4th item in list)
	View

	Available position

HRMEPRecruitingJobAdInfo (5th item in list)
	View

	Your application is registered

HRMEPRecruitingJobApplyConfirm (6th item in list)
	View


Location in Permissions tree: Applicant | Information

	Item
	Permission

	Job ads (2nd item in list)

(HRMEPRecruitingJobAdListPublic)
	View

	Job ads (4th item in list)

(HRMEPRecruitingJobAdListPublic)
	View


Location in Permissions tree: Applicant | Tasks

	Item
	Permission

	Apply for Job (2nd item in list)

(HRMEPRecruitingJobApplyPublic)
	View

	Apply for Job (4th item in list)

(HRMEPRecruitingJobApplyPublic)
	Create

	Unsolicited application (6th item in list)

(HRMEPRecruitingJobApplyUnsolictedPublic)
	View


Basic

Location in Permissions tree: Basic | Tables
	Item
	Permission

	Inventory Dimensions (InventDim)
	View


Business Connector Proxy

Location in Permissions tree: Business Connector Proxy

	Item
	Permission

	Business Connector Proxy (SysCom)

Verify that all child keys are selected and set to Full control.
	Full


Human Resources

Location in Permissions tree: Human Resources | Tables

	Item
	Permission

	Application Basket (HRMApplicationBasket)
	Create

	Job Ads (HRMRecruitingJobAd)
	View

	Recruitment Projects (HRMRecruitmentTable)
	View


Inventory Management

Location in Permissions tree: Inventory management | Tables

	Item
	Permission

	Items (InventTable)
	View

	Inventory module parameters (InventTableModule)
	View

	Presentations (ECPPresentation)
	View

	Product group items (InventProductGroupItem)
	View

	Product group structure (InventProductBroupBOM)
	View

	Product groups (InventProductGroup)
	View


Questionnaire Participant

Location in Permissions tree: Questionnaire Participant | Miscellaneous

	Item
	Permission

	"Question", KMEPQuestionnaireGotoQuestion
	View


Location in Permissions tree: Questionnaire Participant | Information

	Item
	Permission

	Cancel (KMEPQuestionnaireFormCancelPublic)
	View

	Cancel (KMEPQuestionnaireFormCancel)
	Full

	Questionnaire completed (KMEPQuestionnaireFormEndPublic)
	View

	Questionnaire completed (KMEPQuestionnaireFormEnd)
	Full


Location in Permissions tree: Questionnaire Participant | Tasks

	Item
	Permission

	Questionnaire (KMEPQuestionnaireFormPublic)
	View

	Questionnaire (KMEPQuestionnaireForm)
	Full


Customer

Location in Permissions tree: Customer | Miscellaneous

	Item
	Permission

	Activate user (ECPCustSignUpUserActivation)

Type = Web content Object Display
	Edit

	Activate user (ECPCustSignUpUserActivation)

Type = Web Menu Item URL
	View


Location in Permissions tree: Customer | Information

	Item
	Permission

	Campaign items (Type = Web Menu Item URL)

(EPCSSPromotionalItemGuest)
	View

	Campaign items (Type = Weblet)

(EPCSSPromotionalItem)
	View

	Item description (Type = Web Menu Item URL)

(EPCSSItemDescription)
	View

	Item description (Type = Web Content Object Display)

(EPCSSItemDescription)
	View

	Product catalog group (WebProductCatalogGroup)
	View

	Product catalog group (WebProductCatalogGroupWeblet)
	View

	Product catalog items (WebProductCatalogItem)
	View

	Product catalog items (WebProductCatalogItemWeblet)
	View

	Product catalog (Type = Web Menu Item URL ) (EPCSSProductGroupPrintGuest)
	View

	Product catalog (Type = Weblet) (EPCSSProductGroupPrint)
	View


Location in Permissions tree: Customer | Tasks

	Item
	Permission

	Sign up (Type =Web Menu Item URL)

(EPCSSCustSignUpGuest)
	View

	Sign up (Type = Web Content Object Display) (EPCSSCustSignUpGuest)
	Create


Grant anonymous access to the document library

999. Open your Enterprise Portal home page.
1000. Click Sign-in.

1001. Click Documents and Lists.

1002. Under Document Libraries, click Enterprise Portal.

1003. Click Modify settings and columns.

1004. Under General Settings, click Change permission for this document library.

1005. Click Change anonymous access.

1006. Select View Items and click OK.

1007. Close Internet Explorer and open your Enterprise Portal home page.

Disable the Guest user account

The Guest user account allows anonymous Web users to log onto the Microsoft Dynamics AX Enterprise Portal customer site with limited functionality. The Guest account is created automatically during installation and is disabled by default.

Disable the Guest user account

1008. From an Microsoft Dynamics AX client, click Administration > Users. 
1009. On the Overview tab, select the Guest user account.

1010. Click to clear the Enabled check box.

1011. Close the form to save changes.

After the Guest user account is disabled, you can view any active Guest user sessions and terminate them.

Terminate Guest user sessions

1012. From an Microsoft Dynamics AX client, click Administration > Online users.
1013. Select the user and then click End sessions.

This disconnects the current user from the database.

1014. Close the form to save changes.

Customizing an Enterprise Portal siteEnterprise Portal siteEnterprise Portal site

The Microsoft Dynamics AX Enterprise Portal is integrated with the Microsoft Windows SharePoint Services framework. Because of this integration with SharePoint, most system administrator tasks for customizing the Enterprise Portal can be accomplished from within the browser using standard SharePoint functionality.

The topics in this section describe how to perform site customization tasks that are specific to Microsoft Dynamics AX:

· Link a Web site with the AOT for Web development
· Modify Web Part properties
· About adding Web parts to existing pages
· Use Enterprise Portal Web parts on an existing site
· Deploy changes to enterprise portal
For more information about how to customize the Enterprise Portal site in SharePoint, see Windows SharePoint Services Help.

Integration with SharePoint

Integration with the Windows SharePoint Services greatly simplifies the process of customizing Web pages on the Enterprise portal site.

· Create and modify Web pages on the Enterprise Portal site by using standard Web editing tools.  Web pages on the Enterprise Portal site are no longer created and maintained in the Microsoft Dynamics AX Application Object Tree (AOT). You can make basic customization changes from within the browser, and you can further customize a site by using a Web page editor that is compatible with Windows SharePoint Services, such as Microsoft Office FrontPage 2003.

· Add SharePoint features to your Enterprise Portal pages.  Users can easily customize your Enterprise Portal pages by adding standard SharePoint page elements such as discussion lists, announcements, and document workspaces.

· Integrate Microsoft Dynamics AX data by using Web Parts.  SharePoint Web Part Pages replace Web pages that were previously stored in the AOT. Several new Web Parts display Microsoft Dynamics AX forms, reports, and menus on the Enterprise Portal site. As an administrator, you can modify the properties for Microsoft Dynamics AX Web Parts from within the browser.

· Customize the site layout.  Themes and Cascading Style Sheets (CSS) provide options to separate the layout of the Web sites from the actual (HTML) content. This allows you to create more that one site based on the same application project. As an administrator, you can customize the styles and themes on your Enterprise Portal site to reflect the visual layout and design of your company's Web site.
Link a Web site with the AOT for Web development

You can determine which Web site is called by the Application Object Tree (AOT) for development. This setting affects which site is opened for the following things: 

· The location used to find the URL property of a Web Menu Item.

· The URL used for the Import Page command on the shortcut menu for a Web Menu Item.

· The URL used for the Deploy Page command on the shortcut menu for a Web Menu Item.

To link a Web site with the AOT: 

1015. Click Administration > Setup > Internet > Internet.
1016. Select an Enterprise Portal site from the AOT site. 

Note   Sites that only have Enterprise Portal Web parts deployed to them cannot be associated with the AOT. 

Modify Web Part properties

Enterprise Portal sites for Microsoft Dynamics AX utilize Microsoft SharePoint Web Parts to integrate Microsoft Dynamics AX data into the sites. In addition to standard SharePoint Web Parts, the Enterprise Portal includes several Web Parts that display Microsoft Dynamics AX forms, reports, and menus on the Enterprise Portal site. You can modify attributes of these Web Parts by assigning values to the Web Part properties. 

Before you modify the properties for Web Parts that display Microsoft Dynamics AX data, make sure that:

· The Enterprise Portal site has been created. 

· The Web Menu or Web Content Object that you want to modify has been defined in the Microsoft Dynamics AX Application Object Tree (AOT).

· The Web Part you want to modify has been added to the Web page on the Enterprise Portal site.

· You have permissions to update the shared Web page. 

Note   For information about how to modify standard SharePoint Web Parts, see Windows SharePoint Services Help.

Modify Web Part properties

1017. Navigate to the page on the Enterprise Portal site where the Web Part is located.
1018. Click Modify Shared Page. 

1019. Point to Modify Shared Web Parts, and select the Web Part you want to modify.

The list of properties that apply to the selected Web Part is displayed in the tool pane. These properties include all the common properties as well as any custom properties that the Web Part developer has defined for the Web Part.

Property descriptions

The Web Parts that display Microsoft Dynamics AX forms, reports, and menus on the Enterprise Portal site have common SharePoint properties as well as properties specific to Microsoft Dynamics AX. For more information about common SharePoint Web Part properties, see SharePoint Help. 

For information about properties that are specific to Microsoft Dynamics AX for the WebFormWebPart, WebReportWebPart, WebMenuWebPart, and WebMenuBoxWebPart, see Web Part Properties. For information about the properties for the GenericWebPart, see Weblets.

About adding Web Parts to existing pages

In Microsoft Windows SharePoint Services, Web Parts are the basic building blocks of a Web Part Page. These Web Parts are easy to reuse, share, and personalize by all users who have permission to access them. 

An Enterprise Portal site utilizes Web Parts to integrate Microsoft Dynamics AX data into the site. In addition to the Web Parts that are included with Windows SharePoint Services, the Enterprise Portal includes several Web Parts that display Microsoft Dynamics AX forms, reports, and menus on the Enterprise Portal site. 

Adding a Web Part for Microsoft Dynamics AX data to a page on the Enterprise Portal site involves making changes in the Microsoft Dynamics AX Application Object Tree (AOT). For more information about how to add a Web Part for Microsoft Dynamics AX data to a page on the Enterprise Portal site, see Create Web Part Pages.

Note   For information about how to add standard SharePoint Web Parts to a Web Part Page, see the Microsoft Windows SharePoint Services Help, available from the Help menu within your Enterprise Portal site.

Web Parts for Microsoft Dynamics AX

The Web Parts for Microsoft Dynamics AX include:

· Web Form - Web Part that hosts a Web form for Microsoft Dynamics AX (Web Content Item of Display type) on the Enterprise Portal site. 

· Web Report - Web Part that hosts a report or Web report for Microsoft Dynamics AX (Web Content Item of Output type) on the Enterprise Portal site. 

· Web Menu - Web Part that hosts a Microsoft Dynamics AX menu on the Enterprise Portal site. 

· Box Menu - Web Part that hosts a Microsoft Dynamics AX menu on the Enterprise Portal site. A box menu can include descriptive text for each item in the menu. 

· Generic Web Part - Web part that can host any Weblet for Microsoft Dynamics AX.

Deploy changes to Enterprise Portal Web sites

When you have made changes to Web parts, you must redeploy them to Enterprise Portal. If you have changed images, you must publish them.

Redeploy Web parts

1020. Click Administration > Setup > Internet > Enterprise Portal > Enterprise Portal.
1021. In the Virtual server URL list, select the server you want to redeploy the Web parts to, and then click Update.

Publish images

If you have changed an image file, you must publish it to each Web site.

1022. Click Administration > Setup > Internet > Enterprise Portal > Publish images.
1023. Click Publish.

Use Enterprise Portal Web parts on an existing site

To set an existing Web site to use Enterprise Portal Web parts, you must deploy the Enterprise Portal Web parts to it and register the site.

Deploy Enterprise Portal Web parts only

Note   If you have already performed a full deployment of Enterprise Portal to a Web site, you do not need to redeploy to use Web parts only. 

1024. From the Microsoft Dynamics AX client on the Enterprise Portal computer, click Administration> Setup> Internet> Manage deployments. 
The Enterprise Portal Deployment Wizard opens. 

If you have previously deployed Enterprise Portal, the Manage Enterprise Portal deployments dialog box appears—you do not need to follow the rest of this procedure.

1025. On the Choose deployment options page, in the IIS virtual server list, select the virtual server that you want to deploy Enterprise Portal to. 

1026. Under Deployment option, select Web parts only and then click Next. 

IIS must be restarted before you can create a Web site. To have the wizard automatically restart IIS, click IIS must be restarted before you can create a new Enterprise Portal site.. You can also have the wizard start the SharePoint New Site Wizard after IIS restarts. 

1027. Click Finish.

Register an existing site to use Enterprise Portal Web parts

You can associate more than one Web site with Enterprise Portal by registering each Web site. 

1028. Click Administration > Setup > Internet > Internet.
1029. Click Register Site, or press CTRL+N to create a new line, then under Internal URL enter the URL of the site you want to register.

1030. Under Type, select the type of site (Full (Web parts and site templates) or Web parts only). 

1031. Close the form. 

Manage Enterprise Portal security

Enterprise Portal enables end users to access Microsoft Dynamics AX over the Web. If you are not diligent and proactive with Enterprise Portal security, you could inadvertently allow attackers or malicious users access to Microsoft Dynamics AX. For this reason, managing Enterprise Portal security must be one of your highest priorities as an administrator for Microsoft Dynamics AX.

Before you begin

Enterprise Portal leverages the following technologies:

· Microsoft Internet Information Services (IIS) version 6.0

· Microsoft ASP.NET

· Microsoft Windows SharePoint Services

To ensure that Enterprise Portal is secure, you must first ensure that these technologies are secure. These technologies are generally secure by default, which means an administrator must grant access to the technology during initial configuration. If you did not perform the initial setup and configuration of IIS, ASP.NET, and SharePoint Services, review the security settings before configuring Enterprise Portal security.

Important   As a security best practice, always provide users and groups the least privilege necessary to do their jobs.

· Verify that your Web site in Microsoft Internet Information Services (IIS), version 6.0, is secure. For more information about IIS security, see Security in IIS 6.0 on TechNet.

· Verify that IIS is configured to use Secure Sockets Layer (SSL) encryption and Basic authentication (required for Enterprise Portal). For more information about encryption, see IIS 6.0 Encryption on TechNet.

· Verify that Microsoft ASP.NET is secure. For more information about ASP.NET security, see Overview of ASP.NET Security on TechNet.

· Verify that the ASP.NET central configuration file, Web.config, is secure at the file system level. Review NTFS permissions for the file and the C:\Inetpub\WWWroot directory to ensure the file can only be accessed by administrators.

· Verify that user groups and permissions in Microsoft Dynamics AX mirror the groups and permissions you have set up in Microsoft SharePoint Services.

Enterprise Portal permissions

Permissions and security keys determine who has access to data in Microsoft Dynamics AX and content on Enterprise Portal. Security keys are created in Application Object Tree (AOT) for Microsoft Dynamics AX and then assigned to various user groups on the User group permissions form. 

Microsoft Dynamics AX partners and developers can create many security keys for Enterprise Portal, depending on how the organization wants to control permissions. All of the Web content objects and Web menu items on Enterprise Portal should be assigned to one of the security keys created for Enterprise Portal.

After the security keys have been created and assigned to the Web menu items and Web content objects in AOT, administrators can use the User group permissions form to set permissions for the Web menu items and Web content objects.

Set Enterprise Portal permissions

1032. From a Microsoft Dynamics AX client, click Administration > Setup > Security > User group permissions.
1033. On the Overview tab, select a user group and then select a domain. 

1034. Click the Permissions tab.

1035. In the Viewing box, select Security (incl. Web).

1036. Expand the node for the security key that protects the Web content object or Web menu item for which you want to set the permissions.

The root entry for each node in the list box is a security key, followed by child security keys or end AOT elements that are protected by that security key.

1037. Select the check boxes for the Web content object and the Web menu item for which you want to set permissions.

1038. Under Access, select a permissions level. After you select a permissions level, the selected item shows a check mark to indicate permissions have been set.

1039. Click the Cascade button to ensure all dependent keys are set and to inherit this permission level to all child tables, forms, and nodes.

1040. Close the form to save changes.

Important   Make sure that you assign the same permissions to both the Web content object and the Web menu item that points to that content object.

· If access is allowed to the Web menu item only and not to the Web content object, the end users in this group see the menu item where appropriate, but the page it points to does not display the content from this Web content object.

· If access is allowed to the Web content object only and not to the Web menu item, the end users in this group can use this Web content object in their own Web part pages, but they do not have access to the Web menu item that points to the page.

Denial-of-service attacks

If you experience or want to prevent denial-of-service attacks on your Enterprise Portal, you can adjust the values of the following configuration commands in the configuration file of the Application Object Server (AOS):

· MaxConcurrentGuestSessions - This value controls the maximum number of concurrent Guest (anonymous user) sessions. The default value is 65535. By reducing this value, you can reduce the number of sessions that an attacker can hold. After setting this value, you must restart the AOS for the change to be applied.
· MaxConcurrentWebSessions - This value controls the maximum number of concurrent Enterprise Portal sessions, including Guest sessions. The default value is 65535. By reducing this value, you can reduce the number of sessions that an attacker can hold. After setting this value, you must restart the AOS for the change to be applied.

· MaxMemLoad - This value controls the maximum amount of memory usage (the maximum percentage of physical memory that is in use on the computer). The default value is 100. By reducing this value, you can reduce the number of sessions that an attacker can start. After setting this value, you must restart the AOS for the change to be applied.

For details about using MaxConcurrentGuestSessions, MaxConcurrentWebSessions, MaxMemLoad, and other configuration commands, see Configuration commands (Server).

Remove an Enterprise Portal site

To remove an Enterprise Portal site, you first delete the site in Microsoft Windows SharePoint Services, and then remove the association with the site from within the Microsoft Dynamics AX client application.

Delete the SharePoint site

To remove the SharePoint site, you must be a member of the Administrator site group for the site that you want to delete.

1041. Open the Enterprise Portal site in your Internet browser.
1042. On the top link bar, click Site Settings.

1043. In the Administration section, click Go to Site Administration.

1044. In the Management and Statistics section, click Delete this site.

1045. Click Delete to confirm.

Note   For more information about deleting a site from Microsoft Windows SharePoint Services, see Windows SharePoint Services Help.

Remove site association

1046. Click Administration > Setup > Internet > Enterprise Portal > Manage deployments.
1047. In the Virtual server URL list, select the server you want to remove Enterprise Portal from, and then click Remove.

Setting up and configuring a reporting server

A reporting server is a computer running Microsoft SQL Server 2005 Reporting Services that has been configured to connect to a Microsoft Dynamics AX database to support ad hoc reporting. Ad hoc reporting enables end users to dynamically develop and run reports. 

Note   This section does not describe how to use standard reporting. For information about standard reporting, see Set up and configure standard reporting.

End users can take advantage of ad hoc reporting after you have completed the following:

· Set up and configure SQL Server 2005 Reporting Services.

· Configure Microsoft Dynamics AX to communicate with Reporting Services.

· Generate a report model.

For an overview of:

· Installing a reporting server, see Flowchart: Installation process.

· Recommended topologies, see System topology recommendations.

· Reporting server architecture, see Microsoft Dynamics architecture.

This section includes the following topics:

	Section
	Description

	Flowchart: Configuring ad hoc reporting
	This topic describes the process of configuring ad hoc reporting.

	Install a reporting server
	This procedural topic describes how to install a reporting server. 

	Create an ad hoc report model
	This procedural topic describes how to create an ad hoc report model (view of business data).

	Reporting Services Security
	This topic describes the security system for ad hoc reporting.

	Ad hoc reporting for multiple languages and currencies
	This section describes how to set up ad hoc reporting for systems that use multiple languages.

	Report Manager
	This topic describes how to use Report Manager to administer SQL Server Reporting Services. 

	Troubleshoot ad hoc reporting problems
	This topic lists issues you may encounter with ad hoc reporting, and how to resolve them.


Flowchart: Configuring ad hoc reporting

Ad hoc reporting enables business decision makers and technical end-users to dynamically develop and run reports. Ad hoc reporting uses the powerful reporting platform of Microsoft SQL Server 2005 Enterprise Edition Reporting Services.
For detailed procedures on how to set up and configure Enterprise Portal, see Set up and configure ad hoc reporting.
Prerequisites

1048. Install and configure Internet Information Services (IIS)
1049. Install and configure SQL Server Reporting Services
1050. Install the reporting server role using Setup.exe on your Microsoft Dynamics AX DVD.

1051. Add a report server in Microsoft Dynamics AX
1052. Create a perspective

1053. Generate ad hoc report models
Flowchart

See Ad hoc reporting flowchart for print version.

The main setup forms of ad hoc reporting

Ad hoc reporting forms include the following (in order of setup).
1054. Add a report server using the Reporting Servers 
For an explanation of the fields on this form, see Reporting Services Servers (Form).

1055. Generate a report model using the Reporting Servers
For an explanation of the fields on this form, see Model Generation Options (Form).
The optional setup forms of ad hoc reporting

Additional setup forms include the following:
Set options on the Report Builder options form.
Install and configure a reporting server for ad hoc reporting

This topic describes how to install and configure Microsoft SQL Server 2005 Reporting Services and Microsoft Dynamics AX for ad hoc reporting.

Verify prerequisites

To perform the following operations, you must have the following rights or privileges:

	Rights or privileges
	Servers

	Member of Microsoft Windows Administrators group
	On the computer or computers running Microsoft SQL Server, Microsoft Dynamics AX, and Microsoft SQL Server Reporting Services 

	Member of the Microsoft Dynamics AX Administrators group
	On the computer running Microsoft Dynamics AX

	Member of the Database Owner role
	In the Microsoft Dynamics AX database.


Verify domain and domain account prerequisites

Verify the following prerequisites before installing Reporting Services or the Microsoft Dynamics AX reporting server role:

Domain prerequisites

The following must be available in the domain: 

· A core Microsoft Dynamics AX installation, including users.

This installation can be completed at the same time as the Reporting server installation or earlier.

· Active Directory configured in native mode.

Domain account prerequisites

During Setup, you must provide an existing domain account for the Microsoft Dynamics AX reporting server. The reporting server uses the domain account to connect to a SQL Server data source and retrieve data. Work with a System Administrator to have a new account created solely for use by Microsoft Dynamics AX before you install the reporting server role. We recommend that the account have a password that does not expire, and be set up as follows:

On the Microsoft Dynamics AX database computer (if a SQL Server):

· Not a member of any groups (not a member of the Users group)

· No positive privileges should be granted

· Deny log on locally 

· Deny logon through Terminal Services.

On the Reporting Services computer:

· Not a member of any groups (e.g. should not be a member of the Users group)

· No positive privileges should be granted

· Should have Deny log on through Terminal Services

· Should have Deny access to this computer through the network

· Must NOT be denied the ability to log on locally.

This account is granted read-only access to the Microsoft Dynamics AX database.

Additional requirements

SQL Server Reporting Services server requirements

	Requirements
	Comments

	SQL Server 2005 Reporting Services, Service Pack 1
	Reporting Services is a component of SQL Server 2005. For ad hoc reporting with Microsoft Dynamics AX, you must install SQL Server Reporting Services even if you are using an Oracle database or a SQL Server database.


Web server and Web browser requirements

	Requirements
	Comments

	Internet Information Services (IIS) 6.0 
	Reporting Services reports are managed and accessed using a Web browser. Reporting Services therefore requires IIS 6.0 (available in Windows Server 2003). The Reporting Services Configuration Manager simplifies the process of creating and configuring the Web site that will host reports. However, to ensure that malicious users can not access reports, it is recommended you configure the Web site to use Secure Sockets Layer (SSL) encryption. SSL encryption requires a valid SSL certificate from a certificate authority. For more information, see the IIS documentation on Technet

	Internet Explorer
	Reporting Services reports are managed and accessed using a Web browser. For this reason, all users viewing ad hoc reports require Internet Explorer 6.0, Service pack 2 or any more recent version.


Microsoft Dynamics AX requirements

	Requirements
	Comments

	License for Business Analysis in Microsoft Dynamics AX
	Ad hoc reporting requires the Business Analysis module. If your company or organization does not have a valid license for this module, you cannot access the Reporting Serversform.

To obtain a Business Analysis license, contact your Microsoft partner.


Database requirements

	Requirements
	Comments

	A supported database
	Microsoft Dynamics AX supports the following databases for ad hoc reporting: 

· SQL Server 2000, Service Pack 4, or any more recent version

· SQL Server 2005

· Oracle 10g
Note   Ad hoc reporting can consume resources such as memory and CPU on the database. For this reason, we recommend that you use a replica of the primary Microsoft Dynamics AX database for ad hoc reporting.

	Microsoft Data Access Components (MDAC) 

– and –

Oracle data provider
	Microsoft Data Access Components are installed when you install SQL Server. If these components were removed, reinstall them.

· MDAC version 2.80.1022.3 or any more recent version

– and –

· Oracle client 10.2.0.1, if Oracle database, or any more recent version

	SQL Server running under the Local System account
	During SQL Server setup, the administrator determines whether the SQL Server process runs under the Local System account or a domain user account. Verify that the SQL Server process runs under the Local System account.


SQL Server 2005 Reporting Services

SQL Server 2005 Reporting Services is a server-based reporting platform for creating reports from relational or multidimensional data sources. Reports are managed and viewed in a Web browser. Microsoft Dynamics AX uses Reporting Services to host report models and ad hoc reports. 

Note   Reporting Services is dependent on Microsoft Internet Information Services (IIS) for Web application services. Install IIS before installing Reporting Services. For more information, see the IIS documentation on Technet.

For more information about Reporting Services, see the SQL Server 2005 books online.

Install Reporting Services

Use Setup.exe on the SQL Server 2005 DVD to install Reporting Services.

Set up Reporting Services Configuration Manager

After you install Reporting Services, use the Report Server Configuration Manager (Start > All Programs > Microsoft SQL Server 2005 > Configuration Tools > Reporting Services Configuration) to configure and start Reporting Services.

Verify the following configurations in the Reporting Services Configuration manager:

	Screen
	Details

	Server Status
	If the report server is not running, click Start.

	Report server virtual directory
	Click New to create the ReportServer virtual directory on the Default Web Site. Select Require Secure Sockets Layer (SSL) connections if this site is external facing (accessible from the World Wide Web), or you wish to encrypt report server communication over your internal network. 

Note   To use SSL connections, you must install an SSL certificate on the Default Web Site. See the IIS documentation for more details.

	Report manager virtual directory
	Click New to create the Reports virtual directory on the Default Web Site. 

	Windows service identity
	Set the Windows service account to use the Local System built-in account.

	Web service identity
	Verify that the ASP.NET Service Account is set to NT Authority\NetworkService. 

Verify that the Web service identity is set to DefaultAppPool for the Report Server and the Report Manager.

	Database Setup
	1056. In the Server Name drop-down list, enter the name of the server where Reporting Services is installed (for example Report Server 1).
1057. Click New beside the Database Name drop-down list to create a new report server database. 

Note   This is a unique database. This is not your Microsoft Dynamics AX database. In the SQL Server Connection dialog box, accept the default values and click OK.

1058. In the Credentials Type drop-down list, verify that Service Credentials is selected.

1059. Click Apply.

1060. In the SQL Connection dialog box, verify that Current User-Integrated Security is selected and click OK.

	Encryption keys
	Optional

	Initialization
	Reporting Services Configuration manager initializes the report server after you completed the steps on the Database Setup screen. If the report server did not initialize, verify all configurations as described here.

	Email settings
	Optional

	Execution account
	Optional


After you verified the Reporting Server configurations and the report server successfully initialized, you are ready to install the Microsoft Dynamics AX reporting server role.

Microsoft Dynamics AX reporting server role

Installing the Microsoft Dynamics AX reporting server role installs the following objects in Reporting Services:

· Dynamics folder

· Dynamics data source

Start Setup

If you have not done so already, insert the Microsoft Dynamics AX DVD into your drive. If the Microsoft Dynamics AX Setup Wizard does not launch automatically, double-click the Autorun.hta file in the root directory of the DVD.

If you are installing from a network location, share the installation files and connect to the location from the computer on which you want to install the program.

Install reporting server files

1061. To begin the installation process, click Microsoft Dynamics AX.
On the Prerequisites check page, Setup validates that the software required to install Microsoft Dynamics AX is present. If it is not, click Install. To continue after the update completes, click Next.

1062. On the Welcome page of the Setup Wizard, click Next to continue.

1063. On the License agreement page, read the license agreement and then click I accept the terms in the license agreement to accept the licensing terms and conditions. Accepting the license agreement activates the Next button. To continue, click Next.

Note   To end Setup, click Cancel.

1064. On the Select installation type page, click Custom installation, and then click Next.

1065. On the Select Computer Role page, select Reporting server, and then click Next.

1066. On the Select an instance of SQL Server 2005 Reporting Services page, select the instance name of SQL Server 2005 Reporting Services to which you would like to connect. The Web service and Report manager URLs are shown when the instance has been found.

1067. On the Select a database for the reporting server data source page, enter the name of the server that hosts the Microsoft Dynamics AX database and the name of the Microsoft Dynamics AX database, and then click Next.

1068. On the Provide credentials for the reporting server data source page, enter the domain account and password, and determine whether you want to overwrite any existing Microsoft Dynamics AX data sources defined in SQL Server Reporting Services.

1069. On the Installing page, you can monitor installation progress as Setup proceeds.

1070. On the Completing Microsoft Dynamics AX Setup page, you can review the summary of roles and components for your computer. To exit Setup, click Finish.

After installing the reporting server role, you are now ready to configure Microsoft Dynamics AX for ad hoc reporting.

Configure Microsoft Dynamics AX for ad hoc reporting

The following procedure describes how to add a server to the list of reporting servers in Microsoft Dynamics AX and thereby link Microsoft Dynamics AX and Reporting Services for ad hoc reporting.

If you have not already done so, read Reporting Services Security before connecting Microsoft Dynamics AX and Reporting Services.

Before you begin

If you do not have Microsoft SharePoint Services installed on your reporting server, you can skip to Add a reporting server in Microsoft Dynamics AX.

If SharePoint Services is installed on the same machine as your reporting server, you must add the /reports and /reportserver paths to the list of excluded paths in SharePoint Services. If you do not add these paths to the list of excluded paths in SharePoint, Axapta will not be able to locate the Reporting Services URLs and therefore you will not be able to link Microsoft Dynamics AX and Reporting Services.

1071. From the Start menu, click Administrative Tools > SharePoint Central Administration.
1072. Click Configure Virtual Server Settings.

1073. Click Default Web Site.

1074. Click Define Managed Paths.

1075. Under Add a New Path, enter /reports in the Path text box.

1076. Select the Excluded Path option.

1077. Click OK.

1078. Enter /reportserver in the Path text box.

1079. Select the Excluded Path option.

1080. Click OK.

Add a reporting server in Microsoft Dynamics AX

1081. Click Administration > Setup > Business analysis > Reporting Services > Reporting Servers.
1082. In the Server name field, enter the name of your Reporting Services server. If Reporting Services is installed on the same machine as Microsoft Dynamics AX, you still must enter the computer name. Microsoft Dynamics AX automatically populates the Web service URL field (https://servername/reportserver) and the Report Manager URL field (https://servername/reports).

1083. If you do not plan to use Secure Sockets Layer (SSL) with Reporting Services, change the Web service URL to http://servername/reportserver and the Report Manager URL to http://servername/reports.

1084. In the Description field, enter a name or a description to help end users understand which reporting server to select when creating ad hoc reports. For example, Finance Report Server.

1085. Click Validate to verify that Microsoft Dynamics AX can connect to the reporting server.

If the validation failed, do the following:

· Verify the name of the reporting server in the Server name field.

· Verify that the report server is running. To see if the service is running, open the Report Server Configuration Manager (Start > All Programs > Microsoft SQL Server 2005 > Configuration Tools > Reporting Services Configuration).

· Verify that Internet Information Services (IIS) is running (Start > Administrative Tools > Internet Information Services Manager).

· Verify in IIS that the DefaultAppPool and the Default Web site are running. See the IIS documentation for more details.

· If using SSL, verify that the SSL certificate is stored on the local machine's certificate store. See the IIS documentation for more details.

If the connection to the reporting server failed after verifying these items, contact your Microsoft partner.

Note   If you want to test ad hoc reporting with several languages, you can configure multiple instances of Reporting Services to work with Microsoft Dynamics AX. The additional instances of Reporting Services must be located on the same computer. To add multiple instances, repeat the "Install reporting server files" procedure and the "Add a reporting server in Microsoft Dynamics AX" procedure in this topic. For each procedure, enter a new Reporting Services instance or new URLs where appropriate.

Now that you have installed and configured Reporting Services and Microsoft Dynamics AX for ad hoc reporting you are ready to create a report model. For more information, see Create an ad hoc report model.

Create an ad hoc report modelmodel

A report model is a view of business data. The view has been isolated from other Microsoft Dynamics AX data and processed so a manager or business decision maker can examine data relevant to their role in an ad hoc report. For example, a manager who oversees customer relations requires a model based on customer data. Specifically, this manager needs a model based on the Customer table (CustTable) database table and other related tables. After the model is generated and published, the manager can develop, view, and print various reports based on customer data.

Important   To perform the procedures described here, you must be a member of the Admins group in Microsoft Dynamics AX.

Generate models for ad hoc reporting

This section describes the procedures for configuring, generating, and publishing report models. This section also describes important details about model-generation options.

You must manually update report models (as described here):

1086. When a table is modified (and the table is included in a perspective)
1087. When an extended data type is modified (particularly when a relationship is added or modified)

1088. When a table is added to a table collection.

1089. When a perspective is modified (created, deleted, or its children have been modified).

1090. Enumerations change.

Create a perspective for each model you want to generate

A perspective identifies the tables in the Microsoft Dynamics AX database on which the report model is based. For example, to generate a Sales model that includes customer data, you must have a perspective that includes the CustTable database table.

Microsoft Dynamics AX includes standard perspectives that reflect the different nodes in the product. You can view these perspectives in the Application Object Tree > Data Dictionary > Perspectives node. You can generate report models and ad hoc reports based on these standard perspectives. These perspectives can help you and your business decision makers become familiar with the features of ad hoc reporting. However, after they are familiar with the standard perspectives, your business decision makers might require different tables or different perspectives altogether, in which case, you must create a new perspective or modify an existing perspective.

If you are not certain which tables to include in which perspectives, talk with a developer and business decision makers to learn which ad hoc reports they want to view and which tables provide data for these reports.

To create a perspective for a report model

1091. Click the Application Object Tree button on the toolbar.
1092. Expand Data Dictionary.

1093. Right-click Perspectives and select New Perspective.

1094. Select the new perspective to rename it. For example, Customers.

1095. Expand the new perspective to access the Tables list. 

1096. Right-click the Tables list and select New to specify a new table.

1097. Right-click the new table and select Properties.

1098. In the Table properties dialog box, select the Properties tab, and then click the Table field.

1099. Select a table from the drop-down list.

1100. Close the Application Object Tree.

Report-model options

Now that you have created perspectives and identified the data for the report models, you must specify report-model options in Microsoft Dynamics AX. To access the report-model options form, click the Tools menu > Reporting tools > Model generation options. Adjust the following options as necessary before generating a model.

General tab

Log-model update events

If Microsoft Dynamics AX experiences an event or a problem when generating a model, the system writes the event to a file called AxModel.log (by default). Some events are general in nature. For example, the log file includes the timestamps when model synchronization begins and ends. Other events are more particular in nature. For example, the system writes an AOT event to the log file when it cannot locate a CurrencyCode field in the CompanyCurrencyConversion table. If you are having trouble generating models, the model-update log file can help you understand what is happening on the system during model updates.

Note   If Microsoft Dynamics AX experiences an access-denied error when communicating with a Reporting Services Web service as part of the synchronization process, the system writes an event to the Windows Application Event log.

Specify where report models will be published

By default, Microsoft Dynamics AX publishes models to the report server. You can publish models to a file folder if you find it easier for backup or debugging purposes. If you do publish models to a file folder, the models must be uploaded manually into Microsoft SQL Server 2005 Reporting Services (SSRS) for use with SQL Server Reporting Services Report Builder.

Contents tab

Set the default exchange rate company and report currency

Report models translate all financial totals into a specified company's currency. By default, the model for each language uses the default exchange rate company as the specified company. If your organization or business includes multiple companies doing business in multiple currencies, you must specify a single company and a single currency for report-model totals. Once you select the company, Microsoft Dynamics AX automatically uses the currency and currency rates for that company (as defined in the General ledger module) when generating financial totals.

Important   For every financial transaction, report models perform currency translation according to the historical rate for the specified currency. For this reason, do not use reports based on models for statutory financial reporting. Statutory financial reporting requires different currency-translation methods based on the nature of the financial account.

Note   The Default currency for total amounts is automatically set to the master currency for the selected company. The master currency is set in the General ledger module. 

Languages tab

For more information, see Ad hoc reporting for multiple languages.

Generate and view a model

Now that you have set model-generation options, you are ready to create a model. Microsoft Dynamics AX takes several minutes to generate the model. The length of time depends on the amount of data being processed and the amount of traffic on the server. For this reason, you might consider setting up a batch job when creating a model.

To generate a model

1101. From a Microsoft Dynamics AX client, click the Tools menu > Reporting tools > Update models.
1102. Enter the desired criteria and click OK.

1103. When the operation completes, the Infolog informs you which models were published.

To view a model

1104. From a Microsoft Dynamics AX client, click the Tools menu > Reporting tools > Report Manager.
1105. Click the name of the application. For example, Dynamics.

1106. Locate the models. The models have the same name as the perspective on which they are based.

Ad hoc reporting security

This topic discusses how security is enforced for the ad hoc reporting features, ad hoc reports, and report data in Microsoft Dynamics AX. This topic also describes how to configure security for ad hoc reporting.

Report Builder, Report Manager, and report model security

Report Builder and Report Manager are the primary features for creating, viewing, and managing ad hoc reports. A report model is a description of the business data and corresponding relationships that users can navigate in an ad hoc report. By default, only Microsoft Dynamics AX administrators have access to these features and data. If a user requires access to ad hoc reporting features, reports, or data, an administrator must add the user to a group with the appropriate permissions as described in this topic.

Note   All security restrictions and permissions set in Microsoft Dynamics AX automatically apply to ad hoc reporting features, reports, and data. Security and permissions are enforced immediately. You do not need to synchronize data or regenerate report models to enforce security restrictions.

Security guidelines and best practices

When you set up ad hoc reporting in your organization or business, consider the following guidelines and best practices:

· Create Microsoft Dynamics AX user groups and grant the appropriate permissions for these groups (described later in this topic) before users can access ad hoc reporting features, reports, or data.

· Set up a precise security policy for ad hoc reporting by setting restrictions on database tables and fields, and by using record-level security filters.

· Control access to report data on a per-company basis.

· Grant access to the server hosting Microsoft SQL Server 2005 Reporting Services only to administrators and approved developers.

· If you configure Microsoft Dynamics AX to publish report models to a shared folder or Universal Naming Convention (UNC) directory on a server, ensure the directory is only accessible by those users who have permission to write to that directory.

· If users access ad hoc reports from an external-facing Web site or if report models are published to an external-facing Web site, use Secure Sockets Layer (SSL) technology to encrypt data transmission.

· As a security best practice, periodically change the password associated with the ad hoc reporting domain account (the account set up when you installed the Reporting Services role).

· Be aware that Reporting Services roles and security are not managed by the Microsoft Dynamics AX installation program or application. Reporting Services roles and security must be managed by an administrator through Microsoft SQL Server 2005 Reporting Services Report Manager.

Configure ad hoc reporting security

The following table describes ad hoc reporting keys and menu items that must be enabled in the Microsoft Dynamics AX permissions tree before members of a user group can access the corresponding features, reports, or data.

	Key or Menu name
	Location in the Permissions tree (when Viewing = Security)
	Recommended access level
	Details

	Report Builder
	Basic > Inquiries
	View
	Enables access to the Report Builder menu. Report Builder is the primary tool for creating and modifying ad hoc reports.

	Report Manager
	Basic > Inquiries
	View
	Enables access to the Report Manager menu. Report Manager is the primary tool for viewing and managing reports.

	Report Builder options
	Basic > Setup
	Full control
	The Report Builder options menu allows users to select report data for their reports and a report language (if applicable).


Only administrators and approved developers should have access to the following security keys and menu items. If an end user or malicious user gained access to one of these items, that user might be able to generate and publish a report model and thereby view sensitive data they are not intended to view.

	Key or Menu name
	Location in the Permissions tree (when Viewing = Security)
	Recommended access level

	Manual Update Options 

Model generation options

Model languages

Model Security Key Cache

Reporting Servers (menu item)

Reporting Servers (table)

Reporting Services field cache

Reporting Services role cache

SRS Model Options
	Administration > Setup
	Full control


To grant access to ad hoc reporting features

1107. From a Microsoft Dynamics AX client, click (Administration > Setup > Security > User group permissions.
1108. On the Overview tab, select a user group and then select a domain.

1109. Click the Permissions tab.

1110. In the list box, select the item(s) for which you want to set permissions. Press and hold the CTRL button on your keyboard to select multiple items.

1111. Under Access, select a permissions level. Once you select a permissions level, the selected item shows a check mark to indicate that permissions have been set.

1112. Click the Cascade button to ensure all dependent keys are set and to inherit this permission level to all child tables, forms, and nodes.

1113. Press CTRL+S to save changes.

Note   If you need to set permissions for a group in a different domain, repeat this procedure and select the new domain in step 2.

Secure views

A secure view is a database view that enforces security on tables when accessed from outside of Microsoft Dynamics AX. The application creates secure views of all data for every table referenced in a report model when the model is generated or updated. When a user accesses report data using Report Builder, security is automatically enforced so users see only the data they are supposed to see (according to their user group membership). 

If your organization or business does not intend to use Report Builder, you must generate secure views using the Create all Secure Views form (Administration > Periodic > Business analysis).

Important   Database views are stored in the database. By default, only the database administrator, the account for the Application Object Server (AOS), and the Reporting Server domain account have access to secure views. Do not grant users access to secure views. If a user gains access to secure views, the user could view data not intended for that individual.

Generate ad hoc report models in multiple languages

If your organization or business has offices in different countries, you might find it useful to create ad hoc reports in each country's native language. After you generate a report model for each language (as described in this topic), users can then create ad hoc reports from the translated models. 

You can create ad hoc reports in any language for which you have a valid Microsoft Dynamics AX license code. Changing the language for a report model (as described in this topic) does not change the language of the report data. For example, you can change the language options for your report models to create models in French. The resulting report metadata (for example, column and row headings or descriptions) would be French. However, if all of the report data was entered into the database in German, the data would still be German.

Note   The process of generating ad hoc report models in multiple languages consumes memory and CPU resources on your server. It is highly recommended that you generate report models in multiple languages using a batch process. For more information, see Processing batch jobs.

To generate report models in multiple languages

1114. From a Microsoft Dynamics AX client, click the Tools menu > Reporting tools > Model generation options.
1115. Click the Languages tab. The tab lists those languages for which you have a valid Microsoft Dynamics AX license code.

1116. Select the languages for which you want to create report models and ad hoc reports. For each language, verify that the Destination Server ID is listed. If a server ID is not listed, click the drop-down and select the server ID now.

1117. Click Update models.

1118. Click the Batch tab. Enter the appropriate information and click OK.
Generate ad hoc report models in multiple currencies

To understand how to work with multiple currencies in ad hoc reports, consider the following scenario:

Contoso Corporation manufactures blue jeans. Contoso has manufacturing facilities and corporate headquarters in India (called Contoso Asia--Parent Company in Microsoft Dynamics AX) and distribution/sales offices in the following locations:

· United States (Contoso North America--Company 2)

· Brazil (Contoso South America--Company 3)

· Prague (Contoso Europe--Company 4). 

The Director of Finance, Thejas, plans to use ad hoc reporting to track financial details.

By default, ad hoc reports return data for all companies a user has permission to access. Because Thejas has access to all four companies, the ad hoc reports he creates return data from all four companies. Because each company uses a different currency, the ad hoc reports show the following fields: 

	Original AMT
	Original Currency
	Reporting AMT
	Reporting Currency


Original Currency denotes the currency used for the original transactions. For example, if the transactions in the report were processed in Brazil, the Original Currency would be the Brazilian Real - BRL. Original AMT is the amount of the currency.

Thejas is not familiar with the Brazilian Real so transaction and totals (if left in the original currency) would be confusing. Thejas must see transactions and totals in the currency he knows, the India Rupee. 

Thejas and his administrator configured Microsoft Dynamics AX so that all foreign currencies are automatically processed against an exchange rate and converted to the India Rupee. In this case, the India Rupee is the Reporting Currency (also called the Master Currency). The master currency is associated with a master company, called the Exchange-Rate company. In this case, Contoso India is the Exchange-Rate Company.

When Thejas creates ad hoc reports, understands the transactions and totals in the report because the original amount and currency have been processed against an exchange rate and converted into the currency he knows.

To work with multiple currencies in ad hoc reports, you must do the following (as described in this topic):

· Verify that all currencies to be published in reports are listed on the Exchange Rates Form

· Select a master currency and exchange-rate company and update all models

To verify currencies

1119. From a Microsoft Dynamics AX client, click the General ledger > Setup > Exchange rates.
1120. Verify that all currencies to be published in reports are listed. For example, if ad hoc reports display data from four companies and each company has its own currency, verify that all four currencies are listed on the Exchange rates form. 

1121. If necessary, add a new line to the form and enter a currency name and code. For information about the fields on this form, see Exchange rates (Form).

Note   Your accountant, or whoever is responsible for the General ledger, should update the exchange rates on this form. If you add a currency, or if you select a currency on this form and you do not see exchange rates listed for that currency, then work with your accountant to get exchange rates entered into the system.
To set the master currency and exchange-rate company

1122. From a Microsoft Dynamics AX client, click the Tools menu > Reporting tools > Model generation options > Content tab.
1123. Use the Default exchange rate company drop-down list to select the company (and corresponding currency) in which totals are calculated. If you do not see the desired currency, set a new currency on the Basic > Setup > Company information > Other tab.

1124. Click Update models.

Administering Reporting Services using Report Manager

Report Manager is a Web-based administration tool used to manage a single reporting-server instance. Report Manager is installed with the reporting server by default. With Report Manager, you can perform the following administrative tasks (and more):

· Create or select new data sources for ad hoc reports.

· Create or modify security settings for reporting-server folders, data sources, reports, and models. These security settings are based on Microsoft SQL Reporting Services roles.

· View report histories.

· View a list of reports that use a shared data source.

· View or modify the application name and other settings that have a site-wide effect.

· View system-level roles that can be used to create security policies for the reporting server.

For the full list of Report Manager features, view the Report Manager online Help.

To access Report Manager and Report Manager online Help

1125. From a Microsoft Dynamics AX Client, click the Tools menu > Reporting tools > Report Manager. Report Manager opens in a Web browser. If you do not see this menu item, verify that the ReportingServices configuration key is enabled.
1126. To view Report Manager online Help, click the Help link in the upper-left corner of the Web browser.

You can also access Report Manager from Basic > Inquiries > Report Manager.

Troubleshoot ad hoc reporting problems

This topic describes common problems that administrators experience when installing and configuring ad hoc reporting or when creating a report model. This topic also includes a procedure for troubleshooting the problem, where applicable.

Problems installing and configuring SQL Server 2005 Reporting Services

The following list describes common issues and troubleshooting tips when installing and configuring Microsoft SQL Server 2005 Reporting Services:

· Verify that Internet Information Services (IIS) is installed and running (Start > Administrative Tools > Internet Information Services Manager). If you do not see the Internet Information Services Manager, you have not installed IIS. To learn how to install IIS 6.0, see Installing IIS 6.0 on TechNet.

· Verify you installed Reporting Services by opening the Reporting Services Configuration Manager (Start > All Programs > Microsoft SQL Server 2005 > Configuration Tools > Reporting Services Configuration)

· Verify the following configurations in the Reporting Services Configuration Manager:

	Screen
	Details

	Server Status
	If the report server is not running, click Start.

	Report server virtual directory
	Click New to create the ReportServer virtual directory on the Default Web Site. Select Require Secure Sockets Layer (SSL) connections if this site is external facing (accessible from the World Wide Web), or you want to encrypt report server communication over your internal network. 

Note   To use SSL connections, you must install an SSL certificate on the default Web site. For more details, see the IIS documentation.



	Report manager virtual directory
	Click New to create the Reports virtual directory on the default Web site. 

	Windows service identity
	Set the Windows service account to use the Local System account.

	Web service identity
	Verify that the ASP.NET Service Account is set to NT Authority\NetworkService. Verify that the Web service identity is set to DefaultAppPool for the Report Server and the Report Manager.

	Database setup
	1127. In the Server Name drop-down list, enter the name of the server where Reporting Services is installed (for example Report Server 1).
1128. Click New beside the Database Name drop-down list to create a new report server database. Note: this is a unique database. This is not your database for Microsoft Dynamics AX. In the SQL Server Connection dialog box, accept the default values and click OK.

1129. In the Credentials Type drop-down list, verify that Service Credentials is selected.

1130. Click Apply.

1131. In the SQL Connection dialog box, verify that Current User-Integrated Security is selected and click OK.

	Encryption keys
	Optional

	Initialization
	Reporting Services Configuration Manager initializes the report server after you complete the steps on the Database Setup screen. If the report server does not initialize, verify all configurations as described here.

	E-mail settings
	Optional

	Execution account
	Optional


If you still cannot get the Reporting Services server to initialize, consult the SQL Server 2005 Reporting Services online Help.

Problems installing the reporting server role

To install the reporting server role, you must be a member of the db_securityadmin role on the database for Microsoft Dynamics AX. If you are not a member of this role, Microsoft Dynamics AX does not allow you to install the reporting server role.

If you experience a problem or an error when installing the reporting server role, review the error details in the installation log files: \Documents and Settings\All Users\Application Data\Microsoft\Dynamics AX\Dynamics AX Setup Logs
Problems adding a reporting server in Microsoft Dynamics AX

If you added a server on the Reporting Servers form in Microsoft Dynamics AX but could not validate the server, do the following:

· Verify the name of the reporting server in the Server name field.

· Verify that the report server is running. To see if the service is running, open the Report Server Configuration Manager (Start > All Programs > Microsoft SQL Server 2005 > Configuration Tools > Reporting Services Configuration).

· Verify in IIS that the DefaultAppPool and the Default Web site are running. For more details, see the IIS documentation.

· If using SSL, verify that the SSL certificate is stored on the local machine's certificate store. For more details, see the IIS documentation.

Network Service error

If you received the following error: "The current identity (NT AUTHORITY\NETWORK SERVICE) does not have write access to "C:\WINNT\Microsoft.NET\Framework\v2.0.50727\Temporary ASP.NET Files," do the following:

1132. Right-click the directory specified in the error message and select Sharing and Security. 
1133. Click the Security tab.

1134. Click Add.

1135. Enter NETWORK SERVICE in the text box.

1136. In the Permissions list box in the Allow column, select Write.

1137. Click OK.

Problems locating the Web application

If you receive an error stating that Microsoft Dynamics AX could not locate the Web application or the Web application is unavailable, determine whether your reporting server is also hosting Microsoft Windows SharePoint Services. If SharePoint Services is installed on the same server as your reporting server, you must add the /reports and /reportserver paths to the list of excluded paths in SharePoint Services. If you do not add these paths to the list of excluded paths in SharePoint, Microsoft Dynamics AX cannot locate the Reporting Services URLs; therefore, you cannot link Microsoft Dynamics AX and Reporting Services.

1138. From the Start menu, click Administrative Tools > SharePoint Central Administration.
1139. Click Configure Virtual Server Settings.

1140. Click Default Web Site.

1141. Click Define Managed Paths.

1142. Under Add a New Path, enter /reports in the Path text box.

1143. Select the Excluded Path option.

1144. Click OK.

1145. Enter /reportserver in the Path text box.

1146. Select the Excluded Path option.

1147. Click OK.

Problems generating a model

If you receive the following error, "There is no data source on server 'http://servername/ReportServer' whose path and name are '/Dynamics/Dynamics Database'. Please check the settings on the Advanced tab of the Reporting servers form or contact your administrator," you have not installed the reporting server role. On the installation DVD, click Setup.exe to install the role. For more information about installing the reporting server role, see Install and configure a reporting server for ad hoc reporting.

If you experience a problem or an error when generating a model, review the error details in the Microsoft Dynamics AX log files: \Documents and Settings\All Users\Application Data\Microsoft\Dynamics AX\Dynamics AX Setup Logs.
Update or reconfigure a report server

If you installed and configured a report server for Microsoft Dynamics AX ad hoc reporting and you need to make changes to your computing environment, use the procedures in this topic to update or reconfigure your report server. If you do not use the procedures described here, your configuration changes might be incomplete or wrong, which might cause errors for users trying to create or view ad hoc reports.

Change the database credentials used by a report server 

To maintain a secure computing environment, many organizations and business require that all users, administrators, and proxy accounts change their credentials on a regular basis. 

To change the database credentials used by a report server

1148. Open Report Manager in a Web browser (http://servername/reports)
1149. Click the Dynamics folder (or the folder storing your Dynamics data source details and ad hoc reports).

1150. Click Dynamics database.

1151. Enter the new user name or password and click Apply.

Change the database used by a report server 

Many organizations or business create a database snapshot for reporting purposes. A database snapshot is a read-only, static view of a database (the source database). Multiple snapshots can exist on a source database and always reside on the same server instance as the database. Each database snapshot is transactionally consistent with the source database as of the moment of the snapshot's creation. A database snapshot is an effective means for reducing performance impact of ad hoc reporting and query generation against the main transactional database. For more information about database snapshots, see the SQL Server Books online.

To change the database used by a report server

1152. Open Report Manager in a Web browser (http://servername/reports)
1153. Click the Dynamics folder (or the folder storing your Dynamics data source details and ad hoc reports).

1154. Click Dynamics database.

1155. Clear the Enable this data source checkbox.

1156. Click Apply.

1157. Click the Back button in your browser or click the Dynamics link at the top of your browser.

1158. Click New Data Source.

1159. Enter the required information and click OK.

Change the Reporting Services instance associated with your Microsoft Dynamics AX report server

During regular maintenance or upgrades, you might find it necessary to create a new instance of Reporting Services for ad hoc reporting. To change the instance in Microsoft Dynamics AX, you effectively need to add a new report server in the Reporting Servers form. For the procedure to add a report server in Microsoft Dynamics AX, see Install and configure a reporting server for ad hoc reporting.

Change the application pool used by the report server Web service 

During regular maintenance or upgrades, or when troubleshooting a problem with a Web application, you might find it necessary to create a new application pool for your report server.

To change the application pool used by the report server Web service

1160. Open IIS Manager [Start > Administrative tools > Internet Information Services (IIS) Manager].
1161. Expand the local computer.

1162. Expand the Web Sites directory.

1163. Expand the Default Web Site.

1164. Right-click the ReportServer virtual directory and click Properties.

1165. In the Application Pool drop-down list, select a new application pool and click OK.

Setting up and configuring application integration

Application Integration Framework (AIF) can be used to send and receive XML data between Microsoft Dynamics AX and external software systems. AIF enables business-to-business scenarios and enterprise application integration projects.

AIF supports BizTalk Server 2006, Microsoft Message Queue (MSMQ), and file system adapters that are well suited for asynchronous data exchange. The framework also supports a Web Services interface that is well suited for synchronous data exchange. You can also create custom adapters.

You can use some functionality provided by AIF without setting up an application integration server, for details see Configuring document exchanges with adapters. An application integration server is only required if you want to use inbound Web services.

AIF replaces the Microsoft Axapta 3.0 Commerce Gateway feature.

For an overview of:

· The architecture of AIF, see Microsoft Dynamics architecture.

· Application integration server installation, see Flowchart: Installation process.

· The recommended deployment topology for an application integration server, see System topology recommendations.

This section includes the following:

	Section
	Description

	Using the Application Integration Framework (AIF) to integrate Microsoft Dynamics AX with external software systems
	This topic provides an overview of AIF and how you can use it.

	Securing the Application Integration Framework
	This topic describes the security mechanisms available for AIF.

	Adapter-based exchanges
	This section describes how to configure adapter-based exchanges.

	Web services for application integration
	This section describes how to configure Web services for application integration.

	Configuring document exchanges
	This section describes how to configure different types of document exchanges.

	Managing document exchanges
	This section describes how to track and view document exchanges.

	Troubleshoot problems operating the Application Integration Framework
	This topic describes how to resolve issues with AIF.


Using the Application Integration Framework (AIF) to integrate Microsoft Dynamics AX with external software systems

Application Integration Framework (AIF) provides an extensible framework that supports multiple asynchronous transports, as well as synchronous transport using Web services, to reliably exchange documents in XML format with trading partners or other systems. 

An exchange starts with a document, that is, a document class defined using Microsoft Dynamics AX business logic. The document is serialized into XML and header information is added to create a message, which may then be transferred into or out of your Microsoft Dynamics AX system (called the local endpoint within AIF). The other entity taking part in the exchanges is called the endpoint. The transaction types are called actions in AIF: for example, SendPurchaseOrder. You set up and configure endpoints and actions and all the other elements of an exchange using forms found when you click Basic> Setup > Application Integration Framework. 

An asynchronous exchange uses an adapter to convert the document into the proper format for exchange by means of a particular transport mechanism, such as Microsoft Message Queuing (also known as MSMQ). Adapter-based exchanges are asynchronous in that they involve moving the document into a queue where it waits for processing by a Microsoft Dynamics AX batch job. Adapter-based exchanges require configuration of a channel for use by the AIF. Adapters support the following transaction types for asynchronous exchange:

· Send Documents - Microsoft Dynamics AX sends documents to another system

· Receive and Create Documents - Microsoft Dynamics AX receives documents from another authorized system and creates new records in the Microsoft Dynamics AX database

· Respond to Read and Query Requests - Microsoft Dynamics AX receives requests for documents from another authorized system, retrieves the requested information (whether a document or a list of documents) from the Microsoft Dynamics AX database, and returns it to the requesting system, with appropriate filtering and security

The same transactions can be accomplished by using Web services. Using Web services for inbound documents requires installation and configuration of Web services for application integration and Microsoft Internet Information Services (IIS) 6.0. An exchange using outbound Web services (that is, sending a document from your Microsoft Dynamics AX installation to another system) requires an adapter and the Web services that reside on the receiving end of the transaction.

You configure the AIF framework using the configuration forms found in the Basic section of Microsoft Dynamics AX. For asynchronous, adapter-based exchanges, you configure and control the Microsoft Dynamics AX batch jobs that process documents in the AIF queues. Exchanges configured to use inbound Web services are processed synchronously. AIF allows multiple connections. That is, your Microsoft Dynamics AX system can support the processing of document exchanges with multiple partners using multiple transport types simultaneously.

Microsoft Dynamics AX includes the functionality to enable connections with the following asynchronous adapters: 

· Microsoft Message Queue (MSMQ)
Important   To send documents using MSMQ, you must use a domain account for the AOS account. For more information, see Install an Application Object Server (AOS) instance
· File system (documents exchanged to and from folders on a computer)
· Outbound Web Services
Synchronous document exchange is supported using inbound Web services.
To help ensure the highest level of security, deploy Web services on your intranet only. Deployment of Web services outside your intranet requires additional middleware to ensure security. 

Send and receive documents and data

By using outbound exchanges in AIF, you can send documents and data to your trading partners. You receive documents and data from endpoints in an inbound exchange.

Send documents and data

Sending a document can be initiated by clicking a button on a form, such as the Send electronically button on the Chart of accounts form. For more information, see How to send and receive documents electronically and About sending and receiving documents electronically.

Receive documents and data

When documents are received in an inbound transfer data is added, deleted or changed in the Microsoft Dynamics AX database. For this reason, you should carefully consider how to proceed to help ensure the security of your Microsoft Dynamics AX system when configuring the Microsoft Dynamics AX users associated with an endpoint, making sure that the users are trusted by your business organization.

Create a connection

Whether you exchange documents using Web services or an adapter-based exchange such as MSMQ, file system, or outbound Web services, you must:

· Negotiate agreements on document or data exchange with trading partners or third parties which are represented in the Microsoft Dynamics AX database.

· Install Web services for application integration using the Microsoft Dynamics AX setup program and install and configure Microsoft IIS 6.0 if you intend to set up exchanges that use inbound Web services. See Install an application integration server and Configure IIS to work with Microsoft Dynamics AX Web services.

· Configure the connection using the forms found when you click Basic > Setup > Application Integration Framework. 

You use a different set of steps when you configure asynchronous adapter-based exchanges (including outbound Web services) and synchronous exchanges using inbound Web services. For more detailed information about configuration, see the sections on configuring, below. See also Configuring document exchanges.

· Carefully consider the resources used in the transfer and the effect of the transfers on performance. You can set the maximum batch size (or set it to be unlimited) to control the number of messages processed from a queue at one time by a batch job. You can also set the maximum locking interval, that is, the maximum time in minutes that the channels and endpoints are to be locked while processing. If you do not have any special circumstances, such as very large or very small messages, you can use the default, monitor your system's performance, and change the maximum locking interval accordingly.

· Maintain and troubleshoot connections by viewing messages in the queues and information when exceptions occur using the Queue manager, Document history, and Exceptions forms found by clicking Basic > Periodic > Application Integration Framework. See Managing document exchanges.

Configure an adapter-based (asynchronous) exchange

A core installation of Microsoft Dynamics AX includes the software to enable adapter-based connections. After a connection is configured and processing initiated by starting the Microsoft Dynamics AX batch jobs, messages are exchanged between the local endpoint and the endpoint using the defined channel. The XML messages consist of the document and a header and can be viewed during the exchange as they appear on the queues.

After your company decides to exchange documents or data with a trading partner or third-party system, you must perform the following tasks.

· Configure the local endpoint (your Microsoft Dynamics AX system). A local endpoint also determines the company that inbound messages are applied to. See Create and configure local endpoints.

· Create and configure actions that define the transactions processed though the framework. Every action specifies a Microsoft Dynamics AX document and the direction of the transfer. For example, the SendPurchaseOrder action specifies that the Microsoft Dynamics AX Purchase Order document is to be sent to the endpoint. See Configure an action.

· Choose a transport mechanism (MSMQ, file system, or outbound Web services) and perform any prerequisite configuration. See the following topics:

· Configure MSMQ to work with Microsoft Dynamics AX.

· Configure Microsoft Dynamics AX to use the file system for exchanging documents.

· Configure outbound Web services.

· Configure the adapter and enable it for use in a channel. Adapters are custom software components that pass the document to a specific transport mechanism, for example, MSMQ. See Configure an adapter.

· Create and configure a channel, specifying the adapter. Channels define the transport method and address, which enables messages to move in and out of the framework to reach the endpoint. See Configure a Channel.

· Define an endpoint for the trading partner or third party, which must be represented in the Microsoft Dynamics AX database. An endpoint is the destination for an outbound document and the source of an incoming document. See Configure an Endpoint.

Note   Endpoints are the conceptual entities at either end of a transaction. For example, a single endpoint may apply to multiple customers or vendors. If sales order confirmations must be sent to a chain of retail stores where each store is set up in the Microsoft Dynamics AX database as a separate customer, you can create a single endpoint which can be authorized for each of the individual stores.

· Create endpoint action policies to define the actions (an action contains a document and an operation, for example SendPurchaseOrder) to be associated with an endpoint. See Configure endpoint action policies.

· Create a data policy for each action on each endpoint. The data policy determines which of the document's data fields participate in the exchange. See Configure endpoint action data policies.

· Optionally, define a pipeline to perform any optional document transformations, value substitutions, or custom operations. See Configure a pipeline. Optional value mappings are available for certain documents as well. 

Note   The pipeline is a configurable engine for processing XML documents as they enter or are sent from Microsoft Dynamics AX. The pipeline is composed of a series of individual pipeline components that are executed in sequential order to transform the XML document. Some generic pipeline components are provided with the Microsoft Dynamics AX installation. The architecture of the pipeline allows developers to create and configure new pipeline components.

· Start and stop processing in the queues for adapter-based exchanges by setting up batch jobs to process the asynchronous channels (using forms found by clicking Basic > Setup > Batch). For more information, see Processing batch jobs and Start and stop the asychronous AIF services.

Configure an exchange using Web services

The AIF also provides a Web services interface for exchanging documents synchronously. This interface provides a seamless integration experience for Microsoft .NET and other Web clients. The Web services are generated automatically from the Microsoft Dynamics AX business logic, so that developers with limited Web experience can easily create their own Web services.

After your company decides to exchange documents or data with a trading partner or third-party system using Web services, the following tasks must be performed.

· Install Web services for application integration. 

See Install an application integration server.

· Configure IIS for Web services. 

This includes specifying the folder where Web services will be installed using the Microsoft Dynamics AX setup wizard, using IIS and Windows administrative tools to set up the Application Pool, to configure security settings, and to create the virtual directory for Web services. See Configure IIS to work with Microsoft Dynamics AX Web services.

· Create a record for the Web site and enter its virtual directory share path using the Web sites form from a Microsoft Dynamics AX client. 

See Configure Web sites for document exchange.

· Configure the local endpoint (your Microsoft Dynamics AX system). 

A local endpoint also determines the company that inbound messages are applied to. See Create and configure local endpoints.

· Create and configure actions that are used to generate Web services. 

Every action specifies a Microsoft Dynamics AX document and the direction of the transfer. For example, the SendPurchaseOrder action specifies that the Microsoft Dynamics AX Purchase Order document is to be sent to the endpoint. See Configure an action.

· Generate Web services for the actions. 

See Create Web services for an action.

· Define an endpoint for the trading partner or third party, which must be represented in the Microsoft Dynamics AX database. 

An endpoint is the destination for an outbound document and the source of an incoming document. See Configure an Endpoint.

Note   Endpoints are the conceptual entities at either end of a transaction. For example, a single endpoint may apply to multiple customers or vendors. If sales order confirmations must be sent to a chain of retail stores where each store is set up in the Microsoft Dynamics AX database as a separate customer, you can create a single endpoint which can be authorized for each of the individual stores.

· Create endpoint action policies to define the actions (an action contains a document and an operation, for example SendPurchaseOrder) to be associated with an endpoint. 

See Configure endpoint action policies.

· Create a data policy for each action on each endpoint. 

The data policy determines which of the document's data fields participate in the exchange. See Configure endpoint action data policies.

· Optionally, define a pipeline to perform any optional document transformations, value substitutions, or custom operations. 

See Configure a pipeline. Optional value mappings are available for certain documents as well.

Note   The pipeline is a configurable engine for processing XML documents as they enter or are sent from Microsoft Dynamics AX. The pipeline is composed of a series of individual pipeline components that are executed in order to transform the XML document. Some generic pipeline components are provided with the Microsoft Dynamics AX installation. The architecture of the pipeline allows developers to create and configure new pipeline components.

Perform optional configuration: document transformations, value substitution, and value mapping

The pipeline is a configurable engine for processing XML documents as they enter or are sent from Microsoft Dynamics AX. The pipeline is composed of a series of individual pipeline components that are executed in order to transform the XML document. Some generic pipeline components are provided with the Microsoft Dynamics AX installation. The architecture of the pipeline allows developers to create and configure new pipeline components.

· With value lookups, you can substitute one character string for another in any field of a document. You can configure value lookups using the AifValueSubstitutor pipeline component. See Creating and configuring a pipeline. 

· You can also create value lookups for any field, if you know the data type for the field. After creating a value lookup table using the Value lookup form, you associate that value lookup table to the pipeline component by entering an identification number in the Lookup table ID field when you configure the pipeline component.

· You can set up optional pre-defined value mapping that is available for certain documents on the Value Mapping form. The value mappings are pre-defined for each document, and arise from the associated business logic. You can map the values used for the active action policy and for the particular endpoint such as item number, customer account number, vendor account number and terms of delivery.

Maintain integration with external software systems

Maintaining integration includes the following tasks:

· Checking error logs and message queues to monitor traffic. 

See About the Error Log and Queue Management.

· Stopping and restarting the framework when necessary. 

See Start and stop the asychronous AIF services.

· Reconfiguring the channel and endpoint if conditions change. 

See Managing changes in documents.

Securing the Application Integration Framework

Since the Application Integration Framework (AIF) is by definition used to exchange data with outside parties or systems, security considerations are extremely important. The discussion below assumes that you have a working knowledge of AIF concepts and terms. For a discussion of concepts, see Using AIF to integrate Microsoft Dynamics AX with external software systems. 

For authorization purposes, each endpoint may be configured for one or more endpoint users, and, optionally, one or more trusted intermediaries. A trusted intermediary is a Microsoft Dynamics AX user configured on the Endpoints form. This user represents an entity that you trust to submit documents to your Microsoft Dynamics AX system. For more information about configuring trusted intermediaries, see Configure an Endpoint.

Endpoint users and trusted intermediaries are Microsoft Dynamics AX users or groups that are configured on the endpoint on the Users tab of the Endpoints form. Only these authorized users are allowed to exchange documents and data on behalf of a particular endpoint.

For this discussion, the concept of a submitting user is defined as the user context of the process that submitted the message. The SourceEndpointUser is a field in the header of the message XML. During an inbound exchange, when a message arrives, the AIF checks that the SourceEndpointUser matches the submitting user and, in turn, also matches the endpoint user. If these are true, the document was submitted by an internal Microsoft Dynamics AX user, and is accepted. If the submitting user does not match the SourceEndpointUser on the message, then it is checked against the trusted intermediary for the endpoint, if one exists. If the submitting user has been configured as a valid endpoint user or trusted intermediary, the inbound message is accepted by AIF.

After endpoint users are configured on the endpoint, only those authorized endpoint users and trusted intermediaries are allowed to exchange documents and data through the framework on behalf of that particular endpoint.

The end result is that the framework ensures that messages are received from an endpoint user authorized to submit them on behalf of the endpoint. However, it is up to all applicable administrators to ensure that the authorized endpoint users and trusted intermediaries represent trusted entities, whether they are internal or external partners, other companies, or other applications.

Security and deployment of Web services

Web services are intended only for deployment in an intranet scenario. To expose Web services to an extranet or the Internet, additional software (middleware) is required to help ensure security. 

Adapter-based exchanges

A transport adapter is a software component that enables an asynchronous exchange in which documents are placed on queue to await processing by different transport mechanisms. To start and stop processing in the queues, use the Microsoft Dynamics AX batch functionality. For more information, see Start and stop the asynchronous AIF services. The transport adapters that are included with Microsoft Dynamics AX include:

· Microsoft Message Queuing (MSMQ)

· Outbound Web services
· File system

· BizTalk
The steps in using adapter-based exchanges include:

· Configuring an adapter 
· Configuring a transport mechanism
· Configuring a channel
· Configuring  the batch jobs that process documents in the queues
The topics in this section include: 

	Topic
	Description

	Flowchart: AIF for adapter-based exchanges
	This topic describes the Conceptual information about workflow and forms that are used to set up adapter-based exchanges.

	Configure Microsoft Dynamics AX to use the file system for exchanging documents
	This topic describes how to configure Microsoft Dynamics AX to use the file system for document exchange. 

	Configure Message Queuing to work with Microsoft Dynamics AX
	This topic describes how to configure Microsoft Dynamics AX to use the message queuing for document exchange.

	Configure outbound Web services
	This topic describes how to configure Microsoft Dynamics AX to use the outbound Web services for document exchange.

	Configure the BizTalk adapter for Microsoft Dynamics AX
	This section describes how to configure Microsoft Dynamics AX to use the BizTalk Adapter for document exchange.


Flowchart: AIF for adapter-based exchanges

Setting up Application Integration Framework (AIF) for document exchange involves one or both of the following tasks:

· Set up transport adapter-based exchanges

A transport adapter is a software component that enables an asynchronous exchange in which documents are placed on queues to await processing by different transport mechanisms. To start and stop processing in the queues, you use the Batch functionality in Microsoft Dynamics AX. See Processing batch jobs. Examples include using Microsoft Message Queuing (MSMQ), outbound Web services, or the file system for the exchange.

· Set up exchanges that expose Web services for inbound document transfer.

For adapter-based exchanges you also configure an adapter, a transport mechanism, a channel, and the batch jobs that process documents in the queues.

This section describes forms that must be used to set up an adapter-based exchange. Adapter-based exchanges are asynchronous exchanges including outbound Web services.

Prerequisites

You must set up and configure the transport you are going to use. 

· For exchanges using the file system, see Configure Microsoft Dynamics AX to use the file system for exchanging documents. 

· For exchanges using MSMQ, see Configure MSMQ to work with Microsoft Dynamics AX. 

· For exchanges using the BizTalk adapter for Microsoft Dynamics AX, see Install BizTalk adapter for application integration and Import AIF schema for a BizTalk project.

Flowchart
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See AIF for adapter-based exchanges flowchart for print version.

The main setup forms of AIF for adapter-based exchanges

The forms that a company must set up to be able to use the basic functionality of AIF for adapter-based exchanges are listed below in the recommended order of setup.

Elements for exchange

Local endpoint
Create local endpoints in the Local endpoints form. For guidelines, see Create and configure local endpoints.

Actions
Configure an action in the Action form. For guidelines, see Configure an action. 

For inbound Web services, see Create Web services for an action.

Endpoints
Configure endpoints in the Endpoints form. For guidelines, see Configure an Endpoint. 

For inbound Web services, you must also give the endpoint user access to Business Connector. See Configuring document exchanges that expose Web services.

Endpoint action policy
Configure endpoint action policies in the Action policies form. For guidelines, see Configure endpoint action policies.

Endpoint action data policy
Configure endpoint action data policies in the Data Policies form. For guidelines, see Configure endpoint action data policies.

Transport adapters

Configure an adaptor in the Transport adapters form. For guidelines, see Configure an adapter.

Channels

Configure a channel in the Channels form. For guidelines, see Configure a Channel.

Start and stop an asynchronous (adapter-based) exchange
Control the exchange of documents with adapters using batch jobs in Microsoft Dynamics AX. For details on setting up the batch jobs for asynchronous data exchange, see Start and stop the asychronous AIF services.

The optional setup forms of AIF for adapter-based exchanges

The setup of AIF for adapter-based exchanges includes a number of other steps beyond the basic functionality.

The additional setup forms are organized by functionality.
Global settings

Configure global settings in the Global settings form. For guidelines, see Configure global settings for document exchange.

Pipeline components for document transformations: value substitution and XSLT transforms
Configure a pipeline in the Pipeline components form. For guidelines, see Configure a pipeline.

Configure value substitution (using lookup tables)
Configure value substitution using lookup tables in the Value lookup form. For guidelines, see Configure a pipeline and About value lookups.

Configure the AifXMLtransform pipeline component
Configure the XSLT transforms in the XSLT repository form. For guidelines, see Configure a pipeline. There are three basic steps:

1166. Create an XSLT style sheet.
1167. Create an ID for the style sheet and import it using the XSLT repository form.

1168. Enter the ID for the XSLT style sheet that you imported on the Pipeline XSLT transform. Click Basic > Setup > Application Integration Framework.> Endpoints > Action policies > Pipeline components. Select AifXMLtransform. Click Configure.

Value mapping for document transformation
Configure value mapping in the Intercompany setup configuration form. for guidelines, see Value Mapping (Form).

Setting up value mapping 

This section describes forms that must be used to set up value mapping for endpoints and external codes for different fields used in the documents.

External Codes

Set up, define and maintain external codes in the External codes form. These external codes are for different fields used to send and receive specific documents electronically through the AIF. 

Set up external codes if necessary for: 

· Trading partners (vendor and customer account numbers)

· Addresses (countries/regions, counties, states, and postal (ZIP) Codes)

· Inventory (Item numbers, barcodes, item units and warehouses)

· Currency codes

· Delivery methods

· Delivery terms

· Miscellaneous charges 

· Dimensions (department, purpose, cost center)

Endpoint Value Mapping

Map the values used for the active action policy and for the particular endpoint such as item number, customer account number, vendor account number and terms of delivery in the Intercompany setup configuration form.

Map values for 

· Trading partners (vendor and customer account numbers)

· Addresses (countries/regions, counties, states and postal (ZIP) Codes)

· Inventory (item numbers, barcodes, item units, and warehouses)

· Currency codes

· Delivery methods

· Delivery terms

· Miscellaneous charges 

· Dimensions (department, purpose, cost center)

Document parameter setup

This section lists the setup parameters for each document to be sent or received by the Application Integration Framework.

Document Notes

Define the name of the Note document type in Parameters form. for guidelines, see Document management parameters (Form).

Inbound Sales Order document

· Define where inbound sales order documents are to be received in the Parameters form (AIF > Order type). For guidelines, see Accounts receivable parameters (form).

· The inbound sales order will be received in the Sales order form. For guidelines, see Sales orders (Form).

· The inbound sales order will be received in the Sales journal form. . For guidelines, see Sales orders (Form).

Inbound Purchase Invoice document

· Define the default register to receive the purchase invoice document in the Parameters form (AIF > Journal name). For guidelines, see Accounts payable parameters (Form).

· Set up how duplicate invoices are to be processed in the Parameters form (Updates > Check the invoice number used). For guidelines, see Accounts payable parameters (Form). 

Inbound Packing Slip document

Define the default settings for the inbound packing slip document in the Parameters form (AIF > Packing slip). For guidelines, see Accounts receivable parameters (form).

Inbound Inventory Counting document

Set the default inventory counting journal for the inventory counting document in the Parameters form (AIF > Counting). For guidelines, see Inventory parameters (Form).

Inbound Transfer Journal document

Set the default counting transfer journal for the inventory transfer document in the Parameters form (AIF > Transfer). For guidelines, see Inventory parameters (Form).

Inbound Inventory Profit/Loss document

Set the default counting profit and loss journal for the inventory profit and loss document in the Parameters form (AIF > Profit/Loss). For guidelines, see Inventory parameters (Form).

Inbound Price/Discount agreement document (Trade Agreements)

Set the default counting price discount journal for the price discount document in the Parameters form (AIF > Price/Discount agreement). For guidelines, see Accounts payable parameters (Form).

Configure Microsoft Dynamics AX to use the file system for exchanging documents

When you use the file system adapter to exchange documents, you must create a file folder for each channel that is used in the exchange. You can create a folder using a Windows Explorer window, or you can create a folder when you configure a channel to use the file system adapter.

For an inbound transfer using the file system, change the default owner for the folder that receives the files.

1. Change the default owner for objects for an inbound file system transfer

Before you create the folder for the inbound file system adapter on the server, complete the following:

1169. Click Start > Programs > Administrative Tools > Local Security Policy.
1170. On the Local Security Settings menu, navigate to Security Settings > Local Policies > Security Options.
1171. Change the Security Settings for the System Objects: Default owner for objects created by members of the administrator's group from Adminstrator's group to Object creator.

1172. Log off and log back on to the computer.

1173. Create the folder for the inbound file system transfer.

1174. Verify that the owner of the folder is the user sending the document to Microsoft Dynamics AX (the submitting user) by:

ak. Right-clicking the folder and selecting Properties, and then
al. Clicking Advanced on the Security tab to view the Advanced Security Settings. 

The owner of the folder is shown on the Owner tab.

2. Create a folder when configuring a channel

1175. Click Basic > Setup > Application Integration Framework > Application Integration Framework. 
1176. Select an existing channel, or press CTRL+N to create a new one.

1177. Select a file system adapter.

1178. Click Address.

1179. Navigate to the folder where you want the file system folder to reside.

1180. Click Make new folder and enter the new folder name.

1181. Click OK. 

3. Configure a folder for sending or receiving documents

1182. Right-click the folder in an Windows Explorer window and click Properties.
1183. On the Security tab, click Advanced.

1184. On the Owner tab, set the Current owner of this item: to be the logged-in user who will perform the document exchange.

1185. Click Apply.

1186. Click OK to exit the menus.

1187. Log off and then log back on to the computer.

Configure Message Queuing to work with Microsoft Dynamics AX

An adapter for Microsoft Message Queuing (also known as MSMQ) is included with your Microsoft Dynamics AX installation. 

Important   To send documents using MSMQ, you must use a domain account for the AOS account. For more information, see Install an Application Object Server (AOS) instance.
To send documents using MSMQ, you must install MSMQ on a computer in your network and create at least one public queue.

Note   Whenever the word "queue" is used in this topic, it refers to a queue created and maintained using MSMQ.

To receive documents using MSMQ, you must install MSMQ and create at least one queue on a computer that has Application Object Server (AOS) installed, and that has been configured to run the AIF batch jobs. For more information about these batch jobs, see Start and stop the asynchronous Application Integration Framework (AIF) services.

To configure the MSMQ adapter (AifMSMQAdapter) for use in a channel, see Configure an adapter and Configure a Channel. 

1. Install MSMQ on a Windows Server 2003 computer

To configure MSMQ to receive documents, you must install MSMQ on a computer with AOS installed. This computer must also be configured to run the AIF batch jobs that execute the AIF services.

1188. Click Start > Settings > Control Panel > Add or Remove Programs > Add/Remove Windows Components.
1189. Select Application Server.

1190. Click Details.

1191. Select Message Queuing.

1192. Click Details.

1193. Select Active Directory Integration and Common.

1194. Click OK.

1195. Click OK.

1196. Click Next to install.

2. Create a queue

A queue for inbound messages can be either private or public; a queue for outbound messages must be public.

1197. Click Start > Settings > Control Panel > Administrative Tools > Computer Management.
1198. Under Services and Applications, expand the Message Queuing folder.

1199. To create a new public queue, right-click the Public Queues folder and click New > Public Queue.

1200. To create a new private queue, right-click the Private Queues folder and click New > Private Queue.

Any queue used for receiving messages must be located on the same computer as the AOS that is configured to run the batch jobs that operate on the AIF queues. For more information, see Start and stop the asynchronous Application Integration Framework (AIF) services.

1201. Enter a name for the queue.

1202. Click the Transactional check box.

1203. Click OK.

3. Configure a queue for sending or receiving documents

AIF requires all inbound messages to be authenticated. When using MSMQ, authenticated messages are passed to AIF through authenticated or unauthenticated queues. AIF does not provide authentication for outbound messages, so you must configure outbound queues to be unauthenticated.

1204. Click Start > Settings > Control Panel > Administrative Tools > Computer Management.
1205. Under Services and Applications, expand the Message Queuing folder.

1206. Right-click the queue you created and click Properties.

1207. If you are configuring an inbound queue, on the General tab, select Authenticated. If you are configuring an outbound queue, clear Authenticated.

Inbound messages must be authenticated. That is, inbound messages that are not authenticated fail to reach their destination (the local endpoint).

1208. On the Security tab, set ACLs appropriately for all queues.

When configuring the ACLs for newly created MSMQ queues, ensure that the current, logged-in user retains Full Control over each queue. If the current, logged-in user is denied certain privileges, they may become locked out of the queue and unable to make changes.

By default, Everyone and Anonymous Logon users can send messages to any newly created queue. Only the creator of the queue and an Administrator can receive messages from the queues.

For inbound queues, select Allow on Receive Message and Peek Message for the AOS account (the domain account or Network Service account associated with the AOS instance). Select Allow on Send Message, Get Properties, and Get Permissions for endpoint users only. For more information about configuring endpoint users and trusted intermediaries, see Configure an Endpoint.

For outbound queues, set the ACLs to select Allow on Send Message, Get Properties, and Get Permissions for the Anonymous Logon user. Select Allow on Receive Message and Peek Message for endpoint users only.

If the inbound queue is not on the same machine as the AOS, then two additional entries need to be added to the queue's ACL. First, add the account for the AOS computer (for example, domain\computer-name$), and select Allow on Peek Message and Receive Message. Second, grant the Peek Message and Receive Message permissions for the Anonymous Logon.
1209. On the Security tab, click Advanced.

1210. On the Owner tab, set the Current owner of this item: to be the logged-in user who performs the document exchange.

1211. Click OK to exit the menus.

1212. Log off and then log back on to the computer.

Configure outbound Web services

A document exchange using outbound Web services routes a document from your Microsoft Dynamics AX installation to the Web services that reside on your trading partner's computer. This type of exchange is adapter-based: the AifWebServiceAdapter passes the document to the external Web services. 

You should always negotiate agreements on document or data exchange with trading partners or third parties which are represented in the Microsoft Dynamics AX database.

To configure an exchange using outbound Web services requires the following steps:

1213. Create and configure a local endpoint (your Microsoft Dynamics AX system) by using the Local endpoints form.
For more information, see Create and configure local endpoints.

1214. Configure an action by using the Local endpoints form.

An action is comprised of a document and an operation, such as createSalesOrder. This form is also used to generate Web services from actions. For more information, see Configure an action.

1215. Configure the AifWebServiceAdapter by using the Local endpoints form.

For more information see Configure an adapter. Configure a channel to use the AifWebServiceAdapter on the Local endpoints form.

For more information, see Configure a Channel.

1216. Create and configure an endpoint for the trading partner in the exchange by using the Local endpoints form.

Endpoints represent your trading partners. For more information, see Configure an Endpoint.

1217. Configure the endpoint action policy to associate the desired actions with the endpoint by using the Local endpoints form.

Action policies relate actions to endpoints. For more information, see Configure endpoint action policies.

1218. Configure endpoint action data policies by using the Local endpoints form.

The data policy specifies which fields participate in the transfer. For more information, see Configure endpoint action data policies.

1219. Optionally, you may configure value mappings and pipeline components. 

For more information, see About value lookups and Configure a pipeline.

1220. Start the exchange by setting up the required batch jobs. 

See Start and stop the asychronous AIF services.

Install BizTalk adapter for application integration

To install the BizTalk adapter for Microsoft Dynamics AX, you must be at the application integration gateway computer. After you install the BizTalk adapter services, you must finish configuring and deploying it within Microsoft Dynamics AX.
Components installed

Setting up a computer as an application integration gateway installs the following components on the computer:

· .NET Business Connector
· BizTalk adapter for Microsoft Dynamics AX
Verify prerequisites

On the computer running the BizTalk adapter for Microsoft Dynamics AX, the following must be installed:

· Microsoft BizTalk Server 2006

The following must be available in the domain: 

· A core Microsoft Dynamics AX installation. This installation must be completed before you install the BizTalk adapter.

· Active Directory directory services configured in native mode.

Verify account rights

You must log in with an account that is a member of the Administrators group on the computer on which you are running Setup. 

Set up the Business Connector Proxy for BizTalk
If you have already set up the Business Connector proxy account, you do not need to set it up again for the BizTalk adapter.

Create the proxy account in Active Directory

A proxy account in Active Directory must exist on your domain controller before Business Connector can act on behalf of remote users. If the proxy account does not exist in Active Directory, remote users cannot authenticate with Microsoft Dynamics AX.

· Work with the domain administrator to have a unique user created in Active Directory with the following characteristics:

· User cannot have the same name as an existing Microsoft Dynamics AX user.

· Password does not expire.

· No interactive logon rights.

Associate the proxy account with Business Connector

When you associate the proxy account with Business Connector, the proxy account is added to the Microsoft Dynamics AX database. By storing the proxy account in the Microsoft Dynamics AX database, multiple Application Object Server (AOS) instances can access the proxy.
Note   Do not add the Business Connector Proxy domain account to Microsoft Dynamics AX as a user.
1221. From an Microsoft Dynamics AX client, click Administration > Setup > Security > Business Connector Proxy.
1222. In the Alias field, type the name of the proxy user that was previously created in Active Directory.

1223. In the Network domain field, type the domain.

1224. To propagate the change to the Microsoft Dynamics AX database, restart the AOS.

Start Setup

At the computer running BizTalk Server, If you have not done so already, insert the Microsoft Dynamics AX DVD into your drive. If the Microsoft Dynamics AX Setup Wizard does not launch automatically, double-click the Autorun.hta file in the root directory of the DVD.

If you are installing from a network location, share the installation files and connect to the location from the computer on which you want to install the program.

Install the BizTalk adapter for Microsoft Dynamics AX
1225. To begin the installation process, click Microsoft Dynamics AX.
On the Prerequisites check page, Setup validates that the software required to install Microsoft Dynamics AX is present. If it is not, click Install. To continue after the update completes, click Next.

1226. On the Welcome page of the Setup Wizard, click Next to continue.

1227. On the License agreement page, read the license agreement and then click I accept the terms in the license agreement to accept the licensing terms and conditions. Accepting the license agreement activates the Next button. To continue, click Next. 

Note   To end Setup, click Cancel.

1228. On the Select installation type page, click Custom installation, and then click Next.

1229. On the Select Computer Role page, under Application integration gateway, select BizTalk adapter, and then click Next.

1230. On the Installing page, you can monitor installation progress as Setup proceeds.

1231. On the Completing Microsoft Dynamics AX Setup page, you can review the summary of roles installed on the computer.

1232. To exit the Microsoft Dynamics AX Setup wizard, click Finish.
Next steps

Now that you have installed the BizTalk adapter, you must configure it in Microsoft Dynamics AX. For details, see Configure AIF for use with BizTalk Server.

Configure AIF for use with BizTalk Server

The steps in configuring Application Integration Framework (AIF) for use with Microsoft BizTalk Server include:

· Enable the BizTalk transport adapter for Microsoft Dynamics AX. Configure a channel to use the BizTalk transport adapter (Create the BizTalk Group). 

Enable the BizTalk Adapter for Microsoft Dynamics AX

1233. Click Basic > Setup > Application Integration Framework > Application Integration Framework.
1234. Press CTRL+N.
1235. In the Adapter class list, select AifBizTalkAdapter. 
Note   The first time the form is opened, the process of scanning for adapters may take a few moments. There is a progress bar at the bottom of the form.

1236. To make the adapter available for use in a channel, click Active.
1237. Close the form.
Configure a channel to use the BizTalk transport adapter (Create the BizTalk Group)
1238. Click Basic > Setup > Application Integration Framework > Application Integration Framework. 
1239. Press CTRL+N to create a new channel.

1240. Select AifBizTalkAdapter in the Adapter field.

1241. Enter the unique identification information for the new channel, including an identifier in the Channel ID field and a friendly name in the Name field.

1242. To activate the channel and allow it to participate in document exchanges, click Active.

1243. In the Direction field select Bothfor the direction for the transfers to be performed in this channel.

1244. In the Addressfield, enter the name of the BizTalk group to use. 

1245. Press CTRL+S to save the channel.

1246. Click Configure.

1247. Enter the names of the computers running BizTalk Server that belong to the specified BizTalk group. Press CTRL+N to add each server to the list. 

Next steps

After you configure AIF for use with BizTalk, you must: 

· Configure the BizTalk adapter. For more information, see Configure the BizTalk adapter for Microsoft Dynamics AX.
· Configure document exchanges. For more information, see Configuring document exchanges. 

· Start and stop processing in the queues by setting up batch jobs to process the asynchronous channels. For more information, see Processing batch jobs and Start and stop the asychronous AIF services.
Import AIF schema for a BizTalk project

Before you configure the BizTalk adapter for Microsoft Dynamics AX in Microsoft BizTalk Server 2006, you should configure the Application Integration Framework (AIF) for use with BizTalk. For more information, see: Configure AIF for use with BizTalk Server.
1248. In Microsoft Visual Studio 2005, create a BizTalk Server project.
1249. Add the following reference to the project: Program Files\Microsoft Dynamics AX\40\Client\Bin\Microsoft.Dynamics.BizTalk.Adapter.Schemas.

1250. Use the Add Adapter Wizard (Add Generated Items > Add Adapter Metadata > Add) to import the Microsoft Dynamics AX schema.
am. In the Add Adapter Wizard, select Microsoft Dynamics AX, and click Next. 
Note   If you select a port on this screen, you will skip the next screen

an. On the Specify Connection Information page, specify the server and port of a Microsoft Dynamics AX Application Object Server (AOS) instance, and a Microsoft Dynamics AX client configuration. 
ao. On the Import Microsoft Dynamics AX Schemas page, choose the document, message exchange, purchase requisition, or sales order schemas to import. 
ap. Click Finish.
1251. Update the orchestrations for multi-part message types. Update the body type to use the correct schema from the referenced schema assembly for the following message types: EntityKey, EntityKeyList, Message, QueryCriteria, Fault. For more information about message types, see About Messages. 

Web services for application integration

Web services are programmatic interfaces that are made available to facilitate application-to-application (A2A) communication. The Application Integration Framework (AIF) includes support for Web services exposed to trading partners (known as inbound Web services) as well as an adapter to specify documents and use Web services exposed by other trading partners (known as outbound Web services). 

· Inbound Web services are synchronous; that is, they do not rely on a queue and a processing service to transfer information. 

Inbound Web services do not require an adapter, nor do they require a channel to be configured. However, you must configure a Web site on the Web sites form and you must configure all the other elements for a document transfer that uses AIF. That is, you must configure a local endpoint, actions (from which you generate Web services), at least one endpoint and an action policy on that endpoint. Additionally, you may configure pipeline components (including value lookups) and endpoint action data policies for document transfer with inbound Web services.

When you configure an endpoint for inbound Web services, you must set up an Microsoft Dynamics AX user (or user group) for that endpoint. Next, you must give the user group access to the Business Connector. For details, see Configuring document exchanges that expose Web services.

· Outbound Web services are asynchronous and place messages on a queue where they are exchanged using a batch processing service.

Outbound Web services are initiated by your Microsoft Dynamics AX installation when other external sites have exposed Web services.

When you use AIF to expose Web services to external trading partners, you are allowing trading partners to create, update, read, delete, or query for records in the Microsoft Dynamics AX database. 

Note   It is unsafe to deploy AIF using Web services outside the intranet without installing additional middleware to ensure proper security. As installed with Microsoft Dynamics AX, AIF Web services are intended for intranet deployment only.

Flowchart: AIF for inbound Web services

Setting up Application Integration Framework (AIF) for document exchange involves one or both of the following tasks:

· Set up transport adapter-based exchanges.

A transport adapter is a software component that enables an asynchronous exchange in which documents are placed on queues to await processing by different transport mechanisms. To start and stop processing in the queues, you use the Batch functionality in Microsoft Dynamics AX. See Processing batch jobs. Examples include using Microsoft Message Queuing (MSMQ), outbound Web services, or the file system for the exchange.

· Set up exchanges that expose Web services for inbound document transfer.

This section describes forms that must be used to set up an exchange using Web services for inbound data exchange.

Prerequisites

If you are setting up inbound Web services, you must perform these three steps:

1252. Set up an application integration server as described in the Implementation Guide topic Install an application integration server.
1253. Configure Internet Information Services (IIS) as described in the topic Configure IIS to work with Microsoft Dynamics AX Web services.

1254. Use the Web sites form to configure the AIF Web site where Web services are stored. For guidelines, see Configure Web sites for document exchange.

Flowchart
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See AIF for inbound Web services flowchart for print version.

The main setup forms of AIF for inbound Web services

The forms that a company must set up to be able to use the basic functionality of AIF for inbound Web services are listed below in the recommended order of setup.

Local endpoint

Create local endpoints in the Local endpoints form. For guidelines, see Create and configure local endpoints.

Actions

Configure an action in the Action form. For guidelines, see Configure an action. 

For inbound Web services, see Create Web services for an action.

Endpoints

Configure endpoints in the Endpoints form. For guidelines, see Configure an Endpoint.

For inbound Web services, you must also give the endpoint user access to Business Connector. See Configuring document exchanges that expose Web services.

Endpoint action policy

Configure endpoint action policies in the Action policies form. For guidelines, see Configure endpoint action policies.

Endpoint action data policy

Configure endpoint action data policies in the Data Policies form. For guidelines, see Configure endpoint action data policies.

The optional setup forms of AIF for inbound Web services

The setup of AIF for inbound Web services includes a number of other steps beyond the basic functionality.

The additional setup forms are organized by functionality.

Global settings
Configure global settings in the Global settings form. For guidelines, see Configure global settings for document exchange.

Pipeline components for document transformations: value substitution and XSLT transforms
Configure a pipeline in the Pipeline components form. For guidelines, see Configure a pipeline.

Configure value substitution (using lookup tables)
Configure value substitution using lookup tables in the Value lookup form. For guidelines, see Configure a pipeline and About value lookups.

Configure the AifXMLtransform pipeline component
Configure the XSLT transforms in the XSLT repository form. For guidelines, see Configure a pipeline. There are three steps:

1255. Create an XSLT style sheet.
1256. Create an ID for the style sheet and import it using the XSLT repository form.

1257. Enter the ID for the XSLT style sheet that you imported on the Pipeline XSLT transform. Click Basic > Setup > Application Integration Framework.> Endpoints > Action policies > Pipeline components. Select AifXMLtransform. Click Configure.

Value mapping for document transformation
Configure value mapping in the Intercompany setup configuration form. For guidelines, see Value Mapping (Form).

Setting up value mapping

This section describes forms that must be used to set up value mapping for endpoints and external codes for different fields used in the documents.

External codes

Set up, define, and maintain external codes in the External codes form. These external codes are for different fields used to send and receive specific documents electronically through AIF. 

Set up external codes if necessary for:

· Trading partners (vendor and customer account numbers)

· Addresses (countries/regions, counties, states, and postal (ZIP) Codes)

· Inventory (item numbers, barcodes, item units, and warehouses)

· Currency codes

· Delivery methods

· Delivery terms

· Miscellaneous charges 

· Dimensions (department, purpose, cost center)

Endpoint Value Mapping

Map the values used for the active action policy and for the particular endpoint such as item number, customer account number, vendor account number, and terms of delivery in the Intercompany setup configuration form.

Map values for 

· Trading partners (vendor and customer account numbers)

· Addresses (countries/regions, counties, states, and postal (ZIP) Codes)

· Inventory (item numbers, barcodes, item units and warehouses)

· Currency codes

· Delivery methods

· Delivery terms

· Miscellaneous charges 

· Dimensions (department, purpose, cost center)

Document parameter setup

This section lists the setup parameters for each document to be sent or received by AIF.

Document Notes

Define the name of the Note document type in Parameters form. For guidelines, see Document management parameters (Form).

Inbound Sales Order document

· Define where inbound sales order documents are to be received in the Parameters form (AIF > Order type). For guidelines, see Accounts receivable parameters (form).

· The inbound sales order is received in the Sales order form. For guidelines, see Sales orders (Form).

· The inbound sales order is received in the Sales journal form. For guidelines, see Sales orders (Form).

Inbound Purchase Invoice document

· Define the default register to receive the purchase invoice document in the Parameters form (AIF > Journal name). For guidelines, see Accounts payable parameters (Form).

· Set up the manner in which duplicate invoices are processed in the Parameters form (Updates > Check the invoice number used). For guidelines, see Accounts payable parameters (Form).

Inbound Packing Slip document

Define the default settings for the inbound packing slip document in the Parameters form (AIF > Packing slip). For guidelines, see Accounts receivable parameters (form).

Inbound Inventory Counting document

Set the default inventory counting journal for the inventory counting document in the Parameters form (AIF > Counting). For guidelines, see Inventory parameters (Form).

Inbound Transfer Journal document

Set the default counting transfer journal for the inventory transfer document in the Parameters form (AIF > Transfer). For guidelines, see Inventory parameters (Form).

Inbound Inventory Profit/Loss document

Set the default counting-profit-and-loss journal for the inventory profit-and-loss document in the Parameters form (AIF > Profit/Loss). For guidelines, see Inventory parameters (Form).

Inbound Price/Discount agreement document (trade agreements)

Set the default counting price discount journal for the price discount document in the Parameters form (AIF > Price/Discount agreement). For guidelines, see Accounts payable parameters (Form).

Install Web services for application integration

To install the Application Integration Framework (AIF) Web services, you must be at the application integration gateway computer. After you install the AIF Web services, you must finish configuring and deploying them within Microsoft Dynamics AX. 

Note   It is unsafe to deploy AIF Web services outside the intranet without installing additional middleware (or intermediaries like BizTalk Server software or Web Services Enhancements (WSE) 3.0 intermediaries) to ensure proper security. As installed with Microsoft Dynamics AX, AIF Web services are intended for intranet deployment only. Do not install the AIF Web services on an external (Internet) facing Microsoft Internet Information Services (IIS) server. For details, see Security considerations for the Application Integration Framework. 

Components installed

Setting up AIF Web services installs the following components on the computer:

· .NET Business Connector

· AIF Web services

Verify prerequisites

The computer that will host the AIF Web services must have IIS, version 6.0 or later installed.

If you do not have IIS installed, you can install it from Start > Control Panel > Add or Remove Programs > Add/Remove Windows Components > Application server.

Note   Do not install the AIF Web services on an external (Internet) facing IIS server.

Verify that the following options were selected when installing.

	Option
	Value

	Application Server Console
	Installed

	ASP.NET 
	Installed

	Enable network COM+ access
	Installed

	Internet Information Services (IIS)
	Installed


The following must be available in the domain: 

· A core Microsoft Dynamics AX installation. This installation can be completed at the same time as the AIF Web services installation or earlier.

· Active Directory directory service configured in native mode.

Set up the Business Connector Proxy for AIF

To set up a Business Connector Proxy, you must perform the steps below. If you have already set up the Business Connector proxy account, you do not need to redo the first two steps - you just need to add the proxy account to the IIS local Microsoft Windows group.

· Create an account for the proxy in Active Directory.

· Associate the account with the Business Connector proxy in Microsoft Dynamics AX.

· Add the proxy account to IIS local Windows group.

Note   Do not add the Business Connector Proxy domain account to Microsoft Dynamics AX as a user.

Create the proxy account in Active Directory

A proxy account in Active Directory must exist on your domain controller before Business Connector can act on behalf of remote users. If the proxy account does not exist in Active Directory, remote users cannot authenticate with Microsoft Dynamics AX.

· Have the domain administrator create a unique user in Active Directory in the form domain\username with the following characteristics:

· The user cannot have the same name as an existing Microsoft Dynamics AX user.

· Password does not expire.

· No interactive logon rights.

Associate the proxy account with Business Connector

Associating the proxy account with Business Connector adds it to the Microsoft Dynamics AX database. By storing the proxy account in the Microsoft Dynamics AX database, multiple Application Object Server (AOS) instances can access the proxy.

1258. From an Microsoft Dynamics AX client, click Administration > Setup > Security > Business Connector Proxy.
1259. In the Alias field, type the name of the proxy user previously created in Active Directory.

1260. In the Network domain field, type the domain.

1261. To propagate the change to the Microsoft Dynamics AX database, you must restart the AOS.

Add the proxy account to the IIS local Windows group

You must add the Business Connector proxy account to the IIS local Windows group.

1262. Open the Computer Management application (Start > Administrative Tools > Computer Management).
1263. Expand the Groups folder under Local Users and Groups.

1264. Add the Business Connector proxy account to the IIS_WPG (IIS Worker Process Group).

Grant the proxy account permissions to the %windir%\temp folder

Because Microsoft Dynamics AX uses ASP.NET 2.0, the Business Connector proxy must be granted List Folder Contents and Read permissions on the %windir%\temp folder. 

1265. Navigate to the %windir%\temp folder, right-click the folder, and point to Properties.
1266. In the Properties dialog box, click the Security tab, and under Group or user names, click Add.

1267. In the Select Users, Computers, or Groups dialog box, under Enter the object names to select, enter the Business Connector proxy account, and then click OK.

1268. In the Permissions list, in the Allow column, make sure that only List Folder Contents and Read are selected, and then click OK.

Verify account rights

You must log in with an account that is a member of the Administrators group on the computer on which you are running Setup. 

Start Setup

If you have not done so already, insert the Microsoft Dynamics AX DVD into your drive. If the Microsoft Dynamics AX Setup Wizard does not launch automatically, double-click the Autorun.hta file in the root directory of the DVD.

If you are installing from a network location, share the installation files and connect to the location from the computer on which you want to install the program.

Install an AIF Web services

1269. To begin the installation process, click Microsoft Dynamics AX.
On the Prerequisites check page, Setup validates that the software required to install Microsoft Dynamics AX is present. If it is not, click Install. To continue after the update completes, click Next.

1270. On the Welcome page of the Setup Wizard, click Next to continue.

1271. On the License agreement page, read the license agreement and then click I accept the terms in the license agreement to accept the licensing terms and conditions. Accepting the license agreement activates the Next button. To continue, click Next. 

Note   To end Setup, click Cancel.

1272. On the Select installation type page, click Custom installation, and then click Next.

1273. On the Select Computer Role page, under Application integration gateway, select Web services, and then click Next.

1274. On the Install application integration Web services page, enter the directory that corresponds to the IIS virtual root where you want to install. 

Setup then performs the following actions:

· Creates a local Windows group called Dynamics AX Web Service Administrators.

· Creates a network share in the directory where the AIF files are installed. The network share is called Aifwebservice.

· Grants Full Control permissions on the share to the Dynamics AX Web Service Administrators local group and to the AOS account (the domain account or Network Service account associated with the AOS service), if the AOS is installed on the same computer at the same time as the AIF Web services. 

1275. On the Installing page, you can monitor installation progress as Setup proceeds.

1276. On the Completing Microsoft Dynamics AX Setup page, you can review the summary of roles installed on the computer.

1277. To exit the Microsoft Dynamics AX Setup wizard, click Finish.

Add users to the Dynamics AX Web Service Administrators group (Optional)

If the AOS is installed on a different computer than the AIF Web services, you must manually add the AOS account to the Dynamics AX Web Service Administrators. 

If you are setting up an AOS instance and the AIF Web services at the same time, you can skip this step. 

1278. Open Computer Management (Start > Administrative Tools > Computer Management). 
1279. In the left pane, click Local Users and Groups and then click Groups. 

1280. In the right pane, right-click Dynamics AX Web Service Administrators and select Add to Group. 

1281. Click Add. The Select Users, Computers, or Group dialog box appears.

· To add a domain account, in the Enter the object names to select box, type the AOS account and then click OK.

· To add the Network service account of a different computer, click Object Types, select Computers, and then click OK. In the Enter the object names to select box, type the Network service account in the format domain\computername$ and then click OK.
1282. Click OK.
Configure IIS

To configure an existing installation of IIS, click Start > All Programs > Administrative tools > Internet Information Services Manager. For more information about configuring IIS, see the IIS documentation on Technet.

1. Validate that IIS is set to run in worker process isolation mode

AIF requires that IIS 6.0 be running in worker process isolation mode and not IIS 5.0 isolation mode. The application isolation mode applies globally to the IIS service and affects all Web applications on the computer. You cannot apply an application isolation mode to individual applications. 

1283. Open the IIS management console and expand the local computer by clicking the plus sign. 
1284. Right-click the Web Sites folder, click Properties, and then click the Service tab. 

1285. Under Isolation mode, clear the Run Web service in IIS 5.0 isolation mode check box to configure IIS to run in worker process isolation mode.

2. Change the application pool identity for IIS to use the Business Connector Proxy account

1286. In the left pane of the IIS Manager, expand Application Pools.
1287. Right-click Application Pools, and then click New > Application Pool.

1288. Enter a name for the application pool, and click OK.

1289. Right-click the application pool that you created and click Properties. 

1290. Click the Identity tab.

1291. Select Configurable.

1292. Enter the Business Connector proxy account username and password. 

1293. Verify the password, and click OK.

1294. Click Finish to close the wizard.

3. Create a virtual root

If you did not choose to use the default IIS virtual root (%Systemdrive%\Inetpub\Wwwroot\) during installation, you must create a virtual root.

1295. In IIS Manager, expand the local computer, expand the Web Sites or FTP Sites folder, right-click the site or folder within which you want to create the virtual directory, point to New, and then click Virtual Directory. The Virtual Directory Creation Wizard appears.
1296. In the Alias box, type a name for the virtual directory, and then click Next. Choose a short name that is easy to type because the user types this name.

1297. In the Path box, type or browse to the physical directory in which the virtual directory resides, and then click Next. 

1298. Under Allow the following permissions, select Read for all users, and then click Next. 

1299. Click Finish. The virtual directory is created below the currently selected folder level. 

4. Set the properties for the virtual directory you created

1300. In the left pane of the IIS Manager, expand Web Sites, expand Default Web Site, right-click the folder where you installed the Application Integration Web services (by default, DynamicsWebServices), and click Properties.
1301. On the Directory tab, under Application settings, click Create. 

1302. In the Execute Permissions list, select Scripts only.

1303. In the Application Pool field, select the application pool you associated with the Business Connector proxy account.

1304. On the Directory Security tab, under Authentication and access control, click Edit.

1305. In the Authentication Methods dialog box, clear the Enable anonymous access check box, then under Authenticated access, verify that Integrated Windows authentication is selected.

1306. On the ASP.NET tab, in the ASP.NET version list, select 2.0.50727, and then click OK. 

If you do not see an ASP.NET tab, see Troubleshoot problems operating the Application Integration Framework.

1307. Click OK again to save the changes you have made.

Restrict access to application integration files

When an application integration server is installed, Setup does the following: 

· Creates a local Windows group Dynamics AX Web Service Administrators. 

· Creates a network share in the directory where the AIF files are installed. The network share is called Aifwebservice.

· Grants Full Control permissions on the share to the Dynamics AX Web Service Administrators local group and to the AOS account. This enables the Web services generated from the AOS to write and delete files in the virtual directory.

Restrict access

1308. Open the Computer Management application (Start > Administrative Tools > Computer Management).
1309. Expand the Groups folder under Local Users and Groups.

1310. In the Dynamics AX Web Service Administrators local group, verify that only the AOS account is a member of the group. 

1311. If you have more than one AOS server, add the AOS account for each server to the group.

1312. If you are using the default permissions in Microsoft Windows Server 2003, all domain users have Read and Execute permissions to the virtual directory where AIF is installed. For details, see the Default local groups article on TechNet. If you are not using default permissions, you may need to grant access to the share using one of the methods below. 

· Create a local Windows group with access to the directory and add users of the AIF Web service to it. 

· Add users of the AIF Web service to the local Users group of the computer.

Set up AIF and Enterprise Portal to coexist (optional)

For the Application Integration Framework (AIF) to coexist with Windows SharePoint Services (WSS) and Enterprise Portal on the same computer, the virtual directory that AIF is using must be excluded from the SharePoint managed path. 

To exclude the AIF virtual directory from the SharePoint managed path list: 

1313. Launch the SharePoint Central Administration page. (Start > All Programs > Administrative Tools > SharePoint Central Administration); or, from the browser on a remote computer, type the URL for the pages on the administration port. For example: http://servername:port.
1314. Click Configure virtual server settings and click the name of the site you are managing. 

1315. Under Virtual Server Management, click Define managed paths.

1316. Under Add a New Path, enter the AIF virtual directory path, and then select Excluded path, and click OK.

Next steps

Now that you have set up AIF Web services, you must configure them. For details, see About integration using Web services.

Configure IIS to work with Microsoft Dynamics AX Web services

In order to perform document exchanges that expose Web services (that is, enable transfers using inbound Web services), you must install an application integration server using the Microsoft Dynamics AX setup program, as well as Microsoft Internet Information Services (IIS) 6.0. A core Microsoft Dynamics AX installation must also reside in the domain. We recommend that the application integration server and the Application Object Server (AOS) be installed on different computers. For details on installing an application integration server, see Install an application integration server.

Additional steps for configuring IIS and adding a Web site for use by AIF are included below.

Configure an existing installation of IIS

To locate your existing installation of IIS Services Manager, click Start > All Programs > Administrative tools > Internet Information Services Manager. For complete instructions on configuring IIS Services Manager, see the IIS documentation on Technet.

Configure IIS to run in worker process isolation mode

AIF requires that IIS 6.0 be running in worker process isolation mode and not IIS 5.0 isolation mode. The application isolation mode applies globally to the IIS service and affects all Web applications on the computer. You cannot apply an application isolation mode to individual applications. 

To select worker process isolation mode in IIS 6.0: 

1317. Open the IIS management console and expand the local computer by clicking the plus sign. 
1318. Right-click the Web Sites folder, click Properties, and then click the Service tab. 

1319. Under Isolation mode, clear the Run WWW service in IIS 5.0 isolation mode check box to configure IIS to run in worker process isolation mode. 

Finish configuring IIS after setup

1320. To open IIS Services Manager, click Start > All Programs > Administrative tools > Internet Information Services Manager. 
1321. In IIS Manager, navigate to the virtual root DynamicsWebService.

1322. Click Action > Properties. 

1323. On the Directory tab, click Create.

1324. Select the Application Pool created when you set up the application integration server. For additional information, see Install an application integration server.

1325. For Execute permissions, select Scripts only.

1326. Set the local path permissions to read by selecting the Read check box in the Local path section.

1327. Navigate to Directory Security and clear Anonymous. Select Integrated.

1328. On the ASP.NET tab, select ASP Version 2.0. If the ASP.NET tab does not appear, you must uninstall and reinstall ASP.NET in IIS using the following steps:

aq. Click Start > Run.
ar. Type cmd.

as. In the Command Prompt window, type:

cd your-system-directory\Microsoft.NET\Framework\v2.0.50727. and press ENTER.

at. Type aspnet_regiis.exe -u and press ENTER.

au. Type aspnet_regiis.exe –i -enable and press ENTER.

av. Type iisreset and press ENTER.

aw. Close the Command Prompt window.

After uninstalling and reinstalling ASP.NET and resetting IIS, the ASP.NET tab is available, and you can select ASP version 2.0. This allows you to browse the Web services after you create them on the Action form. See Create Web services for an action.
Add a Web site for use by AIF

After you finish configuring IIS, you add a Web site in the Microsoft Dynamics AX client, using the Web sites form.

1329. Click Basic > Setup > Application Integration Framework > Web sites.
1330. Press CTRL+N to create a new Web site, or select one of the Web sites from the list.

1331. On the General tab, enter a descriptive name for this Web site in the Name field.

The name may contain special characters and blanks and may be up to 50 characters long.

1332. In the Virtual directory share path field, enter the path to the virtual directory to contain the Web service components that are generated from actions. Specify the path to the share created when you installed the application integration server as a Windows share, that is, it should have the format \\computer-name\share-name. Click Validate to check that the share name is correct and that the AOS service account has been given Read and Write access.

Configuring document exchanges

You configure document exchanges differently for asynchronous, adapter-based exchanges than for synchronous exchanges that use inbound Web services. Adapter-based exchanges include outbound Web services. These asynchronous exchanges are set up to process messages in queues using Microsoft Dynamics AX batch jobs. Inbound Web services require you to set up and configure IIS and an application integration server on your system to enable the synchronous data exchange.

Set up Application Integration Framework for document exchange

Setting up the Application Integration Framework (AIF) for document exchange involves one or both of the following tasks:

· Set up transport adapter-based exchanges (A transport adapter is a software component that enables an asynchronous exchange, in which documents are placed in queues to await processing by different transport mechanisms. To start and stop processing in the queues you use the batch functionality in Microsoft Dynamics AX. Examples include using Microsoft Message Queuing (also known as MSMQ), outbound Web services, or the file system for the exchange.).

Note   A transport adapter is a software component that enables an asynchronous exchange using a particular transport mechanism. Header information is added to XML documents to create messages, and these messages are placed on queues for processing by AIF services.

· Set up exchanges that expose Web services for inbound document transfer.

Set up inbound Web services

If you are setting up inbound Web services, you must perform these three steps as prerequisites:

· Set up an application integration server. See Install an application integration server.

· Configure IIS. See Configure IIS to work with Microsoft Dynamics AX Web services.

· Configure a Web site for use by AIF with the Web sites form. See Configure Web sites for document exchange.

Set up required elements for an exchange 

All exchanges require that you set up the transfer using the following forms:

· Local endpoints - The local endpoint represents your Microsoft Dynamics AX installation. See Create and configure local endpoints.

· Action - An action is comprised of a document and an operation, for example, createSalesOrder. This form is also used to generate Web services from actions. See Configure an action and Create Web services for an action.

· Endpoints - Endpoints represent your trading partners). See Configure an Endpoint.

· Action policies - Action policies relate actions to endpoints. See Configure endpoint action policies.

· Data Policies - The data policy specifies which fields participate in the transfer. See Configure endpoint action data policies.

These forms are optional for document exchanges regardless of transport:

· Configure global defaults on the Global settings form. Global defaults configure adapters, actions, resource locks for batch processing, and schema validation, as well as the default encoding format for documents. See Configure global settings for document exchange.

· Configure optional document transformations on the Pipeline components form. Optional document transformations include XSLT style sheet mapping and value substitutions. See Configure a pipeline.

· Set up optional pre-defined value mapping that is available for certain documents on the Registration Entries form. See Configure endpoint action policies.

Configure the adapter-based exchange

For adapter-based exchanges you also configure an adapter, a transport mechanism, a channel, and the batch jobs that process documents in the queues using the following steps:

1333. Perform any prerequisite steps for your transport mechanism. 
· For exchanges using the file system, see Configure Microsoft Dynamics AX to use the file system for exchanging documents. 

· For exchanges using Message Queuing, see Configure MSMQ to work with Microsoft Dynamics AX.

1334. Configure an adapter using the Transport adapters form. Adapters are software components that translate the XML document into a format for a particular transport, for example, Message Queuing or file system. See Configure an adapter.

1335. Configure a channel using the Channels form. Channels specify the direction for a particular transport in an adapter-based exchange. You also specify a transport mechanism that corresponds to the adapter on this form. See Configure a Channel.

1336. To set up the batch jobs that run the services that manage inbound and out documents in the queues for adapter-based exchanges, click Basic > Setup > Batch and select from the Batch groups, Journal types or Journal names forms. See Start and stop the asychronous AIF services.

Configure global settings for document exchange

In the Global settings form, you can set global defaults for configuring:

· Adapters

· Actions

· AIF "resource locks"

· Schema validation

· Default encoding format for documents. An encoding format is a code that pairs a set of characters with numeric codes to facilitate electronic storage or data exchange. Common encoding formats include Unicode and UTF-8.

Setting the maximum resource locking interval determines how often the various services lock resources when processing messages. The maximum locking interval is used by the gateway service to lock channels for inbound and outbound processing, by the inbound processing service to lock channels for inbound processing, and by the outbound processing service to lock endpoints for outbound processing. 

· If the locking interval is set too small, the locks expire faster. When a lock expires and another Application Object Server (AOS) is available, the same channel or endpoint is processed again. This can lead to a waste of resources as the channel or endpoint is processed continuously when no messages are present. . 

· If the lock is set too large it takes the system longer to recover if there is a failure. It is difficult to choose a number that works for all cases. 

You should change the maximum locking interval after monitoring the volume of exchanges for your particular system.

Note   Choosing to validate the schema for every outbound document may negatively impact performance.

Set the maximum resource locking interval

For adapter-based exchanges, AIF implements a scheme for locking endpoints and channels to guarantee that messages are processed in a particular order. After one of the AIF services (AifInboundProcessingService, AifOutboundProcessingService, GatewaySendService, and GatewayReceiveService) begins processing messages related to a channel or an endpoint, a "lock" is set for that resource. If the service stops processing the resource before all messages have been transferred, the "lock" on the resource expires after the maximum locking interval you set, and another service can begin processing that resource. For more information about the AIF services, see Start and stop the asychronous AIF services.

If your installation only runs one instance of the AIF services, the maximum locking interval is not used. 

The default value for the maximum resource locking interval is 30 minutes. If your installation only runs one instance of the AIF services, and those services are interrupted while processing channels or endpoints, the maximum time before the services can begin processing again is 30 minutes.

However, if you are exchanging documents using more than one channel or more than one endpoint, and you use multiple Application Object Server (AOS) instances installed on multiple computers, you may need to consider setting the maximum locking interval.

1337. To set the maximum resource locking interval for channels and endpoints (that is, the maximum time in minutes that the channels and endpoints are to remain locked if processing ceases), click Basic > Setup > Application Integration Framework > Global settings.
1338. Enter the time in minutes in the Maximum resource locking interval (minutes) field. 

1339. Press CTRL+S to save changes.

Set the default behavior for enabling Web services

Note   If no Web sites have been configured, Web services are not enabled regardless of this setting. To set up Web sites, see Configure Web sites for document exchange.

To enable creation of Web services by default on the Action form:

1340. Click Basic > Setup > Application Integration Framework > Global settings.
· Select the Enable Web methods by default field to enable Web methods by default when creating actions.

· Clear the Enable Web methods by default field. 

Note   Clearing this field also clears the Web method enabled field on the Action form.

1341. Press CTRL+S to save your changes.

Set the default encoding format

1342. Click Basic > Setup > Application Integration Framework > Global settings.
1343. In the Default encoding format field, select a supported encoding format from the list to be used as the default on the Endpoints form.

1344. Press CTRL+S to save your changes.

Set up validation for all outbound documents

1345. Click Basic > Setup > Application Integration Framework > Global settings.
1346. Select the Validate outbound schema field.

1347. Press CTRL+S to save changes.

Create and configure local endpoints

A local endpoint is the origination for sent messages and the destination for received messages. That is, the local endpoint refers to your Microsoft Dynamics AX installation. There may be more than one local endpoint, depending on how many companies are configured for your Microsoft Dynamics AX installation.

The name of the local endpoint identifies you to your trading partners, therefore we recommend that the name for the local endpoint be representative of the Microsoft Dynamics AX company name that participates in the exchange.

1348. Click Basic> Setup > Application Integration Framework > Local endpoints.
1349. Press CTRL+N to create a new local endpoint record.

1350. Select a company from the Company field.

1351. Enter a name for the endpoint in the Local endpoint field.

The name for the local endpoint should be representative of the Microsoft Dynamics AX company name that participates in the exchange.

1352. Press CTRL+S to save the data.

Configuring document exchanges with adapters

A transport adapter is a software component that enables an asynchronous exchange, in which documents are placed in queues to await processing by different transport mechanisms. To start and stop processing in the queues, you use the Batch functionality in Microsoft Dynamics AX. Transport adapters available when you install Microsoft Dynamics AX include Microsoft Message Queuing (also known as MSMQ), outbound Web services, and file system.

When you configure a document exchange that uses an adapter, you must perform the following tasks:

1353. Perform any prerequisite steps for your transport mechanism.
· For exchanges that use the file system, see Configure Microsoft Dynamics AX to use the file system for exchanging documents.

· For exchanges that use MSMQ, see Configure MSMQ to work with Microsoft Dynamics AX.

1354. Create a local endpoint by using the Local endpoint form.

The local endpoint represents your Microsoft Dynamics AX installation.

1355. Configure an action by using the Local endpoint form.

An action is comprised of a document and an operation, such as createSalesOrder. This form is also used to generate Web services from actions).

1356. Create and configure an endpoint for the trading partner in the exchange by using the Local endpoint form.

Endpoints represent your trading partners.

1357. Configure the endpoint action policy to associate the desired actions with the endpoint by using the Local endpoint form.

Action policies relate actions to endpoints.

1358. Configure endpoint action data policies by using the Local endpoint form.

The data policy specifies which fields participate in the transfer.

1359. Configure an adapter by using the Local endpoint form.

Adapters are software components that translate the XML document into a format for a particular transport, for example, MSMQ or file system.

1360. Configure a channel by using the Local endpoint form.

Channels specify the direction for a particular transport in an adapter-based exchange. You also specify a transport mechanism that corresponds to the adapter on this form.

1361. Click Basic > Setup > Batch to set up the batch jobs to run the services that manage inbound and outbound documents in the queues for adapter-based exchanges.

These forms are optional when setting up a transfer:

· Use the Batch form to configure global defaults for configuring adapters, actions, resource locks for batch processing, and schema validation, as well as the default encoding format for documents.

· Use the Batch form to configure optional document transformations, including XSLT style sheet mapping or value substitutions.

· Use the Value Mapping form to set up optional predefined value mapping that is available for certain documents.

Creating and configuring actions

Actions are created when document classes are implemented. The term action refers to the document (for example, SalesOrder) and the operation on that document (for example, create or read). The action type describes the direction of the transfer and the element being transferred. There are six types of actions:

· ReceiveDocument

· ReceiveDocumentList

· QueryEntityKeys

· QueryDocuments

· SendDocument

· SendDocumentList
After document classes have been implemented, you configure actions using the Action form.

Configuring an action includes the following tasks:

· Scanning the Application Object Table (AOT) for new actions.

· Enabling actions for use in document exchanges.

· Enabling and generating Web services for an action when configuring a transfer using inbound Web services.

· Viewing the schema for the document.

· Viewing the action status.

· Viewing any errors that arise from creating actions and Web services.

Perform these tasks in any order and as often as you need to as you debug and tune the exchange you are setting up. 

Create an action

An action refers to the document and the operation to be performed on it, such as Send or Receive. After a document class is implemented, an action or actions are available for the document in the Application Object Tree (AOT). 

To make the documents and actions available for use in exchanges, you must first scan the AOT and register the actions, which creates them in the AifAction table and makes them available on the Action form. Then you can enable actions to use in exchanges. You must register and enable each action before you can use it in an exchange. You can also generate Web services from an action on the Action form. For more information, see Create Web services for an action. 

Note   Certain actions, such as creating exchange rates, cause data to be written directly to the Microsoft Dynamics AX database without manual end-user verification. When configuring endpoints and creating new actions, be especially careful to restrict access to trusted and reliable partners and applications.

1362. Click Basic > Setup > Application Integration Framework > Action. No actions are present if this is the first time you have opened the form after Microsoft Dynamics AX is installed.
1363. Click Scan and register.

1364. After all actions are scanned and registered, select Enabled to enable the action to use in an exchange.

1365. If any errors occur, select an action and click View errors to view errors associated with the selected action.

Configure an action

An action refers to the document and the operation to be performed on it, such as Send or Receive. After a document class is implemented, an action or actions are available for the document in the Application Object Tree (AOT). 

To make the documents and actions available for use in exchanges, you register and enable actions using the Action form. Registering actions creates them in the AifAction table and makes them available on the Action form. You must enable each action before you can use it in an exchange. You can also generate Web services from an action on the Action form. For more information, see Create Web services for an action.

Security note for actions on inbound documents

Certain actions, such as creating exchange rates, cause data to be written directly to the Microsoft Dynamics AX database without manual end-user verification. When configuring endpoints and creating new actions, be careful to restrict access to trusted and reliable partners and applications.

Register and enable actions

1366. Click Basic > Setup > Application Integration Framework > Application Integration Framework.
1367. To register all actions for document classes that exist in the Application Object Tree (AOT), click Scan and register. Registering an action creates a row for it in the AifAction table.

1368. After all items are scanned and registered, select Enabled to enable the actions you need for your exchange.

Note   Select an action on the Overview tab and click Re-register if you need to regenerate actions and create or update the row for that action in the action table. Note that re-registering affects all the actions on the document class for the action you have selected.

Register actions using the AOT

This is an alternate way of registering actions for one particular document class. It is useful if you have a new document class and don't want to wait for the scanning process, which registers all actions for all documents in the AOT.

1369. Open the AOT and expand the Classes node.
1370. Navigate to the document class to re-register (for example AxdSalesPackingSlip).

1371. Right-click on the document class and click Add Ins > Register actions.

1372. The registered action or actions are available on the Action form.

View the schema and error log

1373. Click Basic > Setup > Application Integration Framework > Application Integration Framework.
1374. On the Overview tab, select an action.

1375. To view the XML schema of the document for the selected action, click View schema.

1376. To view the Infolog from the last attempt to generate actions or the XML schema of the document for the selected action or from the last attempt to generate Web services, click View errors.

Sort on document class

1377. Click Basic > Setup > Application Integration Framework > Application Integration Framework.
1378. Press CTRL+F3 to set up an advanced filter or sort on the Inquiry form.

1379. In the lower pane, click the Sorting tab.

1380. Press CTRL+N to create a new sorting field.

1381. Select Action in the Table field.

1382. Select Document class in the Field field.

1383. Select Ascending or Descending in the Search direction field.

1384. Click OK to return to the Search direction form.

About creating and configuring adapters

Adapters are the software components that enable document exchange by communicating with specific transport mechanisms, for example, file system, Microsoft Message Queuing (MSMQ) or outbound Web services. Several adapters are installed with the framework, including one for transferring documents via the file system, one for transferring documents via MSMQ, and one for outbound Web services. You can also create custom adapters for your own specific needs.

After a custom adapter has been created (coded), you add it to the list of available adapters and enable it. Then you create and configure a new channel to use the new adapter. Detailed instructions for creating new adapters can be found in the SDK. Note that you can only delete an adapter if it has no corresponding channels.

This section includes the following:

Configure an adapter
Delete an adapter
Configure an adapter

The following adapters are available after installing Microsoft Dynamics AX:

· AifFileSystemAdapter

· AifMSMQAdapter

· AifWebServiceAdapter

· AifBizTalkAdapter

To configure an adapter for use in a channel, you activate it and specify its direction (inbound, outbound, or both) on the Search direction form.

Adapters may be hosted or isolated and this status is displayed for informational purposes only on the Search direction form. 

· A hosted adapter relies on the Application Integration Framework (AIF) gateway services to send or receive messages. 

· An adapter that is isolated is external to the AIF gateway service and is implemented so that it controls sending or receiving of messages. 

For more information about the AIF gateway service, see Start and stop the asychronous AIF services.

1385. Click Basic > Setup > Application Integration Framework > Application Integration Framework.
1386. Select the adapter you want to use. 

Note   The first time the form is opened, the process of scanning for adapters may take a few moments. There is a progress bar at the bottom of the form.

1387. To make the adapter available for use in a channel, click Active.

1388. If the adapter has been implemented as "unidirectional," on the General tab, select a direction (inbound or outbound) for the adapter. 

If the adapter is not set to "unidirectional," the direction for the adapter appears as it has been implemented and you cannot change it.

1389. The Hosted checkbox indicates whether the adapter is hosted. 

A hosted adapter uses the gateway queue to send and receive messages.

Creating and configuring channels

Channels define the transport method that enables messages to move in and out of the framework to reach the endpoint. Before configuring a channel, a transport adapter must be available. For more information, see Configure an adapter. 

Channels may support inbound transfers only, outbound only, or both. Configuration settings are different depending on the direction for the transfer in the channel as well as for different adapters. Inbound channels may use a response channel that handles verification or error responses to inbound transfers.

Three adapters are included with each Microsoft Dynamics AX installation to enable transfers by using the file system, Message Queuing (also known as MSMQ), and outbound Web services. These adapters are available for channel configuration without any customization of your installation.

Note   Transfers implemented using outbound Web services require an adapter to pass messages with document information to the endpoint's Web service implementation. Therefore, outbound Web services are asynchronous and adapter-based. Only transfers using inbound Web services are synchronous.
Create a channel

Channels define the transport method and transport address that enable messages to move in and out of the framework to reach the endpoint. Before configuring a channel, you must have activated an adapter on the Transport adapters form. For more information, see Configure an adapter.

1390. Click Basic > Setup > Application Integration Framework > Application Integration Framework. 
1391. Press CTRL+N to create a new channel.

1392. Select an adapter in the Adapter field.

Note   You must first have activated an adapter on the Transport adapters form before it appears in the list of available adapters.

1393. Enter the unique identification information for the new channel, including an identifier in the Channel ID field and a friendly name in the Name field.

1394. To activate the channel and allow it to participate in document exchanges, click Active.

1395. Configure the address for the adapter. 

· If you are using one of the adapters included with Microsoft Dynamics AX (file system, Message Queuing, or outbound Web services), you choose an adapter-specific Address. 

· If you are using a custom adapter, click Configure and enter the adapter-specific information. 

For more information, see Configure a Channel.

1396. Select from the available directions for the transfers to be performed in this channel (Inbound, Outbound, or Both). The list of available directions depends on the adapter.

1397. If the direction is set to Inbound, you can select a response channel. 

Inbound channels can use an outbound channel called a "response channel" to transfer or "respond back" to the source endpoint with verification results or error responses to inbound transfers. 

1398. On the General tab, set the Maximum batch size to the maximum number of messages to be processed at one time from the queues. 

Note   You can select Unlimited if you do not want to limit this number.

Configure a channel

Channels define the transport method and transport address that enable messages to move in and out of the framework to reach the endpoint. Before configuring a channel, you must have activated an adapter on the Transport adapters form.

Configure a channel to use the file system transport adapter

1399. Click Basic > Setup > Application Integration Framework > Channels. 
1400. Press CTRL+N to create a new channel, or select an existing channel to configure.

1401. Enter a unique identification for the new channel, and a free-text name to identify it.

1402. To activate the channel, select Active. 

1403. For file system transfers, in the Adapter field, select File System Adapter. 

Note   You must previously have activated this adapter on the Transport adapters form.

1404. In the Direction, select the direction for the transfers to be performed in this channel (Inbound, Outbound, or Both).

1405. In the Address field, select an address (a file folder) for the channel to use. For more information, see Configure Microsoft Dynamics AX to use the file system for exchanging documents.

1406. If the direction is set to Inbound, in the Response channel field, select a response channel. 

Inbound channels can use an outbound channel called a "response channel" to transfer or "respond back" with verification results or error responses to inbound transfers. 

1407. On the General tab, for the maximum number of messages to be processed at one time from the queues, set the Maximum batch size. 

You can select Unlimited if you do not want to limit this number.

Configure a channel to use Message Queuing and the MSMQ adapter

1408. Click Basic > Setup > Application Integration Framework > Channels. 
1409. Press CTRL+N to create a new channel or select an existing channel to configure.

1410. Enter a unique identification for the channel, and a free-text name to identify it.

1411. To activate the channel, select Active. 

1412. For Message Queuing (also known as MSMQ), select MSMQ Adapter in the Adapter field. 

Note   You must previously have activated this adapter on the Transport adapters form.

1413. In the '-AOS-' is an invalid User ID field, select the direction for the transfers to be performed in this channel (Inbound, Outbound, or Both).

1414. Select an address (the name of the MSMQ queue that you have installed) for the channel to use. 

For more information about installing MSMQ to work with Application Integration Framework (AIF), see Configure MSMQ to work with Microsoft Dynamics AX.

1415. If the direction is set to Inbound, in the Response channel field, select a response channel. 

Inbound channels can use an outbound channel called a "response channel" to transfer or "respond back" with verification results or error responses to inbound transfers. 

1416. On the General tab, for the maximum number of messages to be processed at one time from the queues, set the Maximum batch size. 

You can select Unlimited if you do not want to limit this number.

Configure a channel to use the outbound Web services transport adapter

1417. Click Basic > Setup > Application Integration Framework > Channels. 
1418. Press CTRL+N to create a new channel, or select an existing channel to configure.

1419. Enter a unique identification for the channel, and a free-text name to identify it.

1420. To activate the channel, click Active. 

1421. For outbound Web services, in the Adapter field, select Outbound Web Service Adapter. 

Note   You must previously have activated this adapter on the Transport adapters form.

1422. Select an address (the URL for the Web site where the Web services components reside) for the channel to use. For more information, see Configure outbound Web services.

1423. On the General tab, for the maximum number of messages to be processed at one time from the queues, set the Maximum batch size. 

You can select Unlimited if you do not want to limit this number.

Configure a channel to use the BizTalk transport adapter (Create the BizTalk Group)
1424. Click Basic > Setup > Application Integration Framework > Application Integration Framework. 
1425. Press CTRL+N to create a new channel.

1426. Select the AifBizTalkAdapter in the Adapter field.

1427. Enter the unique identification information for the new channel, including an identifier in the Channel ID field and a friendly name in the Name field.

1428. To activate the channel and allow it to participate in document exchanges, click Active.

1429. In the Direction field select Bothfor the direction for the transfers to be performed in this channel.

1430. In the Addressfield, enter the name of the BizTalk group to use. 

1431. Press CTRL+S to save the channel.

1432. Click Configure.

1433. Enter the names of the computers running BizTalk Server that belong to the specified BizTalk group. Press CTRL+N to add each server to the list. 

Configure a channel to use a custom transport adapter

1434. Click Basic > Setup > Application Integration Framework > Channels. 
1435. Press CTRL+N to create a new channel, or select an existing channel to configure.

1436. Enter a unique identification for the channel, and a free-text name to identify it.

1437. To activate the channel, click Active. 

1438. In the Adapter field, enter the identifier for the adapter that you have configured on the Transport adapters form.

1439. In the '-AOS-' is an invalid User ID field, select the direction for the transfers to be performed in this channel (Inbound, Outbound, or Both).

1440. If the direction is set to Inbound, in the Response channel field, select a response channel. 

Inbound channels can use an outbound channel called a "response channel" to transfer or "respond back" with verification results or error responses to inbound transfers. 

1441. To configure the custom adapter for the connection, click Configure. 

1442. On the General tab, for the maximum number of messages to be processed at one time from the queues, set the Maximum batch size. 

You can select Unlimited if you do not want to limit this number.

Creating and configuring endpoints

Using Application Integration Framework (AIF), you enable document exchanges between endpoints and the local endpoint. A local endpoint is the origination for sent messages and the destination for received messages. That is, the local endpoint refers to your Microsoft Dynamics AX installation.

An endpoint is the destination for an outbound document and the source of an incoming document. That is, an endpoint represents your trading partner in a document exchange.

Before you can configure an endpoint, the following must already exist and be configured:

· A local endpoint.

· A named action for the exchange, consisting of a document and a description of the operation to be performed on it, for example, ReadSalesOrder. For more information, see Creating and configuring actions.

· Microsoft Dynamics AX users to be associated with the endpoint.

· An outbound channel must be already be defined if needed.

When you configure an endpoint, you enter information about the following:

· Identifying information for the endpoint, including an identifier, a friendly name, the active status, the associated channel, and the Microsoft Dynamics AX company identification.

· Constraints on the endpoint that restrict document exchange by defining valid Microsoft Dynamics AX customers or vendors.

· Microsoft Dynamics AX users and trusted intermediaries that are allowed to submit documents for the exchange.

· Endpoint action policies that relate actions to the endpoint.

· Pipeline components for any optional document transformations for the action related to the endpoint.

· Endpoint action data policies (or "data policies") that defines which fields in a document are allowed or required to participate in the exchange.

· Document configuration options, including value mapping. For more information, see About External Codes.

Create an endpoint

Before you can create an endpoint, the following must already exist and be configured:

· A local endpoint

· A named action for the exchange, consisting of a document and a description of the operation to be performed on it, for example, createPurchaseOrder. For more information, see Creating and configuring actions.

· Microsoft Dynamics AX users to be associated with the endpoint

· An outbound channel must be already be defined if needed.

1443. Click Basic > Setup > Application Integration Framework > Endpoints.

1444. Press CTRL+N to create a new endpoint.

1445. Do not select Intercompany organization unless the endpoint is to be used in an intercompany transfer. For more information about these transfers, see Intercompany for sales orders or Intercompany purchase orders.

1446. Enter the information for the endpoint, including the endpoint identification information, name, local endpoint ID, and channel information (outbound or both).

1447. On the Constraints tab, click No constraints to clear the form and allow data to be exchanged regardless of any associations. For more information, see Configure an Endpoint. After selecting, the No constraints check box becomes unavailable. However, if you add constraints later, the check box clears itself.

1448. On the Overview tab, select Active to activate the endpoint.

1449. On the Users tab, enter information to restrict users that are authorized to initiate transactions for the endpoint. In the User type field, select either User or User group. 

You can also designate trusted intermediaries on the Users tab. Trusted intermediaries are logical “middle men” between external endpoints and AIF, that is, they are Microsoft Dynamics AX users (or user groups) that are authorized to submit inbound requests on behalf of the endpoint. For more information about trusted intermediaries, see Security considerations for the Application Integration Framework.

Note   When configuring users on an endpoint, keep in mind that these Microsoft Dynamics AX users may represent outside interests and must have permissions set appropriately. For more information about configuring Microsoft Dynamics AX users, see Managing access to Microsoft Dynamics AX, Manage permissions, Manage user groups, and Manage users. You must also set the appropriate security keys and record-level security for any users that are granted access to Microsoft Dynamics AX through Application Integration Framework (AIF), to help prevent unauthorized data access. For more information, see Manage record-level security, Security keys, and Set up security keys. Certain actions cause data to be written directly to the Microsoft Dynamics AX database without manual end-user verification (for example, creating exchange rates). When configuring endpoints and creating new actions, be especially careful to restrict access to trusted and reliable partners and applications.

1450. Click Action policies to configure actions on the endpoint with the Action policies form. Examples of actions include SendSalesOrder and ReceivePurchaseOrder. For details on setting up action policies, see Configure endpoint action policies.

1451. From the Action policies form you can select an action and click Data Policies to enter the data policy, that is, information about which fields are required and which are optional in the document to be exchanged. For details on setting up data policies, see Configure endpoint action data policies.

1452. From the Action policies form, you can click Configure to perform document-specific configuration, including value mapping. Value mapping is the translation of field data values based on business rules, for example, translating internal item numbers to vendor-specific item numbers or industry standard numbers depending on the trading partner. For more information, see Configure endpoint action data policies.

Configure an endpoint

When you configure an endpoint, you enter information on the Endpoints form about the following:

· Identifying information for the endpoint, including a unique identifier, a friendly name, the active status, the intercompany status, local endpoint, Microsoft Dynamics AX company identification for an intercompany exchange, channel information (if any), and encoding format for the transfer

· Constraints on the endpoint that restrict document exchange by defining valid Microsoft Dynamics AX customers or vendors or warehouses

· Microsoft Dynamics AX users and trusted intermediaries that are allowed to submit documents for the exchange

· Endpoint action policies that relate actions to the endpoint

· Pipeline components for an action related to the endpoint

· Endpoint action data policies that define which fields in a document are required for the exchange

Configure endpoint identification

1453. Click Basic > Setup > Application Integration Framework.> Endpoints.
1454. Press CTRL+N to create a new endpoint, or select an existing endpoint from the list to be modified.

1455. Enter the information for the endpoint on the General tab, including the unique endpoint identification information, the friendly name for the endpoint, the local endpoint ID, and the default encoding format.

1456. For intercompany transfers, select Intercompany organization if the endpoint is a company within your Microsoft Dynamics AX installation, and select a company in the Company field. 

Do not select Intercompany organization unless the endpoint is to be used in an intercompany transfer. For more information about these transfers see Intercompany for sales orders or Intercompany purchase orders.

1457. Selecting an outbound channel is not required for all exchanges. However, if your Microsoft Dynamics AX installation is sending messages to this endpoint (for example, if you are configuring an outbound-only exchange), you must select a channel in the Outbound channel ID field.

1458. In the Local endpoint ID field, select the local endpoint identification that participates in exchanges with this endpoint.

Note   There may be more than one local endpoint configured for your Microsoft Dynamics AX installation. If that is the case, then be sure to select the correct local endpoint to participate in the exchange with the endpoint you are configuring.

1459. View the pre-populated setting for encoding format in the Default encoding format field. This setting defaults to the value set on the Global settings form.

Configure constraints on an endpoint and activate the endpoint

1460. Click Basic > Setup > Application Integration Framework > Endpoints.
1461. Press CTRL+N to create a new endpoint, or select an existing endpoint from the list to be modified.

1462. On the Constraints tab, select No constraints to clear the form and allow data to be exchanged regardless of any association. The No constraints check box becomes unavailable. However, if you add constraints later, the check box clears itself.

1463. Press CTRL+N to create a new constraint. 

1464. Choose the Constraint type (Vendor, Customer or Warehouse).

1465. Select a Constraint ID from the list. The Name field is completed when you select the Constraint ID.

1466. On the Overview tab, select Active to activate the endpoint. 

Messages flow through the framework from the local endpoint to and from any active endpoints.

Configure users and trusted intermediaries for an endpoint

You must enter information for at least one endpoint user or trusted intermediary who is authorized to initiate transactions for the endpoint on the Users tab.

Note   When configuring users on an endpoint, remember that these Microsoft Dynamics AX users may represent outside interests and must have permissions set appropriately. For more information about configuring Microsoft Dynamics AX users, see Managing access to Microsoft Dynamics AX, Manage permissions, Manage user groups, and Manage users. 

You must also set the appropriate security keys and record-level security for any users that are granted access to Microsoft Dynamics AX through Application Integration Framework (AIF), to help prevent unauthorized data access. For more information, see Manage record-level security, Security keys, and Set up security keys.

Certain actions cause data to be written directly to the Microsoft Dynamics AX database without manual end-user verification (for example, creating exchange rates). When configuring endpoints and creating new actions, be especially careful to restrict access to trusted and reliable partners and applications.

Configure an endpoint user

1467. Click Basic > Setup > Application Integration Framework > Endpoints.
1468. Press CTRL+N to create a new endpoint, or select an existing endpoint from the list to be modified.

1469. Click the Users tab.

1470. Under Endpoint users, in the User type field, select either User or User group.

1471. In the Application user or group field, select a valid Microsoft Dynamics AX user or user group name. The Name field is filled in automatically.

For more information about Microsoft Dynamics AX users and user groups, see Managing access to Microsoft Dynamics AX.

Configure a trusted intermediary

Trusted intermediaries are logical “middle men” between external endpoints and AIF, that is, they are Microsoft Dynamics AX users (or user groups) that are authorized to submit inbound requests on behalf of the endpoint. For more information about trusted intermediaries, see Security considerations for the Application Integration Framework.

For more information about Microsoft Dynamics AX users and user groups, see Managing access to Microsoft Dynamics AX.

Note   If the Use trusted intermediary box is checked, there must be at least one entry in the Trusted intermediaries grid.

1472. Under Trusted intermediaries, select Use trusted intermediary to enable a trusted intermediary for exchanges with this endpoint. 
1473. Under Trusted intermediaries, in the User type field, also select either User or User group.

1474. In the Application user or group field, select a valid Microsoft Dynamics AX user or user group name. The Name field is filled in automatically.

Configure action policies, data policies, and pipeline components for an endpoint

1475. After you have completed the information in the items above, click Action policies to configure actions on the endpoint. 
For more information about action policies, see Configure endpoint action policies. 

1476. Press CTRL+S to save the action policy.

1477. From the Action policies form, select an action, press CTRL+S, and click Data Policies to enter information about which fields are required and which are optional in the document to be exchanged. 

1478. Click Configure to perform document-specific configuration, including value mapping, for the document exchange. 

Value mapping is translation of field data values based on business rules, for example, translating internal item numbers to vendor-specific item numbers or industry standard numbers depending on the trading partner. For more information, see Configure endpoint action data policies.

1479. Click Pipeline components to configure the pipeline components for any custom transformations performed on the document. For more information, see Creating and configuring a pipeline.

1480. Click View schema to view the XML schema for the document configured by the action policy on the endpoint. On the Schema form, you can click Save as to save the schema as a file.

Give the endpoint user access to Business Connector when using inbound Web services

When you configure an endpoint for inbound Web services, you must configure an endpoint user and/or trusted intermediary, as outlined above. Next, you must give that Microsoft Dynamics AX user or user group access to the Business Connector.

1481. Click Administration > Setup > User groups and select the user group for the endpoint, or the user group that contains the user for the endpoint.
1482. Click Permissions.

1483. On the Permissions tab, select Business Connector Proxy and then select Full control.

1484. Click Cascade.

Configure endpoint action policies

To enable exchange of documents for endpoints, select which actions an endpoint may perform. This process is called configuring endpoint action policies.

Actions are defined as named entities comprising an XML document and an operation on that document. Web services can be generated from actions. Examples of actions are createPurchaseOrder and readSalesOrder. You configure actions on the Action form. For more information, see Creating and configuring actions.

1. Configure an action on an endpoint

Before configuring actions on an endpoint, you must first have registered and enabled actions on the Action form.

1485. Click Basic > Setup > Application Integration Framework > Endpoints.
1486. Select the endpoint to configure and click Action policies.

1487. Press CTRL+N to enter a new action policy.

1488. The Overview tab lists the available actions that you have registered and enabled on the Action form. 

The name of the action in the Action ID field and the name of the document class in the Class name field cannot be changed.

1489. You can change the status of an action associated with the endpoint to Enabled, Disabled, or Hold. 

1490. Select Enabled to make the action active for this endpoint.

Selecting Disabled has the same effect as if the action was not configured on the endpoint.

1491. Select Hold to prevent outbound documents from being passed to the adapter and inbound documents from being passed to the document class. 

The document is held in the queue and may be examined and resubmitted. For more information, see Edit and resubmit messages in the queues. For a synchronous exchange such as a Web service, an error message is generated for the hold condition.

1492. On the General tab, enter a name for External Identifier Override to override the External identifier field on the Action form. 

This sets the contents of the Action tag in the XML document being exchanged.

1493. Press CTRL+S to save the action policy you have created. This makes the buttons available.

1494. Click Pipeline components to create a pipeline for any transformation of the document.

1495. Click View schema to view the XML schema for the document that corresponds to the action you have selected.

2. Select a logging mode for an action on an endpoint

1496. Click Basic > Setup > Application Integration Framework > Endpoints.
1497. Select an endpoint.

1498. Click Action policies.

1499. Select an action on the Overview tab.

1500. On the General tab, select a logging mode (Log Original, Log All, or Log None) for the document exchange. 

· Log Original captures only the information for the initial document transfer, 

· Log All captures information about every transfer 

· Log None stores no data for this action and endpoint.

1501. To view the document history by message or by document, click Basic > Periodic > Application Integration Framework > Document history.

3. Configure document-specific options including value mapping

1502. Click Basic > Setup > Application Integration Framework > Endpoints.
1503. Select an endpoint and click Action policies.

1504. Click Action policies and select an action on the Overview tab.

1505. Click Configure to perform document-specific configuration, including value mapping. 

Value mapping is the translation of field data values based on business rules, for example, translating internal item numbers to vendor-specific item numbers or industry standard numbers depending on the trading partner.

4. Configure data policies for an action on an endpoint

For more information about data policies, see Configure endpoint action data policies.

1506. Click Basic > Setup > Application Integration Framework > Endpoints.
1507. Select an endpoint and click Action policies.

1508. Click Action policies and select an action on the Overview tab.

1509. Click Data Policies to configure required and allowed fields for the document transfer.

Configure endpoint action data policies

A document is made up of many data fields. When you set up a document exchange, you decide, on a field-by-field basis, which data fields are transferred. This is known as the data policy. You configure the data policy on the Data Policies form.

Note   For inbound documents, mandatory fields (that is, fields required by the Microsoft Dynamics AX database) are set to Required by default on the Data Policies form if they cannot be set by default in the database. For outbound documents, the fields to be sent must be set to Enabled.

There are two types of qualifiers for data fields on the Data Policies form: required and enabled. These have different meanings and effects depending on the direction of the transfer. 

If a data field is allowed to be included in an inbound exchange, it is said to be "enabled." For inbound documents, only fields that are enabled are allowed to be submitted by the endpoint. If a document is received that includes fields that are not enabled, the document is rejected and an exception is logged. 

For inbound documents only (for example, actions having an action type of Receive), fields may be designated as Required if the document class defines them as mandatory (that is, they are required for the database record to be inserted or updated and they cannot be defaulted). Additionally, the XML document may specify required elements depending on the business logic in the document class. You can also specify additional required elements by selecting Required for the field on the Endpoint action data policies form. However, you cannot use the data policy to make an element optional if it is required by the document class.

For an inbound document, fields that are enabled but not required are optional to the exchange. Fields in an inbound exchange that are required are automatically designated as enabled - if the document does not contain these fields, the document is rejected.

The concept of "required fields" has no meaning for outbound transfers. For outbound documents, only fields that are enabled are included in the exchange.

Note   When you clear the Enabled check box for a field used for calculating the value of another field, you may also need to clear the Enabled check box for the calculated field, so that unauthorized users may not be able to deduce the value of the original field that is not enabled. Please refer to Using Standard AxdDocuments for details of the calculated fields available in each document.

Configure data fields for an inbound document

You must first configure an endpoint and enable the action or actions for the exchange.

1510. Click Basic > Setup > Application Integration Framework > Endpoints.
1511. Select an endpoint and click Action policies.

1512. Select an action.

1513. Click Data Policies to configure required and allowed fields for the document transfer. 

For fields that are required to be present in the XML document according to the document class, select the Enabled and Required check boxes.

1514. For other fields in the document, you can select Required if the field is required for the document exchange (Enabled is automatically set). 

Note   If you find that your needs for the document transfers change, you can clear the Required check box.

1515. Click Set to clear or select all fields at one time.

Configure data fields for an outbound document exchange

You must first configure an endpoint and enable the action or actions for the exchange.

1516. Click Basic > Setup > Application Integration Framework > Endpoints.
1517. Select an endpoint.

1518. Click Action policies and select an action.
1519. Click Data Policies and select Enabled for each field to be included in the document transfer. 

Note   For an inbound document, fields that are enabled but not required are optional in the exchange. For an outbound document, concept of "required fields" has no meaning - only fields where you have selected the Enabled check box are sent in the transfer.

1520. Click Set to clear or select all fields.

Creating and configuring a pipeline

A pipeline consists of a set of components that transform XML documents as they flow in or out of Microsoft Dynamics AX through the Application Integration Framework (AIF). The architecture of the pipeline makes it easy for developers to create and configure custom components to transform documents. A separate pipeline consisting of one or several pipeline components may be specified for every endpoint action policy, which enables custom transformations between specific partners.

Two pipeline components are installed with Microsoft Dynamics AX:

· A component for value substitution 

· A component that enables Extensible Stylesheet Language Transformations (XSLT) document transformations. 

The AifValueSubstitutor pipeline component allows you to substitute one character string for another for a field. To apply XSLT document transformations, you must first import an XSLT style sheet into Microsoft Dynamics AX, and then specify the AifXMLTransform pipeline component for the desired endpoint action policy.

Before configuring any pipeline components, you must have configured the following:

· A local endpoint (see Create and configure local endpoints).

· An action (see Configure an action).

· An endpoint with an action policy and a data policy (see Configure an Endpoint, Configure endpoint action policies, and Configure endpoint action data policies).

Before configuring a pipeline component, be sure you have configured a local endpoint, an action, and an endpoint with an action policy and a data policy.

1521. Click Basic > Setup > Application Integration Framework > Endpoints.
1522. Select an endpoint.

1523. Click Action policies.

1524. Select an action.

1525. Click Pipeline components.

1526. Press CTRL+N to create a new pipeline component entry. 

1527. Select a component from the list under Class name.

1528. Press CTRL+S to save the record and to make the Configure button available.

1529. Each pipeline component has different configuration requirements, so you see a different form when you click Configure for any pipeline component. For more information, see Configure a pipeline.

Configure a pipeline

Configuring a pipeline for an action on an endpoint involves specifying the pipeline components for a transformation of the document, in execution order, on the Configure form. 

Two pipeline components are included with an Microsoft Dynamics AX installation and you can configure them to perform value substitution and XSLT transformations. Other custom pipeline components may be developed for your system by your team or outside consultants or partners. Configuration of any custom pipeline component depends entirely on the implementation of that component.

· To begin configuring a pipeline component, on the Endpoint Action Policies form, click Pipeline components. The Pipeline components form displays the list of pipeline components configured for the action on the endpoint. 

· To display the list of available pipeline components, on the Pipeline components form, click Class name. The two pipeline components available with your Microsoft Dynamics AX installation are:

· AifValueSubstitutor for simple string mapping of field values and 

· AifXMLTransform for XSLT transforms of XML documents. 

You can include as many pipeline components as you need to transform the document to meet the needs of the exchange.

Each pipeline component has different configuration requirements, so you see a different form when you click Configure for any custom pipeline component.

Before configuring any pipeline components, you must have already configured the following:

· A local endpoint 

See Create and configure local endpoints.

· An action 

See Configure an action.

· An endpoint with an action policy and a data policy 

See Configure an Endpoint, Configure endpoint action policies, and Configure endpoint action data policies.

Configure value substitution

Before configuring a pipeline component, be sure you have already configured a local endpoint, an action, and an endpoint with an action policy and a data policy. See Configure an Endpoint, Configure endpoint action policies, and Configure endpoint action data policies.

1530. Click Basic > Setup > Application Integration Framework > Endpoints.
1531. Select an endpoint.

1532. Click Action policies.

1533. Select an action.

1534. Click Pipeline components. 

1535. Select AifValueSubstitutor (you may have to press CTRL+N and select AifValueSubstitutor from the Class name list) press CTRL+S to save.

1536. Click Configure.

1537. On the Pipeline value substitution form, select the Lookup table identification Lookup table ID for the value lookup table (that you entered on the Value lookup form) for the fields requiring value substitution. For more information about configuring value lookups, see About value lookups. 

Note   Values for Lookup table ID are filtered by type. If no values are displayed for Lookup table ID, you may need to return to the Value lookup form and enter a value for Type on the General tab.

The Pipeline value substitution form displays:

· Element name (the name of the data field)

· Lookup table ID, XPath (the XPath, the specification for where the data field fits into the schema hierarchy) 

· Type (the Microsoft Dynamics AX data type).

Configure an XSLT transform

Before configuring a pipeline component, be sure you have configured a local endpoint, an action, and an endpoint with an action policy. Note that the XLST transform is only applied to the XML document itself, and not to the message header. See Configure an Endpoint, Configure endpoint action policies, and Configure endpoint action data policies.

1538. Click Basic > Setup > Application Integration Framework > Endpoints > Action policies. 
For information about configuring action policies on an endpoint, see Configure endpoint action policies.

1539. On the Action policies form, click Pipeline components.

1540. Select AifXMLTransform and click CTRL+S to save.

1541. Click Configure.

1542. On the Pipeline XSLT transform form, enter the identification of the XSLT transform from the XSLT repository that you entered on the XSLT repository form. 

For more information about importing XSLT style sheets into the XSLT repository in Microsoft Dynamics AX, see below.

1543. If you want any Microsoft Visual Studio (VS) scripts in the XSLT file to be executed, select Scripting Enabled.

1544. .Press CTRL+S.

Add an XSLT style sheet to the XSLT repository

1545. Click Basic > Setup > Application Integration Framework > XSLT repository.
1546. Click CTRL+N to create a new record.

1547. In the XSLT ID field, enter a unique identifier for the XSLT transform.

1548. In the Name field, enter a free-text description for the transform.

1549. Click Import and specify the file name of the XSLT style sheet for the transform.

1550. Click View to view the XML for the transform, and then click Save as to export the XML to a file.

About value lookups

With value lookups, you can substitute one character string for another in any field of a document. You can implement value lookups using the AifValueSubstitutor pipeline component. See Creating and configuring a pipeline.

You can also create value lookups for any pipeline component, if you know the data type for the field. After creating a value lookup using the Value lookup form, you relate that value lookup to the pipeline component by entering the value lookup identification when you configure the pipeline component.

Configure value lookups for a pipeline component 

1551. Click Basic > Setup > Application Integration Framework > Value lookup.
1552. Press CTRL+N to create a new line.

1553. On the Overview tab, enter:

· A new identification in the Lookup table ID field 

· A name for the table in the Name field.

1554. On the General tab, select the Microsoft Dynamics AX data type from the list of available data types. For the data types that reference a table in Microsoft Dynamics AX, the internal values are populated from that table.

1555. Enter the internal values and the external values for the string substitution in the lower pane of the form.

Use a value lookup table with the AifValueSubstitutor pipeline component

Before configuring a pipeline component, configure a local endpoint, an action, and an endpoint with an action policy and a data policy. See Configure endpoint action policies and Configure endpoint action data policies.

1556. Click Basic > Setup > Application Integration Framework > Endpoints.
1557. Select an endpoint.

1558. Click Action policies.

1559. Select an action.

1560. Click Pipeline components.

1561. Select AifValueSubstitutor in the Class name field (press CTRL+N to create the line if you need to) and press CTRL+S to save.

1562. Click Configure.

The Pipeline value substitution form is populated with the data fields that are Enabled on the Data Policies form for your document.

1563. Enter the Lookup table ID for each data field to be substituted. This is the identifier you entered on the Value lookup form.

1564. In the XPath field, you can view the place in the XML schema hierarchy where the element resides.

1565. In the Type field, you can view the Microsoft Dynamics AX type of the data field.

Configuring document exchanges that expose Web services

When you configure a document exchange that exposes Web services, you perform the transfer using inbound Web services. To do this, you must first ensure that Microsoft IIS 6.0 is configured properly on the computer where the application integration server is installed. For more information, refer to Install an application integration server.

Document exchanges with outbound Web services are adapter-based and do not require IIS to be installed.

Configure the exchange

To configure the document exchange itself you must perform the following tasks:

· Create a local endpoint. See Create and configure local endpoints.

· Create and configure an endpoint for the trading partner who will consume the Web services. See Configure an Endpoint.

· Configure an action. See Configure an action.

· Configure the endpoint action policy to associate the desired actions with the endpoint. See Configure endpoint action policies.

· Configure data policies. See Configure endpoint action data policies.

· Configure a Web site for the Web services on the Web sites form. See Configure Web sites for document exchange.

· Generate Web services from the actions. See Create Web services for an action.

The following tasks are optional:

· Configure a pipeline for document transforms. See Configure a pipeline.

· Configure value lookups. See About value lookups.

· Configure document-specific value mapping. See Configure endpoint action policies.

Configure the endpoint user group for inbound Web services

When you configure an endpoint for inbound Web services, you must set up an Microsoft Dynamics AX user or user group for that endpoint. For more information, see Configure an Endpoint.

Next, you must give the endpoint user or user group access to the Business Connector:

1566. Click Administration >. Setup > User groups.
1567. Select the user group for the endpoint, or the user group that contains the user for the endpoint.

1568. Click Permissions.

1569. On the Permissions tab, select Business Connector Proxy, Full control, then click Cascade.

Configure Web sites for document exchange

In order to perform document exchanges that expose Web services, you must install an application integration server using the Microsoft Dynamics AX setup program, as well as Microsoft Internet Information Services (IIS) 6.0. A core Microsoft Dynamics AX installation must also reside in the network domain. We recommend that the application integration server and the Application Object Server (AOS) be installed on different computers.

· For details about installing an application integration server, see Install an application integration server. 

· For details about additional steps for configuring IIS, see Configure IIS to work with Microsoft Dynamics AX Web services.

Add a Web site for use by the framework

1570. Click Basic > Setup > Application Integration Framework > Web sites.
1571. Press CTRL+N to create a new Web site or select one of the Web sites from the list.

1572. Enter a descriptive name for this Web site in the Name field. 

The name can contain special characters and blanks and can be up to 50 characters long.

1573. In the Virtual directory share path field, enter the path to the virtual directory to contain the Web service components that are generated from actions.

1574. To search for a directory path, on the General tab, click Browse.

1575. In the Description field, enter a description of the Web site.

Validate that a Web site is ready for use with AIF Web services

1576. Click Basic > Setup > Application Integration Framework > Web sites. 
1577. On the Overview tab, select a Web site from the list.

1578. To check that each selected directory path exists, and that the current Application Object Server (AOS) Windows user account has read, write, and delete permissions on the directory, click Validate.

Creating and configuring actions

Actions are created when document classes are implemented. The term action refers to the document (for example, SalesOrder) and the operation on that document (for example, create or read). The action type describes the direction of the transfer and the element being transferred. There are six types of actions:

· ReceiveDocument

· ReceiveDocumentList

· QueryEntityKeys

· QueryDocuments

· SendDocument

· SendDocumentList
After document classes have been implemented, you configure actions using the Action form.

Configuring an action includes the following tasks:

· Scanning the Application Object Table (AOT) for new actions.

· Enabling actions for use in document exchanges.

· Enabling and generating Web services for an action when configuring a transfer using inbound Web services.

· Viewing the schema for the document.

· Viewing the action status.

· Viewing any errors that arise from creating actions and Web services.

Perform these tasks in any order and as often as you need to as you debug and tune the exchange you are setting up. 

Create an action

An action refers to the document and the operation to be performed on it, such as Send or Receive. After a document class is implemented, an action or actions are available for the document in the Application Object Tree (AOT). 

To make the documents and actions available for use in exchanges, you must first scan the AOT and register the actions, which creates them in the AifAction table and makes them available on the Action form. Then you can enable actions to use in exchanges. You must register and enable each action before you can use it in an exchange. You can also generate Web services from an action on the Action form. For more information, see Create Web services for an action. 

Note   Certain actions, such as creating exchange rates, cause data to be written directly to the Microsoft Dynamics AX database without manual end-user verification. When configuring endpoints and creating new actions, be especially careful to restrict access to trusted and reliable partners and applications.

1579. Click Basic > Setup > Application Integration Framework > Action. No actions are present if this is the first time you have opened the form after Microsoft Dynamics AX is installed.
1580. Click Scan and register.

1581. After all actions are scanned and registered, select Enabled to enable the action to use in an exchange.

1582. If any errors occur, select an action and click View errors to view errors associated with the selected action.

Configure an action

An action refers to the document and the operation to be performed on it, such as Send or Receive. After a document class is implemented, an action or actions are available for the document in the Application Object Tree (AOT). 

To make the documents and actions available for use in exchanges, you register and enable actions using the Action form. Registering actions creates them in the AifAction table and makes them available on the Action form. You must enable each action before you can use it in an exchange. You can also generate Web services from an action on the Action form. For more information, see Create Web services for an action.

Security note for actions on inbound documents

Certain actions, such as creating exchange rates, cause data to be written directly to the Microsoft Dynamics AX database without manual end-user verification. When configuring endpoints and creating new actions, be careful to restrict access to trusted and reliable partners and applications.

Register and enable actions

1583. Click Basic > Setup > Application Integration Framework > Application Integration Framework.
1584. To register all actions for document classes that exist in the Application Object Tree (AOT), click Scan and register. Registering an action creates a row for it in the AifAction table.

1585. After all items are scanned and registered, select Enabled to enable the actions you need for your exchange.

Note   Select an action on the Overview tab and click Re-register if you need to regenerate actions and create or update the row for that action in the action table. Note that re-registering affects all the actions on the document class for the action you have selected.

Register actions using the AOT

This is an alternate way of registering actions for one particular document class. It is useful if you have a new document class and don't want to wait for the scanning process, which registers all actions for all documents in the AOT.

1586. Open the AOT and expand the Classes node.
1587. Navigate to the document class to re-register (for example AxdSalesPackingSlip).

1588. Right-click on the document class and click Add Ins > Register actions.

1589. The registered action or actions are available on the Action form.

View the schema and error log

1590. Click Basic > Setup > Application Integration Framework > Application Integration Framework.
1591. On the Overview tab, select an action.

1592. To view the XML schema of the document for the selected action, click View schema.

1593. To view the Infolog from the last attempt to generate actions or the XML schema of the document for the selected action or from the last attempt to generate Web services, click View errors.

Sort on document class

1594. Click Basic > Setup > Application Integration Framework > Application Integration Framework.
1595. Press CTRL+F3 to set up an advanced filter or sort on the Inquiry form.

1596. In the lower pane, click the Sorting tab.

1597. Press CTRL+N to create a new sorting field.

1598. Select Action in the Table field.

1599. Select Document class in the Field field.

1600. Select Ascending or Descending in the Search direction field.

1601. Click OK to return to the Search direction form.

Create Web services for an action

If the global setting for creating Web services by default is enabled on the Global Settings form, then the Enable Web method checkbox is selected for each action on the Actions form, as long as the action is enabled and a Web site has been configured using the Web sites form.

Complete before you generate Web services for an action

Before you can generate Web services for an action you must:

· Install and configure an application integration server and Microsoft Internet Information Services (IIS) 6.0 or later. See Install an application integration server.

· Enable an action on the Action form.

· Create and configure a valid Web site for the Web services on the Web sites form.

Generate Web services for an action

1602. Click Basic > Setup > Application Integration Framework > Application Integration Framework.
1603. Select an action. 

Note   Be sure that the Enabled check box is selected for the selected action.

1604. Select Web method enabled.

1605. Click Generate. 

Verify the Web services

1606. Open IIS Services Manager (Start > All Programs > Administrative tools > Internet Information Services Manager). 
1607. Navigate to the virtual root DynamicsWebService.

1608. Right-click on the .asmx file and click Browse to view the Web services.

Recover from Page not found errors

If you get a Page not found error after clicking Browse then you must re-register ASP.NET in IIS using the following steps:

1609. Click Start > Run.
1610. Type your-system-directory\Microsoft .NET\Framework\v2.0.50727 and press ENTER.

1611. Type aspnet_regiis.exe -u and press ENTER.
1612. Type aspnet_regiis.exe –i -enable and press ENTER.

1613. Type iisreset and press ENTER.

1614. Close the Command Prompt window.

After uninstalling and reinstalling ASP.NET and resetting IIS, the ASP.NET tab is available, and you can select ASP version 2.0. This allows you to browse the Web services after you create them on the Action form. See Create Web services for an action.
Creating and configuring endpoints

Using Application Integration Framework (AIF), you enable document exchanges between endpoints and the local endpoint. A local endpoint is the origination for sent messages and the destination for received messages. That is, the local endpoint refers to your Microsoft Dynamics AX installation.

An endpoint is the destination for an outbound document and the source of an incoming document. That is, an endpoint represents your trading partner in a document exchange.

Before you can configure an endpoint, the following must already exist and be configured:

· A local endpoint.

· A named action for the exchange, consisting of a document and a description of the operation to be performed on it, for example, ReadSalesOrder. For more information, see Creating and configuring actions.

· Microsoft Dynamics AX users to be associated with the endpoint.

· An outbound channel must be already be defined if needed.

When you configure an endpoint, you enter information about the following:

· Identifying information for the endpoint, including an identifier, a friendly name, the active status, the associated channel, and the Microsoft Dynamics AX company identification.

· Constraints on the endpoint that restrict document exchange by defining valid Microsoft Dynamics AX customers or vendors.

· Microsoft Dynamics AX users and trusted intermediaries that are allowed to submit documents for the exchange.

· Endpoint action policies that relate actions to the endpoint.

· Pipeline components for any optional document transformations for the action related to the endpoint.

· Endpoint action data policies (or "data policies") that defines which fields in a document are allowed or required to participate in the exchange.

· Document configuration options, including value mapping. For more information, see About External Codes.

Configure an endpoint

When you configure an endpoint, you enter information on the Endpoints form about the following:

· Identifying information for the endpoint, including a unique identifier, a friendly name, the active status, the intercompany status, local endpoint, Microsoft Dynamics AX company identification for an intercompany exchange, channel information (if any), and encoding format for the transfer

· Constraints on the endpoint that restrict document exchange by defining valid Microsoft Dynamics AX customers or vendors or warehouses

· Microsoft Dynamics AX users and trusted intermediaries that are allowed to submit documents for the exchange

· Endpoint action policies that relate actions to the endpoint

· Pipeline components for an action related to the endpoint

· Endpoint action data policies that define which fields in a document are required for the exchange

Configure endpoint identification

1615. Click Basic > Setup > Application Integration Framework.> Endpoints.
1616. Press CTRL+N to create a new endpoint, or select an existing endpoint from the list to be modified.

1617. Enter the information for the endpoint on the General tab, including the unique endpoint identification information, the friendly name for the endpoint, the local endpoint ID, and the default encoding format.

1618. For intercompany transfers, select Intercompany organization if the endpoint is a company within your Microsoft Dynamics AX installation, and select a company in the Company field. 

Do not select Intercompany organization unless the endpoint is to be used in an intercompany transfer. For more information about these transfers see Intercompany for sales orders or Intercompany purchase orders.

1619. Selecting an outbound channel is not required for all exchanges. However, if your Microsoft Dynamics AX installation is sending messages to this endpoint (for example, if you are configuring an outbound-only exchange), you must select a channel in the Outbound channel ID field.

1620. In the Local endpoint ID field, select the local endpoint identification that participates in exchanges with this endpoint.

Note   There may be more than one local endpoint configured for your Microsoft Dynamics AX installation. If that is the case, then be sure to select the correct local endpoint to participate in the exchange with the endpoint you are configuring.

1621. View the pre-populated setting for encoding format in the Default encoding format field. This setting defaults to the value set on the Global settings form.

Configure constraints on an endpoint and activate the endpoint

1622. Click Basic > Setup > Application Integration Framework > Endpoints.
1623. Press CTRL+N to create a new endpoint, or select an existing endpoint from the list to be modified.

1624. On the Constraints tab, select No constraints to clear the form and allow data to be exchanged regardless of any association. The No constraints check box becomes unavailable. However, if you add constraints later, the check box clears itself.

1625. Press CTRL+N to create a new constraint. 

1626. Choose the Constraint type (Vendor, Customer or Warehouse).

1627. Select a Constraint ID from the list. The Name field is completed when you select the Constraint ID.

1628. On the Overview tab, select Active to activate the endpoint. 

Messages flow through the framework from the local endpoint to and from any active endpoints.

Configure users and trusted intermediaries for an endpoint

You must enter information for at least one endpoint user or trusted intermediary who is authorized to initiate transactions for the endpoint on the Users tab.

Note   When configuring users on an endpoint, remember that these Microsoft Dynamics AX users may represent outside interests and must have permissions set appropriately. For more information about configuring Microsoft Dynamics AX users, see Managing access to Microsoft Dynamics AX, Manage permissions, Manage user groups, and Manage users. 

You must also set the appropriate security keys and record-level security for any users that are granted access to Microsoft Dynamics AX through Application Integration Framework (AIF), to help prevent unauthorized data access. For more information, see Manage record-level security, Security keys, and Set up security keys.

Certain actions cause data to be written directly to the Microsoft Dynamics AX database without manual end-user verification (for example, creating exchange rates). When configuring endpoints and creating new actions, be especially careful to restrict access to trusted and reliable partners and applications.

Configure an endpoint user

1629. Click Basic > Setup > Application Integration Framework > Endpoints.
1630. Press CTRL+N to create a new endpoint, or select an existing endpoint from the list to be modified.

1631. Click the Users tab.

1632. Under Endpoint users, in the User type field, select either User or User group.

1633. In the Application user or group field, select a valid Microsoft Dynamics AX user or user group name. The Name field is filled in automatically.

For more information about Microsoft Dynamics AX users and user groups, see Managing access to Microsoft Dynamics AX.

Configure a trusted intermediary

Trusted intermediaries are logical “middle men” between external endpoints and AIF, that is, they are Microsoft Dynamics AX users (or user groups) that are authorized to submit inbound requests on behalf of the endpoint. For more information about trusted intermediaries, see Security considerations for the Application Integration Framework.

For more information about Microsoft Dynamics AX users and user groups, see Managing access to Microsoft Dynamics AX.

Note   If the Use trusted intermediary box is checked, there must be at least one entry in the Trusted intermediaries grid.

1634. Under Trusted intermediaries, select Use trusted intermediary to enable a trusted intermediary for exchanges with this endpoint. 
1635. Under Trusted intermediaries, in the User type field, also select either User or User group.

1636. In the Application user or group field, select a valid Microsoft Dynamics AX user or user group name. The Name field is filled in automatically.

Configure action policies, data policies, and pipeline components for an endpoint

1637. After you have completed the information in the items above, click Action policies to configure actions on the endpoint. 
For more information about action policies, see Configure endpoint action policies. 

1638. Press CTRL+S to save the action policy.

1639. From the Action policies form, select an action, press CTRL+S, and click Data Policies to enter information about which fields are required and which are optional in the document to be exchanged. 

1640. Click Configure to perform document-specific configuration, including value mapping, for the document exchange. 

Value mapping is translation of field data values based on business rules, for example, translating internal item numbers to vendor-specific item numbers or industry standard numbers depending on the trading partner. For more information, see Configure endpoint action data policies.

1641. Click Pipeline components to configure the pipeline components for any custom transformations performed on the document. For more information, see Creating and configuring a pipeline.

1642. Click View schema to view the XML schema for the document configured by the action policy on the endpoint. On the Schema form, you can click Save as to save the schema as a file.

Give the endpoint user access to Business Connector when using inbound Web services

When you configure an endpoint for inbound Web services, you must configure an endpoint user and/or trusted intermediary, as outlined above. Next, you must give that Microsoft Dynamics AX user or user group access to the Business Connector.

1643. Click Administration > Setup > User groups and select the user group for the endpoint, or the user group that contains the user for the endpoint.
1644. Click Permissions.

1645. On the Permissions tab, select Business Connector Proxy and then select Full control.

1646. Click Cascade.

Configure endpoint action policies

To enable exchange of documents for endpoints, select which actions an endpoint may perform. This process is called configuring endpoint action policies.

Actions are defined as named entities comprising an XML document and an operation on that document. Web services can be generated from actions. Examples of actions are createPurchaseOrder and readSalesOrder. You configure actions on the Action form. For more information, see Creating and configuring actions.

1. Configure an action on an endpoint

Before configuring actions on an endpoint, you must first have registered and enabled actions on the Action form.

1647. Click Basic > Setup > Application Integration Framework > Endpoints.
1648. Select the endpoint to configure and click Action policies.

1649. Press CTRL+N to enter a new action policy.

1650. The Overview tab lists the available actions that you have registered and enabled on the Action form. 

The name of the action in the Action ID field and the name of the document class in the Class name field cannot be changed.

1651. You can change the status of an action associated with the endpoint to Enabled, Disabled, or Hold. 

1652. Select Enabled to make the action active for this endpoint.

Selecting Disabled has the same effect as if the action was not configured on the endpoint.

1653. Select Hold to prevent outbound documents from being passed to the adapter and inbound documents from being passed to the document class. 

The document is held in the queue and may be examined and resubmitted. For more information, see Edit and resubmit messages in the queues. For a synchronous exchange such as a Web service, an error message is generated for the hold condition.

1654. On the General tab, enter a name for External Identifier Override to override the External identifier field on the Action form. 

This sets the contents of the Action tag in the XML document being exchanged.

1655. Press CTRL+S to save the action policy you have created. This makes the buttons available.

1656. Click Pipeline components to create a pipeline for any transformation of the document.

1657. Click View schema to view the XML schema for the document that corresponds to the action you have selected.

2. Select a logging mode for an action on an endpoint

1658. Click Basic > Setup > Application Integration Framework > Endpoints.
1659. Select an endpoint.

1660. Click Action policies.

1661. Select an action on the Overview tab.

1662. On the General tab, select a logging mode (Log Original, Log All, or Log None) for the document exchange. 

· Log Original captures only the information for the initial document transfer, 

· Log All captures information about every transfer 

· Log None stores no data for this action and endpoint.

1663. To view the document history by message or by document, click Basic > Periodic > Application Integration Framework > Document history.

3. Configure document-specific options including value mapping

1664. Click Basic > Setup > Application Integration Framework > Endpoints.
1665. Select an endpoint and click Action policies.

1666. Click Action policies and select an action on the Overview tab.

1667. Click Configure to perform document-specific configuration, including value mapping. 

Value mapping is the translation of field data values based on business rules, for example, translating internal item numbers to vendor-specific item numbers or industry standard numbers depending on the trading partner.

4. Configure data policies for an action on an endpoint

For more information about data policies, see Configure endpoint action data policies.

1668. Click Basic > Setup > Application Integration Framework > Endpoints.
1669. Select an endpoint and click Action policies.

1670. Click Action policies and select an action on the Overview tab.

1671. Click Data Policies to configure required and allowed fields for the document transfer.

Configure endpoint action data policies

A document is made up of many data fields. When you set up a document exchange, you decide, on a field-by-field basis, which data fields are transferred. This is known as the data policy. You configure the data policy on the Data Policies form.

Note   For inbound documents, mandatory fields (that is, fields required by the Microsoft Dynamics AX database) are set to Required by default on the Data Policies form if they cannot be set by default in the database. For outbound documents, the fields to be sent must be set to Enabled.

There are two types of qualifiers for data fields on the Data Policies form: required and enabled. These have different meanings and effects depending on the direction of the transfer. 

If a data field is allowed to be included in an inbound exchange, it is said to be "enabled." For inbound documents, only fields that are enabled are allowed to be submitted by the endpoint. If a document is received that includes fields that are not enabled, the document is rejected and an exception is logged. 

For inbound documents only (for example, actions having an action type of Receive), fields may be designated as Required if the document class defines them as mandatory (that is, they are required for the database record to be inserted or updated and they cannot be defaulted). Additionally, the XML document may specify required elements depending on the business logic in the document class. You can also specify additional required elements by selecting Required for the field on the Endpoint action data policies form. However, you cannot use the data policy to make an element optional if it is required by the document class.

For an inbound document, fields that are enabled but not required are optional to the exchange. Fields in an inbound exchange that are required are automatically designated as enabled - if the document does not contain these fields, the document is rejected.

The concept of "required fields" has no meaning for outbound transfers. For outbound documents, only fields that are enabled are included in the exchange.

Note   When you clear the Enabled check box for a field used for calculating the value of another field, you may also need to clear the Enabled check box for the calculated field, so that unauthorized users may not be able to deduce the value of the original field that is not enabled. Please refer to Using Standard AxdDocuments for details of the calculated fields available in each document.

Configure data fields for an inbound document

You must first configure an endpoint and enable the action or actions for the exchange.

1672. Click Basic > Setup > Application Integration Framework > Endpoints.
1673. Select an endpoint and click Action policies.

1674. Select an action.

1675. Click Data Policies to configure required and allowed fields for the document transfer. 

For fields that are required to be present in the XML document according to the document class, select the Enabled and Required check boxes.

1676. For other fields in the document, you can select Required if the field is required for the document exchange (Enabled is automatically set). 

Note   If you find that your needs for the document transfers change, you can clear the Required check box.

1677. Click Set to clear or select all fields at one time.

Configure data fields for an outbound document exchange

You must first configure an endpoint and enable the action or actions for the exchange.

1678. Click Basic > Setup > Application Integration Framework > Endpoints.
1679. Select an endpoint.

1680. Click Action policies and select an action.
1681. Click Data Policies and select Enabled for each field to be included in the document transfer. 

Note   For an inbound document, fields that are enabled but not required are optional in the exchange. For an outbound document, concept of "required fields" has no meaning - only fields where you have selected the Enabled check box are sent in the transfer.

1682. Click Set to clear or select all fields.

Creating and configuring a pipeline

A pipeline consists of a set of components that transform XML documents as they flow in or out of Microsoft Dynamics AX through the Application Integration Framework (AIF). The architecture of the pipeline makes it easy for developers to create and configure custom components to transform documents. A separate pipeline consisting of one or several pipeline components may be specified for every endpoint action policy, which enables custom transformations between specific partners.

Two pipeline components are installed with Microsoft Dynamics AX:

· A component for value substitution 

· A component that enables Extensible Stylesheet Language Transformations (XSLT) document transformations. 

The AifValueSubstitutor pipeline component allows you to substitute one character string for another for a field. To apply XSLT document transformations, you must first import an XSLT style sheet into Microsoft Dynamics AX, and then specify the AifXMLTransform pipeline component for the desired endpoint action policy.

Before configuring any pipeline components, you must have configured the following:

· A local endpoint (see Create and configure local endpoints).

· An action (see Configure an action).

· An endpoint with an action policy and a data policy (see Configure an Endpoint, Configure endpoint action policies, and Configure endpoint action data policies).

Before configuring a pipeline component, be sure you have configured a local endpoint, an action, and an endpoint with an action policy and a data policy.

1683. Click Basic > Setup > Application Integration Framework > Endpoints.
1684. Select an endpoint.

1685. Click Action policies.

1686. Select an action.

1687. Click Pipeline components.

1688. Press CTRL+N to create a new pipeline component entry. 

1689. Select a component from the list under Class name.

1690. Press CTRL+S to save the record and to make the Configure button available.

1691. Each pipeline component has different configuration requirements, so you see a different form when you click Configure for any pipeline component. For more information, see Configure a pipeline.

Configure a pipeline

Configuring a pipeline for an action on an endpoint involves specifying the pipeline components for a transformation of the document, in execution order, on the Configure form. 

Two pipeline components are included with an Microsoft Dynamics AX installation and you can configure them to perform value substitution and XSLT transformations. Other custom pipeline components may be developed for your system by your team or outside consultants or partners. Configuration of any custom pipeline component depends entirely on the implementation of that component.

· To begin configuring a pipeline component, on the Endpoint Action Policies form, click Pipeline components. The Pipeline components form displays the list of pipeline components configured for the action on the endpoint. 

· To display the list of available pipeline components, on the Pipeline components form, click Class name. The two pipeline components available with your Microsoft Dynamics AX installation are:

· AifValueSubstitutor for simple string mapping of field values and 

· AifXMLTransform for XSLT transforms of XML documents. 

You can include as many pipeline components as you need to transform the document to meet the needs of the exchange.

Each pipeline component has different configuration requirements, so you see a different form when you click Configure for any custom pipeline component.

Before configuring any pipeline components, you must have already configured the following:

· A local endpoint 

See Create and configure local endpoints.

· An action 

See Configure an action.

· An endpoint with an action policy and a data policy 

See Configure an Endpoint, Configure endpoint action policies, and Configure endpoint action data policies.

Configure value substitution

Before configuring a pipeline component, be sure you have already configured a local endpoint, an action, and an endpoint with an action policy and a data policy. See Configure an Endpoint, Configure endpoint action policies, and Configure endpoint action data policies.

1692. Click Basic > Setup > Application Integration Framework > Endpoints.
1693. Select an endpoint.

1694. Click Action policies.

1695. Select an action.

1696. Click Pipeline components. 

1697. Select AifValueSubstitutor (you may have to press CTRL+N and select AifValueSubstitutor from the Class name list) press CTRL+S to save.

1698. Click Configure.

1699. On the Pipeline value substitution form, select the Lookup table identification Lookup table ID for the value lookup table (that you entered on the Value lookup form) for the fields requiring value substitution. For more information about configuring value lookups, see About value lookups. 

Note   Values for Lookup table ID are filtered by type. If no values are displayed for Lookup table ID, you may need to return to the Value lookup form and enter a value for Type on the General tab.

The Pipeline value substitution form displays:

· Element name (the name of the data field)

· Lookup table ID, XPath (the XPath, the specification for where the data field fits into the schema hierarchy) 

· Type (the Microsoft Dynamics AX data type).

Configure an XSLT transform

Before configuring a pipeline component, be sure you have configured a local endpoint, an action, and an endpoint with an action policy. Note that the XLST transform is only applied to the XML document itself, and not to the message header. See Configure an Endpoint, Configure endpoint action policies, and Configure endpoint action data policies.

1700. Click Basic > Setup > Application Integration Framework > Endpoints > Action policies. 
For information about configuring action policies on an endpoint, see Configure endpoint action policies.

1701. On the Action policies form, click Pipeline components.

1702. Select AifXMLTransform and click CTRL+S to save.

1703. Click Configure.

1704. On the Pipeline XSLT transform form, enter the identification of the XSLT transform from the XSLT repository that you entered on the XSLT repository form. 

For more information about importing XSLT style sheets into the XSLT repository in Microsoft Dynamics AX, see below.

1705. If you want any Microsoft Visual Studio (VS) scripts in the XSLT file to be executed, select Scripting Enabled.

1706. .Press CTRL+S.

Add an XSLT style sheet to the XSLT repository

1707. Click Basic > Setup > Application Integration Framework > XSLT repository.
1708. Click CTRL+N to create a new record.

1709. In the XSLT ID field, enter a unique identifier for the XSLT transform.

1710. In the Name field, enter a free-text description for the transform.

1711. Click Import and specify the file name of the XSLT style sheet for the transform.

1712. Click View to view the XML for the transform, and then click Save as to export the XML to a file.

About value lookups

With value lookups, you can substitute one character string for another in any field of a document. You can implement value lookups using the AifValueSubstitutor pipeline component. See Creating and configuring a pipeline.

You can also create value lookups for any pipeline component, if you know the data type for the field. After creating a value lookup using the Value lookup form, you relate that value lookup to the pipeline component by entering the value lookup identification when you configure the pipeline component.

Configure value lookups for a pipeline component 

1713. Click Basic > Setup > Application Integration Framework > Value lookup.
1714. Press CTRL+N to create a new line.

1715. On the Overview tab, enter:

· A new identification in the Lookup table ID field 

· A name for the table in the Name field.

1716. On the General tab, select the Microsoft Dynamics AX data type from the list of available data types. For the data types that reference a table in Microsoft Dynamics AX, the internal values are populated from that table.

1717. Enter the internal values and the external values for the string substitution in the lower pane of the form.

Use a value lookup table with the AifValueSubstitutor pipeline component

Before configuring a pipeline component, configure a local endpoint, an action, and an endpoint with an action policy and a data policy. See Configure endpoint action policies and Configure endpoint action data policies.

1718. Click Basic > Setup > Application Integration Framework > Endpoints.
1719. Select an endpoint.

1720. Click Action policies.

1721. Select an action.

1722. Click Pipeline components.

1723. Select AifValueSubstitutor in the Class name field (press CTRL+N to create the line if you need to) and press CTRL+S to save.

1724. Click Configure.

The Pipeline value substitution form is populated with the data fields that are Enabled on the Data Policies form for your document.

1725. Enter the Lookup table ID for each data field to be substituted. This is the identifier you entered on the Value lookup form.

1726. In the XPath field, you can view the place in the XML schema hierarchy where the element resides.

1727. In the Type field, you can view the Microsoft Dynamics AX type of the data field.

Troubleshoot problems operating the Application Integration Framework

This topic describes how to troubleshoot common issues with document exchange using the Application Integration Framework (AIF).

Set up an endpoint to use inbound Web services

You may see the message "The requested operation cannot be performed because the required security key doesn’t exist" in the Web server event log. This occurs if the endpoint user does not have access to Business Connector.

When you configure an endpoint for inbound Web services, you must:

1728. Set up an Microsoft Dynamics AX user (or user group) as endpoint user or trusted intermediary for that endpoint.
1729. Give the user group access to the Business Connector.

Give the endpoint user access to Business connector

1730. Click Administration >. Setup > User groups and select the user group for the endpoint, or the user group that contains the user for the endpoint.
1731. Click Permissions.

1732. On the Permissions tab, in the table under the Viewing field:

ax. Select Business Connector Proxy 
ay. Select Full control
az. Click Cascade.

After installing Enterprise Portal, Application Integration Framework Web services do not work

For the Application Integration Framework (AIF) Web services to coexist with Windows SharePoint Services (WSS) and Enterprise Portal on the same computer, the virtual directory that AIF is using for Web services must be excluded from the SharePoint managed path. 

To exclude the AIF virtual directory from the SharePoint managed path list: 

1733. Launch the SharePoint Central Administration page (Start > All Programs > Administrative Tools > SharePoint Central Administration or, from the browser on a remote computer, type the URL for the pages on the administration port. For example: http://servername:port).
1734. Click Configure virtual server settings and click the name of the site you are managing. 

1735. Under Virtual Server Management, click Define managed paths.

1736. Under Add a New Path, enter the AIF virtual directory path, and then select Excluded path, and click OK.

Re-register ASP.NET when setting up inbound Web services

If you cannot see the ASP.NET tab when viewing Properties for the virtual root in the IIS Services Manager (see Configure IIS to work with Microsoft Dynamics AX Web services) or if you see a Page not found error after clicking Browse when validating Web services (see Create Web services for an action) you must re-register ASP.net in IIS using the following steps:

1737. Click Start > Run.
1738. Type cmd.

1739. In the Command Prompt window, type:

1740. cd your-system-directory\Microsoft.NET\Framework\v2.0.50727 and press ENTER.

1741. Type aspnet_regiis.exe -u and press ENTER.
1742. Type aspnet_regiis.exe –i -enable and press ENTER.

1743. Type iisreset and press ENTER.

1744. Close the Command Prompt window.

1745. After uninstalling and reinstalling ASP.NET and resetting IIS, the ASP.NET tab is available, and you can select ASP version 2.0. This allows you to browse the Web services after you create them on the Action form. See Create Web services for an action.
Issues when using Message Queuing (MSMQ) to exchange documents

· If the error message "The transaction context is invalid" appears for an inbound message, check that the queue that receives the message is located on the same computer as the Application Object Server (AOS) running the AIF batch jobs. For more information on these batch jobs, see Start and stop the asynchronous Application Integration Framework (AIF) services.

· If the error message "The specified format name does not support the requested operation. For example, a direct queue format name cannot be deleted" appears when a message is sent, check that the queue you are sending to is a public queue, and its address (on the Channels form) is given in short name format (for example: computer-name\queue-name).

· If it seems that outbound messages are sent (that is, they no longer appear in the list on the Overview tab in the Queue manager form, and no entries are created in the Exception Log for an error condition) but the messages are not received by the target queue, ensure that the target queue's access control list (ACL) is set properly: on the Security tab of the Properties window for the queue, Allow should be selected for Send Message, Get Permissions and Get Properties for the Anonymous Logon user. Also check that the target queue's Authenticated property is unchecked on the General tab in the Message Queuing folder (click Start > Settings > Control Panel > Administrative Tools > Computer Management).

· For inbound messages, if there is a message in the Exception Log that says "The user is not authorized to perform this action", check the Queue manager form (click Basic > Periodic > Application Integration Framework > Queue manager) for any inbound messages in an Error state. If the Submitting user field on the Details tab is blank, ensure that either the inbound queue's Authenticated property is checked or that all incoming messages are signed and authenticated.

Setting up and configuring OLAP reporting

An online analytical processing (OLAP) server adds to the reporting functionality for Microsoft Dynamics AX by linking Microsoft Dynamics AX to the functionality in Microsoft SQL Server Analysis Services.

After you set up SQL Server Analysis Services, and configure Microsoft Dynamics AX to connect to it, you must set up OLAP queries, or cubes.

OLAP cubes must be designed, configured, and processed before they can be used by client applications. Additionally, cubes usually require periodic updating to reflect changes to the underlying transactional data.

This section contains the following topics:

	Topic
	Description

	Flowchart: Configuring OLAP reporting
	This topic describes the process of configuring OLAP reporting.

	Set up OLAP reporting
	This topic describes how to set up OLAP reporting.

	OLAP Security
	This topic describes the security system for OLAP reporting.

	Create and process an OLAP cube
	This topic describes how to configure, transfer, and process OLAP cubes for use by Microsoft Dynamics AX. 

	Set up an OLAP server to work with an Oracle database
	This topic describes how to configure Microsoft SQL Server Analysis Services to retrieve data from an Oracle 10g database for online analytical processing (OLAP).


Flowchart: Configuring OLAP reporting

Microsoft Dynamics AX enables you to perform online analytical processing (OLAP) on your data using Microsoft SQL Server Analysis Services. OLAP is a process of retrieving and analyzing data to reveal business trends and statistics.
OLAP queries, called OLAP cubes, must be designed, configured, and processed before they can be used by client applications. Additionally, cubes usually require periodic updating to reflect changes to the underlying transactional data.
For detailed procedures on how to set up and configure OLAP reporting, see Set up OLAP reporting.
Prerequisites for Analysis Services server
1746. Install SQL Server 2000, Service Pack 4 or later, SQL Server 2005, or Oracle SQL server
1747. Install SQL Server Analysis Services 2000 Service Pack 4 or later, or SQL Server Analysis Services 2005
1748. Add users to the list of OLAP administrators in Analysis Services

Prerequisites for clients connecting to systems running SQL Server 2000 Analysis Services

1749. Install Microsoft SQL Server 2000 PivotTable Services
1750. Install Microsoft Office Web Components 11 (OWC11) (Optional)
Prerequisites for clients connecting to systems running SQL Server 2005 Analysis Services

1751. Install Microsoft Core XML Services (MSXML)
1752. Install Microsoft SQL Server 2005 Analysis Services OLE DB Provider
1753. Install Microsoft SQL Server Native Client (Optional)

1754. Install Microsoft SQL Server 2005 Analysis Management Objects (AMO) Collection (Optional)

1755. Install Microsoft Office Web Components 11 (OWC11) (Optional)

Flowchart for OLAP
See OLAP reporting flowchart for print version.

The main setup forms for OLAP

The OLAP forms include the following (in order of setup).

1756. Add an OLAP server, in the OLAP servers form
For complete guidelines, see OLAP servers (Form).

1757. Create an OLAP database, in the OLAP databases form.

Note   First open the OLAP servers form, select a server, and then click OLAP databases.

For an explanation of the fields on this form, see OLAP databases (Form).

1758. Define the limits of the cube data to be collected, in the OLAP parameters form.

For an explanation of the fields on this form, see OLAP parameters (Form).

1759. Import sample cube definitions, in the Cube Definition Manager form.
For an explanation of the fields on this form, see Cube Definition Manager (Form).

1760. Create and set up cube instances, in the Cube instances form.
For an explanation of the fields on this form, see Cube instances (Form).

1761. Transfer the cubes to the Analysis server, in the Cube instances form.
For an explanation of the fields on this form, see Cube instances (Form).

1762. Process the cubes, in the Cube instances form.
For an explanation of the fields on this form, see Cube instances (Form).

1763. Use SQL Server Analysis Services administration tools to grant end users access to cubes.
Note   You can create your own queries for OLAP cubes in the Application Object Tree (AOT). For more information, see Access Data and Add Multiple Data Sources to a Query. You can then use the Cube Definition Manager to create custom cubes based on your AOT queries.

Set up OLAP reporting

This topic describes how to set up and configure Microsoft SQL Server Analysis Services and Microsoft Dynamics AX for online analytical processing (OLAP) reporting. This topic includes the following procedures that show how to:

· Install Analysis Services for OLAP reporting.

· Create an OLAP database in Analysis Services.

· Add users to the list of OLAP administrators in Analysis Services. 

· Create an OLAP server and an OLAP database inMSDAX.
· Set OLAP parameters.

Considerations

· To perform the following operations, you must be a member of the Microsoft Dynamics AX Administrator group on the computer running Microsoft Dynamics AX. You must also be a member of the OLAP Administrators group on the computer running Analysis Services.

· The process of generating OLAP cubes and running Analysis Services can consume memory and CPU resources on the server. For this reason, consider setting up Analysis Services on a server separate from the Microsoft Dynamics AX server.

Requirements for OLAP reporting

To use a computer as an OLAP client for Microsoft Dynamics AX, it must have a Microsoft Dynamics AX client installed. 

Requirements for clients connecting to systems running SQL Server 2000 Analysis Services

The following components are required for clients that are connecting to, creating or configuring cubes on systems running SQL Server 2000 Analysis Services. 

Note   The components must be installed in the order specified.

	Component
	Version
	State during installation

	Microsoft SQL Server 2000 PivotTable Services
	 
	Can be installed after Microsoft Dynamics AX installation. All components are available in the downloadable Feature Pack for Microsoft SQL Server 2005.

Note   If a client must be able to connect to both SQL Server 2000 and SQL Server 2005 Analysis Services data sources, this component must be the first installed.

	Microsoft Office Web Components 11 (OWC11) 
	2003
	Can be installed after Microsoft Dynamics AX installation. 

Available from this location as a download: http://go.microsoft.com/fwlink/?LinkId=47538 

By installing the Office Web Components tool, users can view published components and data access pages on the Web without having to install Office 2003. 

Note   If you do not own an Office 2003 license, the Office Web Components are licensed to be used in static, non-interactive, client-side, view-only mode. If you do own an Office 2003 license, the Office Web Components are licensed to be used in interactive mode.


Requirements for clients connecting to systems running SQL Server 2005 Analysis Services

The following components are required for clients that are connecting to systems running SQL Server 2005 Analysis Services. 

Note   The components must be installed in the order specified.

	Component
	Version
	State during installation

	Microsoft Core XML Services (MSXML) 
	6.0
	Can be installed after Microsoft Dynamics AX installation. All components are available in the downloadable Feature Pack for Microsoft SQL Server 2005.

	Microsoft SQL Server 2005 Analysis Services OLE DB Provider
	9.0
	Can be installed after Microsoft Dynamics AX installation. All components are available in the downloadable Feature Pack for Microsoft SQL Server 2005.

	Microsoft SQL Server Native Client
	 
	Can be installed after Microsoft Dynamics AX installation. All components are available in the downloadable Feature Pack for Microsoft SQL Server 2005. 

Note   This component is not required if the client does not need to create or configure cubes.

	Microsoft SQL Server 2005 Analysis Management Objects (AMO) Collection
	 
	Can be installed after Microsoft Dynamics AX installation. All components are available in the downloadable Feature Pack for Microsoft SQL Server 2005.

Note   This component is not required if the client does not need to create or configure cubes.

	Microsoft Office Web Components 11 (OWC11) 
	2003
	Can be installed after Microsoft Dynamics AX installation. 

Available from this location as a download: http://go.microsoft.com/fwlink/?LinkId=47538 

By installing the Office Web Components tool, users can view published components and data access pages on the Web without having to install Office 2003. 

Note   If you do not own an Office 2003 license, the Office Web Components are licensed to be used in static, non-interactive, client-side, view-only mode. If you do own an Office 2003 license, the Office Web Components are licensed to be used in interactive mode.


SQL Server Analysis Services server requirements

	Requirements
	Comments

	SQL Server Analysis Services 2000 Service Pack 4 or later, or SQL Server Analysis Services 2005
	Analysis Services is a component of SQL Server. For OLAP reporting with Microsoft Dynamics AX, you must install Analysis Services, even if you are using an Oracle database.

	A unique Analysis Services database for each Microsoft Dynamics AX company that will generate OLAP reports.
	OLAP cubes from different companies can overwrite each other if those cubes are stored in the same Analysis Services database. To remedy this, create a unique database in Analysis Services for each Microsoft Dynamics AX company that will generate OLAP reports. For more information, see Creating Databases in the SQL Server Analysis Services books online.


Microsoft Dynamics AX requirements

	Requirements
	Comments

	License for Business Analysis in Microsoft Dynamics AX
	OLAP reporting requires the Business Analysis module in Microsoft Dynamics AX. If your company or organization does not have a valid license for this module, you cannot access the OLAP setup form in Microsoft Dynamics AX under Administration > Setup > Business analysis > OLAP
To obtain a Business Analysis license, contact your Microsoft partner.


Database requirements

	Requirements
	Comments

	A supported database
	Microsoft Dynamics AX supports the following databases: 

· SQL Server 2000, Service Pack 4 or later

· SQL Server 2005

· Oracle 


Installing and Configuring Analysis Services for OLAP Reporting

To install Analysis Services for OLAP reporting

1764. Insert the Microsoft SQL Server CD-ROM into your CD-ROM drive.
1765. When prompted, select SQL Server Components.

1766. Select Install Analysis Services.

1767. Complete the installation wizard.

To add users to the OLAP administrator's role

Any user who wants to create or process OLAP cubes in Microsoft Dynamics AX must be a member of the OLAP administrator's role on the Analysis Services. For information about adding a user to the list of OLAP administrators, see Creating Security Roles in the SQL Server Analysis Services books online.

Configuring Microsoft Dynamics AX for OLAP Reporting

After you install Analysis Services and define roles for OLAP reporting, you are ready to configure Microsoft Dynamics AX for OLAP reporting.

To create an OLAP server and an OLAP database in Microsoft Dynamics AX

1768. From a Microsoft Dynamics AX client, click Administration > Setup > Business analysis > OLAP > OLAP servers.
1769. On the Overview tab, enter an identifier in the Server ID field, for example Finance or OLAPSrvr. An ID is required.

1770. Enter the name of the Analysis Services server in the Server name field. If the Analysis Services server resides on the same server as Microsoft Dynamics AX, you must still enter the computer name. A server name is required.

1771. Enter a description if you want. Do not select the Valid checkbox, which will automatically be selected when you synchronize the server and database later in this procedure.

1772. Click OLAP databases.

1773. On the Overview tab, press CTRL + N to create a new line. Enter a name for your OLAP database.

Note   The name of your OLAP database must consist of numbers or letters. Do not use any symbols. If the name of your database contains a symbol, you might not be able to transfer the OLAP cube to the Analysis Services server. 

1774. Enter a description if you want. 
1775. In the Origin list box, leave the option set to Present Microsoft Dynamics. This option is intended to be read-only and indicates whether the cube was created by this Microsoft Dynamics AX instance or by some other tool.

1776. Press CTRL + S to save changes. Microsoft Dynamics AX creates the OLAP database in Analysis Services.

1777. To synchronize OLAP databases, click the Synchronize button on the OLAP servers form. If the synchronization is successful, OLAP is set up correctly. If the synchronization is not successful, see Checklist for troubleshooting Axapta OLAP reporting.

1778. When the synchronization is successful, press CTRL + S to save changes.

Set account permissions for database access

After you add an OLAP server and create an OLAP database in Microsoft Dynamics AX, you must set account permissions so Analysis Services can read data from the Microsoft Dynamics AX database. You can set account permissions using SQL Server Enterprise Manager:

1779. From the Start menu, click All Programs > Microsoft SQL Server > SQL Enterprise Manager.
1780. Expand the SQL Server hosting the Microsoft Dynamics AX database you created earlier in this topic.

1781. Expand the Security node.

1782. Select Logins.

1783. Click the New login button on the toolbar. The SQL Server Properties - New Login dialog box appears.

1784. In the Name text box, enter a name in the form domain\machinename$. For example, EU\SQLServer4$.

1785. Verify that Windows authentication is selected.

1786. Verify the domain.

1787. In the Default section, select the Microsoft Dynamics AX database you created earlier in this topic.

1788. Click the Database Access tab.

1789. Select the Microsoft Dynamics AX database.

1790. In the Database Roles for section, select the db_datareader role.

1791. Click OK.

The account accessing the Microsoft Dynamics AX database now has the appropriate permissions to read data for the purpose of generating OLAP reports.

To set OLAP parameters

The OLAP forms in the Basic module (Basic > Setup > Business analysis) specify information to be used on a per-company basis, such as which OLAP server and database to use. With this form, you can specify the date range to use when analyzing that company's data in PivotTable reports.

1792. From a Microsoft Dynamics AX client, click Basic > Setup > Business analysis.
1793. Select your default OLAP database.

1794. Enter the Year start and Year end values. By setting the year values on this form, you save time later by not having to set these values for each cube you create.

1795. Press CTRL + S to save changes.

OLAP cubes

After you create the OLAP server and database in Microsoft Dynamics AX and specify the parameters, you are ready to create an OLAP cube. An OLAP cube is the very foundation of the OLAP reporting process; that is, before you can create the cube, you must know the kind of reports your business decision makers want to generate. For example, business decision makers in the Sales group might want OLAP reports on sales of certain products, in a certain region, for a certain period of time. In order to create OLAP reports that satisfy these criteria, you need to sit down with business decision makers in your organization and determine the kind of OLAP reports they want to generate. Ideally, you would have key decision makers sitting with you when you create their cubes in Microsoft Dynamics AX.

Important   Before creating an OLAP cube, read OLAP Security to understand the security risks (and how to mitigate those risks) in OLAP reporting.

OLAP security

Business decision makers typically view online analytical processing (OLAP) data in a PivotTable report. A PivotTable, as the name implies, can be rearranged or "pivoted" quickly for a different data summary. By default, user groups do not have access to PivotTable reports. They must be granted access. This topic describes how to control access to OLAP reports.

Security notes

· Applications such as Microsoft Excel can link directly to OLAP cubes in Analysis Services. Even if you have restricted access to cube data in Microsoft Dynamics AX, end users might still be able to access cube data in Microsoft SQL Server Analysis Services if you have not properly configured security roles in Analysis Services. For more information about securing access to OLAP cubes in Analysis Services, see Creating Security Roles in the Microsoft SQL Server Analysis Services books online.

· Cubes from different companies in Microsoft Dynamics AX can overwrite each other unless those cubes are stored in separate Analysis Services databases. For this reason, create a unique Analysis Services database for each company that will generate OLAP reports. To learn how to create separate databases in Analysis Services, see Creating Databases in the SQL Server Analysis Services books online.

· Only members of the Administrators group in Microsoft Dynamics AX should be granted access to the OLAP parameters form (Basic > Setup > Business analysis > OLAP parameters) and the Business analysis forms (Administration > Setup > Business analysis). If a non-administrator is granted access to these forms, the user could view OLAP data not intended for that individual.

· If you restricted access to certain fields or tables in Microsoft Dynamics AX using Record level security, be aware that those restrictions are not propagated to OLAP cubes. To enforce data-level restrictions in OLAP cubes, use Analysis Services mining models and custom roles. For more information, see Creating Security Roles in the Microsoft SQL Server Analysis Services books online.

To learn more about OLAP cubes and PivotTable reports, see Introduction to OLAP Reporting.

Controlling access to OLAP data

SQL Server Analysis Services enforces OLAP security through roles. A user can access OLAP data if the user's name has been added to a role with access to OLAP data. If the user's name has not been added to a role, the user will not have access to OLAP data, regardless of any configurations in Microsoft Dynamics AX. For this reason, see the SQL Analysis Servers books online regarding how to add a user to an Analysis Services role.

Once the user has been added to an Analysis Services role, you must configure Microsoft Dynamics AX access to OLAP data. Users can view OLAP data from a variety of forms and menus in Microsoft Dynamics AX if their user group has permission to a form/menu and if an OLAP cube has been processed for the form/menu. For example, if members of a Finance group have View, Edit, Create, or Full Control permission for the General ledger > Chart of accounts > Inquiry menu, and if the administrator has processed a cube for this menu item, then members of that group can click Pivot table to view OLAP data for accounts in the General Ledger.

Users can access the Pivot table button or option from the following forms or menus:

· Administration > Inquiries > User log
· Administration > Users > User log
· Administration > Setup > Business analysis > OLAP > Cube Definition Manager > Cube instances
· Basic > Setup > Business analysis > Cube instances
· Accounts receivable > Customers > Inquiry
· Accounts payable > Vendors > Inquiry
· Basic > Inquiries > Analysis views
· Basic > Inquiries > Analysis views > View setup
· General ledger > Chart of accounts > Inquiry
· Human Resources > Employee
· Project > Projects > Inquiry
· Project > Setup > Category > Categories
· Inventory management > Items > Inquiries
· Inventory management > Setup > Inventory breakdown > Locations > Inquiries
· Questionnaire > Inquiries > Statistics > Result
To control access to OLAP data, determine which groups need access to which forms/menus. Next, determine the most restrictive permissions possible for the user group. You can set permissions on the User group permissions form (Administration > Setup > Security > User group permissions). If you are unsure whether a group should have access to a form, deny access until you receive explicit instructions stating otherwise from a manager or supervisor. When you receive a request for access to one of the preceding forms/menus, use the following procedure to grant access to the form/menu and thereby grant access to OLAP data.

Important   Restrict user group and application access to OLAP data and the Analysis Services server. If you do not restrict access, a malicious user could perform repeated OLAP operations that could quickly consume all memory and CPU resources on the server and the database and thereby render these computers temporarily inaccessible.

To grant access to OLAP data

1796. From a Microsoft Dynamics AX client, select a user group on the User group permissions form (Administration > Setup > Security > User group permissions). For the procedure to create a new user group, see Manage user groups.
1797. Select a domain. For the procedure to create a new domain, see Manage domains. 

1798. Click the Permissionstab.

1799. In the list box, select the form or menu to which you want to grant access, for example, Basic > Inquiries > Analysis views, and then select the appropriate permission under Access.

1800. If you select a child node, for example Analysis views, click Cascade to set the permission on all corresponding child tables and fields.

1801. Press CTRL + S to save changes.

Restricting OLAP cube availability in the Analysis views form

The Analysis views form (Basic > Inquiries > Analysis views) provides a list of processed OLAP cubes. If a user group can view an OLAP cube in the Analysis views form, then members of that group can view OLAP data by selecting a cube and clicking Pivot table. As a security best practice, restrict OLAP cube availability in the Analysis views form according to user groups.

To restrict OLAP cube availability in the Analysis views form

1802. From a Microsoft Dynamics AX client, click Administration > Setup > Business analysis > OLAP > Cube Definition Manager.
1803. On the Overview tab, select a cube definition.

1804. Click the General tab.

1805. Make a note of the key name in the Security key name drop-down list. For example, CustInquiries.

1806. Close the form.

1807. Open the User group permissions form (Administration > Setup >Security> User group permissions). 

1808. Select a user group and a domain and click the Permissions tab.

1809. Locate the node that corresponds to the security key. For example, select the Accounts receivable node and then select Inquiries. Notice that the security key CustInquiries appears in the left pane under Name.

1810. Under Access, select a permissions level. To view OLAP data using the Analysis views, a user group requires View permissions at the very least. If a user group currently has View permissions for a selected key and you want to restrict access, select No access. 

1811. Press CTRL + S to save changes.

1812. Repeat this procedure for each OLAP cube listed in the Cube Definition Manager.

Create and process an OLAP cube

An OLAP query returns data from multiple tables in a database. Because the query returns data from multiple tables, the query is said to be multidimensional. The multidimensional nature of the query is typically represented as a cube--called an OLAP cube. OLAP cubes must be configured, transferred to the Microsoft SQL Server Analysis Services server, and processed before they can be used by client applications. Be sure you have completed the OLAP setup processes described in Set up OLAP reporting before starting the procedures in this topic. For an introduction to OLAP cubes and OLAP concepts, see Introduction to OLAP reporting.

This topic includes the following procedures that show how to:

· Import Microsoft Dynamics AX standard cube definitions.

· Create a new cube definition.

· Create and process a cube instance.

Important   The process of creating and editing cube definitions, as described in this topic, must be completed with the help of business decision makers in your organization or company. Business decision makers will tell you what kind of data they want to process in an OLAP cube, which will determine how you create the cube. You might also need the help of a developer or partner to create new queries in Application Object Tree (AOT). Queries identify which data sources the cube should process. For more information about creating queries in AOT, see the Microsoft Dynamics AX software development kit.

Cube definitions

Microsoft Dynamics AX includes standard cube definitions, or cubes that have already been constructed. You can import and view standard cube definitions in the Microsoft Dynamics AX Cube Definition Manager. Standard cube definitions, when processed, return data about your customer revenue, inventory transactions, ledger transactions, and sales margins (to name a few). Some of the standard cube definitions might work for your organization without changes; that is, you can import the definitions, process them, and analyze the data to get meaningful results that will be of value to your business decision makers. Other standard cube definitions, however, require editing to make them suitable for your organization. If none of the standard cube definitions meet the needs of your organization, you can create your own cube definitions, as described later in this topic.

To import standard cube definitions

1813. From a Microsoft Dynamics AX client, click Administration > Setup > Business analysis > OLAP > Cube Definition Manager.
1814. Click Import/Export and select Import cube definitions.

1815. In the Import cube definitions dialog box, enter the following path in the File name field:
%systemdrive%:\Microsoft Dynamics AX client\data\OLAPSampleData.def
1816. Click OK to exit the Import cube definitions dialog box.

If the import was successful, you will see several cube definitions listed in the Cube Definition Manager form. Again, these cubes, when transferred and processed, will query your database and return report data that can be viewed in a PivotTable. If you import cube definitions from another source, you might need to construct an entity called a data warehouse, which Microsoft Dynamics AX does not require as long as you create cubes in Microsoft Dynamics AX or use the standard cube definitions.

If you have not created and processed a cube before now, you should go to the procedure in this topic called "To Create a Cube Instance". By creating and processing a cube with a standard cube definition, you can familiarize yourself with the process and quickly view an OLAP report in a PivotTable. Once you are familiar with the process, you will be ready to create your own cube definitions.

To create a new cube definition

1817. From a Microsoft Dynamics AX client, click Administration > Setup > Business analysis > OLAP > Cube Definition Manager.
1818. On the Overview tab, press CTRL+N to add a new cube definition.

1819. Enter a name in the Cube name field. If you are using SQL Server Analysis Services 2000, then cubes must be named using Latin characters. SQL Server Analysis Services 2000 can not process cubes named with characters other than Latin characters.

1820. Select a query from the Query drop-down list. If you want to use a new query, you must first add the query to Application Object Tree (AOT). For more information, see the Microsoft Dynamics AX software development kit.

1821. Enter a description of this cube in the Description field.

1822. Select a module in the Application module drop-down list. The cube definition and the module should correspond. For example, if you are creating a cube that processes sales data, select the Sales & Marketing module.

General tab

1823. Click the General tab.
1824. Select a key in the Configuration Key drop-down list (optional).

1825. Select a key in the Security key namedrop-down list (optional, but strongly recommended for securing access).

Measures tab

1826. Click the Measures tab.
1827. Enter a name in the Measure field.

1828. Select a field from the Field name drop-down list.

1829. Select a calculation function for the measure in the Aggregate function box.

1830. Select a field in the Transaction date field box if the measure represents an amount that will be given in a foreign currency.

1831. To add additional measures, press CTRL+N.

Dimensions tab

1832. Click the Dimensions tab.
1833. Enter a name in the Dimension name field, for example, Customer or Product or Time. 

1834. Select Regular or Time in the Dimension type drop-down list.

Note   Most cubes use more than one dimension (view the standard cube definitions to see an example). To add additional dimensions, press CTRL+N.

The item currently selected on the Dimensions tab determines the options you see on the Levels tab. That is, levels options for Regular dimensions are different from options for Time dimensions. You must add at least one level to each dimension to process the cube definition—this means that you must select one dimension on the Dimensions tab and then click the Levels tab to set levels options for that dimension. Next, you must return to the Dimensions tab and select a new dimension until you have set level options for all of the dimensions.

1835. To add a level for a Regular dimension, do the following:
ba. Press CTRL+N to create a new level.
bb. Enter a name in the Level name field. The name cannot begin with a number.

bc. Select a data source in the Name of table drop-down list.

bd. Select a field in the Field name drop-down list.

be. To add additional levels, press CTRL+N.

bf. To analyze a measure across an aggregate of all the dimension levels, select the All level box.

1836. To add a level for a Time dimension, do the following:

bg. Select a field in the Time field drop-down list.
bh. Select Use calendar year or Use accounting periods.

bi. In the Time levels list box, press CTRL+N and select the appropriate level from the drop-down list.

bj. To add additional levels, press CTRL+N.

bk. To analyze a measure across an aggregate of all the dimension levels, select the All level box.

Calculated member tab

1837. Click the Calculated member tab.
1838. Define a calculation to perform on a measure or dimension by doing the following:

bl. Click Add member.
bm. Type the name of the calculated member in the Member name field.

bn. Select Measures or a specific dimension on which to perform the calculation in the Parent dimension box.

bo. Expand the Data tree and double-click a measure or dimension level to add it to the Expression box.

bp. Expand the Function tree and double-click a function to add it to the Expression box.

bq. Modify the expression, as needed, and then click OK.

Important   If you see the following error in the Infolog, you created a level in the wrong dimension which caused an orphaned table: "Error 0x8004004F: A table was detected in the schema that is not joined to any other table." Verify all levels on the Dimensions tab. You might need to delete levels to remedy this problem.

Now that you have created a cube definition, you are ready to create a cube instance, transfer that instance to the Analysis Services server, and process the cube.

To create and process a cube instance

Before you can process a cube, you must copy it and move the copy to the Analysis Services Server. The copy of the cube is called a cube instance. Described another way, a cube instance is a representation of a cube definition that is stored on an OLAP server. You can have several instances of the same cube and can use these instances to make versions of cubes in multiple currencies or from multiple time periods.

Important   If you modify and transfer an existing cube, all cube security settings (roles and permissions) are lost and need to be recreated using SQL Server Analysis Services administration.

1839. From a Microsoft Dynamics AX client, click Basic > Setup > Business analysis > Cube instances.
1840. On the Overview tab, click Create instances. Microsoft Dynamics AX creates instances for all cubes listed in the Cube Definition Manager.

1841. On the General tab, change the identification and parameters details as necessary.

Note   Microsoft Dynamics AX generates a table that contains time information based on the Year start and Year end times. Each day in the period exists as a separate entry, which can make for an extremely large time table. For performance reasons, enter the precise time period for which you want report data.

1842. On the Overview tab, select the cubes that you want to transfer to the Analysis Services server for processing, and then click Transfer Cube.
Note   If the name of your OLAP database contains a symbol, you might not be able to transfer the OLAP cube to the Analysis Services server. If the cube failed to transfer, verify that the name of the OLAP database does not contain a symbol. 
1843. In the Batch, enter the desired processing details and click OK. The Infolog shows the transfer progress.
Important   Consider enabling automatic batch processing for OLAP cube instances. If a cube instance is not processed on a regular basis, business decision makers might be looking at outdated data.

1844. Select the cubes you want to process, and then click Process. The Process cubes form appears. Verify the details and click OK. The Infolog provides status about cube processing. If the operation is completed successfully, close the dialog to save changes. If the operation fails, review the details in the Infolog. If you need help troubleshooting the operation, see Checklist for troubleshooting Axapta OLAP reporting. 
For details on how to view cube data in a PivotTable report, see View OLAP reports.

Set up an OLAP server to work with an Oracle database

The procedures in this topic describe how to configure Microsoft SQL Server Analysis Services to retrieve data from an Oracle 10g database for Microsoft Dynamics AX online analytical processing (OLAP).

Important   OLAP reporting requires Microsoft SQL Server Analysis Services 2000 or 2005, even if your data is stored in an Oracle database. For information on setting up an OLAP database, see Set up OLAP reporting.

To set Microsoft Dynamics AX up to work with an Oracle Database, you must work with an Oracle database administrator (DBA) to follow this process. On the computer running SQL Server Analysis Services: 

1845. Install an Oracle Database Client. 
1846. Set up a Net Service connection.

1847. Specify the Oracle data source in Microsoft SQL Server Analysis Services.

Install an Oracle client
On the computer running SQL Server Analysis Services, the Oracle DBA must perform the following steps. 
1848. Install an Oracle Database Client (10g release), Runtime version.
1849. Create an Oracle Net Service to connect to the Microsoft Dynamics AX database. 

Note   The user account used by the Oracle Net Service must have read access to the Microsoft Dynamics AX database.
Specify a data source in Microsoft SQL Server Analysis Services

You must configure Analysis Services to use the Oracle data source.

To specify a data source in SQL Server 2000 Analysis Services
1850. Open SQL Server Analysis Manager (Start > All Programs > Microsoft SQL Server > Analysis Services Manager).
1851. Expand the database tree.

1852. Right-click the Data Sources folder and then click New Data Source.

1853. In the Data Link Properties dialog box, on the Provider tab, select Microsoft OLE DB Provider for Oracle.

1854. On the Connection tab, in the Server name field, enter the name of the Oracle Net Service.

1855. Specify user credentials so that Analysis Services can connect to Oracle.

Important   If you select Allow saving password, the password is saved unmasked and unencrypted with the connection string. This can create a security vulnerability if the repository is accessible to other users.

1856. To determine whether the data source is correctly connected, click Test Connection.

1857. In the Data Link Properties dialog box, click OK.

To specify a data source in SQL Server 2005 Analysis Services
1858. Open a project in SQL Server Business Intelligence Development Studio (Start > All Programs > Microsoft SQL Server 2005 > SQL Server Business Intelligence Development Studio).
1859. Connect to your OLAP database (File > Open > Analysis Services Database).
1860. In Solution Explorer, right-click Data Sources, and click New Data Source. 

1861. On the Select how to define the connection page, select Create a data source based on an existing or new connection, and then click New.

1862. In the Provider list, select Microsoft OLE DB provider for Oracle. 
1863. In the Server field enter the name of the Net Service, the user name and password. 

1864. Select Save my password.

1865. Click Test Connection.

1866. In the Datasource designer, click the Impersonation Information tab and then select Use service account.

1867. Save the datasource.

Managing version control

The Version Control Management System (VCMS) enables a team of developers to work, at the same time, on the code base in one or more projects. Using a VCMS has several advantages:

· Each developer can save time by safely saving their modifications, without the risk of overwriting work or changes that have already been done.

· Developers can save their work periodically to ensure that no work is lost.

· Developers can easily share their changes when they are working on a project.

· Developers can test changes in the application without the risk of losing previous work, as they can always roll back their changes to an earlier version.

· Changes in the code are monitored and saved to provide an audit trail for any potential roll backs.

· Developers can track changes and compare different versions of the objects.

Each object in the Application Object Tree (AOT) must have a unique ID. When you develop in a team environment, you can use a centralized service to control the allocation of IDs. You can connect the team server to the VCMS to issue object IDs and Label IDs when new objects are added.

The following topics provide information about the VCMS in Microsoft Dynamics AX, how you set it up, and how you deploy it.

	Topics
	Description

	Set up a team server
	Provides information about how to set up up the team server and issues object IDs.

	Set up the Visual SourceSafe server
	Provides information about how to set up up the object server, such as a server that runs Microsoft Visual SourceSafe.

	Set up global version control parameters (Administrator)
	Provides information about how to set up the global parameters for the VCMS and enabling version control globally. 

	Set up local version control parameters (Developer)
	Provides information about how to set up version control parameters on developer computers and enabling version control for developers who are working on the development project.

	Deploy AOT objects on the VSS server
	Provides information about how to adding application objects to the server that runs VSS and assigning IDs to objects.

	Deploy label file on the VSS server
	Provides information about how to add label files to the server that runs VSS. and assigning IDs to labels.

	Add rules for objects
	Provides information about how to add rules for object names and object types.

	Managing object IDs
	Provides information about how to manage the computer that runs the team server such as releasing unused IDs.


Set up a team servera team server

When you develop for Microsoft Dynamics AX in a team environment, you need a central service to coordinate the assignment of unique identification to each object and label. The team server handles the task of issuing IDs when developers create new objects and labels.

Note   We recommend that you set up the team server on a different computer from the Microsoft Dynamics AX database. If the two databases are installed on the same computer, the Application Object Server (AOS) account is authenticated by two different user groups. Therefore, the two groups have access to either the Microsoft Dynamics AX database or the team server database but not both.

Prerequisites

The Team Server Setup Wizard deploys the team server components and creates the database and schema. The wizard also adds the stored procedures that serve as an interface to the computer running Team Server.
Before you continue, verify that the following prerequisites are met.
Prerequisites for Microsoft SQL Server

· Follow the operating system requirements for the database server. For more information, see Microsoft SQL Server 2005 system requirements.

· Microsoft SQL Server 2000 or 2005.

Note   SQL Server must be configured to operate in Windows Authentication security mode.
· Each developer computer must be added as a user on the team server. When you set up the team server, you will be asked for the user group name. Therefore, before you set up the Team Server, create a new local user group, and add all developer computers as members.
· SQL Server agent is running.

Prerequisites for Oracle

· Follow the operating system requirements for the database server. For more information, see Oracle.com.

· Oracle database server.

Note   The Oracle database server must be configured to use Windows authentication.
Set up the Team server on MS SQL
The Team Server Setup Wizard is available to help you install and set up the team server.

1868. If you have not already done this, insert the Microsoft Dynamics AX DVD into the computer that is running the team server.
1869. If the wizard does not start automatically, double-click the Autorun.hta file in the root directory of the DVD.

1870. Click Browse additional tools.

1871. Click Install Team Server.

1872. In the Welcome screen, click Next.

1873. Select your language, read the License agreement terms carefully, select I accept the terms in the License agreement, and then click Next.
1874. Select Microsoft SQL Server, type the SQL Server name, and then click Next.

1875. Type the Team Server database name, and then click Next.

1876. Type the Team Server user group name, and then click Next.

1877. Click Install.

1878. On the Setup Wizard Completed page, click Finish.
Note   When you create the repository and the label file in the version control database, IDs are assigned to all objects and labels. For more information, see Deploy AOT objects on the VSS server and Deploy label file on the VSS server.

Set up Team Server on Oracle
The Team Server Setup Wizard is available to help you install and set up the team server.

1879. If you have not already done this, insert the Microsoft Dynamics AX DVD on the computer that is running the team server. If the wizard does not start automatically, double-click the Autorun.hta file in the root directory of the DVD.
1880. Click Browse additional tools.

1881. Click Install Team Server.

1882. In the Welcome screen, click Next.

1883. Select your language, read the License agreement terms carefully, select I accept the terms in the License agreement, and then click Next.
1884. Select Oracle Database Server, type the TNS Service name, and then click Next.

1885. Type the Schema name and Password, and then click Next.

1886. Type the Oracle Role name, and then click Next.

Note   The wizard automatically adds the new Oracle role to the schema. To grant developers access to the team server schema, you must add each developer's computer to the new Oracle role.

1887. Click Install.
1888. On the Setup Wizard Completed page, click Finish.
Note   When you create the repository and the label file in the version control database, IDs are assigned to all objects and labels. For more information, see Deploy AOT objects on the VSS server and Deploy label file on the VSS server.

Set up the server that runs Visual SourceSafe

The server that is running Microsoft Visual SourceSafe (VSS) stores all versions of the application objects. When you want to modify an application object, you must check out the object from the server, make your modifications, and check in the changed object on the server.

Note   We recommend that you install VSS on a separate server.

To successfully install and set up VSS on a server, follow these steps:

Prerequisites

· Microsoft Visual SourceSafe 2005 on the computer that will be the server for VSS.

· A VSS database on the server.

· A new project in the VSS database.

Note   Follow the installation and setup instructions in the VSS 2005 documentation.

Share the VSS database folder on the server

The developers who use the VSS database need access to the VSS database folder on the server that is running VSS. The security setup mentioned here can be changed based on your preferences.

1889. Open Windows Explorer.
1890. Right-click the VSS database folder and select Sharing and Security.

1891. Click Share this folder.

1892. Click Permissions.

1893. In Group or User names, click Everyone or click Add to add a specific developer to the list.

1894. In Permissions for Everyone, select the appropriate access level, such as Full control.

1895. Click OK twice.

Set up global version control parameters (Administrator)

As an administrator, you control the global settings for the version control management system (VCMS). This includes specifying the team server, specifying rules for objects in Microsoft Visual SourceSafe (VSS), and setting rules for best practices. When you have enabled the VCMS globally, the individual developers can choose their personal setup, which might include a repository folder or other options.

Create a local repository folder

1896. Open Windows Explorer.
1897. Create a new folder to use as your local repository folder. For example, C:\Dynamics_Repository.

Set up the Global version control Parameters (Administrator)

1898. Click Tools > Development tools > Version control > Setup > System settings.
1899. In Version control system, select Visual SourceSafe.

1900. In Repository folder, type the name of your local repository folder. For example, C:\Dynamics_Repository.

1901. In Team Server Type, select Microsoft SQL Server or Oracle.

1902. If you selected Microsoft SQL Server in step 4, type or select the name of the team server in the Team Server Name field.

–or–

If you selected Oracle in step 4, type or select the TNS Service name in the Team Server TNS Service Name field.
1903. If you selected Microsoft SQL Server in step 4, type or select the name of the team server database, such as AXTS, in the Team Server Database name field. For more information about how to set up a team server, see Set up a Team server.

–or–

If you selected Oracle in step 4, type or select the team server schema, such as AXTS, in Team Server Schema field. For more information about how to set up a team server, see Set up a team server.

1904. Click the Visual SourceSafe tab.

1905. In SourceSafe database .INI file, type the path and filename for the SourceSafe.Ini file in the SourceSafe database folder on the server that is running VSS. Optionally, click Browse to locate the SourceSafe.Ini file.

1906. In the SourceSafe root project field, type the name of the project in VSS. Remember to include the ROOT name, such as $/AX40VersionControl.

1907. Click the General tab.

1908. In Source control status, select Enable, and then click Apply.

1909. Click Yes to confirm changes to the global settings.

Note   By default, all the Best practice settings are set to "Reject", and Run Title Case Update is set to "No".

Note   When you have successfully set up the global version control parameters and click Apply, you receive a message that the definition file has been created successfully. This definition file (vcsdef.xml) defines the global settings for interaction with the VCMS, including the name of the computer that is running Team Server and information about the project you are working on. This file is automatically created or modified and checked into VSS whenever you set up or change the global parameters. It is important to protect this file from being changed by others. The version control structure in VSS is generated by Microsoft Dynamics AX.

Protect the Global Version Control settings

Only the VCMS administrator should have Write permissions to the definition file. Otherwise, developers can accidentally turn off version control for all developers by disabling version control on the System settings form. Developers are allowed to disable their personal version control parameters but should not be allowed to change the global settings.

To protect the Global Version Control settings in VSS:

1910. Click Start > All programs > Microsoft Visual SourceSafe > Microsoft Visual SourceSafe Administration.
1911. Click Tools > Options.

1912. Select the Project rights tab, select Enable Rights and Assignments commands, and then click OK.

1913. Click Tools > Rights by project.

1914. Expand the project nodes and select the Definition node.

1915. Select all developers in the Users list, and clear the Check Out/Check In check box. This will provide Read permissions only to all developers, while the administrator maintains all permissions.

Set up local version control parameters (Developer)

When your version control management system (VCMS) administrator has set up a team server, installed Microsoft Visual SourceSafe (VSS) on a server, and has enabled version control globally, you can enable version control on your development computers.

When you have successfully enabled version control on your development computer, you can check out and modify objects in the Application Object Tree (AOT), add new objects, and more. After you make changes and check them into VSS, other developers who are working on the same project can retrieve the updated object from the server that is running VSS. For more information about how to use version control features, see Version Control System.
Prerequisites

On your development computer, the following must be installed:

· Microsoft Windows Server 2003.

· Microsoft Dynamics AX application and client.

· Microsoft Visual SourceSafe on a client computer (optional).

Create a local Repository folder

1916. Open Windows Explorer.
1917. Create a new folder to use as your local repository folder. For example, C:\VCS_Repository.

Enable version control locally (Developer)

1918. Click Tools > Development tools > Version control > Setup > Parameters.
1919. In Version control system, select Visual SourceSafe.

1920. In Repository folder, type the name of your local repository folder. For example, C:\VCS_Repository.

1921. Click the Visual SourceSafe tab.

1922. In SourceSafe database .INI file, type the path and file name for the SourceSafe.Ini file in the SourceSafe database folder on the server that is running VSS.

1923. In the SourceSafe root project field, type the name of the project in VSS. Remember to include the ROOT name, such as $/Ax40VersionControl.

1924. Click the General tab.

1925. In Source control status, select Enable, and then click Apply.

Synchronize AOT objects with the server

At first, the local version of Microsoft Dynamics AX might be out of sync with the master version that is deployed by your VCMS administrator. Objects might be created, modified, deleted, or renamed. To access the latest version of all AOT objects, synchronize your local version with the version on the server that is running VSS.

1926. Click Tools > Development tools > Version control > Synchronize.
1927. Select whether you want to force the synchronization and whether you want to delete local objects that have been deleted on the version control server (optional). 

1928. Click OK to start synchronization.

The latest version of all AOT objects on the server that is running VSS will be copied to the repository folder on your development computer.

Deploy AOT objects on the server that runs Visual SourceSafeSafe

When you have set up the team server and the server that is running Microsoft Visual SourceSafe (VSS), you must add all objects, from your master copy of Microsoft Dynamics AX, to the VSS server.

When you add the objects to the server that is running VSS, they are automatically registered in the team server so that IDs are assigned to them. Assigning IDs to all existing objects ensures that the team server can issue unique IDs for new objects when they are created.

Create a local Repository folder

If you have not already done this, create a repository folder on your computer. When you deploy the Application Object Tree (AOT) objects, a copy of each object is also added to your repository folder.

1929. Open Windows Explorer.
1930. Create a new folder to use as your local repository folder, such as C:\VCS_Repository.

Create Repository

1931. Click Tools > Development tools > Version control > Setup > Create repository.
1932. In Check-in description, type a description of the check in, such as "Creation of repository."

1933. Click OK.

Note   This process might take some time, depending on the computer and network speed.

Deploy a label file on the server that runs Visual SourceSafe

The label files that you use in your development must be added to Microsoft Visual SourceSafe (VSS). IDs are assigned, by the team server, when you add the label files to VSS.

Create a label file

1934. Click Tools > Development tools > Version control > Setup > Create label file.
1935. In Check-in description, type a description of the check in, such as "Initial creation of label file."

1936. In File name, type the path and name of the label file, or click Browse to locate the master label file. Label files are usually located in the C:\Program file\Microsoft Dynamics Ax\40\Application\Appl\Standard folder.

1937. Click OK.

1938. Repeat steps 1 through 4 to add more label files to VSS.

Add rules for objects

By enabling the version control management system (VCMS), you can also add rules for which object names and object types developers can check into Microsoft Visual SourceSafe (VSS).

Note   The global settings might be protected from changes so that only the VCMS administrator can perform this task.

Note   We recommend that your development team follows the Microsoft Dynamics AX Development Best Practices.

Specify unwanted object names

1939. Click Tools > Development tools > Version control > Setup > System settings.
1940. Click the Object rules Tab.

1941. In Unwanted object names, type the object names or parts of object names that you do not want developers to check in to VSS.


Examples
If you do not allow for object names that start with AAA, type <AAA, where the less-than sign means "starts with".
If you do not allow for form names such as 'Form1', 'Form45', or something similar, type <Form:d+, where :d+ represents one or more numeric characters.
For more information about the special characters that you can use when you specify unwanted object names, see the remarks section for the match Function.

Specify unwanted object types

1942. Click Tools > Development tools > Version control > Setup > System settings.
1943. Click the Object rules tab.

1944. In Unwanted object types, select the object types that you do not want developers to create and check in to VSS.

1945. Press CTRL+N to add more object types to the list.

Managing object IDs

The Team server allocates object IDs (OID) and Label IDs (LID) when developers add objects and labels to the system. Each layer in Microsoft Dynamics AX has a limited number of available IDs, and, during the development phase, some IDs are reserved but not used. This happens if developers import lots of objects or create objects only for testing.

At some point, you might run out of available IDs, and the Team Server Administrator has to recover the unused IDs for reallocation. You do this manually by using the stored procedures that were added to the Team server database during installation.

Note   When you rename an object, the ID stays the same.

Example

If developers import lots of objects or create objects for testing, many IDs are allocated and fewer Ids are available in a range. For example, Developer A creates a new table and reserves object ID 1000. At the same time, developer B creates a table and reserves object ID number 1001. Developer A then deletes the table again, because it was only used for testing. Developer B checks in his new table in the version control system. Object ID number 1000 is now unused because it is not automatically released/recovered on the Team Server when the developer deleted the object.

Recovering unused IDs

Because the Team server can be deployed on either an Oracle database server, or Microsoft SQL Server 2000 or 2005, the execution of the stored procedures varies.

Therefore, we will not go into details with the execution of the stored procedures here. For more details about how to execute stored procedures on the server, see your Microsoft SQL server or Oracle documentation. However, the following example shows how to use the stored procedure FREELABELID, in Microsoft SQL Server 2005, to release label ID number one in the label file "TST":

USE [DatabaseName]

GO

DECLARE     @return_value int

EXEC  @return_value = [dbo].[FREELABELID]

            @LABELFILEID = N'TST',

            @ID = 1

SELECT      'Return Value' = @return_value

GO
Stored Procedures

The database administrator can use the database management tools to execute the following stored procedures.

Note   GETOBJECTID, ALLOCOBJECTID, REGLABELFILE, GETLABELID and ALLOCLABELID can be accessed by users who have development permissions. The rest of the stored procedures require administrative permissions.
	Stored procedure name and parameters
	Description

	ALLOCLABELID(LABELFILEID, ID)
	Allocate a specific LID from a specific label file.

	ALLOCOBJECTID(TYPEID, ID, [PARENTID])
	Allocate a specific OID, of the specified type, in the specified layer. 

	FREELABELID(LABELFILEID, ID)
	Recover the specified LID to an unallocated state for reallocation.

	FREEOBJECTID(TYPEID, ID, [PARENTID])
	Recover the specified OID, of the specified object type, to an unallocated state for reallocation.

	GETALLOCATEDLABELIDCNT(COUNT, [LABELFILEID])
	Get the count of allocated LIDs in the specified label file.

	GETALLOCATEDOBJECTIDCNT(COUNT, LAYERID, TYPEID, PARENTID)
	Get the count of available OIDs of a certain object type in the specified layer.

	GETAVAILABLELABELIDCNT()
	Get the count of available LIDs in the specified label file.

	GETAVAILABLEOBJECTIDCNT()
	Retrieve the counts of available OIDs per layer and object type.

	GETLABELID(LABELFILEID, ID)
	Retrieve a label ID from the specified label file. You can specify the ID value.

	GETOBJECTID(LAYERID, TYPEID, ID, PARENTID)
	Retrieve an object ID for an object of the specified type.
You can specify the OID to retrieve, in which case the appropriate layer is detected automatically.

	REGLABELFILE(LABELFILEID)
	Register the specified label file ID in the Team server database. When a label file has been registered, the Team server can allocate LIDs for the label file.

	RESETLABELIDS(LABELFILEID)
	Recover all LIDs in the specified label file.

	RESETOBJECTIDS(LAYERID, TYPEID, PARENTID)
	Recover all OIDs, of the specified type, in the specified layer.

	UNREGLABELFILE(LABELFILEID)
	Unregister the specified label file. When a label file is unregistered, all its corresponding LID ranges are deleted. No LIDs can be allocated for the unregistered label file.


Parameter: Layer ID

When you work with layers in Microsoft Dynamics AX, you normally refer to the layer name, such as SYS. However, when you work with the stored procedures on the Team server, you have to use the Layer IDs. The following list of layer IDs is available in the LAYERS table in the Team server database.

	Layer ID
	Layer name
	Range min. value
	Range max. value

	0
	Sys
	1
	8000

	1
	Syp
	1
	8000

	2
	Gls
	8000
	16000

	3
	Glp
	8000
	16000

	4
	Dis
	16000
	18000

	5
	Dip
	16000
	18000

	6
	Los
	18000
	20000

	7
	Lop
	18000
	20000

	8
	Bus
	20000
	30000

	9
	Bup
	20000
	30000

	10
	Var
	30000
	40000

	11
	Vap
	30000
	40000

	12
	Cus
	40000
	50000

	13
	Cup
	40000
	50000

	14
	Usr
	50000
	60000

	15
	Usp
	50000
	60000


Parameter: Type ID and Parent ID

Objects of the same type, in the same layer, must have unique IDs. Objects of different types, in the same layer, can have identical IDs. For example, you can have a table in the SYS layer with ID number 1 and an Enum in the SYS layer with ID number 1. You cannot have two Enums, in the same layer, with the same ID. The following list of type IDs is available in the TYPES table in the Team server database.

	Type ID
	Parent ID
	Type name

	12
	12
	TableInstanceMethod

	15
	15
	LicenseCode

	26
	26
	TableMap

	35
	35
	ConfigurationKey

	36
	36
	SecurityKey

	40
	40
	Enum

	41
	41
	ExtendedType

	42
	44
	TableField

	43
	44
	TableIndex

	44
	44
	Table

	45
	45
	Class

	66
	66
	Perspective


Return codes

The following return codes indicate the overall success or failure of the execution of the stored procedures.
	Return code number
	Return code description

	0
	Operation completed successfully

	-1
	Invalid TYPEID.

	-2
	Invalid LAYERID.

	-3
	No IDs available for the specified LAYERID, TYPEID and PARENTID.

	-4
	PARENTID not allowed for this element type.

	-5
	Invalid LABELFILEID.

	-6
	PARENTID out of range.

	-7
	PARENTID required for this element type.

	-8
	Invalid ID.

	-9
	ID already allocated.

	-10
	ID not allocated.

	-11
	TYPEID required when PARENTID is specified.

	-12
	LABELFILEID already registered.

	-13
	LABELFILEID not registered.

	-14
	No IDs available for the specified LABELFILEID.

	-255
	TS internal error.


Additional parameters

By default, developers will receive a warning when there are less than 1,000 OIDs and 20,000 LIDs available. The Team server database administrator can change these values in the SETTINGS table in the Team server database.

All changes that are made, by calling stored procedures, are logged in the EVTLOG table. You can specify the maximum number of days to keep them in the log by changing the MAXLOG value in the SETTINGS table. The default value is 30 days.

Cleaning up the Team server

ProcedureTitle

ProcedureTitle

Test an installation

After installation, and before proceeding to configuring Microsoft Dynamics AX, test whether your installation is functioning.

To test whether an installation of a Microsoft Dynamics AX system has succeeded, perform the following steps:

1946. Start all Application Object Server (AOS) instances.
1947. Launch a client that is connected to each running AOS instance.

1948. Test the security of your system:

· Can an unauthorized user get to application files? 

· Can an unauthorized user get to the database computer?

· Can an unauthorized user get to your Enterprise Portal site?

· Can an unauthorized user get to your application integration site? 

· Validate that you have correct permissions on the reporting server data.

· Validate who is allowed to print Microsoft Dynamics AX data.

· Set events to look for unusual activity.

· Establish a procedure for monitoring logs for unusual activity.

For information about troubleshooting, see Troubleshooting.

Troubleshooting

To find recommendations for resolving a specific issue, start by searching the Help system for the error message you have received.

This section contains the following topics:

· Repair Microsoft Dynamics AX
· Uninstall Microsoft Dynamics AX
· Troubleshoot installation issues
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Troubleshoot upgrade issues
· Troubleshooting problems with clients
· Troubleshoot access management
· Tune database settings
· Troubleshooting problems operating the Application Object Server
· Troubleshoot Business Connector
· Troubleshooting Enterprise Portal
· Checklist for troubleshooting OLAP reporting
· Troubleshoot problems operating the Appliction Integration Framework
· Tracing
Repair Microsoft Dynamics AX

To repair a Microsoft Dynamics AX installation that returns messages that a file cannot be found, you may need to uninstall and reinstall one or more roles. For details, see Uninstall Microsoft Dynamics AX.

Uninstall Microsoft Dynamics AX

To uninstall Microsoft Dynamics AX, on each computer in the system, you must uninstall the components installed on that computer. 

Remove components

The following procedure can be followed for any Microsoft Dynamics AX component.

1949. Open Add or Remove Programs. (Start > All Programs > Control Panel > Add or Remove Programs).
1950. Select the component that you want to remove, and then click Remove. Possible components to remove include:

· Microsoft Dynamics 4.0 Client

Setting up the Microsoft Dynamics Client also installs the following components that you may want to remove.

- Microsoft SQL Server Native Client

- Microsoft SQL Server 2005 Analysis Services 9.0 OLEDB Provider

- Microsoft SQL Server Management Objects Collection 

- MSXML 6.0 Parser

· Microsoft Dynamics 4.0 COM Business Connector

· Microsoft Dynamics 4.0 .NET Business Connector

· Microsoft Dynamics 4.0 Object Server (##-instancename), where ## is an integer from 01 to 20

· Microsoft Dynamics 4.0 Application Integration Server

1951. A message box asks you to confirm that you want to uninstall the product. To proceed with the uninstallation process, click Yes.

The Setup wizard removes the component from your computer. If Setup requires access to the DVD, you are prompted to insert it.

1952. Repeat for all components installed on the computer.

Remove other files

If you choose to remove an entire installation, some files and accounts remain after Add or Remove Programs is finished. Databases, log files, and application files must be removed manually. The following table provides more information:

	To remove this 
	Do this 

	Application files
	Delete the application file directory from the location you installed it to.

	Database and log files
	Use your database server (Microsoft SQL Server or Oracle) to delete the database and log files.


Troubleshoot installation issues

This topic provides information about troubleshooting issues encountered in installing a Microsoft Dynamics AX system. If Setup fails, first refer to the Setup log that is created each time Microsoft Dynamics AX is installed.

Review the Setup log and error messages

1953. Navigate to: Documents and Settings\All Users\Application Data\Microsoft\Dynamics AX\Dynamics AX Setup Logs\Date Time\ DynamicsSetupLog.txt.
1954. Find the error message returned by the failure. Review the information immediately following the error message in the log for details.

Error messages returned by Setup

The following table lists the error messages that Setup can return, and possible causes for each.

	Error message
	Possible cause

	You must be an administrator on the local computer to run Microsoft Dynamics AX Setup
	Your domain account is not a member of the local computer group Administrators.

	An error occurred while the log file {0} was initializing. Confirm that you have rights to the folder that contains the log file. You might need to be an administrator to access some folders. The following messages would have been written to the log if you had rights to it:
	Your domain account does not have rights to write to the directory where the log files are placed (Documents and Settings\All Users\Application Data\Microsoft\Dynamics AX\Dynamics AX Setup Logs\Date Time\AxSetupLog.txt). Contact a system administrator.

	An unexpected exception occurred. See the log file {0} for details.
	An unexpected error occurred.  Review the messages below this line to determine the problem.

	The parameter {0} was not recognized.
	A parameter sent to the Setup program was not recognized. Review the syntax you are using.

	The parameter {0} contains the invalid value {1}. Cause: {2}.
	A value included for a Setup parameter was incorrect. Review the syntax you are using.

	The parameter file {0} was not found.
	The location of the file in the parmfile parameter passed to the Setup program could not be found.

	An error occurred while parameter file {0} was being read. Error:
	The parameter file passed by the parmfile parameter could not be read. Review the file to identify the error.

	Setup cannot install from this location because the.NET security level for this security zone is not set to Full Trust. You can change the .NET security level for a zone in .NET Framework Configuration in Control Panel.
	Setup cannot install from this location because the .NET security level for this security zone is not set to Full Trust. You can change the .NET security level for a zone in Control Panel > .NET Framework Configuration.

	The parameter {0} contains the invalid value {1}. Specify 0 for False or No. Specify 1 for True or Yes.
	An invalid value has been passed to a parameter. Specify 0 for false or no. Specify 1 for true or yes.

	The parameter {0} contains the invalid value {1}. The value must be one of the following: {2}.
	An invalid value has been passed to a parameter. Review the syntax you are using to pass the parameter values.

	The parameter {0} contains the invalid value {1}.
	An invalid value has been passed to a parameter. Review the syntax you are using to pass the parameter values.

	You must set a value for the parameter {0} if the parameter {1} is set to {2}.
	The parameter you set is dependent on the value of another parameter. Review the Setup parameters documentation.

	The required Lists file {0} was not found.
	The AxSetupLists.txt file could not be found. It is part of a standard Microsoft Dynamics AX installation, and should be available on the DVD. Copy the file to the share you are installing from.

	An error occurred while reading the AxSetup Lists file {0}. Error:
	The AxSetupLists.txt file could not be read. It is part of a standard Microsoft Dynamics AX installation, and should be available on the DVD. Copy the file to the share you are installing from.

	An invalid record format was found in file {0}, line {1}. The line should contain {2} values separated by tabs. Found: {3}
	The file contains an invalid record format. Re-create the file and try again.

	An invalid record format was found in file {0}, record {1}, section '{2}'. Field {3} cannot be: '{4}'
	The file contains an invalid record format. Re-create the file and try again.

	The LicenseTerms section is missing from file {0}.
	The LicenseTerms required for this installation could not be found in the AxSetupLists.txt file. It is part of a standard Microsoft Dynamics AX installation, and should be available on the DVD. Copy the file to the share you are installing from.

	The license file {0} was not found.
	The License file could not be found. It is part of a standard Microsoft Dynamics AX installation, and should be available on the DVD. Copy the file to the share you are installing from.

	An error occurred while reading License file {0}. Reason {1}
	The License file could not be read. It is part of a standard Microsoft Dynamics AX installation, and should be available on the DVD. Copy the file to the share you are installing from.

	The LicenseTermsVersion code {0} is not valid. Valid codes can be found in the LicenseTerms section of file {1}
	The parameter file contains an invalid LicenseTermVersion code. Refer to the AxSetupLists.txt file on the DVD for valid codes.

	The ClientLanguage code {0} is not valid. Valid codes can be found in the Language section of file {1}.
	The parameter file contains an invalid ClientLanguage code. Refer to the AxSetupLists.txt file on the DVD for valid codes.

	The ApplicationRegion code {0} is not valid. Valid codes can be found in the Region section of file {1}.
	The parameter file contains an invalid ApplicationRegion code. Refer to the AxSetupLists.txt file on the DVD for valid codes.

	The ClientHelpLanguages code {0} is not valid. Valid codes can be found in the Language section of file {1}
	The parameter file contains an invalid ClientHelpLanguages code. Refer to the AxSetupLists.txt file on the DVD for valid codes.

	The Language section is missing from file {0}.
	The Language section is missing from the AxSetupLists.txt file. The file is part of a standard Microsoft Dynamics AX installation, and should be available on the DVD. Copy the file to the share you are installing from.

	The Region section is missing from file {0}.
	The Region section is missing from the AxSetupLists.txt file. The file is part of a standard Microsoft Dynamics AX installation, and should be available on the DVD. Copy the file to the share you are installing from.

	The name of the SQL Server instance cannot include blanks or spaces.
	The name of the Microsoft SQL Server instance cannot include blanks or spaces. Review the name of the SQL Server you are connecting to, and try again.

	You do not have permission to create a new database. For more information, contact the database administrator.
	To create a database, you must be a member of the DBCreators role on the database server. 

	You do not have permission to configure the database server {0} to allow the Application Object Server (AOS) to connect to it. For more information, contact the database administrator.
	To allow another user to connect to a database, you must be a member of the Security Administrators role on the database. 

	The database name cannot include blanks, spaces, or any of the following characters: \ / . , : [ ] ( ) - ;
	The name of the SQL Server instance cannot include blanks, spaces, or any of the following characters: \  / . , : [ ] ( ) - ;. Review the name of the SQL Server you are connecting to, and try again.

	The DbConnectionTimeout value must be from 10 through 999.
	The SQL Server database connection time out value is invalid. Contact the database administrator for help.

	The path {0} contains invalid characters.
	The path contains invalid characters. Review what you have entered, and try again.

	You must enter a complete path for the application file installation directory. Valid formats for the path include: c:\\pathname \\\\MyServer\\SharedPath
	The path you entered for the application file installation directory was incomplete. Valid formats for the path include: 

· C:\\pathname
· \\\\MyServer\\SharedPath

	The application files installation path is not valid. The root location of the path ({0}) must exist before you install the application files.
	The root location of the path for the application file installation directory must exist before you install.

	The application files installation folder does not exist. The path must reference a location where application files have been installed.
	You are attempting to connect to an application files folder that does not exist. The path must refer to a location where application files have been installed.

	Setup detected existing files in the application files installation folder. The folder must be empty for Setup to proceed. To ensure that the folder is completely empty, in Windows Explorer, on the Tools menu, click Options. Select the View tab, and in the list of advanced settings, select the Show hidden files and folders option and clear the Hide protected operating system files check box. Then open the installation folder.
	The application files directory you are installing to contains files. To install using a parameter file, the directory must be empty. Copy the application files to another location if you want to save them. 

	Setup detected existing files in the installation folder for the application files. The folder must be empty for Setup to proceed. Deleting the existing application files will remove all application customizations. To save your customizations, move the application files to a different folder. Do you want to delete the files currently in the folder?
	The application files directory you are installing to contains files. If you continue to install, they are deleted. Application files contain all customizations. 

	The name of an application instance cannot include any of the following characters: \ / . , : [ ] ( ) -
	The application instance name contains one of the following invalid characters \ / . , : [ ] ( ) -. Review what you have entered, and try again.

	You must provide a value for {0}.
	You cannot proceed with Setup without providing a value for this parameter.

	A database named {0} already exists on the server {1}. Enter another name.
	You have attempted to create a database that has the same name as an existing database. Enter a new database name, delete the existing database and begin again, or in the Setup wizard select the option to connect to an existing database.

	Setup cannot find the database {0} on the server {1}. Check that the name is correct.
	Setup cannot locate the database you entered. Validate the name, and try again.

	The Application Object Server cannot be installed on this operating system. Install it on a server running Windows Server 2003.
	You cannot install the role you selected on a computer running this operating system. For details, see Hardware and software requirements.

	Setup has detected that this computer is running Windows Server 2003 without Service Pack 1. We strongly recommend that you install Service Pack 1.
	Service Pack 1 for Windows Server 2003 provides security enhancements. We strongly recommend that you install it. Installing on Windows Server 2003 without Service Pack 1 is not a supported configuration. 

	The Application Object Server (AOS) port number must be four digits long.
	The TCP/IP value you provided is not valid.

	An Application Object Server (AOS) instance name cannot have more than {0} characters and may not contain spaces or the characters / or \.
	The name you entered contains invalid characters. Review what you have entered, and try again.

	Setup detected an existing Application Object Server (AOS) instance named {0}. Instance names must be unique. Enter another name.
	Setup detected an existing Application Object Server (AOS) instance named {0}. Instance names must be unique. Enter another name.

	Setup cannot install another Application Object Server (AOS) instance on this computer. No more than {0} AOS instances can be installed on a single computer.
	Setup cannot install another Application Object Server (AOS) instance on this computer. No more than {0} AOS instances can be installed on a single computer.

	You must enter a fully qualified path for the {0} installation directory. Valid formats for the path include: c:\\pathname.
	You must enter a fully qualified path for the {0} installation directory. Valid formats for the path include: C:\\pathname.

Note   You cannot install to the root directory—you must install to a named folder.

	The Application Object Server (AOS) installation path is not valid. The root location of the path ({0}) must exist before you install the AOS.
	The root location of the path for the AOS installation directory must exist before you install.

	Warning: Setup could not connect the Application Object Server (AOS) instance to the database because it could not add the AOS account {0} to the database server as a login account. Installation of the AOS instance was completed, but the AOS instance cannot run without a connection to the database. You might not have permission to modify security on the database server. A database administrator can grant permission manually, and then AOS setup will be complete. For more information, see the installation log file for the error message returned by the database.
	Setup could not connect the Application Object Server (AOS) instance to the database because it could not add this computer’s AOS account (a domain account, or the Network Service account of the computer running the AOS instance) to the database server as a login account. Installation of the AOS instance was completed, but the AOS instance cannot run without a connection to the database. You might not have permission to modify security on your selected database server. A database administrator can grant permission manually, and then AOS setup is complete. For more information, see the installation log file for the error message returned by the database.

	Setup has detected that this computer is not running the recommended service pack for this operating system. We strongly recommended that you run this computer on Windows 2000 Server with Service Pack 4 or Windows XP with Service Pack 1.
	Service Packs provide security enhancements. We strongly recommend that you keep your computers fully up-to-date with the Service Packs for the operating system you are running. Installing on a system without the appropriate service pack is not a supported configuration.

	The client installation path is not valid. The root location of the path ({0}) must exist before you install the client.
	The root location of the path for the client installation directory must exist before you install.

	The name of the Application Object Server (AOS) instance to connect to {0} cannot include blanks, spaces, or any of the following characters: ` ~ ! # $ ^ & * ( )
	The name of the Application Object Server (AOS) instance to connect to {0} cannot include blanks, spaces, or any of the following characters: ` ~ ! # $ ^ & * ( ) 

	To install a client, .NET or COM Business Connector, or any application that uses Business Connector, you must provide the name of an Application Object Server instance (AOS) to connect to.
	To install a client, .NET or COM Business Connector, or any application that uses Business Connector, you must provide the name of an Application Object Server instance (AOS) to connect to.

	Setup cannot find the client configuration file {0}.
	Setup cannot find the client configuration file specified in the setup parameters you passed. Check to be sure that the file is in the location specified.

	SQL Server Reporting Services must be installed before a Microsoft Dynamics AX reporting server can be set up.
	Microsoft SQL Server 2005 Reporting Services was not detected on this computer.

	Setup cannot find the SQL Server Reporting Services instance. Check that the name is correct.
	Setup cannot find the SQL Server Reporting Services instance. Check that the name is correct.

	You must configure the Report Server virtual directory and Report Manager virtual directory for SQL Server Reporting Services instance {0} before you install a Microsoft Dynamics AX reporting server. Use the SQL Server Reporting Services Configuration Tool.
	You must configure the Report Server virtual directory and Report Manager virtual directory for SQL Server Reporting Services instance {0} before you install a Microsoft Dynamics AX reporting server. Use the SQL Server Reporting Services Configuration Tool. For more information, see Install and configure a reporting server for ad hoc reporting.

	Setup could not connect to the database server {0}.
	The database server may be unavailable. Check with the database administrator.

	The database to be referenced by the reporting server {0}, does not exist on the server {1}.
	The database that the reporting server is attempting to connect to cannot be found. Check that you have entered the path correctly.

	The database server {0} does not contain any databases.
	The database that the reporting server is attempting to connect to cannot be found. Check that you have entered the path correctly.

	Setup could not add the account {0} to the database server {1}as a login. The reporting server was installed on this computer without permission to access this database. It cannot run without a connection to the database. You might not have permission to modify security on the database server. A database administrator can grant permission manually, and then the reporting server setup will be complete. For more information, see the installation log file for the error message returned by the database.
	Setup could not add the account {0} to the database server {1} as a login. The reporting server was installed on this computer without permission to access this database. It cannot run without a connection to the database. You might not have permission to modify security on the database server. A database administrator can grant permission manually, and then the reporting server setup is complete. For more information, see the installation log file for the error message returned by the database.

	An error occurred during registration of the data source in SQL Server Reporting Services. See the log for details.
	An error occurred during registration of the data source in SQL Server Reporting Services. See the log for details.

	Setup could not find an installation of Windows SharePoint Services to support Enterprise Portal. Either it is not installed, or the version is outside the expected range of 6.0.2 to 7.0.0. If you continue, Enterprise Portal will not function until you have set up Windows SharePoint Services.
	Setup could not find an installation of Windows SharePoint Services to support Enterprise Portal. Either it is not installed, or the version is outside the expected range of 6.0.2 to 7.0.0. If you continue, Enterprise Portal will not function until you have set up Windows SharePoint Services.

	Enter the {0} domain account {1} in the format domain\account.
	The domain account you entered was not recognized.

	The {0} account {1} cannot be your own account. Contact your system administrator to create a dedicated account.
	You cannot use your own domain account to connect to databases. Contact a system administrator for a domain account to use.

	You cannot set the account for {0} to a local computer account {1} when the Microsoft Dynamics AX database is not located on the same computer. Use a domain account instead.
	If the Microsoft Dynamics AX database is not located on the same computer as the AOS, you cannot use a local computer account to connect to it. 

	The {0} account {1} was not found on the local computer, or the password is incorrect.
	The domain account you entered was not recognized by the local computer, or the password is incorrect.

	The {0} account {1} was not found, or the password is incorrect.
	The domain account you entered was not recognized, or the password is incorrect.

	The application integration server installation path is not valid. The root location of the path ({0}) must exist before you install the application integration server.
	The root location of the path for the application integration server directory must exist before you install.

	Setup could not create the local Windows security group {0} on this computer. This group must exist, contain the current user {1}, and have rights to update the folder {2} before the application integration server can run. See the log for related messages.
	Setup could not create the local Windows security group {0} on this computer. This group must exist, contain the current user {1}, and have rights to update the folder {2} before the application integration server can run. Setup completes without setting up this account.

	The application integration framework (AIF) Windows security group {0} already exists. No changes will be made to it.
	During installation Setup found that the application integration framework (AIF) Windows security group {0} already exists. No changes are made to it.

	The application integration framework (AIF) Windows security group {0}, user {1} already exists. No changes will be made.
	During installation Setup found that the application integration framework (AIF) Windows security group {0}, user {1} already exists. No changes are made.

	Setup could not create the shared folder /security {0} which the application integration framework (AIF) tools must use when copying files from a client to the AIF VRoot folder. You can set this up manually. The folder on the client is {1}, and the user or group being given access is {2}. See the log for related messages.
	Setup could not create the shared folder /security {0} which the application integration framework (AIF) tools must use when copying files from a client to the AIF VRoot folder. You can set this up manually. The folder on the client is {1}, and the user or group being given access is {2}. See the log for related messages.

	The shared folder already exists. No changes will be made to it.
	The shared folder already exists. No changes are made to it.

	Setup could not create the shared folder {0} (code {1}).
	Setup could not create the shared folder. 

	The shared folder was not deleted because it does not exist.
	The shared folder was not deleted because it does not exist.

	Setup could not delete the shared folder {0} (code {1}).
	Setup could not delete the shared folder.

	Provide the name of a SQL Server. To specify an instance, use the format MyServer\MyInstance. To specify the SQL Server instance on this computer, enter (local).
	Provide the name of a SQL Server. To specify an instance, use the format MyServer\MyInstance. To specify the SQL Server instance on this computer, enter (local).

	Setup could not connect to the database server {0}.
	Setup could not connect to the database server specified.

	If you install files in a location other than the default, work with your system administrator to ensure that access to the folders is appropriately restricted.
	If you install files in a location other than the default, work with your system administrator to ensure that access to the folders is appropriately restricted.

	A required file is missing from the source location {0}.
	Setup could not find a required file. It is part of a standard Microsoft Dynamics AX installation, and should be available on the DVD. Copy the file to the share you are installing from.

	A required folder is missing from the source location {0}.
	Setup could not find a required file. It is part of a standard Microsoft Dynamics AX installation, and should be available on the DVD. Copy the file to the share you are installing from.

	A required folder for region {0} is missing. It should be under {1} and have a name that starts with the letter {2}. See the file AxSetupLists.txt for a list of regional files that should be included in the installer files.
	A required folder for the region is missing. See the file AxSetupLists.txt for a list of regional files that should be included in the installer files.

	The default Application Object Server (AOS) instance has previously been installed as name {0}
	The default Application Object Server (AOS) instance has previously been installed with a different name.

	An Application Object Server (AOS) instance {0} has previously been installed as name {1}. Enter another name.
	AOS instances cannot be installed on the same computer with the same name. 


Setup cannot connect to an instance of Microsoft SQL Server

When Setup cannot connect to an instance of SQL Server, one of the following may be the cause. 

Database version incorrect

Check that the SQL Server instance is running on a supported version of SQL Server. For more information, see Hardware and software requirements. 

Integrated authentication not available

Check that the SQL Server instance is running on a supported version of SQL Server with integrated security.

Remote connections not enabled

Check that the SQL Server instance is configured as follows: 

· Enable remote connections. 

· In the SQL Server Management Studio (Start > All Programs > Microsoft SQL Server 2005 > SQL Server Management Studio), log in, and then right-click the instance you want to connect to.

· Click Properties, click Connections, and then select Allow remote connections to this server.

· Enable named pipes. Follow the steps below for Microsoft SQL Server 2005. For Microsoft SQL Server 2000, refer to your documentation. 

· Open the SQL Server Configuration Manager (Start > All Programs > Microsoft SQL Server 2005 > Configuration Tools > SQL Server Configuration Manager).

· Expand SQL Server 2005 Network Configuration, select Protocols for MSSQLSERVER, right-click Named Pipes.

· Click Enable. 

After making these changes, you must restart SQL Server.
Port 1433 not open

If the SQL Server computer has a firewall running on it, be sure that port 1433 is open. See the SQL Server Technology Center on TechNet for information on how to set up SQL Server to work across a firewall.

SQL Server Database not running under Local System account

The Application Object Server (AOS) instance cannot connect to a SQL Server database that is not running under the Local System account. As a symptom of this error, in the log file you may see that the connection could not be established, and a "Cannot generate SSPI context" error. Change the account your SQL Server database is running under, and try the AOS installation again.

I created a database manually—why am I unable to connect the AOS to it?

You must use the Setup program to create a SQL Server database, because Setup sets the appropriate rights for the AOS account on the database server and writes the stored procedures used for session management to the database. 

Object Server Setup could not create a database

If your account does not have permission to create a SQL Server login for the AOS account in the database, then setup of the AOS completes, but displays an error. Work with your database administrator to have the AOS account added to the database as a member of the db_reader, db_writer and db_ddladmin roles. When the account is added, you should be able to start the AOS service.

Client cannot connect to an instance of Application Object Server

When a client cannot connect to an Application Object Server (AOS) instance, one of the following may be the cause: 

AOS is starting

The AOS Windows service can take several minutes to start after installing for the first time. To determine whether the AOS service has completed its startup, either open the event viewer (Administrative tools > Event viewer) or the Services program (Administrative tools > Services), and review the status of the Dynamics service.

Port is not open

If the Application Object Server instance is installed on a computer with a firewall, be sure that the port you are trying to connect to is open. The default port 2712, but additional instances may install incrementally onto ports 2713, 2714, and so on. 

MDAC components are not the same version

If different versions of the Microsoft Data Access Components (MDAC) are installed on the client, Application Object Server (AOS) and database, you may experience client connection failure or sporadic disconnecting of the client, AOS, or database. 

User not recognized error when trying to start client after installing

The client returns a User not recognized error if you are not a user in the system. After installation, the first person to start a client on a computer is set to be the administrator user. You can determine whether someone has been set as the Microsoft Dynamics AX administrator by querying the values in the userinfo table in the database. You can have the administrator user add you as a user to the system, and then add you to the Administrators group. For more information, see Create new users and Manage user groups.

Additional AOS does not install to a different location

You cannot install any additional AOS instances to a different location than the first AOS installed on a computer. The AOS instances must share some common files, and must always install in the same location. If you install an additional AOS silently and provide a value for the AosInstallPath, the value is ignored.

Installing to Program Files directory on 64-bit operating system fails

When installing on a 64-bit operating system, you cannot override the default Program Files location (%SystemDrive%\Program Files (x86)), because the Microsoft installer (MSI) files called during installation automatically reset the path for 64-bit operating systems to %SystemDrive%\Program Files (x86). 

Enterprise Portal site does not render content

If the trust level for your SharePoint installation is not set to Medium, the Microsoft Dynamics AX Web Parts do not render content correctly. To change the setting:

1955. Navigate to the root of your SharePoint installation. The default is C:\Inetpub\wwwroot.
1956. Open the web.config file, set the value for trust level to WSS_Medium, and save the file.

After installation Microsoft .NET Framework 2.0 is only available in English

The Microsoft Dynamics AX Setup Wizard installs the US English version of the Microsoft .NET Framework version 2.0. If you need an alternate language of the .NET Framework version 2.0, you can either download and install it before installing Microsoft Dynamics AX, or you can reinstall the .NET Framework in the language of your choice after installing Microsoft Dynamics AX.

Cannot install to a directory that contains Chinese characters in the name

On every computer in a Microsoft Dynamics AX implementation that is running in Chinese, you must ensure that the following options have been set before installing. Otherwise Setup cannot install Microsoft Dynamics AX to directories that contain Chinese characters. 

1957. Open the Regional and Language Options control panel (Start > Control Panel > Regional and Language Options).
1958. On the Regional Options tab, select the language that you are installing in. If you do not see the language you need to use in the list, you must install supplemental language support files. 

· On the Languages tab, under Supplemental language support, select Install files for East Asian languages. If you need to perform this step, you must restart the computer. 

1959. On the Advanced tab, under Select a language to match the language version of the non-Unicode programs you want to use, select the same language you chose in step 2. 

1960. Click OK.

Cannot install to the root directory

The Microsoft Dynamics AX Setup Wizard cannot install files at the directory root, for example, c:\. You must install to a folder. 

Permissions to application file location removed by installation of second AOS instance

Windows removes inherited permissions for all accounts (including members of the Administrators and Power Users groups) when new permissions are explicitly granted on folders that are the root of a share (\\MyApplicationServer\MyShare).  However, inherited permissions are not removed for subfolders under a share (\\MyApplicationServer\MyShare\MySubfolder). Inherited permissions are also not removed for local folders such as C:\MyFolder.

When you install an AOS instance, if you specify that the application files are at the root of a share, such as \\MyApplicationServer\MyShare, Windows removes any permissions that the folder inherited from folders above it.

If the application files must be on a different computer than the computer running the AOS instance, install the application files at least one level down from the share root, for example, \\MyApplicationServer\MyShare\MyApplication Files.

This problem is most likely to occur during distributed installations, and when installing a second AOS instance. 

Possible symptoms of this problem include: 

· The first AOS instance returns an access denied error when trying to connect to the application folder.

· Opening any AIF configuration form returns the error “Directory Include was not found in the Application folder.”

If the inherited permissions have been removed from the application file location, one way of recovering is: 

1961. Log in as the local administrator of the computer hosting the share.
1962. Create a folder that is a sibling of the folder that no longer has inherited permissions. The inherited permissions will be set properly on the new folder.

1963. Recreate the explicitly assigned permissions on the original folder in the new folder.

1964. Copy all files from the original folder to the new folder.

1965. Rename the original folder, for example, foldername_old.

1966. Rename the new folder to the name of the original folder.

1967. Share the folder again (not at the root of the share).

Cannot connect to a database

If, during installation of an AOS, you were not able to connect to a database, the AOS account may not have appropriate rights in the SQL Server instance. The AOS account must be a user in the database, and be assigned to the following database roles db_ddladmin, db_datareader, and db_datawriter.

After installation, cannot find the Help files for the required language

You may not have installed the Help files for the language you required. To install additional Help files, run the Microsoft Dynamics AX Setup program again, selecting the Client installation path, and then select any additional languages you require.

Troubleshoot upgrade issues

This topic provides information about troubleshooting issues encountered in upgrading a Microsoft Dynamics AX system.

Virus scanner stops the Dynamics AX DB Upgrade Preparation Tool

The Dynamics AX DB Upgrade Preparation Tool creates interim files that may falsely be identified by your virus scanner, causing the Dynamics AX DB Upgrade Preparation Tool to fail.

If this problem occurs, disable your virus scanner, and restart the Dynamics AX DB Upgrade Preparation Tool.

Compile stalls during upgrade due to XRef error

If the compiler stalls during upgrade and produces an XRef error ("The database reported... INSERT INTO XREF..."), do the following:

1968. In Axapta 3.0, open Tools > Options > Compiler > Setup, and deselect the "Cross-reference" check box.
1969. Run the Dynamics AX DB Upgrade Preparation Tool.

1970. Continue the upgrade process, as described in Upgrading to Microsoft Dynamics AX.

Client crashes at client startup in code upgrade

If you have completed all of the steps in Prepare a Microsoft Dynamics AX system for code upgrade and the client crashes, check for the following:

Class modifications that affect startup

Check whether you have modified any low-level code that is run during startup or code that is started from the class Info startup or Application startup.

If you have modified classes that prevent Microsoft Dynamics AX from starting up correctly, delete your modifications.

Database structure modifications

Check whether there are any name changes that conflict with the new database structure. It is possible that there are field name modifications that conflict with additions made by mcCoName. Field names must have unique IDs. Open the event viewer (Administrative tools > Event viewer) and check the event log, which identifies any fields that are duplicated.

Insufficient rights error during compile

If you get Insufficient rights errors when you compile Microsoft Dynamics AX during upgrade, check whether you have modified classes in either the VAR layer or BUS layer, and their patch layers, that require you to load a license. If you have modified classes that start up early and require a license, start the Application Object Server (AOS) and load the correct license before you copy the updated applications files to the Standard folder. The upgrade sequence would then be as follows:

1971. Install Microsoft Dynamics AX (includes application, client, AOS, and new empty database).
1972. Run the DB Preparation Tool from the installation DVD.

1973. Start the AOS.

1974. Start the Microsoft Dynamics AX client.

1975. Load your license keys:

(Click Administration > Setup > System > License information).

1976. Close the Microsoft Dynamics AX client.

1977. Stop the AOS.

1978. Copy the application files (*.aod) from all layers above the DIS layer to:

\Microsoft Dynamics\4.0\Application\Appl\Standard

1979. Copy application files (*.aod) from all layers above the DIS layer to:

\Microsoft Dynamics\4.0\Application\Appl\Standard\Old

1980. Delete the index file (axapd.aoi) from the Standard folder.

1981. Start the AOS.

1982. Start the Microsoft Dynamics AX client.

1983. Run through the Upgrade checklist.

Troubleshooting problems with clients

When a client cannot connect to an instance of the Application Object Server (AOS), one of the following may be the cause.

AOS is starting

The first time you start a client after the AOS has been installed, the AOS service may be still be starting up. On the AOS computer, use the Services manager to determine whether the service has started.

Port is not open

If the AOS is installed on a computer with a firewall, be sure that the port you are trying to connect to is open. The default port 2712, but additional instances may install on ports 2713, 2714, and so on.

MDAC components are not the same version

If different versions of the Microsoft Data Access Components (MDAC) are installed on the client, AOS and database, you may experience client connection failure or sporadic disconnecting of the client, AOS, or database.

Help files do not display correctly

If the topics in the Help files do not display when you are using a configuration file to point to an alternate Help location, you may need to modify security settings that prevent Help from loading over a network. For details, see the Knowledge Base article located at http://support.microsoft.com/kb/896358.

Troubleshoot access management

This topic describes how to troubleshoot common issues with user management. User management includes adding users to Microsoft Dynamics AX, adding groups, and granting access to user groups.

Users

· How do I add users to Microsoft Dynamics AX?

See Create new users.

· Why do I get Error: Invalid network account when trying to add a user to Microsoft Dynamics AX? 

Microsoft Dynamics AX searched Microsoft Active Directory directory services on your local domain controller and could not find the user you are trying to add.

To add an additional layer of security to your computing environment, Microsoft Dynamics AX requires that all users be listed in Active Directory on your domain controller before they can be enabled on the Microsoft Dynamics AX User form. If a user is not enabled on this form, they cannot access Microsoft Dynamics AX. For more information, see Active Directory user topology.

· How do I set user passwords?

You do not need to set user passwords in Microsoft Dynamics AX. When a user opens the client, Microsoft Dynamics AX validates the user name against the user name and password in Active Directory. If the alias and password are found in Active Directory, the user is authenticated and the client opens. If authentication fails, the client does not open.

User groups

· How do I add a group to Microsoft Dynamics AX?

See Manage user groups.

· Can users be members of more than one group?

Yes, but remember that the user inherits the highest permissions level between the two groups.

Access and permissions

· I added several people to the User form, but those users are still unable to access Microsoft Dynamics AX. How can I remedy this?

Before a user can access Microsoft Dynamics AX:

br. The user must be added to the User form and the Enabled checkbox must be selected (see Create new users).
bs. The user must be a member of at least one Microsoft Dynamics AX group (see Manage user groups).

bt. The designated group must be granted access to menu items and tables in the User group permissions form (see Manage permissions).

· Users are not able to access Microsoft Dynamics AX through Enterprise Portal. How can I remedy this?

Granting users access to Microsoft Dynamics AX through Enterprise Portal requires several additional steps beyond setting up users and groups. For more information about setting up users for Enterprise Portal, see Managing Enterprise Portal users.

· Why do I get the following error: User <username> is not authorized to insert a record in table SqlDictionary. Request Denied?

The user does not have the appropriate permissions. If you grant a user group developer permissions, the group must have developer permissions across all domains. If the group does not have developer permissions across all domains, members of the group cannot synchronize the Application Object Tree (AOT). To remedy this problem, give the user developer permissions in all domains on the Users > User permissions form.

· Why do I get the following error: User does not exist?

The user has not been added to the list of users on the Users. If the user does exist in the list, verify that the Enabled checkbox is selected for that user.

· Developers cannot synchronize the AOT. Why?

If you grant developer permissions to a user group, the group must have developer permissions across all domains. If the group does not have developer permissions across all domains, members of the group cannot synchronize the Application Object Tree (AOT). See Manage permissions to learn how to grant developer group permissions across all domains.

Tune database settings

You may want to tune the database settings for Microsoft Dynamics AX to improve performance. Before changing settings, trace the usage of your Microsoft Dynamics AX database to ensure that you have clear understanding of performance under the current settings. To trace Microsoft Dynamics AX database performance, use:

· Tracing from the Microsoft Dynamics AX Server Configuration Utility. For more information, see Set tracing options.

· Windows Performance Monitor, using Microsoft Dynamics AX Object counters. For more information, see Set up Performance Monitor counters.

· The Microsoft Dynamics AX System Monitoring dialog box Tools > Development tools > System monitoring).

Test all tuning changes before implementing them in a production environment. In a test or development environment, make a single change and then test your system's performance before making another change.

Change the concurrency mode

Concurrency settings enable you to reduce locking conflicts on your system. For more information, see the following topics: 

· Concurrency model configuration (Form)
· Performance optimizations: Database design and operations
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· Exception handling
· Select statement syntax
· Table properties
Tune connections

The following table lists common connection issues, and some adjustments to try in the Server Configuration Utility.

	Symptom
	Adjustments to try

	Results for common queries are returned slowly.
	Increase the Maximum buffer size value.

	Results for ad hoc queries are returned slowly.
	Check to see that the appropriate indexes are in place. For the most recent guidance about indexing, check Microsoft Dynamics AX Online.

	Transactions are failing frequently.
	Decrease the Transaction retry interval value.

	Data grids for commonly used tables draw slowly.
	Increase the Array fetch ahead value.


Tune queries

If queries in the system are running slowly, you may want to change settings for literals, string functions, or hints. Microsoft Dynamics AX no longer uses literals by default in form and report queries, or in complex-join queries.

Adjust the use of literals

Microsoft Dynamics AX may pass either parameters (placeholders) or literals (actual values) in queries.

· Parameters allow Microsoft Dynamics AX and the database server to reuse the query when search values change. They are preferred for high-frequency queries.

· Literals allow the database server to optimize the query for a specific piece of information. This provides an optimal query for that piece of information, but the database server must perform the optimization for every query executed. Literals may be used for long running queries such as complex joins. 

A developer can override the default use of literals by specifying parameters in their code, or an administrator can override the use of literals in the Server Configuration Utility.

	Symptom
	Adjustments to try
	Anticipated effect

	Long-running queries run slowly.
	Review the query plan statements sent to SQL Server and consider taking corrective action.  Using literals may be one solution. 

Select Use literals in join queries from forms and reports.

Select Use literals in complex joins from X++.
	Long-running queries pass literals to the database. Processing time for long-running queries should go down. 


Adjust the use of autogenerated string functions

Microsoft Dynamics AX embeds some string functions in SELECT statements automatically. String functions are included to support: 

· Treating uppercase and lowercase versions of the same text as the same text (single case) for Oracle installations.

· Left justification or right justification.

When a string function is included in a query, the optimizer may have to choose a less-than-optimal access plan, such as a table scan, for retrieving data. If customers do not require the use of mixed case outside Microsoft Dynamics AX and do not use left justification or right justification, these functions are not required and should be turned off. To improve performance, we recommend that all values be stored left-aligned by default. 

If queries take longer to run than anticipated or appear to be using table scans rather than indexes, try the following adjustments: 

· Clear Include LTRIM in all SELECT statements to remove leading space from right-aligned columns.

· Clear Include SUBSTR and LOWER in all SELECT statements to support Oracle mixed-case systems.
If the adjustment is successful, queries use query plans and return results more quickly.

Adjust the use of hints

In Microsoft Dynamics AX, you can allow developers to override the index selected by the query optimizer. In most situations, allowing the query optimizer to select an index for a query results in improved performance.

If queries include INDEX hints and are running more slowly than expected, clear the Allow INDEX hints in queries option.

Changes in the use of hints

If you have upgraded to Microsoft Dynamics AX, the queries in your system may contain outdated Microsoft SQL Server hints. Configuration commands are no longer available to globally enable or disable many of the hints from previous versions. If hints are explicitly specified in an X++ statement, they are added to the SQL Server query that is generated. Otherwise, they are not added. 

The following changes have also been made: 

· The OPTION (FAST), LOOP, and FORCE ORDER hints are not applied by default, but are applied if explicitly specified in X++.

· A FIRSTONLY hint in X++ is translated into the addition of a TOP 1 statement to the SQL Server query.

· FASTFORWARD cursors are used for all user queries unless a cursor has been marked as FOR UPDATE.

· FOR UPDATE, NOLOCK, and READPAST, hints are added to statements depending on the type of the cursor that an X++ query has produced. No interface is available to modify these hints.

Troubleshoot problems operating the Application Object Server

This topic provides information about how to troubleshoot issues encountered when running or connecting to an Application Object Server (AOS) instance. 

To help Microsoft solve problems with AOS instances, if you are experiencing fatal errors in an instance of the AOS, in the Microsoft Dynamics AX Server Configuration Utility (Start > All Programs > Administrative Tools > Microsoft Dynamics AX Server Configuration Utility) you can select the Automatically send information about fatal errors in any Application Object Server service instance to Microsoft option to send information about any fatal error in an AOS instance to Microsoft. 

If you enable error reporting, information is sent over a secure (https) connection to Microsoft, where it is stored with limited access. Microsoft uses the reports only to improve Microsoft Dynamics AX, and treats all information as confidential. 

Client cannot connect to an AOS instance

When a client cannot connect to an instance of the Application Object Server (AOS), one of the following may be the cause.

AOS is starting

The first time you start a client after the AOS has been installed, the AOS service may still be starting up. On the AOS computer, use the Services manager to determine whether the service has started.

Port is not open

If the Application Object Server is installed on a computer with a firewall, be sure that the port you are trying to connect to is open. The default port is 2712, but additional instances may install on ports 2713, 2714, and so on. 

MDAC components are not the same version

If different versions of the Microsoft Data Access Components (MDAC) are installed on the client, Application Object Server (AOS), and database, you may experience client connection failure or sporadic disconnection of the client, AOS, or database. 

AOS instance cannot connect to new database

If you are trying to connect to a database that was not created by Setup, the AOS account (the domain account or Network Service account associated with an AOS instance) may not have appropriate rights in SQL Server. The AOS account must be a user in the database and be assigned to the following database roles db_ddladmin, db_datareader, and db_datawriter.

AOS instance does not start after changing databases

When an AOS instance and SQL Server database are installed on the same computer, Setup creates a dependency—the AOS instance does not start unless the SQL Server database is running. 

If you change the AOS instance to use a SQL Server on a different computer, you must manually change or delete the dependency using the SC tool (SC.exe) from a command prompt. For more information about SC commands, see the SC topic in the Microsoft Windows Server TechCenter.

To make the AOS dependent on the new SQL Server instance

Open a Command Prompt window and type: 

sc config AOSinstancename depend= RpcSs/sqlserverinstancename
To remove the AOS dependency on SQL Server being started

Open a Command Prompt window and type: 

sc config AOSinstancename depend= RpcSs

Troubleshoot Business Connector

This topic includes answers to frequently asked questions (FAQ) about Business Connector for Microsoft Dynamics AX.

How do I install Business Connector?

Install and uninstall Business Connector using the Setup.exe utility on the Microsoft Dynamics AX DVD. For more information, see Install Business Connector to support a custom application.

How do I register Business Connector?

Business Connector is automatically registered when it is installed.

My application cannot communicate with Business Connector. I get an authentication error. How do I remedy this?

Applications using the .NET or COM Business Connector now require integrated Windows authentication. Inform your developers of this new requirement and ask them to change the application to use integrated Windows authentication, which requires the Business Connector LogonAs function. For more information, see Introduction to the Microsoft Dynamics AX Business Connector in the Developer's Guide.

My application cannot communicate with Microsoft Dynamics AX. How do I remedy this?

If Business Connector is installed and you have modified your application to use integrated Windows authentication, communication problems between the application and Microsoft Dynamics AX are usually found in the application itself. You can enable debugging in Microsoft Dynamics AX to better understand what is happening in the X++ code when the application tries to communicate with Microsoft Dynamics AX. For more information, see Debugging a Business Connector Application Running Under a Non-Interactive Account in the Developer's Guide.

Troubleshooting Enterprise Portal

This topic describes how to troubleshoot problems with Enterprise Portal.

Common Issues

	Symptom
	Issue and Resolution

	You see error messages that include phrases like "assembly not found," "could not be created," or "threw an exception".
	You might not have ASP.NET 2.0 installed or registered:

1984. From a command prompt, execute the following command on your IIS server:
%SYSTEMROOT%\Microsoft.NET\Framework\v2.0.50727\aspnet_regiis.exe -i 

1985. Verify that ASP.NET v2.0.50727 is listed in IIS Manager on the ASP.NET tab:

bu. Click Start > Run, type inetmgr and press Enter.
bv. Right-click the Default Web site and click Properties.

bw. Click the ASP.NET tab.

bx. In the ASP.Net version drop-down list, verify that v2.0.50727 is selected. If it is not selected, do that now.

1986. Click OK.
1987. Redeploy Enterprise Portal and recreate your Website

	You see error messages that include phrases like "access denied" or "do not have permission".
	Permissions may not be set properly for the Business Connector proxy user or a user group. See Set up the Business Connector proxy user for Enterprise Portal and Managing Enterprise Portal users.

	Users can access EP Web pages, but they do not see content
	You might not have user groups, user access, or user relations configured properly. See Granting users access to Enterprise Portal for instructions on how to enable users to view content on Enterprise Portal.


Installation, deployment, site-creation problems

Error states "Cannot add the specified assembly to the global assembly cache" or the error states "w3wp.exe unhandled exception (System.UnauthorizedAccessException)"
Your Business Connector proxy account might not have the appropriate permissions on the server to allow access. At the very least, the Business Connector proxy must:

· Exist as a user in Active Directory 

· Be a member of the Power Users, IIS_WPG, STS_WPG, and the Performance Monitor Windows groups on the IIS server hosting Enterprise Portal.
For more information about creating a Business Connector proxy account, see Set up the Business Connector proxy user for Enterprise Portal.
Can not locate or install Enterprise Portal templates

You must use an Enterprise Portal template when you create your top-level Web site in Windows SharePoint services. If you do not see the Enterprise Portal public or private templates in the list, do the following:
1988. Use Windows Explorer to verify that the templates exist on the server. By default, the templates exist in the following folder: C:\Inetpub\wwwroot\wpcatalog. If you do not see this folder, Enterprise Portal was not installed properly. Uninstall and reinstall Enterprise Portal. 
1989. If you do see the templates on the server, redeploy the Web site. From a Microsoft Dynamics AX client on your EP server, click Administration > Setup > Internet > Enterprise Portal > Manage deployments.

1990. Clear the Enabled checkbox beside your virtual server. When prompted, click yes to remove the deployment.

1991. Select the Enabled checkbox beside your virtual server. A message box appears and states that the webparts were deployed successfully.

1992. In Windows SharePoint Administration, click the Create a top-level Website link and verify that you are now presented with Enterprise Portal templates in the templates list.
Error states, "The Web site http://server/sites/site_name was not created correctly. Exception: No .NET Business Connector session could be found."
If you receive this error, the Business Connector might not be configured correctly. To verify the configuration:
1993. On the IIS server hosting your Enterprise Portal site, click Start > Administrative Tools > Microsoft Dynamics AX Configuration Utility.
1994. In the Configuration target drop-down list, click Business Connector (non-interactive use only)
1995. Click the Connection tab.

1996. Verify the Server Name and the TCP/IP port. If the port is blank, it is assumed to be running on port 2712. You can verify the actual port on the AOS server by viewing Dynamics Information events in the Application Event log after the AOS has started.
1997. If necessary, update the configuration or create a new configuration (click Manage > Create configuration). For more information, see Manage a Business Connector non-interactive configuration.

Error states "http://server/sites/site_name was not created correctly. Exception: Thread was being aborted."

This error occurs because of a connection timeout after you select the Dynamics AX template while creating a new top-level Web site in Windows SharePoint Administration. To resolve this problem, you must do the following:

· Change the Connection Timeout and Http Keep-Alive properties on the IIS server.
· Change connection timeout properties in the web.config file.
To change the Connection Timeout and HTTP Keep-Alive properties on the IIS server:

1998. Open the Internet Information Services Manager (Start > Run, type inetmgr and press Enter).
1999. Expand the local computer, expand the Web sites directory, and right-click the web site hosting your Enterprise Portal site (typically the Default Web site) and click Properties.

2000. On the Web Site tab, specify a new value in the Connection timeout field. The default value is 120 seconds. If you think the server requires up to 4 minutes to create a new site using EP templates, then specify a value of 240 seconds (or longer, as appropriate).

2001. Select Enable HTTP Keep-Alives (if it is not selected).

2002. Click OK.

2003. Restart IIS (from a command prompt enter iisreset and press Enter).

To change connection timeout properties in the web.config file:

2004. In a basic text editor like Notepad, open the web.config file (%SYSTEMDRIVE%\Inetpub\wwwroot by default)
2005. Press CTRL + F to open the Find dialog box.

2006. Find the following tag:

<httpRuntime maxRequestLength="51200" />

2007. Replace it with this tag (changes in bold):

<httpRuntime executionTimeout="6000" maxRequestLength="51200" />

2008. Find the following tag (you might need to search from the beginning of the file):

</sectionGroup>
2009. Add the following tags on new lines after the </sectionGroup> tag:

<sectionGroup name="DynamicsAX">
<section name="Deployment" type="System.Configuration.SingleTagSectionHandler, System, Version=1.0.5000.0, Culture=neutral, PublicKeyToken=b77a5c561934e089" />
</sectionGroup>
2010. Find the following tag:

</SharePoint>
2011. Add the following tags on new lines after the </SharePoint> tag:

<DynamicsAX>

<Deployment SiteCreationTimeOut="1200" />

</DynamicsAX>

2012. Save your changes.

2013. Close the web.config file.

2014. At the command prompt, type IISReset and press Enter.
2015. Try to create the top-level Web site in SharePoint Portal Administration.

After installing Enterprise Portal, the Application Integration Framework doesn't work

For the Application Integration Framework (AIF) to coexist with Windows SharePoint Services (WSS) and Enterprise Portal on the same computer, the virtual directory that AIF is using must be excluded from the SharePoint managed path. 

To exclude the AIF virtual directory from the SharePoint managed path list: 

2016. Launch the SharePoint Central Administration page. (Start > All Programs > Administrative Tools > SharePoint Central Administration); or, from the browser on a remote computer, type the URL for the pages on the administration port. For example: http://servername:port
2017. Click Configure virtual server settings and click the name of the site you are managing. 

2018. Under Virtual Server Management, click Define managed paths.

2019. Under Add a New Path, enter the AIF virtual directory path, and then select Excluded path, and click OK.

Error states, "No .NET Business Connector session found"

The .NET Business Connector is not configured properly for the IIS and SharePoint Windows groups. See Set up the Business Connector proxy user for Enterprise Portal for the procedure to add the Business Connector to the appropriate groups.
Error states, "An X++ exception has occurred"

Microsoft Dynamics AX allows one Enterprise Portal site per company. Verify that the company you are logged into does not already have a registered EP site (Administration > Setup > Internet > Enterprise Portal > Web sites).
Web site access problems
Users have been assigned a user relation for Enterprise Portal, but they still cannot access the site
This problem occurs if the following conditions are true:
•
Microsoft Dynamics AX 4.0 compares the first part of the fully qualified domain name (FQDN) to the account name in the Microsoft Windows SharePoint Services database. 

•
The first part of the FQDN does not match the account name. 

A supported hotfix is available from Microsoft to fix this problem. The hotfix will be included in Microsoft Dynamics AX Service Pack 1.
To resolve this problem immediately, contact Microsoft Business Solutions Technical Support to obtain the hotfix. You can log on to the Microsoft Business Solutions Support site and create a new support request. To do this, visit the following Microsoft Web site: 

https://mbs.microsoft.com/support/newstart.aspx 

You can also contact Microsoft Business Solutions Technical Support by telephone at (888) 477-7877. 

Note In special cases, charges that are ordinarily incurred for support calls may be canceled if a Microsoft Business Solutions Support Professional determines that a specific update will resolve your problem. The usual support costs will apply to any additional support questions and issues that do not qualify for the specific update in question.
Checklist for troubleshooting OLAP reporting

The following checklist is designed to validate your computing environment for online analytical processing (OLAP) reporting and OLAP setup in Microsoft Dynamics AX. If you are reasonably certain the reporting problem does not reside in your computing environment or in OLAP setup, then investigate your OLAP cube definitions. Most OLAP problems are the result of improper data relations when cubes are built.

Validating the computing environment for OLAP reporting

If you cannot generate any OLAP reports, your computing environment might not be set up properly for OLAP reporting. For example, you might be using an unsupported database, or you might have overlooked a simple step, such as ensuring that Microsoft SQL Server Analysis Services is running. The following section will help you validate your computing environment for OLAP reporting.

· Verify that your Microsoft Dynamics AX computing environment is a three-tier environment that meets the appropriate hardware requirements

For a detailed description of the three-tier environment and all Microsoft Dynamics AX hardware requirements, see System topology recommendations and Hardware and software requirements in the Microsoft Dynamics AX Implementation Guide.

· Verify that you have installed the required software for the OLAP client and the system it is connecting to. 

The following components are required for clients that are connecting to systems running SQL Server 2000 Analysis Services. 

Note   The components must be installed in the order specified.

	Component
	Version
	State during installation

	Microsoft SQL Server 2000 PivotTable Services
	 
	Can be installed after Microsoft Dynamics AX installation. All components are available in the downloadable Feature Pack for Microsoft SQL Server 2005.

Note   If a client must be able to connect to both SQL Server 2000 and SQL Server 2005 Analysis Services data sources, this component must be the first installed.

	Microsoft Office Web Components 11 (OWC11) 
	2003
	Can be installed after Microsoft Dynamics AX installation. 

Available from this location as a download: http://go.microsoft.com/fwlink/?LinkId=47538


The following components are required for clients that are connecting to systems running SQL Server 2005 Analysis Services. 

Note   The components must be installed in the order specified.

	Component
	Version
	State during installation

	Microsoft Core XML Services (MSXML) 
	6.0
	Can be installed after Microsoft Dynamics AX installation. All components are available in the downloadable Feature Pack for Microsoft SQL Server 2005.

	Microsoft SQL Server 2005 Analysis Services OLE DB Provider
	9.0
	Can be installed after Microsoft Dynamics AX installation. All components are available in the downloadable Feature Pack for Microsoft SQL Server 2005.

	Microsoft SQL Server Native Client
	 
	Can be installed after Microsoft Dynamics AX installation. All components are available in the downloadable Feature Pack for Microsoft SQL Server 2005. 

Note   This component is not required if the client does not need to create or configure cubes.

	Microsoft SQL Server 2005 Analysis Management Objects (AMO) Collection
	 
	Can be installed after Microsoft Dynamics AX installation. All components are available in the downloadable Feature Pack for Microsoft SQL Server 2005.

Note   This component is not required if the client does not need to create or configure cubes.

	Microsoft Office Web Components 11 (OWC11) 
	2003
	Can be installed after Microsoft Dynamics AX installation. 

Available from this location as a download: http://go.microsoft.com/fwlink/?LinkId=47538


· Verify that you are using a supported database.

Microsoft Dynamics AX supports Microsoft SQL Server 2000, Service Pack 4, Microsoft SQL Server 2005, and Oracle 10g. To determine the version number, consult the database software product Help.

· Verify that Analysis Services is installed and running.

Microsoft Dynamics AX requires SQL Server Analysis Services for OLAP reporting, regardless of whether you are using a SQL Server or Oracle database.

To determine whether Analysis Services is installed, on the Microsoft Windows task bar, click Start > All Programs > Microsoft SQL Server > Analysis Services > Analysis Manager. If you can open the Analysis Manager, the service is installed. If you do not see the option for the Analysis Manager, see Set up OLAP reporting for the procedure to install SQL Server Analysis Services.

To determine whether SQL Server Analysis Services is running:

2020. Double-click the MSSQLServer icon in the Windows System Tray. The SQL Server Services manager opens.

2021. In the Services drop-down list, select MSSQLServerOLAPServices.

2022. If the Start/Continue button is unavailable, then the service is running. If the button is available, click it to start Analysis Services.

2023. Verify that anyone who needs to create cubes is a member of the OLAP Administrators group on the computer running Analysis Services.

To verify and add members to the OLAP Administrators Group:

2024. Right-click My Computer and select Manage.

2025. Expand Local Users and Groups.

2026. Double-click the OLAP Administrators group.

2027. If you or anyone who needs to create cubes is not listed as a member of the OLAP Administrators group, click Add to add a name to the group.

Validating OLAP setup in Microsoft Dynamics AX

The following section will help ensure that you have properly configured Microsoft Dynamics AX for OLAP reporting.

· Verify that you have a license code for the Business Analysis module.

From a Microsoft Dynamics AX client, click Administration > Setup > System > License information. Ensure that the status for Business Analysis shows OK.

· Verify that Business Analysis is enabled on the configuration form.

From a Microsoft Dynamics AX client, click Administration > Setup > System > Configuration. Ensure that Business Analysis is selected. Expand Business Analysis and verify that OLAP is selected.

· Verify that the user group has permissions for OLAP reporting.

For more information, see OLAP Security.

· Verify that you created an OLAP server and an OLAP database in Microsoft Dynamics AX.

For more information, see Set up OLAP reporting.

· Verify that OLAP parameters are set.

The OLAP forms in the Basicmodule (Basic > Setup > Business analysis) specify information to be used on a per-company basis, such as which OLAP server and database to use. Additionally, you can specify the date range to use when analyzing that company's data in pivot tables.

To verify OLAP parameters:

2028. From a Microsoft Dynamics AX client, click Basic > Setup > Business analysis.

2029. Select your default OLAP database.

2030. Enter the Year start and Year end values. By setting the year values on this form, you will save time later by not having to set these values for each cube you create.

2031. Press CTRL + S to save changes.

· Verify that you created a cube instance.

For more information about OLAP cube instances, see Create and process an OLAP cube for details.

Troubleshoot problems operating the Application Integration Framework

This topic describes how to troubleshoot common issues with document exchange using the Application Integration Framework (AIF).

Set up an endpoint to use inbound Web services

You may see the message "The requested operation cannot be performed because the required security key doesn’t exist" in the Web server event log. This occurs if the endpoint user does not have access to Business Connector.

When you configure an endpoint for inbound Web services, you must:

2032. Set up an Microsoft Dynamics AX user (or user group) as endpoint user or trusted intermediary for that endpoint.
2033. Give the user group access to the Business Connector.

Give the endpoint user access to Business connector

2034. Click Administration >. Setup > User groups and select the user group for the endpoint, or the user group that contains the user for the endpoint.
2035. Click Permissions.

2036. On the Permissions tab, in the table under the Viewing field:

by. Select Business Connector Proxy 
bz. Select Full control
ca. Click Cascade.

After installing Enterprise Portal, Application Integration Framework Web services do not work

For the Application Integration Framework (AIF) Web services to coexist with Windows SharePoint Services (WSS) and Enterprise Portal on the same computer, the virtual directory that AIF is using for Web services must be excluded from the SharePoint managed path. 

To exclude the AIF virtual directory from the SharePoint managed path list: 

2037. Launch the SharePoint Central Administration page (Start > All Programs > Administrative Tools > SharePoint Central Administration or, from the browser on a remote computer, type the URL for the pages on the administration port. For example: http://servername:port).
2038. Click Configure virtual server settings and click the name of the site you are managing. 

2039. Under Virtual Server Management, click Define managed paths.

2040. Under Add a New Path, enter the AIF virtual directory path, and then select Excluded path, and click OK.

Re-register ASP.NET when setting up inbound Web services

If you cannot see the ASP.NET tab when viewing Properties for the virtual root in the IIS Services Manager (see Configure IIS to work with Microsoft Dynamics AX Web services) or if you see a Page not found error after clicking Browse when validating Web services (see Create Web services for an action) you must re-register ASP.net in IIS using the following steps:

2041. Click Start > Run.
2042. Type cmd.

2043. In the Command Prompt window, type:

2044. cd your-system-directory\Microsoft.NET\Framework\v2.0.50727 and press ENTER.

2045. Type aspnet_regiis.exe -u and press ENTER.
2046. Type aspnet_regiis.exe –i -enable and press ENTER.

2047. Type iisreset and press ENTER.

2048. Close the Command Prompt window.

2049. After uninstalling and reinstalling ASP.NET and resetting IIS, the ASP.NET tab is available, and you can select ASP version 2.0. This allows you to browse the Web services after you create them on the Action form. See Create Web services for an action.
Issues when using Message Queuing (MSMQ) to exchange documents

· If the error message "The transaction context is invalid" appears for an inbound message, check that the queue that receives the message is located on the same computer as the Application Object Server (AOS) running the AIF batch jobs. For more information on these batch jobs, see Start and stop the asynchronous Application Integration Framework (AIF) services.

· If the error message "The specified format name does not support the requested operation. For example, a direct queue format name cannot be deleted" appears when a message is sent, check that the queue you are sending to is a public queue, and its address (on the Channels form) is given in short name format (for example: computer-name\queue-name).

· If it seems that outbound messages are sent (that is, they no longer appear in the list on the Overview tab in the Queue manager form, and no entries are created in the Exception Log for an error condition) but the messages are not received by the target queue, ensure that the target queue's access control list (ACL) is set properly: on the Security tab of the Properties window for the queue, Allow should be selected for Send Message, Get Permissions and Get Properties for the Anonymous Logon user. Also check that the target queue's Authenticated property is unchecked on the General tab in the Message Queuing folder (click Start > Settings > Control Panel > Administrative Tools > Computer Management).

· For inbound messages, if there is a message in the Exception Log that says "The user is not authorized to perform this action", check the Queue manager form (click Basic > Periodic > Application Integration Framework > Queue manager) for any inbound messages in an Error state. If the Submitting user field on the Details tab is blank, ensure that either the inbound queue's Authenticated property is checked or that all incoming messages are signed and authenticated.

Tracing

Tracing Microsoft Dynamics AX server performance can be useful in the following scenarios:

· Developing a performance baseline, for a system that provides information that you can use for managing changes to the system and planning capacity.

· Performing regular traces to help monitor performance. 

· Determining which factors might be affecting performance.

The table below describes the topics in this section.

	Topic
	Description

	Set tracing options
	Describes how and when to turn on tracing.

	Reading trace files
	Describes how to read trace files.


Silent installation

You can install any part of Microsoft Dynamics AX silently (without using the Setup wizard user interface) by passing parameters to the Setup program (Setup.exe).

This section contains the following topics:

· Install clients silently
· Setup parameters
Install clients silently

For a large deployment, you are likely to deploy clients silently. You must make the following decisions: 

· Whether to install with a shared configuration file

· Whether to install the configuration utility with all clients

· How to install the clients

All silent installations require the use of setup parameters. For more information, see Setup parameters.

Rights required for silent installation

In order to install silently, you must be a member of the Administrators group on each computer you are installing to.

Use a shared configuration file for clients

When you deploy Microsoft Dynamics AX, you are likely to want to point all clients to a single configuration file, stored in a shared directory. We recommend that you share a directory on the computer running the instance of Application Object Server (AOS) that clients connect to.

Note   If the shared directory is unavailable, clients are unable to start. 

Create a configuration file to share

2050. On a client that is connected to the appropriate Application Object Server, open the Microsoft Dynamics AX Configuration Utility (Start > All Programs > Administration > Microsoft Dynamics AX Configuration Utility). 
2051. Verify that all settings in the configuration are set to those you want to distribute broadly. 

2052. Click Manage, and then click Export Configuration to File. Name and save the configuration file.

2053. Copy the file to a shared directory that all client computers can connect to.

We recommend that you use a shared directory on the computer running the instance of Application Object Server that clients connect to.

Point to a shared configuration file during deployment

Deploy the Microsoft Dynamics client to user computers by using the Clientconfigfile setup parameter. The following provides an example of the parameter:

Setup.exe HideUI=1 AcceptLicenseTerms=1 LicenseTermsVersion=en-US InstallClientUI=1 ClientAosServer=Server1 ClientLanguage=en-US ClientConfigFile=”\\Server1\ConfigAll.axc”

Install clients without the configuration utility

By default, all clients are installed with the Microsoft Dynamics AX Configuration Utility, whether the installer is run interactively or silently. On any client computer running the Configuration Utility, configuration settings can be seen by all users, but only administrators or power users can change settings. For your installation, you may not want to install the configuration utility on all clients. 

Deploy the Microsoft Dynamics client to user computers without the configuration utility by using the ClientConfig and the ClientConfigFile setup parameters. The following provides an example of the parameters:

Setup.exe HideUI=1 AcceptLicenseTerms=1 LicenseTermsVersion=en-US InstallClientUI=1 ClientConfig=0 ClientAosServer=Server1 ClientLanguage=en-US ClientConfigFile=”\\Server1\ConfigAll.axc”

Note   If you set clients to be installed without the configuration utility, and you do not provide a configuration file, no shortcuts to the client are created.

Install clients silently

How you decide to install clients may be determined by the following considerations:

· Whether your users have the appropriate permissions to install Axapta themselves: users must be administrators or power users to install. 

· If you have a large company, and your users are administrators or power users on their computers, you may want to provide them with a shortcut to run that points them to a version of Setup with some properties preset, located on a shared folder. 

· Whether you have a management system, such as Microsoft Systems Management Server that you use to deploy software. If you do use management software, it may require that you use a Windows Installer command to install silently. To determine which MSI files and commands to use, review the log file found at Documents and Settings\All Users\Application Data\Microsoft\Dynamics AX\Dynamics AX Setup Logs\timestamp\DynamicsSetupLog.txt, to determine the values of the parameters passed during setup.

Construct a silent installation command

Before installing clients silently, you must construct a silent installation command for your environment. 

2054. Install a client on a representative computer using the user interface. 
2055. Review the log file found at Documents and Settings\All Users\Application Data\Microsoft\Dynamics AX\Dynamics AX Setup Logs\timestamp\ DynamicsSetupLog.txt, to determine the values of the parameters passed during setup. 

2056. Construct a silent installation command, changing any options you require by using setup parameters. See below for an example.

2057. Run the command on another representative computer to ensure that it is accurate.

Example of a silent client installation command 

Setup.exe LogDir=”C:\Documents and Settings\All Users\Application Data\Microsoft\Dynamics AX\Dynamics AX Setup Logs” RunMode=Custom HideUI=1 AcceptLicenseTerms=1 LicenseTermsVersion=en-US InstallClientUI=1 ClientInstallPath=”C:\Program Files\Microsoft Dynamics\4.0\Client” ClientAosServer=Company1 ClientLanguage=en-US ClientHelpLanguages=en-US;fr-ca ClientHelpRegions=CN
Install silently from a shared directory

To install silently, follow the steps below. 

2058. Copy the contents of the Microsoft Dynamics AX DVD to a readily accessible directory.
2059. Run a setup command from each computer on which you want to install a client.

Setup parameters

Microsoft Dynamics AX Setup is comprised of an executable file (Setup.exe) that calls multiple Microsoft Windows installer files (.msi). Setup can be run in interactive mode, in which it presents a user interface to gather values for required parameters, or in silent mode, in which parameters have been passed from the command line, or from a parameter file. In silent mode, the user is not asked any questions. The Setup.exe file is found on the Microsoft Dynamics AX DVD.

We recommend that you determine which parameters to pass to a computer by setting up Microsoft Dynamics AX on a single computer that is similar to the others you are setting up, then reviewing the Setup log file from %SystemDrive%\Documents and Settings\All Users\Application Data\Microsoft\Dynamics AX\Dynamics AX Setup Logs\Date Time\ DynamicsSetupLog.txt. The log lists the parameters that have been passed.

Pass parameters to Setup

You can pass parameters to Setup before it runs in either interactive or silent mode. 

2060. Open a command prompt.
2061. Enter the following command: 

Setup.exe parameter1 = "value" parameter2 = "value"

Example

The following example illustrates performing a single-computer installation using setup parameters. Any values not provided are assumed by the system to be the defaults.

Setup.exe LogDir=”C:\Documents and Settings\All Users\Application Data\Microsoft\Dynamics AX\Dynamics AX Setup Logs” RunMode=Custom HideUI=1 AcceptLicenseTerms=1 LicenseTermsVersion=en-US InstallDatabase=1 DbServerType=0 DbSqlServer=SQL1 DbSqlDatabaseName=Dynamics InstallApplication=1 ApplicationInstallPath=”C:\Program Files\Microsoft Dynamics\4.0\Application”  InstallAos=1 AosInstallPath=”C:\Program Files\Microsoft Dynamics\4.0\Server” AosInstanceName=AOS1 AosPort=2712 AosStart=1 InstallClientUI=1 ClientInstallPath=”C:\Program Files\Microsoft Dynamics\4.0\Client” ClientAosServer=AOS1 ClientLanguage=en-US InstallReportingServer=1 ReportingServerInstance=MSSQLSERVER  ReportingServerSqlDatabaseName=Dynamics ReportingServerAccount=Domain1\RSUser ReportingServerAccountPassword=**** ReportingServerReplaceDataSource=0

General parameters

This table lists the parameters that control general Setup behaviors such as setting a parameter file, showing or hiding the user interface, and identifying the location of all related files. Parameters that are required are denoted with an asterisk.

	Parameter
	Default value
	Description

	ParmFile
	No default value
	The path to a file containing other parameters. 

If this parameter is provided, it must be the only parameter, and the parameter file must contain all the parameters you want to pass. 

In the parameter file, each parameter's Name=Value combination must be on a separate line. 

Because a line return is used as a delimiter within a parameter file, values that otherwise require the use of double quotes do not. 

Note   Do not include double quotes in parameter files.

To comment out a line in a parameter file, place a pound sign (#) in front of the parameter. 

The path must be fully qualified.

	HideUI
	0
	Specifies whether the user interface should be displayed.

· 0 - Show the pages in the Setup wizard.

· 1 - Hide the user interface and run silently.

	AcceptLicenseTerms
	0
	Defines whether the License Terms are accepted. 

· 0 - Do not accept agreement. 

· 1 - Accept the terms of the license agreement.

AcceptLicenseTerms is applicable only if HideUI is set to 1. AcceptLicenseTerms must be set to 1 in order for installation to proceed. If AcceptLicenseTerms is set to 0, then an error message is displayed.

If HideUI is set to 0, then the License Terms screen displays regardless of the AcceptLicenseTerms setting.

	LicenseTermsVersion
	See description.
	Identifies the regional version of the license that has been accepted and installed on the Client. 

The value should be the country/region code that corresponds to the localized and translated version of the license.

The country/region codes include:

CS

Czech

DA

Danish

DE

German

EN

English

ES

Spanish

ET

Estonian

FI

Finnish

FR

French

HU

Hungarian

IS

Icelandic

IT

Italian

JA

Japanese

LT

Lithuanian

LV

Latvian

NL

Dutch

NO

Norwegian

PL

Polish

PT

Portuguese

RU

Russian

SV

Swedish

TH

Thai

TR

Turkish

ZH

Chinese



	LogDir
	See description.
	Specifies where the log files for Setup and the Windows installers are written. 

By default, the log files are written to a folder that includes the current date and time to prevent subsequent installations from overriding previous logs.

The default path is:

Documents and Settings\All Users\Application Data\Microsoft\Dynamics AX\Dynamics AX Setup Logs

Note   If you override the default LogDir, Microsoft Dynamics AX writes logs to the specified directory. However, each file written overwrites the previous file.

The path can be fully qualified or relative to the location of the AXSetup file. Relative paths can include upward qualifiers such as "..\..\".

	RunMode
	Custom
	Identifies the mode in which Setup should be launched.

· Custom - User can choose features.

· JustClient - Installs the client without the .NET or COM Business Connector, without allowing feature choice.


Client parameters

This table lists the parameters that control how Setup installs the client and client options.

	Parameter
	Default value
	Description

	InstallClientUI
	0
	Specifies whether to install the client user interface (UI client).

· 0 - Do not install the UI client.

· 1 - Install UI client.

If RunMode is set to JustClient this parameter is implicitly set to 1.

	ClientConfig
	1 
	Specifies whether the Microsoft Dynamics AX Configuration Utility should be installed. If any of the roles which use the .NET Business Connector are installed, then the Configuration Utility is always installed. 

This option is not available in the user interface. 

· 0 - Do not install the Configuration Utility nor any configuration settings in the registry. 

· 1 - Install the Configuration Utility and configuration settings in the registry.

For more information, see the ClientConfigFile parameter. 

	ClientConfigFile
	blank 
	Specifies the path to the client configuration file. This can be local or a shared folder with restricted permissions. Specifying this parameter creates a shortcut to the client that includes a reference to the configuration file. 

To point to all clients to a configuration file, enter a value for ClientConfigFile, and set ClientConfig to 0.

If ClientConfig is set to 1 and a ClientConfigFile is specified, two shortcuts to the client are created - one that points to the configuration settings in the registry, one that points to the configuration file. 

Avoid setting ClientConfig to 0 and not specifying ClientConfigFile, as no shortcuts to the client are created. 

	ClientLanguage
	en-us
	Specifies the default language-culture value for the client the first time it is started.

Valid values are identified in the Languages section of the AxSetupLists.txt file. In the Languages, Help languages are identified by a language-culture code. 

This parameter is prohibited if not installing the client UI.

The parameter is ignored if the client UI is already installed.

	ClientHelpLanguages
	See note on right
	Specifies which Help languages to install. 

Valid values are identified in the Languages section of the AxSetupLists.txt file. In the languages section, Help languages are identified by a language-culture code. Separate multiple values with a semi-colon. (that is, en-us;fr-fr). Values are case-insensitive. 

The value en-us is required and will be automatically included if omitted. If this parameter is omitted, the default is the value specified in ClientLanguage and en-us.

	ClientInstallPath
	%SystemDrive%\Program Files\Microsoft Dynamics\4.0\Client
	Specifies the directory into which any client-related file should be installed.

Prohibited if one of the following parameters are not used to install a role: 

· InstallClientUI

· InstallNetBusinessConnector

· InstallComBusinessConnector

This parameter is ignored if any of the above client roles have been installed, because they are all installed to the same location.

If not provided, it defaults to: Program Files\Microsoft Dynamics\4.0\Client

	ClientAosServer
	See notes at right
	Specifies the name of the computer hosting the AOS instance to connect the client to.

Prohibited if one of the following parameters are not used to install a role: 

· InstallClientUI

· InstallNetBusiness Connector

· InstallComBusinessConnector

This parameter is ignored if any of the above client roles have been installed, because the registry settings with this information already exist.

If it is not prohibited nor ignored, this parameter is required.

Values:

· 1 - Current computer.

· <Computername> - Can include multiple AOS instances by delimiting values with semicolon (;).

	InstallNetBusinessConnector
	0
	Specifies whether to install the .NET Business Connector role. 

· 0 - Do not install .NET Business Connector.

· 1 - Install .NET Business Connector.

	InstallComBusinessConnector
	0
	Specifies whether to install the COM Business Connector role. 

· 0 - Do not install COM Business Connector.

· 1 - Install COM Business Connector.


Database parameters

This table lists the parameters that control how Setup interacts with the Microsoft Dynamics AX database.

	Parameter
	Default value
	Description

	InstallDatabase
	0
	Specifies whether a database should be created.

· 0 - No, do not install database. 

· 1 - Create database, but fail if a database of the same name already exists.

· 2 - Create or replace database.

Applicable only if RunMode is set to Custom. If RunMode is not set to Custom, the parameter is ignored.

	DbServerType
	0
	Specifies the type of database.

· 0 - Microsoft SQL Server

· 1 - Oracle

Required only if InstallDatabase > 0 or InstallAos is set to 1

	DbSqlServer
	(local)
	Specifies the name of the SQL Server to connect to. Can be specified as a server, or as a fully-qualified server and instance.

Applicable and required only if InstallDatabase > 0 or InstallAos is set to 1 and DbServerType is set to 0.

	DbSqlDatabaseName
	No default value
	Specifies the name of the SQL Server database. 

Applicable and required only if InstallDatabase > 0 or InstallAos is set to 1 and DbServerType is set to 0. If InstallDatabase > 0, then this must be the name of a new database--specifying an existing database name causes an error.

	DbConnectionTimeout
	(Database default)
	Overrides the default database connection timeout value. In most cases, you should not set this value. If the database server is on a remote server, you may need to increase the time Setup has available for its connection to the database.

Applies to both SQL Server and Oracle.

	DbOracleConnectService
	1
	Specifies whether to connect to the Oracle database using the service name defined by DbOracleServiceName or the custom settings. 

· 0 - Use custom settings

· 1 - Use service name

	DbOracleServiceName
	No default value
	Specifies the name of the Oracle service to connect to. 

Applicable only if OracleConnectService is set to 1. 

	DbOracleHostName
	No default value
	Specifies the name of the Oracle host. 

Applicable only if OracleConnectService is set to 0. 

	DbOracleDatabaseId
	No default value
	Specifies the Oracle database ID.

Applicable only if OracleConnectService is set to 0.

	DbOracleTCPIP
	1521
	Specifies the port number of the host on which the Oracle database is located. 

Applicable only if OracleConnectService is set to 0.

	DbOracleSchema
	dbo
	Specifies the default schema under which the Microsoft Dynamics AX objects are created in the Oracle database. Creates the specified schema or uses an existing schema.

	DbOracleSchemaPassword
	dbo
	Specifies the password to use for the Oracle schema set by DbOracleSchema.


Application files parameters

This table lists the parameters that control how Setup interacts with the application files.

	Parameter
	Default value
	Description

	InstallApplication
	0
	Specifies whether application files should be installed 

· 0 - Do not install Application files

· 1 - Copy the application files without deleting the existing contents of the folder. 

· 2 - Copy the application files, but first delete the existing contents of the folder. 

Note   This parameter does not delete and recreate the folder, it only deletes all file in it so that any rights set on the folder are retained. 

Not applicable if RunMode is set to JustClient.

	ApplicationInstallPath
	%SystemDrive%\ Program Files\Microsoft Dynamics\4.0\Application
	Specifies the directory where the application files are copied to.

Applicable only if InstallApplication is set to 1 or InstallAos is set to 1.

Required only if InstallApplication is set to 0 and InstallAos is set to 1.

If InstallApplication is set to 1, the folder must be empty or not exist.

The path must be fully qualified.

	ApplicationInstanceName
	See notes to right
	Provides a name for the Application files. This setting is used in the registry to identify where the Application files are installed.

If not provided, it defaults to the AosInstanceName if available, then to DbSqlDatabaseName if available, then to Dynamics. 

If a value already exists in the registry, it is overwritten.

	ApplicationRegion
	See notes to right
	Specifies which country/region application files to install. Only one region may be specified.

The country/region pack default value is set based on the Region code in the OS Default Language section of AxSetupLists.txt file on the DVD. Region codes are listed in the GDL Regions section of the file. Regions are identified by a two or three character code.  

To specify that no regional Application files should be installed, specify the value '-'.

Note   ApplicationRegion only controls the application files to install. The initial language of the client is controlled by the ClientLanguage parameter, and Help files are controlled by the ClientHelpLanguages parameter.


Application Object Server (AOS) parameters

This table lists the parameters that control how Setup interacts with the AOS.

	Parameter
	Default value
	Description

	InstallAos
	0
	Specifies whether an AOS instance should be installed. 

Values: 

· 0 - Do not install an instance of AOS.

· 1 - Install an instance of AOS.

Not applicable if RunMode is set to JustClient.

If AosInstanceName matches a previously installed instance, then setting InstallAos to 1 runs the Windows installer file in maintenance mode and does not change any settings.

	AosInstallPath
	%SystemDrive%\ Program Files\Microsoft Dynamics\4.0\Server
	Specifies the directory into which the AOS instance should be installed.

You cannot install any additional AOS instances to a different location than the first AOS installed on a computer. The AOS instances must share some common files, and must always install in the same location. If you install an additional AOS silently and provide a value for the AosInstallPath, the value is ignored.

	AosInstanceName
	No default value
	Specifies the name of the instance. Must be unique.

Required parameter if InstallAOS is explicitly or implicitly set to 1.

	AosAccount
	Network Service
	Specifies the account that the AOS Windows Service runs as. The AOS uses this account to connect to the Microsoft Dynamics AX database and to access the application files. 

The Fformat must be DomainName\AccountName.
Note    Your own account or a local computer account cannot be specified as the AosAccount. 


	AosAccountPasswordd
	No default value
	Specifies the password associated with the AOS account. 

Required if AosAccount is specified.

	AosStart
	1
	Specifies whether Setup should start the AOS after installing it.

· 0 - Do not start the AOS service.

· 1 - Start the AOS service.

	AosPort
	See notes at right
	Specifies the port number that the AOS scans on and the client or Business Connect sends requests on.

Must be a numeric value.

The default for the AOS is 2712.

The default in the client or Business Connector configuration is an empty string, which causes Microsoft Dynamics AX to use port 2712.


Application integration parameters

This table lists the parameters that control how Setup installs an application integration gateway role.

	Parameter
	Default value
	Description

	InstallApplicationIntegrationServer
	0
	Specifies whether to install the application integration Web services.

· 0 - Do not install Web services.

· 1 - Install Web services.

	InstallBizTalkServer
	0
	Specifies whether to install the application integration BizTalk Adapter.

· 0 - Do not install BizTalk Adapter.

· 1 - Install BizTalk Adapter.

The BizTalk Adapter DLLs are placed both in the global assembly cache (GAC) and in the Program Files\Microsoft Dynamics\4.0\Client\Bin directory:

· Microsoft.Dynamics.BizTalk.Adapter.dll

· Microsoft.Dynamics.BizTalk.Adapter.Management.dll

· Microsoft.Dynamics.BizTalk.Adapter.Schemas.dll
The file AxAifRemSrv.exe is placed in the Program Files\Microsoft Dynamics\4.0\Client\Bin directory.

	ApplicationIntegrationServerInstallPath
	Program Files\Microsoft Dynamics\4.0\Client
	Specifies the directory into which the Web services files should be installed.

The Business Connector files are always installed in the GAC. The Configuration Utility files are placed in the location specified by the ClientInstallPath parameter.

This parameter is ignored if the application integration files are already installed. 


Reporting server parameters

This table lists the parameter that controls how Setup installs a reporting server.

	Parameter
	Default value
	Description

	InstallReportingServer
	0
	Specifies whether to install the reporting server role. 

· 0 - Do not install reporting server.

· 1 - Install reporting server.

	ReportingServerInstance
	First one found
	Specifies the SQL Server Reporting Services instance to register.

	ReportingServerSqlServer
	DbSqlServer
	Specifies the name of the SQL Server that SQL Server Reporting Services should connect to. The name can be specified as servername, or servername\instance.

If the Microsoft Dynamics AX database is also being set up, then this defaults to the server specified for the database.

Otherwise, it defaults to (local) or Server/Instance.

Applicable and required only if InstallReportingServer = 1.

	ReportingServerSqlDatabaseName
	DbSqlDatabaseName
	Specifies the name of the SQL Server database that SQL Server Reporting Services should use connect to. 

If the Microsoft Dynamics AX database is also being set up, then this defaults to that same database.

Otherwise, it defaults to the database most recently set up on this computer.

The database must exist. 

	ReportingServerAccount
	No default
	Specifies the domain account that is used to connect the reporting server to the database to retrieve reporting data.

By default should be a domain account, but can be a local account if all the components are installed on the same computer.

Format must be DomainName\AccountName.

Local system, Network service and other default Windows accounts cannot be used. 

Required if InstallReportingServer is set to 1.

	ReportingServerAccountPassword
	No default
	Specifies the password associated with the ReportingServerAccount.

Required if InstallReportingServer is set to 1.

	ReportingServerReplaceDataSource
	0
	Specifies whether any existing data source should be replaced. 

· 0 - Do not replace.

· 1 - Replace.


Trial installations

Microsoft Virtual PC images for Microsoft Dynamics AX are available as downloads from http://www.microsoft.com/dynamics/default.mspx. You can modify and use a Virtual PC image to demonstrate the features and functionality of Microsoft Dynamics AX in a live environment using a laptop computer.

You can also set up a single-computer installation of Microsoft Dynamics AX for demonstration purposes. The computer must be running Microsoft Windows Server 2003. For more details, see Install Microsoft Dynamics AX on a single computer.

Customizing an application

Almost all Microsoft Dynamics AX systems involve customized applications. Customizing an application is described in detail in the documentation for Microsoft Dynamics AX developers. To see the full developer documentation set, click Help, and then click Developer Help.

While each customization effort is unique, some recommended practices include:

· To keep customization costs and effort as low as possible, become very familiar with the functionality available in standard Microsoft Dynamics AX modules.

· To minimize problems during future updates such as when applying service packs or moving to the next version of the product, become familiar with the design recommendations in the developer documentation:

· Modifying objects in the standard application
· Modifying user interface text
· Design principles
· Performance optimizations
· Axapta Design Patterns
· APIs in the standard application
· Frameworks introduction
· Design guidelines for cost-efficient upgrades
· Take advantage of the development tools that suit your project and the Microsoft Dynamics AX Development Best Practices guidance described in the Help on Developing Applications for Microsoft Dynamics AX.

The table below describes what you will find in this section.

	Section
	Description

	Considerations for development and test environments
	Describes the environment you may need for a development or test environment.

	Common AOS configuration settings in a development environment
	Describes the server settings you may need to use in a development or test environment.

	Common client configuration settings in a development environment
	Describes the client settings you may need to use in a development or test environment.

	Tracing performance
	Describes how to trace performance.

	Import a class silently on startup
	Describes how to import and execute a class on startup.


Considerations for development and test environments

We recommend that you maintain separate development, test, and production environments. While a development environment runs on very different hardware than the intended production environment, the test environment should mimic the production environment as closely as possible.

In a development environment, you are more likely to do the following tasks than in other environments:

· Change Application Object Server (AOS), client, and non-interactive Business Connector configurations.

For details, see the following topics:

Common Application Object Server (AOS) configuration settings in a development environment
Common client configuration settings in a development environment
· Run multiple instances of Microsoft Dynamics AX.

For details, see the following topics:

· Install multiple instances of Microsoft Dynamics AX
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Install multiple Application Object Server instancesRun multiple version of Microsoft Dynamics AX.

For details, see Install multiple versions of Microsoft Dynamics AX on one computer.

· Set up a team server to help manage version control.

For details, see Managing version control.

· Set up an environment with debugging turned on.

For details, see Allow debugging.

· Use tracing. 

For details, see Tracing performance.

Common Application Object Server (AOS) configuration settings in a development environmentCommon Application Object Server (AOS) configuration settings in a development environment

In a development environment, you are likely to use the Microsoft Dynamics AX Server Configuration Utility to change settings. This section includes topics about some of the more frequently-performed configuration changes:

· Create a new configuration (Server)
· Save or export a configuration (Server)
· Load a configuration (Server)
· Connect an Application Object Server instance to a different database
· Connect an Application Object Server instance to a different application
· Connect an Application Object Server instance to a different bin directory
· Change the TCP/IP port an Application Object Server instance runs on
· Allow debugging
· Compress data
· Tune database settings
· Run commands at startup (Server)
Create a new configuration (Server)

You can create a new configuration for an Application Object Server (AOS) instance to:

· Tune Microsoft Dynamics AX. Save a configuration with the defaults, and then change compression, database turning, and tracing settings one at a time, and save them as different configurations. Start with each configuration in turn, and evaluate how the system performs. 

· Move from a development environment to a production environment. Change the application directory that an AOS instance points to, the database it is connected to, and whether a system allows debugging.

You cannot modify the original configuration of a system. To change a configuration, you must create a new one and modify it.

2062. Open the Server Configuration utility (Start > Administrative Tools > Microsoft Dynamics AX Server Configuration Utility).
2063. In the Application Object Server instance box, select the AOS instance to modify.

2064. Click Manage, and then click Create configuration:

2065. In the Create configuration dialog box, in the Name box, type a name.

2066. Decide whether you want to copy settings from the active configuration or the original (default) configuration, and then click OK.

Save or export a configuration (Server)

You can save startup settings for an Application Object Server (AOS) instance as a configuration stored in the registry or as a configuration file. Saved startup settings enable you to:

· Tune Microsoft Dynamics AX. Change settings, and then tune your system by comparing performance with saved configurations that contain varied compression, database turning, and tracing settings. 

· Move a configuration from one server to another.

Save a configuration to the registry

Use this procedure to save changed settings.

2067. Open the Server Configuration utility (Start > Administrative Tools > Microsoft Dynamics AX Server Configuration Utility).
2068. Make any changes to the currently selected AOS instance and configuration that you want.

2069. Click OK.

Export a configuration to a file

Use this procedure if you want to copy a configuration to an AOS instance on another computer.

2070. Open the Server Configuration utility (Start > Administrative Tools > Microsoft Dynamics AX Server Configuration Utility).
2071. Verify that the currently selected AOS instance and configuration are the ones you want to save.

2072. Click Manage, and then click Export. Choose a location and name for the configuration file, and then click Save. The file is saved with an .axc extension. 

Export all configurations to a file

Use this procedure if you want to copy all configurations for an AOS. 

2073. Open the Server Configuration utility (Start > Administrative Tools > Microsoft Dynamics AX Server Configuration Utility).
2074. Verify that the currently selected AOS instance and configuration are the ones you want to save.

2075. Click Manage, and then click Export All. Choose a location and name for the configuration file, and then click Save. The files are saved with an .axc extension.

Save a configuration file with a new name

You may want to save a configuration file under a new name to provide a record of the changes you are making to configurations over time.

2076. Open the Server Configuration utility (Start > Administrative Tools > Microsoft Dynamics AX Server Configuration Utility).
2077. Verify that the currently selected AOS instance is the one you want.

2078. Import a configuration file.

2079. Click Manage, and then click Save configuration file. Choose a location and name for the configuration file, and then click Save. The file is saved with an .axc extension.

Load a configuration (Server)

If you are an Administrator or Power User on the computer, you can load a configuration (startup settings) for an Application Object Server (AOS) instance from a configuration stored in the registry or from a configuration file.

Load a configuration from the registry

2080. Open the Server Configuration utility (Start > Administrative Tools > Microsoft Dynamics AX Server Configuration Utility).
2081. In the Application Object Server instance box, select the AOS instance to modify.

2082. In the Configuration list, click the configuration you want to open.

Import a configuration from a file

Although you can use the Open command to view a saved configuration, Microsoft Dynamics AX does not store the settings from the opened file to the registry. To store saved configuration files to the registry, you must use the Import command.

2083. Open the Server Configuration utility (Start > Administrative Tools > Microsoft Dynamics AX Server Configuration Utility).
2084. In the Application Object Server instance box, select the AOS instance to modify.

2085. Click Manage, and then click Import.

2086. Browse to the configuration file you would like to use (*.axc), and open it.

Connect an Application Object Server instance to a different database

You can connect an Application Object Server (AOS) instance to a different database. You may want to do this in the following situations:

· Moving from a development or staging environment to a production environment.

· Upgrading a Microsoft Dynamics AX system.

Note   If you are trying to connect to a database that was not created by Microsoft Dynamics AX Setup, the AOS account (the domain account or Network Service account associated with the AOS service)  may not have appropriate rights in Microsoft SQL Server. The AOS account must be a user in the database, and be assigned to the following database roles db_ddladmin, db_datareader, and db_datawriter. 

Connect to a different database

2087. Open the Server Configuration utility (Start > Administrative Tools > Microsoft Dynamics AX Server Configuration Utility).
2088. Verify that the currently selected AOS instance and configuration are the ones you want to modify.

2089. On the Database connection tab, enter the details of the database you would like to connect to, and then click OK.

For a SQL Server connection, consider the following:

· To specify a SQL Server named instance, use the format MyServer\MyInstance.

· To specify the local SQL Server instance on this computer, enter (local).

For an Oracle connection, consider the following: 

· Choose whether to connect using a net service or custom settings.
· In the Use this schema box, specify the schema under which the Microsoft Dynamics AX objects are stored in the database.
Connect an Application Object Server instance to a different application

You can connect an Application Object Server (AOS) instance to a different application file location. You may want to do this in the following situations:

· Moving from a development or staging environment to a production environment.

· Upgrading a Microsoft Dynamics AX system.

2090. Open the Server Configuration utility (Start > Administrative Tools > Microsoft Dynamics AX Server Configuration Utility).

2091. Verify that the currently selected AOS instance and configuration are the ones you want to modify.

2092. On the Application Object Server tab, in the Application file location box, type the path to the application you would like to connect to, and then click OK.

Connect an Application Object Server instance to a different bin directory

By default, Microsoft Dynamics AX reads the text displayed in the user interface from the kernel text data file (*.ktd) stored in the bin directory of the Application Object Server (AOS) directory. You can have Microsoft Dynamics AX use a different kernel text data file by modifying a copy of the kernel text data file, choosing a location, and pointing an AOS instance to it.

2093. Open the Server Configuration utility (Start > Control Panel > Administrative Tools > Microsoft Dynamics AX Server Configuration Utility).
2094. Verify that the currently selected AOS instance and configuration are the ones you want to modify.

2095. On the Application Object Server tab, in the Alternate bin directory box, type or browse to the location of the kernel text data file you want to point to, click Apply, and then click OK.

Change the TCP/IP port an Application Object Server instance runs on

By default, an Application Object Server (AOS) instance runs on port 2712. Subsequent instances are assigned TCP/IP ports dynamically. You can set a different static port for an instance using the Server Configuration Utility. 

You may want to set a different port when: 

· The firewall you are using restricts you to use specific TCP/IP ports. 

· You have multiple AOS instances running on a computer, and always want to know what they are.

2096. Open the Server Configuration utility (Start > Administrative Tools > Microsoft Dynamics AX Server Configuration Utility).

2097. Verify that the currently selected AOS instance and configuration are the ones you want to modify.

2098. On the Application Object Server tab, in the TCP/IP port box, type the port you want the instance to run on, click Apply, and then click OK.

Allow debugging

You can set Microsoft Dynamics AX to allow debugging on an Application Object Server (AOS), or on a client that is running the .NET Business Connector or COM Business Connector. For more information about debugging code for an application that uses Business Connector, see Debugging a Business Connector Application Running Under a Non-Interactive Account.

Allow debugging on an Application Object Server instance 

Note   This option is set in the Microsoft Dynamics AX Server Configuration Utility. 

2099. Open the Server Configuration utility (Start > Administrative Tools > Microsoft Dynamics AX Server Configuration Utility).
2100. Verify that the currently selected AOS instance and configuration are the ones you want to modify. 

2101. On the Application Object Server tab, click Enable breakpoints to debug X++ code running on this server, and then click OK. 

Allow debugging of a Business Connector or Client

The following options in the Microsoft Dynamics AX Configuration Utility can used to enable breakpoints for a Business Connector instance or a client: 

· Enable user breakpoints to debug code running in the Business Connector

For sessions owned by users for whom debug is enabled within Microsoft Dynamics AX, allow X++ code running in the Business Connector to be interrupted by breakpoints

· Enable global breakpoints to debug code running in the Business Connector or client 
For all users, allow X++ code running in the Business Connector or client to be interrupted by global breakpoints. 

Note   When this option is set, you will see all breakpoints for currently active clients.

To debug Business Connector, you must set both debug options. To debug the client, set only the second option. 

Enable breakpoints for a Business Connector instance

2102. Open the Configuration utility (Start > Control Panel > Administrative Tools > Microsoft Dynamics AX Configuration Utility).
2103. On the Developer tab, select Enable user breakpoints to debug code running in the Business Connector.

2104. Select Enable global breakpoints to debug code running in the Business Connector or client, and then click OK.

Enable breakpoints for a client

2105. Open the Configuration utility (Start > Control Panel > Administrative Tools > Microsoft Dynamics AX Configuration Utility).
2106. On the Developer tab, select Enable global breakpoints to debug code running in the Business Connector or client, and then click OK.

Compress data between clients and an Application Object Server

If you have a slow network, with either low bandwidth or high latency causing slow response times, you may want to increase the compression of the data sent between Microsoft Dynamics AX clients and servers.

Decreasing the data size in each client/server request or response can greatly reduce transmission time because of: 

· Better use of limited bandwidth.

· Decreased chance of bit errors.

· Decreased chance of exceeding TCP window size.

The TCP window size is the amount of data received (in bytes) that can be buffered at one time on a connection. The sending host can send only that amount of data before waiting for an acknowledgment and window update from the receiving host.

If the size per client/server request or response is kept below the TCP window size, the sender does not have to wait for an acknowledgment (ACK) when the window size is exceeded. If exceeding the TCP window size cannot be avoided, making as few TCP round trips as possible for each client/server request or response is important.

2107. Open the Server Configuration utility (Start > Control Panel > Administrative Tools > Microsoft Dynamics AX Server Configuration Utility).
2108. Verify that the currently selected Application Object Server (AOS) instance and configuration are the ones you want to modify.

2109. In the Minimum packet size to compress (in KB) field, choose a packet size. 

Choose the smallest useful packet size to compress. The larger the packet size chosen, the smaller the gains in performance.

Tune database settings

You may want to tune the database settings for Microsoft Dynamics AX to improve performance. Before changing settings, trace the usage of your Microsoft Dynamics AX database to ensure that you have clear understanding of performance under the current settings. To trace Microsoft Dynamics AX database performance, use:

· Tracing from the Microsoft Dynamics AX Server Configuration Utility. For more information, see Set tracing options.

· Windows Performance Monitor, using Microsoft Dynamics AX Object counters. For more information, see Set up Performance Monitor counters.

· The Microsoft Dynamics AX System Monitoring dialog box Tools > Development tools > System monitoring).

Test all tuning changes before implementing them in a production environment. In a test or development environment, make a single change and then test your system's performance before making another change.

Change the concurrency mode

Concurrency settings enable you to reduce locking conflicts on your system. For more information, see the following topics: 

· Concurrency model configuration (Form)
· Performance optimizations: Database design and operations
· Transaction integrity
· Exception handling
· Select statement syntax
· Table properties
Tune connections

The following table lists common connection issues, and some adjustments to try in the Server Configuration Utility.

	Symptom
	Adjustments to try

	Results for common queries are returned slowly.
	Increase the Maximum buffer size value.

	Results for ad hoc queries are returned slowly.
	Check to see that the appropriate indexes are in place. 

	Transactions are failing frequently.
	Decrease the Transaction retry interval value.

	Data grids for commonly used tables draw slowly.
	Increase the Array fetch ahead value.


Tune queries

If queries in the system are running slowly, you may want to change settings for literals, string functions, or hints. Microsoft Dynamics AX no longer uses literals by default in form and report queries, or in complex-join queries.

Adjust the use of literals

Microsoft Dynamics AX may pass either parameters (placeholders) or literals (actual values) in queries.

· Parameters allow Microsoft Dynamics AX and the database server to reuse the query when search values change. They are preferred for high-frequency queries.

· Literals allow the database server to optimize the query for a specific piece of information. This provides an optimal query for that piece of information, but the database server must perform the optimization for every query executed. Literals may be used for long running queries such as complex joins. 

A developer can override the default use of literals by specifying parameters in their code, or an administrator can override the use of literals in the Server Configuration Utility.

	Symptom
	Adjustments to try
	Anticipated effect

	Long-running queries run slowly.
	Review the query plan statements sent to SQL Server and consider taking corrective action.  Using literals may be one solution. 

Select Use literals in join queries from forms and reports.

Select Use literals in complex joins from X++.
	Long-running queries pass literals to the database. Processing time for long-running queries should go down. 


Adjust the use of autogenerated string functions

Microsoft Dynamics AX embeds some string functions in SELECT statements automatically. String functions are included to support: 

· Treating uppercase and lowercase versions of the same text as the same text (single case) for Oracle installations.

· Left justification or right justification.

When a string function is included in a query, the optimizer may have to choose a less-than-optimal access plan, such as a table scan, for retrieving data. If customers do not require the use of mixed case outside Microsoft Dynamics AX and do not use left justification or right justification, these functions are not required and should be turned off. To improve performance, we recommend that all values be stored left-aligned by default. 

If queries take longer to run than anticipated or appear to be using table scans rather than indexes, try the following adjustments: 

· Clear Include LTRIM in all SELECT statements to remove leading space from right-aligned columns.

· Clear Include SUBSTR and LOWER in all SELECT statements to support Oracle mixed-case systems.
If the adjustment is successful, queries use query plans and return results more quickly.

Adjust the use of hints

In Microsoft Dynamics AX, you can allow developers to override the index selected by the query optimizer. In most situations, allowing the query optimizer to select an index for a query results in improved performance.

If queries include INDEX hints and are running more slowly than expected, clear the Allow INDEX hints in queries option.

Changes in the use of hints

If you have upgraded to Microsoft Dynamics AX, the queries in your system may contain outdated Microsoft SQL Server hints. Configuration commands are no longer available to globally enable or disable many of the hints from previous versions. If hints are explicitly specified in an X++ statement, they are added to the SQL Server query that is generated. Otherwise, they are not added. 

The following changes have also been made: 

· The OPTION (FAST), LOOP, and FORCE ORDER hints are not applied by default, but are applied if explicitly specified in X++.

· A FIRSTONLY hint in X++ is translated into the addition of a TOP 1 statement to the SQL Server query.

· FASTFORWARD cursors are used for all user queries unless a cursor has been marked as FOR UPDATE.

· FOR UPDATE, NOLOCK, and READPAST, hints are added to statements depending on the type of the cursor that an X++ query has produced. No interface is available to modify these hints.

Run commands at startup (Server)

You can run a command when an Application Object Server (AOS) instance starts. You should exercise caution and test the commands you are using thoroughly in a development or test environment before using them in a Microsoft Dynamics AX production environment. Startup commands are not evaluated before being passed to the AOS instance, and if not correct, can cause the instance to fail to start.

To run a command at startup

2110. Open the Server Configuration utility (Start > Administrative Tools > Microsoft Dynamics AX Server Configuration Utility).
2111. Verify that the currently selected AOS instance and configuration are the ones you want to modify.

2112. On the Application Object Server tab, in the Run advanced startup commands box, type the command or commands you want to run at startup, and then click OK.

Configuration commands (Server)

Configuration commands set the options that are used when an Application Object Server (AOS) instance starts. Configuration commands can be run directly from the following locations: 

· In a configuration file.

· In the Configuration Command to run at kernel startup field in the Server Configuration Utility.

· From a command prompt when starting an AOS instance. 

Configuration commands require that you use different syntax if you are setting them in a configuration file, or executing them in the Configuration Command to run at kernel startup field or from a command prompt. The syntax variations are provided in the following sections.

For details on how to execute configuration commands, see Executing configuration commands at startup.

General options

This table describes the general options you can use to work with configurations and files.

	Command in configuration file
	Command from command line
	Configuration utility option
	Description

	This command cannot be set in a file. 
	-regConfig=<configname>
	Configuration
	Specify the name of the current group of settings for this AOS instance.


Application Object Server options

This table describes the options you can use to manage how an AOS functions.

	Command in configuration file
	Command from command line
	Configuration utility option
	Description

	application,Text,
<applicationname>
	-application=<applicationname>
	Application instance
	Specify the instance of an application that the AOS instance connects to.

	bindir,Text,<path>
	-bindir=<path>
	Alternate bin directory
	Specify the location of a directory containing an alternate kernel text data file (one of the Microsoft Dynamics AX label files).

	compressiondisabled,Int,1
	-compressiondisabled 
	Option not available in utility
	This is a binary command that is not set by default. When this value is absent, data sent between the AOS and its clients is compressed to speed client-server communications. 

If the value is present, then compression of packets is turned off. To turn on packet compression, remove the value from the configuration file. 

We recommend that you not disable compression. Disabling compressions can negatively affect system performance and security.

	compressionminsize,
Text,<number>
	-compressionminsize=<number>
	Minimum packet size to compress
	Specify the smallest useful packet size to compress. The larger the packet size chosen, the smaller the gains in speed.

	directory,Text,<path>


	-directory=<spath>
	Application file location
	Specify the location of the application files for the AOS instance to connect and write to.

	exposeserverprinters,
Int,1
	-exposeserverprinters
	Allow clients to connect to printers on this server
	This is a binary command that is not set by default. When this value is present, clients are allowed to connect to printers that are connected to the AOS computer.

	port,Text,
<portnumber>


	-port=<portnumber>
	TCP/IP port 
	The TCP/IP port that the AOS instance should use to connect to clients. The default value is 2712.

	xppdebug,Text,<0,1>


	-xppdebug=<0,1>
	Enable breakpoints to debug X++ code running on this server
	Enable clients to trace their interactions with this AOS instance. The default is off (0).

	caslevel,Text,<enable/disable/trace>
	-caslevel=<enable/disable/trace>
	Option not available in utility
	Code Access Security (CAS) is the mechanism in Microsoft Dynamics AX that is used to protect specific APIs. For a list of these APIs, see Secured APIs. 

Enable, the default setting, activates CAS for all CAS-protected APIs. If a CAS-protected API is invoked without following the correct consumer steps, an error is generated.

Trace is used to simulate CAS being enabled. An error is not generated if a CAS-protected API is invoked incorrectly. Instead, debug information is written to the Infolog. Use in development or test environments to determine the changes that need to be made to get the system working.

Important   Do not set the caslevel to Trace in production environments.

Disable disables CAS entirely. 

Important   Do not set the caslevel to Disable in production environments.

For more information about securing APIs, see Securing an API that Executes on the Server Tier.

	MaxConcurrentUISessions,Text,<value>
	-MaxConcurrentUISessions=<value>
	 
	Set the maximum number of concurrent Microsoft Dynamics AX client sessions. 

The minimum value is 0, the maximum value (and default) is 65535.

For details about using this setting to tune AOS performance, see Tune application object server settings. 

	MaxConcurrentGuestSessions,Text,<value>
	-MaxConcurrentGuestSessions=<value>
	 
	Set the maximum number of concurrent Guest (anonymous user) sessions.

The minimum value is 0, the maximum value (and default) is 65535.

For details about using this setting to tune AOS performance, see Tune application object server settings. 

	MaxConcurrentWebSessions,Text,<value>
	-MaxConcurrentWebSessions=<value>
	 
	Set the maximum number of concurrent Enterprise Portal sessions, including Guest sessions. 

The minimum value is 0, the maximum value (and default) is 65535.

For details about using this setting to tune AOS performance, see Tune application object server settings. 

For details about using this setting to protect system security, see Security considerations and Best practices.

	MaxConcurrentBCSessions,Text,<value>
	-MaxConcurrentBCSessions=<value>
	 
	Set the maximum number of concurrent Business Connector sessions, including all Web sessions (all Web sessions come through Business Connector).  

The minimum value is 0, the maximum value (and default) is 100.

For details about using this setting to tune AOS performance, see Tune application object server settings. 

	MaxMemLoad,Text,<value>
	-MaxMemLoad=<value>
	 
	Set the maximum amount of memory usage (the maximum percentage of physical memory that is in use on the computer). 

The minimum value is 1, the maximum value (and default) is 65535.

For details about using this setting to tune AOS performance, see Tune application object server settings. 

For details about using this setting to protect system security, see Security considerations and Best practices.

	MaxConcurrentSessions,Int,<value>
	-MaxConcurrentSessions=<value>
	Maximum number of client sessions
	Set the maximum number of client sessions this AOS instance will accept. 

The minimum value is 0, the maxiumum value (and default) is 65535.



	Loadbalance,Int,<0,1>
	-LoadBalance=<0,1>
	Make this AOS instance part of the load balancing cluster
	Set this AOS instance to load balance client connection requests with other AOS instances that also have load balancing enabled.

	startupcmd,Text,<command>
	-startupCmd=<command>
	Command to run at application startup
	Enter a SysStartupCmd method to run when this client application starts. For details, see Executing commands on startup.

	extracmd,Text,<command>
	-extracmd=<command>
	Configuration command to run at kernel startup
	Enter any configuration command to run when the kernel starts.


Database connection options

This table describes the options you can use to connect to a database.

	Command in configuration file
	Command from command line
	Configuration utility option
	Description

	createdsn,Text, <microsoftsqlserver, oracle>


	createdsn=<microsoftsqlserver, oracle>
	Option not available in utility
	Create the data source in the ODBC manager.

	dsn,text,<portnumber>
	-dsn=<portnumber>
	Option not available in utility
	Point to a specific data source.

	database,Text,<databasename>
	-database=<databasename>
	Database to connect to


	Specify the database to connect to.

	dbcli,Text,<ODBC, OCI>
	-dbcli=<ODBC, OCI>
	Option not available in utility
	Run Microsoft Dynamics AX in either ODBC or OCI (Oracle) mode. ODBC is the default.

	dbserver,Text,<servername>
	-dbserver=<servername>
	Option not available in utility
	SQL Server name.


Database tuning options

This table describes the options you can use to tune database performance. 

	Command in configuration file
	Command from command line
	Configuration utility option
	Description

	connectionidletimeout,Text,<0,1>


	-connectionidletimeout=<0,1>
	Leave the connection running when idle
	Retain a connection to the database when no transactions are running.

	connectionidletimeout,Text,<time>


	-connectionidletimeout=<time>
	Maximum idle time before closing
	Specify the amount of time to leave a database connection idle before closing it.

	fetchahead,Text,<number>


	-fetchahead=<number>
	Array fetch ahead
	Specify the maximum number of records that the system fetches at the same time. Starts as your local default computer setting of 100.

	hint,Text,1


	-hint=<0, 1>
	Allow INDEX hints in queries
	Enable any query written with an INDEX hint to override the index selected by the database management system.

	hint,Text,12
	-hint=<0, 12>
	Include SUBSTR and LOWER in all SELECT statements to support Oracle mixed-case systems
	Add SUBSTR and LOWER statements to all queries generated by Microsoft Dynamics AX to convert uppercase data to lowercase. Using SUBSTR and LOWER forces the database to perform a table scan, which can slow query results. Set to 12 to enable this feature, and 0 to disable it.

	hint,Text,2
	-hint=<0, 2>
	Include LTRIM in all SELECT statements to remove leading space from right-aligned columns
	Add LTRIM to all queries generated by Microsoft Dynamics AX. Using LTRIM forces the database to perform a table scan, which can slow query results. Set to 2 to enable this feature, and 0 to disable it.

	ignoredatasourceindex,Text,<0,1>


	-ignoredatasourceindex=<0, 1>
	Generate ORDER BY clauses from WHERE clauses
	Set to 1 to override the ordering specified by the index on the data source, using the order of the columns as specified in the WHERE clause. This can improve query performance.

	newconnectionretrycount,Text,<number>


	-newconnectionretrycount=<number>
	Number of connection retries
	Specify the number of times to try connecting to the database before failing.

	newconnectionretrydelayms,Text,<time>


	-newconnectionretrydelayms=<time>
	Connection retry interval
	Specify the interval between attempts to connect to the database in milliseconds.

	opencursors,Text,<number>


	-opencursors=<number>
	Maximum open cursors
	Specify the maximum number of database cursors to keep open for reuse in a connection. Starts as your local computer setting, which defaults to 90.

	retry,Text,<time>


	-retry=<time>
	Transaction retry interval (in seconds)
	Specify the delay before re-executing a transaction after a deadlock. The default value is 5 seconds.

	sqlbuffer,Text,<number>


	-sqlbuffer=< number>
	Maximum buffer size
	Specify the maximum size of the data retrieval buffer. The larger the buffer, the greater the number of records transferred at the same time. Starts as your local default computer setting of 24.

	sqlcomplexliterals,Text,<0,1>
	-sqlcomplexliterals=<0,1>
	Use literals in complex joins from X++
	Specify that Microsoft Dynamics AX use literals rather than parameters for complex joins to optimize performance.

	sqlformliterals,Text, <0,1>
	-sqlformliterals=<0, 1>
	Use literals in join queries from forms and reports
	Specify that Microsoft Dynamics AX use literals rather than parameters in long-running queries to optimize performance.


Tracing options

This table describes the options you can use to trace calls between the AOS, the database and clients. 

Note   The logdir directory where the trace files are stored cannot be changed. It is the server installation directory\log.

	Command in configuration file
	Command from command line
	Configuration utility option
	Description

	TraceStart,Int,1
	-TraceStart=
	Start trace
Stop trace
	Specify whether trace should be started or stopped:

0 – stop trace 

1 – start trace 

The default value is 0.

	traceeventsenabled,Text, <1; 100; 101; 200; 201; 202; 203; 204; 205>
	-TraceEventsEnabled=<1; 100; 101; 200; 201; 202; 203; 204; 205>
	See below
	Specify the event types to be enabled. You can enable multiple event types using a semi-colon (;) as the delimiter. See below for detailed descriptions. The default value is 1.

	traceeventsenabled,Text,1


	-TraceEventsEnabled=1
	RPC round trips to server
	Trace all remote procedure call (RPC) round trips from any client to the server.

	traceeventsenabled,Text,100


	-TraceEventsEnabled=100
	X++ method calls
	Trace all X++ methods that are invoked on the server.

	traceeventsenabled,Text,101
	-TraceEventsEnabled=101
	Function calls
	Trace all function calls that are invoked on the server.

	traceeventsenabled,Text,200
	-TraceEventsEnabled=200
	Connect and disconnect
	Trace each time the AOS connects and disconnects from the database.

	traceeventsenabled,Text,201


	-TraceEventsEnabled=201
	Transactions: TTSBegin, TTSCommit, TTSAbort
	Trace all transactions that use the TTSBegin, TTSCommit, and TTSAbort statements.

	traceeventsenabled,Text,202


	-TraceEventsEnabled=202
	SQL statements
	Trace all SQL Server statements that are invoked on the server.

	traceeventsenabled,Text,203


	-TraceEventsEnabled=203
	Bind variables
	Trace all columns that are used as input bind variables. 

Note   SQL Statements (202) must also be on to enable this option.

	traceeventsenabled,Text,204


	-TraceEventsEnabled=204
	Row fetch
	Trace all rows that are fetched using SQL Server.

Note   SQL Statements (202) must also be on to enable this option.

	traceeventsenabled,Text,205
	-TraceEventsEnabled=205
	Row fetch summary (count and time)
	Count all rows that are fetched, and record the time spent fetching.

Note   SQL Statements (202) must also be on to enable this option.

	tracexppmethodcalldepth,Text,<number>


	-TraceXppMethodCallDepth=<number>
	Number of nested calls:
	Specify the maximum call depth to be traced for X++ methods. 

Note   TraceEventsEnabled must also be set to 100 to use this command.

The default value is 3.

	tracemaxfilesize,Text,<number>


	-TraceMaxFileSize= <number>
	Option not available in utility
	Specify the maximum size for each trace file in megabytes (MB).

The default value is 10MB.

	tracebuffersize,Text,<number>


	-TraceBufferSize= <0:64>
	Option not available in utility
	Specify the Event Tracing for Windows buffer size, in kilobytes (KB). The maximum size that can be set is 64KB.

The default value is 20KB.

	traceallowclient,Int,1


	-TraceAllowClient
	Allow client tracing on Application Object Server instance
	This is a binary command that is not set by default. Specify whether client tracing is allowed on this AOS instance.


Unfamiliar configuration options

In the configuration files generated by Microsoft Dynamics AX, you may see unfamiliar options. Some are legacy options (configuration options from previous versions) that are not in use. Other configuration options remain in both the client or server configuration files, although they only apply to client or server, because in previous product versions the utilities were combined. We recommend that you do not change values for these options; unexpected results may occur. 

	Value in configuration file
	Applies to

	company,Text,
	Client

	client,Text,thin
	Legacy

	application,Text,standard
	Client

	broadcast,Text,
	Legacy

	aol,Text,sys
	Client

	aolcode,Text,
	Client

	native,Int,0
	Legacy

	sqluser,Text,
	Legacy

	hassqlpwd,Int,0
	Legacy

	sqlpwd,Text,
	Legacy

	startupmsg,Text,
	Client

	localappldoc,Int,0
	Legacy

	localsysdoc,Int,0
	Legacy

	applshare,Int,0
	Legacy

	applexclusive,Int,1
	Legacy

	startupcmd,Text,test
	Client

	hascompwd,Int,0
	Legacy

	compwd,Text,
	Legacy

	allowunauth,Int,0
	Legacy

	windowsauth,Text,1
	Legacy

	aosencryption,Text,0
	Client

	xppdebug,Text,1
	Legacy

	ociuser,Text,
	Legacy

	hasocipwd,Int,0
	Legacy

	ocipwd,Text,
	Legacy

	dbunicodeenabled,Text,1
	Legacy


Common client configuration settings in a development environment

In a development environment, you are likely to use the Microsoft Dynamics AX Configuration Utility to change settings. This section includes topics about some of the more frequently-performed configuration changes:

· Manage a client configuration
· Manage a Business Connector non-interactive configuration
· Set company to open on startup
· Change the log location
· Run commands at startup (Client)
· Allow debugging
· Set default Application Object Tree (AOT) layer to open

 HYPERLINK  \l "b_Display " 
b_Display Display message at startup
· Connect to a different Axapta Object Server instance
Manage a client configuration

If you are an Administrator or Power User on a computer running Microsoft Dynamics AX, you can manage the configurations for your local client through the Microsoft Dynamics AX Configuration Utility. Configuration options are stored in a file, or in the registry hive HKEY_CURRENT_USER/Software/Microsoft/Dynamics/4.0/Configuration/Configname.

Start the configuration utility

2113. Open the configuration utility (Start > Control Panel > Administrative Tools > Microsoft Dynamics AX Configuration Utility).
2114. In the Configuration target list, select Local client.

Create a new configuration

You cannot modify the original configuration of a system. To change a configuration, you must create a new one and modify it.

2115. Click Manage, and then click Create configuration:
2116. In the Create configuration dialog box, in the Name box, type a name.

2117. Decide whether you want to copy settings from the active configuration or the original (default) configuration, and then click OK.

Note   You cannot delete or rename the original configuration. You can only rename or delete configurations that you create.

Copy a configuration

2118. In the Configuration list, select the configuration you would like to create a copy of.
2119. Click Manage, and then click Create configuration:

2120. In the Create configuration dialog box, in the Name box, type a name.

2121. Click Copy settings from the active configuration, and then click OK.

Rename a configuration

2122. In the Configuration list, select the configuration you would like to rename.
2123. Click Manage, and then click Rename configuration.

2124. In the Rename configuration dialog box, in the New name box, type a name, and then click OK.

Load a configuration

You can either load a configuration that is stored in the local registry or import a configuration file. Although you can use the Open command to view a saved configuration, Microsoft Dynamics AX does not store the settings from the opened file to the registry. To store saved configuration files to the registry, you must use the Import command.

Load a configuration from the registry

· In the Configuration list, select the configuration you would like to open.

Import a configuration file

2125. Click Manage, and then click Import.
2126. Browse to the configuration file you would like to use (*.axc), and open it.

Save or export a configuration

You can save startup settings for a client or Business Connector instance as a configuration stored in the registry, or as a configuration file. Saved startup settings enable you to: 

· Tune Microsoft Dynamics AX. Change settings, and then tune your system by comparing performance with saved configurations that contain varied compression, database turning, and tracing settings. 

· Move a configuration from one client to another.

Save a configuration to the registry

2127. Verify that the currently selected configuration is the one you want to save.
2128. Make any changes to the currently selected configuration that you want.

2129. Click Apply, and then click OK.

Export a configuration to a file

Use this procedure if you want to copy a configuration to a client on another computer.

2130. Verify that the currently selected configuration is the one you want to save.
2131. Click Manage, and then click Export configuration to a file. Choose a location and name for the configuration file, and then click Save. The file is saved with an .axc extension. 

Export all configurations to a file

Use this procedure if you want to copy all configurations from one client.

2132. Verify that the currently selected configuration is the one you want to save.
2133. Click Manage, and then click Export All. Choose a location and name for the configuration file, and then click Save. The files are saved with an .axc extension. 

Save a configuration file with a new name

Use this procedure if you want to create a copy of the configuration file you have been using.

2134. Import or open a configuration file.
2135. Make changes to settings.

2136. Click Manage, and then click Save configuration file as. Choose a location and name for the configuration file, and then click Save.

Delete a configuration

2137. Verify that the currently selected configuration is the one you want to delete.
2138. Click Manage, and then click Delete configuration.

Manage a Business Connector non-interactive configuration

To modify the configuration options for a Business Connector that is running non-interactively (not being run in conjunction with a client), you must be a member of the Administrators or Power Users group on the local computer.

Note   Although the option to change the Business Connector non-interactive configuration becomes available when Business Connector is installed, if a Microsoft Dynamics AX client is also installed on the computer, the configuration settings for the client will be used for it and for the Business Connector if Business Connector is running under the currently logged-in account.

Start the configuration utility

2139. Open the configuration utility (Start > Control Panel > Administrative Tools > Microsoft Dynamics AX Configuration Utility).
2140. In the Configuration target list, select Business Connector (non-interactive use only).

Create a new configuration

You cannot modify the original configuration of a system. To change a configuration, you must create a new one and modify it.

2141. Click Manage, and then click Create configuration:
2142. In the Create configuration dialog box, in the Name box, type a name.

2143. Decide whether you want to copy settings from the active configuration or the original (default) configuration, and then click OK.

Copy a configuration

2144. In the Configuration list, select the configuration you would like to create a copy of.
2145. Click Manage, and then click Create configuration:

2146. In the Create configuration dialog box, in the Name box, type a name.

2147. Click Copy settings from the active configuration, and then click OK.

Rename a configuration

2148. In the Configuration list, select the configuration you would like to rename.
2149. Click Manage, and then click Rename configuration. 

2150. In the Rename configuration dialog box, in the New name box, type a name, and then click OK.

Load a configuration

You can either load a configuration that is stored in the local registry or import a configuration file. Although you can use the Open command to view a saved configuration, Microsoft Dynamics does not store the settings from the opened file to the registry. To store saved configuration files to the registry, you must use the Import command.

Load a configuration from the registry

· In the Configuration list, select the configuration you would like to open.

Import a configuration file

2151. Click Manage, and then click Import. 
2152. Browse to the configuration file you would like to use (*.axc), and open it.

Save or export a configuration

You can save startup settings for a client or Business Connector instance as a configuration stored in the registry, or as a configuration file. Saved startup settings enable you to: 

· Tune Microsoft Dynamics AX. Change settings, and then tune your system by comparing performance with saved configurations that contain varied compression, database turning, and tracing settings.

· Move a configuration from one client to another.

Save a configuration to the registry

2153. Verify that the currently selected configuration is the one you want to save.
2154. Make any changes to the currently selected configuration that you want.

2155. Click OK.
Export a configuration to a file

Use this procedure if you want to copy a configuration to a client on another computer.

2156. Verify that the currently selected configuration is the one you want to save.
2157. Click Manage, and then click Export configuration to a file. Choose a location and name for the configuration file, and then click Save. The file is saved with an .axc extension.

Export all configurations to a file

Use this procedure if you want to copy all configurations from one client.

2158. Verify that the currently selected configuration is the one you want to save.
2159. Click Manage, and then click Export All. Choose a location and name for the configuration file, and then click Save. The files are saved with an .axc extension. 

Save a configuration file with a new name

Use this procedure if you want to create a copy of the configuration file you have been using. 

2160. Import or open a configuration file. 
2161. Make changes to settings.

2162. Click Manage, and then click Save configuration file as. Choose a location and name for the configuration file, and then click Save. 

Delete a configuration

2163. Verify that the currently selected configuration is the one you want to delete.
2164. Click Manage, and then click Delete configuration.

Set company to open on startup

You can set Microsoft Dynamics AX to always open a particular company's data when it starts by using the Microsoft Dynamics AX Configuration Utility.

2165. Open the Configuration Utility (Start > Control Panel > Administrative Tools > Microsoft Dynamics AX Configuration Utility).
2166. Verify that the currently open configuration target and configuration are the ones you want to modify.

2167. On the General tab, in the Company box, enter the three letter company identifier, and then click OK.

Change the log location

You can change where Microsoft Dynamics AX places the log files by using the Microsoft Dynamics AX Configuration Utility.

2168. Open the Configuration Utility (Start > Control Panel > Administrative Tools > Microsoft Dynamics AX Configuration Utility).
2169. Verify that the currently open configuration target and configuration are the ones you want to modify.

2170. On the General tab, in the Log directory box, type the path in which you want to store the log files, and then click OK.

Run commands at startup (Client)

You can run a command when Microsoft Dynamics AX starts. You should exercise caution and test the commands you are using thoroughly in a development or test environment before using them in a production environment. Startup commands are not evaluated before being passed to Microsoft Dynamics AX and, if not correct, can cause the system to fail to start. 

2171. Open the Configuration Utility (Start > Control Panel > Administrative Tools > Microsoft Dynamics AX Configuration Utility).
2172. Verify that the currently open configuration target and configuration are the ones you want to modify.

2173. On the General tab, in the Startup command box, type the command or commands you want to run at startup, and then click OK.

Configuration commands (Client)

Configuration commands set the options that are used when a Microsoft Dynamics AX client starts. Configuration commands can be run directly from the following locations: 

· In a configuration file.

· In the Configuration Command to run at kernel startup field in either the Client Configuration Utility or Server Configuration Utility.

· From a command prompt when starting a client or an Application Object Server (AOS) instance. 

Configuration commands require that you use different syntax if you are setting them in a configuration file, or executing them in the Configuration Command to run at kernel startup field or from a command prompt. The syntax variations are provided in the following sections. For information about executing configuration commands, see Executing configuration commands at startup.

General options

This table describes the options you can use to work with configurations and files, as well as general startup options such as company, log file, and startup commands and messages.

	Command in configuration file
	Command in command line
	Configuration utility option
	Description

	company,Text,<string>
	-company=<string>
	Company
	Specify the company that holds data for your application.

	log,Text, <path>
	-log=<path>
	Log directory
	Specify an alternate directory for the log files generated when you make changes in the Application Object Tree (AOT).

	helpdir,Text,<path>


	-helpDir=<path>
	No corresponding user interface value
	Specify the location where Help files are stored. For details, see Set Help file location.

	This command cannot be set in a file.
	-regConfig=<configname>
	Configuration
	Specify the name of the current group of settings for this Application Object Server (AOS) instance.

	startupcmd,Text,<command>
	-startupCmd=<command>
	Command to run at application startup
	Enter a SysStartupCmd method to run when this client application starts. For details, see Executing commands on startup.

Note   No syntax checking is performed before startupCmd commands are passed to the Microsoft Dynamics AX client application. A bad command can disable your system. Test any command before using it.

	startupmsg,Text,<string>
	-startupmsg=<string>
	Startup message
	Specify text to display in a message box when Microsoft Dynamics AX starts.

	extracmd,Text,<command>
	-extracmd=<command>
	Configuration command to run at kernel startup
	Enter a configuration command to run when the kernel starts.

Note   No syntax checking is performed before extracmd commands are passed to the Microsoft Dynamics AX kernel. A bad command can disable your system. Test any command before using it.

	This command cannot be set in a file.
	-language=<string>
	No corresponding user interface value
	Change the language that a Microsoft Dynamics AX client uses when starting.

In most instances, you should use the user management options to change a user's language. See Set a user's default language for details. Use this option only if a user has changed to a new language and the Microsoft Dynamics AX client is unable to open. 


Connection options

This table describes the options you can use to connect to an AOS instance.

	Command in configuration file
	Command from command line
	Configuration utility option
	Description

	aos,text,<options>

Options include: 

host
- or -

host:port
- or -

instance@host

- or -

instance@host:port
	-aos=host
- or -

-aos =host:port
- or -

-aos=instance@host

- or -

-aos=instance@host:port
	Application Object Server connection
	Specify a connection to an AOS instance. Instance and port are optional. 

If port is not specified, the value defaults to 2712.

	aos2,text,<options>

Options include: 

host
- or -

host:port
- or -

instance@host

- or -

instance@host:port
	-aos2=host
- or -

-aos2=host:port
- or -

-aos2 =instance@host

- or -

-aos2=instance@host:port 
	Application Object Server connection
	Specify connections to additional AOS instances. Instance and port are optional. 

If port is not specified, the value defaults to 2712

	aosencryption,Text,<0,1>
	-aosencryption=<0,1>
	Encrypt client to server communication
	Encrypt all data sent between this client and the AOS. 

	useserverprinters,Int,1
	-useserverprinters
	Connect to printers on the server
	This is a binary command that is not set by default. Allow client to connect to printers on the AOS computer. Similar settings must be set on the AOS instance to enable this functionality.


Developer options

This table describes the options you can use to set up the development environment.

	Command in configuration file
	Command from command line
	Configuration utility option
	Description

	aol,Text,<string>
	-aol=<string>
	Layer to open in Application Object Tree
	Layer to open in the Application Object Tree (AOT)

	aolcode,Text,<string>
	-aolcode=<string>
	License code
	Developer license code to open development options in Microsoft Dynamics AX

	globalbreakpoints,Int,1
	-globalbreakpoints
	Enable global breakpoints for debugging code running in the Business Connector or client 
	This is a binary command that is not set by default. For all users, allow X++ code running in the Business Connector or client to be interrupted by global breakpoints 

	xppdebug,Text,<0,1>
	-xppdebug=<0,1>
	Enable user breakpoints for debugging code running in the Business Connector
	For sessions owned by users for whom debug is enabled, allow X++ code running in the Business Connector to be interrupted by breakpoints.

	aotimportfile,text,<file.xpo>
	–aotimportfile=<File.xpo>
	Option not available in utility
	Import an xpo file and start a full compile of the AOT when the client starts.


Tracing options

This table describes the options you can use to trace calls between a client, the AOS, and the database.

Note   The logdir directory where the trace files are stored cannot be changed. It is the installation directory\log.

	Command in configuration file
	Command from command line
	Configuration utility option
	Description

	TraceStart,Int,1
	-TraceStart=
	Start trace
Stop trace
	Specify whether trace should be started or stopped:

0 – Stop trace 

1 – Start trace 

The default value is 0.

	traceeventsenabled,Text, <1; 100; 101; 200; 201; 202; 203; 204; 205>
	-TraceEventsEnabled=<1; 100; 101; 200; 201; 202; 203; 204; 205>
	For descriptions, see the following options. 
	Specify the event types to be enabled. You can enable multiple event types using a semicolon ; as the delimiter. For detailed descriptions, see the following options. The default value is 1. 

	traceeventsenabled,Text,1


	-TraceEventsEnabled=1
	RPC round trips to server
	Trace all remote procedure call (RPC) round trips from any client to the server.

	traceeventsenabled,Text,100


	-TraceEventsEnabled=100
	X++ method calls
	Trace all X++ methods that are invoked on the server.

	traceeventsenabled,Text,101
	-TraceEventsEnabled=101
	Function calls
	Trace all function calls that are invoked on the server.

	traceeventsenabled,Text,200
	-TraceEventsEnabled=200
	Connect and disconnect
	Trace each time the AOS connects and disconnects from the database.

	traceeventsenabled,Text,201
	-TraceEventsEnabled=201
	Transactions: TTSBegin, TTSCommit, TTSAbort
	Trace all transactions that use the TTSBegin, TTSCommit, and TTSAbort statements.

	traceeventsenabled,Text,202
	-TraceEventsEnabled=202
	SQL statements
	Trace all SQL Server statements that are invoked on the server.

	traceeventsenabled,Text,203
	-TraceEventsEnabled=203
	Bind variables
	Trace all columns that are used as input bind variables. 

Note   TraceEventsEnabled must also be set to 202 to use this command.

	traceeventsenabled,Text,204
	-TraceEventsEnabled=204
	Row fetch
	Trace all rows that are fetched using SQL Server.

Note   TraceEventsEnabled must also be set to 202 to use this command.

	traceeventsenabled,Text,205
	-TraceEventsEnabled=205
	Row fetch summary (count and time)
	Count all rows that are fetched, and record the time spent fetching.

Note   TraceEventsEnabled must also be set to 202 to use this command.

	tracexppmethodcalldepth,Text,<number>
	-TraceXppMethodCallDepth=<number>
	Number of nested calls:
	Specify the maximum call depth to be traced for X++ methods, effective only when X++ methods are traced. 

Note   TraceEventsEnabled must also be set to 100 to use this command.

The default value is 3.

	tracemaxfilesize,Text,<number>
	-TraceMaxFileSize=<number>
	Option not available in utility
	Specify the maximum size for each trace file in megabytes (MB).

The default value is 10MB.

	tracebuffersize,Text,<number>
	-TraceBufferSize=<0:64>
	Option not available in utility
	Specify the Event Tracing for Windows buffer size, in kilobytes (KB). The maximum size that can be set is 64KB.

The default value is 20KB.



" 

Unfamiliar configuration
 options

In the configuration files generated by Microsoft Dynamics AX, you may see unfamiliar options. Some are legacy options (configuration options from previous versions) that are not in use. Other configuration options remain in both the client or server configuration files, although they only apply to client or server, because in previous product versions the utilities were combined. We recommend that you do not change values for these options; unexpected results may occur. 

	Value in configuration file
	Applies to

	directory,Text,<pathname>
	Server

	client,Text,thin
	Legacy

	broadcast,Text,
	Legacy

	sql,Int,1
	Server

	native,Int,0
	Legacy

	fetchahead,Text,
	Server

	opencursors,Text,
	Server

	database,Text,
	Server

	dsn,Text,
	Server

	sqluser,Text,
	Legacy

	hint,Text,
	Server

	sqlbuffer,Text,
	Server

	log,Text,
	Server

	hassqlpwd,Int,0
	Legacy

	sqlpwd,Text,
	Legacy

	retry,Text,
	Server

	dbserver,Text,
	Server

	localappldoc,Int,0
	Legacy

	localsysdoc,Int,0
	Legacy

	applshare,Int,1
	Legacy

	applexclusive,Int,0
	Legacy

	hascompwd,Int,0
	Legacy

	compwd,Text,
	Legacy

	hasserveridletimeout,Int,0
	Server

	serveridletimeout,Text,
	Server

	connectionidletimeout,Text,
	Server

	port,Text,
	Server

	createdsn,Text,
	Server

	allowunauth,Int,0
	Legacy

	sqlformliterals,Text,1
	Server

	sqlcomplexliterals,Text,1
	Server

	ignoredatasourceindex,Text,0
	Server

	dbcli,Text,odbc
	Server

	dbunicodeenabled,Text,1
	Legacy

	newconnectionretrydelayms,Text,
	Server

	newconnectionretrycount,Text,
	Server

	cachesynctime,Text,
	Server

	_clientadname,Text,
	Legacy


Allow debugging

You can set Microsoft Dynamics AX to allow debugging on an Application Object Server (AOS), or on a client that is running the .NET Business Connector or COM Business Connector. For more information about debugging code for an application that uses Business Connector, see Debugging a Business Connector Application Running Under a Non-Interactive Account.

Allow debugging on an Application Object Server instance 

Note   This option is set in the Microsoft Dynamics AX Server Configuration Utility. 

2174. Open the Server Configuration utility (Start > Administrative Tools > Microsoft Dynamics AX Server Configuration Utility).
2175. Verify that the currently selected AOS instance and configuration are the ones you want to modify. 

2176. On the Application Object Server tab, click Enable breakpoints to debug X++ code running on this server, and then click OK. 

Allow debugging of a Business Connector or Client

The following options in the Microsoft Dynamics AX Configuration Utility can used to enable breakpoints for a Business Connector instance or a client: 

· Enable user breakpoints to debug code running in the Business Connector

For sessions owned by users for whom debug is enabled within Microsoft Dynamics AX, allow X++ code running in the Business Connector to be interrupted by breakpoints

· Enable global breakpoints to debug code running in the Business Connector or client 
For all users, allow X++ code running in the Business Connector or client to be interrupted by global breakpoints. 

Note   When this option is set, you will see all breakpoints for currently active clients.

To debug Business Connector, you must set both debug options. To debug the client, set only the second option. 

Enable breakpoints for a Business Connector instance

2177. Open the Configuration utility (Start > Control Panel > Administrative Tools > Microsoft Dynamics AX Configuration Utility).
2178. On the Developer tab, select Enable user breakpoints to debug code running in the Business Connector.

2179. Select Enable global breakpoints to debug code running in the Business Connector or client, and then click OK.

Enable breakpoints for a client

2180. Open the Configuration utility (Start > Control Panel > Administrative Tools > Microsoft Dynamics AX Configuration Utility).
2181. On the Developer tab, select Enable global breakpoints to debug code running in the Business Connector or client, and then click OK.

Set default Application Object Tree (AOT) layer to open

You can set Microsoft Dynamics AX to always open a specific Application Object Tree (AOT) layer when it starts by using the Configuration Utility.

2182. Open the Configuration Utility (Start > Control Panel > Administrative Tools > Microsoft Dynamics AX Configuration Utility).
2183. Verify that the currently open configuration target and configuration are the ones you want to modify.

2184. On the Developer tab, in the Application Object Layer to open list, select the layer you would like to open, click Apply and then click OK.

Display message at startup

You can set Microsoft Dynamics AX to display a message box when it starts by using the Microsoft Dynamics AX Configuration Utility.

To set a startup message

2185. Open the Configuration Utility (Start > Control Panel > Administrative Tools > Microsoft Dynamics AX Configuration Utility).
2186. Verify that the currently open configuration target and configuration are the ones you want to modify.

2187. On the General tab, in the Startup message box, enter the message you want to display, and then click OK.

When the client is started, the text displays in a message box, with an OK button below.

Connect a client to a different Application Object Server instance

You can connect a client to a different Application Object Server (AOS) instance from the Microsoft Dynamics AX Configuration Utility.

Connect to a different AOS instance

2188. Open the Configuration Utility (Start > Control Panel > Administrative Tools > Microsoft Dynamics AX Configuration Utility).
2189. Verify that the currently open configuration target and configuration are the ones you want to modify.

2190. On the Connection tab, in the Application Object Server instance list, choose the AOS instance to connect to, and then click the up arrow until it is first in the list.

Note   Microsoft Dynamics AX connects to the first AOS instance in the list unless it is unavailable, then it connects to the next instance in the list.

2191. Click OK.

Add an instance to the list of available AOS instances

2192. On the Connection tab, click Add. 
2193. In the Application Object Server box, type the name of the computer running the AOS instance you want to connect to.

2194. Optional. In the Instance name box, type the name of the AOS instance. 

2195. In the TCP/IP port box, type the TCP/IP port that the AOS instance is running on, and then click OK.

Tracing performance

Tracing Microsoft Dynamics AX server performance can be useful in many scenarios to:

· Develop a performance baseline for a system, to provide information for managing changes to the system, and for capacity planning.

· Perform regular traces to help monitor performance. 

· Determine what factors may be impacting performance.

The table below describes what is in this section.

	Topic
	Description

	Set tracing options
	Describes how and when to turn on tracing.

	Reading trace files
	Describes how to read trace files.


Set tracing options


Microsoft Dynamics AX provides multiple locations to set tracing options for server and client activity. You can set traces: 

· In the Microsoft Dynamics AX Server Configuration Utility on the computer running the Application Object Server (AOS) instance.

· In the Microsoft Dynamics AX Configuration Utility on a client or for an instance of Business Connector that is running non-interactively.

· Within Microsoft Dynamics AX, in the Tools > Options... dialog box, on the Development and SQL tabs.

Note   This option is not available unless you also select Allow client tracing on Application Object Server instance in the Server Configuration Utility.

In general, we recommend that you use these tools to help you trace in the following scenarios:

	Scenario
	Tool

	Monitoring general performance
	Trace from the Server Configuration Utility on a computer running an AOS instance. 

	Standard troubleshooting 
	Trace from the Server Configuration Utility on a computer running an AOS instance.

	Debugging code
	Trace from the Configuration Utility on the client

- or -

For line-by-line tracing only, use the options in the Tools > Options dialog box. This may option may degrade system performance.

	Create an application profile
	Trace from the Configuration Utility on the client.

	Deep troubleshooting 
	Trace from the Server Configuration Utility on the AOS.


Considerations for tracing from the configuration utilities

When you are setting up tracing from the Configuration Utility or Server Configuration Utility, be aware of the following: 

Note   Tracing is processing-intensive and space-intensive - We recommend that you do not turn tracing on for more than one client at a time.

· The log directory cannot be changed - The log is always installed to installationdirectory\log. Restrict access to the directory to administrators and the AOS account (the domain account or Network Service account associated with the AOS service).

· Trace files are stored in binary format, and can be read with the Microsoft Dynamics AX Tracing Utility, available for download from Microsoft Dynamics AX Online. 

Set tracing options (Server)

2196. Open the Server Configuration utility (Start > Administrative Tools > Microsoft Dynamics AX Server Configuration Utility).
2197. Verify that the currently selected Application Object Server (AOS) instance and configuration are the ones you want to modify. 

2198. On the Tracing tab, evaluate the type of tracing you need to do, and choose settings. 

	To do this
	Select these options

	Monitor general performance on a production server
	RPC round trips to server

	Perform standard troubleshooting
	RPC round trips to server
X++ method calls, Number of nested calls: 4
SQL statements
Allow client tracing on Application Object Server instance

	Debug code
	RPC round trips to server
X++ methods
SQL statements
Row fetch summary (count and time)
Allow client tracing on Application Object Server instance

	Deep troubleshooting
	All options. Performance may be degraded while all tracing options are on.


2199. On the Tracing tab, click Start trace. If the AOS Windows service is running, the trace starts within 15 seconds. If the service is stopped, the trace starts the next time the service is started.
Set tracing options (Client)

2200. Open the Configuration utility (Start > Control Panel > Administrative Tools > Microsoft Dynamics AX Configuration Utility).
2201. Verify that the currently selected configuration is the one you want to modify. 

2202. On the Tracing tab, evaluate the type of tracing you need to do, and choose settings. 

	To do this
	Select these options

	Monitor general performance on a production server
	RPC round trips to server

	Perform standard troubleshooting
	RPC round trips to server
X++ method calls, Number of nested calls: 4
SQL statements

	Debug code
	RPC round trips to server
X++ methods
SQL statements
Row fetch summary (count and time)
Enable method tracing to client desktop

	Deep troubleshooting
	All options. Performance may be degraded while all tracing options are on.


2203. To start tracing once you have set the options you want, close the Configuration Utility, and restart your Microsoft Dynamics AX client.
View a trace file

Files from traces are saved to the following locations: 

	Type of trace
	Location

	AOS trace files
	AOS computer Log\<servername>_<timestamp>.trc

	AOS settings and SQL settings triggered from client (Allow client tracing on Application Object Server instance is selected)
	AOS computer Log\<Username>_<ClientIP>_<sessionID>_<server>.trc

	Client method trace triggered from client (Enable method tracing to client desktop is selected)
	Client computer log\<Username>_<ClientIP>_<sessionID>_<client>.trc


A new file is created each time tracing is started, or when a new day starts. 

Note   If you are running frequent traces, be sure to remove or archive unneeded trace files often.

Troubleshooting tracing

This section provides information on troubleshooting issues encountered while tracing.

In the Configuration Utility it appears that a trace is running, but when I look in Windows, the trace is not running

When a trace file reaches its size limit, it is stopped by Windows. The Configuration Utility interface does not synchronize with Windows until you click Stop trace.

When I run more than one client tracing session at a time, my system slows down

Tracing is processing-intensive and space-intensive - we recommend that you do not turn tracing on for more than one client at a time.

Reading trace files

Trace files store Microsoft Dynamics AX information gathered by turning on tracing in the configuration utilities. Trace files are stored in a binary format. A trace file reader utility is available for download. For the most current information, visit Microsoft Dynamics AX Online.

· Client log and trace files are stored at: ProgramFiles\Microsoft Dynamics\4.0\Client\Log
· Server log and trace files are stored at: ProgramFiles\Microsoft Dynamics\4.0\Server\company\Log
When you trace method calls, the values returned are multiples of 2. To determine the actual call depth, divide the value by 2.
Import a class on startup

You can import a class, and execute methods within it without user interaction by starting Microsoft Dynamics AX from the command line with an XML file as input parameter. The XML file specifies the class and methods to use. The result of importing and executing is written to a log file or shown to the user in Infolog.

Executing with no user interaction is useful for any automation of customer tasks, in particular during the test phase.

Create an XML file

2204. On the Microsoft Dynamics AX client computer, create a file of type XML.
2205. Add tags to XML file specifying:

· Microsoft Dynamics AX version.

· Name and location of the log file. 

· The XPO file containing the class to be imported.

· The method to be run.

Note   The XML file syntax is described in the documentation for the SysAutoRun Class.

2206. Open a command line window and type 

ax32.exe –StartupCmd=AutoRun_c:\folder\filename.XML
Sample XML file

This is an example of an XML file that can be used to import data silently.

<?xml version="1.0" encoding="utf-8" ?> 

<AxaptaAutoRun version="4.0" logFile="AxaptaAutoRun_BVTRun.log">

  <XpoImport file="\share\TestCases\CreateClass.xpo" />

  <Run type="class" name="CreateClass" method="main" />

  </AxaptaAutoRun>

Moving to a production environment

Before you move to a production environment, you should:

· Fully test your system in a development or test environment.

· Fully train the new users of your system.

When you deploy Microsoft Dynamics AX to a production environment follow a process similar to the following: 

· Set up all prerequisite servers in their final configurations, and make the production environment as stable as possible.

· Install and deploy your Microsoft Dynamics AX application and servers, and a few test clients. 

· Test the system.

· Deploy clients to the user's desktops. You may want to deploy clients silently.

· Handle final data migrations and open transactions.

· Go live.

The table below describes what you will find in this section.

	Section
	Description

	Modify AOS and client configurations for a production environment
	Provides a description of the server and client configurations you are likely to use in a production environment. 

	Migrating data
	Provides a description of how to move data to a production environment. 

	Set Help file location
	Provides a description of how to set an alternate Help file location. 

	Benchmark an installation
	Provides a description of how to benchmark an installation.

	Silent installation
	Provides a description of how to install clients silently, and the setup parameters you must use.

	Go live
	Provides a description of the tasks for the server to be placed into a work environment or "go live."

	Manage AOS load balancing
	Provides a description of how to set up load balancing for AOS instances.

	Manage Help files and updates
	Provides a description of how to manage Help file locations, and downloadable updates.


Modify server and client configurations for a production environment

When you move a system to a production environment, use the Microsoft Dynamics AX Server Configuration Utility and Microsoft Dynamics AX Configuration Utility to reconfigure the computers that the system is running on.

This section contains information on how to perform some of the more common configuration tasks required for moving to a production environment. The topics in this section include:

· Connect an Application Object Server instance to a different application
· Connect an Application Object Server instance to a different database
· Tune database settings
· Tune Application Object Server performance
· Change the TCP/IP port an Application Object Server instance runs on
· Enable printing from a computer running Application Object Server
· Compress data
· Change the log location
· Set company to open on startup
· Display message at startup
· Connect to a different Axapta Object Server instance
· Encrypt data
· Edit code at a customer site
Connect an Application Object Server instance to a different application

You can connect an Application Object Server (AOS) instance to a different application file location. You may want to do this in the following situations:

· Moving from a development or staging environment to a production environment.

· Upgrading a Microsoft Dynamics AX system.

2207. Open the Server Configuration utility (Start > Administrative Tools > Microsoft Dynamics AX Server Configuration Utility).

2208. Verify that the currently selected AOS instance and configuration are the ones you want to modify.

2209. On the Application Object Server tab, in the Application file location box, type the path to the application you would like to connect to, and then click OK.

Connect an Application Object Server instance to a different database

You can connect an Application Object Server (AOS) instance to a different database. You may want to do this in the following situations:

· Moving from a development or staging environment to a production environment.

· Upgrading a Microsoft Dynamics AX system.

Note   If you are trying to connect to a database that was not created by Microsoft Dynamics AX Setup, the AOS account (the domain account or Network Service account associated with the AOS service)  may not have appropriate rights in Microsoft SQL Server. The AOS account must be a user in the database, and be assigned to the following database roles db_ddladmin, db_datareader, and db_datawriter. 

Connect to a different database

2210. Open the Server Configuration utility (Start > Administrative Tools > Microsoft Dynamics AX Server Configuration Utility).
2211. Verify that the currently selected AOS instance and configuration are the ones you want to modify.

2212. On the Database connection tab, enter the details of the database you would like to connect to, and then click OK.

For a SQL Server connection, consider the following:

· To specify a SQL Server named instance, use the format MyServer\MyInstance.

· To specify the local SQL Server instance on this computer, enter (local).

For an Oracle connection, consider the following: 

· Choose whether to connect using a net service or custom settings.
· In the Use this schema box, specify the schema under which the Microsoft Dynamics AX objects are stored in the database.
Tune database settings

You may want to tune the database settings for Microsoft Dynamics AX to improve performance. Before changing settings, trace the usage of your Microsoft Dynamics AX database to ensure that you have clear understanding of performance under the current settings. To trace Microsoft Dynamics AX database performance, use:

· Tracing from the Microsoft Dynamics AX Server Configuration Utility. For more information, see Set tracing options.

· Windows Performance Monitor, using Microsoft Dynamics AX Object counters. For more information, see Set up Performance Monitor counters.

· The Microsoft Dynamics AX System Monitoring dialog box Tools > Development tools > System monitoring).

Test all tuning changes before implementing them in a production environment. In a test or development environment, make a single change and then test your system's performance before making another change.

Change the concurrency mode

Concurrency settings enable you to reduce locking conflicts on your system. For more information, see the following topics: 

· Concurrency model configuration (Form)
· Performance optimizations: Database design and operations

 HYPERLINK  \l "b_Transact" 
b_TransactTransaction integrity
· Exception handling
· Select statement syntax
· Table properties
Tune connections

The following table lists common connection issues, and some adjustments to try in the Server Configuration Utility.

	Symptom
	Adjustments to try

	Results for common queries are returned slowly.
	Increase the Maximum buffer size value.

	Results for ad hoc queries are returned slowly.
	Check to see that the appropriate indexes are in place. For the most recent guidance about indexing, check Microsoft Dynamics AX Online.

	Transactions are failing frequently.
	Decrease the Transaction retry interval value.

	Data grids for commonly used tables draw slowly.
	Increase the Array fetch ahead value.


Tune queries

If queries in the system are running slowly, you may want to change settings for literals, string functions, or hints. Microsoft Dynamics AX no longer uses literals by default in form and report queries, or in complex-join queries.

Adjust the use of literals

Microsoft Dynamics AX may pass either parameters (placeholders) or literals (actual values) in queries.

· Parameters allow Microsoft Dynamics AX and the database server to reuse the query when search values change. They are preferred for high-frequency queries.

· Literals allow the database server to optimize the query for a specific piece of information. This provides an optimal query for that piece of information, but the database server must perform the optimization for every query executed. Literals may be used for long running queries such as complex joins. 

A developer can override the default use of literals by specifying parameters in their code, or an administrator can override the use of literals in the Server Configuration Utility.

	Symptom
	Adjustments to try
	Anticipated effect

	Long-running queries run slowly.
	Review the query plan statements sent to SQL Server and consider taking corrective action.  Using literals may be one solution. 

Select Use literals in join queries from forms and reports.

Select Use literals in complex joins from X++.
	Long-running queries pass literals to the database. Processing time for long-running queries should go down. 


Adjust the use of autogenerated string functions

Microsoft Dynamics AX embeds some string functions in SELECT statements automatically. String functions are included to support: 

· Treating uppercase and lowercase versions of the same text as the same text (single case) for Oracle installations.

· Left justification or right justification.

When a string function is included in a query, the optimizer may have to choose a less-than-optimal access plan, such as a table scan, for retrieving data. If customers do not require the use of mixed case outside Microsoft Dynamics AX and do not use left justification or right justification, these functions are not required and should be turned off. To improve performance, we recommend that all values be stored left-aligned by default. 

If queries take longer to run than anticipated or appear to be using table scans rather than indexes, try the following adjustments: 

· Clear Include LTRIM in all SELECT statements to remove leading space from right-aligned columns.

· Clear Include SUBSTR and LOWER in all SELECT statements to support Oracle mixed-case systems.
If the adjustment is successful, queries use query plans and return results more quickly.

Adjust the use of hints

In Microsoft Dynamics AX, you can allow developers to override the index selected by the query optimizer. In most situations, allowing the query optimizer to select an index for a query results in improved performance.

If queries include INDEX hints and are running more slowly than expected, clear the Allow INDEX hints in queries option.

Changes in the use of hints

If you have upgraded to Microsoft Dynamics AX, the queries in your system may contain outdated Microsoft SQL Server hints. Configuration commands are no longer available to globally enable or disable many of the hints from previous versions. If hints are explicitly specified in an X++ statement, they are added to the SQL Server query that is generated. Otherwise, they are not added. 

The following changes have also been made: 

· The OPTION (FAST), LOOP, and FORCE ORDER hints are not applied by default, but are applied if explicitly specified in X++.

· A FIRSTONLY hint in X++ is translated into the addition of a TOP 1 statement to the SQL Server query.

· FASTFORWARD cursors are used for all user queries unless a cursor has been marked as FOR UPDATE.

· FOR UPDATE, NOLOCK, and READPAST, hints are added to statements depending on the type of the cursor that an X++ query has produced. No interface is available to modify these hints.

Tune Application Object Server performance

Before you start to tune the performance of an Application Object Server (AOS) instance, trace the usage of the AOS instance to ensure that you understand the performance under the current settings. For information about tracing and monitoring AOS performance, see Monitoring and tuning.

Before you implement tuning changes in a production environment, test them all. In a test or development environment, make one change and then test your system's performance before making another change. 

You can adjust many options to tune your system, including: 

· Adjust the maximum allowed sessions and memory use for an AOS.

· Set a group of AOS instances to load balance.

Adjust maximum sessions and memory use 

If after you run your Microsoft Dynamics AX implementation you find that your system performs best when at or under a certain load, you can adjust the values of the following configuration commands in the configuration file of the AOS. After you set any value, you must restart the AOS for the change to be applied.

· MaxConcurrentUISessions - Sets the maximum number of concurrent Microsoft Dynamics AX client sessions. The default value is 65535.

· MaxConcurrentGuestSessions - Sets the maximum number of concurrent Guest (anonymous user) sessions. The default value is 65535.

· MaxConcurrentWebSessions - Sets the maximum number of concurrent Enterprise Portal sessions, including Guest sessions. The default value is 65535.
· MaxConcurrentBCSessions - Sets the maximum number of concurrent Business Connector sessions, including all Web sessions (all Web sessions come through Business Connector). The default value is 65535.
· MaxMemLoad - Sets the maximum amount of memory usage (the maximum percentage of physical memory that is in use on the computer). The default value is 100.

· MaxConcurrentSessions - Sets the maximum number of client sessions an AOS instance will accept. The default value is 65535.

Note   MaxConcurrentSessions is the only value that affects load balancing. If you load balance, do not use any MaxConcurrent<option>Sessions value or the MaxMemLoad option to tune performance.
For details about using these commands, see Configuration commands (Server).

Set up load balancing

 You can load balance across multiple computers that are running Microsoft Dynamics AX Application Object Server (AOS) instances. 

The options for a load balancing topology include: 

· Add AOS instances to a cluster and run the cluster without a load balancer.

If you set up a cluster without a load balancer, you can use client configurations to set clients to connect to one or more AOS instances that have load balancing enabled. If an administrator needs to remove a computer from the cluster, and one or more client configuration is pointing to it, the client configuration must be updated. No additional hardware is required for this topology. 

· Add AOS instances to a cluster and configure one or more AOS instances to be a load balancer.

If you set up a cluster with a load balancer, you must use client configurations to set clients to connect to the AOS that has been set as the load balancer. You can then add and remove instances from the cluster without needing to update client configurations. Additional hardware may be required to set up a computer as a load balancer. 

For details about setting up and managing load balancing, see Manage AOS load balancing.

Change the TCP/IP port an Application Object Server instance runs on

By default, an Application Object Server (AOS) instance runs on port 2712. Subsequent instances are assigned TCP/IP ports dynamically. You can set a different static port for an instance using the Server Configuration Utility. 

You may want to set a different port when: 

· The firewall you are using restricts you to use specific TCP/IP ports. 

· You have multiple AOS instances running on a computer, and always want to know what they are.

2213. Open the Server Configuration utility (Start > Administrative Tools > Microsoft Dynamics AX Server Configuration Utility).

2214. Verify that the currently selected AOS instance and configuration are the ones you want to modify.

2215. On the Application Object Server tab, in the TCP/IP port box, type the port you want the instance to run on, click Apply, and then click OK.

Enable printing from a computer running Application Object Server

You can set Microsoft Dynamics AX to allow printing to a printer attached to a computer running an Application Object Server (AOS) instance. You may want to use this type of printing for reports or other data to which you want to restrict access. Options must be set on both the AOS and client to enable printing. 

Note   To print a document to a PDF file, you must have installed an Adobe Printer driver. For details, refer to your Adobe license and documentation (http://www.adobe.com)

Set an Application Object Server instance to enable printing

Note   This option is set in the Microsoft Dynamics AX Server Configuration Utility.

2216. Open the Server Configuration utility (Start > Administrative Tools > Microsoft Dynamics AX Server Configuration Utility).
2217. Verify that the currently selected AOS instance and configuration are the ones you want to modify.

2218. On the Application Object Server tab, click Connect to printers on this server, and then click OK.

Set a client to use printing

Note   This option is set in the Microsoft Dynamics AX Client Configuration Utility. 

2219. Open the Configuration utility (Start > Control Panel > Administrative Tools > Microsoft Dynamics AX Client Configuration Utility).
2220. Verify that the currently selected configuration target and configuration are the ones you want to modify. 

2221. On the Connection tab, click Connect to printers on the server, and then click OK.

Compress data between clients and an Application Object Server

If you have a slow network, with either low bandwidth or high latency causing slow response times, you may want to increase the compression of the data sent between Microsoft Dynamics AX clients and servers.

Decreasing the data size in each client/server request or response can greatly reduce transmission time because of: 

· Better use of limited bandwidth.

· Decreased chance of bit errors.

· Decreased chance of exceeding TCP window size.

The TCP window size is the amount of data received (in bytes) that can be buffered at one time on a connection. The sending host can send only that amount of data before waiting for an acknowledgment and window update from the receiving host.

If the size per client/server request or response is kept below the TCP window size, the sender does not have to wait for an acknowledgment (ACK) when the window size is exceeded. If exceeding the TCP window size cannot be avoided, making as few TCP round trips as possible for each client/server request or response is important.

2222. Open the Server Configuration utility (Start > Control Panel > Administrative Tools > Microsoft Dynamics AX Server Configuration Utility).
2223. Verify that the currently selected Application Object Server (AOS) instance and configuration are the ones you want to modify.

2224. In the Minimum packet size to compress (in KB) field, choose a packet size. 

Choose the smallest useful packet size to compress. The larger the packet size chosen, the smaller the gains in performance.

Change the log location

You can change where Microsoft Dynamics AX places the log files by using the Microsoft Dynamics AX Configuration Utility.

2225. Open the Configuration Utility (Start > Control Panel > Administrative Tools > Microsoft Dynamics AX Configuration Utility).
2226. Verify that the currently open configuration target and configuration are the ones you want to modify.

2227. On the General tab, in the Log directory box, type the path in which you want to store the log files, and then click OK.

Set company to open on startup

You can set Microsoft Dynamics AX to always open a particular company's data when it starts by using the Microsoft Dynamics AX Configuration Utility.

2228. Open the Configuration Utility (Start > Control Panel > Administrative Tools > Microsoft Dynamics AX Configuration Utility).
2229. Verify that the currently open configuration target and configuration are the ones you want to modify.

2230. On the General tab, in the Company box, enter the three letter company identifier, and then click OK.

Display message at startup

You can set Microsoft Dynamics AX to display a message box when it starts by using the Microsoft Dynamics AX Configuration Utility.

To set a startup message

2231. Open the Configuration Utility (Start > Control Panel > Administrative Tools > Microsoft Dynamics AX Configuration Utility).
2232. Verify that the currently open configuration target and configuration are the ones you want to modify.

2233. On the General tab, in the Startup message box, enter the message you want to display, and then click OK.

When the client is started, the text displays in a message box, with an OK button below.

Connect a client to a different Application Object Server instance

You can connect a client to a different Application Object Server (AOS) instance from the Microsoft Dynamics AX Configuration Utility.

Connect to a different AOS instance

2234. Open the Configuration Utility (Start > Control Panel > Administrative Tools > Microsoft Dynamics AX Configuration Utility).
2235. Verify that the currently open configuration target and configuration are the ones you want to modify.

2236. On the Connection tab, in the Application Object Server instance list, choose the AOS instance to connect to, and then click the up arrow until it is first in the list.

Note   Microsoft Dynamics AX connects to the first AOS instance in the list unless it is unavailable, then it connects to the next instance in the list.

2237. Click OK.

Add an instance to the list of available AOS instances

2238. On the Connection tab, click Add. 
2239. In the Application Object Server box, type the name of the computer running the AOS instance you want to connect to.

2240. Optional. In the Instance name box, type the name of the AOS instance. 

2241. In the TCP/IP port box, type the TCP/IP port that the AOS instance is running on, and then click OK.

Encrypt data

By default, Microsoft Dynamics AX secures data sent across a network by using the remote procedure call (RPC) function RPC_C_AUTHN_LEVEL_CONNECT, which validates user credentials at the time a connection is established. 

You can also encrypt data if your security needs require it. When you turn on encryption, Microsoft Dynamics AX uses the RPC_C_AUTHN_LEVEL_PKT_PRIVACY call, which provides the highest security level available through RPC.

For more information about RPC security, search for RPC security in MSDN: http://msdn.microsoft.com/.

Note   Enabling encryption may decrease performance between five and ten percent.

2242. Open the Microsoft Dynamics AX Configuration utility (Start > Control Panel > Administrative Tools > Microsoft Dynamics AX Configuration Utility).
2243. Verify that the currently selected instance and configuration are the ones you want to modify.

2244. On the Connection tab, click Encrypt client-to-server communications, and then click OK.

Edit code at a customer site

With a development license, you can edit X++ code at any customer location by using the Configuration Utility to establish your credentials.

To edit code at a customer site

2245. Open the configuration utility (Start > All Programs > Administration > Microsoft Dynamics AX Configuration Utility).
2246. Verify that the currently open configuration target and configuration are the ones you want to modify.

2247. On the Developer tab, in the License code box, enter a valid development license code, retype the code in the Confirm license code box, click Apply, and then click OK.

Migrating data

When you move data from the current system to Microsoft Dynamics AX, you have a number of features available to make the data migration process successful. For additional information about export and import features, see the Planning data migration section and the Managing Data section in the Microsoft Dynamics AX IT Professional documentation.

The Migrating data section contains information about how to perform some of the more common data migration procedures when moving data from the current system to Microsoft Dynamics AX. 

Work with customer, vendor and item data using the Excel wizard 

Work with historical transaction data
A note about exporting tables and classes
Using the application object export-import facilities
Delete table and class members: a simple example
Import data from older versions
Handle open transactions
Import data on startup
Work with customer, vendor and item data using the Microsoft Excel wizard

 Administration > Periodic > Data export/import > Excel spreadsheets > Template WizardBefore you import customer, vendor and item data into Microsoft Dynamics AX, complete the setup for all involved files, since field names and values in Microsoft Dynamics AX may be different than what the current system is using. Create a record manually to understand all of the available Microsoft Dynamics AX fields and how they correspond to the current system.

After you have decided how fields are to be mapped from your old database to the new one, use the Template Wizard to create a Microsoft Excel template of user-selected Microsoft Dynamics AX tables and fields that you can map to the current system's field names and values using Excel functionality.

Do not convert all your records at once or attempt to work with a blank template. Create a few records in Microsoft Dynamics AX and follow the process below before converting everything so you are sure that the template conversion meets your needs and converts your data as you expect it to. As you create the template using the wizard, you can check the template by populating it with this data. If it does not meet your expectations, redo the template and try again. When you are satisfied, convert all your data.

Create a Vendor template in Excel using the template wizard

Using the Template Wizard, create a template called Vendors.

· Select VendTable from the available objects.

· Select the fields to be shown in the template - note the mandatory fields aremarked with a red padlock icon and cannot be cleared.. 

· Complete the Vendors template using the wizard.

· Use Excel functionality to map fields to that of the current system and to populate the template with data.

Create a Customer template in Excel using the template wizard

Using the Template Wizard, create a template called Customers.

· Select CustTable from available objects.

· Select the fields to be shown in the template - note the mandatory fields are marked with a red padlock icon cannot be cleared. 

· Complete the Customer template using the wizard.

· Use Excel functionality to map fields to that of the current system and to populate the template with data.

Import Item data using the Excel template wizard

Using the Template Wizard, you must create 3 different templates: Item table, Inventory module parameters and Warehouse items.

· For the Item table template select InventTable from available objects.

· For the Inventory module parameters, select InventTableModule - In the InventTableModule make sure that the followingavailable objects are selected: Invent, Purch, and Sales.

· For the Warehouse items select InventItemLocation.

· Complete the item templates using the wizard.

· Use Excel functionality to map fields to that of the current system and to populate the templates with data.

Work with historical transaction data

The history of a transaction is generally only converted for General Ledger balances. For you to convert history for the subsidiary modules would be time-consuming, since it is likely that the current system does not have the same fields, file layouts, and posting methodologies as Microsoft Dynamics AX. The current system or hard copy records should be available to you for research history and transaction details.

A note about exporting tables and classes

During export and import, tables and classes are handled differently than other application objects.

When you export a table or a class, only the members (fields, field groups, indexes, relations, and methods) that have been created or modified in the layer you are exporting from are included in the export.

When you later import such objects, you should make sure that the Delete table and class members check box is not selected.

As opposed to tables and classes, application objects like forms, reports, and queries are always fully exported. For example, this means that all methods, controls and so on are exported, whether or not they have been created or modified in the current layer.

Using the application object export-import facilities

Use the Microsoft Dynamics AX application object export-import facilities for backup purposes, or if you want to reuse objects from one Microsoft Dynamics AX installation at another one.

Typical export-import workflow for selected application objects

2248. Open the Application Object Tree (AOT).
2249. Select the objects you want to export.

Tip   To ease the process of exporting objects of different types, create a project with the objects you want to export. Then select individual objects in the project or export the entire project. If you choose to export the entire project, the individual objects as well as the project with all objects are exported.

2250. Choose Export on the Command menu, or on the AOT shortcut menu.
To learn about the Export dialog box, see Exporting application objects.

2251. Make the export file available at the Microsoft Dynamics AX installation where you want to use the application objects, for example on a network drive or on a disk.

2252. Open the AOT at the Microsoft Dynamics AX installation where you want to import application objects.

Choose Import on the Command menu, or click the import icon on the [image: image97.png]



2253. Locate the import file and open it.

The objects in the export file are presented in a tree structure where you can select all or only some objects.

To learn about the Import dialog box, see Importing application objects.

Delete table and class members: a simple example

In this example you are importing a class named MyClass with the methods called A, B, and C.

In the Application Object Tree (AOT), MyClass has the methods A, B, C, D, and E.

· If you select Overwrite table and class members, MyClass in the AOT only has the methods A, B, and C after the import where methods A, B, and C have been overwritten with the ones from the import file.

· If you do not select Overwrite table and class members, MyClass in the AOT still has the methods A, B, C, D, and E after the import. Methods A, B, and C have been overwritten with the ones from the import file.

Import data from older versions

Due to database schema changes between major versions, data from a previous version can only be used after it has been upgraded. Upgrading to match the new schema is handled by data upgrade scripts that are automatically triggered when import is run. However, there are a number of restrictions on the data you can import:

· You can only import data from one version back. This means that in Microsoft Dynamics AX version 4.0 you can import from Microsoft Dynamics AX version 3.0 but not from earlier versions.

· You can only import into a single, empty company. This means that in an installation with multiple company accounts, you will get an error message when trying to import.

Note   Data import should not be used to upgrade an entire production system. The recommended way to upgrade data is to use the Dynamics AX DB Upgrade Preparation Tool and the Upgrade checklist.
In Microsoft Dynamics AX version 4.0 with a single, empty company import by following below steps:

2254. Click Administration > Periodic > Data export/import > Import to open the Import form.
2255. Browse to locate and select the file holding the data (.dat) or the file identifying the data to import (.def) and click OK to start the import.

The upgrade scripts are automatically run and the resulting data is ready for Microsoft Dynamics AX version 4.0.
Handle open transactions

Open transactions are defined as the unpaid and partly-settled invoices, both from customers and from vendors, that exist prior to your migration to Microsoft Dynamics AX. How you deal with open transactions during the planning and implementation phase depends ultimately on your customer or user requirements. 

Note   The following information provides you with a number of guidelines on how to handle open transactions. You may be required to transfer more information or less information when handling open transactions, depending on local accounting rules. In addition, because the transactions were not created in Microsoft Dynamics AX l you lose all historical references to transactions. 

Consider the following when you work with open transactions:

· Since handling open transaction must be done manually, try to minimize the number of open transactions you must work on before migrating to Microsoft Dynamics AX. To do this, settle as many accounts receivable and accounts payable as possible before transferring transactions. 

· Partly-settled invoices should indicate only:

· The original total amount, presented in a text string 

· The current open balance.

· Create journals for customers and vendors, and Enter open transactions using one line for each unsettled invoice by:

Pointing directly at the Accounts Receivable/Accounts Payable (AR/AP) accounts, and 

Specifying the AR/AP ledger control account respectively as the offset account.

This allows each journal line to be balanced and the net AR/AP ledger control account posting to be zero.

This method requires your General Ledger opening balance to include the control account totals.

Import data on startup

You can import data into Microsoft Dynamics AX without user interaction by starting Microsoft Dynamics AX from the command line with an XML file as input parameter. The XML file specifies the data to be imported. The result of importing the data is written to a log file or shown to the user in Infolog.

Executing with no user interaction is useful for any automation of customer tasks, in particular during the test phase.

Create an XML file

2256. On the Microsoft Dynamics AX client computer, create a file of type XML.
2257. Add tags to XML file specifying:

· Microsoft Dynamics AX version.

· Name and location of the log file.

· The data file to be imported, along with the appropriate attributes.

Note   The XML file syntax is described in the documentation for the SysAutoRun Class.

2258. Open a command line window and type 

ax32.exe –StartupCmd=AutoRun_c:\folder\filename.XML
Sample XML file

This is an example of an XML file that can be used to import data silently.

  <?xml version="1.0" encoding="utf-8" ?> 

<AxaptaAutoRun exitWhenDone="true" version="4.0" logFile="axautodata.log">

<CompanyAccounts>

  <Company name="Demo Company" id="DMO" overwrite="true" /> 

  </CompanyAccounts>

  <DataImport companyId="DMO" file="\\servername\sharename\demoData.dat" /> 

  </AxaptaAutoRun>

Set Help file location

You can use the helpDir command to point a Microsoft Dynamics AX client to Help files that are stored in a location different than the default. The location can be on a network share or local. When you use a configuration that points to an alternate location for Help files, the Help files stored locally are not used. 

2259. Place the Help files in the location you want. 
2260. If you are still using the original configuration, open the Microsoft Dynamics AX Configuration Utility (Start > All Programs > Control Panel > Administration > Microsoft Dynamics AX Configuration Utility), create a new configuration file, and then close the configuration utility. For details, see Manage a client configuration.

2261. Open the client configuration file you are using with a text editor, such as Microsoft Notepad. 

2262. Add the following line to the file, and then save and close it.

helpDir,Text,filelocation.

2263. Save the configuration file, and copy it to a shared directory that all client computers can connect to.

We recommend that you use a shared directory on the computer running the instance of Application Object Server (AOS) that clients connect to.

Note   If you did not deploy your clients to use a shared configuration file, you can provide each user with a new desktop shortcut to Microsoft Dynamics AX that passes the location of the configuration file. For example: Ax32.exe \\MyShare\SharedConfigFile.axc. 

2264. Close any Microsoft Dynamics AX clients that are using the configuration file, and then restart them. The Help system reads from the location you designated.

Note   If the topics in the Help files do not display when you are pointing to a location on a network, you may need to modify security settings that prevent Help from loading over a network. For details, see this Knowledge Base article.

Benchmark an installation

By the end of calendar year 2006, Microsoft will provide a Benchmark Toolkit for Microsoft Dynamics AX for download from CustomerSource and PartnerSource. The toolkit:

· Provides extensible features to develop benchmarks that closely mimic your custom implementation. 

· Includes scripts that run on SYS layer code to simulate core business flows. These scripts are designed for Microsoft Dynamics AX 4.0, but customers and partners can modify them to run on Axapta 3.0.  

· Provides a powerful programming model built on the .NET framework that is closely integrated with Microsoft Visual Studio 2005. 

For more information, see the Microsoft Dynamics AX 4.0 white paper Benchmarking on Hewlett-Packard Proliant Servers at Benchmark Results.
Silent installation

You can install any part of Microsoft Dynamics AX silently (without using the Setup wizard user interface) by passing parameters to the Setup program (Setup.exe).

This section contains the following topics:

· Install clients silently
· Setup parameters
Go live with a new implementation

As you move Microsoft Dynamics AX to a production environment and test the system, users must be made aware of how to work with Microsoft Dynamics AX. To do this, ensure that:

· Everyone is properly trained, so they know how to work in the environment.

· The production environment has been tested properly.

· Users realize the benefits of the new system. 

If problems do occur, then there must be a response plan in place to deal with them. This plan should be simple and provide a way to track progress in resolving the problem, and informing the users after a solution is found.

For information about how to troubleshoot, see Troubleshooting.

Manage Help files and updates

You can customize the location from which Microsoft Dynamics AX retrieves Help updates. You can also set the Help file location for clients.

Set the Help update location

2265. In the Microsoft Dynamics AX client, click Administration > Setup > Help Update parameters.
2266. Enter the location you want to retrieve Help files from, and click OK.

Download updated Help

For subscribers to an Enhancement plan, updated Help files for Microsoft Dynamics AX are made available in English and a limited set of additional languages. This Help contains content updates made in response to customer feedback.

Note   The Help files distributed by Microsoft do not overwrite Help files created by your partner for Microsoft Dynamics AX.

2267. Navigate to Using Microsoft Dynamics AX to find the location of the most recent downloadable Help files. 
2268. Download and install the updated Help files in the location you have set for your system.

2269. On each client, on the Help menu, click Check for Updates.

Note   Using Microsoft Dynamics AX also provides access to an updated version of the Microsoft Dynamics AX Help system that you can browse.

Determine where to store Help files for each client

You can use the helpDir command to point a Microsoft Dynamics AX client to Help files that are stored in a location different than the default. The location can be on a network share or local. The directory structure required for the alternate Help location mirrors that used by Microsoft Dynamics AX: Help\language. For a list of the language directories used by your installation, review the folders under the Program Files\Microsoft Dynamics AX\40\Client\Bin\Help directory.

Point a single client to an alternate Help file location

2270. Place the Help files in the location you want. The file location can be local, or on a network share. 
2271. Open the Microsoft Dynamics AX Configuration Utility (Start > All Programs > Administration > Microsoft Dynamics AX Configuration Utility), and create a new configuration if you are still using the original configuration. 

2272. In the Startup command field, enter -helpDir=filelocation. Close the configuration utility to save the configuration.

2273. Close Microsoft Dynamics AX if it is open, and restart it. The Help system reads from the location you designated.

Note   If the topics in the Help files do not display when you are pointing to a location on a network, you may need to modify security settings that prevent Help from loading over a network. For details, see this Knowledge Base article.

Point multiple clients to an alternate Help file location

To point multiple clients to a new Help file location when you are deploying them, you must create a configuration file that contains the helpDir command, and deploy the clients to use a shared configuration file. For details about deploying clients to use a shared configuration file, see Install clients silently.

When you use a configuration that points to an alternate location for Help files, the Help files stored locally are not used. 

2274. Place the Help files in the location you want.
2275. Open the Microsoft Dynamics AX Configuration Utility (Start > All Programs > Administration > Microsoft Dynamics AX Configuration Utility). 

2276. Click Manage > Save Configuration as file, and name and save the configuration file.

2277. Close the configuration utility.

2278. Edit the configuration file in a text editor. Add the following command to the file: 

helpDir = <help file location>

2279. Save the file, and copy it to a shared directory that all client computers can connect to.

We recommend that you use a shared directory on the computer running the instance of Application Object Server that clients connect to.

Distribute Help to clients that use a shared configuration

Copy the updated Help files to the location specified by the helpDir parameter in the shared configuration file. For details about shared configuration files, see Install clients silently.

Manage AOS load balancing

You can load balance across multiple computers that are running Microsoft Dynamics AX Application Object Server (AOS) instances. 

Set up load balancing

The options for a load balancing topology include: 

· Add AOS instances to a cluster and run the cluster without a load balancer.

If you set up a cluster without a load balancer, you can use client configurations to set clients to connect to one or more AOS instances that have load balancing enabled. If an administrator needs to remove a computer from the cluster, and one or more client configuration is pointing to it, the client configuration must be updated. No additional hardware is required for this topology. 

· Add AOS instances to a cluster and configure one or more AOS instances to be a load balancer.

If you set up a cluster with a load balancer, you must use client configurations to set clients to connect to the AOS that has been set as the load balancer. You can then add and remove instances from the cluster without needing to update client configurations. Additional hardware may be required to set up a computer as a load balancer. 

Add AOS instances to a cluster

2280. Open the Server Configuration utility (Start > Control Panel > Administrative Tools > Microsoft Dynamics AX Server Configuration Utility).
2281. Verify that the currently selected Application Object Server (AOS) instance and configuration are the ones that you want to modify.
2282. Select Make this AOS instance part of the load balancing cluster.

2283. Set a value for the maximum number of client sessions that the AOS instance will accept. 
Set up an AOS to be a load balancer

2284. Open the Server Configuration utility (Start > Control Panel > Administrative Tools > Microsoft Dynamics AX Server Configuration Utility).
2285. Verify that the currently selected Application Object Server (AOS) instance and configuration are the ones that you want to modify.

2286. Select Use this AOS instance for load balancing only (accept no client connections).
Manage members of a cluster

As part of maintenance, you may need to temporarily remove and add AOS instances from a cluster. To add and remove members of a cluster, you control whether an instance accepts or rejects new client connections.
Set an AOS instance to reject new clients 

2287. Open a Microsoft Dynamics AX client.
2288. Open the Online users form. (Administration > Online users).
2289. On the Server Instances tab, select the AOS instance. 

2290. When the number of clients connected to the AOS reaches 0, it is safe to perform maintenance.

Add an AOS instance to a cluster 

2291. Open the Online users form. (Administration > Online users).
2292. On the Server Instances tab, select the AOS instance. 

Maintaining Microsoft Dynamics AX

This section provides information about common maintenance tasks for a Microsoft Dynamics AX system.

The table below describes what you will find in this section.

	Section
	Description

	Processing batch jobs
	Describes how to set up and process batch jobs. 

	Backing up application files
	Describes how and when to back up application files.

	Backing up and restoring data
	Describes how and when to back up application files.

	Download current Help files
	Describes how to keep your Help system current.

	Monitoring and tuning
	Describes how to monitor and tune your Microsoft Dynamics AX system.


Processing batch jobs

Batch processing allows you to run jobs, such as printing reports or posting journals, at a different time and on a different computer. Thereby you avoid slowing down your computer or the server during normal working hours.

Batch jobs are submitted to a central batch list where they are prioritized, queued, and executed. If a specific batch group was selected when the batch job was submitted, it will be executed when batch processing is started for that specific batch group. Batch groups are created by the AX administrator in Basic > Setup > Batch > Batch groups.

Batch processing is initiated from a client by selecting Basic > Periodic > Batch > Processing. If a batch group is not selected, all the jobs submitted without specifying a batch group are processed. If a batch group is selected, just the jobs in that batch group are processed. It is possible to set up batch processing on multiple clients, for example to process jobs in different batch groups.

The following topics describe how to set up and use Microsoft Dynamics AX for batch processing.

	Topic
	Description

	Create a batch group
	Provides information for creating batch groups to process multiple batch journals and reports simultaneously.

	Create a batch journal type
	Provides information for creating batch journal types to process multiple related jobs as batch jobs.

	Create a batch journal
	Provides information for creating batch journals and specifying how to run the jobs, on the journal types, which are attached to the journal.

	Add batch job to a batch journal
	Provides information for adding batch jobs to batch journals.

	Add batch journal to a batch group
	Provides information for adding batch journals to batch groups.

	Set criteria for a batch job
	Provides information for setting up the batch job criteria.

	Delete a batch job
	Provides information for deleting batch jobs from the batch queue.

	Change batch job status
	Provides information for changing the status of batch jobs.

	Display batch job status
	Provides information for displaying the status of batch jobs.

	Create a private batch job
	Provides information for creating private batch jobs.

	Clean up the batch list
	Provides information for cleaning up the batch list.

	Running batch jobs
	Provides information for running batch jobs.


Backing up application files

To ensure that all modifications and customizations are not lost in the event of a computer failure, regularly back up the application files directory using Microsoft Windows backup or another backup system. The default location is the Program Files\Microsoft Dynamics\4.0\Application directory.

Backing up and restoring data

As a safeguard for protecting critical data, you should have a well-planned backup and restore strategy for all databases in your system. 

Implementing a well-planned backup and restore strategy protects databases against data loss due to damage caused by a variety of failures. Testing your strategy by restoring a set of backups and recovering your database prepares you to respond effectively to a disaster. 

A backup is a copy of data that is used to restore and recover data after a system failure. Backups allow you to restore data after a failure. With proper backups, you can recover from many failures, including: 

· Media failure.

· User errors (such as dropping a table by mistake).

· Hardware failures (such as a damaged disk drive or permanent loss of a server).

· Natural disasters.

Additionally, backups of a database are useful for routine purposes, such as copying a database from one server to another, loading a new license, setting up database mirroring, archiving for governmental purposes, and disaster recovery. Refer to your database documentation for details about how to choose and implement a backup and restore strategy.

Refer to the guidance for your database management system when planning your strategy. A Microsoft Dynamics AX system can include:

· A Microsoft Dynamics AX database, either Microsoft SQL Server or Oracle

· A SharePoint database to support Enterprise Portal

· A SQL Server 2005 Reporting Services database to support ad hoc reporting

· A SQL Server Analysis Services database to support OLAP reporting
Microsoft SQL Server documentation
Microsoft Windows SharePoint Services documentation
Manage Help files and updates

You can customize the location from which Microsoft Dynamics AX retrieves Help updates. You can also set the Help file location for clients.

Set the Help update location

2293. In the Microsoft Dynamics AX client, click Administration > Setup > Help Update parameters.
2294. Enter the location you want to retrieve Help files from, and click OK.

Download updated Help

For subscribers to an Enhancement plan, updated Help files for Microsoft Dynamics AX are made available in English and a limited set of additional languages. This Help contains content updates made in response to customer feedback.

Note   The Help files distributed by Microsoft do not overwrite Help files created by your partner for Microsoft Dynamics AX.

2295. Navigate to Using Microsoft Dynamics AX to find the location of the most recent downloadable Help files. 
2296. Download and install the updated Help files in the location you have set for your system.

2297. On each client, on the Help menu, click Check for Updates.

Note   Using Microsoft Dynamics AX also provides access to an updated version of the Microsoft Dynamics AX Help system that you can browse.

Determine where to store Help files for each client

You can use the helpDir command to point a Microsoft Dynamics AX client to Help files that are stored in a location different than the default. The location can be on a network share or local. The directory structure required for the alternate Help location mirrors that used by Microsoft Dynamics AX: Help\language. For a list of the language directories used by your installation, review the folders under the Program Files\Microsoft Dynamics AX\40\Client\Bin\Help directory.

Point a single client to an alternate Help file location

2298. Place the Help files in the location you want. The file location can be local, or on a network share. 
2299. Open the Microsoft Dynamics AX Configuration Utility (Start > All Programs > Administration > Microsoft Dynamics AX Configuration Utility), and create a new configuration if you are still using the original configuration. 

2300. In the Startup command field, enter -helpDir=filelocation. Close the configuration utility to save the configuration.

2301. Close Microsoft Dynamics AX if it is open, and restart it. The Help system reads from the location you designated.

Note   If the topics in the Help files do not display when you are pointing to a location on a network, you may need to modify security settings that prevent Help from loading over a network. For details, see this Knowledge Base article.

Point multiple clients to an alternate Help file location

To point multiple clients to a new Help file location when you are deploying them, you must create a configuration file that contains the helpDir command, and deploy the clients to use a shared configuration file. For details about deploying clients to use a shared configuration file, see Install clients silently.

When you use a configuration that points to an alternate location for Help files, the Help files stored locally are not used. 

2302. Place the Help files in the location you want.
2303. Open the Microsoft Dynamics AX Configuration Utility (Start > All Programs > Administration > Microsoft Dynamics AX Configuration Utility). 

2304. Click Manage > Save Configuration as file, and name and save the configuration file.

2305. Close the configuration utility.

2306. Edit the configuration file in a text editor. Add the following command to the file: 

helpDir = <help file location>

2307. Save the file, and copy it to a shared directory that all client computers can connect to.

We recommend that you use a shared directory on the computer running the instance of Application Object Server that clients connect to.

Distribute Help to clients that use a shared configuration

Copy the updated Help files to the location specified by the helpDir parameter in the shared configuration file. For details about shared configuration files, see Install clients silently.

Monitoring and tuning

You monitor the health of your system by observing its real-time operation. Your objective is to gather knowledge about how your Microsoft Dynamics AX servers are operating, and then use this knowledge to tune that operation to improve performance.

This section includes the following:

	Topic
	Description

	Statistics (Oracle and SQL Server)
	Discusses the statistics available for database operation. 

	Tracing
	Describes tracing tools and options.

	Tune database settings
	Describes options for database tuning.

	Troubleshooting problems with clients
	Describes common problems and solutions with clients.

	Tune Application Object Server performance
	Describes the options for tuning the Application Object Server (AOS) service.


Set up Performance Monitor counters

You can use the Performance Monitor counters that ship with MSDAX to help you monitor the utilization of system resources. Collect and view real-time performance data in the form of counters, for server resources such as processor and memory use, and for many Microsoft Dynamics AX and Microsoft SQL Server resources such as locks and transactions.

The counters that ship with Microsoft Dynamics AX include: 

	Performance Object
	Counter
	Description

	Microsoft Dynamics AX Object Server
	Active Sessions
	The number of currently active server sessions.

	
	Number of Bytes Received by Server
	The number of bytes received by the Application Object Server (AOS) instance since starting.

	
	Number of Bytes Sent by Server
	The number of bytes sent by the AOS instance since starting.

	
	Number of Client Requests
	The number of client to server requests since the AOS instance started.

	
	Number of Client Requests per Second
	The number of client to server requests processed per second by the AOS instance.

	
	Number of Server Requests
	The number of server to client requests processed since the AOS instance started.

	
	SQL connections-cached
	The number of currently cached (inactive) SQL connections.

	
	SQL connections-active
	The number of user and session connections to the database. 

	
	Total Sessions
	Total sessions active since the AOS instance started. 

	Microsoft Dynamics: Enterprise Portal

(All Enterprise Portal counters are .NET Business Connnector counters. If you call the .NET Business Connector through another application, the same counters can be used). 
	Number of Sessions
	The number of currently active .NET Business Connector sessions.

	
	Webpart Execution Time
	The time in seconds that a Web Part takes to execute and render.

	
	Webpart Execution Time Base
	A base counter that is used in the calculation of Web Part Execution Time

	
	Unsuccessfull Logons
	The number of unsuccessful .NET Business Connector logons.

	
	Fatal Sessions Exceptions
	The number of fatal .NET Business Connector session exceptions.

	
	Nonfatal Session Exceptions
	The number of nonfatal .NET Business Connector session exceptions.

	
	Xpp Session Exceptions
	The number of X++ .NET session exceptions.

	
	Sessions Allocated
	The total number of .NET Business Connector sessions allocated since startup.

	
	Sessions Disposed
	The total number of .NET Business Connector sessions disposed since startup.

	
	Session Allocation Rate
	The total number of .NET Business Connector sessions allocated per second.


You may also want to monitor counters for the AOS process (Ax32Serv), such as CPU usage, memory usage, handle counts, and thread counts.

Start Performance Monitor
On the Start menu, click Control Panel > Administrative Tools > Performance.

Add counters
2308. In Performance window, click the + toolbar button, or press CTRL+I.

2309. In the Add Counters dialog box, select Select Counters from Computer, and then in the Performance Object box, select the object to add counters for. 

2310. You can select all counters for an object, or select individual counters. 

2311. After choosing the counters you want, click Add, and then click Close. 

Set up an alert
2312. On the navigation tree of the Performance window, expand Performance Logs and Alerts.

2313. Right-click Alerts, and then click New Alert Settings.

2314. In the New Alert Settings dialog box, type a name for the new alert, and then click OK.

2315. On the General tab of the dialog box for the new alert, add a comment, and click Add to add a counter to the alert.

All alerts must have at least one counter.

2316. In the Add Counters dialog box, select a MSDAX object from the Performance Object list, and then select a counter from the Select counters from list.

2317. To add the counter to the alert, click Add. You can continue to add counters, or you can click Close to return to the dialog box for the new alert.

2318. In the new alert dialog box, click either Over or Under in the Alert when the value is list, and then enter a threshold value in Limit.

The alert is generated when the value for the counter is more than or less than the threshold value (depending on whether you clicked Over or Under).

2319. In the Sample data every boxes, set the sampling frequency.

2320. On the Action tab, set actions to occur every time the alert is triggered.

2321. On the Schedule tab, set the start and stop schedule for the alert scan.

Microsoft Dynamics is a line of integrated, adaptable business management solutions that enables you and your people to make business decisions with greater confidence. Microsoft Dynamics works like and with familiar Microsoft software, automating and streamlining financial, customer relationship and supply chain processes in a way that helps you drive business success.
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